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 ORION NETWORK PERFORMANCE MONITOR 
 

SolarWinds について 

SolarWinds, Inc は、今日のネットワーク管理者やコンサルタントの多様な要件を満たすため、豊富なネット 

ワーク管理、監視、発見ツールの開発および販売をしております。SolarWinds の製品は、品質と性能の基準

を常に打ち立てており、弊社はネットワーク管理および発見テクノロジーのトップ企業として位置づけられています。

SolarWinds の顧客基盤には、フォーチュン 500社の 45%以上の企業が含まれており、90か国以上に広く分

散しています。当社のグローバル ビジネス パートナーの販売代理店ネットワークは、100 以上の販売業者およ

び再販業者で構成されています。 

SolarWindsへのお問い合わせ 

 SolarWindsには、以下を含むさまざまな方法でお問い合わせいただけます。 

チーム 連絡先情報 

営業 

sales@solarwinds.com 
www.solarwinds.com 
1.866.530.8100 
+353.21.5002900 

テクニカル サポート www.solarwinds.com/support/ 

ユーザー フォーラム www.thwack.com 

 

http://www.solarwinds.com/
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SolarWinds Orion Network Performance Monitor 

ドキュメンテーション ライブラリ 

SolarWinds Orion Network Performance Monitorのドキュメンテーション ライブラリには、次のドキュメントが

含まれています。 

ドキュメント 目的 

管理者ガイド セットアップ、設定、およびコンセプト情報の詳細を提供します。 

Orion共通 

コンポーネント管理者 

ガイド 

Orion ファミリーのすべての製品に共通なセットアップ、設定、およびコ

ンセプト情報の詳細を提供します。Orion NPM に関連する

『SolarWinds Orion 共通コンポーネント管理者ガイド』の情報は、
この『SolarWinds Orion NPM 管理者ガイド』にも含まれてい 

ます。 

評価ガイド 
Orion Network Performance Monitorの機能の紹介とインストー

ルおよび初期設定について説明しています。 

ページ ヘルプ 
Orion Network Performance Monitorのユーザー インターフェース

のウィンドウごとに関連ヘルプを提供します。 

クイックスタート ガイド 

インストールおよびセットアップ方法、そして Orion Network 

Performance Monitor がシンプルかつパワフルなソリューションを提

供する一般的なシナリオを紹介しています。 

リリース ノート 
最新情報や既知の問題、アップデートを提供します。最新リリース  

ノートは www.solarwinds.com を参照してください。 

 

表記規則 

本書は、印刷版およびオンライン ライブラリ全体にわたって使用される用語を特定できるようにするため、一貫性

のある表記規則を使用しています。 

表記規則 用途 

太字 ボタンやフィールドを含むウィンドウ項目 

イタリック体 書籍や CDの題名、変数名、新用語 

固定フォント 
ファイルやディレクトリの名前、コマンド、コードの例、ユーザーがタイ

プするテキスト 

角括弧、[値]  オプションのコマンド パラメータ 

波括弧、{値} 必須コマンド パラメータ 

論理 OR、値 1|値 2 1つのオプションしか指定できない排他的なコマンド パラメータ 

 

 

 

http://www.solarwinds.net/
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 はじめに  1 

第 1章 

はじめに 

Orion Network Performance Monitor （Orion NPM ）は、総合的なネットワークの障害お

よび性能管理を実現します。Orion NPM では、急激なネットワークの成長に対応しながら、

ネットワークの監視ニーズに合わせて拡張が可能で、ウェブ ブラウザから可用性やリアルタイム・

履歴統計を直接収集して閲覧することができます。ルータ、スイッチ、ファイアウォール、サー 

バー、またはその他の SNMP 有効デバイスからのデータの監視、収集、解析において、Orion 

NPM は、あらゆる規模のネットワークに対応する IT プロフェッショナルに、使いやすく拡張性の

あるネットワーク監視ソリューションを提供します。Orion NPM を立ち上げて稼働するために、

コンサルタント チームを要請したり、数ヶ月間も不慮の事態に直面する必要はありません。な

ぜなら、Orion NPM は従来の複雑な企業向けネットワーク管理システムに比べてはるかに直

感的であるからです。Orion NPM は 1 時間以内に配置することができ、コンサルタントも不

要なため、Orion NPM はネットワーク内のネットワーク機器、サーバー、アプリケーションの健全

性について、迅速かつコスト効果の高い可視性を提供し、システムのパフォーマンスを最大限

に発揮するために必要なリアルタイムの情報を保証します。 

SolarWinds Orion NPM をインストールする理由 

難しい設定なしに、Orion NPM はネットワーク内の物理および仮想デバイスに対して、次の

重要なパフォーマンス指標を監視します。 

 ネットワーク可用性 

 帯域幅容量の利用率 

 バッファ使用量およびエラー 

 CPU およびメモリ利用率 

 インターフェース エラーおよび廃棄 

 ネットワーク遅延 

 ノート、インターフェース、およびボリュームのステータス 

 ボリューム使用量 

これらの監視機能に加え、完全にカスタマイズ可能なウェブ インターフェース、アラート、レポー

ト  エンジン、柔軟な拡張機能を備える  SolarWinds Orion Network Performance 

Monitor は、ネットワークのパフォーマンス監視のニーズを満たす最高の選択と言えます。 
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2  はじめに 

Orion Network Performance Monitor の利点 

Orion Network Performance Monitor には、次の利点があります。 

難しい設定はなし 

自動ディスカバリとウィザード形式の設定で、投資回収をすぐに達成できます。Orion 

NPM のインストール後、数分以内に重要なネットワーク デバイスの監視を始められます。 

理解しやすく使いやすい 

Orion NPM は、他の業務も同時に担当するスタッフが日常的に使用できるように設計

されています。Orion NPM インターフェースは、必要な情報を好きな場所に表示でき、

設定作業を最小限に抑えながらも高度な機能を提供します。 

手頃な価格 

Orion NPM は、たとえより優れているとまではいかなくても、他の競合ソリューションと類似

する機能を提供し、Orion NPM の価格と保守コストは、他の多くのソリューションの初期

費よりも安く済みます。 

スケーラビリティ 

個々のポーリング エンジンを追加することで、環境規模に合わせて Orion NPM を拡張

できます。同じデータベースを共有すれば、ユーザーは追加のポーリング エンジンを意識す

ることなく統一されたユーザー インターフェースを共有できます。 

thwack.com オンライン コミュニティ 

thwack.com は、SolarWinds のユーザーとより広範なネットワーク  コミュニティに、

SolarWinds のネットワーク管理ソリューションに関連する有益な情報、ツール、貴重なリ

ソースを提供する目的で構築されたコミュニティ サイトです。Orion ウェブ コンソールから 

thwack.com コミュニティに直接アクセスし、最近の投稿を閲覧したり、過去の投稿を検

索することができます。 

Orion Network Performance Monitor の主な機能 

上述の利点に加え、次の機能を提供する Orion NPM は、最高の選択肢と言えます。 

カスタマイズ可能かつ柔軟な Orion ウェブ コンソール 

完全にカスタマイズ可能なウェブ インターフェースには、詳細なグラフや表、リストが表示さ

れ、ネットワークの障害、可用性、パフォーマンス情報をリモートで閲覧することができます。

受賞歴に輝く、直感的な Orion NPM ウェブ インターフェースを使用し、個々またはグ 

ループごとに新しいデバイスの追加、カスタム リソースやビューの作成、部門や地理的場

所、その他の条件に基づいた一意的なユーザー アカウントとビューの作成、ウェブ コンソー
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ル表示のカスタマイズといった管理タスクをネットワークのどこからでも実行できます。これら

の機能により、リモート デスクトップ プロトコル（RDP）で Orion サーバーに直接接続する

ことなく、遠隔から Orion NPM タスクの管理を行えるため、時間の節約につながります。 

自動的および定期的なデバイス ディスカバリ 

ウィザード形式のデバイス ディスカバリにより、Orion NPM へのデバイスやインターフェース

の追加がさらに簡単になります。デバイスについて 2、3 の一般的な質問に答えるだけで、

ディスカバリ アプリケーションが処理を引き継ぎ、Orion NPM を使用してすぐにネットワー

ク解析を開始することができます。また、ネットワーク ディスカバリのスケジュールを作成して、

必要に応じて、Network Sonar Discovery ジョブを単独で自動的に実行できます。 

直感的な Orion NPM 管理 

受賞歴のある直感的な Orion NPM ウェブ インターフェースを使用して、ネットワークのど

こからでも、個々またはグループごとに新しいデバイスの追加、一意なユーザー アカウント

の作成、ウェブ コンソールの表示のカスタマイズといった管理タスクをネットワークのどこから

でも行えます。これらの管理機能により、リモート デスクトップ プロトコル（RDP）で Orion 

NPM ホスト サーバーに直接接続することなく、Orion NPM タスクの管理をリモートで行

えるため、時間を節約することができます。 

オープンな統合 

Microsoft® SQL Server データベースと、業界標準の MIB やプロトコルを含む企業で

実証済みの標準が、Orion NPM のネットワーク監視ソリューションのバックボーンです。 

統合されたワイヤレス ポーラー 

統合ワイヤレス デバイス ポーラーにより、実績ある Orion NPM のアラート、レポート、ウェ

ブ コンソール リソースを活用して、ワイヤレス シンおよび自律型の無線アクセス ポイントを、

既に監視を行っている有線ネットワーク デバイスと同じビューで監視・管理できます。 

Cisco EnergyWise 監視 

Cisco EnergyWise 技術により、企業におけるエネルギー利用の責任ある管理を行えま

す。Orion NPM で EnergyWise デバイス管理データを閲覧し、EnergyWise を採用

したスイッチに接続しているあらゆるデバイスのエネルギー消費量の測定、レポートの出力、

および削減を行うことができます。 

ConnectNow 機能付き Network Atlas 

Orion のネットワーク マッピング アプリケーションである Network Atlas を使用し、複数の

レイヤで完全にカスタマイズ可能なウェブベース マップを作成できます。また、ネットワークの

あらゆる場所にあるデバイスのパフォーマンスを視覚的にかつリアルタイムで追跡することが

できます。ConnectNow 機能は、ネットワークで検出される相互接続された物理ノード

の間に自動的にリンクを設定します。 
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プラグ取り外し可能ポート モード 

Orion NPM では、特定のポートをプラグ取り外し可能に指定することで、接続されたデ

バイスをユーザーが切り離したり、シャットダウンした際にも不要なアラートを受信する必要

はありません。この機能は、ノートパソコンを接続した優先度の低いポートと、PC を接続

した非常に重要なインフラストラクチャ ポートを区別するために特に役立ちます。 

ユニバーサル デバイス ポーラー 

ユニバーサル デバイス ポーラーにより、SNMP 有効デバイスを簡単にローカルの監視デー

タベースに追加でき、デバイス MIB テーブルで参照される統計や情報を収集することがで

きます。ユニバーサル デバイス ポーラー ウィザードでポーラー変換を使用し、複数のユニ 

バーサル デバイス ポーラーから収集したデータを操作して、独自のカスタム統計情報を作

成したり、カスタマイズしたデータの表示方法を選択することができます。 

VMware インフラストラクチャ監視 

Orion NPM では、VMware サーバー、データセンター、およびクラスタを監視できます。こ

れには、VMware ESX、ESXi、Virtual Center、およびネットワーク上の ESX サー 

バーがホストする仮想マシン（VM）が含まれます。ESXi および ESX サーバー上の VM 

の一覧、ESXi および ESX サーバーとホストされる VM のパフォーマンス詳細、そして関

連するグラフやレポートなどのリソースを利用できます。 

データ センター監視 

Orion NPM は、Cisco Unified Computing Systems （UCS）やファイバー チャネル デ

バイス（Cisco MDS 、Brocade 、McData 製）のパフォーマンス データを提供する定義

済みレポート、ウェブ コンソール ビュー、およびリソースを提供します。 

インシデント アラート 

複数条件のチェックを含む数百通りのネットワーク シナリオに対応するカスタム アラートを

設定できます。Orion NPM アラートは、ネットワーク ユーザーが生産性の低下に直面す

る前に、問題を認識します。アラートの配信と応答方法に、メール、ページング、SNMP 

トラップ、テキスト音声変換、Syslog メッセージ、外部アプリケーションの実行をサポートし

ています。 

統合されたトラップおよび Syslog サーバー 

Orion NPM を使用すれば、複数のマシンをポーリングすることなく、トラップや Syslog  

メッセージを使用して、単一のインターフェースからネットワーク情報にアクセスできるため、

ネットワーク問題の調査にかかる時間を節約できます。Orion NPM を使用して、簡単に

アラートを設定し、Syslog およびトラップ メッセージの受信、処理、転送、および送信を

実行することができます。 
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詳細な履歴レポート 

期間を指定し、Orion データベースからのデータを使用して簡単にレポートを作成できま

す。データは、ウェブ コンソールまたは Orion Report Writer アプリケーションで閲覧できる

形式で提示されます。40 以上のレポートが用意されており、将来の傾向や容量ニーズを

予測し、可用性、パフォーマンス、利用率などの統計情報にすぐにアクセスできます。

Report Writer にインポートできる新しいレポートを www.thwack.com からダウンロード

することもできます。 

グループおよび依存関係 

デバイス グループや依存関係を定義できるため、ネットワークをより効果的に管理できま

す。グループにより、デバイス タイプや場所を問わず、監視対象オブジェクトを論理的に整

理することができ、また依存関係は、ネットワークの本当の状態を忠実に示すことができる

ため、「誤検出」のアラート トリガーを排除し、監視するネットワーク オブジェクトのステータ

スについて正確な見識を得られます。 

拡張可能な Orion NPM モジュール 

アプリケーション パフォーマンス モニター（Orion APM）、NetFlow トラフィックアナライザ

（Orion NTA）、Orion IP SLA マネージャー（旧 Orion VoIP モニター）、IP アドレス マ 

ネージャー（Orion IPAM）、およびネットワーク コンフィグレーション モニター（Orion NCM）

の統合を含めた Orion の追加モジュールを使用し、ネットワーク アプリケーションの監視や、

ネットワーク トラフィックの分析、Cisco IP SLA を使用した VoIP および WAN トラフィッ

クの監視、IP アドレスとサブネット割当の管理、EnergyWise デバイスの監視をそれぞれ

行うことができます。Orion モジュールは、追加のスタンドアロン ソフトウェアを必要とするこ

となく、既存の Orion NPM に機能を追加するため、時間を節約できます。 

製品アップデートの通知 

インストールされている Orion の監視および管理アプリケーションのアップデートについて、

定期的な自動通知を Orion ウェブ コンソールで受信することができます。製品アップデー

トには、アップグレードやサービスパック、ホットフィックスなどが含まれます。 

Orion 製品チーム ブログ 

SolarWinds のオンライン ユーザー コミュニティであるスワックの Orion 製品チーム ブログ

で、Orion 製品ファミリーをお届けしているスタッフと連絡を取り合うことができます。Orion 

の製品マネージャーや開発者の投稿を読み、自社のネットワーク  ニーズに合わせて 

Orion のインストレーションを拡張・最適化する方法を学べます。 

http://www.thwack.com/
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ネットワークの概念および用語 

次のセクションでは、Orion NPM で使用するネットワークの概念や用語を定義しています。 

 インターネット コントロール メッセージ プロトコル （ICMP） 

 簡易ネットワーク管理プロトコル （SNMP） 

 SNMP 認証 

 マネジメント情報ベース （MIB） 

インターネット コントロール メッセージ プロトコル （ICMP） 

Orion NPM は、インターネット コントロール メッセージ プロトコル（ICMP）を使用して管理され

るデバイスに対し ping と echo 要求を行い、ステータスをポーリングします。Orion NPM が 

ICMP を使用して管理対象デバイスをポーリングする際に、デバイスが稼働中の場合には、応

答時間とドロップしたパケットの記録を返します。この情報は、Orion NPM が管理対象デバイ

スのステータスを監視し、平均応答時間とパケット損失率を測定するために使用されます。 

注記： Orion NPM は、ステータスや平均応答時間、パケット損失率をデバイスからポーリング

するために ICMP のみを使用します。Orion ウェブ コンソールに表示されるその他の情報は、

SNMP 要求を使用して取得されます。 

簡易ネットワーク管理プロトコル （SNMP） 

Orion NPM は、ほとんどのネットワーク監視および管理タスクに、簡易ネットワーク管理プロト

コル （SNMP）を使用します。ルータ、スイッチ、PC を含む SNMP 有効ネットワーク デバイス

には、特定のオブジェクト識別子 （OID）に関連付けられたシステム ステータスとパフォーマンス

情報の仮想データベースを管理する SNMP エージェントが常駐しています。この仮想データ 

ベースは、マネジメント情報ベース （MIB）と呼ばれ、Orion NPM は、選択した SNMP 有効

デバイスに関する特定データを取得するために MIB OID を参照として使用します。MIB デー

タへのアクセスは、SNMPv1 および SNMPv2c で提供される SNMP コミュニティ ストリング、

または SNMPv3 で提供される SNMP 認証のどちらかを使用し、セキュリティを確保してい 

ます。 

注記： 

 ネットワーク上のデバイスを正しく監視するためには、SNMP 通信に対応するすべてのデ

バイスで、SNMP が有効である必要があります。SNMP を有効にする手順はデバイスご

とに異なるため、デバイス ベンダーが提供するドキュメンテーションを確認してください。 
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 Orion NPM で監視したいデバイス上で SNMPv2c が有効になっている場合、Orion 

NPM はデフォルトで SNMPv2C を使用し、デバイスからパフォーマンス情報のポーリング

を試みます。Orion NPM に SNMPv1 のみを使用してポーリングさせる場合、ポーリング

の対象となるデバイス上で SNMPv2c を無効にしなければなりません。 

MIB の詳細については、7 ページの「マネジメント情報ベース （MIB）」を参照してください。

SNMP 認証の詳細については、7 ページの「SNMP 認証」を参照してください。 

SNMP 認証 

SNMP 認証は、SNMP を有効にしたデバイスでセキュアなアクセスを保証します。SNMPv1 

および SNMPv2c 認証は一種のパスワードです。認証方法としては、SNMP 要求によって

提供される平文の SNMP コミュニティ ストリングと、管理している SNMP 有効デバイス上の 

MIB オブジェクトして保存した SNMP コミュニティ ストリングとが一致しているかを確認します。

SNMPv3 は、次に示すフィールドを使用することで、よりセキュアな通信を提供します。 

 User Name （ユーザー名）は、SNMP 有効デバイスへのアクセスを試みるエージェントま

たはポーリング リクエストを識別する平文の文字列です。User Name （ユーザー名）は、

SNMPv1 および SNMPv2c の SNMP コミュニティ ストリングと同様の役割を果たします。 

 Context （コンテキスト）はオプションの識別用フィールドで、SNMP 有効デバイスの MIB 

で利用可能な情報に追加の構造とセキュリティを提供します。Context （コンテキスト）は

通常、SNMP 有効デバイス上で特に設定されない限り、空の文字列です。 

 SNMPv3 は、2 つのオプションとして 認証方法 ： Message Digest 5 （MD5 ：メッセー

ジ ダイジェスト 5 ）と Secure Hash Algorithm 1 （SHA1 ：セキュア ハッシュ アルゴリズ

ム 1 ）を提供します。MD5 と SHA1 のどちらも、SNMPv3 パケットに 認証キー を持た

せ、送信される SNMPv3 パケット全体のダイジェストを生成します。MD5 ダイジェストは 

20 バイト長で、SHA1 ダイジェストは 16 バイト長です。パケットを受信すると、適切な方

法を使用してパケット ダイジェストを再作成するために User Name （ユーザー名）を使用

します。双方のダイジェストが認証のために比較されます。 

 SNMPv3 は、2 つのオプションとして プライバシー / 暗号化方式 ： Data Encryption 

Standard （DES56）と 128 ビットの鍵を使用する Advanced Encryption Standard 

（AES128）も提供します。SNMPv3 パケット全体を暗号化するために、DES56 は  

56 ビットキーと共に 56 ビットソルト、AES128 は 128 ビットキーと共に 128 ビットのソル

トを使用します。 

マネジメント情報ベース （MIB） 

マネジメント情報ベース（MIB）は、SNMP を使用して管理できる一連のオブジェクトの形式的

記述です。MIB-I は初期の MIB 定義、MIB-II は現在の定義をそれぞれ指します。各 MIB 

オブジェクトは、sysUpTime （システム稼働時間）、bandwidth utilization （帯域幅利
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用率）、または sysContact （連絡先）などを含む値を保存します。ポーリング時に、Orion 

NPM は各ネットワーク デバイスに SNMP GET 要求を送信し、指定した MIB オブジェクトを 

ポーリングします。受信した応答は、Orion NPM が使用する Orion ウェブ コンソール リソース

内を含む Orion NPM データベースに記録されます。 

ほとんどのネットワーク デバイスは、複数の異なる MIB タイプをサポートしています。ほとんどの

デバイスは標準の MIB-II MIB をサポートしていますが、監視の必要があるその他多数の 

MIB をサポートしている場合もあります。完全にカスタマイズ可能な Orion ユニバーサル デバ

イス ポーラーを使用すれば、アクセス可能なあらゆるネットワーク デバイス上の MIB から情報

を収集できます。 

Orion Network Performance Monitor の仕組み 

ICMP、SNMP、および Syslog 通信とデータ収集を通して、Orion NPM はネットワークの健

全性とパフォーマンスを継続的に監視します。しかも同時に、Orion NPM はネットワーク デバ

イスの重要な機能には干渉しません。他の多くのネットワーク監視製品とは異なり、Orion 

NPM は次の方法でネットワークの全体的なパフォーマンスの維持を手助けします。 

 Orion NPM は、ミッション クリティカルなサーバー上に外部エージェントをインストールしま

せん。 

 Orion NPM は重要なアプリケーションから貴重なリソースを奪うサービスを使用しません。 

 Orion NPM は監視されたネットワーク デバイスに上にいかなるコードもインストールしませ

ん。管理されていない、または旧式のコードは、ネットワーク内にセキュリティホールが生じる

原因となります。 

Orion NPM のインストール後、ネットワークの初回ディスカバリを自動化し、新しいデバイスを

ネットワークに追加するたびに、Orion NPM に簡単に追加することができます。Orion NPM 

は、収集された情報を SQL データベースに保存し、現在および過去のネットワーク ステータス

を閲覧するための、ユーザー フレンドリーで、高度にカスタマイズ可能なウェブ コンソールを提供

します。 
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第 2章 

SolarWinds Orion Network Performance 
Monitor 

Orion Network Performance Monitor （Orion NPM）は、シンプルなウィザード形式のイン

ストール プロセスを提供しています。企業規模の製品としては、ライセンス、ハードウェア、およ

びソフトウェアの各種要件はそれほど多くありません。 

Orion Network Performance Monitor のライセンス 

Orion NPM は、ルータ、スイッチ、ファイアウォール、サーバーを含むバージョン 3 以前のあらゆ

る SNMP 有効デバイスからデータや詳細情報を収集できます。Orion NPM は、次の 3 つの

タイプの監視されたネットワーク エレメントの最大数に従ってライセンス供与されます。 

ノード 

ノードには、ルータ、スイッチ、仮想および物理サーバー、アクセス ポイント、モデムなど、す

べてのデバイスが含まれます。 

インターフェース 

インターフェースには、スイッチ ポート、物理インターフェース、仮想インターフェース、サブイ

ンターフェース、VLAN 、およびその他のネットワーク トラフィックの単一点が含まれます。 

ボリューム 

ボリュームは、監視する論理ディスクと同等です。 

次の一覧は、Orion Network Performance Monitor のさまざまなタイプのライセンスを挙げ

ています。 

 SL100 ライセンスは、最大 100 ノード、100 インターフェース、および 100 ボリューム 

（合計 300 エレメント）の監視を許可します。 

 SL250 ライセンスは、最大 250 ノード、250 インターフェース、および 250 ボリューム 

（合計 750 エレメント）の監視を許可します。 

 SL500 ライセンスは、最大 500 ノード、500 インターフェース、および 500 ボリューム 

（合計 1500 エレメント）の監視を許可します。 

 SL2000 ライセンスは、最大 2000 ノード、2000 インターフェース、および 2000 ボリュー

ム（合計 6000 エレメント）の監視を許可します。 

 SLX ライセンスは、無制限数のエレメントの監視を許可します。関連するサーバー サイジ

ングの詳細については、14 ページの「サーバーのサイズ」を参照してください。 
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データベースのサイズは、監視するエレメントの追加に伴って増加します。ネットワーク上のエレ

メント数とトラフィック量によっては、8000 以上のエレメントを監視するのに追加のポーリング エ

ンジンが必要になる場合もあります。詳細については、165 ページの「追加ポーリング エンジン

の使用」を参照してください。 

Orion NPM の要件 

SolarWinds は、Orion NPM を単独のサーバーにインストールし、Orion データベースを別の

単独の SQL Server 上にホストすることを推奨します。Orion NPM、Orion アプリケション パ

フォーマンス モニター、および Orion Network Configuration Manager を含む複数の 

Orion サーバーで 1 つのデータベースを共有することは推奨しません。詳細については 10ペー

ジの「Orion の要件」を参照してください。 

注記： インストールされるすべての追加のポーリング エンジンと追加のウェブ サーバーは、プライ

マリ Orion サーバーにインストールした Orion NPM と同じバージョンを使用しなければなりま

せん。 

Orion の要件 

SolarWinds は Orion サーバーと SQL Server を別々のサーバーにインストールすることを推

奨します。同じデータベースを使用する複数の Orion NPM サーバーのインストレーションはサ

ポートされていません。下記のセクションでは、詳細な要件を挙げています。 

 Orion サーバー ハードウェア要件 

 Orion サーバーのソフトウェア要件 

 仮想マシンおよびサーバーの要件 

 その他の必須コンポーネント 

Orion サーバー ハードウェア要件 

次の表には Orion サーバーに対する最低限のハードウェア要件と推奨がリストされています。 

注記： ハードウェア要件は Orion NPM のライセンス レベル別に記載されています。 

ハードウェア SL100 、SL250 、または SL500 SL2000 SLX 

CPU スピード 

2.0 GHz 2.4 GHz 3.0 GHz 

注記： デュアル プロセッサ、デュアル コアを推奨します。Physical Address Extension 

（PAE 、物理アドレス拡張） は有効にしないでください。 

ハードドライブ  

スペース 

2.5 GB 5 GB 20 GB 

注記： サーバー オペレーティング システム、Orion インストールおよび tempdb ファイル用に
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ハードウェア SL100 、SL250 、または SL500 SL2000 SLX 

は RAID 1 ドライブが推奨されます。Orion は、ジョブ エンジン、情報サービス、コレクタ  

サービス、MIB データベース、およびその他の必須ファイル用に最低 1.5GB を必要としま

す。Orion インストーラは一時的 Windows システムまたはユーザー変数が保存されるドラ

イブで 1GB が必要になります。Windows 基準によって、サーバー オペレーティング システ

ムと同じドライブに共通ファイルのいくつかをインストールする必要がある場合があります。詳

細については、471 ページの「一時ディレクトリでの作業」を参照してください。 

メモリ 3 GB 4 GB 4 GB 

Orion サーバーのソフトウェア要件 

以下の表は、最小ソフトウェア要件と推奨要件を示しています。 

ソフトウェア 要件 

オペレーティング 

システム 

Windows Server 2003 SP2 R2 または 2008 （ R2 含む、32 ビット モードの IIS ）。 

IIS および MSMQ のインストールは必須です。SolarWinds では、ローカル Orion ツー

ルの機能性を完全にするために Orion 管理者がローカル管理者特権を有することを推

奨します。Orion ウェブ コンソールの使用に限定されるアカウントには管理者特権は必

要ありません。 

注記： 

 SolarWinds では、Windows XP 、Windows Vista 、もしくは Windows 7 システ

ムにおける Orion 製品の生産インストールをサポートしていません。 

 Orion NPM は、Web ガーデンを使用する Internet Information Services バー 

ジョン 6.0 （IIS6）との互換性がありません。 

アプリケーション  

ポート 

161、162、443 （SNMP） VMware ESX/ESXi サーバーは 443 にポーリングされてい

ます。 

514 （UDP）は Syslog メッセージ用。162 （SNMP）は SNMP トラップ用。 

17777 （TCP）は Orion モジュール トラフィック用。 

17778 （HTTPS）は SolarWinds Information Service API へのアクセス用。 

17779 （HTTP および HTTPS）は SolarWinds Toolset Integration 用。 

ウェブ サーバー 

32bit モードの Microsoft IIS バージョン 6.0 以上 

DNS 仕様では、ホスト名は英数字 （A～Z 、0～9）、マイナス サイン （-） およびピリ

オド （.） で構成されるように要請してます。アンダースコア （_）は許可されません。詳細

情報は RFC 952 を参照してください。 

注記： SolarWinds は、Orion 製品を同じサーバーにインストールすること、またはリサー

チ イン モーション （RIM） Blackberry サーバーと同じデータベース サーバーを使用するこ

とを推奨もサポートもしません。 

.NET 
Framework 

バージョン 3.5..NET Framework 3.5 SP1 が推奨されます。 

SNMP Trap  

サービス 
Windows オペレーティング システム管理およびモニタリング ツールのコンポーネント 

ウェブ コンソール 

ブラウザ 

アクティブ スクリプトのついた Microsoft Internet Explorer バージョン 6 以降 

Firefox 3.0 以降 （ツールセット統合は Firefox に対応していません） 
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Orion データベース サーバー （SQL サーバー）の要件 

次の表では、Orion データベース サーバーのソフトウェアおよびハードウェア要件をリストしていま

す。Orion NPM ライセンス レベルが参考として提供されています。 

要件 SL100 、SL250 、または SL500 SL2000 SLX 

SQL Server 

SQL Server 2005 SP1 Express、Standard、または Enterprise 

SQL Server 2008 R2、Express、Standard、または Enterprise 

注記： 

 SQL Server Compact 3.5 SP1 は、Orion 評価版でのみサポートされてい 

ます。 

 レイテンシの影響によって SolarWinds では SQL サーバーおよび Orion サーバー

または追加ポーリング エンジンを WAN 上の別の場所にインストールすることは奨

励しません。詳細情報は、SolarWinds ナレッジベース記事の「Orion サーバーま

たは追加ポーリング エンジンと Orion データベース（SQL サーバー）を WAN 上の

別の場所にインストールできますか? 」を参照してください。 

  

 混合モードまたは SQL 権限のいずれかがサポートされている必要があります。 

 Orion データベースを管理している場合、SolarWinds では  SQL Server 

Management Studio のコンポーネントをインストールすることをお勧めします。 

 Orion NPM 製品が SQL Server System CLR Types をインストールする場

合、Orion データベースの SQL Server サービスを手動で再起動する必要があり

ます。 

 次のデータベース セレクト文を使用して、SQL サーバーのバージョンやサービスパッ

ク、リリース レベル、版を確認してください。 
select SERVERPROPERTY ('productversion'), 

SERVERPROPERTY ('productlevel'), SERVERPROPERTY 

('edition') 

CPU スピード 2.0 GHz 2.4 GHz 3.0 GHz 

ハー ド ド ラ イ ブ  

スペース 

2 GB 5 GB 20 GB 

注記： 極度の I/O 要件があるため、SQL サーバー データベース、Orion データおよび

ログ ファイルには RAID 1+0 ドライブを強く推奨します。SQL サーバーのハード ドライ

ブには RAID 5 を推奨しません。Orion インストーラは一時的 Windows システムまた

はユーザー変数が保存されるドライブで最低 1GB が必要になります。Windows 基

準によって、サーバー オペレーティング システムと同じドライブに共通ファイルのいくつかを

インストールする必要がある場合があります。詳細については、471 ページの「一時ディ

レクトリでの作業」を参照してください。 

メモリ 

2 GB 3 GB 4 GB 

注記： SolarWinds は、監視対象が 1000 を超える Orion APM インストレーション

に最大 8GB の RAM 搭載を推奨しています。 

.NET 
Framework 

バージョン 3.5..NET Framework 3.5 SP1 が推奨されます。 
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仮想マシンおよびサーバーの要件 

VMware 仮想マシンおよび Microsoft 仮想サーバーへの Orion のインストールは、各仮想マ

シンが次の最小要件を満たす場合のみ、完全にサポートされます。 

注記： SolarWinds では、個別の物理的サーバー上に SQL サーバー データベースを管理す

ることを強く推奨します。 

仮想マシン構成 
ライセンス レベル別の Orion 要件 

SL100、SL250、または SL500 SL2000 SLX 

CPU スピード 2.0 GHz 2.4 GHz 3.0 GHz 

配置済み 

ハードドライブ  

スペース 

2GB 5GB 20GB 

注記： 極度の I/O 要件のために、SQL サーバーは RAID 1+0 と設定された個別

の物理的サーバーにホストされる必要があります。SQL サーバーのハード ドライブに

は RAID 5 を推奨しません。 

メモリ 3 GB 4 GB 4 GB 

ネットワーク  

インターフェース 

Orion がインストールされている各仮想マシンは独自の専用ネットワーク インター 

フェイス カードを備えている必要があります。 

注記： Orion は SNMP を使用してネットワークを監視しますが、Orion サーバーに

ネットワーク インターフェイス カードを提供できない場合は、通常 SNMP トラフィック

に割り当てられる優先度が低いためデータの監視にギャップを感じる場合があり 

ます。 

その他の必須コンポーネント 

Orion Installation Wizard （インストール ウィザード）は、次の必須の x86 コンポーネントが 

Orion データベース サーバー上に見つからない場合、それらをインストールします。 

 SQL サーバーシステム共通言語ランタイム（CLR）タイプ。Orion 製品では選択された、

非ビジネス用のデータ オペレーションに対して安全な SQL CLR ストアド プロシージャを

使用します。 

 Microsoft SQL Server Native Client 

 Microsoft SQL Server Management Objects 
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サーバーのサイズ 

Orion NPM は、小規模会社の LAN から大企業やサービス プロバイダ ネットワークまで、どの

ような規模のネットワークでも監視できます。ほとんどの Orion NPM システムは、デフォルトの

ポーリング エンジン設定であれば、3 GB RAM を搭載した 3.0 GHz システムで十分に動作

します。ただし、大きめのネットワークを監視する場合は、使用するハードウェアおよびシステム

の設定をさらに考慮する必要があります。 

スケーラビリティに影響を及ぼす主な変数は 3 つあります。最も考慮が必要な変数は、監視

するエレメントの数です。エレメントは、単一かつ識別可能なノード、インターフェース、またはボ

リュームです。1,000 以上のエレメントを監視するシステムには、最適なパフォーマンスに調整

する必要がある場合があります。考慮するべき 2 つ目の変数はポーリングの頻度になります。

たとえば、デフォルトの 9 分ではなく、5 分ごとに統計情報を収集する場合、システムの負荷が

高くなるため、システム要件が増加します。最後は、Orion NPM に同時にアクセスするユー 

ザー数です。これはシステムのパフォーマンスに直接影響します。 

Orion NPM のインストレーションを計画する際には、ポーリング容量に関して留意すべき 4 つ

の主要因があります。それは CPU 、メモリ、ポーリング エンジンの数、ポーリング エンジンの設

定になります。推奨される最小ハードウェア要件については、10 ページの「Orion NPM の要

件」を参照してください。ポーリング エンジンの詳細については、165 ページの「追加ポーリング 

エンジンの使用」を参照してください。 

多くの場合、特に 2,000 以上のエレメントを監視するときには、Orion NPM と SQL Server 

を別々のサーバーにインストールすることを強く推奨しています。パフォーマンスに関する問題が

発生する場合または非常に大きなネットワークのモニタリングを計画している場合は、このオプ

ションを考慮する必要があります。このシナリオでは、Orion NPM サーバーはデータベース処理

を全く行わず、SQL Server ともリソースを共有する必要がないため、いくつかのパフォーマンス

上の利点があります。 

8,000 以上のエレメントを監視する計画があれば、SolarWinds は別のサーバーに追加の 

ポーリング エンジンをインストールし、負荷分散することを推奨します。ご利用のネットワークに

合わせた Orion NPM のサイジングの詳細については、SolarWinds 営業チームにお問い合

わせになるか、www.solarwinds.com をご覧ください。追加のポーリング エンジンの詳細につ

いては、165 ページの「追加ポーリング エンジンの使用」を参照してください。 
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監視されたデバイスの SNMP 要件 

Orion NPM は、ネットワーク上のあらゆる SNMPv1 、SNMPv2c 、SNMPv3 有効デバイス

のパフォーマンスを監視できます。デバイスで SNMPv2c が有効な場合、デフォルトにより、

Orion NPM はデバイスからパフォーマンス情報をポーリングする際に、SNMPv2c の使用を試

みます。Orion NPM に SNMPv1 のみを使用してポーリングさせる場合、ポーリング対象のデ

バイスで SNMPv2c を無効にする必要があります。デバイスの文書を参照するか、デバイス製

造元のテクニカル担当者に問い合わせて、手持ちのデバイスで SNMP を設定する詳細手順

を入手してください。 

注記： 

 Unix ベースのデバイスでは、使用中の Unix ベース オペレーティング システムに合った 

Net-SNMP バージョン 5.5 以降の設定を使用してください。 

 Orion NPM は、VMware Tools がインストールされた VMware ESX および ESXi  

サーバーのバージョン 3.5 以降を監視できます。VMware デバイスで SNMP および 

VMware ツールを有効にする詳細情報については、VMware の文書を参照するか、テ

クニカル担当者にお問い合わせください。 

Microsoft インターネット情報サービス （IIS）の有効化 

Orion ウェブ コンソールをホストするには、Orion サーバーに Microsoft インターネット情報 

サービス（IIS）をインストールし、有効にしている必要があります。次のセクションで説明するよう

に、Windows Server 2003 は IIS バージョン 6 、Windows Server 2008 は IIS バージョ

ン 7 をそれぞれ必要とします。 

 Windows Server 2003 での IIS 有効化 

 Windows Server 2008 での IIS 有効化 

Windows Server 2003 での IIS 有効化 

次の手順に従うと Windows Server 2003 で IIS を有効にできます。 

Windows Server 2003 で IIS を有効にするには次の手順に従います。 

1. Start > Control Panel > Add or Remove Programs （スタート＞コントロール パ

ネル＞プログラムの追加と削除）をクリックします。 

2. Add/Remove Windows Components （ Windows コンポーネントの追加／削

除）をクリックします。 

3. Application Server （アプリケーション サーバー）をクリックし、次に Details （詳細）を

クリックします。 
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4. Internet Information Services (IIS) （インターネット情報サービス（IIS））をクリックし

次に Details （詳細）をクリックします。 

5. World Wide Web Service （WWW サービス）をクリックし、次に Details （詳細）をク

リックします。 

6. World Wide Web Service （WWW サービス）を選択し、OK をクリックします。 

7. Internet Information Services (IIS) （インターネット情報サービス（IIS））ウィンドウで 

OK をクリックし、次に Application Server （アプリケーション サーバー）ウィンドウで OK 

をクリックします。 

8. Management and Monitoring Tools （管理とモニタツール）をクリックし、次に 

Details （詳細）をクリックします。 

9. Simple Network Management Protocol （簡易ネットワーク管理プロトコル

（SNMP））と WMI SNMP Provider （WMI SNMP プロバイダ）の双方が選択されて

いることを確認し、OK をクリックします。 

10. Windows Components （Windows コンポーネント）ウィンドウで Next （次へ）をクリック

して、Windows Components （Windows コンポーネント）ウィザードを終了したら、

Finish （完了）をクリックします。 

注記： 追加コンポーネントのインストール、Windows オペレーティング システム メディアの

挿入、またはコンピュータの再起動を求められる場合があります。サーバーの再移動を求

められたら、指示に従ってください。ただし Orion では Phone Book Service （電話帳 

サービス）を必要としません。 

11. Orion インストレーションの一部として IIS を有効にする場合、Orion インストーラを再実

行します。インストール手順の詳細については、ご利用の Orion 製品の『管理者ガイド 』

を参照してください。 

Windows Server 2008 での IIS 有効化 

次の手順は、Windows Server 2008 で IIS を有効にします。 

Windows Server 2008 で IIS を有効にするには： 

1. Start > All Programs > Administrative Tools > Server Manager （スタート＞

すべてのプログラム＞管理ツール＞サーバー マネージャ）をクリックします。 

2. 左ペインの Roles （役割）をクリックし、次にメイン ペインの Add Roles （役割の追加）

をクリックします。 

3. Next （次へ）をクリックして Add Roles Wizard （役割の追加ウィザード）を開始します。 

4. Web Server (IIS) （Web サーバー（IIS））を確認します。 
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5. ウェブ  サーバー（ IIS）に必要な機能の追加を求められた場合、Add Required 

Features （必要な機能を追加）をクリックします。 

6. Select Server Roles （サーバーの役割の選択）ウィンドウで Next （次へ）をクリックし、

次に Web Server (IIS) （Web サーバー（IIS））ウィンドウで Next （次へ）をクリックします。 

7. Common HTTP Features > Static Content > （HTTP 基本機能 > 静的なコンテ

ンツ）がインストールされていることを確認します。 

8. Application Development > ASP.NET （アプリケーション開発  > ASP.NET）を選

択し、Add Required Role Services （必要な役割サービスを追加）をクリックします。 

9. Security > Windows Authentication （セキュリティ  > Windows 認証）と 

Security > Basic Authentication （セキュリティ > 基本認証）の双方を選択します

。 

10. Management Tools > IIS 6 Management Compatibility （管理ツール > IIS 6 

管理互換）を選択し、Select Role Services （役割サービスの選択）ウィンドウで Next 

（次へ）をクリックします。 

11. Confirm Installation Selections （インストール項目の確認）ウィンドウで Install （イン

ストール）をクリックし、次に Installation Results （インストールの結果）ウィンドウで 

Close （閉じる）をクリックします。 

12. Orion インストレーションの一部として IIS を有効にする場合、Orion インストーラを再実

行します。インストール手順の詳細については、ご利用の Orion 製品の『管理者ガイド 』

を参照してください。 

SSL によるセキュア チャネルの有効化  

Orion は、Orion ウェブ コンソールとのセキュアな通信を確立するため、Secure Sockets 

Layer （SSL 、セキュア ソケット レイヤー）証明書の使用をサポートしています。次のセクション

は、Orion ウェブ コンソールとの SSL 接続を有効にする手順を提供します。 

 Windows Server 2003 での SSL 接続の有効化 

 Windows Server 2008 での SSL 接続の有効化 

 Orion ウェブ コンソールでの SSL 設定 
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Windows Server 2003 での SSL 接続の有効化 

次の手順は、Windows Server 2003 にインストールされた Orion ウェブ コンソールへの 

SSL 接続を有効にします。 

注記： 

 セキュアな SSL 通信は、ポート 443 経由で行われます。 

 次の手順では、必要な証明書の取得方法や第三者証明書機関向けの証明書署名

要求の生成方法について説明していません。ご利用の Orion NPM サーバーに必要な 

SSL 証明書が既にインストールされている必要があります。詳細については、次の手順を

参考にした記事 （http://support.microsoft.com/kb/298805）を参照してください。 

Windows Server 2003 上のウェブ コンソールとの SSL 接続を有効にするには： 

1. 管理者特権を持つアカウントで Orion NPM サーバーにログインします。 

2. Start > Control Panel > Administrative Tools > Computer Management （

スタート > コントロール パネル > 管理ツール > コンピュータの管理）の順でクリックします。 

3. Services and Applications > Internet Information Services (IIS) 

Manager > Web Sites （サービスとアプリケーション  > インターネット インフォメーション 

サービス（ IIS ）マネージャ  > Web サイト）の順で展開します。 

4. SolarWinds NetPerfMon をクリックし、次に Action > Properties （操作 > プロパ

ティ）の順でクリックします。 

5. Web Site （Web サイト）タブを開き、SSL port （SSL ポート）が 443 に設定されてい

ることを確認し、Apply （適用）をクリックします。 

6.  Advanced （詳細設定）をクリックします。 

7.  Multiple SSL identities for this Web site （この Web サイトの複数の SSL ID ）
フィールドに Orion ウェブ コンソールの IP アドレスと SSL ポートの 443 が表示されない
場合には、次の手順を実行します。 

a. Add （追加）をクリックしてから、Orion ウェブ コンソールの IP address （IP アドレ

ス）を選択します。 

注記： Configuration Wizard （設定ウィザード）で初期設定されているように、この

オプションは通常 All Unassigned （未使用の IP アドレスすべて）に設定されてい

ます。Orion ウェブ コンソールの IP アドレスが All Unassigned （未使用の IP アド

レスすべて）に設定されていない場合は、Orion ウェブ コンソールに実際に設定され

た IP アドレスを選択します。 

b. 443 を TCP port （TCP ポート）に入力し、OK をクリックします。 

http://support.microsoft.com/kb/298805
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8. Directory Security （ディレクトリ セキュリティ）タブをクリックします。 

9. Secure communications （セキュリティで保護された通信）セクションの Edit （編集）を

クリックします。 

10. Require secure channel (SSL) （セキュリティで保護されたチャンネル（ SSL ）を要

求する）を選択します。 

11. Client certificates （クライアント証明書）エリアの Accept client certificates （クライ

アント証明書を受諾する）を選択します。 

12. Secure communications （セキュリティで保護された通信）ウィンドウで OK をクリックし

ます。 

13. Apply （適用）をクリックし、OK をクリックして終了します。 

Windows Server 2008 での SSL 接続の有効化 

次の手順は、Windows Server 2008 にインストールされた Orion ウェブ コンソールへの 

SSL 接続を有効にします。 

注記： セキュアな SSL 通信は、ポート 443 経由で行われます。 

Windows Server 2008 上のウェブ コンソールとの SSL 接続を有効にするには： 

1. 管理者特権を持つアカウントで Orion NPM サーバーにログインします。 

2. Start > Administrative Tools > Internet Information Services (IIS) Manager （

スタート  > 管理ツール  > インターネット インフォメーション サービス（IIS）マネージャ）の順でクリ

ックします。 

3. Connections （接続） ペインで、Orion サーバーの名前を展開し、Sites （サイト） を展

開します。 

4. SolarWinds NetPerfMon をクリックし、右側の Action（操作）ペインで Bindings 

（バインド）をクリックします。 

5. Site Bindings （サイト バインド）ウィンドウで Add （追加）をクリックします。 

6. Type （種類）フィールドで https を選択し、Port （ポート）が 443 に設定されていること

を確認します。 

7. SSL Certificate （SSL 証明書）フィールドで証明書を選択し、OK をクリックします。 

8. Site Bindings （サイト バインド）ウィンドウで Close （閉じる）をクリックします。 

9. IIS グループで SSL Settings （SSL 設定） をクリックし、Require SSL （SSL が必

要）を選択します。 
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10.  右側の Actions （操作）グループの Apply （適用）をクリックします。 

11.  Connections （接続）ペインで SolarWinds NetPerfMon をクリックします。 

12. 右側の Manage Web Site （Web サイトの管理）グループで Restart （再起動）をク 

リックします。 

Orion ウェブ コンソールでの SSL 設定 

次の手順は、Orion ウェブ コンソールでセキュア ソケット レイヤー（SSL）のセキュリティ（https）

を有効にします。 

Orion ウェブ コンソールで SSL を有効にするには： 

1. 管理者権限を持つアカウントで Orion サーバーにログインします。 

2. Start > All Programs > SolarWinds Orion > Advanced Features > Orion Service 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > Orion 

サービス マネージャ）の順でクリックします。 

3. Shutdown Everything （すべてシャットダウン）をクリックします。 

注記： すべてのサービスを停止するために数分かかる場合があります。 

4. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データ

ベース マネージャ）の順でクリックします。 

5. 左ペインに Orion データベースが表示されない場合に、次の手順を実行します。 

a. Add SQL Server （ SQL Server の追加）をクリックします。 

b. サーバー / インスタンス の形式で、Orion データベースとして使用している SQL 

Server インスタンスを選択または入力します。 

c. 適切なログイン方法を選択し、必要に応じて資格情報を入力し、Connect to 

Database Server （データベース サーバーに接続）をクリックします。 

6. 左ペインで Orion データベースを展開します。 

7. Websites （ウェブサイト）テーブルを右クリックし、Query Table （テーブルをクエリー）をク

リックします。 

8. デフォルトのクエリーを次のクエリーに置き換えます。 

UPDATE dbo.Websites 

SET SSLEnabled=1 

WHERE WebsiteID=1 
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9. Refresh （更新）をクリックします。 

10. Start > All Programs > SolarWinds Orion > Advanced Features > Orion 

Service Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > 

Orion サービス マネージャ）の順でクリックします。 

11. Start Everything （すべて開始）をクリックします。 

 注記： すべてのサービスを再開するために数分かかる場合があります。 

12. デフォルトの https ポート 443 のようにウェブ コンソールで指定した SSL ポートを使用し
たい場合、次の手順に従ってウェブ コンソール ポートを変更します。 

a. Start > All Programs > SolarWinds Orion > Configuration and Auto-

Discovery > Configuration Wizard （スタート > すべてのプログラム > SolarWinds 

Orion > 設定と自動検出 > 設定ウィザード）の順でクリックします。 

b. Website （ウェブサイト）を選択し、ウェルカム ウィンドウで Next （次へ）をクリックし 

ます。 

c. Port （ポート）フィールドに指定する SSL ポート番号を入力し、Next （次へ）をク 

リックします。 

注記： ポート 443 は通常、SSL トラフィック用に予約されています。 

d. 設定サマリーを確認して、Next （次へ） をクリックします。 

e. Configuration Wizard （設定ウィザード）が完了したら、Finish （完了）をクリックし

ます。 

アンチウイルスのディレクトリ除外 

すべての Orion 製品が全必須ファイルにアクセスできるようにするため、次のオペレーティング シ

ステム別のディレクトリを、アンチウイルス保護から除外してください。 

注記： 

 実行ファイルは除外しないでください。 

 デフォルトのインストール ボリュームは C:\ です。 

Windows Server 2003 および Windows XP ： 

 c:\Documents and Settings\All Users\Application Data\SolarWinds\ 

Windows Server 2007 、Windows Vista 、および Windows 2008 ： 

 c:\ProgramData\SolarWinds\ 
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ライセンス マネージャによるライセンス管理 

SolarWinds ライセンス マネージャは、SolarWinds カスタマー サービスに問い合わせることな

く、1 台のコンピュータから別のコンピュータに Orion ライセンスを簡単に移行できる無料のユー

ティリティです。次のセクションでは、ライセンス マネージャのインストールおよび使用手順を提供

しています。 

 ライセンス マネージャのインストール 

 ライセンス マネージャの使用 

ライセンス マネージャのインストール 

現在ライセンスされた製品の移行元コンピュータにライセンス マネージャをインストールします。 

注記： ライセンス マネージャは、正しいシステム時刻のコンピュータにインストールしなければな

りません。コンピュータのシステム時刻がグリニッジ標準時（GMT）から少しでもずれている場合

に、SolarWinds カスタマー サービスに問い合わせることなくライセンスをリセットできません。タイ

ムゾーン設定は、この問題に影響を与えることも、原因になることもありません。 

ライセンス マネージャのインストールするには： 

1. Start > All Programs > SolarWinds > SolarWinds License Manager Setup （

スタート > すべてのプログラム  > SolarWinds > SolarWinds ライセンス マネージャの設

定）の順でクリックします。 

2. SolarWinds EULA に同意する場合は、I Accept （同意する）をクリックします。 

3. SolarWinds ライセンス  マネージャ アプリケーションのインストールを求められたら、
Install （インストール）をクリックします。 

ライセンス マネージャの使用 

新しいインストレーションにライセンスを移行する前に、現在ライセンスされた SolarWinds 製

品がインストールされているコンピュータでライセンス マネージャを実行する必要があります。下

記の手順は、現在インストールされたライセンスのアクティベーションを解除し、新しいインスト 

レーションに移行できるようにします。 

 現在インストールされたライセンスのアクティベーションを解除するには： 

1. Start > All Programs > SolarWinds > SolarWinds License Manager （ス 

タート > すべてのプログラム  > SolarWinds > SolarWinds ライセンス マネージャ）の順

でクリックします。 
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2. このコンピュータでアクティベーションを解除する製品を選択し、Deactivate （アクティベー

ション解除）をクリックします。 

3.   SolarWinds Customer ID （カスタマー ID ）と password （パスワード）を求められたら、

それを入力し、Deactivate （アクティベーション解除）をクリックします。 

注記： アクティベーションを解除したライセンスは、新しいコンピュータでアクティベーションを

行うことができます。 

製品のアクティベーションを解除したら、製品のインストール先となるコンピュータにログインし、イ

ンストール手順を開始します。ライセンスの指定を求められたら、適切な情報を提供します。

前にアクティベーションを解除したライセンスが、新しいインストレーションに割り当てられます。 

Orion Network Performance Monitor 

Orion NPM のインストールまたはアップグレードには、次のセクションで説明されるように、イン

ストーラと Configuration Wizard （設定ウィザード）の双方を使用します。 

注記： Orion 製品のダウングレードはサポートされていません。複数の Orion 製品のアップグ

レードまたはインストールを行う場合、 SolarWinds カスタマー ポータル にあるアップグレード手

順で指定している順序でインストールしてください。 

 Orion NPM のインストール手順 

 Orion Configuration Wizard （設定ウィザード）の完了 

Orion NPM のインストール手順 

Orion NPM のインストールを開始する前に、Orion NPM のインストール先サーバーが現在

求められる要件を満たしていることを確認してください。詳細については、10 ページの「Orion 

NPM の要件」を参照してください。 

注記： 

 SolarWinds は、アップグレードを実行する前に、データベースをバックアップすることを推

奨しています。詳細については、388 ページの「データベース バックアップの作成」を参照し

てください。 

 Orion Network Performance Monitor の古いバージョンからアップグレードする場合は、

30 ページの「Orion Network Performance Monitor」を参照してください。 

 Internet Explorer を使用する場合、SolarWinds は、Orion ウェブサイトの URL  

(http://FullOrionServerName/)、SolarWinds サポートの URL  

(http://support.solarwinds.com)、および about:blank を信頼済みサイトの

リストに追加することを推奨します。信頼済みサイのリストにサイトを追加する詳細につい

http://www.solarwinds.com/customerportal/
http://fullorionservername/
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ては、Microsoft の記事「Working with Internet Explorer 6 Security Settings 」を

参照してください。 

 Orion NPM を Windows 7、Windows XP、または Windows Vista 上にインストール

できるのは評価目的の場合のみとなります。ただし、SolarWinds は、生産環境でのこれ

らのオペレーティング システム上に Orion NPM をインストールすることをサポートも推奨も

していません。 

 Orion NPM を Windows XP 上にインストールする場合、リモート データベースで共有

メモリ、名前付きパイプ、および TCP/IP が有効になっていることを確認してください。 

 Orion NPM を Windows Server 2008、Windows Vista、または Windows 7 上に

インストールする場合、Internet Information Services （IIS）で IPv6 サポートを無効

にする必要があります。詳細については、 http://support.microsoft.com/kb/929852/ 

を参照してください。 

 権限の問題が発生するのを避けるため、Orion NPM をドメイン コントローラ上にインス 

トールしないでください。 

次の手順は Orion NPM をインストールします。 

Orion Network Performance Monitor ： 

1. 管理者として、Orion NPM サーバーにログインします。 

2. ネットワーク情報の収集に 2 つ以上のポーリング エンジンを使用する場合、作業を続け
る前に各ポーリング エンジンをシャットダウンしてください。 

3.  本製品を SolarWinds のウェブサイトからダウンロードした場合、ダウンロード先に移動
し、実行ファイルを起動します。 

4. 物理メディアを入手した場合は、実行ファイルに移動して起動します。 

5. 要件をインストールするように求められたら、Install （インストール）をクリックして、インス 

トールを完了させ、必要に応じて再起動を行います。 

 注記： 

 既存のシステム構成によっては、Microsoft.NET Framework 3.5 SP1 のダウン 

ロードとインストールに、20 分以上かかる場合もあります。 

 再起動が必要な場合、再起動後に Install （インストール）をクリックしてインストー

ルを続行し、ウェルカム ウィンドウで Next （次へ）をクリックします。 

6. Welcome （ウェルカム）テキストを確認し、Next （次へ）をクリックします。 

http://www.microsoft.com/windows/ie/ie6/using/howto/security/settings.mspx
http://support.microsoft.com/kb/929852/


SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 SolarWinds Orion Network Performance Monitor のインストール  25 

7. Orion Network Performance Monitor の Setup Wizard （セットアップ ウィザー
ド）が、Microsoft インターネット情報サービス（IIS）がインストールされていないことを検
出した場合、Suspend installation to manually install IIS （インストールを中断

して手動で IIS をインストールする）を選択し、Finish （完了）をクリックしてセットアップを

終了し、IIS をインストールします。 

注記： 

 Orion ウェブ コンソールでは、Orion NPM サーバーに Microsoft IIS がインストール

する必要があります。この時点で IIS をインストールしない場合、後で IIS をインス 

トールし、Orion ウェブ コンソールが使用するウェブサイトを設定しなければなりません。 

 ブラウザ ウィンドウが自動的に開き、SolarWinds ナレッジベースの記事「Enabling 

IIS: What IIS components does Orion NPM require?」が表示される場合もあ

ります。この記事は、Windows Server 2003、Windows Server 2008、

Windows XP、Windows Vista、および Windows 7 上で IIS を有効にする手順

を示します。 

8. IIS のインストールが必要な場合、インストーラを再び起動し、ウェルカム ウィンドウで 

Next （次へ）をクリックします。 

注記： IIS のインストール後に、サーバーの再起動が必要な場合もあります。 

9.  InstallShield ウィザードが、Microsoft SQL Server CLR Types 、Native 

Client 、または Management Objects がインストールされていないことを検出した場
合は、Install （インストール）をクリックします。 

10.  ライセンス契約の条件に同意し、Next （次へ）をクリックします。 

11. Orion NPM をデフォルトのフォルダとは別のフォルダにインストールしたい場合、Browse 

（参照）をクリックしてインストール先フォルダを指定し、OK をクリックします。 

12. Choose Destination Location （インストール先の選択）ウィンドウで Next （次へ）をク

リックします。 

13. 現在のインストール設定を確認し、Start Copying Files （ファイル コピーの開始）ウィンド

ウで Next （次へ）をクリックします。 

14. Orion Network Performance Monitor Setup Wizard （セットアップウィザード）が終

了したら、Finish （完了）をクリックします。 

15. Orion NPM を評価する場合は、Continue Evaluation （評価を続ける）をクリックし

ます。 

http://knowledgebase.solarwinds.com/kb/questions/1309/
http://knowledgebase.solarwinds.com/kb/questions/1309/
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16. Orion NPM のプロダクション バージョンをインストールする場合、Enter Licensing 

Information （ライセンス情報の入力）をクリックし、次の手順に従って Orion NPM イン

ストレーションをライセンスします。 

a. アクティベーション キーをお持ちでインターネットへのアクセスがある場合は、最初のオ
プションの I have internet access and an activation key… （インターネッ 

ト アクセスとアクティベーション キーがあります）を選択し、Activation Key （アクティ

ベーション キー）を入力して、Next （次へ）をクリックします。 

注記： プロキシ サーバー経由でインターネットにアクセスしている場合、I access 

the internet through a proxy server （プロキシ サーバー経由でインターネット

にアクセスする）を選択し、Proxy address （プロキシ アドレス）と Port （ポート）を

入力します。 

b. Orion NPM サーバーからインターネットへのアクセスがない場合は、This server 

does not have internet access… （このサーバーはインターネット アクセスがな

い）を選択し、Next （次へ）をクリックして指示される手順に従います。 

Orion Configuration Wizard （設定ウィザード）が自動的にロードされます。Orion 

Configuration Wizard （設定ウィザード）を完了する詳細については、26 ページの「Orion 

Configuration Wizard （設定ウィザード）の完了 」を参照してください。 

Orion Configuration Wizard （設定ウィザード）の完了 

下記の手順は、Orion Configuration Wizard （設定ウィザード）を完了し、Orion NPM イ

ンストレーションの設定を行います。 

注記： 

 Orion NPM 用に SQL Server データベースのインスタンスを指定したことを確認してくだ

さい。詳細については、10 ページの「Orion NPM の要件」を参照してください。 

 Configuration Wizard （設定ウ ィザード ） を実行中に、 Internet Information 

Services （IIS） Manager が開いていないことを確認してください。 

 SolarWinds は、Configuration Wizard （設定ウィザード）を開始する前に、ウェブ コン

ソールで開いているすべてのセッションを閉じることを推奨します。 

 設定時に Orion ポーリング エンジンが一時的にシャットダウンするため、実際にポーリング

中の場合は、一部のポーリング データを失う可能性があります。SolarWinds は、一時

的なポーリング停止の影響を最小限に抑えるため、ネットワーク使用のオフピーク時間帯

にアップグレードを実施することを推奨します。 
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Orion Network Performance Monitor ： 

1. Configuration Wizard （設定ウィザード）が自動的にロードされない場合は、Start > 

All Programs > SolarWinds Orion > Configuration and Auto-Discovery > 

Configuration Wizard （スタート  > すべてのプログラム  > SolarWinds Orion > 設

定と自動ディスカバリ  > 設定ウィザード）の順でクリックします。 

2. Configuration Wizard （設定ウィザード）の Welcome （ウェルカム）ダイアログで、Next 

（次へ）をクリックします。 

3. サービスを停止するように求められたら、Yes （はい）をクリックします。 

注記： すべてのアップデートおよび変更が正しくインストールされるようにするため、すべての

サービスを必ず停止してください。 

4. ネットワーク データの保存先となる SQL Server インスタンスを指定します。 

注記： 

 SQL Express を使用する場合、インスタンスを （local） （ローカル）と指定し、
「強い」パスワードを使用します。強いパスワードを使用した認証の詳細については、 

http://msdn.microsoft.com/ms143705.aspx を参照してください。固有の制限

があるため、SolarWinds は本番環境における SQL Express の使用を推奨しま

せん。 

 選択したインスタンスは、混合モードまたは強いパスワードを使用した SQL 認証をサ

ポートする必要があります。強いパスワードは、次の 4 つの条件のうち、少なくとも 3 

つを満たす必要があります。 

o 1 つ以上の大文字を含む。 

o 1 つ以上の小文字を含む。 

o 1 つ以上の数字を含む。 

o 1 つ以上の英数字以外の文字（例： # 、% 、または ^ ）を含む。 

強いパスワードを使用した認証の詳細については、 

http://msdn.microsoft.com/ms143705.aspx を参照してください。 

5. 必要に応じて資格情報を入力し、選択したインスタンスにログインします。 

注記： 

 一般に、Orion NPM サーバーが常に SQL Server にアクセスできるようにするため

（たとえ遠隔の別のサーバーにホストされている場合でも）、SolarWinds は SQL 

Server Authentication （SQL Server 認証）を使用することを推奨します。 

 既存のデータベースを作成する場合、ユーザー アカウントは既存データベースの 

db_owner データベース ロールのみに属する必要があります。 

http://msdn.microsoft.com/ms143705.aspx
http://msdn.microsoft.com/ms143705.aspx
http://msdn.microsoft.com/ms143705.aspx
http://msdn.microsoft.com/ms143705.aspx
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 既存の SQL アカウントを使用する場合、ユーザー アカウントは Orion NPM データ

ベースの db_owner データベース ロールのみに属する必要があります。 

 新しいデータベースを作成する場合、ユーザー アカウントは dbcreator サーバー 

ロールのメンバーでなければなりません。sysadmin サーバー ロールおよび sa ユー 

ザー アカウントは、常に dbcreator のメンバーになります。 

 Orion NPM で使用する新しい SQL アカウントを作成する場合、ユーザー アカウン

トは securityadmin サーバー ロールのメンバーでなければなりません。 

注記： sysadmin サーバー  ロールおよび sa ユーザー  アカウントは、常に 

securityadmin のメンバーになります。 

6. Next （次へ）をクリックします。 

7. 新しいデータベースを作成する場合、Create a new database （新しいデータベースの

作成）を選択し、名前をつけて、Next （次へ）をクリックします。 

注記： SolarWinds は、データベースの名前に英数字以外の文字を使用することを推

奨しません。 

8. 既存のデータベースを使用する場合、Use an existing database （既存のデータベー

スを使用）を選択し、データベース名を入力するかリストから選択して、Next （次へ）をク 

リックします。 

9. Orion NPM ポーリング エンジンとウェブ コンソール用にデータベースにアクセスするための
新しい SQL アカウントを作成する場合は、Create a new account （新しいアカウント

の作成）を選択し、アカウント名とパスワードを入力して、Next （次へ）をクリックします。 

10. Orion NPM ポーリング エンジンとウェブ コンソール用のデータベースにアクセスするための
既存の SQL アカウントを使用する場合は、既存のアカウントを選択し、適切なパスワー
ドを入力して Next （次へ）をクリックします。 

11. Orion NPM ウェブ コンソール用に特定の IP アドレスを指定する場合、ホスト ウェブ  

サーバーの IP address （IP アドレス）を入力します。 

注記： SolarWinds は、ご利用の環境で Orion ウェブ コンソールに特定の IP アドレスを

使用しなければならない場合を除き、デフォルトの All Unassigned （未使用の IP アド

レスすべて）を選択することを推奨します。 

12. ウェブ コンソールへのアクセスに使用する Port （ポート）とウェブ コンソール ファイルのインス

トール先となる Website Root Directory （ウェブサイト ルート ディレクトリ）を指定し 

ます。 

注記： 80 以外のポートを指定する場合、ウェブ コンソールにアクセスするときに使用する 

URL にそのポートを含めなければなりません。たとえば、192.168.0.3 の IP アドレスと 

8080 のポートを指定する場合、ウェブ  コンソールにアクセスするための  URL は 

http://192.168.0.3:8080 になります。 
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13. Windows 認証を使用した自動ログインを有効にするには、Yes – Enable 

automatic logiin using Windows Authentication （はい - Windows 認証によ

る自動ログインを有効にする）を選択します。 

注記： 自動ログインが有効または無効になっているかにかかわらず、Windows 認証を使

用した手動ログインはいつでも利用できます。 

14. Next （次へ）をクリックします。 

15. 新しいディレクトリを作成するように求められたら、Yes （はい）をクリックします。 

16. 新しいウェブサイトを作成するように求められたら、Yes （はい）をクリックします。 

注記： 既存のウェブサイトを上書きしても、以前に適用したカスタムの Orion NPM ウェブ

サイト設定は削除されません。 

17. インストールするすべてのサービスが選択されていることを確認します。 

注記： 通常は、表示されるすべてのサービスをインストールします。 

18. Next （次へ）をクリックします。 

19. 設定項目の最終確認を行い、Next （次へ）をクリックします。 

20. Completing the Orion Configuration Wizard （Orion 設定ウィザードの完了）ダイア

ログで Next （次へ）をクリックします。 

21. Orion Configuration Wizard （Orion 設定ウィザード）が完了したら、Finish （完了） 

をクリックします。 

22. 管理者として Orion ウェブ コンソールにログインします。 

注記： 

 デフォルトでは、アカウントを変更するまでは、Admin のユーザー名とパスワードなしで

ログインできます。 

 Toolset integration （SWToolset.exe ）のインストールを求められたら、More 

Options （その他のオプション）をクリックし、オプションを選択して、必要に応じて 

Install （インストール）または Don’t Install （インストールしない）を選択します。詳

細については、216 ページの「SolarWinds エンジニア ツールセットの統合」を参照し

てください。 

23. ネットワーク デバイスのディスカバリをせずに Orion データベースに追加すると、Network 

Discovery Wizard （ネットワーク ディスカバリ ウィザード）が開始します。詳細については、

35 ページの「ネットワーク デバイスのディスカバリと追加 」を参照してください。 



 管理者ガイド  SolarWinds Orion Network Performance Monitor 

 

 

30  SolarWinds Orion Network Performance Monitor のインストール 

Orion Network Performance Monitor 

以前のバージョンの Orion NPM からアップグレードする場合や、ライセンスされた監視可能な

エレメント数をアップグレードする場合は、次の手順を実行します。 

注記： 
 SolarWinds は、アップグレードを実行する前に、データベースをバックアップすることを推

奨します。データベースのバックアップ作成の詳細については、388 ページの「データベース 

バックアップの作成」を参照してください。 

 SolarWinds は、データベースのバックアップ作成後にウェブ コンソールの設定をバックアッ

プすることを推奨します。詳細については、220 ページの「Orion ウェブ コンソール設定の

管理」を参照してください。 

 Orion NPM の古いバージョンのディスカバリ プロファイルは、アップグレードを通じて保持さ

れません。ディスカバリ プロファイルを保持したい場合は、アップグレードの開始前に保持す

るプロファイル設定を外部に記録します。 

 アップグレード時に、Orion ポーリング エンジンが一時的にシャットダウンするため、一部の

ポーリング データが失われる可能性があります。SolarWinds は、一時的なポーリング停

止の影響を最小限に抑えるため、ネットワーク使用のオフピーク時間帯にアップグレードを

実施することを推奨します。 

 現在インストールされている Orion NPM のバージョンが 7.8.5 より古い場合、バージョン 

7.8.5 にアップグレードしなければなりません。 

 現在インストールされている Orion NPM のバージョンが 7.8.5 ～ 8.5 の場合、バージョ
ン 8.5.1 にアップグレードしなければなりません。 

 現在インストールされている Orion NPM のバージョンが 8.5.1 の場合、バージョン 9.1 

にアップグレードしてください。 

 現在インストールされている Orion NPM のバージョンが 9.0 ～ 9.5.1 の場合、最新バ
ージョンにアップグレードする前に、バージョン 10.0 にアップグレードしなければなりません。 

特定のアップグレード手順は、SolarWinds カスタマー ポータルで入手できます。Orion NPM の 

アップグレードの詳細については、Orion モジュールを含むOrion NPM インストレーションをアップグ 

レードする場合、 SolarWinds カスタマー ポータル （www.solarwinds.com/customerportal/）に

ログインし、License Management （ライセンス管理）をクリックして、該当する Orion 製品のラ

イセンスリストから Upgrade Instructions （アップグレード手順）をクリックします。 

http://www.solarwinds.com/customerportal/
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次の手順は、Orion NPM のアップグレードを行います。 

Orion Network Performance Monitor ： 

1. ネットワーク情報の収集に 2 つ以上のポーリング エンジンを使用する場合、作業を続け
る前に各ポーリング エンジンをシャットダウンしてください。 

2. ローカルの管理者アカウントを使用して、Orion Network Performance Monitor をアッ

プグレードするコンピュータにログインします。 

3. 本製品を SolarWinds のウェブサイトからダウンロードした場合、ダウンロード先に移動し、
実行ファイルを起動します。 

4. Welcome （ウェルカム）テキストを確認し、Next （次へ）をクリックします。 

5. Orion Network Performance Monitor は自動的に以前のインストレーションを検出し

ます。現在のインストレーションのアップグレードを求められたら、Next （次へ）をクリックし 

ます。 

注記： ウェブ コンソールの設定を含むすべてのカスタマイズが維持されます。 

6. ライセンス契約の条件に同意し、Next （次へ）をクリックします。 

7. 現在のインストール設定を確認し、Start Copying Files （ファイル コピーの開始）ウィンド

ウで Next （次へ）をクリックします。 

8. Install Software License Key （ソフトウェア ライセンス キーのインストール）ウィンドウで

必須情報を入力します。 

注記： キーを正常にインストールするには、カスタマー ID とパスワードが必要になります。

詳細については、419 ページの「ソフトウェアのライセンス キー」を参照してください。 

9. Continue （続行する）をクリックし、ライセンスがインストールされたら再び Continue 

（続行する）をクリックします。 

10. Upgrade Reminder （アップグレードのリマインダー）を確認して、Next （次へ）をクリック

します。 

11. InstallShield Wizard Complete （ InstallShield ウィザードの完了）ウィンドウで 

Finish （完了）をクリックします。 

12. Configuration Wizard （設定ウィザード）を完了します。詳細については、26 ページの

「Orion Configuration Wizard （設定ウィザード）の完了」を参照してください。 

評価ライセンスのアップグレード 

標準の Orion NPM 評価期間は 30 日間です。この期間の終わりに、Orion NPM ライセン

スを購入するか、既にご購入になった Orion NPM ライセンスの情報を入力するように求めら
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れます。評価期間のどの時点でも、Orion NPM ライセンスをご購入になった場合、次の手順

で示すように、評価ライセンスをアップグレードできます。 

Orion NPM 評価ライセンスをアップグレードするには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

Network Performance Monitor Licensing （スタート  > すべてのプログラム   > 

SolarWinds Orion > Network Performance Monitor > Network Performance 

Monitor ライセンス）の順でクリックします。 

2. Enter Licensing Information （ライセンス情報の入力）をクリックします。 

3. Orion NPM をインストールしたコンピュータがインターネットに接続されている場合は、次
の手順を実行します。 

a. I have internet access... （インターネット アクセスとアクティベーション キーがあり

ます）を選択します。 

b. http://www.solarwinds.com/customerportal/ にアクセスし、SolarWinds カスタ

マー ID とパスワードを使用してログインします。 

注記： SolarWinds カスタマー ID とパスワードを知らない場合、かつ保守期間外で

ある場合は、SolarWinds 保守更新チーム（maintenance@solarwinds.com）ま

でお問い合わせください。SolarWinds カスタマー ID とパスワードを知らない場合、

かつ保守期間内であれば、カスタマー サービス チケットを 

www.solarwinds.com/support/ticket/ で提出してください。 

c. License Management （ライセンス管理）をクリックします。 

d. Orion Network Performance Monitor を参照し、Unregistered Licenses （未

登録ライセンス）リストを見つけます。 

e. 未登録の Orion NPM アクティベーション キーをクリップボードにコピーし、Activate 

NPM （ NPM のアクティベーション）ウィンドウの Activation Key （キーのアクティ 

ベーション）フィールドに貼り付けます。 

f. プロキシ サーバー経由でインターネットにアクセスしている場合、I access the 

internet through a proxy server （プロキシ サーバー経由でインターネットにア

クセスする）を選択し、プロキシ アドレスとポート番号を入力します。 

g. Next （次へ）をクリックします。 

4.    Orion NPM をインストールするコンピュータがインターネットに接続されていない場合は、
次の手順を実行します。 

http://www.solarwinds.com/customerportal/
mailto:maintenance@solarwinds.com
http://www.solarwinds.com/support/ticket/
http://www.solarwinds.com/support/ticket/
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a. This server does not have internet access （このサーバーはインターネットに

アクセスしていない） を選択し、Next （次へ）をクリックします。 

b. Activate Product （製品のアクティベーション）ウィンドウで、Copy Unique 

Machine ID （固有マシン ID のコピー）をクリックします。 

c. コピーしたデータをテキスト エディタの新しいドキュメントにコピーし、テキスト文書として

保存します。 

d. この文書をインターネット アクセスがあるコンピュータに移します。 

e. インターネット アクセスがあるコンピュータから 

http://www.solarwinds.com/customerportal/ にアクセスします。 

f. SolarWinds カスタマー ID とパスワードを使用してログインします。 

注記： SolarWinds カスタマー ID とパスワードを知らない場合、かつ保守期間外で

ある場合は、SolarWinds 保守更新チーム（maintenance@solarwinds.com）ま

でお問い合わせください。SolarWinds カスタマー ID とパスワードを知らない場合、

かつ保守期間内であれば、カスタマー サービス チケットを 

www.solarwinds.com/support/ticket/ で提出してください。 

g. License Management （ライセンス管理）をクリックします。 

h. Orion Network Performance Monitor にアクセスし、Manually Register 

License （ライセンスの手動登録）をクリックします。 

i. 上記の手順 3 でコピーした Unique Machine ID （固有マシン ID）を入力し、ライ

センス キーをダウンロードします。 

j. ライセンス キーを共有の場所に移し、インターネット アクセスがないサーバー上で、

Activate Product （製品のアクティベーション）ウィンドウから共有されるライセンス  

キー ファイルの保存先を参照します。 

 

  

 

 

 

 

http://www.solarwinds.com/customerportal/
http://www.solarwinds.com/customerportal/
mailto:maintenance@solarwinds.com
http://www.solarwinds.com/support/ticket/
http://www.solarwinds.com/support/ticket/
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第 3章 

ネットワーク デバイスのディスカバリと追加 

Orion 製品は、監視オブジェクトのディスカバリに、Network Sonar Discovery およびイン 

ポート機能、あるいは Orion ウェブ コンソールの Node Management （ノード管理）のいずれ

かを使用します。推奨される方法は、追加するデバイスの数によって大きく異なります。 

 企業全体にわたる多数のデバイスのディスカバリおよび追加を行える、Network Sonar と 

Network Sonar Results Wizards （Network Sonar 結果ウィザード）が用意されてい

ます。詳細については、36 ページの「Network Sonar ウィザードを使用したネットワーク 

ディスカバリ 」を参照してください。 

 ウェブ コンソールは、監視用に個々のオブジェクトのディスカバリと追加を簡単に行えるよう

ウェブノード管理を提供しています。詳細については、223 ページの「ウェブ コンソールのデ

バイスの管理  –  コア」を参照してください。 

Orion データベースにノードを追加する方法に、Web Node Management （ウェブ ノード管

理）と Network Sonar Discovery の 2 つの方法があります。推奨される方法は、追加する

デバイス数によって大きく異なります。企業全体にわたる多数のデバイスのディスカバリおよび追

加を行える、Network Sonar と Network Sonar Results Wizards （Network Sonar 結

果ウィザード）が用意されています。この章では、Orion NPM で監視および管理したいネット 

ワーク オブジェクトを Orion NPM データベースにすばやく投入する方法について示します。

Orion ウェブ コンソールは、個々のネットワーク オブジェクトをディスカバリおよび追加するのに適

した使いやすい Web Node Management （ウェブ ノード管理）ウィザードも提供しています。

詳細については、55 ページの「ウェブ コンソールでのデバイス監視 」を参照してください。 

Discovery Central （ディスカバリ セントラル） 

Discovery Central （ディスカバリ セントラル）では、現在インストールされている Orion 製品

で監視しているネットワーク オブジェクトのタイプと数を集約した概要を提供します。Discovery 

Central （ディスカバリ セントラル）ビューは、インストールされた Orion 製品に合わせて、セクシ

ョン別に細分化されています。Network Discovery （ネットワーク ディスカバリ）セクションは、す

べてのノード ベースの Orion 製品を表示します。Network Discovery （ネットワーク ディスカ

バリ）の詳細については、36ページの「Network Discovery （ネットワーク ディスカバリ） 」を参

照してください。特定のセクションの詳細については、該当する Orion 製品の『管理者ガイド 』

を参照してください。 

Go to Orion Home （Orion ホームに移動する）をクリックすると、監視されているネットワーク

全体の Orion Summary Home （Orion サマリー ホーム）ビューが開きます。 
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Network Discovery （ネットワーク ディスカバリ） 

Network Discovery （ネットワーク ディスカバリ）リソースは、現在監視されているノードとボ 

リュームの数を提供します。この情報は、インストールされているすべての Orion 製品で利用で

き、また同製品を対象にしています。 

Network Sonar Discovery を起動するには、Network Sonar Discovery をクリックしま

す。詳細については、35 ページの「ネットワーク デバイスのディスカバリと追加 」を参照してくだ 

さい。 

Add a Single Device （単一デバイスの追加）をクリックすると、Orion Node Management  

（ノード管理）ユーティリティの Add Node – Define Node （ノードの追加 - ノードの定義）ビューが

開きます。詳細については、223 ページの「ウェブ コンソールのデバイスの管理  –  コア」を参照

してください。 

Interface Discovery （インターフェース ディスカバリ） 

Interface Discovery （インターフェース ディスカバリ）セクションは、ネットワーク トラフィックを監

視できるインターフェースの数を提供します。ネットワーク上のインターフェースをディスカバリする

には、親ノードをディスカバリまたは追加します。Orion は自動的に指定した親ノードのすべて

のインターフェースをディスカバリします。この情報は、Orion Network Performance Monitor 

（Orion NPM ）とインストールされたすべての Orion NPM モジュールで利用が可能で、同製

品とモジュールを対象にしています。 

Network Sonar Discovery を起動するには、Network Sonar Discovery をクリックしま

す。詳細については、36 ページの「Network Sonar ウィザードを使用したネットワーク ディスカ

バリ」を参照してください。 

Network Sonar ウィザードを使用したネットワーク ディスカバリ 

Orion 製品は、ネットワーク上のデバイスをディスカバリする使いやすい Network Sonar ウィ 

ザードを採用しています。Network Sonar ウィザードを使用する前に、Orion NPM のネット 

ワーク ディスカバリについて、次の点を検討してください。 

 Network Sonar ウィザードは、Orion データベースに既に存在するネットワーク デバイス

を認識するため、重複したデバイスをインポートできないようになっています。 

 Windows、Cisco Systems、VMware、および Foundry Networks の各種デバイスに

対して、CPU and Memory Utilization （CPU とメモリ利用率）チャートが自動的に有

効になります。 

 Network Sonar ウィザードで設定するコミュニティ ストリングは SNMP GET 要求のみに

使用されるため、読み取り専用のストリングで十分です。 
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 Network Sonar Results Wizard （Network Sonar 結果ウィザード）の Interfaces 

（インターフェース）ページでは、監視するインターフェースを選択できます。 

次の手順では、Network Sonar ウィザードを使用してネットワーク上のデバイスのディスカバリ

方法を示します。 

ネットワーク デバイスをディスカバリするには： 

1. Network Sonar ウィザードがまだ開いていない場合は、Start > All Programs > 

SolarWinds Orion > Configuration and Auto-Discovery > Network Discovery 

（スタート > すべてのプログラム  > SolarWinds Orion > 設定と自動ディスカバリ  > ネッ

トワーク ディスカバリ）の順でクリックします。 

2. 新しいディスカバリを作成する場合、Add New Discovery （新しいディスカバリの追加）

をクリックします。  

3. 既に定義されたネットワーク  ディスカバリがある場合、Network Sonar Discovery 

（Network Sonar ディスカバリ）タブにいくつかのオプションが用意されています。次のいず

れか 1 つを選択します。 

 使用する前に既存のディスカバリを編集する場合、編集するディスカバリを選択して 

Edit （編集）をクリックします。 

 既存のディスカバリを使用してネットワークの再ディスカバリを行う場合、使用するディ
スカバリを選択し、Discover Now （今すぐディスカバリ）をクリックして、ディスカバリが

完了したら、Network Sonar Results Wizard （Network Sonar 結果ウィザード）

を完了します。詳細については、43 ページの「Network Sonar Results Wizard 

（Network Sonar 結果ウィザード）の使用」を参照してください。 

 定義されたディスカバリで発見し、まだ監視対象としてインポートしていない一部また
はすべてのデバイスをインポートする場合、定義したディスカバリを選択し、Import 

All Results （すべての結果をインポート）をクリックします。詳細については、43 ペー

ジの「Network Sonar Results Wizard （Network Sonar 結果ウィザード）の使

用」を参照してください。 

 定義済みディスカバリ プロファイルに一致する新しい有効デバイスをインポートする場
合、現在の定義済みディスカバリを選択し、Import New Results （新しい結果の

インポート）をクリックします。ネットワーク ディスカバリ結果の詳細については、43 ペー

ジの「Network Sonar Results Wizard （Network Sonar 結果ウィザード）の使

用」を参照してください。 

 既存のディスカバリ プロファイルを削除する場合、現在定義されたディスカバリを選択
し、Delete （削除）をクリックします。 
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4. ネットワーク デバイスが、Orion NPM によって提供される public と private のデ 

フォルト  ストリング以外のコミュニティ  ストリングを必要としない場合、SNMP 

Credentials （ SNMP 資格証明）ビューの Next （次へ）をクリックします。 

5. ネットワーク デバイスが public と private 以外のコミュニティ ストリングを必要とする
場合、または  SNMPv3 資格情報を使用したい場合、次の手順に従って必要な 

SNMP 資格情報を追加します。 

注記： 新しいコミュニティ ストリングごとに、次の手順を繰り返します。ディスカバリ時間を

短縮するには、ネットワークで最も多く使用されるコミュニティ ストリングをハイライトし、矢

印を使ってリストの一番上に移動します。 

a. Add New Credential （新規資格証明の追加）をクリックし、新規資格証明の 

SNMP Version （SNMP バージョン）を選択します。 

b. SNMPv1 または  SNMPv2c 資格証明を追加する場合、新しい  SNMP 

Community String （SNMP コミュニティ ストリング）を入力します。 

c. SNMPv3 資格証明を追加する場合、次のフィールドに入力します。 

 User Name （ユーザー名）、Context （コンテキスト）、および 

Authentication Method （認証方法） 

 必要に応じて、Authentication Password/Key （認証パスワード / キー）、

Privacy/Encryption Method （プライバシー  / 暗号化方式）、および 

Password/Key （パスワード / キー）。 

d. Add （追加）をクリックします。 

6. SNMP Credentials （SNMP 資格証明）ビューの Next （次へ）をクリックします。 

7. ネットワーク上の VMware VCenter または ESX サーバーをディスカバリする場合、Poll 

for VMware （VMware のポーリング）が選択されていることを確認し、次の手順に従っ

て必要な VMware 資格証明の追加または編集を行います。 

注記： 新規資格証明ごとに、次の手順を繰り返します。ディスカバリ時間を短縮するには、

ネットワークで最も多く使用される資格証明を、矢印を使ってリストの一番上に移動し 

ます。 
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a. Add vCenter or ESX Credential （vCenter または ESX 資格証明の追加）を

クリックします。 

b. 既存の VMware 資格証明を使用する場合、Choose Credential （資格証明

の選択）ドロップダウン メニューから適切な資格証明を選択します。 

c. 新しい VMware 資格証明を追加する場合、Choose Credential （資格証明の
選択）ドロップダウン メニューから <New Credential> （新規資格証明）を選択し、

Credential Name （資格証明名）フィールドに新規資格証明の名前を入力し 

ます。 

注記： SolarWinds は、VMware 資格認証名に英数字以外の文字を使用するこ

とを推奨しません。 

d.  必要に応じて、資格証明の User Name （ユーザー名）と Password （パスワード）

を追加または編集します。 

e. 確認のためにパスワードを再入力し、Add （追加）をクリックします。 

8. Local vCenter or ESX Credentials for VMware （VMware 用のローカル vCenter 

または ESX 資格証明）ビューで、Next （次へ）をクリックします。 

9. 特定の IP アドレス範囲にあるネットワーク デバイスのディスカバリを行う場合、次の手順を
実行します。 

注記： 定義済みディスカバリ 1 つにつき、選択方法を 1 つのみ使用できます。 

a. Selection Method （選択方法）メニューの IP Ranges （IP 範囲）をクリックし、各 

IP 範囲に対して Start address （開始アドレス）と End address （終了アドレス

）を入力します。 

注記： 予定ディスカバリ プロファイルには、動的に IP アドレスを割り当てられた

（DHCP）ノードを含む IP アドレス範囲を使用しないでください。 

b. 別の範囲を追加する場合、Add More （更に追加）をクリックし、前の手順を繰り

返します。 

注記： 複数の範囲がある場合に、間違った範囲を削除するには、X をクリックします。 

c.  ポーリングする IP 範囲をすべて追加したら、Next （次へ）をクリックします。 
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10. 特定のルータまたはネットワークの特定のサブネットに接続されたデバイスのディスカバリを
行う場合、次の手順を実行します。 

注記： 定義済みディスカバリ 1 つにつき、選択方法を 1 つのみ使用できます。 

a.  Selection Method （選択方法）メニューの Subnets （サブネット）をクリックします。 

b. 特定のサブネットでディスカバリを行う場合、Add a New Subnet （新しいサブネッ

トの追加）をクリックし、サブネットの Subnet Address （サブネット アドレス）と 

Subnet Mask （サブネット マスク）を入力して、Add （追加）をクリックします。 

注記： ポーリングする追加のサブネットごとに、この手順を繰り返します。 

c. シード ルータを使用してデバイスのディスカバリを行う場合、Add a Seed Router 

（シード ルータの追加）をクリックし、Router （ルータ）の IP アドレスを入力して、

Add （追加）をクリックします。 

注記： 

 使用する追加のシード ルータごとに、この手順を繰り返します。 

 Network Sonar は、指定したルータのルーティング テーブルを読み込み、シード 

ルータを含むクラス A ネットワーク（255.0.0.0 マスク）上のノードのディスカバリを、

また Orion NPM インストレーションのデバイスのディスカバリを行う場合には、 

シード  ルータのすべてのインターフェースを含むクラス  C ネットワーク

（255.255.255.0 マスク）上のデバイスのディスカバリを、SNMP Credentials 

（SNMP 資格証明）ページで選択した SNMP バージョンを使用して行います。 

 シード ルータを介して接続されるネットワークは、ディスカバリの対象として自動

的に選択されません。 

d.  ネットワーク ディスカバリの対象とするすべてのネットワークが選択されていることを確

認し、Next （次へ）をクリックします。 

11.  ディスカバリして Orion データベースに含めたいデバイスの IP アドレスまたはホスト名を
既に知っている場合、次の手順を実行します。 

a. Selection Method （選択方法）メニューの Specific Nodes （特定ノード）をクリッ

クします。 

b. 監視するためにディスカバリしたいデバイスの IPv4 アドレスまたはホスト名を該当する

フィールドに入力します。 

注記： 1 行につき、IPv4 アドレスまたはホスト名を 1 つのみ入力してください。 

c. 入力された IPv4 アドレスまたはホスト名が SNMP 有効デバイスに割り当てられて

いるか確認するため、Validate （検証）をクリックします。 
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d. ディスカバリしたいすべての IPv4 アドレスとホスト名を入力したら、Next （次へ）をク

リックします。 

12. 次の手順で説明されるように、Discovery Settings （ディスカバリ設定）ビューの各種オプ

ションを設定します。 

a. 現在のディスカバリ プロファイルと他のネットワーク領域のディスカバリに使用するプロ 

ファイルを区別するため、Name （名前）と Description （説明）を入力します。 

注記： Description （説明）は、Network Sonar ビューの利用可能なネットワーク 

ディスカバリ設定のリストで、Name （名前）の横に表示されます。 

b.   スライダーの位置を調整するか、ミリ秒（ms）単位の値を入力して、SNMP 

Timeout （SNMP タイムアウト）を設定します。 

注記： ネットワーク ディスカバリ中に数多くの SNMP タイムアウトに遭遇する場合は、

この値を増やしてください。SNMP Timeout （SNMP タイムアウト）は、パケットがネッ

トワーク デバイス間の最も長い経路を移動するのにかかる時間の少なくとも 2 倍以

上にしなければなりません。 

c. スライダーの位置を調整するか、ミリ秒（ms）単位の値を入力して、Search 

Timeout （検索タイムアウト）を設定します。 

注記： Search Timeout （検索タイムアウト）は、Network Sonar Discovery が

特定の IP アドレスを割り当てられているデバイスが存在するかどうかを判断するまで

待機する時間です。 

d. スライダーの位置を調整するか、値を入力して、SNMP Retries （SNMP リトライ）

を設定します。 

注記： この値は、Network Sonar Discovery が失敗した SNMP 要求を再試行

する回数です。上記で定義される SNMP Timeout （SNMP タイムアウト）内に応

答を受け取らなかった場合、SNMP 要求が失敗したと見なされます。 

e. スライダーの位置を調整するか、値を入力して、Hop Count （ホップ カウント）を設

定します。 

注記：  Hop Count （ホップ  カウント）が  0 以上の場合、Network Sonar 

Discovery はディスカバリしたデバイスに接続しているデバイスを検索します。ディスカ

バリされるデバイスへの各接続をホップとしてカウントします。 

f. スライダーの位置を調整するか、値を入力して、Discovery Timeout （ディスカバリ 

タイムアウト）を設定します。 

注記：  Discovery Timeout （ディスカバリ  タイムアウト）は、Network Sonar 

Discovery がネットワーク ディスカバリに費やす時間（分単位）です。Discovery 

Timeout （ディスカバリ タイムアウト）の時間が経過すると、ディスカバリは終了します。 
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13. SNMP に応答するデバイスのみのディスカバリを行う場合、Use SNMP only （SNMP 

のみを使用）を選択します。 

注記： デフォルトでは、Network Sonar は ICMP ping リクエストを使用してデバイスを

探します。監視ネットワーク オブジェクトのほとんどの情報は、SNMP クエリーで取得され

ます。 

14. 複数の  Orion ポーリング  エンジンを利用できる場合、このディスカバリに使用する 

Polling Engine （ポーリング エンジン）を選択します。 

15. Next （次へ）をクリックします。 

16. 現在定義しているディスカバリを定期的に実行したい場合、次の手順で示すように、ディ
スカバリの Frequency （頻度）として、Custom （カスタム）または Daily （毎日）のいず

れかを選択します。 

注記： 

 予定ディスカバリ プロファイルには、動的に IP アドレスを割り当てられた（DHCP）ノー

ドを含む IP アドレス範囲を使用しないでください。 

 デフォルトの  Discovery Scheduling （ディスカバリ  スケジュール）設定では、

Discover （ディスカバリ）をクリックするとすぐにディスカバリが 1 回実行されます。 

 予定ディスカバリの結果は、Network Discovery （ネットワーク ディスカバリ）の 

Scheduled Discovery Results （予定ディスカバリ結果）タブに保持されます。予

定ディスカバリ結果の管理の詳細については、47 ページの「Scheduled Discovery 

Results （予定ディスカバリ結果）の管理 」を参照してください。 

a. 現在定義されたディスカバリを今後繰り返し実行するようにカスタムのディスカバリ ス
ケジュールを定義したい場合、Custom （カスタム）を選択して、ディスカバリを実行

する間隔（時間）を入力します。 

b. 予定ディスカバリを 1 日 1 回実行したい場合、Daily （毎日）を選択し、HH:MM 

AM/PM の形式で毎日実行する時刻を入力します。 

17. この時点でネットワーク ディスカバリを実行しない場合、No, don’t run now （今すぐ実

行しない）を選択し、1 回限りまたは定期的なディスカバリの実行のいずれかの設定に合

わせて、それぞれ Save （保存）または Schedule （予定）をクリックします。 

18. 今すぐ Network Sonar ディスカバリを実行する場合、Discover （ディスカバリ）をクリッ

クして、ネットワーク ディスカバリを開始します。 

注記： 一部のデバイスは、ルータとスイッチの双方の役割を果たしているため、Nodes 

Discovered （ディスカバリしたノード）の合計数が、Routers Discovered （ディスカバリし

たルータ）と Switches Discovered （ディスカバリしたスイッチ）で報告される合計数より

少ない場合があります。 
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Network Sonar Results Wizard （Network Sonar 結果
ウィザード）の使用 

Network Sonar Results Wizard （Network Sonar 結果ウィザード）では、監視するネット

ワーク デバイスを選択できます。同ウィザードは、Network Sonar ウィザードが完了するか、選

択したディスカバリに対して Import All Results （すべての結果をインポート）または Import 

New Results （新しい結果のインポート）のいずれかが選択され、ディスカバリ結果が要求さ

れたときに開きます。詳細については、36 ページの「Network Sonar ウィザードを使用したネッ

トワーク ディスカバリ」を参照してください。 

次の手順は、Orion NPM で監視するディスカバリされたオブジェクトの選択方法について詳細

に示します。 

ネットワーク ディスカバリの結果から Orion NPM で監視するデバイスを選択するには： 

1. Device Types to Import （インポートするデバイス タイプ）ページで、Orion NPM で監

視するデバイス タイプを選択し、Next （次へ）をクリックします。 

注記： 特定のデバイス タイプを監視するかどうかが定かでない場合は、問題になっている

デバイス タイプを選択します。選択したデバイスの監視が不要であると後で分かった場合、

Web Node Management （ウェブ ノード管理）を使用して削除してください。詳細につ

いては、55 ページの「ウェブ コンソールでのデバイス監視」を参照してください。 

2. Orion NPM インストーレーション用にデバイスのディスカバリを行う場合、Interface 

Types to Import （インポートするインターフェース タイプ）ページで Orion NPM で監視

するインターフェース タイプを選択し、Next （次へ）をクリックします。 

注記： 特定のインターフェース タイプを監視するかどうかが定かでない場合は、問題になっ

ているインターフェース タイプを選択します。選択したインターフェースの監視が不要である

と後で分かった場合、Web Node Management （ウェブ ノード管理）を使用して削除し

てください。詳細については、55 ページの「ウェブ コンソールでのデバイス監視」を参照して

ください。 

3. Volume Types to Import （インポートするボリューム タイプ）ページで、Orion NPM で

監視するボリューム タイプを選択し、Next （次へ）をクリックします。 

注記： 特定のボリューム タイプを監視するかどうかが定かでない場合は、問題になってい

るボリューム タイプを選択します。選択したボリュームの監視が不要であると後で分かった

場合、Web Node Management （ウェブ ノード管理）を使用して削除してください。詳

細については、55 ページの「ウェブ コンソールでのデバイス監視」を参照してください。 
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4. ノードをインポート（たとえ、別のポーリング エンジンによってポーリングされていることが既に
分かっている場合でも）する場合、Allow Duplicate Nodes （重複ノードの許可）セク

ション内のオプションを選択します。複数のポーリング エンジンの使用の詳細については、

261 ページの「Orion ポーリング エンジンの管理  –  コア 」を参照してください。 

5. Orion NPM インストレーション用にデバイスのディスカバリを行う場合、Import Settings 

（インポート設定）ページで、インポートされるインターフェースの有効な状態を選択し、

Next （次へ）をクリックします。 

注記： デフォルトでは、Orion NPM は Operationally Up （アップ）状態のインター 

フェースをインポートします。しかし、インターフェースは断続的にオン / オフと切り替わる可

能性があるため、Import Settings （インポート設定）ページでは、Operationally 

Down （ダウン）または Shutdown （シャットダウン）状態のインターフェースもインポートで

きるようになっています。 

6. Import Preview （インポート プレビュー）にインポートしたくないデバイスがある場合、除
外するデバイスを選択して、 Ignore （除外）をクリックします。選択したノードは、

Discovery Ignore List （ディスカバリ除外リスト）に追加されます。詳細については、 

48 ページの「Discovery Ignore List （ディスカバリ除外リスト）の使用」を参照してください。 

7. 監視したいネットワーク オブジェクトが Import Preview （インポート プレビュー）ページで

選択されていることを確認し、Import （インポート）をクリックします。 

8. Orion NPM インストーレーション用にデバイスのディスカバリを実行している場合、イン 

ポートが完了したら Finish （完了）をクリックします。 

注記： インポートされたデバイスは、All Nodes （全ノード）リソースに表示されます。 
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シード ファイルを使用したノード リストのインポート 

Orion NPM バージョン  10.0 以降のバージョンの Orion NPM 製品では、Network 

Discovery Wizard （ネットワーク ディスカバリ ウィザード）の Specific Nodes （特定ノード）オ

プションを使用して、シード ファイルからデバイスをインポートできます。次の手順は、シード ファ

イルと共に Specific Nodes （特定ノード）オプションを使用して、Orion データベースにデバイ

スをインポートする方法について示します。 

注記： シード ファイル ディスカバリのオプションは、Orion NPM バージョン 10 より以前のバー

ジョンで利用できます。 

シード ファイルからデバイスをインポートするには： 

1. シード ファイルを開きます。 

2. Network Sonar ウィザードがまだ開いていない場合は、Start > All Programs > 

SolarWinds Orion > Configuration and Auto-Discovery > Network Discovery 

（スタート > すべてのプログラム > SolarWinds Orion > 設定と自動ディスカバリ > ネットワー

ク ディスカバリ）の順でクリックします。 

3. 新しいディスカバリを作成する場合、Add New Discovery （新しいディスカバリの追加）

をクリックします。 

4. 既に定義されたネットワーク  ディスカバリがある場合、Network Sonar Discovery 

（Network Sonar ディスカバリ）タブにいくつかのオプションが用意されています。次のいず

れか 1 つを選択します。 

 使用する前に既存のディスカバリを編集する場合、編集するディスカバリを選択して 

Edit （編集）をクリックします。 

 既存のディスカバリを使用してネットワークの再ディスカバリを行う場合、使用するディ
スカバリを選択し、Discover Now （今すぐディスカバリ）をクリックして、ディスカバリが

完了したら、Network Sonar Results Wizard （Network Sonar 結果ウィザード）

を完了します。詳細については、43 ページの「Network Sonar Results Wizard 

（Network Sonar 結果ウィザード）の使用」を参照してください。 

 定義されたディスカバリで発見し、まだ監視対象としてインポートしていない一部また
はすべてのデバイスをインポートする場合、定義したディスカバリを選択し、Import 

All Results （すべての結果をインポート）をクリックします。詳細については、43 ペー

ジの「Network Sonar Results Wizard （Network Sonar 結果ウィザード）の使

用」を参照してください。 
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 定義済みディスカバリ プロファイルに一致する新しい有効デバイスをインポートする場
合、現在の定義済みディスカバリを選択し、Import New Results （新しい結果の

インポート）をクリックします。ネットワーク ディスカバリ結果の詳細については、43 ペー

ジの「Network Sonar Results Wizard （Network Sonar 結果ウィザード）の使

用」を参照してください。 

 既存のディスカバリ プロファイルを削除する場合、現在定義されたディスカバリを選択
し、Delete （削除）をクリックします。 

5. ネットワーク デバイスが、Orion NPM によって提供される public と private のデフ
ォルト ストリング以外のコミュニティ ストリングを必要としない場合、SNMP Credentials 

（SNMP 資格証明）ビューの Next （次へ）をクリックします。 

6. シード ファイル内のデバイスをディスカバリするために新しい SNMP 資格証明が必要な
場合、Add New Credential （新規資格証明の追加）をクリックし、必要な情報を入

力して、Add （追加）をクリックします。詳細については、36 ページの「Network Sonar ウ

ィザードを使用したネットワーク ディスカバリ」を参照してください。 

7. SNMP Credentials （SNMP 資格証明）ビューの Next （次へ）をクリックします。 

8. 既知の VMware vCenter または ESX サーバーをインポートする目的でシード ファイル
内のこれらのサーバーをディスカバリするために新しい VMware 資格証明が必要な場合、
Local vCenter or ESX Credentials for VMware （VMware 用のローカル vCenter 

または ESX 資格証明）ビューで次の手順を実行します。 

a. Poll for VMware （VMware のポーリング）を選択し、Add vCenter or ESX 

Credential （vCenter または ESX 資格証明の追加）をクリックします。 

b. 必要な情報を入力し、Add （追加）をクリックします。 

注記： 詳細については、36 ページの「Network Sonar ウィザードを使用したネッ

トワーク ディスカバリ」を参照してください。 

9. Next （次へ）をクリックし、Selection Method （選択方法）メニューの Specific Nodes 

（特定ノード）をクリックします。 

10. シード ファイルからディスカバリしたいデバイスの IP アドレスまたはホスト名を該当するフィー

ルドに入力します。 

注記： 1 行につき、1 つの IPv4 アドレスまたはホスト名のみを入力してください。 

11. 入力された IPv4 アドレスまたはホスト名が SNMP 有効デバイスに割り当てられているか

確認するため、Validate （検証）をクリックします。 

12. ディスカバリしたいすべての IPv4 アドレスとホスト名を入力したら、Next （次へ）をクリック

します。 
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13. Network Discovery Wizard （ネットワーク  ディスカバリ  ウィザード）と  Network 

Discovery Results Wizards （ネットワーク ディスカバリ結果ウィザード）を完了します。

詳細については、36 ページの「Network Sonar ウィザードを使用したネットワーク ディス

カバリ」を参照してください。 

Scheduled Discovery Results （予定ディスカバリ結果）の
管理 

Network Discovery （ネットワーク ディスカバリ）の Scheduled Discovery Results （予定

ディスカバリ結果）タブは、監視ネットワーク上で最近ディスカバリ、変更、またはインポートされ

たすべてのデバイスのリストを提供します。結果はディスカバリ間で比較され、このタブに表示さ

れます。次の手順は、ディスカバリ結果の管理ガイドラインを提供します。 

Scheduled Discovery Results （予定ディスカバリ結果）を管理するには： 

1. Start > All Programs > SolarWinds Orion > Configuration and Auto-

Discovery > Network Discovery （スタート > すべてのプログラム > SolarWinds Orion > 

設定と自動ディスカバリ > 設定ウィザード）の順でクリックします。 

2. Scheduled Discovery Results （予定ディスカバリ結果）をクリックします。 

3. 左ペインの Status （ステータス）メニューから表示したいデバイス タイプを選択します。次の

オプションから選択できます。 

 Found （発見）を選択すると、予定ディスカバリによってディスカバリされたすべてのデ

バイスを表示します。 

 Changed （変更）を選択すると、最近の予定ディスカバリ間で変更されたすべての

デバイスを表示します。変更には、インターフェースの追加やデバイス設定の変更が

含まれます。 

 Imported （インポート）を選択すると、Orion データベースに最近インポートしたすべての

デバイスが表示されます。デバイスのインポートの詳細については、43 ページの「Network 

Sonar Results Wizard （Network Sonar 結果ウィザード）の使用」を参照してください。 

 Ignored （除外）を選択すると、Discovery Ignore List （ディスカバリ除外リスト）に

追加したすべてのデバイスが表示されます。Discovery Ignore List （ディスカバリ除

外リスト）の詳細については、48 ページの「Discovery Ignore List （ディスカバリ除

外リスト）の使用」を参照してください。 

 Found and Changed （発見および変更）を選択すると、上記の Found （変更）

と Changed （変更）のすべてのデバイスを組み合わせたリストが表示されます。 
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 All except Ignored （除外以外すべて）を選択すると、上記の Ignored （除外）

に指定していない Found （発見）、Changed （変更）、および Imported （インポー

ト）のすべてのデバイスを表示します。 

4. 結果リストを整理するためにグループ化の基準を適用する場合、左ペインの Group by 

（グループ化基準）メニューから適切な基準を選択します。 

5. 結果リスト内の変更またはディスカバリされたノードを Orion データベースに反映したい場
合、更新または追加するすべてのノードを選択し、Import Nodes （ノードのインポート）

をクリックします。 

6. 将来のディスカバリにおいて、ディスカバリされた更新または変更にかかわらず、Orion 

NPM にディスカバリを除外させる場合、除外するすべてのノードを選択し、Add to 

Ignore List （除外リストに追加）をクリックします。Discovery Ignore List （ディスカバリ

除外リスト）の詳細については、48 ページの「Discovery Ignore List （ディスカバリ除外

リスト）の使用」を参照してください。 

Discovery Ignore List （ディスカバリ除外リスト）の使用 

Orion NPM で監視するつもりのないデバイスがネットワーク ディスカバリで発見されることがよく

あります。Discovery Ignore List （ディスカバリ除外リスト）は、ネットワーク上のそのようなデバ

イスをすべて記録したものです。Discovery Ignore List （ディスカバリ除外リスト）にデバイスを

追加することにより、監視するつもりのないデバイスのディスカバリに伴う SNMP 処理負荷を最

小限にします。 

Discovery Ignore List （ディスカバリ除外リスト）のデバイスを管理するには： 

1. Start > All Programs > SolarWinds Orion > Configuration and Auto-

Discovery > Network Discovery （スタート > すべてのプログラム > SolarWinds 

Orion > 設定と自動ディスカバリ > 設定ウィザード）の順でクリックします。 

2. 現在の  Discovery Ignore List （ディスカバリ除外リスト）を表示するには、
Discovery Ignore List （ディスカバリ除外リスト）をクリックします。 

3. Discovery Ignore List （ディスカバリ除外リスト）にデバイスを追加するには、次の手
順を実行します。 

a. Scheduled Discovery Results （予定ディスカバリ結果）をクリックします。 

b. 除外するデバイスを選択し、Add to Ignore List （除外リストに追加）をクリックし 

ます。 

4. Discovery Ignore List （ディスカバリ除外リスト）からデバイスを削除するには、次の手
順を実行します。 
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a. Scheduled Discovery Results （予定ディスカバリ結果）をクリックします。  

b. リストから削除するデバイスを選択します。 

c. Remove from Ignore List （除外リストから削除）をクリックします。 

d. OK をクリックして、選択した項目の除外を解除します。 
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 第 4章 

ウェブ コンソールでの Orion NPM の管理 

Orion ウェブ コンソールは、インターネットに完全に接続しているコンピュータから閲覧する設定

が可能な Orion 製品ファミリーの主要な一部です。ウェブ コンソールのインターフェースを複数

ユーザー向けにカスタマイズしたり、個々のカスタマイズ ビューをユーザー プロファイルとして保存

することもできます。この章では、Orion Network Performance Monitor に特有なウェブ コ

ンソール設定と管理情報を提供します。一般的なウェブ コンソールの設定と管理の詳細につ

いては、169ページの「ウェブ コンソール  –  コアの管理」を参照してください。 

Orion Network Performance Monitor のしきい値 

Orion ウェブ コンソールの利用可能なリソースの多くは、ネットワーク上のデバイスのエラーと警

告条件を表示することができます。Orion NPM の Orion ウェブ コンソールのエラーおよび警

告表示は、いつどのようにエラーや警告を表示するか決定するために、しきい値ページで提供

される値を使用します。次のセクションでは、しきい値タイプや設定に関する詳細が提供され 

ます。 

 Network Performance Monitor のしきい値タイプ 

 Orion NPM しきい値の設定 

注記： Orion の一般的なしきい値の詳細については、180ページの「Orion 一般しきい値」を

参照してください。 

Network Performance Monitor のしきい値タイプ 

次のデバイスの状態しきい値は、Network Performance Monitor のしきい値として設定でき

ます。 

注記： Orion の一般的なしきい値の詳細については、180 ページの「Orion 一般しきい値」を

参照してください。 

Cisco のバッファ ミス 

多くの Cisco デバイスは、バッファ ミスを報告します。バッファ ミスの数が High Level 

（高レベル）に設定された値より多い監視ネットワーク デバイスは、Cisco Buffer （Cisco 

バッファ）リソースで太字の赤色で表示されます。バッファ ミスの数が Warning Level 

（警告レベル）に設定された値より多いが、High Level （高レベル）に設定された値より

少ない監視ネットワーク デバイスは、Cisco Buffer （Cisco バッファ）リソースで赤色で表

示されます。 
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インターフェース エラーおよび廃棄 

エラー数および廃棄数が Error Level （エラー レベル）に設定された値より多い監視イン

ターフェースは、High Errors and Discards （高エラーおよび廃棄数）レポートとリソース

で太字の赤色で表示されます。エラー数および廃棄数が Warning Level （警告レベ

ル）に設定された値より多いが、Error Level （エラー レベル）に設定された値より少ない

監視インターフェースは、High Errors and Discards （高エラーおよび廃棄数）レポートと

リソースで赤色で表示されます。 

インターフェース利用率 

現在の利用率が High Level （高レベル）に設定された値より高い監視インターフェース

は、High Percent Utilization （高利用率）レポートとリソースに表示されます。これらの

デバイスのゲージも太字の赤色で表示されます。現在の利用率が  Warning Level 

（警告レベル）に設定された値より高いが、High Level （高レベル）に設定された値より

低い監視インターフェースは、High Percent Utilization （高利用率）レポートとリソース

に表示されます。これらのデバイスのゲージも赤色で表示されます。 

Orion NPM しきい値の設定 

次の手順では、Network Performance Monitor Thresholds （Network Performance 

Monitor のしきい値）ビューを開き、Orion NPM のしきい値を設定します。 

Orion NPM しきい値を設定するには： 

1. 管理者として Orion ウェブ コンソールにログインし、ウェブ  コンソールの右上にある 

Settings （設定）をクリックします。 

2. Settings （設定）グループ内の NPM Thresholds （NPM しきい値）をクリックします。 

注記： Network Performance Monitor のしきい値の詳細については、51 ページの

「Network Performance Monitor のしきい値タイプ」を参照してください。 

3. 選択したしきい値の Error Level （エラーレベル）、High Level （高レベル）、または 

Warning Level （警告レベル）に対する適切な数値を提供します。 
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Orion NPM のカスタム インターフェース チャート 

あらゆる Orion インストレーションで提供されるデフォルトのチャートに加え、Orion NPM は 

Orion ウェブ コンソール内のリソースとして独自にカスタマイズできる次のタイプ別にグループ化さ

れたインターフェース関連のチャートを提供します。 

注記： インターフェース チャートを監視インターフェースを扱っているウェブ コンソール ビューに追

加するには、Custom Interface Chart （カスタム インターフェース チャートリソースを追加しま

す。ビューにリソースを追加する詳細については、183 ページの「ビューの編集 」を参照してくだ

さい。ウェブ コンソールで利用できるカスタマイズ可能なチャート タイプの詳細については、209 

ページの「Orion ウェブ コンソールのカスタム チャート 」を参照してください。 

Discards and Errors （廃棄およびエラー）チャート 

 次のグラフは、Orion NPM によって監視されるインターフェース上の廃棄およびエラーに関する

情報を表示するのに利用できます。 

 In/Out Discards – Step Chart （入出力廃棄数 - ステップ グラフ） 

 In/Out Errors – Step Chart （入出力エラー数 - ステップ グラフ） 

 In/Out Errors and Discards – Step Chart （入出力エラーおよび廃棄数 - ステップ グ

ラフ） 

Percent Utilization （利用率）チャート 

次のグラフは、Orion NPM によって監視されるインターフェース利用率に関する情報を表示す

るのに利用できます。 

 Min/Max/Average Percent Utilization （最小 / 最大 / 平均利用率） 

 Min/Max/Average Transmitted + Received Traffic Percent Utilization （最小 / 

最大 / 平均送受信トラフィック利用率） 

 Percent Utilization – Line Chart （利用率 - 折れ線グラフ） 

 Percent Utilization – Step Chart （利用率 - ステップ グラフ） 
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Traffic （トラフィック）チャート 

次のグラフは、Orion NPM によって監視されるデバイス上のインターフェース トラフィック（マルチ

キャスト トラフィックも含む）に関する情報を表示するために利用できます。 

 Average bps – Line Chart （平均 bps - 折れ線グラフ） 

 Average bps – Step Chart （平均 bps - ステップ グラフ） 

 Average Packets per Second （ 1 秒あたりの平均パケット数） 

 Min/Max/Average bps In/Out （最小 / 最大 / 平均入出力 bps） 

 Min/Max/Average bps Received （最小 / 最大 / 平均受信 bps） 

 Min/Max/Average bps Transmitted （最小 / 最大 / 平均送信 bps） 

 Min/Max/Average bps Transmitted （最小 / 最大 / 平均送受信 bps） 

 Min/Max/Average bps Transmitted （最小 / 最大 / 平均送受信 bps 利用率） 

 Min/Max/Average Packets In/Out （最小 / 最大 / 平均入出力パケット数） 

 Multicast Traffic （マルチキャスト トラフィック） 

 Total Bytes Transferred （総転送バイト数） 

 Total Packets Transmitted/Received （総送受信パケット数） 
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第 5章 

ウェブ コンソールでのデバイス監視 

Orion ファミリーのすべての製品と同様に、Orion Network Performance Monitor を使用

することで、ネットワークのパフォーマンスに関する見識をすぐに得られます。Orion NPM は、次

のデバイス タイプとテクノロジーについて、インターフェース レベルのパフォーマンス データと見識を

提供します。 

 Cisco EnergyWise 有効デバイス。EnergyWise 有効デバイスの監視についての詳細

は、77 ページの「EnergyWise デバイスの監視」を参照してください。 

 VMware 仮想サーバーおよびマネージャ。VMware デバイスの監視についての詳細は、

65 ページの「仮想化」を参照してください。 

 ファイバ チャネル（FC）   

 仮想ストレージ エリア ネットワーク（VSAN） 

 Cisco ユニファイド コンピューティング システム（UCS） 

 ワイヤレス クライアント、不正アクセス ポイント、ワイヤレス コントローラをなどのワイヤレス 

デバイス。ワイヤレス デバイスの監視についての詳細は、87 ページの「ワイヤレス ネットワ

ークの監視」を参照してください。 

次のセクションでは、Orion ウェブ コンソールからすべてのネットワーク デバイスの監視および管

理を行うために、Orion NPM で有効にする各種機能について説明しています。 

注記： Orion 製品ファミリーのすべてのアプリケーションで利用可能なネットワーク デバイスの監

視および管理機能の詳細については、223 ページの「ウェブ コンソールのデバイスの管理  –  コ

ア 」を参照してください。 

ネットワーク概要 

デフォルトにより、すべての Orion NPM インストレーションにおいて、Orion ウェブ コンソールは、

Orion NPM が現在監視しているネットワーク上のすべてのノードおよびインターフェースに関す

る幅広い情報が一目で分かる Network Overview （ネットワーク概要）を提供します。

Network Overview （ネットワーク概要）は、ネットワーク上の各監視ノードの左側にノード プ

ロパティ ステータス アイコンを表示します。各ノードの右側にステータス アイコンが並んでいます。

それぞれのアイコンはノードの選択されたインターフェース プロパティの状態を表しています。

Network Overview （ネットワーク概要）の一番下の凡例は、各ネットワーク デバイス プロパ

ティのアイコンの色が意味する測定値を示します。詳細については、427 ページの「ステータス 

アイコンと識別子」を参照してください。 
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下記の表は、Network Overview （ネットワーク概要）で表示される監視ノードおよびインター

フェースに関する情報のタイプを記載しています。 

ノード プロパティ インターフェース プロパティ 

Response Time （応答時間） Percent Utilization （利用率） 

Average Response Time  

（平均応答時間） 
Type （タイプ） 

Maximum Response Time  

（最大応答時間） 
Errors and Discards Today （今日のエラーおよび廃棄） 

CPU Load （CPU 負荷） Errors and Discards This Hour （過去 1 時間のエラーおよび廃棄） 

Percent of Memory Used  

（メモリ利用率） 
ステータス 

パーセント パケット損失 Traffic （トラフィック） 

Machine Type （マシン タイプ）  

Node Status （ノード ステータス）  

 

アイコン、IP アドレス、またはノード名の上にカーソルを移動すると、関連するノードまたはイン 

ターフェースの現在のステータス情報を提供する tooltip （ヒント）が開きます。 

ネットワーク概要を表示するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト > すべてのプログラム > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. Orion ウェブ コンソールにログインし、Network  > Overview （ネットワーク > 概要）の

順でクリックします。 

3. 表示するノード プロパティを Nodes （ノード）フィールドで選択し、表示するインターフェー

ス プロパティを Interfaces （インターフェース）フィールドで選択します。 

4. 更新された概要を表示するために、Refresh （更新）をクリックします。 
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Orion NPM Tooltips （ヒント）でのインターフェース データの表示 

Orion ウェブ コンソールがデフォルトで提供する監視ノードの tooltips （ヒント）に加え、Orion 

NPM が提供するインターフェースの tooltips （ヒント）は、監視インターフェースのステータス概

要を表示します。監視インターフェースの概要をウェブ  コンソールで表示するには、インター 

フェース名の上にカーソルを合わせます。次のインターフェース情報がすぐに表示されます。 

注記： Orion ウェブ コンソールによりデフォルトで提供されるノード tooltip （ヒント）に関する情

報を含む tooltips （ヒント）の詳細については、228 ページの「ヒントでのノード データの表示」

を参照してください。 

インターフェース Tooltip （ヒント）データ 

Interface Name  

（インターフェース名） 
親ノードからディスカバリされたインターフェースの名前 

Operational Status  

（操作ステータス） 
インターフェースの操作ステータス 

Administrative Status  

（管理ステータス） 
インターフェースの管理者ステータス（有効または無効） 

Interface Type  

（インターフェース タイプ） 
親ノードのディスカバリ時に Orion NPM によって割り出されるイン

ターフェースの数値タイプ。 

Transmitted Current Traffic  

（現在の送信トラフィック） 
最後のインターフェース ポーリング時にインターフェースから送信され

たトラフィック量 

Transmitted Percent Utilization 

（送信利用率） 
最後のインターフェース ポーリング時に、利用可能な帯域幅に対

するインターフェースから送信されたトラフィックのパーセント 

Received Current Traffic  

（現在の受信トラフィック） 
最後のインターフェース ポーリング時にインターフェースが受信した 

トラフィック量 

Received Percent Utilization  

（受信利用率） 
最後のインターフェース ポーリング時に、利用可能な帯域幅に対

するインターフェースが受信したトラフィックのパーセント 

 

インターフェース管理状態の設定 

監視されるインターフェースの稼働状況は定期的にポーリングされ、収集された統計情報は 

Orion ウェブ コンソールに表示されます。Orion ウェブ コンソールの Node Management  

（ノード管理）機能を使用することで、監視インターフェースの管理ステータスを簡単に設定また

は変更することができ、必要に応じてインターフェースを「Unpluggable （取り外し可能）」に指

定したり、データ収集の一時中断や、ポーリングおよび統計情報の収集の再開を実行できま

す。次の手順は、Orion ウェブ コンソールで監視インターフェースの管理状態を設定または変

更します。 
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インターフェースの管理状態を設定または変更するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノード＆グループ管理）のグループ化で Manage Nodes （ノードの管

理）をクリックします。 

4. 次のいずれかの方法で、管理するインターフェースの親ノードを見つけます。 

 ノード リストの上にある検索ツールを使用し、管理したいインターフェースを  Orion  

データベース内で検索します。 

 適切な Group by （グループ化基準）を選択し、管理するインターフェースの親ノー

ドを含むグループをクリックします。 

5. 編集するインターフェースの親ノードの + をクリックして展開します。 

6. 編集するインターフェースを選択します。 

7. インターフェースを Unmanaged （管理外） として設定する場合は、次の手順を実行し
ます。 

a. Unmanage （管理外）をクリックします。 

b. デバイスの管理外期間を開始する日時を入力します。 

c. デバイスの管理外期間を終了する日時を入力します。 

d. OK をクリックします。 

8. Unmanaged （管理外）に設定されたインターフェースの管理を再開するには、
Remanage （管理再開）をクリックします。 

9. インターフェースを Unpluggable （プラグ取り外し可能） として設定する場合は、次の手
順を実行します。 

a. Edit Properties （プロパティの編集）をクリックします。 

b. Display interface as unplugged rather than down （インターフェースをダウ

ンではなく、プラグ取り外しとして表示する）を選択します。 

c. Submit （送信）をクリックします。 
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インターフェース プロパティの編集 

次のインターフェース プロパティは、ウェブ コンソールの Edit Interface （インターフェースの編

集）ビューで設定されます。 

 Interface name （インターフェース名） 

 Unpluggable status （プラグ取り外しステータス） 

 Custom bandwidth （カスタム帯域幅） 

 Polling intervals （ポーリング間隔） 

 Custom properties （カスタム プロパティ） 

 インターフェース プロパティの設定は、次の手順に従います。 

 インターフェース プロパティを設定するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Node & Group Management （ノードおよびグループ管理）グループ内の Manage 

Nodes （ノード管理）をクリックします。 

4. 次のいずれかの方法を使用して、管理するインターフェースの親ノードを見つけます。 

 ノード リストの上にある検索ツールを使用して、管理したいインターフェースの親ノード

を Orion データベース内で検索します。 

 適切な Group by （グループ化基準）を選択し、管理するインターフェースの親ノー

ドを含むグループをクリックします。 

5. + をクリックして親ノードを展開し、管理するインターフェースを選択します。 

6. 選択したインターフェースの名前を編集する場合、Interface Name （インターフェース

名）フィールドにある既存の名前を編集します。 

7. 選択したインターフェースに対して、カスタムの帯域幅を指定する場合、Custom 

Bandwidth （カスタム帯域幅）を選択し、Transmit Bandwidth （送信帯域幅）と 

Receive Bandwidth （受信帯域幅）のそれぞれにに Mb/s 単位で適切な値を入力し

ます。 

8. 現在のインターフェースのポーリング間隔を変更する場合、Interface Status Polling 

（インターフェース ステータスのポーリング）の値を秒単位で、Collect Statistics Every 

（統計情報の収集間隔）の値を分単位で編集します。 
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注記： 

 インターフェースのステータスは、Interface Status Polling （インターフェース ステー

タスのポーリング）フィールドで指定される間隔でキューされる SNMP 要求を親ノード

上で使用することによって判断されます。デフォルトのインターフェース ステータスのポー

リング間隔は 120 秒です。 

 インターフェースの統計情報は、親ノードの SNMP ポーリングを使用して割り出され

ます。デフォルトの統計情報の収集間隔は 9 分です。 

9. 選択したインターフェースの定義済みカスタム  プロパティを編集する場合、Custom 

Properties （カスタム プロパティ）グループの適切なカスタム プロパティ フィールドを編集し

ます。詳細については、375 ページの「カスタム プロパティの作成  –  コア」を参照してくだ

さい。 

10. インターフェース プロパティの編集を終えたら、Submit （送信）をクリックします。 

インターフェースの依存関係の詳細については、243 ページの「依存状態の管理」を参照してく

ださい。 

監視インターフェースのリモート管理 

次の手順で示されるように、Node Management （ノード管理）ユーティリティを使用して、遠

隔からインターフェースのシャットダウンまたは有効化、EnergyWise 電源設定のオーバーライ

ドを行うことができます。 

インターフェースをリモート管理するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ  コンソールの右上の  Settings （設定）をクリ ックし、Node & Group 

Management （ノードおよびグループ管理）グループ内で Manage Nodes （ノード管

理）をクリックします。 

3. 次のいずれかの方法を使用して、管理するインターフェースの親ノードを見つけます。 

 ノード リストの上にある検索ツールを使用して、管理したいインターフェースの親ノード

を Orion データベース内で検索します。 

 適切な Group by （グループ化基準）を選択し、管理するインターフェースの親ノー

ドを含むグループをクリックします。 

4. + をクリックして親ノードを展開し、管理するインターフェースを選択します。 

5. 選択したインターフェースをシャットダウンする場合、More Actions > Shut Down （そ

の他のアクション  > シャットダウン）の順でクリックし、OK をクリックして確定します。 
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6. 選択したインターフェースを有効にする場合、More Actions > Enable （その他のアク

ション  > 有効化）の順でクリックします。 

7. 選択したインターフェースが EnergyWise 有効で、現在の電源レベル設定をオーバーラ
イドする場合、More Actions > Override Power Level （その他のアクション  > 電

源レベルのオーバーライド）の順でクリックし、任意の電源レベルを設定して、OK をクリック

します。 

注記： リモート オーバーライドは一時的なもので、選択したインターフェースに設定された 

EnergyWise ポリシーに従ってリセットされます。EnergyWise 有効デバイスの監視の詳

細については、77 ページの「EnergyWise デバイスの監視」を参照してください。 

監視デバイスへのポーラーの割り当て 

Orion NPM は、定義済みのポーラーに加え、ネットワーク デバイスの特定の側面を監視する

ために独自のポーラーを定義できる Universal Device Poller （ユニバーサル デバイス ポー 

ラー）ユーティリティも提供しています。Orion ウェブ コンソールにおける監視デバイスへのポー 

ラーの割り当ては、次の手順で示すように、簡単なプロセスです。 

注記： 特定の監視ニーズを満たすポーラーが存在しない場合は、Universal Device Poller 

（ユニバーサル デバイス ポーラー）を使用して、独自のポーラーを作成してください。詳細につい

ては、133 ページのユニバーサル デバイス ポーラーによる MIB の監視」を参照してください。 

監視デバイスにポーラーを割り当てるには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ  コンソールの右上の  Settings （設定）をクリ ックし、Node & Group 

Management （ノードおよびグループ管理）グループ内の Manage Nodes （ノード管

理）をクリックします。 

3. 次のいずれかの方法を使用して、ポーリングするノード、インターフェース、インターフェース

の親ノード、またはボリュームを見つけます。 

 ノード リストに上にある検索ツールを使用して、Orion データベースを検索します。 

 適切な Group by （グループ化基準）を選択し、ポーリングするノード、インター 

フェースの親ノード、またはボリュームのいずれかのグループをクリックします。 

4. ノードにポーラーを割り当てるには、次の手順を実行します。 

a. ポーラーを割り当てる監視ノードを選択します。 

b. Node Management （ノード管理）ツールバーの Assign Pollers （ポーラーの割

り当て）をクリックします。 

c. 適切なポーラー グループの + をクリックして展開します。 
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d. 割り当てるポーラーを選択して、Submit （送信）をクリックします。 

e. OK をクリックし、割り当てを確定します。 

5. インターフェースまたはボリュームにポーラーを割り当てるには、次の手順を実行します。 

a. ポーラーを割り当てるインターフェースの親ノードまたはボリュームの横の + をクリックし

ます。 

b. ポーラーを割り当てるインターフェースまたはボリュームを選択します。 

c. Node Management （ノード管理）ツールバーの Assign Pollers （ポーラーの割

り当て）をクリックします。 

d. 適切なポーラー グループの + をクリックして展開し、割り当てるポーラーを選択して、

Submit （送信）をクリックします。 

e. OK をクリックし、割り当てを確定します。 

予定外のデバイス ポーリングおよび再ディスカバリ 

Orion NPM は、System Manager （システム マネージャ）のポーリング設定に基づいて、定

期的にデバイスから統計情報とステータスをポーリングします。詳細については、154 ページの

「Network Performance Monitor 設定」を参照してください。しかし時には、監視されたデバ

イスに対して、予定外のポーリングまたは再ディスカバリを行う必要がある場合もあります。次の

手順で示すように、Node Management （ノード管理）ユーティリティはこの機能を提供します。 

予定外のポーリングまたは再ディスカバリを実行するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノード＆グループ管理）のグループ化で Manage Nodes （ノードの管

理）をクリックします。 

4. 次のいずれかの方法を使用し、ポーリングするノードまたはインターフェースを見つけ、再 

ディスカバリするノードを選択します。 

 ノード リストに上にある検索ツールを使用して、Orion データベースを検索します。 

 適切な Group by （グループ化基準）を選択し、ポーリングするノードまたはインター

フェース、または再ディスカバリするノードのいずれかを含むグループをクリックします。 

5. 選択したノードまたはインターフェースをポーリングするには、More Actions > Poll Now 

（その他のアクション  > 今すぐポーリング）の順でクリックします。 



SolarWinds Orion Orion Network Performance Monitor  管理者ガイド 

 

 

 ウェブ コンソールでのデバイス監視  63 

6. 選択したノードを再ディスカバリするには、More Actions > Rediscover （その他のア

クション  > 再ディスカバリ）の順でクリックします。 

ファイバー チャネル デバイスおよび VSAN の監視 

Orion NPM は、監視対象のネットワーク オブジェクトとして Orion データベースに追加される 

VSAN およびファイバー チャネル デバイスを認識します。すべての Orion NPM インストレーシ

ョンで定義済みの Fibre Channel Units and Ports （ファイバー チャネル ユニットおよびポー

ト）レポートに加え、Orion NPM は次の VSAN およびファイバー チャネル関連のウェブ コン 

ソール ビューとリソースを提供します。 

VSAN の各種ビュー 

Orion NPM は、次の VSAN 関連ビューを Orion ウェブ コンソールに提供します。 

注記： ウェブ コンソール ビューの詳細については、182 ページの「ビューのカスタマイズ」を参照

してください。 

VSAN Details （VSAN 詳細） 

各 VSAN は、独自のネットワーク オブジェクトとして監視され、それぞれに独自の VSAN 

Details （VSAN 詳細）ビューが用意されています。VSAN Details （VSAN 詳細）ビューは、

次のリソースであらかじめ設定されています。 

VSAN Details （VSAN 詳細）リソース 

All VSAN Members  

（すべての VSAN メンバー） 
インターフェース ポートの割当およびステータスを含む、選択された 

VSAN 内の監視されるすべてのデバイスの概要を提供します。 

VSAN Details  

（ VSAN 詳細） 
ステータス、名前、ID メディア タイプ、および負荷分散タイプを含む、 

選択された VSAN に関する情報を提供します。 

イベント サマリー 
選択した VSAN で最近の定義した Orion イベントのサマリー。イベント

は、VSAN メンバー別に一覧表示されます。 

Total Bytes Transferred 

（総転送バイト数） 
選択した VSAN で、カスタマイズ可能な期間にわたって送受信された総

転送バイト数を示すグラフ。 

In/Out Errors and Discards 

（入出力エラーおよび廃棄数） 
選択した VSAN で、カスタマイズ可能な期間におけるすべての送受信 

エラーおよび廃棄の数を示すグラフ。 

VSAN Traffic  

（ VSAN トラフィック） 
選択した VSAN の、カスタマイズ可能な期間にわたる平均トラフィック量

を示すグラフ。 
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VSAN Summary （VSAN サマリー） 

VSAN Summary （VSAN サマリー）ビューは、次のリソースであらかじめ設定されています。 

VSAN Details （VSAN 詳細）リソース 

All VSAN Nodes  

（すべての VSAN ノード） 
Orion NPM によって現在監視されているすべての VSAN のリストを提

供します。監視される各 VSAN は、単一のノードとして扱われます。 

Fibre Channel Reports  

（ファイバー チャネル レポート） 

定義済みの Fibre Channel Units and Ports （ファイバー チャネル ユ

ニットおよびポート）レポートへのリンクを提供するカスタマイズ可能なリソー

ス。新たにレポートが定義されると、リストに追加されます。 

Last 25 Events  

（過去 25 件のイベント） 
監視される VSAN に関連する過去 25 件の Orion イベントのリスト。 

VSAN Traffic  

（VSAN トラフィック） 
監視されるすべての VSAN の、カスタマイズ可能な期間にわたる平均ト

ラフィック量を示すグラフ。 

Windows サーバー メモリ監視 

Orion NPM が Windows サーバーから CPU 負荷とメモリ利用率をポーリングする時、物理

メモリ容量（ 100% の数値）をプルし、各割り当てで使用されるメモリ容量を合計して、使用さ

れる物理メモリの割合を算出します。多くのアプリケーションは、あらかじめメモリを割り当て、実

際にメモリが必要になる前にスワップするため、100% を超えるメモリ利用率の測定値になるこ

とがあります。これを回避するため、Orion NPM 内でこれらのサーバーの物理メモリをボリュー

ムとして追加できます。ボリュームとして監視すると、測定値はより予測に沿ったものになります。 

ノード保守モード期間のスケジュール 

ノードまたはそのコンポーネントに対して、ファームウェアのアップグレード、新しいソフトウェアのイ

ンストール、セキュリティの更新などの保守を実施する必要がある場合は、保守でデバイスがダ

ウンしている間に、ポーリングを中断することを検討してください。ノード保守時に、ポーリングを

無効にしたり、ノード ステータスを Unmanaged （管理外）として設定することで、データの精

度を維持し、不要なアラート メッセージを防ぎます。ノード ポーリングの無効化の詳細について

は、57 ページの「インターフェース管理状態の設定」を参照してください。 
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第 6章 

仮想化 

Orion NPM に内蔵された  SolarWinds Orion Integrated Virtual Infrastructure 

Monitoring （IVIM ）では、仮想ネットワークや仮想データ センター、プライベート クラウドにお

ける今日の近代的なネットワーク構造を監視することができます。仮想化環境における明確な

可視性によって、ネットワーク パフォーマンスが仮想化プロジェクトの妨害になるのではなく、役

に立つようにします。 

Orion NPM は VMware ESXi および ESX サーバー バージョン 3.5 以降を監視することが

できます。 

VMware の監視 

最高レベルから最低レベルまでの VMware 仮想インフラストラクチャ全体（vCenter → データ 

センター → クラスタ → ESX ホスト → 個々の仮想マシン）を監視します。CPU 、メモリ、スト

レージ、ネットワーク帯域幅使用率を含む可用性とパフォーマンス指標を追跡します。 

仮想マシンの自動サマリー 

VMware ホスト サーバーに追加された、もしくは vMotion 時にアップデートされた新しい仮想

マシンを自動的に識別し、監視します 。 

仮想化アラートおよびレポート 

SolarWind Orion 本来のアラートおよびレポート機能は仮想インフラストラクチャにシームレス

に拡張されます。 

ESXi および ESX サーバーの監視における要件 

次の表では、Orion NPM を効果的に使用して VMware ESXi および ESX サーバーを監

視するために必要な最低要件を提供しています。 

要件  説明 

SNMP 

Orion NPM は、SNMP を使用してすべての ESXi および ESX サーバーを監視しま

す。SNMP の有効化の詳細については、67ページの「VMware ESXi および ESX サ

ーバーで SNMP を有効にする」を参照してください。 

VMware API 

Orion NPM は VMware API を使用し、ESXi および ESX サーバー バージョン 3.5 

および 4.0 を実行するデバイスからのパフォーマンス データのほとんどをポーリングします。

必要な資格証明作成の詳細については、72 ページの「Orion NPM 用の ESX サーバ

ー資格証明の作成」を参照してください。 
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要件  説明 

VMware  

ツール 

VMware ツールは、監視対象となるすべての ESXi および ESX サーバーにインストール

する必要があります。VMware ツールは監視されている ESXi および ESX サーバーを

実行している仮想マシンには必要ありませんが、監視されている ESXi および ESX サー

バーがホストする仮想マシンに VMware ツールをインストールする場合に、IP アドレスを

含む追加情報が必要になります。 

次の表では、Orion NPM が、VMware ESX サーバーとそのコンポーネント機能の監視に使

用する方法のサマリーを示します。 

機能  3.5  3i  4  4i 

データセンター  VMware API 

ESX クラスタ  VMware API 

仮想センター  VMware API 

ESX サーバーとして検出  VMware API 

ボリューム  SNMP 該当なし  SNMP  該当なし 

インターフェース  SNMP 該当なし  SNMP  SNMP （一部） 

CPU  VMware API 

メモリ  VMware API 

CPU 合計（ESX Details  

（ESX 詳細）ビュー） 
 VMware API 

メモリ合計（ESX Details  

（ESX 詳細）ビュー） 
 VMware API 

ネットワーク トラフィック利用率 

 （ESX Details （ESX 詳細）ビュー） 
 VMware API 

ゲスト VM リスト（ESX Details  

（ESX 詳細）ビュー） 
 VMware API 
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VMware ESXi および ESX サーバーで SNMP を有効にする 

Orion NPM では SNMP を使用して VMware ESXi および ESX サーバーからパフォーマン

ス データをポーリングします。このパフォーマンス データを Orion NPM で利用可能にするため

には次のセクションで説明するように、VMware ESXi および ESX サーバーで SNMP を有効

にする必要があります。 

注記： VMware では、VMware ESXi および ESX サーバー バージョン 4.0 以降の SNMP 

クエリーに対して限定された情報量のみを提供します これらのバージョンで詳細情報にアクセ

スするために、Orion NPM は VMware API を使用します。 

 VMware ESXi で SNMP を有効にする 

 ESX サーバー バージョン 3.5 で SNMP を有効にする 

 ESX サーバー バージョン 4.0 で SNMP を有効にする 

VMware ESXi で SNMP を有効にする 

次の手順で VMware ESXi で SNMP を有効にすることができます。 

注記： SNMP を有効にする次の手順では vSphere コマンド ライン インターフェース（CLI）が

必要になります。vSphere CLI はデフォルトで ESXi サーバーに付属していませんので、説明

に従って VMware からダウンロード する必要があります。 

 VMware ESXi で SNMP を有効にするには： 

1. VMware ダウンロード センター（http://downloads.vmware.com/d/）から、VMware 

vSphere コマンド ライン インターフェースをダウンロードしてインストールします。 

2. VMware vSphere コマンド ライン インターフェースをインストールします。 

3. vSphere CLI を使用し、次の手順で説明されるように ESXi サーバーの SNMP 設定を

表示します。 

a. vSphere インストールの Perl\bin ディレクトリで次のスクリプトを実行します。 

 perl ..\..\bin\vicfg-snmp.pl --server ip_address –s 

  

http://downloads.vmware.com/d/info/datacenter_downloads/vmware_vsphere_4/4
http://downloads.vmware.com/d/
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注記： 

 C:\Program Files\VMware\VMware vSphere CLI\Perl\bin は 

vSphere Perl\bin ディレクトリのデフォルトの場所になります。 

 ip_address を ESXi サーバーの IP アドレスと置き換え、cstring を、追加

するコミュニティ ストリングと置き換えます。ほとんどの環境ではコミュニティ ストリン

グは public （パブリック）で差し障りありません。 

b. プロンプトで適切なユーザー名を入力します。 

注記： ほとんどの環境では root （ルート）で差し障りありません。 

c. プロンプトで関連パスワードを入力します。 

4.  vSphere CLI を使用して、次の手順に従って ESXi サーバーで SNMP を有効にし 

ます。 

a. vSphere インストールの Perl\bin ディレクトリで次のスクリプトを実行して適切な

コミュニティ ストリングを追加します。 

perl..\..\bin\vicfg-snmp.pl --server ip_address -c cstring 

注記： ip_address を ESXi サーバーの IP アドレスを置き換え、cstring を、追

加するコミュニティ ストリングと置き換えます。ほとんどの環境ではコミュニティ ストリング

は public （パブリック）で差し障りありません。 

b. プロンプトで適切なユーザー名を入力します。 

注記： ほとんどの環境では root （ルート）で差し障りありません。 

c. プロンプトで関連パスワードを入力します。 

d. vSphere インストールの Perl\bin ディレクトリで次のスクリプトを実行して SNMP 

を有効にします。 

perl..\..\bin\vicfg-snmp.pl --server ip_address –E 

注記： ip_address を ESXi サーバーの IP アドレスと置き換えます。 

e. プロンプトで適切なユーザー名を入力します。 

注記： ほとんどの環境では root （ルート）で差し障りありません。 

f. プロンプトで関連パスワードを入力します。 

5. ESXi サーバーを再起動して設定を有効にします。 
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ESX サーバー バージョン 3.5 で SNMP を有効にする 

次の手順に従って、ESX サーバー バージョン 3.5 で SNMP を有効にすることができます。 

注記： ESX サーバー 3.5 および ESX サーバー MIB に関する詳細情報は VMware 文書

の「基本システム管理： ESX サーバー 3.5、ESX サーバー 3i バージョン 3.5、VirtualCenter 

2.5 」を参照してください。 

ESX サーバー 3.5 で SNMP を有効にするには： 

1. 管理者特権のあるアカウントで ESX サーバーにログインします。 

2. テキスト エディタで snmpd.conf を開きます。 

注記： 

 snmpd.conf のデフォルトの場所は root/etc/snmp/snmpd.conf になります。 

 デフォルトの ESX サーバー バージョン 3.5 環境でデフォルトのテキスト エディタ nano 

を使用するには、プロンプトで nano /etc/snmp/snmpd.conf と入力します。 

3. rocommunity 設定を見つけて、デフォルトのコミュニティ ストリング public と各環境に

適した読み取り専用のコミュニティ ストリングを置き換えます。 

注記： 複数のコミュニティ ストリングを分けるにはコンマを使います。 

4. snmpd.conf を保存してエディタを閉じます。 

注記： ナノを使用する場合、Ctrl+X でナノを閉じ、Y を入力して snmpd.conf を保

存します。 

5. ESX サーバーを再起動する際に chkconfig snmpd on を入力して SNMP を有効

にします。 

6. esxcfg-firewall -e snmpd と入力して SNMP が ESX サーバーのファイアウォール

を通過できるようにします。 

7. service snmpd と入力して SNMP サービスを開始します。 

8. 次のコマンドを入力して ESX サーバー上で SNMP ポーリングが有効になっていることを

確認します。 

snmpwalk -v1 -c cstring localhost.1.3.6.1.4.1.6876 | grep 

6876.1 

注記： cstring を上記で提供したコミュニティ ストリングに置き換えます。 

9. snmpwalk コマンドを入力した後、ESX サーバーは次のような情報を返す必要があり 

ます。 

http://www.vmware.com/pdf/vi3_35/esx_3/r35/vi3_35_25_admin_guide.pdf
http://www.vmware.com/pdf/vi3_35/esx_3/r35/vi3_35_25_admin_guide.pdf
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SNMPv2-SMI::enterprises.6876.1.1.0 = STRING: "VMware ESX 

Server"  

SNMPv2-SMI::enterprises.6876.1.2.0 = STRING: "3.5.0"  

SNMPv2-SMI::enterprises.6876.1.3.0 = OID: SNMPv2-

SMI::enterprises.6876.60.1.3.5.0 

SNMPv2-SMI::enterprises.6876.1.4.0 = STRING: "153875"  

注記： MIB OID SNMPv2-SMI::enterprises.6876.1.4.0 では、製品のビルド番
号を返すので、上記に表示されたビルド番号とは異なる場合があります。 

ESX サーバー バージョン 4.0 で SNMP を有効にする 

次の手順によってシステム デフォルトの SNMP デーモン snmpd および独自仕様の VMware 

SNMP デーモン vmware-hostd の双方を VMware ESX サーバー バージョン 4.0 で有効

にすることができます。 

注記： ESX サーバー 4.0 および ESX サーバー MIB の詳細については、VMware 文書

『vSphere 基本システム管理： Update 1、ESX 4.0、ESXi 4.0、vCenter サーバー 4.0』

を参照してください。 

ESX サーバー バージョン 4.0 で SNMP を有効にするには： 

1. 管理者特権のあるアカウントで ESX サーバーにログインします。 

2. テキスト エディタで snmp.xml を開きます。 

注記： 

 snmp.xml のデフォルトの場所は root/etc/vmware/snmp.xml になります。 

 デフォルトの ESX サーバー バージョン 4 環境でデフォルトのテキスト エディタ nano 
を使用するには、プロンプトで nano /etc/vmware/snmp.xml と入力します。 

3. communities タグを見つけて、デフォルトのコミュニティ ストリング public を各環境に
あった読み取り専用のコミュニティ ストリングと置き換えます。 

注記： 複数のコミュニティ ストリングを分けるにはコンマを使います。 

4. enable タグを見つけ、true に設定されていることを確認します。 

5. port タグを見つけ、171 に設定されていることを確認します。 

6. targets タグを見つけ、 127.0.0.1@162/ cstring に設定されていることを確認ます。 

注記： cstring を上記で提供したコミュニティ ストリングに置き換えます。 

7. snmp.xml を保存して、エディタを閉じます。 

注記： nano を使用する場合、Ctrl+X で nano を閉じ、Y を入力して snmp.xml を
保存します。 

mailto:127.0.0.1@162/cstring
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8. service snmpd stop と入力して SNMP サービスが停止していることを確認します。 

9. テキスト エディタで snmpd.conf を開きます。 

注記： 

 snmpd.conf のデフォルトの場所は root/etc/snmp/snmpd.conf になります。 

 デフォルトの ESX サーバー バージョン 4 環境でデフォルトのテキスト エディタ nano 

を使用するには、プロンプトで nano /etc/snmp/snmpd.conf と入力します。 

10. snmpd.conf を編集して次の 2 行を入れます。 

 view systemview included.1.3.6.1.4.1.6876 

 proxy -v 1 -c cstring 127.0.0.1:171.1.3.6.1.4.1.6876 

 注記： cstring を上記で提供したコミュニティ ストリングに置き換えます。 

11. snmpd.conf を保存してエディタを閉じます。 

注記： ナノを使用する場合、Ctrl+X でナノを閉じ、Y を入力して snmpd.conf を保

存します。 

12. service mgmt-vmware restart と入力して mgmt-vmware サービスを再起動ます。 

13. service snmpd start と入力して SNMP サービスを開始します。 

14. chkconfig snmpd on と入力して ESX サーバーを再起動する際に SNMP を有効に

します。 

15. esxcfg-firewall -e snmpd と入力して SNMP が ESX サーバーのファイアウォール

を通過できるようにします。 

16. 次のコマンドを入力して ESX サーバー上で SNMP ポーリングが有効になっていることを

確認します。 

snmpwalk -v1 -c cstring localhost.1.3.6.1.4.1.6876 | grep 

6876.1 

注記： cstring を上記で提供したコミュニティ ストリングに置き換えます。 

17. snmpwalk コマンドを入力した後、ESX サーバーは次のような情報を返す必要があります。 

SNMPv2-SMI::enterprises.6876.1.1.0 = STRING: "VMware ESX"  

SNMPv2-SMI::enterprises.6876.1.2.0 = STRING: "4.0.0"  

SNMPv2-SMI::enterprises.6876.1.4.0 = STRING: "208167"  

注記： OID SNMPv2-SMI::enterprises.6876.1.4.0 は製品のビルド番号を返し

ます。よって上記のビルド番号とは異なる場合があります。 
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Orion NPM 用の ESX サーバー資格証明の作成 

Orion NPM では、VMware API を使用し、ESXi および ESX サーバー バージョン 3.5 およ

び 4.0 を実行するデバイスからのパフォーマンス データのほとんどをポーリングします。次の手順

で示すように、Orion NPM ポーリング エンジン用に ESX サーバーで資格証明を作成する必

要があります。 

注記： Orion NPM ポーリング エンジン用に作成する資格証明には、少なくとも読み取り専

用の権限が必要になります。 

Orion NPM 用に ESX サーバー資格証明を作成するには： 

1. 管理者特権のあるアカウントで ESX サーバーにログインします。 

注記： 通常は、root のユーザー名とパスワードで差し障りありません。 

2. 信用できない SSL 認証の警告が表示される場合、Ignore （無視） をクリックして現在

の SSL 認証で続行します。 

3. Users & Groups （ユーザーおよびグループ）タブを開き、Users （ユーザー）をクリックし 

ます。 

4. Users （ユーザー）ビューを右クリックして、Add （追加）をクリックします。 

5. Add New user （新しいユーザーの追加）ウィンドウで、次の手順を完了します。 

注記： この手順で入力する User Name （ユーザー名）と Password （パスワード）は、

初回のネットワーク ディスカバリ時に提供するか、Web Node Management （ウェブ ノー

ド管理）を使用し、現在の ESX サーバーを監視対象として Orion NPM に追加するた

びに提供しなければなりません。 

a. Orion NPM ポーリング エンジンに対して、Login （ログイン）と User Name （ユー

ザー名）を入力します。 

b. パスワード を入力して確定します。 

c. OK をクリックします。 

6. Permissions （許可）タブを開きます。 

7. Permissions （許可）ビューを右クリックして、Add Permission （許可の追加）をクリッ

クします。 

8. Assign Permissions （許可の割り当て）ウィンドウで Add （追加）をクリックします。 

9. たった今作成したユーザーを選択して Add （追加）をクリックします。 
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10. Users and Groups （ユーザーおよびグループ）ウィンドウで OK をクリックします。 

11. Assigned Role （割り当てられた役割）で適切な役割を選択し、Assign Permissions 

（許可の割り当て）ウィンドウで OK をクリックします。 

これで作成した資格証明が ESX サーバーの監視用として使用することができます。ESX  

サーバーを監視のために Orion データベースに追加することに関する詳細情報は 73 ページの

「ウェブ コンソールで VMware 資格証明を管理する 」を参照してください。 

ウェブ コンソールで VMware 資格証明を管理する 

VMware の資格証明のユーザー名またはパスワードをアップデートする必要がある場合、

VMware Credentials Library （ VMware 資格証明ライブラリ）タブで行うことができます。 

VMware 資格証明をアップデートするには、次の手順に従います。 

1. ウェブ コンソールにログインします。 

2. Settings （設定）をクリックします。 

3. Node & Group Management （ノード＆グループ管理）セクションで VMware Settings 

（VMware 設定）をクリックします。 

4. VMware Credentials Library （VMware 資格証明ライブラリ）タブをクリックします。 

5. アップデートする必要のある資格証明を確認し、Edit Credential （資格証明の編集）

をクリックします。 

6. 必要事項をアップデートしたら OK をクリックします。 
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監視のために VMware サーバーを追加する 

VMware Vcenter 、ESX サーバーおよび仮想マシンはその他のデバイスが Orion ウェブ コン

ソールに監視のために追加されるのと同じ方法で Orion データベースに追加されます。 

Network Sonar ウィザードを使用して VMware ノードをポーリングする 

Network Sonar ウィザードは Orion ウェブ コンソールに監視のための VM サーバーを追加す

る際に推奨される方法です。Network Sonar Discovery では、Vmware ビューに対する 

ローカル ESX 資格証明に必要なすべての資格証明を一度に定義することができます。詳細

については、36 ページの「Network Sonar ウィザードを使用したネットワーク ディスカバリ」を参

照してください。 

VMware アセット リソースから VM を追加する 

1. ウェブ コンソールにログインします。 

2. Virtualization （仮想化）タブにポイントして Virtualization Summary （仮想化サマ

リー）をクリックします。 

3. VMware アセット リソースにあるリストの ESX または Vcenter サーバーの横にある [+] 

をクリックして 仮想マシンのリストを展開します。 

4. 現在 SolarWinds Orion で管理されていない仮想マシンをクリックします。管理が解除さ

れている VM はイタリック体でリストされています。 

5. Yes, Manage this Node （はい、このノードを管理します）をクリックします。 

6. VM が  VMware ツールを実行していない場合、  VM の  IP アドレスを手動で 

Hostname or IP Address （ホスト名または IP アドレス） フィールドに入力します。 

7. 仮想マシンを監視するために必要な追加オプションを選択し、Next （次へ）をクリックし 

ます。 

8. 残りのノードの追加ウィザードを完了して OK, Add Node （はい、ノードを追加します）を

クリックします。 

仮想化サマリー 

仮想化サマリー ビューでは仮想化インフラストラクチャの全体的な状態を表示します。 

仮想化サマリーを表示するには、次の手順に従います。 

1. Orion ウェブ コンソールにログインします。 

2. Virtualization （仮想化）タブにポイントして Virtualization Summary （仮想化サマ

リー）をクリックします。 
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仮想化サマリー ビューは次のリソースを表示するように事前設定されています。 

CPU 負荷別の VMware ホスト トップ 10 
実行している VM 数別の VMware ホスト  

トップ 10 

使用されたメモリーの割合別の VMware ホスト  

トップ 10 
ネットワーク活用別の VMware ホスト トップ 10 

VMware アセット VMware アセット サマリー 

 

あらゆるリソースのプロパティやコンテンツを変更するには、リソース ボックスの Edit （編集）をク

リックします。 

ESX ホスト詳細を表示する 

ESX Host Details （ESX ホスト詳細）ページは、仮想化サマリーの ESX ホスト サーバーを

クリックすると表示されます。このページは次のリソースを表示するように事前設定されています。  

 このノードにおけるアクティブ アラート  Availability Statistics （利用状況の統計情報） 

 平均応答時間およびパケット ロス グラフ  平均応答時間およびパケット ロス ゲージ 

 CPU 負荷およびメモリー利用率ゲージ  ディスク容量 

 ESX ホスト詳細  イベント サマリー 

 仮想マシンのリスト  最低／最高平均 CPU 負荷グラフ 

 ノードの詳細  ポーリングの詳細 

 仮想マシン CPU 消費  仮想マシン メモリー消費 

 仮想マシン ネットワーク トラフィック  

 

あらゆるリソースのプロパティやコンテンツを変更するには、リソース ボックスの Edit （編集）をク

リックします。 
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ESX サーバーにおけるポーリングの順番を変更する 

VMware vCenter サーバーによって  VMware ESX ホストが制御されている場合、

SolarWinds Orion では ESX ホストのステータスを ESX ホストから直接ポーリングする代わ

りに vCenter サーバーから取得します。 

ESX サーバーから直接ポーリングするには、VMware 設定ページから ESX ホストの Poll 

Through （ポーリングの経由）の設定を変更する必要があります。このページから ESX ホスト

および vCenter サーバーのポーリングを無効および有効にすることができます。 

vCenter に管理される ESX ホストを SolarWinds Orion サーバーからポーリングするには、

次の手順に従います。 

1. ウェブ コンソールにログインします。 

2. Settings （設定）をクリックします。 

3. Node & Group Management （ノード＆グループ管理）セクションで  VMware 

Settings （VMware 設定）をクリックします。 

4. いずれかのカラム見出しをポイントして逆三角形をクリックし、Columns > Polling 

Through （カラム＞ポーリングの経由）をクリックします。 

5. 直接ポーリングしたい ESX ホストを選択します。 

6. Poll Through > Poll ESX server directly （ポーリングの経由＞ ESX サーバーに

直接ポーリング）をクリックします。 
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 第 7章 

EnergyWise デバイスの監視 

SolarWinds は Cisco 社と提携し、ネットワークのエネルギー利用を最適化する 

EnergyWise を提供しています。EnergyWise 技術を使用し、EnergyWise 有効デバイス

およびパワー オーバー イーサネット（PoE）デバイスを対象としたエネルギー利用ポリシーを設定

することができます。 

EnergyWise とは 

EnergyWise は、企業のエネルギー コストの削減、環境問題への対応、グリーン テクノロジー

に関する政府指令への準拠を支援するために開発された  Cisco 社の技術です。

EnergyWise 対応デバイスを展開し、省エネ機能を有効にすることで、ビジネスにクリティカルな

システムを最大電力で稼働しながらも、パワー オーバー イーサネット（PoE）ポート上のより重要

性の低いデバイスをオフピーク時間に電源オフにしたり、スタンバイ状態にすることができます。 

EnergyWise 関連用語 

次の用語とコンセプトは、EnergyWise MIB で提供され、Orion ウェブ  コンソールの 

EnergyWise リソース内で使用されています。 

ドメイン 

EnergyWise MIB には、EnergyWise 対応デバイスまたはエンティティのグループを、指

定したドメインのメンバーとしてラベル付けするフィールドが含まれています。Orion NPM で

は、単一のドメインは、ネイバーとして定義されるすべての監視対象 Energywise エン 

ティティで構成されています。 

エンティティ 

別のネットワーク デバイスから電源を取る、あるいは別のネットワーク デバイスに電源を供

給する、スイッチ、IP 電話、および EnergyWise 対応デバイスのパワー オーバー イーサ

ネット（PoE）ポートに接続されたその他のコンポーネントを含む、あらゆるネットワーク デバ

イス。 
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重要度レベル 

重要度レベル、または単に重要度は、EnergyWise エンティティと EnergyWise ポリシー
に割り当てられる 1～100 の優先度です。この値が高くなるにつれて、デバイスの重要度
が増し、エネルギー ポリシーの変更により影響を受ける可能性が少なくなります。ポリシー
の適用を試みると、ポリシーと選択したエンティティの重要度が比較され、選択したエンティ
ティにポリシーを実際に適用するかどうかが決定されます。ポリシーの重要度がエンティティ
の重要度より高いか、同じである場合、エンティティにポリシーが適用され、エンティティ パ
ワー レベルが変更されます。同様に、エンティティの重要度がポリシーの重要度より高い
場合、ポリシーは適用されず、エンティティ パワー レベルが変更されることはありません。 

たとえば、重要度 80 を割り当てられた IP 電話が、電源レベル 8 で動作しています。 

エンティティ パワー レベルを 5 に変更するポリシー A5 の重要度が 50 で、エンティティ パ
ワー レベルを 10 に変更するポリシー B10 の重要度が 95 であるとします。IP 電話にポリ
シー A5 を適用しても、IP 電話は電源レベル 8 で動作し続けます。しかし、ポリシー 

B10 を適用した場合、IP 電話の電源レベルは 10 に変更されて、適用されるポリシー 

B10 に従います。 

重要度を使用し、特定のエンティティをポリシー変更の適用対象外にすることができます。
たとえば、すべての緊急用電話が単一のスイッチに接続されている場合、そのスイッチを決
してスタンバイ モードにしてはなりません。緊急用電話をホストするスイッチがスタンバイ  

モードにならないようにするため、スイッチの重要度を 100 に設定し、重要度が 99 以下
のすべてのポリシーが緊急用電話のスイッチに影響を及ぼさないようにします。 

キーワード 

EnergyWise MIB は、個々のエンティティを識別するための一意なラベルを提供していま

す。エンティティの初回の設定時に、次の例で示すように、連続したキーワードをカンマ区

切り（空白スペースなし）で追加できます。 

 キーワード 1, キーワード 2, キーワード 3 

名前 

EnergyWise エンティティまたはドメインの設定時に、エンティティまたはドメインに対して 

EnergyWise MIB で割り当てることができるユーザーフレンドリな識別子。スイッチのデ 

フォルト名はホスト名で、パワー オーバー イーサネット（PoE）ポートのデフォルト名はポート

名を短くした名前です。EnergyWise 名に空白スペースを含めることはできません。

EnergyWise 名を変更しても、デバイスのホスト名またはポート名は変更されません。名

前から空白スペースを省き、アスタリスク（*）の使用を控えてください。使用できる有効文

字には、英数字と #、（ 、%、!、または & の記号が含まれます。 

ネイバー 

同じドメイン内に定義された 2 つの EnergyWise エンティティ同士はネイバーと呼びます。

ネイバーは、エネルギー管理指令の発行などの EnergyWise イベントをやり取りできます。 
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ポリシー レベル 

ポリシー レベルは、選択したエンティティに現在適用されているポリシーの電源レベルです。 

電源レベル 

電源レベルは、現在適用されているポリシーに基づいて、EnergyWise エンティティが引き

出せる電力量です。次の表は、カテゴリ ラベルとアイコンの色で分類された利用可能なレ

ベルを詳細に示しています。 

注記： 

 一部のウェブ コンソール リソースでは、電源レベルは EnergyWise レベルまたは FW 

レベルのいずれかで呼ばれます。 

 一部の Cisco IOS バージョンでは、電源レベルが 0-10 ではなく、1-11 としてレ 

ポートされるという、既知の問題が存在します。Orion NPM バージョン 10.1.2 以降

では、電源レベルが自動的に修正されます。また、監視しているデバイスの IOS がこ

の既知の問題の影響を受けないようにするため、Orion NPM もこの問題を適切に

処理します。 

 レベル 
 Label  

（ラベル） 
 カテゴリ 

 色  色コード 

 10 Full （完全）  Operational （稼働）（ 1 ）  赤色  FF0000 

 9 High （高） 

 8 Reduced （低）  黄色  FFFF00 

 7 Medium （中） 

 6 
Frugal  

（節約） 
 緑色  00FF00 

 5 Low （低） 

 4 
Ready  

（レディ） 
 Standby （スタンバイ）（ 0 ）  青色  0000FF 

 3 
Standby  

（スタンバイ） 

 2 
Sleep  

（スリープ） 
 茶色  A52A2A 

 1 
Hibernate  

（ハイバネート） 

 0 
Shut  

（シャットダウン） 
 Nonoperational （非稼働）

（ -1 ） 

 黒色  000000 
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Orion NPM による EnergyWise デバイスの監視 

Orion NPM は、ネットワークにおけるエネルギー消費量と EnergyWise 有効デバイスが実現

するエネルギー節約の監視をサポートするために、EnergyWise Summary （EnergyWise 

サマリ）ビューと関連する  EnergyWise リソースを提供します。次のセクションでは、

EnergyWise Summary （EnergyWise サマリーー）ビューと関連する EnergyWise リソース

について説明します。 

注記： 

 ネットワーク上のすべての EnergyWise 有効デバイスの IOS を完全にアップグレードして

ください。詳細については、ご利用デバイスのドキュメンテーションまたは www.cisco.com 

を参照してください。 

 EnergyWise Summary （EnergyWise サマリー）ビューが Orion ウェブ コンソールのメ

ニュー  バーに表示されない場合は、 80 ページの 「 EnergyWise Summary 

（EnergyWise サマリー）ビューおよびリソース」を参照してください。 

EnergyWise Summary （EnergyWise サマリー）ビューおよび

リソース 

デフォルトにより、EnergyWise Summary （EnergyWise サマリー）ビューは、次のリソースを

提供します。 

All Nodes （全ノード） 

EnergyWise Summary （EnergyWise サマリー）ビューに含まれる All Nodes （全ノー

ド）リソースは、EnergyWise 機能の観点からネットワーク全体を表示するよう設定されて

います。ネットワーク上のすべてのノードは、次のいずれかのグループに属します。 

 EnergyWise Capable （EnergyWise 対応）グループは、EnergyWise 技術を

搭載しているがまだ有効になっていないすべての監視デバイスを含みます。 

 EnergyWise Enabled （EnergyWise 有効）グループは、EnergyWise 技術が

搭載されかつ有効になっているすべての監視デバイスを含みます。 

 Not EnergyWise Capable （EnergyWise 未対応）グループは、EnergyWise 

技術を搭載していないすべての監視デバイスを含みます。 
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EnergyWise NCM Information （EnergyWise NCM 情報） 

Network Configuration Manager （NCM）は、ネットワークの構成および変更管理に

使用する Orion モジュールです。このリソースは、Orion NCM を使用して、ネットワーク

上の EnergyWise 設定とポリシーを管理する方法についての基本的な情報を提供しま

す。Orion NCM と無償トライアルのダウンロードの詳細については、Download NCM 

（NCM のダウンロード）をクリックしてください。 

EnergyWise Reports （EnergyWise レポート） 

EnergyWise Reports （ EnergyWise レポート）リソースは、ネットワーク全体の現在の 

EnergyWise の対応状況とエネルギー節約を詳述したレポートのリストを提供します。詳

細については、124 ページの「EnergyWise Reports （EnergyWise レポート）」を参照

してください。 

Overall EnergyWise Savings （EnergyWise 総節約量） 

Overall EnergyWise Savings （EnergyWise 総節約量）リソースは、最大消費電力

とネットワーク上のすべての EnergyWise 有効デバイスの実際の消費電力を比較し、そ

の比率を表すグラフを提供します。 

注記： 

 描かれる棒は、指定した間隔にわたる平均の節約量を表します。 

 ネットワークで EnergyWise 管理ポリシーをまだ有効にしていない場合、最大消費

電力と実際の消費電力が同じになる可能性もあります。 

Overall Historical Power Consumption （総消費電力履歴） 

Overall Historical Power Consumption （総消費電力履歴）リソースは、ネットワーク

上のすべての EnergyWise エンティティの実際の消費電力と最大消費電力の双方のグ

ラフを表示します。 

注記： ネットワークで EnergyWise 管理ポリシーをまだ有効にしていない場合、最大消

費電力と実際の消費電力が同じになる可能性もあります。 

その他の EnergyWise リソース  

デフォルトの EnergyWise Summary （EnergyWise サマリー）ビューで提供されるリソースに

加え、Orion NPM は、次に示す EnergyWise リソースを Orion ウェブ コンソールで提供して

います。 

注記： EnergyWise Summary （EnergyWise サマリー）ビューとそのリソースの詳細について

は、84 ページの「EnergyWise Summary （EnergyWise サマリー）ビューおよびリソース」を

参照してください。 
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Device Power Consumption （デバイスの消費電力） 

Device Power Consumption （デバイスの消費電力）リソースは、選択した EnergyWise 

エンティティの実際の消費電力と最大消費電力の双方のグラフを表示します。 

注記： 選択したデバイスで EnergyWise 管理ポリシーをまだ有効にしていない場合、最

大消費電力と実際の消費電力が同じになる可能性もあります。 

EnergyWise Interface Details （EnergyWise インターフェースの詳細） 

このリソースは、選択したインターフェース エンティティとその現在の電源レベルを即座に設

定できる能力について情報を提供します。現在の電源レベルの設定の詳細については、

84ページの「EnergyWise Interface Entity Power Levels （ EnergyWise インターフ

ェース エンティティの電源レベル）の管理」を参照してください。 

EnergyWise Interface Details （EnergyWise インターフェースの詳細）リソースは、選

択したインターフェース エンティティに関して次の情報を提供します。 

 Name （名前）リストは、表示されるインターフェース エンティティに定義されたユー 

ザー フレンドリな EnergyWise エンティティ名を示します。 

 Power Level （電源レベル）リストは、表示されるインターフェース エンティティによって

現在報告されている電源レベルに関連付けられた色アイコンを示します。 

注記： 電源レベルは、このリソースの Set Power Level （電源レベルの設定）をク

リックすることで、一時的にリセットできます。詳細については、84 ページの

「EnergyWise Interface Entity Power Levels （ EnergyWise インターフェース 

エンティティの電源レベル）の管理」を参照してください。 

 Power Level （電源レベル）リストは、表示されるインターフェース エンティティに現在

適用されているポリシーの電源レベルを示す色アイコンとラベルを示します。 

注記： 

o 電源レベルは、表示されるインターフェース エンティティの現在のローカル時間に

おいて、EnergyWise Policy Overview Calendar （EnergyWise ポリシーの

概要カレンダー）で報告される電源レベルと同じです。 

o ポリシーは、監視されるデバイスに設定するか、Orion Network Configuration 

Manager などの設定管理ユーティリティを使用して設定します。Orion NCM 

の詳細については、www.solarwinds.com をご覧ください。 

 Keywords （キーワード）リストでは、表示されるインターフェース エンティティに定義さ

れたキーワードを示します。 
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EnergyWise Node Details （EnergyWise ノードの詳細） 

EnergyWise Node Details （EnergyWise ノードの詳細）リソースは、選択したノード 

エンティティに関する次の情報を提供します。 

 Domain Name （ドメイン名）リストは、表示されるノード エンティティに定義された 

EnergyWise ドメインのユーザー フレンドリ名です。 

 Maximum Importance （最大重要度）フィールドは、表示されるノードに割り当て

られた重要度レベルを示します。 

 Number of Neighbors （ネイバー数）フィールドは、表示されるノード エンティティと 

EnergyWise 指令をやりとりできるその他の現在監視される EnergyWise エンティ

ティの数を示します。 

 Status （ステータス）フィールドは、表示されるノード エンティティで EnergyWise 電

力管理が現在有効になっているかどうかを示します。 

EnergyWise Policy Overview Calendar （EnergyWise ポリシーの概要カレンダー） 

EnergyWise Policy Overview Calendar （EnergyWise ポリシーの概要カレンダー）

リソースは、表示されるエンティティのポリシーまたは設定ベースの電源レベル割り当ての視

覚的な記録を提供します。EnergyWise の繰り返しポリシーは、1 時間単位で電源レ

ベルの割り当てを行い、このリソースは表示されるエンティティに対して、1 週間にわたって 

1 時間単位で割り当てた電源レベルをレポートします。 

注記： 

 すべての参照時刻は、表示されるエンティティの時刻であり、Orion NPM サーバーの

時間であるとは限りません。 

 ポ リ シ ーは 、監視され るデバ イ ス本体に設定する か 、 Orion Network 

Configuration Manager （ Orion NCM ）などの設定管理ユーティリティを使用し

て設定します。Orion NCM の詳細については、www.solarwinds.com をご覧くだ

さい。 

Entity Power Consumption （エンティティの消費電力） 

Entity Power Consumption （エンティティの消費電力）リソースは、表示される 

EnergyWise 有効エンティティの最大消費電力と実際の消費電力の双方のグラフを提

供します。 

注記： 選択したデバイスで EnergyWise 管理ポリシーをまだ有効にしていない場合、最

大消費電力と実際の消費電力が同じになる可能性もあります。 
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EnergyWise Summary （EnergyWise サマリー）ビューの追加 

次の手順は、Orion ウェブ コンソールの Views （ビュー）メニュー バーに EnergyWise 

Summary （EnergyWise サマリー）ビューを追加します。 

ウェブ  コンソールの  Views （ ビュー）メニュー  バーに  EnergyWise Summary 

（EnergyWise サマリー）ビューを追加するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上隅の Settings （設定）をクリックし、Orion ウェブサイトの管理者

ページの Customize （カスタマイズ）グループ内の Customize Menu Bars （メニュー 

バーのカスタマイズ）をクリックします。 

3. EnergyWise Summary （EnergyWise サマリー）ビューへのリンクを追加するウェブ コン

ソール メニュー バーの下で Edit （編集）をクリックします。 

4. 左側の Available items （利用可能な項目）リストから、EnergyWise ボタンをクリック

しながら右側の Selected （選択項目）リストの正しい位置にドラッグします。 

注記： Selected items （選択項目）リストの各項目は、リスト内の上から下の順序に従

って、選択したメニュー バーの左から右に並べられます。 

5. Submit （送信）をクリックします。 

 EnergyWise Interface Entity Power Levels 

（ EnergyWise インターフェース エンティティの電源レベル）の管理 

エンティティの電源レベルは通常、Orion Network Configuration Manager （Orion 

NCM）などの設定管理ユーティリティで定める繰り返しポリシーを使用して設定しますが、

Orion NPM では、選択した EnergyWise インターフェース エンティティの Inteface Details 

（インターフェースの詳細）ビューまたはウェブ コンソールのノード管理ユーティリティからインター 

フェース エンティティの現在の電源レベルを一時的に変更できます。 

いずれの場合も、EnergyWise インターフェース エンティティの現在アクティブな電源レベルを

一時的に変更するには、次の手順を実行する必要があります。 

注記： 

 監視される EnergyWise エンティティの電源レベルへの変更は、定義された繰り返しポリ

シーの次回に予定された適用までしか有効とはなりません。ポリシーは、監視されるデバイ

ス本体に手動で設定するか、Orion NCM などの設定管理ユーティリティを使用して設

定します。Orion NCM の詳細については、 www.solarwinds.com をご覧ください。 

http://www.solarwinds.com/
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 一部の Cisco IOS バージョンでは、EnergyWise レベルが 0-10 ではなく、1-11 として

レポートされる既知の問題が存在します。Orion NPM バージョン 10.1.2 以降では、レ

ポートされるレベルが自動的に内部で修正されます。また、監視しているデバイスの IOS 

がこの既知の問題の影響を受けないようにするため、Orion NPM もこの問題を適切に

処理します。 

監視される EnergyWise エンティティの現在の電源レベルをリセットするには： 

1.  ノード管理または管理者特権を持つアカウントで Orion ウェブ コンソールにログオンし 

ます。 

2. Interface Details （インターフェースの詳細）ビューでエンティティ パワー レベルを設定す
る場合、EnergyWise Interface Details （ EnergyWise インターフェースの詳細）リ 

ソースの Set Power Level （電源レベルの設定）をクリックします。 

3. ウェブ コンソールのノード管理ユーティリティを使用する場合、次の手順を実行します。 

a. Views （ビュー）ツールバーで Home （ホーム）をクリックし、All Nodes （全ノード）リ

ソースの Manage Nodes （ノードの管理）をクリックします。 

b. 次のいずれかの方法を使用して、編集するデバイスを見つけます。 

 ノード リストの上にある検索ツールを使用し、リセットしたい EnergyWise インタ

ーフェース エンティティの親ノードを Orion データベース内で検索します。 

 適切な Group by （グループ化基準）を選択し、リセットしたい EnergyWise 

インターフェース エンティティの親ノードを含むグループをクリックします。 

c. + をクリックしてリセットする EnergyWise インターフェース エンティティの親ノードを展

開し、インターフェース エンティティを選択します。 

d. More Actions > Override Power Level （その他のアクション  > 電源レベルの

オーバーライド）の順でクリックします。 

4. 適切な電源レベルを選択して、OK をクリックします。 
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第 8章 

ワイヤレス ネットワークの監視 

Orion NPM は、IEEE 802.11 準拠の自律型アクセス ポイント（AP）またはワイヤレス コント

ローラを監視できます。アクセス ポイント（AP）、ワイヤレス クライアント、ワイヤレス コントローラ、

シン AP 、不正 AP の詳細を、Orion NPM を使用してすべて監視できます. ワイヤレス デバ

イスの監視は、次のセクションで示すように、Orion ウェブ コンソールを使用して設定、カスタマ

イズ、および管理します。 

はじめに 

Orion Network Performance Monitor は、ワイヤレス AP およびコントローラを Orion デー

タベースに追加すると、自動的にワイヤレス デバイスとして認識します。Orion へのデバイスの

追加の詳細については、35 ページの「ネットワーク デバイスのディスカバリと追加」を参照してく

ださい。 

ワイヤレス インターフェースは、ディスカバリ プロセス時に発見されません。その代わりに、ワイヤ

レス デバイスが Orion に追加され、インベントリが実行されると、各ワイヤレス インターフェース

がデータベースに追加され、ポーリングが開始します。 

 Wireless Networks Module （ワイヤレス ネットワーク モジュー
ル）からのデータの移行 

Orion NPM バージョン 9.5 以降にアップグレードする前に、既に古いバージョンの Wireless 

Network module （ワイヤレス ネットワーク モジュール）がインストールされており、ワイヤレス デ

バイスのポーリングを行っていた場合、Orion NPM は、Orion NPM バージョン 9.5 以降で使

用される新しいフォーマットに履歴データを自動的に移行します。 

注記： 

 ワイヤレスの移行は、インストールおよび設定時には実行されません。移行は、定期的な

データベース保守時にバッチ単位で実行されます。詳細については、399 ページの「データ

ベース保守」を参照してください。 

 所定のノードが移行されるか、Orion イベント ログですべてのノードが移行されると、ユー

ザーにそのことが通知されます。 

 このプロセスはスロットルされるため、すぐに履歴データが表示されません。 
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ワイヤレス データの表示 

Orion NPM ウェブ コンソールの Wireless Summary （ワイヤレス サマリー）ビューでは、すべ

てのワイヤレス アクセス ポイント（AP）と各 AP に接続されたクライアントのリストが表示されま

す。アクセス ポイントの詳細には、IP アドレス、デバイス タイプ、SSID、使用チャンネル、現在

接続されたクライアント数が含まれます。クライアントの詳細には、クライアント名、SSID、IP ア

ドレス、MAC アドレス、受信信号強度（RSSI）、接続時間、データ レート、受信および送信

バイト数が含まれます。次の手順では、Orion NPM でワイヤレス アクセス ポイントとクライアン

トを表示する方法を説明しています。 

注記： ワイヤレスの詳細ビューでは、統計情報を表示するために、デバイス別の node details 

（ノードの詳細）ビューを使用します。詳細については、186 ページの「デバイス タイプ別ビュー」

を参照してください。 

ワイヤレス アクセス ポイントとクライアントを表示するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. Views （ビュー）ツールバーで Wireless （ワイヤレス）をクリックします。 

3. アクセス ポイントを表示する場合、Show （表示）リストから Access Points （アクセ

ス ポイント）を選択します。 

4. クライアントを表示する場合、Show （表示）リストから Clients （クライアント）を選択

します。 

5. グループを使用してビューをフィルタリングする場合、Group by （グループ化基準）リストか

らアクセス ポイントまたはクライアントをグループ化する方法を選択します。 

6. アクセス ポイントに現在クライアントが接続している場合、アクセス ポイント名を展開する

と、接続されているクライアントのリストが表示されます。 

7. アクセス ポイントまたはクライアントを検索する場合、Search （検索）フィールドに検索文

字列を入力して、Search （検索）をクリックします。 

アクセス ポイントをクリックすると、該当するアクセス ポイントの Node Details （ノードの詳細）

ビューが開きます。 

ワイヤレス デバイスの削除 

Orion NPM からワイヤレス デバイスを削除する方法は、Orion からノードを削除する方法と

同じです。詳細については、227 ページの「監視するデバイスの削除」を参照してください。 

注記： 次回の毎夜の保守が完了すると、削除されたデバイスのすべてのワイヤレス統計情報

がデータベースから削除されます。詳細については、399 ページの「データベース保守」を参照

してください。 
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第 9章 

アラートの作成と管理 

アラートは、ネットワーク イベントに対して生成され、突発事象が発生した場合、または監視さ

れるインターフェース、ボリューム、ノードのしきい値を超えた場合にトリガーされます。アラートは、

曜日別、時間別、イベント別に異なる担当者に通知したり、時間、イベント、担当者の任意

の組み合わせで通知するように設定できます。次に示す複数の媒体を通じて、担当者に緊急

イベントを知らせるようにアラートを設定できます。 

  電子メールまたは呼び出しの送信 

  Orion Network Performance Monitor サーバーでのサウンド再生 

  アラートの詳細をファイルにログ記録 

  アラートの詳細を Windows イベント ログにログ記録 

  Syslog メッセージの送信 

  外部プログラムの実行 

  Visual Basic スクリプトの実行 

  ウェブ ページのメール送信 

  インターフェースまたはノードのプロパティ値の変更 

  テキスト音声変換出力の再生 

  Windows Net メッセージの送信 

  呼び出しまたは SMS サービスのダイヤル 

  SNMP トラップの送信 

  ウェブ サーバーへの URL の投稿 

デフォルトの定義済みアドバンスト アラート 

Orion NPM はデフォルトで、インストール時に設定される複数のアドバンスト アラートを提供

しています。次に示すアラートは、Orion ウェブ コンソールのインストール直後からすぐに利用可

能になり、ネットワークのステータスとパフォーマンスについて洞察をすぐに得ることができます。 
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 ノード、インターフェース、ワイヤレス アクセス ポイント、またはグループがダウンしたときにア 

ラートする 

 ノードの再起動時にアラートする 

 デバイスで高いパケット損失、高応答時間、または高い送信利用率が発生した場合にア

ラートする 

 グループが警告または危機的状態になった場合にアラートする 

 管理されるノードが過去 5 回のポーリング試行時にポーリングされなかった場合にアラート

する 

 管理されるノードの最後のポーリング時間から 10 分経過した場合にアラートする 

 ポーリング エンジンが 10 分以内にデータベースを更新しなかった場合にアラートする 

 不正アクセス ポイントの検出時にアラートする 

 ワイヤレス アクセス ポイントのクライアント数が 10 を超えた場合にアラートする 

 誰かがインターフェースをシャットダウンした場合にアラートする 

 高帯域幅使用率をアクセス ポイント別にアラートする 

 Cisco IOS バージョンまたはイメージ ファミリーの変更時にアラートする 

Orion ウェブ コンソールに初めてログインする際に、上記のアラートをトリガーするデバイスがネッ

トワーク上に存在する場合、Orion Summary Home （Orion サマリー ホーム）ビューの 

Active Alerts （アクティブ アラート）リソースに、トリガーされたアラートとその簡単な説明が表

示されます。定義済みアドバンスト アラートの設定または新しいアドバンスト アラートの作成の

詳細については、275 ページの「Orion アドバンスト アラートの使用  –  コア」を参照してくださ

い。 

基本アラートの設定 

システムに新しいアラートを追加すると、Configure Alerts （アラートの設定）ウィンドウにいくつ

かの定義済みアラートと一緒に表示されます。 

Configure Alerts （アラートの設定）ウィンドウを開くには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム  > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし 

ます。 



SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 アラートの作成と管理  91 

Configure Alerts （アラートの設定）ウィンドウでは、次のオプションが用意されています。 

 アラートのステータスをアクティブまたは非アクティブに設定するには、ターゲット アラートを選

択または選択解除します。アラートは、個別にアクティブまたは非アクティブにすることがで

きます。 

 新しいアラートを追加するには、New Alert （新しいアラート）をクリックします。詳細につ

いては、92 ページの「新しい基本アラートの作成 」を参照してください。 

 アラートをコピーするには、コピーするアラートを選択して、Copy Alert （アラートをコピー）

をクリックします。 

注記： このオプションは、類似する複数のアラートをすばやく作成する場合に役立ちます。

詳細については、98 ページの「基本アラート コピーの設定」を参照してください。 

 既存アラートのプロパティを変更するには、変更するアラートを選択し、Edit Alert （ア 

ラートの編集）をクリックします。詳細については、92 ページの「既存の基本アラート名の

編集」を参照してください。 

 Configure Alerts （アラートの設定）ウィンドウのリストからアラートを削除するには、削除

するアラートを選択し、Delete Alert （アラートの削除）をクリックします。 

注記： アラートを削除せずに、一時的に無効にしたい場合は、Configure Alerts （ア 

ラートの設定）ウィンドウでチェックマークを外します。 

 選択したアラートの設定をテストするには、Test Alerts （アラートのテスト）をクリックしま

す。詳細については、97 ページの「基本アラートのテスト 」を参照してください。 

 アラート設定を一時的に無効にする場合、Temporarily Disable all Actions for 

All Alerts （すべてのアラートに対するすべてのアクションを一時的に無効にする）を選択

し、すべてのアラートに対して設定されたアクションを無効にします。各アラートはログに記

録され、Alerts （アラート）ウィンドウに表示されますが、アラート アクションは実行されませ

ん。この機能は、既知のネットワーク問題に対応している間、アラート アクションが作業の

邪魔になる場合に特に役立ちます。 

Orion NPM では、幅広いネットワークの状態に対して、アラートを設定できます。次の手順で

は、基本アラートの作成、設定、および編集方法を示します。 



 管理者ガイド  SolarWinds Orion Network Performance Monitor 

 

 

92  アラートの作成と管理 

新しい基本アラートの作成 

次の手順は、新しい基本アラートを有効にします。 

新しい基本アラートを作成するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート > すべてのプログラム > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. New Alert （新しいアラート）をクリックします。 

4. Name of Alert （アラート名）フィールドに新しいアラートの名前を入力します。 

5. Enable this Alert （このアラートを有効にする）にチェックを選択します。 

既存の基本アラート名の編集 

基本アラートの名前は、次の手順で変更できます。 

基本アラート名を変更するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム  > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 編集するアラートにチェックを入れます。 

4. Edit Alert （アラートの編集）をクリックします。 

5. General （一般）タブをクリックします。 

6. Name of Alert （アラート名）フィールドに新しいアラート名を入力します。 

7. Enable this Alert （このアラートを有効にする）を選択します。 

8. アラートの設定を完了したら、OK をクリックします。 
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基本アラートで監視するプロパティの選択 

基本アラートで監視するネットワーク プロパティを選択するには、次の手順を実行します。 

基本アラートで監視するプロパティを選択するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム  > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 対象のアラートにチェックを入れます。  

4. Edit Alert （アラートの編集）をクリックします。 

5. Property to Monitor （監視プロパティ）タブをクリックします。 

6. 監視したい新しいネットワーク プロパティを選択します。 

注記： ほとんどのプロパティについて、選択時にウィンドウの一番下に説明が表示されます。

アラート アクションごとに 1 つのプロパティしか選択できません。新しい選択は前の選択を

置き換えます。このため、プロパティをクリックして説明を表示する際、前に表示したプロパ

ティの選択を解除する必要はありません。 

7. アラートの設定を完了したら、OK をクリックします。 

基本アラートで監視するネットワーク オブジェクトの選択 

基本アラートで監視するネットワーク オブジェクトを選択するには、次の手順を実行します。 

基本アラートで監視するネットワーク オブジェクトを選択するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム  > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 対象のアラートを選択します。 

4. Edit Alert （アラートの編集）をクリックします。 

5. Monitored Network Objects （監視ネットワーク オブジェクト）タブをクリックします。 
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6. アラートを適用するネットワーク オブジェクトを選択します。 

注記： デフォルトでは、すべてのオブジェクトが選択されています。このアラートで監視したく

ないオブジェクトのチェックを個別に外すか、Clear All （すべてクリア）と Select All （すべ

て選択）のボタンを使用します。 

7. アラートの設定を完了したら、OK をクリックします。 

基本アラートのアラート トリガーの設定 

基本アラート基本アラートのアラート トリガーを設定するには、次の手順を実行します。 

基本アラートのアラート トリガーを設定するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム  > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 対象のアラートを選択し、Edit Alert （アラートの編集）をクリックします。 

4. Alert Trigger （アラート トリガー）タブをクリックし、画面上の指示に従って、アラート トリ

ガーとリセット条件を設定します。 

注記： アラートがトリガーされると、指定したアクションが実行されます。リセット条件が満た

されるまで、アクションは繰り返されません。 

5. アラートの設定を完了したら、OK をクリックします。 

基本アラートの時刻の設定 

基本アラートの時刻を設定するには、次の手順を実行します。 

基本アラートの時刻を設定するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム  > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 対象のアラートを選択し、Edit Alert （アラートの編集）をクリックします。 

4. Time of Day （時刻）タブをクリックします。 
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5. アラートが監視する期間を入力します。入力した期間内にトリガー条件が満たされた場

合のみ、アラートがトリガーされます。 

6. アラートがネットワークを監視する曜日を選択します。選択した曜日にトリガー条件が満た

された場合のみ、アラートがトリガーされます。 

7. アラートの設定を完了したら、OK をクリックします。 

基本アラートのアラート抑制の設定 

基本アラートのアラート抑制を設定するには、次の手順を実行します。 

基本アラートのアラート抑制を設定するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム  > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 対象のアラートを選択し、Edit Alert （アラートの編集）をクリックします。 

4. Alert Suppression （アラート抑制）をクリックし、次のいずれか 1 つのオプションを選択

します。 

 Do not configure Alert Suppression for this Alert （このアラートに対して

アラート抑制を設定しない）。アラートを抑制する条件がない場合は、このオプション

を選択します。 

 Suppress this Alert if ANY of the selected Suppressions are Active 

（選択したいずれかの抑制がアクティブな場合、このアラートを抑制する）。アラートを

抑制する条件がある場合は、このオプションを選択します。 

 Suppress this Alert only if ALL of the selected suppressions are 

Active （選択したすべての抑制がアクティブな場合のみ、このアラートを抑制する）。

いくつもの条件がすべて満たされた場合のみ、アラート コピーを抑制する場合は、この

オプションを選択します。 
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5. すべてのアラート抑制、またはそのどれかを有効にする場合、次の手順でアラート抑制を
設定します。 

a. Add （追加）をクリックします。 

b. Property to Monitor （監視プロパティ）をクリックします。 

c. 抑制に関連するプロパティを選択します。 

d. Network Object （ネットワーク オブジェクト）をクリックします。 

e. 抑制プロパティの監視対象にするネットワーク オブジェクトを選択します。 

f. Suppression Trigger （抑制トリガー）をクリックします。 

g. 最初のアラートを抑制することになるネットワーク オブジェクトとプロパティの条件を選

択します。 

h. アラートに適用する抑制を選択します。 

注記： Edit （編集）と Delete （削除）をクリックし、必要に応じてそれぞれ抑制を編集ま

たは削除できます。詳細については、450 ページの「基本アラート エンジンの抑制例」を

参照してください。 

6. アラートの設定を完了したら、OK をクリックします。 

基本アラートのアクションの選択 

基本アラートのアクションを設定するには、次の手順を実行します。 

基本アラートのアクションを選択するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > Network Performance Monitor > System Manager （スタート > す

べてのプ ログ ラム  > SolarWinds Orion > Network Performance Monitor > 

Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. アクションを追加するアラートにチェックを入れ、Edit Alert （アラートの編集）をクリックし 

ます。 

4. Actions （アクション）をクリックします。 

5. Add Alert Action （アラート アクションの追加）をクリックし、アラート発生時に実行する

アクションを選択します。 
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6. 指示に従って、各アクションを設定します。アラート アクションの追加の詳細については、

103ページの「アラート アクションの追加」を参照してください。 

注記： Edit Alert Action （アラート アクションの編集）と Delete Selected Action 

（選択したアクションの削除）をクリックし、必要に応じてそれぞれアクションを編集または削

除できます。 

7.  基本アラートの設定を完了したら、OK をクリックします。 

基本アラートのテスト 

設定を確認するために、基本アラートのアクションを有効にする前にテストすることができます。

次の手順は、基本アラートのテスト方法を示します。 

基本アラートをテストするには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > Test Fire 

Alerts （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > アラートのテス
ト）の順でクリックします。 

2. Alert on Network Node （ネットワーク ノードに対してアラート実行）を選択します。 

3. アラートが参照するネットワーク ノードを選択します。 

4. インターフェースに対してアラートを実行する場合は、Alert on Network Interface （ネ
ットワーク インターフェースに対してアラート実行）をクリックして、選択したネットワーク ノー
ド上でアラートが参照するインターフェースを選択します。 

5. ボリュームに対してアラートを実行する場合は、Alert on Volume （ボリュームに対してア
ラート実行）をクリックして、選択したネットワーク ノード上でアラートが参照するボリューム
を選択します。 

6. Select an Alert to test fire （テストするアラートの選択）ドロップダウン メニューからテス
トするアラートを選択します。 

7. Test Alert Trigger （アラート トリガーのテスト）をクリックして、テストを開始します。 

注記： テストが完了したら、Test Alert Reset （アラート リセットのテスト）をクリックし、す
べてのトリガーをリセットします。 

8. エラーが発生した場合は、View Alert Error Log （アラート エラー ログの表示）をクリッ
クし、ログを確認します。 

9. エラーの確認後、エラー ログをクリアするには、Clear Alert Error Log （アラート エラー 

ログのクリア）をクリックします。 

10. テストする各アラートごとに、上記の手順を繰り返します。 

11. アラートのテストを完了したら、Done （完了）をクリックします。 
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基本アラート コピーの設定 

同じ条件やアラート アクションの複数の基本アラートを有効にしたい場合もあるでしょう。1 つま

たはわずかな特性のみ異なる複数の類似するアラートを設定するには、System Manager 

（システム マネージャ）の Copy Alert （アラートをコピー）機能を使用します。 

基本アラートをコピーするには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム  > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. コピーするアラートを選択して、Copy Alert （アラートをコピー）をクリックします。 

4. General （一般）をクリックします。 

5. Name of Alert （アラート名）フィールドにアラート コピーの名前を入力します。 

6. Enable this Alert （このアラートを有効にする）にチェックを選択します。 

アラート コピーの名前変更 

アラート コピーの名前は、次の手順で変更できます。 

アラート コピー名を変更するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム  > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 名前を変更するアラートを選択して、Edit Alert （アラートの編集）をクリックします。 

4. General （一般）をクリックして、Name of Alert （アラート名）フィールドにアラート コピー

の新しい名前を入力します。 

5. Enable this Alert （このアラートを有効にする）にチェックを選択します。 

6. アラート コピーの設定を完了したら、OK をクリックします。 
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アラート コピーの監視プロパティの変更 

アラート コピーの監視プロパティを変更するには、次の手順を実行します。 

アラート コピーの監視プロパティを変更するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート > すべてのプログラム > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 変更するアラート コピーを選択します。 

4. Edit Alert （アラートの編集）をクリックします。 

5. Property to Monitor （監視プロパティ）をクリックします。 

6. 監視したい新しいネットワーク プロパティを選択します。 

注記： ほとんどのプロパティについて、選択時にウィンドウの一番下に説明が表示されます。

アラート アクションごとに 1 つのプロパティしか選択できません。新しい選択は前の選択を

置き換えます。このため、プロパティをクリックして説明を表示する際に、前に表示したプロ

パティの選択を解除する必要はありません。 

7. アラート コピーの設定を完了したら、OK をクリックします。 

アラート コピーによって監視されるネットワーク オブジェクトの変更 

アラート コピーで監視するネットワーク オブジェクトを選択するには、次の手順を実行します。 

アラート コピーが監視するネットワーク オブジェクトを変更するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート> すべてのプログラム > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 変更するアラート コピーを選択して、Edit Alert （アラートの編集）をクリックします。 

4. Monitored Network Objects （監視ネットワーク オブジェクト）をクリックし、アラート コ

ピーを適用するネットワーク オブジェクトにチェックを入れます。 
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注記： デフォルトでは、すべてのオブジェクトが選択されています。このアラートで監視したく

ないオブジェクトのチェックを個別に外すか、Clear All （すべてクリア）と Select All （すべ

て選択）のボタンを使用します。 

5. アラート コピーの設定を完了したら、OK をクリックします。 

アラート コピーのアラート トリガーの変更 

アラート コピーのアラート トリガーを変更するには、次の手順を実行します。 

アラート コピーのアラート トリガーを変更するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート > すべてのプログラム > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 変更するアラート コピーを選択して、Edit Alert （アラートの編集）をクリックします。 

4. Alert Trigger （アラート トリガー）をクリックし、画面上の指示に従って、アラート トリガー

とリセット条件を設定します。 

注記： アラートがトリガーされると、指定したアクションが実行されます。リセット条件が満た

されるまで、アクションは繰り返されません。 

5. アラート コピーの設定を完了したら、OK をクリックします。 

アラート コピーの時刻の変更 

アラート コピーの時刻を変更するには、次の手順を実行します。 

アラート コピーの時刻を変更するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート > すべてのプログラム > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 変更するアラート コピーを選択します。 

4. Edit Alert （アラートの編集）をクリックします。 

5. Time of Day （時間帯）をクリックします。 

6. アラート コピーがネットワークを監視する期間を入力します。 
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注記： 入力した期間内にトリガー条件が満たされた場合のみ、アラートがトリガーされます。 

7. アラート コピーがネットワークを監視する曜日を選択します。 

注記： 選択した曜日にトリガー条件が満たされた場合のみ、アラートがトリガーされます。 

8. アラート コピーの設定を完了したら、OK をクリックします。 

アラート コピーのアラート抑制の変更 

アラート コピーのアラート抑制を変更するには、次の手順を実行します。 

アラート コピーのアラート抑制を変更するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート > すべてのプログラム > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 変更するアラート コピーを選択します。 

4. Edit Alert （アラートの編集）をクリックします。 

5. Alert Suppression （アラート抑制）をクリックし、次のいずれか 1 つのオプションを選択

します。 

 Do not configure Alert Suppression for this Alert （このアラートに対して

アラート抑制を設定しない）。アラートを抑制する条件がない場合は、このオプション

を選択します。 

 Suppress this Alert if ANY of the selected Suppressions are Active 

（選択したいずれかの抑制がアクティブな場合、このアラートを抑制する）。アラートを

抑制する条件がある場合は、このオプションを選択します。 

 Suppress this Alert only if ALL of the selected suppressions are 

Active （選択したすべての抑制がアクティブな場合のみ、このアラートを抑制する）。

いくつもの条件がすべて満たされた場合のみ、アラート コピーを抑制する場合は、この

オプションを選択します。 
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6. すべてのアラート抑制、またはそのどれかを有効にする場合、次の手順でアラート抑制を
設定します。 

a. Add （追加）をクリックします。 

b. Property to Monitor （監視プロパティ）タブをクリックし、抑制に関連するプロパティを

選択します。 

c. Network Object （ネットワーク オブジェクト）タブをクリックし、抑制プロパティの監視

対象にするネットワーク オブジェクトを選択します。 

d. Suppression Trigger （抑制トリガー）タブをクリックし、最初のアラートを抑制するこ

とになるネットワーク オブジェクトとプロパティの条件を選択します。 

e. アラートに適用する抑制を選択します。 

注記：抑制を選択して、Edit （編集）または Delete （削除）クリックすることで、それ

ぞれ必要に応じて抑制を編集または削除できます。詳細については、450 ページの

「基本アラート エンジンの抑制例」を参照してください。 

7. アラート コピーの設定を完了したら、OK をクリックします。 

アラート コピーのアクションの変更 

アラート コピーのアクションを変更するには、次の手順を実行します。 

アラート コピーのアクションを変更するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート > すべてのプログラム > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 変更するアラート コピーを選択して、Edit Alert （アラートの編集）をクリックします。 

4. Actions （アクション）をクリックし、Add Alert Action （アラート アクションの追加）をク 

リックして、アラート発生時に実行するアクションを選択します。 

5. 指示に従って、各アクションを設定します。 

注記： Edit Alert Action （アラート アクションの編集）と Delete Selected Action 

（選択したアクションの削除）をクリックし、必要に応じてそれぞれアクションを編集または削

除できます。 

6. アラート コピーの設定を完了したら、OK をクリックします。 



SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 アラートの作成と管理  103 

基本アラートの削除 

特定の基本アラートが不要になった場合は、次の手順に従って削除します。 

基本アラートを削除するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート > すべてのプログラム > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 削除するアラートを選択します。 

4. Delete Alert （アラートの削除）をクリックします。 

基本アラートの無効化 

基本アラートを無効にするには、次の手順を実行します。 

基本アラートを無効化するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート > すべてのプログラム > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Configure Basic Alerts （アラート > 基本アラートの設定）の順でクリックし

ます。 

3. 無効にするアラートのチェックボックスをクリアします。 

アラート アクションの追加 

Orion NPM は、ネットワークのアラート条件を知らせる各種アクションを提供しています。これ

らのアラート アクションは、基本およびアドバンスト アラートで利用可能で、次の手順は定義さ

れるアラート条件にアクションを割り当てます。 

アラート アクションを追加するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート > すべてのプログラム  > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 
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2. Alerts > Active Alerts （アラート> アクティブ アラート）の順でクリックし、Configure 

Basic Alerts （基本アラートの設定）または Configure Advanced Alerts （アドバ

ンスト アラートの設定）のいずれかをクリックします。 

3. アクションをトリガーするにはアラートに選択して、Edit Alert （アラートの編集）をクリックし

ます。 

4. Actions （アクション）をクリックして、編集するアクションを選択します。 

5. Add Alert Action （アラート アクションの追加）をクリックして、選択したアラートに追加

するアクションをクリックします。 

基本アラート アクションの詳細については、104 ページの「利用可能な基本アラート アクショ

ン 」を参照してください。アドバンスト アラートと利用可能なアクションの詳細については、275 

ページの「アドバンスト アラートの作成と設定」を参照してください。 

利用可能な基本アラート アクション 

次のセクションでは、基本アラートで利用できるアクション タイプごとの設定を説明します。アド

バンスト アラートと利用可能なアクションの詳細については、275 ページの「アドバンスト アラー

トの作成と設定」を参照してください。 

電子メール / 呼び出しの送信 

次の手順では、基本アラートの電子メール / 呼び出しアクションを設定します。 

注記： アラートをトリガーするように設定されたポーリング エンジンが SMTP サーバーにアクセス

できることを確認してください。 

基本アラートの電子メール / 呼び出しアクションを設定するには： 

1. Send an E-Mail / Page （電子メール / 呼び出しの送信）をクリックし、OK をクリックし

ます。 

2. E-mail/Pager Addresses （電子メール / ポケベル アドレス）タブで、To （送信先）、

CC 、BCC 、Name （名前）、および Reply Address （返信用アドレス）の各フィール

ドに入力します。 

注記： 

 To （送信先）フィールドに少なくとも 1 つのメールアドレスを入力する必要があります。

フィールドに複数のアドレスを入力する場合、アドレスをカンマで区切ります。 

 一部のポケベル システムでは、呼び出しを送信するために有効な返信用アドレスが

必要です。 
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3. SMTP Server （SMTP サーバー）タブで、SMTP サーバーの Hostname （ホスト名）ま

たは IP Address （ IP アドレス） と SMTP Port Number （SMTP ポート番号）を入

力します。 

注記： SMTP サーバーのホスト名と IP アドレスのフィールドを入力する必要があります。

SMTP サーバーを同定せずに電子メール / 呼び出しを送信することはできません。 

4. ご利用の SMTP サーバーが認証を必要とする場合、This SMTP Server requires 

Authentication （この SMTP サーバーは認証を必要とする）にチェックを入れます。 

5. Trigger Message （トリガー メッセージ）タブで、アラート トリガー電子メール / 呼び出し

の Subject （件名）と Message （メッセージ）を入力します。 

注記： 

 Subject （件名）と Message （メッセージ）フィールドが空白の場合、メッセージ送

信は抑制されます。 

 変数を使用したデフォルトの件名とメッセージが提供されます。変数の詳細について

は、440 ページの「基本的なアラート エンジンの変数」を参照してください。変数を使

用したメッセージ例は、449ページの「変数を使用するメッセージの例」を参照してくだ

さい。 

6. アラート リセット時のメッセージを指定する場合は、Reset Message （リセット メッセー

ジ）タブを開き、アラート リセット電子メール / 呼び出しの Subject （件名）と Message 

（メッセージ）を入力します。 

注記： 

 Subject （件名）と Message （メッセージ）フィールドが空白の場合、メッセージ送

信は抑制されます。 

 変数を使用したデフォルトの件名とメッセージが提供されます。変数の詳細について

は、440 ページの「基本的なアラート エンジンの変数」を参照してください。変数を使

用したメッセージ例は、449ページの「変数を使用するメッセージの例」を参照してくだ

さい。 

7. 電子メール / 呼び出しアラート アクションの設定を完了したら、OK をクリックします。 

サウンドの再生 

アラートのトリガーまたはリセット時に、音声を再生するように Orion NPM を設定できます。次

の手順では、基本アラートに対して再生する音声を設定します。 
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基本アラートの音声再生アクションを設定するには： 

1. Play a Sound （音声の再生）をクリックし、次に OK をクリックします。 

2. Sound file to play when Alert is triggered （アラート トリガー時に再生する音声ファ

イル）フィールドで、次のいずれかの方法でアラート トリガー時の音声ファイルを指定します。 

  完全なディレクトリ パスとファイル名を入力する 

  Browse （…）（参照）をクリックしてフォルダ構造を移動し、ファイルを指定する 

3. Sound file to play when Alert is reset （アラート リセット時に再生する音声ファイ

ル）フィールドで、次のいずれかの方法でアラート リセット時の音声ファイルを指定します。 

  完全なディレクトリ パスとファイル名を入力する 

  Browse （…）（参照）をクリックしてフォルダ構造を移動し、ファイルを指定する  

4.   テキスト フィールドの右にある音符をクリックし、指定した音声ファイルをテスト再生します。 

5. 音声再生アラート アクションの設定を完了したら、OK をクリックします。 

アラートをファイルに記録 

指定したファイルにアラートを記録するように Orion NPM を設定できます。次の手順では、基

本アラートを指定したファイルに記録します。 

基本アラートのアラート ログ ファイルを設定するには： 

1.  Log the Alert to a file （アラートをファイルに記録）をクリックして、OK をクリックします。 

2. Alert Log File （アラート ログ ファイル）フィールドで、次のいずれかの方法でアラート ログ 

ファイルを指定します。 

 ターゲット ファイルの完全パスと名前を入力する 

 Browse （…）（参照）をクリックして、サーバーを参照し、ターゲット ファイルを選択する 

注記： 指定したファイルが存在しない場合は、ファイルは作成され、最初のアラートが実

行されます。 

3. アラートのトリガー時に記録するデフォルトのメッセージを変更する場合、Message to 

log when the Alert is triggered （アラート トリガー時に記録するメッセージ）フィール

ドにメッセージを入力します。 
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注記： 

 Subject （件名）と Message （メッセージ）フィールドが空白の場合、メッセージ送

信は抑制されます。 

 変数を使用したデフォルトの件名とメッセージが提供されます。変数の詳細について

は、440 ページの「基本的なアラート エンジンの変数」を参照してください。変数を使

用したメッセージ例は、449ページの「変数を使用するメッセージの例」を参照してくだ

さい。 

4. アラートのリセット時に記録するデフォルト メッセージを変更する場合、Message to log 

when the Alert is reset （アラート リセット時に記録するメッセージ）フィールドにメッ 

セージを入力します。 

注記： 

 Subject （件名）と Message （メッセージ）フィールドが空白の場合、メッセージ送

信は抑制されます。 

 変数を使用したデフォルトの件名とメッセージが提供されます。変数の詳細について

は、440 ページの「基本的なアラート エンジンの変数」を参照してください。変数を使

用したメッセージ例は、449ページの「変数を使用するメッセージの例」を参照してくだ

さい。 

5. アドバンスト アラートの設定を終了したら、OK をクリックします。 

Windows イベント ログへのアラートの記録 

Orion NPM サーバーまたはリモート サーバーの Windows イベント ログにアラートを記録する

ように設定できます。次の手順では、基本アラートを指定したサーバーの Windows イベント 

ログに記録します。 

基本アラートを Windows イベント ログに記録するためを設定するには： 

1. Windows Event Log （Windows イベント ログ）をクリックし、OK をクリックします。 

2. Target Machine （ターゲット マシン）タブを開きます。 

3. Orion NPM サーバーの Windows イベント ログにアラートを書き込む場合、Log 

Message in Event Log on NetPerfMon Server （NetPerfMon サーバーのイベン

ト ログにメッセージを記録する）を選択します。 

4. リモート サーバーの Windows イベント ログにアラートを書き込む場合、Log Message 

in Event Log on Remote Server （リモート サーバーのイベント ログにメッセージを記

録する）を選択し、Remote Server Name （リモート サーバー名）または IP Address 

（IP アドレス） を入力します。 
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5. Trigger Message （トリガー メッセージ）タブで、トリガーされたアラートが指定したサー 

バーの Windows イベント ログに記録するメッセージを入力します。 

注記： 

 Subject （件名）と Message （メッセージ）フィールドが空白の場合、メッセージ送

信は抑制されます。 

 変数を使用したデフォルトの件名とメッセージが提供されます。変数の詳細について

は、440 ページの「基本的なアラート エンジンの変数」を参照してください。変数を使

用したメッセージ例は、449ページの「変数を使用するメッセージの例」を参照してくだ

さい。 

6. Reset Message （リセット メッセージ）タブで、リセットされたアラートが指定したサーバー

の Windows イベント ログに記録するメッセージを入力します。 

注記： 

 Subject （件名）と Message （メッセージ）フィールドが空白の場合、メッセージ送

信は抑制されます。 

 変数を使用したデフォルトの件名とメッセージが提供されます。変数の詳細について

は、440 ページの「基本的なアラート エンジンの変数」を参照してください。変数を使

用したメッセージ例は、449ページの「変数を使用するメッセージの例」を参照してくだ

さい。 

7. Windows イベント ログ アクションの設定を完了したら、OK をクリックします。 

Syslog メッセージの送信 

Orion NPM は、受信したアラートを指定したマシンの Syslog に記録できます。次の手順で

は、Syslog メッセージを送信するように基本アラートを設定します。 

Syslog メッセージを送信するように基本アラートを設定するには： 

1. Send a Syslog message （Syslog メッセージの送信）をクリックして、OK をクリックし

ます。 

2. Target Machine （ターゲット マシン）タブで、アラート トリガーまたはリセット時のメッセージ

送信先となる Syslog サーバーの Target Hostname （ターゲット ホスト名）または IP 

Address （IP アドレス） を入力します。 

3. Trigger Message （トリガー メッセージ）タブで、Syslog メッセージの Severity （重大

度）を選択します。詳細については、362 ページの「Syslog メッセージの優先順位」を参

照してください。 
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4. アラート  トリガー時に  Syslog に送信するデフォルト  メッセージを変更する場合、
Syslog フィールドにメッセージを入力します。 

注記： 

 Subject （件名）と Message （メッセージ）フィールドが空白の場合、メッセージ送

信は抑制されます。 

 変数を使用したデフォルトの件名とメッセージが提供されます。変数の詳細について

は、440 ページの「基本的なアラート エンジンの変数」を参照してください。変数を使

用したメッセージ例は、449ページの「変数を使用するメッセージの例」を参照してくだ

さい。 

5. アラート リセット時に Syslog に送信するデフォルト メッセージを変更する場合、Syslog 

フィールドにメッセージを入力します。 

注記： 

 Subject （件名）と Message （メッセージ）フィールドが空白の場合、メッセージ送

信は抑制されます。 

 変数を使用したデフォルトの件名とメッセージが提供されます。変数の詳細については、

440ページの「基本的なアラート エンジンの変数」を参照してください。変数を使用し

たメッセージ例は、449 ページの「変数を使用するメッセージの例」を参照してください。 

外部プログラムの実行 

特定のネットワーク イベントの発生時にプログラムを実行したい場合、次の手順で示すように、

Edit Execute Program Action （プログラムの実行アクションの編集）ウィンドウを使用して、

アラートのトリガーまたはリセット時に開始する実行ファイルの完全パスと名前を指定します。 

外部プログラムを実行するように基本アラートを設定するには： 

1. Execute an external program （外部プログラムの実行）をクリックして、OK をクリック

します。 

2. アラートのトリガー時に実行するプログラムを指定する方法として、Program to 

execute when Alert is Triggered （アラート トリガー時に実行するプログラム）フィー

ルドにターゲット ファイルの完全パスと名前を入力するか、Browse （…）（参照）をクリック

してフォルダ構造を参照し、ターゲット ファイルを選択します。 

3. アラートのリセット時に実行するプログラムを指定する方法として、Program to execute 

when Alert is Reset （アラート リセット時に実行するプログラム）フィールドにターゲット 

ファイルの完全パスと名前を入力するか、Browse （…）（参照）をクリックしてフォルダ構

造を参照し、ターゲット ファイルを選択します。 

4. 外部プログラム実行のアクションの設定を終了したら、OK をクリックします。 
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Visual Basic スクリプトの実行 

ネットワーク イベントの発生時に Visual Basic （VB）スクリプトを実行したい場合、Execute 

VB Script （VB スクリプトの実行）アクションを使用して、アラートのトリガーまたはリセット時に

実行するファイルの名前と完全パスを指定します。 

Visual Basic （VB）スクリプトを実行するように基本アラートを設定するには： 

1. Execute an external VB Script （外部 VB スクリプトの実行）をクリックして、OK を

クリックします。 

2. 利用可能な VB Script Interpreter （VB スクリプト インタープリタ）を選択します。 

3. アラートのトリガー時に実行する VB スクリプトを指定する方法として、VB Script to 

execute when Alert is triggered （アラート トリガー時に実行する VB スクリプト）フ

ィールドにスクリプトの完全パスと名前を入力するか、Browse （…）（参照）をクリックして

サーバーを参照し、スクリプトを選択します。 

4. アラートのリセット時に実行する VB スクリプトを指定する方法として、Program to 

execute when Alert is Reset （アラート リセット時に実行するプログラム）フィールドに

ターゲット ファイルの完全パスと名前を入力するか、Browse （…）（参照）をクリックして 

フォルダ構造を参照し、スクリプトを選択します。 

5. VB スクリプト実行のアクションの設定を終了したら、OK をクリックします。 

ウェブ ページのメール送信 

次の手順では、アラート発生時に指定したアドレスにウェブ ページを送信するように電子メール 

メッセージを設定します。 

基本アラートのウェブ ページ電子メールアクションを設定するには： 

1. E-mail a Web Page （ウェブ ページの電子メール送信）をクリックして、OK をクリックしま

す。 

2. E-mail/Pager Addresses （電子メール / ポケベル アドレス）タブで、To （送信先）、

CC、BCC、Name （名前）、および Reply Address （返信用アドレス）の各フィールド

に入力します。 

注記： 

 To （送信先）フィールドに少なくとも 1 つのアドレスを入力する必要があります。フィー

ルドに複数のアドレスを入力する場合、アドレスをカンマで区切ります。 

 一部のポケベル システムでは、呼び出しを送信するために有効な返信用アドレスが

必要です。 
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3. SMTP Server （SMTP サーバー）タブで、SMTP サーバーの Hostname （ホスト名）ま

たは IP Address （IP アドレス） と SMTP Port Number （SMTP ポート番号）を入

力します。 

注記： SMTP サーバーのホスト名と IP アドレスのフィールドを入力する必要があります。

SMTP サーバーを指定せずに、ウェブ ページに電子メールを送信することはできません。 

4. セキュア ソケット レイヤーによるセキュリティを有効にするには、Enable SSL （SSL を有

効にする）にチェックを入れます。 

5. ご利用の SMTP サーバーが認証を必要とする場合、This SMTP Server requires 

Authentication （この SMTP サーバーは認証を必要とする）にチェックを入れます。 

6. Trigger URL （トリガー URL）タブで、アラート トリガー時のウェブ ページ メールの 

Subject （件名）と Web Page URL （ウェブ ページの URL）を入力します。 

注記： 

 Subject （件名）と Message （メッセージ）フィールドが空白の場合、メッセージ送

信は抑制されます。 

 変数を使用したデフォルトの件名とメッセージが提供されます。変数の詳細について

は、440 ページの「基本的なアラート エンジンの変数」を参照してください。変数を使

用したメッセージ例は、449ページの「変数を使用するメッセージの例」を参照してくだ

さい。 

7. 入力した URL のプレビューを表示するには、URL のプレビュー をクリックします。 

8. アラート トリガーの発生時にメールを送信する URL のウェブ サーバーでユーザー アクセス
認証が必要な場合、Optional Web Server Authentication （オプションのウェブ サー

バー認証）領域で、Web Server UserID （ウェブ サーバー ユーザー ID）と Web 

Server Password （ウェブ サーバー パスワード）の両方を入力します。 

9.  アラート リセット時に URL を送信する場合は、Reset URL （リセット URL）タブを開き、

アラート リセット メールの Subject （件名）と Web Page URL （ウェブ ページの URL）

を入力します。 

注記： 

 Subject （件名）と Message （メッセージ）フィールドが空白の場合、メッセージ送

信は抑制されます。 

 変数を使用したデフォルトの件名とメッセージが提供されます。変数の詳細について

は、440 ページの「基本的なアラート エンジンの変数」を参照してください。変数を使

用したメッセージ例は、449ページの「変数を使用するメッセージの例」を参照してくだ

さい。 

10.  入力した URL のプレビューを表示するには、URL のプレビュー をクリックします。 
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11.  アラート リセット時にメールを送信する URL のウェブ サーバーでユーザー アクセス認証が
必要な場合、Optional Web Server Authentication （オプションのウェブ サーバー認

証）領域で、Web Server UserID （ウェブ サーバー ユーザー ID）と Web Server 

Password （ウェブ サーバー パスワード）の双方を入力します。 

12.  URL の電子メール送信アラート アクションの設定を完了したら、OK をクリックします。 

カスタム プロパティの変更 

基本アラートのトリガーまたはリセット時に、基本アラートがカスタム プロパティ値を変更するよう

に設定できます。これは、プロパティ値に基づいて Orion ウェブ コンソール ビューのユーザーを

制限した場合に役立ちます。ユーザーに監視が必要なデバイスを動的に知らせることができま

す。監視を必要とする各問題に対して、プロパティにカスタム URL を投入することもできます。

アカウント制限の詳細については、253 ページの「アカウント制限の設定」を参照してください。

カスタム プロパティの詳細については、375 ページの「カスタム プロパティの作成  –  コア」を参

照してください。 

次の手順では、基本アラートのトリガーまたはリセット時に、カスタム プロパティを変更するように

設定します。 

基本アラートのトリガーまたはリセット時にカスタム プロパティを変更するには： 

1. Change Custom Property （カスタム プロパティの変更）をクリックし、OK をクリックし

ます。 

2. Property （プロパティ）フィールドに、カスタム プロパティの名前を入力します。  

注記： Custom Property Editor （カスタム プロパティ エディタ）アプリケーション内の 

Edit （編集）ビューの表見出しに表示されるプロパティ名と全く同じ名前を入力する必要

があります。詳細については、375 ページの「カスタム プロパティの作成  –  コア」を参照し

てください。 

3. 上記のプロパティをアラート トリガー時に変更する場合は、Value to set when Alert 

is Triggered （アラート トリガー時に設定する値）フィールドに新しい値を入力します。  

4. 上記のプロパティをアラート リセット時に変更する場合は、Value to set when Alert 

is Reset （アラート リセット時に設定する値）フィールドに新しい値を入力します。 

5. カスタム プロパティの変更アクションの設定を完了したら、OK をクリックします。 

テキスト音声変換出力の使用 

アラートがトリガーされる時に読み上げられる語句を指定することができます。Orion NPM は、

Windows 2003 と XP Professional に含まれる Microsoft Speech Synthesis Engine 

バージョン 5.0 を使用します。Orion NPM の保守期間内であれば、SolarWinds ウェブサイ
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トにアクセスして、他のテキスト音声変換エンジンをインストールして使用できます。次の手順で

は、基本アラートのトリガーまたはリセット時のテキスト音声変換出力を設定します。 

基本アラートのトリガー時またはリセット時のテキスト音声変換出力を設定するには： 

1. Text to Speech output （テキスト音声変換出力）をクリックし、OK をクリックします。 

2. General （一般）タブでスピーチ エンジンを選択し、必要に応じて Speed （速度）、

Pitch （音程）、および Volume （音量）の各スライダーを調整します。 

3. Trigger Phrase （トリガー フレーズ）タブを開きます。 

注記： 変数を使用したデフォルトのトリガー アラート フレーズが提供されます。必要に応

じて、このテキストを変更することもできます。変数の使用の詳細については、431 ページ

の「Orion NPM 変数と例」を参照してください。 

4. アラートのトリガー時に新しいフレーズを読み上げる場合は、Phrase to speak when 

Alert is Triggered （アラート トリガー時に読み上げるフレーズ）フィールドに新しいフ 

レーズを入力します。 

5. テキスト音声変換メッセージをテストするには、Speak （読み上げ）をクリックします。 

注記： スピーチ エンジンに搭載されている場合は、Pronunciation Dictionary （発音

辞書）をクリックして、言葉の発音を調整できます。 

6. Reset Phrase （リセット フレーズ）タブを開きます。 

7. アラートのリセット時にフレーズを読み上げる場合は、Phrase to speak when Alert 

is Reset （アラート リセット時に読み上げるフレーズ）フィールドに新しいフレーズを入力し

ます。  

8. テキスト音声変換メッセージをテストするには、Speak （読み上げ）をクリックします。 

 注記： スピーチ エンジンに搭載されている場合は、Pronunciation Dictionary （発

音辞書）をクリックして、言葉の発音を調整できます。 

9. テキスト音声変換アクションの設定を完了したら、OK をクリックします。 
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Windows Net メッセージの送信 

アラートを設定して、指定したコンピュータか、選択したドメインまたはワークグループ内のすべて

のコンピュータで、Windows Net メッセージをポップアップ表示できます。次の手順では、トリ 

ガーまたはリセットしたアラートの Windows Net メッセージを設定します。 

注記： Windows Server 2008 は Windows Net メッセージをサポートしていないため、

Orion NPM を Windows Server 2008 にインストールした場合、このアクションは利用でき

ません。 

アラート発生時に Windows Net メッセージを送信するように Orion NPM を設定するには： 

1.   Send a Windows Net Message （Windows Net メッセージの送信）をクリックして、

OK をクリックします。 

2. Target Machine （ターゲット マシン）または Domain （ドメイン） タブで、アラートのトリ

ガーまたはリセット時に Windows Net メッセージの送信先マシンの Computer Name 

or IP Address （コンピュータ名または IP アドレス）を入力します。 

3. ドメインまたは対象となるコンピュータのワークグループのすべてのコンピュータにメッセージを
送信する場合は、Send to all Computers in the Domain or Workgroup （ドメ

インまたはワークグループのすべてのコンピュータに送信する）にチェックを入れます。 

4.  アラートのトリガー時に送信するデフォルトの Windows Net メッセージを変更する場合、
Trigger Message （トリガー メッセージ）タブをクリックして、Message to send when 

Alert is Triggered （アラート トリガー時に送信するメッセージ）テキストボックスにメッ 

セージを入力します。 

注記： このメッセージで変数を使用することもできます。変数の使用の詳細については、

431 ページの「Orion NPM 変数と例」を参照してください。 

5.  アラートのリセット時に送信するデフォルトの Windows Net メッセージを変更する場合、
Reset Message （リセット メッセージ）タブをクリックして、Message to send when 

Alert is Reset （アラート リセット時に送信するメッセージ）テキストボックスにメッセージを

入力します。 

注記： このメッセージで変数を使用することもできます。変数の使用の詳細については、

431 ページの「Orion NPM 変数と例」を参照してください。 

6.  このアクションの設定を完了したら、OK をクリックします。 
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呼び出しまたは SMS サービスのダイヤル 

アラートのトリガー時に呼び出しまたは SMS サービスにダイヤルするようにアラートを設定できま

す。現在、Orion NPM の基本アラートは、NotePage, Inc. の NotePager Pro に組み込

むことができます。NotePager Pro を Orion NPM で使用する設定の詳細については、 

http://www.notepage.net/solar-winds/orion.htm を参照してください。 

SNMP トラップの送信 

次の手順を実行することで、アラートを設定し、トリガーまたはリセットに関する SNMP トラップ

を送信します。 

アラート発生時に SNMP トラップを送信するように Orion NPM を設定するには： 

1. Send an SNMP Trap （SNMP トラップの送信）をクリックして、OK をクリックします。 

2. Target Machines （ターゲット マシン）タブの Add Trap Destination （トラップ送信先

の追加）フィールドに、送信先 Orion NPM サーバーのホスト名または IP アドレスを入力

して、Add （追加）をクリックします。 

 注記： 追加する送信先マシンごとに、この手順を繰り返します。 

3. Send SNMP Traps to the following machines （SNMP トラップの送信先マシ
ン）フィールドに、SNMP トラップの送信先として不要なマシンがある場合は、リストから該
当するマシンを選択して、Delete （削除）をクリックします。 

4. ネットワークの SNMP Community String （SNMP コミュニティ ストリング）を指定され

たフィールドで入力します。 

5. Trap to Send on Trigger （トリガー時に送信するトラップ）タブの Trap Template （トラッ

プ テンプレート）リストから、アラートのトリガー時に送信するトラップの種類を選択します。 

注記： 一部のトラップ テンプレートはアラート メッセージを使用できるため、トリガー アラー

ト メッセージ用に変数を使用するデフォルト メッセージも提供されます。このテキストは必

要に応じて変更可能ですが、事前に変数の使用について理解しておくことが重要です。

変数の使用の詳細については、431 ページの「Orion NPM 変数と例」を参照してくださ

い。 

6. 選択したアラートのトリガー時に送信される SNMP トラップのデフォルト メッセージを変更
する場合、Some Trap templates may use an Alert Message （一部のトラップ 

テンプレートはアラート メッセージを使用）テキスト ボックスに新しい SNMP トラップ メッ 

セージを入力します。 

7. Trap to Send on Reset （リセット時に送信するトラップ）タブの Trap Template （ト 

ラップ テンプレート）リストから、アラートのリセット時に送信するトラップの種類を選択します。 

http://www.notepage.net/solar-winds/orion.htm
http://www.notepage.net/solar-winds/orion.htm
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8. アラートのリセット時に SNMP トラップを送信する場合、Some Trap templates may 

use an Alert Message （一部のトラップ テンプレートはアラート メッセージを使用）テキ

スト ボックスに SNMP トラップ メッセージを入力します。 

9. Orion NPM の SNMP トラップ送信の設定を完了したら、OK をクリックします。 

GET または POST URL 機能の使用 

HTTP GET または POST 関数を使用してアラートを伝えるように Orion NPM を設定でき

ます。サンプルとして、URL はトラブル チケット システムへのインターフェースとして使用され、さ

らに GET 機能を正しくフォーマットすることで新しいトラブル チケットが自動作成されます。次

の手順では、アラート情報のやり取りに GET または POST HTTP 関数を使用するように 

Orion NPM を設定します。 

GET または POST URL 関数をアラートで使用するように Orion NPM を設定するには： 

1. Get or Post a URL to a Web Server （ウェブ サーバーに URL を Get または Post 

する）をクリックし、OK をクリックします。 

2. Use HTTP GET （HTTP GET を使用）か Use HTTP POST （HTTP POST を使

用）のどちらかを選択し、アラート情報と通信するのに使用する機能を設定します。 

3. アラート  トリガー時の  GET または  POST する URL を  URL when Alert is 

Triggered （アラート トリガー時の URL）フィールドに入力します。 

4. アラート リセット時の GET または POST する URL を URL when Alert is Reset 

（アラート リセット時の URL ）フィールドに入力します。 

5. HTTP GET または POST URL 関数を使用するように Orion NPM を設定したら、
OK をクリックします。 

基本アラートの追加ポーリング エンジンへのコピー 

アドバンスト アラートとは異なり、基本アラートの定義はポーリング エンジンに入力されています。

追加ポーリング エンジンに移行したノードに基本アラートを適用する場合、各基本アラートの

定義のコピーを作成し、新しい追加ポーリング エンジンに入力する必要があります。追加ポーリ

ング エンジンの詳細については、165 ページの「追加ポーリング エンジンの使用」を参照してく

ださい。 

次の手順では、プライマリの Orion ポーリング エンジンから追加ポーリング エンジンに基本ア 

ラートをコピーする方法を提供しています。 
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追加ポーリング エンジンに基本アラートをコピーするには： 

1. 管理者アカウントを使用して、プライマリ Orion NPM サーバーにログインします。 

2. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム   > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

3. Alerts （アラート）をクリックして、Configure Basic Alerts （基本アラートの設定）をク

リックします。 

4. 追加ポーリング エンジンによって監視されるデバイスに適用するアラートごとに、次の手順

を実行します。 

注記： コピーするアラートごとに、この手順を繰り返します。 

a.  コピーするアラートにチェックを入れて、Copy Alert （アラートをコピー）をクリックします。 

b. General （一般）タブで、Name of Alert （アラート名）フィールドでアラートの名前

を編集し、追加ポーリング エンジンのアラートであることを示します。 

c. Monitored Network Objects （監視されたネットワーク オブジェクト）タブで、コピー

したアラートが適切なネットワーク デバイスに適用されたことを確認します。 

d. 必要に応じて他のタブも設定し、Done （完了）をクリックします。詳細については、

90ページの「基本アラートの設定」を参照してください。 

5. Start > All Programs > SolarWinds Orion > Advanced Features > Monitor 

Polling Engines （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能  > 

ポーリング エンジンの監視）の順でクリックします。 

6. 基本アラートのコピー先となる追加ポーリング エンジンを表すアイコンをクリックします。 

7. 追加ポーリング エンジンの Engine ID （エンジン ID）を書き留めます。 

8. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データ

ベース マネージャ）をクリックします。 

9. 左ペインの + をクリックし、SQL Server と Orion データベースの双方を展開します。 

注記： 

 ご利用の SQL Server と Orion データベースがリストに存在しない場合は、それらを

追加する必要があります。SQL Server と Orion データベースの追加の詳細につい

ては、387 ページの「データベース マネージャの使用」を参照してください。 

 SolarWinds Orion が、Orion データベースのデフォルト名です。 

10.  展開した Orion データベース テーブルのリストで Alerts （アラート）をクリックします。 



 管理者ガイド  SolarWinds Orion Network Performance Monitor 

 

 

118  アラートの作成と管理 

11.  Table > Query Table （テーブル > クエリー テーブル）の順でクリックし、Read-Write 

（Results can be edited） （読み書き可能（結果の編集可））を選択します。 

12.  クエリー フィールドをクリアにし、空白のフィールドに次のクエリーを入力します。 

注記： EngineID は、上記の Monitor Polling Engines （ポーリング エンジンを監視）

ユーティリティにある値です。‘APE ‘ は、追加ポーリング エンジンでアラートを識別するた

めに提案される文字列です。 

 UPDATE [SolarWinds Orion].[dbo].[Alerts] 

 SET [EngineID]='EngineID', [AlertName]='APE ' + [AlertName] 

 WHERE [AlertName] Like ‘Copy%’ 

13.  Refresh （更新）をクリックします。 

Orion ウェブ コンソールのアラートの表示 

Orion ウェブ コンソールの Alerts （アラート）ビューでは、現在トリガーされたすべてのアラートが

表形式で表示されます。ウェブ コンソールでのアラート表示の詳細については、312 ページの

「Orion ウェブ コンソールのアラートの表示」を参照してください。 

Orion NPM System Manager （システム マネージャ）における
アラートの表示 

System Manager （システム マネージャ）の一部として、Orion NPM は アラート ログの表 

ビューを表示する Active Alerts （アクティブ アラート）ウィンドウも提供します。次の手順で望

ましいアラートのグループ化基準を選択すると、リスト ビューをカスタマイズできます。 

System Manager （システム マネージャ）でアラートを表示するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート > すべてのプログラム > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. Alerts > Active Alerts （アラート > アクティブ アラート）の順でクリックします。 

3. 必要に応じて、Basic Alerts （基本アラート）または Advanced Alerts （アドバンスト ア

ラート）のどちらかを選択します。 

4. 基本アラートを表示する場合、次のように表示をカスタマイズします。 

a. Group By （グループ化基準）リストから Type of Alert （アラート タイプ）または 

Node （ノード）のいずれかを選択し、Active Alerts （アクティブ アラート）の表示を

変更します。 
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b. 適切なカラムのタイトルをクリックし、次の条件でアラート リストの表示順序を並び替

えます。Alert Time （アラート時間）、Network Object （ネットワーク オブジェク

ト）、または Current Value （現在の値）。 

5. アドバンスト アラートを表示する場合には、次のように Active Alerts （アクティブ アラー

ト）の表示をカスタマイズします。 

a. Group By （グループ化基準）リストの次のオプションから選択し、Active Alerts （ア

クティブ アラート）ビューを変更します。Alert Name （アラート名）、Object Type 

（オブジェクト タイプ）、Object Name （オブジェクト名）、Alert State （アラート ス

テータス）、Acknowledged （承認済み）、Acknowledged By （確認者）または 

No Grouping （グループなし）。 

b. 適切なカラムをクリックし、次の条件でアラート リストの表示順序を並び替えます。

Acknowledged （確認済み）、Alert Name （アラート名）、Alert State （アラー

ト状態）、Object Name （オブジェクト名）、Triggered Time （トリガー時間） 

Acknowledged By （確認者）、Acknowledge Time （確認時間）。 

6. 最新のトリガー アラートを表示するには、Refresh （更新）をクリックします。 

アドバンスト アラートの確認 

Orion NPM では、System Manager （システム マネージャ）または Orion ウェブ コンソール

を使用して、アドバンスト アラートを確認できます。アラートを確認することにより、複数のユー

ザーが同じ問題や、既に解決済みの問題の解決を試みることで発生する時間の損失を排除

します。 

注記： System Manager （システム マネージャ）におけるアラート表示の詳細については、

156ページの「System Manager （システム マネージャ）におけるアラートの表示」を参照して

ください。ウェブ コンソールにおけるアラート確認の詳細については、313 ページの「ウェブ コンソ

ールでアドバンスト アラートの承認」を参照してください。   

次の手順では、System Manager （システム マネージャ）でアラートを確認する方法を示します。 

System Manager （システム マネージャ）を使用してアドバンスト アラートを確認するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム  > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックし 

ます。 

2. Alerts > Active Alerts （アラート > アクティブ アラート）の順でクリックします。 

3. Advanced Alerts （アドバンスト アラート）をクリックします。 

4. 確認するアラートの横にある Acknowledged （確認済み）にチェックを入れます。 
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第 10章 

ネットワーク マップの作成 

Orion Network Atlas は、カスタム マップやネットワーク図を作成するための強力なツールです。

Orion Network Atlas で作成するマップにより、ユーザーは Orion ウェブ コンソールでグラフィ

カルに表現されたネットワークを見ることができます。また、ネットワーク文書の作成にマップを使

用し、必要に応じて印刷したり、エクスポートすることができます。 

マップ オブジェクトには、監視される Orion NPM ノード、インターフェース、およびボリューム、

Orion APM アプリケーションおよびコンポーネント、ネストされたマップ、ネットワーク リンクなどが

含まれます。ネットワーク マップで使用できる数々のプレゼンテーション オプションには、以下が

含まれます。 

 マップで使用できる豊富な定義済みの背景色、模様、画像が用意されています。独自

のカスタム背景画像を使用することもできます。 

 リンク付けされたウェブ画像を背景にすることで、リアルタイムの天気図や自然災害地図を

ネットワーク マップに直接表示できます。 

 マップ リンクの形、サイズ、色、スタイルをカスタマイズし、関連オブジェクトのステータスや相

対帯域幅を図示することができます。 

 ネットワーク状態を示すように、マップ オブジェクトを独自のグラフィック スタイルで表示でき

ます。 

 マップの詳細を徐々に明らかにするようにマップをネスト化したり、ネストしたマップの子オブ

ジェクトのステータスを親マップにバブル表示することができます。 

Orion Network Atlas は、過去のバージョンの Orion NPM の Orion Map Maker で作成

したすべてのネットワーク マップとの完全な互換性があります。Orion Network Atlas の詳細

については、 http://www.solarwinds.com/support/orionModules/modulesDoc.aspx に

ある『SolarWinds Orion Network Atlas 管理者ガイド 』を参照してください。 

 

 

 

 

http://www.solarwinds.com/support/orionModules/modulesDoc.aspx




SolarWinds Orion Network Performance Monitor 管理者ガイド 

 

 

 Orion NPM レポート 123 

第 11章 

DOCPROPERTY ProductShort \* 

MERGEFORMAT Orion NPM レポート 

時間の経過と共に、Orion NPM のデータベースには大量の情報が蓄積されるため、

SolarWinds はデータベースからすばやくかつ簡単にデータを抽出し、使いやすい形式で表示

する Orion Report Writer を開発しました。修正可能な複数の標準的レポートが Report 

Writer に含まれており、必要に応じて新しいレポートも作成できます。Report Writer は強力

なツールを備えており、ユーザーが情報をフォーマット化し、表示する前にレポートを簡単にプレ

ビューするのをサポートします。レポートの編集を終えると、ボタン 1 つで印刷することができ、

Orion Network Performance Monitor ウェブ コンソールの Reports （レポート）ビューを通

して（デフォルト）表示したり、ウェブ コンソール ビューに含まれる Orion Report Writer リソース

からレポートを閲覧することができます。Orion ウェブ コンソールでのレポート表示の詳細につい

ては、327 ページの「レポートの表示」を参照してください。 

注記： Report Writer をカスタム プロパティと併用すると、機能が強化されます。プロパティを

追加すると、レポートの分類やフィルタリングに使用できるようになります。詳細については、 

375 ページの「カスタム プロパティの作成  –  コア」を参照してください。 

定義済み Orion NPM レポート 

次のセクションでは、すべての Orion 製品の定義済みレポートに加え、Orion NPM でのみ提

供されるレポートについて説明しています。すべての定義済みレポートは、必要に応じて、ネッ

トワーク パフォーマンスのレポート要件に合わせて変更できます。すべての Orion インストレー

ションで提供される定義済みレポートの詳細については、321 ページの「定義済みの Orion レ

ポート」を参照してください。 

注記： 必要とするレポートが次のセクションに含まれない場合は、Orion Report Writer を使

用して独自のカスタム レポートを作成してください。独自のカスタム レポート作成の詳細につい

ては、330 ページの「レポートの作成と修正」を参照してください。 
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現在のインターフェース ステータス 

次のインターフェース ステータス レポートは、Orion NPM によってデフォルトで提供されます。 

Current Percent Utilization - Top 25 Interfaces （現在の利用率 - トップ 25 インター

フェース） 

現在の利用率トップ 25 の監視されるインターフェースを表示します。インターフェースは、

その親ノード、送受信利用率の合計平均、および送受信トラフィック速度と共に表示さ

れます。 

Current Traffic - All Interfaces （現在のトラフィック量 - すべてのインターフェース） 

監視されるすべてのインターフェース上の現在のトラフィック負荷の詳細レポートを表示しま

す。すべての監視ノードは、それぞれインターフェースと共に表示されます。このレポートは、

各インターフェースに対して、送受信トラフィック速度、および送受信利用率を表示します。 

Current Traffic - Top 25 Interfaces （現在のトラフィック量 - トップ 25 インターフェース） 

現在のトラフィック負荷トップ 25 の、監視されるインターフェースの詳細レポートを表示し

ます。このレポートは、各インターフェースに対して、親ノード、送受信トラフィック速度、およ

び送受信利用率を表示します。 

Down Interfaces （ダウン インターフェース） 

現在ダウンしている、監視されるすべてのインターフェースを表示します。 

EnergyWise Reports （EnergyWise レポート） 

次の EnergyWise 有効デバイスに関するレポートは、Orion NPM によってデフォルトで提供

されています。 

注記： EnergyWise エネルギー管理を搭載した監視デバイスの詳細については、77 ページ

の「EnergyWise デバイスの監視 」を参照してください。 

Current EnergyWise Status per Interface （ イ ン タ ー フ ェ ー ス別の現在の 

EnergyWise ステータス） 

ネットワーク上の EnergyWise 有効デバイスのすべてのインターフェースのリストを表示し

ます。各インターフェースに対して、このレポートは、見出し、エンティティ名、インターフェー

スの役割などを含むインターフェースの識別情報と次の EnergyWise 関連情報を提供

します。 
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 Interface Status （インターフェース ステータス） 

 Current EnergyWise Energy Level （現在の EnergyWise エネルギー レベル） 

 EnergyWise Events Count （EnergyWise イベント カウント） 

詳細については、77 ページの「EnergyWise デバイスの監視」を参照してください。 

Total Energy Consumption and Savings NetworkWide – Last 7 Days （ネット 

ワーク全体の総エネルギー消費量および節約量 – 過去 7 日間） 

ネットワーク上で監視されるすべての EnergyWise 対応デバイスの過去 7 日間の平均

および最大エネルギー消費量と平均エネルギー節約量を表示します。詳細については、

77 ページの「EnergyWise デバイスの監視を参照してください。 

Total Energy Consumption and Savings NetworkWide – Last Month （ネット 

ワーク全体の総エネルギー消費量および節約量 – 過去 1 ヶ月） 

ネットワーク上のすべての EnergyWise 有効デバイスの過去 1 ヶ月の平均および最大エ

ネルギー消費量と平均エネルギー節約量を表示します。EnergyWise エネルギー管理

の詳細については、77 ページの「EnergyWise デバイスの監視を参照してください。 

Total Energy Consumption and Savings NetworkWide – This Month （ネット 

ワーク全体の総エネルギー消費量および節約量 – 今月） 

ネットワーク上のすべての EnergyWise 有効デバイスの今月の平均および最大エネルギ

ー消費量と平均エネルギー節約量を表示します。EnergyWise エネルギー管理の詳細

については、77 ページの「EnergyWise デバイスの監視を参照してください。 

Total Energy Consumption and Savings per EnergyWise Device – Last  

7 Days （EnergyWise デバイス別総エネルギー消費量および節約量 – 過去 7 日間） 

ネットワーク上の選択した EnergyWise 対応デバイスの過去 7 日間の平均および最大

エネルギー消費量と平均エネルギー節約量を表示します。表示される各 EnergyWise 

有効デバイスのノード名と IP アドレスも提供されます。EnergyWise エネルギー管理の

詳細については、77 ページの「EnergyWise デバイスの監視を参照してください。 
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Total Energy Consumption and Savings per EnergyWise Device – Last 

Month （EnergyWise デバイス別総エネルギー消費量および節約量 – 過去 1 ヶ月） 

ネットワーク上の選択した EnergyWise 対応デバイスの過去 1 ヶ月の平均および最大

エネルギー消費量と平均エネルギー節約量を表示します。表示される各 EnergyWise 

有効デバイスのノード名と IP アドレスも提供されます。EnergyWise の詳細については、

77 ページの「EnergyWise デバイスの監視を参照してください。 

Total Energy Consumption and Savings per EnergyWise Device – This 

Month （EnergyWise デバイス別総エネルギー消費量および節約量 – 今月） 

ネットワーク上の選択した EnergyWise 対応デバイスの今月の平均および最大エネル 

ギー消費量と平均エネルギー節約量を表示します。表示される各 EnergyWise 有効デ

バイスのノード名と IP アドレスも提供されます。EnergyWise の詳細については、 

77 ページの「EnergyWise デバイスの監視を参照してください。 

Total Energy Consumption and Savings per EnergyWise Entity – Last  

7 Days （EnergyWise エンティティ別総エネルギー消費量および節約量 – 過去 7 日間） 

ネットワーク上の選択した EnergyWise 対応デバイスのすべての EnergyWise エンティ

ティの過去 7 日間の平均および最大エネルギー消費量と平均エネルギー節約量を表示

します。一覧表示された各 EnergyWise エンティティの名前と役割も提供されます。詳

細については、77 ページの「EnergyWise デバイスの監視を参照してください。 

Total Energy Consumption and Savings per EnergyWise Entity – Last 

Month （EnergyWise エンティティ別総エネルギー消費量および節約量 – 先月） 

ネットワーク上の選択した EnergyWise 対応デバイスのすべての EnergyWise エンティ

ティの先月の平均および最大エネルギー消費量と平均エネルギー節約量を表示します。

一覧表示された各  EnergyWise エンティティの名前と役割も提供されます。

EnergyWise エネルギー管理の詳細については、77 ページの「EnergyWise デバイスの

監視を参照してください。 

Total Energy Consumption and Savings per EnergyWise Entity – This 

Month （EnergyWise エンティティ別総エネルギー消費量および節約量 – 今月） 

ネットワーク上の選択した EnergyWise 対応デバイスのすべての EnergyWise エンティ

ティの今月の平均および最大エネルギー消費量と平均エネルギー節約量を表示します。

一覧表示された各  EnergyWise エンティティの名前と役割も提供されます。

EnergyWise エネルギー管理の詳細については、77 ページの「EnergyWise デバイスの

監視を参照してください。 
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Fibre Channel Reports （ファイバー チャネル レポート） 

Fibre Channel Units and Ports （ファイバー チャネル ユニットおよびポート）レポートは、デ

フォルトによりすべての Orion NPM インストレーションで提供されます。このレポートは、Orion 

NPM が監視するファイバー チャネル ポートごとに、次の情報を提供します。 

 監視されるファイバー チャネル ポートが存在するデバイスの製造元が提供する製品識別

子（FC Product （FC 製品）） 

 ファイバー チャネル デバイスの製造元が提供する Unit Description （ユニットの説明）。 

 監視されるファイバー チャネル ポートごとに割り当てられる Port Index （ポート インデッ 

クス） 

 監視されるファイバー チャネル ポートのポート タイプを示す Port Description （ポートの

説明） 

 監視される各ポートに割り当てられる固有のワールド ワイド ネーム（WWN） 

Cisco バッファ ミス履歴レポート 

次の Cisco バッファ ミス レポートは、Orion NPM によってデフォルトで提供されます。 

Cisco Buffer Misses - Last 7 Days （Cisco バッファ ミス - 過去 7 日間） 

監視される Cisco デバイス上の過去 7 日間のすべてのバッファ ミスを表示します。バッ 

ファ ミスが発生するすべての Cisco デバイスを対象に、このレポートはすべてのバッファ ミス

の合計数、Small、Medium、Big、Large、Huge の各種グループ別のバッファ ミス数を

表示します。 

Cisco Buffer Misses - Last Month （Cisco バッファ ミス - 先月） 

監視される Cisco デバイス上の先月のすべてのバッファ ミスを表示します。バッファ ミスが

発生するすべての Cisco デバイスを対象に、このレポートはすべてのバッファ ミスの合計数、

Small、Medium、Big、Large、Huge の各種グループ別のバッファ ミス数を表示します。 

Cisco Buffer Misses - This Month （Cisco バッファ ミス - 今月） 

監視される Cisco デバイス上の今月のすべてのバッファ ミスを表示します。バッファ ミスが

発生するすべての Cisco デバイスを対象に、このレポートはすべてのバッファ ミスの合計数、

Small、Medium、Big、Large、Huge の各種グループ別のバッファ ミス数を表示します。 
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トラフィック履歴レポート 

次のネットワーク トラフィック レポートは、Orion NPM によってデフォルトで提供されます。 

95
 th

 Percentile Traffic Rate - Last 7 Days （95 パーセンタイル トラフィック速度 - 過去 

7 日間） 

監視されるすべてのインターフェースを介する過去 7 日間のトラフィック速度の 95 パーセ

ンタイルを表示します。各インターフェースに対して、インターフェース ID 、親ノード、インタ

ーフェース名、送受信および最大の 95 パーセンタイル トラフィック速度が表示されます。 

95
 th

 Percentile Traffic Rate - Last Month （95 パーセンタイル トラフィック速度 - 先月） 

 監視されるすべてのインターフェースを介する先月の 95 パーセンタイル トラフィック速度を

表示します。各インターフェースに対して、インターフェース ID 、親ノード、インターフェース

名、送受信および最大の 95 パーセンタイル トラフィック速度が表示されます。 

95
 th

 Percentile Traffic Rate - This Month （95 パーセンタイル トラフィック速度 - 今月） 

監視されるすべてのインターフェースを介する今月の 95 パーセンタイル トラフィック速度を

表示します。各インターフェースに対して、インターフェース ID、親ノード、インターフェース

名、送受信および最大の 95 パーセンタイル トラフィック速度が表示されます。 

Average and Peak Traffic Rates - Last 7 Days （平均およびピーク トラフィック速度 - 

過去 7 日間） 

監視されるすべてのインターフェースを介する過去 7 日間の平均およびピーク時の送受信

トラフィック速度を表示します。インターフェースは、それぞれの親ノードの下に一覧表示さ

れます。 

Average and Peak Traffic Rates - Last Month （平均およびピーク トラフィック速度 - 

先月） 

監視されるすべてのインターフェースを介する先月の平均およびピーク時の送受信トラフィック

速度を表示します。インターフェースは、それぞれの親ノードの下に一覧表示されます。 

Average and Peak Traffic Rates - This Month （平均およびピーク トラフィック速度 - 

今月） 

監視されるすべてのインターフェースを介する今月の平均およびピーク時の送受信トラフィック

速度を表示します。インターフェースは、それぞれの親ノードの下に一覧表示されます。 
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Average and Peak Traffic Rates - WAN Interfaces Last 7 Days （平均およびピー

ク トラフィック速度 - WAN インターフェース 過去 7 日間） 

監視されるすべての WAN インターフェースを介する過去 7 日間の平均およびピーク時の

送受信トラフィック速度と共に MAC アドレスを表示します。インターフェースは、それぞれ

の親ノードの下に一覧表示されます。 

Total Bytes Transferred by Cisco Devices - Last Month （Cisco デバイス別総転

送バイト数 - 先月） 

監視されるすべての Cisco デバイスの先月の総転送バイト数（受信 + 送信）、送信バイ

ト数、および受信バイト数を表示します。 

Total Bytes Transferred by Interface - Last Month( インターフェース別の総転送バ

イト数 - 先月） 

監視されるすべてのインターフェースを介する先月の総転送バイト数（受信 + 送信）、送

信バイト数、および受信バイト数を表示します。インターフェースは、それぞれの親ノードの

下に一覧表示されます。 

Total Bytes Transferred by Interface - This Month( インターフェース別総転送バイ

ト数 - 今月） 

 監視されるすべてのインターフェースを介する今月の総転送バイト数（受信 + 送信）、送

信バイト数、および受信バイト数を表示します。インターフェースは、それぞれの親ノードの

下に一覧表示されます。 

Total Bytes Transferred by Node - Last 7 Days （ノード別総転送バイト数 - 過去 

 7 日間） 

監視されるすべてのノードの過去 7 日間の総転送バイト数（受信 + 送信）、送信バイト

数、および受信バイト数を表示します。 

Total Bytes Transferred by Node - Last Month （ノード別総転送バイト数 - 先月） 

監視されるすべてのノードの先月の総転送バイト数（受信 + 送信）、送信バイト数、およ

び受信バイト数を表示します。 

Total Bytes Transferred by Node - This Month （ノード別総転送バイト数 - 今月） 

監視されるすべてのノードの今月の総転送バイト数（受信 + 送信）、送信バイト数、およ

び受信バイト数を表示します。 
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インベントリ 

次のインベントリ レポートは、Orion NPM によってデフォルトで提供されます。 

Interface Bandwidth （インターフェース帯域幅） 

監視されるすべてのインターフェースの名前、設定された送信、および受信帯域幅を表示

します。インターフェースは、それぞれの親ノードの下に一覧表示されます。 

Interface Type （インターフェース タイプ） 

監視されるインターフェース タイプと現在監視されている各タイプのインターフェース数のリス

トを表示します。 

UCS （統一コンピューティング システム）レポート 

Cisco 社の UCS （統一コンピューティング システム）を採用した、監視されたデバイスの UCS 

Entitites （UCS エンティティ）レポートが、Orion NPM によってデフォルトで提供されます。 

ワイヤレス レポート 

監視されるワイヤレス アクセス ポイントおよびクライアントに関する次のレポートは、Orion 

NPM によってデフォルトで提供されます。 

Availability of Wireless Access Points – Last 7 Days （ワイヤレス アクセス ポイント

の可用性 – 過去 7 日間） 

監視されるすべてのワイヤレス アクセス ポイントの過去 7 日間の可用性を表示します。 

Availability of Wireless Access Points – Last Month （ワイヤレス アクセス ポイント

の可用性 – 先月） 

監視されるすべてのワイヤレス アクセス ポイントの先月の可用性を表示します。 

Availability of Wireless Access Points – This Month （ワイヤレス アクセス ポイント

の可用性 – 今月） 

監視されるすべてのワイヤレス アクセス ポイントの今月の可用性を表示します。 

Average and Peak Number of Clients by Access Point – Last 7 Days （アクセ

ス ポイント別の平均およびピーク クライアント数 – 過去 7 日間） 

監視される各ワイヤレス アクセス ポイントが過去 7 日間にホストした平均およびピーク ク

ライアント数を表示します。 
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Average and Peak Number of Clients by Access Point – Last Month （アクセス 

ポイント別の平均およびピーク クライアント数 – 先月） 

監視される各ワイヤレス アクセス ポイントが先月ホストした平均およびピーク クライアント

数を表示します。 

Average and Peak Number of Clients by Access Point – This Month （アクセス 

ポイント別の平均およびピーク クライアント数 – 今月） 

監視される各ワイヤレス アクセス ポイントが今月ホストした平均およびピーク クライアント

数を表示します。 

Average and Peak Traffic Rates by Access Point – Last 7 Days （アクセス ポイ

ント別の平均およびピーク トラフィック速度 – 過去 7 日間） 

監視される各ワイヤレス アクセス ポイントの過去 7 日間の平均およびピーク トラフィック

速度を表示します。 

Average and Peak Traffic Rates by Access Point – Last Month （アクセス ポイン

ト別の平均およびピーク トラフィック速度 – 先月） 

監視される各ワイヤレス アクセス ポイントの先月の平均およびピーク トラフィック速度を表

示します。 

Average and Peak Traffic Rates by Access Point – This Month （アクセス ポイン

ト別の平均およびピーク トラフィック速度 – 今月） 

監視される各ワイヤレス アクセス ポイントの今月の平均およびピーク トラフィック速度を表

示します。 

Rogue Access Points – Last 7 Days （不正アクセス ポイント – 過去 7 日間） 

過去 7 日間に検出された MAC アドレスによって識別されるすべての不正ワイヤレス アク

セス ポイントのリストを表示します。 

Rogue Access Points – Last Month （不正アクセス ポイント – 先月） 

先月検出された MAC アドレスによって識別されるすべての不正ワイヤレス アクセス ポイ

ントのリストを表示します。 

Rogue Access Points – This Month （不正アクセス ポイント – 今月） 

今月検出された MAC アドレスによって識別されるすべての不正ワイヤレス アクセス ポイ

ントのリストを表示します。 
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Top 25 Wireless Clients by Traffic Rates over the Last 7 Days （過去 7 日間の

トラフィック速度トップ 25 のワイヤレス クライアント） 

過去 7 日間の監視されるワイヤレス クライアント トップ 25 のトラフィック速度を表示します。 

Total Bytes Transferred by Access Point – Last 7 Days （アクセス ポイント別の総

転送バイト数 – 過去 7 日間） 

監視される各ワイヤレス アクセス ポイントの過去 7 日間の総送信バイト数および総受信

バイト数を表示します。 

Total Bytes Transferred by Access Point – Last Month （アクセス ポイント別の総

転送バイト数 – 先月） 

監視される各ワイヤレス アクセス ポイントの先月の総送信バイト数および総受信バイト

数を表示します。 

Total Bytes Transferred by Access Point – This Month （アクセス ポイント別の総

転送バイト数 – 今月） 

監視される各ワイヤレス アクセス ポイントの今月の総送信バイト数および総受信バイト

数を表示します。 

Report Writer を使用したレポートの表示および作成 

Report Writer は、すべての Orion 製品でインストールされ、すべての Orion 製品がレポート

の作成と編集に使用するアプリケーションです。Orion レポートの作成、編集、および表示の

詳細については、321 ページの「レポートの作成と表示－コア」を参照してください。 
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第 12章 

ユニバーサル デバイス ポーラーによる MIB の監視 

Orion Network Performance Monitor がユニバーサル デバイス ポーラーを使用して監視

できるのは、ネットワーク ステータス、可用性、帯域幅、およびエラーに限りません。Orion ユ

ニ 

バーサル デバイス ポーラーにより、次を含むネットワーク デバイスが記録できるあらゆる統計

情報を監視できます。 

  インターフェース トラフィック 

  CPU 温度 

  対応エラー数 

  UPS のバッテリー ステータス 

  ウェブサイトへの現在の接続数 

ユニバーサル デバイス ポーラーは、膨大な SolarWinds MIB データベースで管理され、ま

た SolarWinds ユーザーが提供するオブジェクト ID に関連付けられたリアルタイムおよび履

歴データを収集できます。このため、ユニバーサル デバイス ポーラーは考えられるほとんどのネ

ットワーク指標のデータを取得できます。また、ユニバーサル デバイス ポーラー変換により、複

数のポーラーの結果を数学的に操作し、独自のカスタム ネットワーク パフォーマンス指標を

作成することもできます。ユニバーサル デバイス ポーラーによって収集されるすべてのネット 

ワーク情報は、ウェブ コンソール内からアクセス可能です。 

警告： ユニバーサル デバイス ポーラーは、Orion Failover Engine （フェイルオーバー エン

ジン）または Hot Standby Engines （ホット スタンバイ エンジン）のいずれからも情報を収

集しません。Orion NPM サーバーに障害が発生した場合、ユニバーサル デバイス ポーラー

による同サーバーからのデータ収集は停止します。障害が発生した Orion NPM サーバーを

ポーリングするすべてのユニバーサル デバイス ポーラーは、同サーバーに関するいかなる情報

もレポートすることができず、Orion Failover Engine （フェイルオーバー エンジン）にフェイル

オーバーした場合でも同じです。詳細については、481ページの「Orion フェイルオーバーおよ

び障害復旧」を参照してください。 

注記： ユニバーサル デバイス ポーラーは、ホスト先となる 個々の Orion NPM ポーリング エ

ンジンと直結しています。そのため、監視ノードを Orion NPM ポーリング エンジン間で移行

する場合は、監視ノードに割り当てられたすべてのユニバーサル デバイス ポーラーも新しい 

ポーリング エンジンに移行する必要があります。 
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SolarWinds MIB データベースのダウンロード 

SolarWinds は、各種ネットワーク デバイスの監視に使用される OID のレポジトリの役割を

果たす MIB データベースを管理します。この MIB データベースは、定期的に更新され、サイ

ズが大きいため、初期の Orion NPM インストーレーション パッケージに含まれていません。

既存の MIB データベースを更新する場合、または初めてユニバーサル デバイス ポーラーを

使用する場合は、次の手順で示すように SolarWinds MIB データベースをダウンロードする

必要があります。 

注記： 新しい MIB データベースのインストール後、ユニバーサル デバイス ポーラーの再起動

が必要な場合もあります。 

SolarWinds MIB データベースをダウンロードおよびインストールするには： 

1. SolarWinds MIB データベースのダウンロードとインストールを求められたら、Yes （は

い）をクリックします。 

注記： このプロンプトは通常、初めてのユーザーに対してのみ表示されます。 

2. 既存の SolarWinds MIB データベースのアップデートをダウンロードする場合、次の
手順を実行します。 

a. SolarWinds Customer ID （カスタマー ID）と Password （パスワード）を使用

して、カスタマー ポータル（ http://www.solarwinds.com/customerportal/ ）にロ

グインします。 

b. 左側の Helpful Links （役に立つリンク）の下の Orion MIB Database （Orion 

MIB データベース）をクリックします。 

3. Internet Explorer を使用している場合に、SolarWinds のダウンロード サイト
（ http://solarwinds.s3.amazonaws.com ）を追加するように求められたら、次
の手順を実行し、MIB データベースのダウンロードを開始します。 

a. Warning （警告）ウィンドウで Add （追加）をクリックします。 

b. Trusted Sites （信頼済みサイト）ウィンドウで Add （追加）をクリックします。 

c. Close （閉じる）をクリックして、ブラウザを更新します。 

4. File Download （ファイルのダウンロード）ウィンドウで Save （保存）をクリックします。 

5. 適切なファイルの保存先に移動して、Save （保存）をクリックします。 

6. ダウンロードが完了したら、MIBs.zip を一時的な場所に解凍します。 

http://www.solarwinds.com/customerportal/
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7. MIBs.zip の解凍先フォルダを開き、Orion NPM サーバーのオペレーティング システム

に基づいて、MIBs.cfg をデフォルトのインストール ボリューム上の SolarWinds フォル

ダにコピーします。 

 \Documents and Settings\All Users\Application Data\ （ 

Windows Server 2003 および XP の場合）  

 \Documents and Settings\All Users\ProgramData\ （ Windows 

Server 2008 および Vista の場合） 

ユニバーサル デバイス ポーラーの作成 

次の手順は、新しいユニバーサル デバイス ポーラーの作成および定義を行います。 

新しいユニバーサル デバイス ポーラーを作成および定義するには： 

1. Start > All Programs > SolarWinds Orion > Universal Device Poller （スタート 

> すべてのプログラム > SolarWinds Orion > ユニバーサル デバイス ポーラー）の順でクリッ

クします。 

2. MIB データベースのダウンロードとインストールを求められたら、Yes （はい）をクリックし、

MIB データベースをダウンロードしてインストールします。詳細については、134 ページの

「SolarWinds MIB データベースのダウンロード 」を参照してください。 

3. File > New Universal Device Poller （ファイル > 新しいユニバーサル デバイス ポ

ーラー）の順でクリックします。 

4. ポーリングしたいオブジェクトの OID を知っている場合は、それを OID フィールドに入力

します。 

5. ポーリングしたいオブジェクトの OID を知らず、利用可能な MIB オブジェクトの定義を
参照したい場合は、次の手順を実行します。 

a. Browse MIB Tree （MIB ツリーの参照）をクリックします。 

b. 左ペインの MIB ツリーを展開し、ポーリングするオブジェクトを見つけます。 

c. ポーリングするオブジェクトを選択して、Select （選択）をクリックします。 

注記： 選択したポーラーの説明が右ペインに表示されます。 

6. ポーリングしたいオブジェクトの OID を知らず、利用可能な MIB オブジェクトの定義を
検索したい場合は、次の手順を実行します。 

a. Browse MIB Tree （MIB ツリーの参照）をクリックします。 

b. Browse MIBs （MIB の参照）ウィンドウの右上隅にある Search MIBs （MIB 

の検索）をクリックします。 
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c. Search By （検索条件）（Name （名前）、Description （説明）キーワード、ま

たは OID ）を選択します。 

d. Search （検索）フィールドに検索文字列を入力して、Search （検索）をクリックし 

ます。 

e. ポーリングするオブジェクトを選択して、Select （選択）をクリックします。 

注記： Search （検索）フィールドの下の OID Details （OID の詳細）には、該当

するオブジェクトの説明が含まれ、現在検索している MIB を示します。入力した 

OID 文字列と一致する既存の OID が存在する場合、Search （検索）フィール

ドの下に一致する OID の詳細が表示されます。名前または説明で検索を行うと、

検索文字列の名前または説明を含むすべての OID が返されます。 

7. 特定ノードの選択したオブジェクトの有効性をテストする場合は、右ペインから適切な
テスト ノードを選択し、Test （テスト）をクリックします。 

注記： 緑色のチェック アイコンは、選択したオブジェクトが選択したノードから正常にポー

リングされ、表示される値が返されたことを意味します。黄色の警告アイコンは、表示さ

れる理由のため、ポーリングのテストに失敗したことを意味します。 

8. ポーラーのテストを行い、失敗した場合は、次を確認してください。 

 テストとしてポーリニングするノードに対して、正しいコミュニティ ストリングを使用して

いますか ? コミュニティ ストリングの提供の詳細については、55 ページの「ウェブ コ

ンソールでのデバイス監視」を参照してください。 

 選択したデバイスは、MIB/OID のポーリングをサポートしていますか? デバイスのド 

キュメンテーションを参照して、MIB をサポートしているか確認してください。 

 Orion NPM サーバーがデバイスにアクセスできますか ? デバイスに Ping を送信

するか、IP Network Browser （IP ネットワーク ブラウザ）などの SolarWinds ツ

ールセット アプリケーションを使用して、デバイスが ICMP と SNMP 要求の双方に

応答していることを確認してください。 

9. 必要な OID を見つけたら、Select （選択）をクリックします。 

10. 必要に応じて、提供されるポーラーの Name （名前）と Description （説明）を編集

します。 

注記： 

 ポーラー名は必須です。Orion NPM は、Orion ウェブ コンソール全体を通してポ

ーラーを参照する際に、この名前を使用します。Name （名前）は空白なしで記

録されるため、名前に含まれるすべての空白は省かれます。 

 Description （説明）は省略可能ですが、ポーラーが収集する情報の種類を識別

するのに役立ちます。 
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11. アドバンスト ポーラーのデフォルト オプションを変更する場合、Show Advanced 

Options （アドバンスト オプションの表示）の横の + をクリックして、次の手順を実行します。 

a. 選択したポーラーの MIB Value Type （MIB 値タイプ）を選択します。 

注記： ポーラー タイプに基づいて、ポーラーは、Rate （レート）、Counter （カウン

タ）、または Raw Value （生値）の形式の統計情報を返します。 

b. Rate （レート）または Counter （カウンタ）を MIB Value Type （MIB 値タイプ）
として選択した場合、適切な Unit （単位）と Time Frame （期間）を提供して

ます。 

c. Raw Value （生値）を MIB Value Type （MIB 値タイプ）として選択した場合、
ポーリングされた生データが表示される適切な Format （形式）を選択します。 

注記： Enumerated （列挙）形式を使用する場合は、Map Values （値のマッ

ピング）をクリックして、ポーラーによって返される値に対応する文字列を指定します。 

d. ポーリングするオブジェクトの SNMP Get Type （SNMP Get タイプ）を選択し、

Node （ノード）または Interface （インターフェース）を選択します。 

12. ポーラーによって収集される履歴データを保持する場合は、Keep Historical Data 

（履歴データの保持）オプションに対して Yes （はい）を選択します。 

注記： SolarWinds は、Orion NPM のデータ表示機能を最大限に活用するために、

履歴データを保持することを推奨します。Orion ウェブ コンソール内に収集したポーラー 

 データをチャートやゲージに表示する場合は、Yes （はい）を選択します。 

13. ポーラーの設定直後にポーリングを開始する場合は、ポーラーの Status （ステータス）

が Enabled （有効）になっていることを確認してください。 

注記： Disabled （無効）を選択すると、ポーラーを有効にするまで、統計情報は収集

されません。 

14. Group （グループ）フィールドで、ポーラーを名前別に整理するための既存のグループを

選択するか、新しいグループ名を入力して、Next （次へ）をクリックします。 

15. 必要に応じて、+ をクリックしてノード ツリーを展開し、新しいポーラーを適用するすべて

のノードを選択します。 

注記： 利用可能なグループは、Group By （グループ化基準）フィールドに表示されま

す。ノード ツリーに表示されるノード数を制限するには、表示するグループを選択します。 
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16. 選択したノードに対するポーラーの最新結果を表示する場合は、Test （テスト）をクリッ

クします。 

注記： 緑色のチェック アイコンは、ポーラーが選択したノードを正常にポーリングし、表

示される値が返されたことを意味します。黄色の警告アイコンは、表示される理由のた

め 、 

ポーリングのテストに失敗したことを意味します。 

17. ポーラーのテストを行い、失敗した場合は、次を確認してください。 

 テストとしてポーリニングするノードに対して、正しいコミュニティ ストリングを使用して

いますか? コミュニティ ストリングの提供の詳細については、55 ページの「ウェブ コン

ソールでのデバイス監視」を参照してください。 

 デバイスがポーリングされる MIB/OID をサポートしていますか? デバイス ベンダーが

提供するドキュメンテーションを参照して、ご利用のデバイスでサポートされている 

MIB を確認してください。 

 Orion Network Performance Monitor サーバーからデバイスにアクセスできます

か? デバイスに Ping を送信するか、IP Network Browser （IP ネットワーク ブラ

ウザ）などの SolarWinds ツールセット アプリケーションを使用し、デバイスが 

ICMP と SNMP 要求の双方に応答していることを確認してください。 

18. Next （次へ）をクリックします。 

19. ポーラーの結果を Orion ウェブ コンソール ビューに表示する場合、Yes （はい）が選

択されていることを確認し、利用可能な各 Orion NPM ビューで、表示するポーラーの

結果リソースの種類を選択します。 

注記： 選択した Orion ウェブ コンソール ビューで、ポーラー リソースがどのように表示さ

れるかを確認するには、Preview （プレビュー）をクリックします。 

20. ポーラーが有効な結果を返した場合に、ポーラーの結果リソースを表示する場合、Do 

not show this poller if it is not assigned （割り当てられていないポーラーを表

示しない）を選択します。 

21. Finish （完了）をクリックします。 
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ノードまたはインターフェースへのポーラーの割り当て 

ユーザーが作成するユニバーサル デバイス ポーラーに加え、Orion NPM には、いくつかの定

義済みのポーラー例が搭載されています。これらのポーラーを使用するには、ポーラーをネット

ワーク デバイスに割り当てて、有効にする必要があります。 

注記： 独自のユニバーサル デバイス ポーラーの作成の詳細については、135 ページの「ユニ

バーサル デバイス ポーラーの作成」を参照してください。 

 ノードまたはインターフェースにポーラーを割り当てて、有効にするには： 

1. Start > All Programs > SolarWinds Orion > Universal Device Poller （ス

タート  > すべてのプログラム  > SolarWinds Orion > ユニバーサル デバイス ポーラー）

の順でクリックします。 

2. File > Assign Pollers （ファイル  > ポーラーの割り当て）の順でクリックします。 

3. 必要に応じて、+ をクリックしてポーラー ツリーを展開し、割り当てるポーラーを選択します。 

注記： 

 デフォルトでは、Orion NPM は次の 2 つのポーラー グループを提供します。

Example （例）および Default （デフォルト）グループ。Example （例）グループに

は、すべての定義済み Orion NPM ポーラーが含まれ、Default （デフォルト）グ 

ループには、他のグループに割り当てられていないすべてのユーザー定義のユニバー

サル デバイス ポーラーが含まれます。 

 ポーラー グループを選択すると、そのグループ内のすべてのポーラーが自動的に選

択されます。選択したグループ内の特定のポーラーを割り当てたくない場合は、 

ポーラー グループ名の横の + をクリックして、割り当てたくないポーラーのチェックボッ

クスのチェックを外します。 

 単一ノードまたはノード グループに複数のポーラーを割り当てる場合は、このビュー

で適用するすべてのポーラーを選択します。これらのポーラーは、次の手順でノード

に割り当てられます。 

4. 割り当てるすべてのポーラーを選択したら、Next （次へ）をクリックします。 
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5. 必要に応じて、+ をクリックしてノード ツリーをインターフェース レベルまで展開し、選択し

たポーラーを適用する要素を選択します。 

注記： 

 利用可能なグループは、Group By （グループ化基準）フィールドに表示されます。

ノード ツリーに表示されるノード数を制限するには、表示するグループを選択します。 

 インターフェース ポーラーを割り当てる際に、ノードを選択すると、そのノードのすべ

てのインターフェースにポーラーが自動的に割り当てられます。親ノードの特定イン 

ターフェースにポーラーを割り当てない場合は、親ノードの横の + をクリックし、ポー

ラーを割り当てない特定インターフェースのチェックボックスのチェックを外します。 

 インターフェース ポーラーを割り当てる場合を除き、インターフェースは表示されません。 

6.  選択したノードおよびインターフェースに対するポーラーの最新結果を表示する場合は、
Test （テスト）をクリックします。 

注記： 緑色のチェック アイコンは、ポーラーが選択したノードを正常にポーリングし、表

示される値が返されたことを意味します。黄色の警告アイコンは、表示される理由のた

め、ポーリングのテストに失敗したことを意味します。 

7. ポーラーのテストを行い、失敗した場合は、次を確認してください。 

 テストとしてポーリニングするノードに対して、正しいコミュニティ ストリングを使用して

いますか ? コミュニティ ストリングの提供の詳細については、55 ページの「ウェブ コ

ンソールでのデバイス監視」を参照してください。 

 デバイスがポーリングされる MIB/OID をサポートしていますか? デバイス ベンダーが

提供するドキュメンテーションを参照して、ご利用のデバイスでサポートされている 

MIB を確認してください。 

 Orion Network Performance Monitor サーバーからデバイスにアクセスできます

か? デバイスに Ping を送信するか、IP Network Browser （IP ネットワーク ブラ

ウザ）などの SolarWinds ツールセット アプリケーションを使用し、デバイスが 

ICMP と SNMP 要求の双方に応答していることを確認してください。 

8. ポーラーの割り当てを完了したら、Finish （完了）をクリックします。 



SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 ユニバーサル デバイス ポーラーによる MIB の監視  141 

割り当てられた ポー ラーの無効化 

デフォルトでは、ポーラーが割り当てられると、すぐに割り当てられている要素の統計情報を

収集します。ポーラーを削除せずに、データ収集を一時中断するには、次の手順に従って 

ポーラーを無効にします。 

注記： 複数のポーラーを無効にする場合は、無効にするポーラーごとに次の手順を繰り返し

ます。 

ユニバーサル デバイス ポーラーを一時的に無効にするには： 

1. Start > All Programs > SolarWinds Orion > Universal Device Poller （ス

タート > すべてのプログラム > SolarWinds Orion > ユニバーサル デバイス ポーラー）

の順でクリックします。 

2. Orion Universal Device Poller （Orion ユニバーサル デバイス ポーラー）ウィンドウの 

All Defined Pollers （すべての定義済みポーラー）ペインで、必要に応じて + をクリック

してポーラー ツリーを展開し、無効にするポーラーをクリックします。 

3. 無効にするポーラーが選択されているかどうか、Orion Universal Device Poller 

（Orion ユニバーサル デバイス ポーラー）のメイン ウィンドウのポーラーのプロパティを確

認してください。必要に応じて、メイン ウィンドウの左下の Show all Properties （す

べてのプロパティの表示）をクリックして、詳細を表示します。 

4. メイン ウィンドウの右上の Edit Properties （プロパティの編集）をクリックします。 

5. Status （ステータス）を Disabled （無効）に設定して、Finish （完了）をクリックします。 

既存の ポー ラーの複製 

Orion NPM では、既存のポーラーを簡単に複製できます。次の手順は、既存のポーラーを

複製する方法を示します。 

Orion NPM で既存のポーラーを複製するには： 

1. Start > All Programs > SolarWinds Orion > Universal Device Poller （ス

タート > すべてのプログラム > SolarWinds Orion > ユニバーサル デバイス ポーラー）

の順でクリックします。 

2. Orion Universal Device Poller （ Orion ユニバーサル デバイス ポーラー）ウィンドウ

の All Defined Pollers （すべての定義済みポーラー）ペインで、+ を必要に応じてク 

リックしてポーラー ツリーを展開し、複製するポーラーをクリックします。 

3.  複製するポーラーが選択されているかどうか、Orion Universal Device Poller 

（Orion ユニバーサル デバイス ポーラー）のメイン ウィンドウのポーラーのプロパティを確

認してください。 
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4. 必要に応じて、メイン ウィンドウの左下の Show all Properties （すべてのプロパティ

の表示）をクリックして、詳細を表示します。 

5. 複製するポーラーの名前を右クリックして、Duplicate Poller （ポーラーの複製）を選

択します。 

6. 複製したポーラーの Name （名前）を変更して、新しいユニバーサル デバイス ポーラー

の作成時と同じように、必要に応じて複製したポーラーの定義を編集します。ユニバー

サル デバイス ポーラーの作成の詳細については、135 ページの「ユニバーサル デバイス 

ポーラーの作成 」を参照してください。 

MIB ポーラーのインポート 

Orion NPM では、Orion NPM の過去のバージョンとユニバーサル デバイス ポーラーのいず

れからもカスタム ポーラーをインポートできます。SolarWinds MIB データベースに MIB を直

接インポートすることはできませんが、MIB とユニバーサル デバイス ポーラー間の関連付けを

インポートすることは可能です。そのあと、ご利用の環境のデバイスにポーラーを関連付けるこ

とができます。ユニバーサル デバイス ポーラーをインポートするには、次の手順を実行します。 

ユニバーサル デバイス ポーラーをインポートするには： 

1. Start > All Programs > SolarWinds Orion > Universal Device Poller （ス

タート > すべてのプログラム > SolarWinds Orion > ユニバーサル デバイス ポーラー）

の順でクリックします。 

2. File > Import Universal Device Pollers （ファイル  > ユニバーサル デバイス ポー

ラーのインポート）の順でクリックします。 

3. インポートするポーラーごとに、次の手順を実行します。 

a. Open （開く）をクリックし、インポートするポーラーの場所に移動します。 

b. インポートするポーラーを選択し、Open （開く）をクリックします。 

4.  左側のリストからインポートするポーラーを選択し、Import （インポート）をクリックします。 

5. インポートするポーラーのリストから特定のポーラーを削除する場合は、削除するポー 

ラーをクリックし、Remove （削除）をクリックします。 

注記： 

 複数のポーラーを選択する場合は、SHIFT または CTRL を押しながら選択する 

ポーラーをクリックします。 

 すべてのフォルダを折りたたみ、グループ名のみを表示する場合は、SHIFT を押し

ながらグループ名の横の - をクリックします。 

6. OK をクリックします。 
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7.  インポートしたポーラーにネットワーク デバイスを割り当てた直後にポーリングを開始させ
る場合は、次の手順を実行します。 

a. Orion Universal Device Poller （Orion ユニバーサル デバイス ポーラー）ウィン

ドウの左にある All Defined Pollers （すべての定義済みポーラー）ペインで、新し

くインポートしたポーラーを選択します。 

b. Edit Properties （プロパティの編集）をクリックします。 

c.   ポーラーの Status （ステータス）が Enabled （有効）になっていることを確認して、

Finish （完了）をクリックします。 

8.  インポートしたポーラーにネットワーク デバイスを割り当てた直後にポーリングを開始させ
ない場合は、次の手順を実行します。  

a. Orion Universal Device Poller （Orion ユニバーサル デバイス ポーラー）ウィン

ドウの左にある All Defined Pollers （すべての定義済みポーラー）ペインで、新し

くインポートしたポーラーを選択します。 

b. Edit Properties （プロパティの編集）をクリックします。 

c. ポーラーの Status （ステータス）を Disabled （無効）に設定し、Finish （完了）

をクリックします。 

 注記： Disabled （無効）を選択すると、ポーラーを有効にするまで、統計情報は収

集されません。 

9.  インポートしたポーラーにノードまたはインターフェースを割り当てます。詳細については、

139 ページの「ノードまたはインターフェースへのポーラーの割り当て」を参照してください。 

 インポートしたポーラーを有効にし、適切なネットワーク デバイスに割り当てると、ポーラーが

統計情報の収集を開始します。これらの統計情報を閲覧するには、Orion Network 

Performance Monitor ウェブ コンソールにログインし、ポーラーに割り当てられたノードまた

はインターフェースを参照します。詳細については、150 ページの「ユニバーサル デバイス ポー

ラーの統計情報の表示 」を参照してください。 
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ユニバーサル デバイス ポーラーのエクスポート 

Orion NPM では、次の手順に従って作成したユニバーサル デバイス ポーラーをエクスポート

できます。 

ユニバーサル デバイス ポーラーをエクスポートするには： 

1. Start > All Programs > SolarWinds Orion > Universal Device Poller （ス

タート  > すべてのプログラム  > SolarWinds Orion > ユニバーサル デバイス ポーラー）

の順でクリックします。 

2. File > Export Universal Device Pollers （ファイル  > ユニバーサル デバイス ポー

ラーのエクスポート）の順でクリックします。 

3. 左側の Pollers （ポーラー）ペインで、必要に応じて + をクリックしてポーラー ツリーを展

開し、エクスポートするポーラーを選択します。 

注記： グループ名を選択すると、そのグループに属するすべてのポーラーが選択されます。

複数のポーラーを選択する場合は、Shift+ クリック または Ctrl+ クリック を実行しま

す。 

4. エクスポートするすべてのポーラーを選択したら、Export （エクスポート）をクリックします。 

5. エクスポートするポーラーのリストから特定のポーラーを削除する場合は、削除するポー
ラーをクリックして、Remove （削除）をクリックします。 

注記： グループ名を選択すると、そのグループに属するすべてのポーラーが選択されます。

複数のポーラーを選択する場合は、Shift+ クリック または Ctrl+ クリック を実行しま

す。 

6. Save （保存）をクリックします。 

7. 選択したポーラーのエクスポート先に移動し、File name （ファイル名）を指定して、

Save （保存）をクリックします。 
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ポーラー結果の変換 

MIB ポーラーが出す結果に単純な数学的処理をして操作することで、より理解しやすいも

のになることがよくあります。たとえば、ポーラーが温度値を摂氏で返した場合、華氏のポー 

ラー結果の方が作業しやすい場合もあります。次のセクションでは、現在利用可能なポー 

ラー変換と新しいポーラー変換の作成について説明しています。 

利用可能なポーラー変換 

Orion NPM は、1 つ上のポーラーに適用し、数学的に操作されたポーラーの結果を生成

する、定義済みの変換関数をいくつか提供しています。次の表は、Orion NPM のユニバー

サル デバイス ポーラーで現在利用可能な変換関数を示しています。 

ポーラー変換 定義 

Average （平均） 複数のポーラー結果の平均を提供します。 

Minimum （最小） 複数のポーラー結果の最小値を提供します。 

Maximum （最大） 複数のポーラー結果の最大値を提供します。 

Truncate （切り捨て） 

ポーリングされた値を指定した小数点以下の桁数で切り捨てます。 

例： Truncate({HiPrecision},4) は、HiPrecision と呼

ばれるポーラー結果を小数点以下 4 桁に切り捨てします。 

ColumnAverage （列平均）     ポーリング テーブルの列の平均値を算出します。 

ColumnMinimum （列最小）  ポーリング テーブルの列の最小値を算出します。 

ColumnMaximum （列最大

） 
 ポーリング テーブルの列の最大値を算出します。 

ColumnSum （列合計）  ポーリング テーブルの列の合計値を算出します。 

Temperature > 
Celsius to Fahrenheit  

（温度 > 摂氏から華氏へ） 
 当初は摂氏で示されたポーラー結果を華氏に変換します。 

Temperature > 
Fahrenheit to Celsius  

（温度 > 華氏から摂氏へ） 
 当初は華氏で示されたポーラー結果を摂氏に変換します。 

X to Kilobyte 

（ X からキロバイトへ） 
当初はバイト単位で示されたポーラー結果をキロバイト単位に変換し 

ます。 

X to Megabyte  

（ X からメガバイトへ） 
当初はバイト単位で示されたポーラー結果をメガバイト単位に変換し 

ます。 

X to Gigabyte  

（ X からギガバイトへ） 
当初はバイト単位で示されたポーラー結果をギガバイト単位に変換し 

ます。 

X to Terabyte  

（ X からテラバイトへ） 
当初はバイト単位で示されたポーラー結果をテラバイト単位に変換し 

ます。 

Kilobyte to Megabyte  

（キロバイトからメガバイトへ） 
当初はキロバイト単位で示されたポーラー結果をメガバイト単位に変換し

ます。 
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ポーラー変換 定義 

Kilobyte to Gigabyte  

（キロバイトからギガバイトへ） 
当初はキロバイト単位で示されたポーラー結果をギガバイト単位に変換し

ます。 

Kilobyte to Terabyte  

（キロバイトからテラバイトへ） 
当初はキロバイト単位で示されたポーラー結果をテラバイト単位に変換し

ます。 

Megabyte to Gigabyte  

（メガバイトからギガバイトへ） 
当初はメガバイト単位で示されたポーラー結果をギガバイト単位に変換し

ます。 

Megabyte to Terabyte  

（メガバイトからテラバイトへ） 
当初はメガバイト単位で示されたポーラー結果をテラバイト単位に変換し

ます。 

Gigabyte to Terabyte  

（ギガバイトからテラバイトへ） 
当初はギガバイト単位で示されたポーラー結果をテラバイト単位に変換し

ます。 

 

ポーラー変換の作成 

次の手順は、ユニバーサル デバイス ポーラーを使用して強力なポーラー変換を開発するた

めの方法を示します。 

ポーラー結果を変換するには： 

1. Start > All Programs > SolarWinds Orion > Universal Device Poller （ス

タート > すべてのプログラム > SolarWinds Orion > ユニバーサル デバイス ポーラー）

の順でクリックします。 

2. File > Transform Results （ファイル  > 結果の変換）の順でクリックします。 

3. ポーラー変換例のページで Next （次へ）をクリックします。 

4. 変換の Name （名前）を入力して、任意の Description （説明）を入力します。 

注記： 

 変換名は入力必須です。Orion NPM は、Orion ウェブ コンソール全体を通して

定義したポーラー変換を参照する際に、この名前を使用します。 

 Name （名前）は空白なしで記録されるため、名前に含まれるすべての空白は省

かれます。 

 Description （説明）は省略可能ですが、ポーラー変換によって生成される情報

の種類を識別するのに役立ちます。 

5. ポーラー変換によって生成される履歴データを保持する場合は、Keep Historical 

Data （履歴データの保持）オプションに対して Yes （はい）を選択します。 

注記： SolarWinds は、Orion NPM のデータ表示機能を最大限に活用するために、

履歴データを保持することを推奨します。Orion ウェブ コンソール内に変換したポーラー 

データをチャートやゲージに表示する場合は、Yes （はい）を選択します。 
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6. ポーラー変換の設定直後に変換された結果の計算を開始する場合は、ポーラー変換
の Status （ステータス）が Enabled （有効）になっていることを確認してください。 

注記： Disabled （無効）を選択すると、ポーラー変換を有効にするまで、ポーラーはポ

ーラー統計情報を変換しません。 

7. Group （グループ）フィールドで、ポーラー変換を名前別に整理するための既存のグ 

ループを選択するか、新しいグループ名を入力します。 

8. Next （次へ）をクリックします。 

9. 次の手順で示すように、Formula （数式）フィールドにポーラー変換の数学的定義を

指定します。 

a. Add Function （関数の追加）をクリックし、1 つ以上のポーラーに適用する関数

を選択します。 

b. 関数の括弧内をクリックします。 

c. Add Poller （ポーラーの追加）をクリックし、変換するポーラーを選択します。 

注記： 

 変換数式に追加するポーラーごとに、この手順を繰り返します。 

 次の例で示すようにポーラーをカンマで区切り、3 つのポーラー結果の平均値を求

めます。 

avg({poller1},{poller2},{poller3}) 

 次の例で示す標準的な数学演算も有効な数式です。 

{poller1}+{poller2} 

 数学定数の e と π も、それぞれ E() と PI() として利用可能です。 

 ポーラー変換数式は、2 つのポーラー比較の平均を返す次の例で示すように、ネ

スト化できます。 

 avg(min({poller1},{poller2}),max({poller3},{poller4})) 

10.  ポーラー変換数式の有効性を特定モードでテストする場合は、利用可能な条件を使
用してテストするデバイスを選択し、Test （テスト）をクリックします。 

注記： 各ポーラーの数式のテスト結果は、定義されるポーラー変換の結果と共に表示

されます。 
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11.  ポーラー変換のテストを行い、失敗した場合は、次を確認してください。 

 変換数式が構文的に正しいですか ? すべての中括弧と括弧を閉じ、不要なス 

ペースを省き、すべてのポーラーが同じタイプの値を返すことを確認してください。 

 テストとしてポーリニングするノードに対して、正しいコミュニティ ストリングを使用して

いますか ? コミュニティ ストリングの提供の詳細については、55ページの「ウェブ コン

ソールでのデバイス監視」を参照してください。 

 選択したデバイスは、ポーリングされた MIB/OID をサポートしていますか? デバイス 

ベンダーが提供するドキュメンテーションを参照し、ご利用のデバイスがサポートする 

MIB を確認してください。 

 Orion Network Performance Monitor サーバーからデバイスにアクセスできます

か? デバイスに Ping を送信するか、IP Network Browser （IP ネットワーク ブラ

ウザ）などの SolarWinds ツールセット アプリケーションを使用し、デバイスが 

ICMP と SNMP 要求の双方に応答していることを確認してください。 

12.  Next （次へ）をクリックします。 

13.  必要に応じて、+ をクリックしてノード ツリーをインターフェース レベルまで展開し、定義

したポーラー変換を適用するすべての監視デバイスを選択します。 

注記： 

 利用可能なグループは、Group By （グループ化基準）フィールドに表示されます。

ノード ツリーに表示されるノード数を制限するには、表示するグループを選択します。 

 ポーラー変換が定義したインターフェース ポーラー上で処理される場合を除き、イ

ンターフェースは表示されません。 

 インターフェース ポーラー変換を割り当てる際に、ノードを選択すると、自動的にそ

のノード上のすべてのインターフェースに選択した変換が割り当てられます。親ノー

ドの特定インターフェースにポーラー変換を割り当てたくない場合は、親ノードの横

の + をクリックし、ポーラー変換を割り当てない特定インターフェースのチェックボック

スのチェックを外します。 

14. 選択したノードおよびインターフェースに対するポーラーの最新結果を表示する場合は、
Test （テスト）をクリックします。 

注記： 

 緑色のチェック アイコンは、ポーラー変換が有効であることを示し、変換結果が表

示されます。 

 黄色の警告アイコンは、表示される理由のため、ポーラー変換に失敗したことを意

味します。 
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15. ポーラーのテストを行い、失敗した場合は、次を確認してください。 

 変換数式が構文的に正しいですか ? すべての中括弧と括弧を閉じ、不要なス 

ペースを省き、すべてのポーラーが同じタイプの値を返すことを確認してください。 

 テストとしてポーリニングするノードに対して、正しいコミュニティ ストリングを使用して

いますか? コミュニティ ストリングの提供の詳細については、55ページの「ウェブ コン

ソールでのデバイス監視」を参照してください。 

 選択したデバイスは、ポーリングされた MIB/OID をサポートしていますか ? デバイ

ス ベンダーが提供するドキュメンテーションを参照し、ご利用のデバイスがサポート

する MIB を確認してください。 

 Orion Network Performance Monitor サーバーからデバイスにアクセスできます

か? デバイスに Ping を送信するか、IP Network Browser （IP ネットワーク ブラ

ウザ）などの SolarWinds ツールセット アプリケーションを使用し、デバイスが 

ICMP と SNMP 要求の双方に応答していることを確認してください。 

16.  Next （次へ）をクリックします。 

17.  ポーラーの結果を Orion ウェブ コンソール ビューに表示する場合、Yes （はい）が選

択されていることを確認し、利用可能な各ビューで、表示するポーラーの結果リソースの

種類を選択します。 

注記： 選択したウェブ コンソール ビューで、ポーラー リソースがどのように表示されるか確認

するには、Preview （プレビュー）をクリックします。 

18.  ポーラー変換が有効な結果を返した場合に、ポーラーの結果リソースを表示する場合
、Do not show this poller if it is not assigned （割り当てられていないポーラー

を表示しない）を選択します。 

19.  Finish （完了）をクリックします。 
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ユニバーサル デバイス ポーラーの統計情報の表示 

ユニバーサル デバイス ポーラーを設定して有効にすると、同ポーラーが記録する統計情報を 

Orion ウェブ コンソールのあらゆるビューで閲覧できます。次の手順は、Orion ウェブ コン 

ソール ビューにポーラー リソースを含めます。 

ポーラー リソースをウェブ コンソール ビューへ追加するには： 

1. Start > All Programs > SolarWinds Orion > Universal Device Poller （ス

タート > すべてのプログラム > SolarWinds Orion > ユニバーサル デバイス ポーラー）

の順でクリックします。 

2. Orion Universal Device Poller （Orion ユニバーサル デバイス ポーラー）ウィンドウの 

All Defined Pollers （すべての定義済みポーラー）ペインで、+ を必要に応じてクリック

してポーラー ツリーを展開し、ウェブ コンソールのリソースとして追加するポーラーをクリッ

クします。 

3. 複製するポーラーが選択されているかどうか、Orion Universal Device Poller 

（Orion ユニバーサル デバイス ポーラー）のメイン ウィンドウのポーラーのプロパティを確

認してください。 

4. リソースとして追加するポーラーを右クリックし、Web Display （ウェブ表示）をクリックし

ます。 

5. Yes （はい）が選択されていることを確認し、利用可能な各 Orion NPM ビューに対し

て、表示するポーラー リソースの種類を選択します。 

注記： 選択した Orion ウェブ コンソール ビューで、ポーラー リソースがどのように表示さ

れるかを確認するには、Preview （プレビュー）をクリックします。 

6. ポーラーが有効な結果を返したときにのみポーラー リソースを表示する場合、Do not 

show this poller if it is not assigned （割り当てられていないポーラーを表示し

ない）を選択します。 

7. Finish （完了）をクリックします。 

ユニバーサル デバイス ポーラーのアラートの作成 

ユニバーサル デバイス ポーラー用のアラートは、Advanced Alert Manager （アドバンスト 

アラート マネージャ）を使用して設定します。詳細については、275 ページの「Orion アドバン

スト アラートの使用  –  コア 」を参照してください。 

../../06_tech/2011-07-11_prep/Orion/OrionCoreAdministratorGuide.doc#CreatingConfiguringAdvancedAlerts
../../06_tech/2011-07-11_prep/Orion/OrionCoreAdministratorGuide.doc#CreatingConfiguringAdvancedAlerts
../../06_tech/2011-07-11_prep/Orion/OrionCoreAdministratorGuide.doc#CreatingConfiguringAdvancedAlerts
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注記： 

 一部の場合、${CustomPollers.Description} のように、ユニバーサル デバイス 

ポーラーのアラートで使用される変数にテーブル名が必要な場合もあります。 

 ユニバーサル  デバイス  ポーラー用に新しいアラートを作成する際には、Trigger 

Condition （トリガー条件）タブで、必要に応じてアラート タイプを Node Poller （ノー

ド ポーラー）または Interface Poller （インターフェース ポーラー）に変更します。 
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第 13章 

Orion System Manager （システム マネージャ）の使用 

 ウェブ コンソールは Orion のプライマリ インターフェースですが、 Orion System Manager 

（システム マネージャ）はアラートの設定や監視ネットワーク デバイスのパフォーマンス データの

表示などの限られた機能を提供します。 

System Manager （システム マネージャ）の起動 

System Manager （システム マネージャ）は、Orion Network Performance Monitor サー

ビスの制限されたインターフェースです。デバイスの表示やカスタム アラートの設定に使用できま

す。 

 System Manager （システム マネージャ）を起動するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム   > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 

2. System Manager （システム マネージャ）が複数の Orion ポーリング エンジンを検出し
た場合、表示または管理するサーバーを選択します。 

3. Connect to Polling Engine （ポーリング エンジンに接続）をクリックします。 

ノード ツリーにおけるノードの検索 

多数のノードを監視すると、特定のノードを見つけるのが困難な場合もあります。個々のノード

をすばやく見つけるには、次の手順を実行します。 

個々のノードを検索するには： 

1. Nodes > Find Node （ノード  > ノードの検索）の順でクリックします。 

2. Lookup Field （検索フィールド）を選択し、次に Lookup Criteria （検索条件）を選

択します。 

注記： 検索条件と一致するノードが、Found Nodes （発見ノード）フィールドに表示さ

れます。 
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ノード ツリーにおけるノードのグループ化 

多数のノードを監視すると、特定のノードをすばやく見つけるのが困難な場合もあります。次の

手順で示すように、ノード グループを定義すると、より簡単にノードを見つけることができます。 

ノード ツリーでノードをグループするには： 

1. Nodes > Refresh Node Tree （ノード  > ノード ツリーの更新）の順でクリックします。 

2. ノード ツリーの上のメニューから、ノードをグループ化する基準を選択します。 

注記： ノード グループの定義用にカスタム プロパティを作成することもできます。詳細につ

いては、375 ページの「カスタム プロパティの作成  –  コア」を参照してください。 

ネットワークの詳細の表示 

Orion NPM は、収集されるネットワーク データや統計情報のテーブルを表示するために、さま

ざまなオプションを提供しています。列ヘッダーを左右にドラッグすることで、列の配置を調整で

きます。列ヘッダーをクリックすると、その列に含まれるデータが、表示されるすべてのデータの並

べ替え順序の基準になります。列ヘッダーをもう一度クリックすると、順序が逆になります。次の

手順では、ネットワークのデータおよび統計情報のカスタム ビューを生成します。 

ネットワークの詳細を表示するには： 

1. 既にビューを生成している場合は、View > Display View （ビュー  > ビューの表示）の

順でクリックし、表示するネットワーク ビューを選択します。 

2. カスタム ビューを生成する場合は、次の手順を実行します。 

a.  View > New View （ビュー  > 新規ビュー）の順でクリックします。 

b.  View name （ビュー名）フィールドにカスタム ビューの名前を入力します。 

c.  表示する項目を選択し、OK をクリックします。 

Network Performance Monitor 設定 

Network Performance Monitor 設定は、Orion NPM が System Manager （システム マ

ネージャ）でどのようにネットワーク  データと統計情報を表示するかを指定します。次の 

System Manager （システム マネージャ）の外見を、Network Performance Monitor 

Settings （Network Performance Monitor 設定）ウィンドウで設定できます。 

  チャートのプロパティ 

  ノード ツリーのプロパティ 

 次のセクションは、チャートおよびノード ツリーを設定する手順を提供します。 
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チャート設定 

Charts （チャート）タブの設定は、印刷されるチャートの外見に影響を及ぼします。次の手順

は、Orion NPM 内のチャートを設定します。 

チャートを設定するには：  

1. File > Orion Network Performance Monitor Settings （ファイル  > Orion 

Network Performance Monitor 設定）の順でクリックします。 

2. Charts （チャート）をクリックし、チャート設定を表示します。 

3. Color （カラー）または Monochrome with symbols （記号付き白黒）を Print 

Charts in （チャートの印刷）領域で選択します。 

注記： モノクロ プリンタに印刷する場合、印刷前に各チャートを記号付きの白黒に変換

する代わりに、Monochrome with symbols （記号付き白黒）を選択することで、

System Manager （システム マネージャ）は印刷するたびにチャートを白黒に変換します。 

4. Large （大）、Medium （中）または Small （小）を、Default Font Size （デフォルト 

フォント サイズ）領域から選択します。 

注記： デフォルトのフォント サイズはグローバルに調整されます。また、System Manager 

（システム マネージャ）はチャート ウィンドウのサイズが変更されると、各チャートのフォント 

サイズを動的に調整します。 

5. Enable Auto-Refresh （自動更新を有効化）または Disable Auto-Refresh （自

動更新の無効化）を選択します。 

注記：  パフォーマンス  チャートは自動的に更新されます。この設定は、System 

Manager （システム マネージャ）内のチャート表示のみに影響し、Orion ウェブ コンソール

内のチャート表示には影響を与えません。 

6. Enable Auto-Refresh （自動更新の有効化）を選択した場合、スライダを使用して更
新頻度を設定します。 

ノード ツリー設定 

System Manager （システム マネージャ）は、ネットワーク内のすべての監視リソースをノード 

ツリーとして表します。ネットワーク内の各リソースは、Type （タイプ）アイコンまたは Status （ス

テータス）アイコンで識別されます。Node Tree （ノード ツリー）タブでは、次の手順で示すよう

に、ネットワークのノード、インターフェース、およびボリュームを示すためにノード ツリーが使用す

るアイコンの種類を選択できます。 
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ノード ツリー アイコンを選択するには： 

1. File > Orion Network Performance Monitor Settings （ファイル  > Orion 

Network Performance Monitor 設定）の順でクリックします。 

2. Node Tree （ノード ツリー）をクリックし、Node Tree （ノード ツリー）アイコン設定を表示

します。 

3. Network Nodes （ネットワーク ノード）領域で、Display Machine Type Icons （マ

シン タイプ アイコンの表示）または Display Node Status Icons （ノード ステータス ア

イコンの表示）を選択します。 

4. Interfaces and Volumes （インターフェースおよびボリューム）領域で、Display Type 

Icons （タイプ アイコンの表示）または Display Status Icons （ステータス アイコンの表

示）を選択します。 

System Manager （システム マネージャ）におけるアラートの表示 

Orion ウェブ コンソールの Alerts （アラート）ビューの方が柔軟ですが、Orion System 

Manager （システム マネージャ）でも基本アラートとアドバンスト アラートの双方を表示するこ

とができます。 

System Manager （システム マネージャ）でアラートを表示するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート  > すべてのプログラム  > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. ツールバーで Alerts （アラート）をクリックします。 

3. アドバンスト アラートを表示する場合、Active Alerts （アクティブ アラート）ウィンドウで 

Advanced Alerts （アドバンスト アラート）をクリックします。詳細については、158 ペー

ジの「System Manager （システム マネージャ）におけるアドバンスト アラートの表示 」を

参照してください。 

4. 基本アラートを表示する場合、Active Alerts （アクティブ アラート）ウィンドウで Basic 

Alerts （基本アラート）をクリックします。詳細については、157 ページの「System 

Manager （システム マネージャ）での基本アラートの表示」を参照してください。 
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System Manager （システム マネージャ）での基本アラートの表示 

Orion は、単純なネットワーク状況に対するアラート作成の限定的な方法として、基本アラー

トを提供しています。基本アラートの設定の詳細については、90 ページの「基本アラートの設

定」を参照してください。 

Orion System Manager （システム マネージャ）で基本アラートを表示するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート  > すべてのプログラム  > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. ツールバーで Alerts （アラート）をクリックします。 

3. Active Alerts （アクティブ アラート）ウィンドウで Basic Alerts （基本アラート）をクリック

します。 

4. アラートを確認しながらアラート アクションをグローバルに無効にするには、左側のアラート 

リストで Temporarily Disable all Actions for All Basic Alerts （すべての基本ア

ラートに対して一時的にすべてのアクションを無効にする）を選択します。 

5. 右側のアラート リストの Group By （グループ化基準）メニューからアラートの並べ替えの

基準を選択します。 

現在アクティブな基本アラートは、Active Alerts （アクティブ アラート）ウィンドウの Basic 

Alerts （基本アラート）タブに表示されます。アラートを展開すると、次の情報を確認できます。 

注記：  表示されるアラート情報を更新するには、Basic Alerts （基本アラート）および 

Advance Alerts （アドバンスト アラート）タブの Refresh （更新）をクリックします。 

 Alert Time （アラート時間）フィールドは、アラートがトリガーされた日付と時刻を示します。 

 Network Object （ネットワーク オブジェクト）フィールドは、表示されるアラートをトリガー

したデバイスのローカル ネットワーク名を示します。 

 Current Value （現在の値）フィールドは、表示されるアラートをトリガーさせることになっ

た監視されるオブジェクト プロパティの値を示します。 

 Message （メッセージ）フィールドは、表示されるアラートをトリガーさせた条件を説明する

メッセージを示します。 
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System Manager （システム マネージャ）におけるアドバンスト アラート

の表示 

アドバンスト アラートは、無限にさまざまな条件付きネットワーク イベントに対してアラート通知

を作成できる、より強力な手段を提供します。アドバンスト アラートの設定の詳細については、

275 ページの「Orion アドバンスト アラートの使用  –  コア」を参照してください。 

Orion System Manager （システム マネージャ）でアドバンスト アラートを表示するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート  > すべてのプログラム  > SolarWinds Orion > Network 

Performance Monitor > システム マネージャ）の順でクリックします。 

2. ツールバーで Alerts （アラート）をクリックします。 

3. Active Alerts （アクティブ アラート）ウィンドウで Advanced Alerts （アドバンスト アラー
ト）をクリックします。 

4. アラートを確認しながら、アラート アクションをグローバルに無効にするには、左側のアラー
ト リストの Temporarily Disable all Actions for All Advanced Alerts （すべて
のアドバンスト アラートに対して一時的にすべてのアクションを無効にする）を選択します。 

5. 右側のアラート リストの Group By （グループ化基準）メニューからアラートの並べ替えの
基準を選択します。 

現在アクティブなアドバンスト アラートは、Active Alerts （アクティブ アラート）ウィンドウの 

Advanced Alerts （アドバンスト アラート）タブに表示されます。アラートを展開すると、次の情
報を確認できます。 

注記：  表示されるアラート情報を更新するには、Basic Alerts （基本アラート）および 

Advance Alerts （アドバンスト アラート）タブの Refresh （更新）をクリックします。 

 Acknowledged （確認）チェックボックスを選択すると、アラートの受け取りを確認できます。 

  Alert Name （アラート名）が最表示されます。 

  Alert State （アラート状態）の値とアイコンは、次の表に従って解釈できます。 

 アラート

状態の値 

アラート状態の名

前 
アラート状態の説明 

 1 
Trigger Pending 

（トリガー保留） 
アラートをトリガーする条件は存在するが、適用される遅延条件の

全期間にわたって存在していない。 

 2 
Triggered （ ト リ

ガー） 

アラートをトリガーする条件は存在し、かつ適用される遅延条件の

全期間にわたって存在している。 

 3 
Reset Pending 

（リセット保留） 
アラート リセットをトリガーする条件は存在するが、適用される遅延

条件の全期間にわたって存在していない。 

 4 Reset （リセット） 
アラート リセットをトリガーする条件が存在し、かつ適用される遅延

条件の全期間にわたって存在している。 
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 Object Name （オブジェクト名）は、表示されるアラートをトリガーしたデバイスのローカル 

ネットワーク名です。 

 Triggered Time （トリガー時間）フィールドは、アラートがトリガーされた日付と時刻を示

します。 

 アラートが確認されると、Acknowledged By （確認者）フィールドには、確認を行った

ユーザーの名前とログイン場所が示されます。 

 Acknowledge Time （確認時間）フィールドは、表示されるアラートを確認した日付と

時刻を示します。 

 表示されるアラートを現在のビューから削除するには、Clear （クリア）フィールドの X をク 

リックします。 

チャートの表示 

System Manager （システム マネージャ）の左ペインのノード ツリーを展開すると、ノートおよび

インターフェースに関する統計情報を閲覧できるいくつかのチャートが表示されます。これらの 

チャートでは、チャートを含むウィンドウのサイズが変更されると、動的に再描画され、見やすさ

と細部を最大限にするために尺度が調整されます。 

任意のエリアに境界ボックスを描き、ズームインすることで、より詳細にチャートを解析できます。

チャートの内容を詳細に見る場合には、グラフの境界内でカーソルをドラッグする必要がありま

す。ズームインを完了すると、すべてのデータは表示可能ですが、チャートの下のデータを見るに

はスクロールする必要がある場合もあります。 

Orion System Manager （システム マネージャ）の定義済みチャート 

次のセクションは、Orion System Manager （システム マネージャ）で利用可能な定義済み

チャートについて説明します。利用可能なチャートのリストは、Orion System Manager （シス

テム マネージャ）の左ペインのオブジェクト ツリーで展開できます。 
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ネットワーク全体のサマリー チャート 

ぜんたいちゃーと以下のすべてのネットワーク全体チャートはカスタマイズ可能です。チャー

トのカスタマイズの詳細については、163 ページの「チャートのカスタマイズ」をご参照ください。 

  ネットワーク全体の利用率チャート 

 カスタマイズ可能な期間で測定されたネットワーク上の全ノードの全インターフェースの平

均受信利用率および平均送信利用率を同じビューで表示します。 

ネットワーク全体のフレーリレー利用率チャート 

カスタマイズ可能な期間で測定されたネットワーク上の全ノードの平均フレームリレー利用

率が表示されます。 

全ノードの平均応答時間チャート 

カスタマイズ可能な期間で測定されたネットワーク上の全ノードの平均応答時間が表示

されます。 

ネットワーク全体の可用性チャート 

カスタマイズ可能な期間で測定されたネットワーク上の全ノードの平均可用性が表示され

ます。 

ネットワーク全体の可用性と応答時間チャート 

カスタマイズ可能な期間にわたって測定したネットワーク可用性と平均応答時間を同じ 

ビューに表示します。 

ネットワークのすべてのノードに対する最小 / 最大および平均応答時間チャート 

カスタム期間にわたって測定したネットワーク上の全ノードの最小、最大、および平均応

答時間を表示します。 

注記： 最小応答時間が 0ms としてレポートされる場合があります。この場合、最小応

答時間はチャートに表示されない場合があります。 

ネットワーク全体で転送された合計バイト チャート 

カスタム期間にわたって測定したネットワーク ノードのすべてのインターフェースで転送され

た合計バイトを表示します。 
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すべてのネットワーク全体のサマリー チャートで表示する期間は、各チャートの下に表示される

以下のオプションのいずれかをクリックして変更できます。 

 Today （今日）では、今日選択した統計情報の時間平均値のチャートを作成します。 

 This Week （今週）では、過去 7 日間で選択した統計情報の時間平均値のチャート

を作成します。 

 This Month （今月）では、現在の月のすべての日で選択した統計情報の日平均値の

チャートを作成します。 

 Last 30 Days （過去 30 日）では、過去 30 日間で選択した統計情報の日平均値の

チャートを作成します。 

 Last 3 Months （過去 3 ヶ月）では、過去 3 ヶ月で選択した統計情報の日平均値の

チャートを作成します。 

 Last 12 Months （過去 12 ヶ月）では、過去 12 ヶ月で選択された統計情報の日平

均値のチャートを作成します。 

 This Year （今年）では、現在の年のすべての日で選択した統計情報の日平均値の 

チャートを作成します。 

 Custom Period （カスタム期間）は、入力した Start Date / Time （開始日 / 時間）

から Ending Date / Time （終了日 / 時間）で選択した統計情報のカスタム チャートを

作成します。データ ポイントが Generate Sample （サンプル作成）フィールドで選択した

間隔でプロットされます。 

上位 XX サマリー チャート 

以下のすべてのネットワーク全体チャートはカスタマイズ可能です。チャートのカスタマイズの詳

細については、163 ページの「チャートのカスタマイズ」をご参照ください。 

 現在の応答時間 

パーセント損失と応答時間により監視されたネットワーク ノードの上位 XX が、チャートが

チャート ツリーから選択された時に表示されます。ノードは、パケット損失のパーセントの降

順で一覧表示されます。また応答時間も降順で表示されます。 
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  平均応答時間 

Orion NPM データベースによるネットワーク データの収集開始以降の、平均パーセント

損失と平均応答時間によって監視したネットワーク ノードの上位 XX が表示されます。 

ノードは、パケット損失のパーセントの降順で一覧表示されます。また応答時間も降順で

表示されます。 

 現在の bps 入出力 

受信および送信レートによって監視したネットワーク インターフェースの上位 XX が、チャー

トをチャート ツリーから選択した時に表示されます。インターフェースは受信または送信トラ

フィック率の降順に一覧表示されます。 

 今日のピーク トラフィック ロード 

今日のピーク受信または送信レートによって監視したネットワーク インターフェースの上位 

XX が表示されます。インターフェースは、受信または送信トラフィックのピーク時の率の降

順に一覧表示されます。 

 現在の利用率 

チャートをチャート ツリーから選択した時点での受信および送信パーセント利用率によって

監視したネットワーク インターフェースの上位 XX が表示されます。インターフェースは、受

信または送信トラフィックの利用率の降順に一覧表示されます。 

 現在の CPU 利用率 

チャートをチャート ツリーから選択した時点での CPU 容量のパーセント利用率によって監

視したネットワーク ノードの上位 XX が表示されます。ノードは CPU 使用率の降順に一

覧表示されます。 

 現在のメモリ利用率 

チャートをチャート ツリーから選択した時点での利用可能メモリの使用率によって監視した

ネットワーク ノードの上位 XX が表示されます。ノードはメモリの利用可能率の降順に一

覧表示されます。 

 現在のボリューム利用率 

チャートをチャート ツリーから選択した時点での利用可能メモリの使用率によって監視した
値の上位 XX が表示されます。ノードはボリューム メモリの利用可能率の降順に一覧表
示されます。 
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 現在のエラー 

今日発生した受信および送信エラーと破棄の合計数によって監視したネットワーク イン 

ターフェースの上位 XX を表示します。インターフェースは下記フォーム内の連結により、親
ノードと共に識別されます。Node_NameInterface_Name 。 

チャートのカスタマイズ 

Orion NPM は生成されたチャートをカスタマイズする多数のオプションを提供します。下記の
手順では、チャート ビューをカスタマイズするために利用可能なオプションを示します。 

 チャート ビューをカスタマイズするには： 

1. Orion システム マネージャの左側ウィンドウにあるノード / インターフェース ツリーのチャート
のサブグループを展開します。 

2. チャートをクリックします。 

3. Charts > Customize Chart （チャート > チャートのカスタマイズ） 

4.  チャート ビューをカスタマイズするために、以下のタブで希望する設定を指定します。 

 General （一般）タブではチャートのタイトル、枠線、色、目盛線、フォント サイズ、
数値有効桁数、グラフの種類に関連するオプションを表示します。 

 Plot （プロット）タブではチャート アックスと、3D オプションを含むプロット スタイルが構
成されます。 

 Subsets （サブセット）タブでは、データのサブセットを（チャート ビュー内で定義され、
利用可能な場合に）中断することができます。 

 Points （ポイント）タブでは、チャート化されたデータ ポイントのより詳細な指定を行う
オプションを利用できます。 

 Axis （軸）タブでは、チャート軸に関連するより豊富なオプションが表示されます。 

 Font （フォント）タブではチャート ラベルの外観の設定を行えます。 

 Color （カラー）タブでは、チャートおよび背景色の設定を行うための多様なオプション
を利用できます。 

 Style （スタイル）タブでは、チャート データのサブセットのポイントとライン タイプが設定
されます。 

その他の利用可能なチャート設定の詳細については、155 ページの「チャート設定」を参照し
てください。  
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第 14章 

追加ポーリング エンジンの使用 

大規模のネットワークは、単一の Orion NPM ポーリング エンジンを監視するには広範になり

すぎる場合があるため、ネットワーク上で並行して機能している複数の監視エンジンを有効に

することで、追加ポーリング エンジンを利用して Orion NPM インストールの監視容量を高める

ことができます。 

注記： EnergyWise 、ESX サーバー、ワイヤレス デバイスのデータ収集をサポートするために、

追加ポーリング エンジンでは主要な Orion NPM ポーリング エンジンを実行している必要があ

ります。 

追加ポーリング エンジン システムの要件 

追加ポーリング システムのシステム要件は、主要な Orion NPM ポーリング エンジンと同じで

す。システム要件の詳細については、10 ページの「Orion NPM の要件」を参照してください。 

注記： Orion NPM は、DNS が追加ポーリング エンジンをホストするサーバー名を解決できな

い場合は、追加ポーリング エンジンにノードを追加できません。 

追加ポーリング エンジンのインストール 

新しい追加ポーリング エンジンのインストール（初期設定を含める）には、主要な Orion NPM 

ポーリング エンジンのインストールと設定を完了させる際と同様の手順を行います。ただし次の

ような考慮事項が生じます。 

 最新のインストーラは、 Orion_Additional_Polling_Engine_version.zip  

アーカイブの SolarWinds カスタマー ポータルで利用可能です。 

 ネットワークを監視するためにカスタムプロパティを使用する場合は、関連するスキーマと構

成ファイルを、主要な Orion サーバーから追加ポーリング エンジンをホストしているサー 

バーへコピーする必要があります。詳細については、168 ページの「追加ポーリング エンジ

ンのカスタムプロパティ」を参照してください。 

 基本アラートを使用してネットワークを監視している場合は、Orion データベース内のすべ

ての基本アラートの定義をコピーし、それらのコピーを追加ポーリング エンジンに割り当てる

必要があります。詳細については、116 ページの「基本アラートの追加ポーリング エンジン

へのコピー」を参照してください。 
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 追加ポーリング エンジンでポーリングされるデバイスの監視および管理を行う Orion モ 

ジュールを使用する場合は、追加ポーリング エンジンをホストしているサーバーで使用され

るモジュールの追加ポーリング エンジン バージョンをインストールする必要があります。詳細

については、Orion モジュールの SolarWinds 文書を参照してください。 

 追加ポーリング エンジンで監視しているノード上でトリガーするための Send Email （メー

ルを送信）アクションのアラートを設定した場合は、追加ポーリング エンジンに SMTP サー

バーへのアクセスがあることを確認してください。 

Orion 追加ポーリング エンジンをインストールするには： 

1. Orion 追加ポーリング エンジンの実行ファイルを SolarWinds のウェブサイトからダウン 

ロードした場合、ダウンロード先に移動し、実行ファイルを起動します。 

2. Orion 追加ポーリング エンジンの実行ファイルを物理メディアで受け取った場合は、実行
ファイルへ移動して、ファイルを開きます。 

注記： 実行ファイルにより、HTML readme 、インストーラ ガイド、追加ポーリング エンジ

ンをサポートするすべての Orion 製品用の追加ポーリング エンジン インストーラを解凍し

ます。 

3. プライマリー サーバーにインストールされた Orion 製品に対応するインストーラーを起動し

ます。 

注記： メインの Orion サーバーに複数の Orion 製品がインストールされている場合は、

それぞれに Additional Web Server をインストールし、確実に機能するようにします。 

4. Compatibility Check （互換性チェック）のウェルカム ウィンドウでは、次の情報を示します。 

 メインの Orion サーバーの Hostname or IP Address （ホスト名または IP 

アドレス）。 

 メイン Orion サーバーの Orion ウェブ コンソールに対して管理者権限を有する

ユーザーの User name （ユーザー名）および Password （パスワード）。 

5. Next （次へ）をクリックします。 

6. メインの Orion サーバーでインストールを完了させます。Orion NPM インストールを完了

する詳細については、9 ページの「SolarWinds Orion Network Performance 

Monitor」を参照してください。 
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追加ポーリング エンジンのアップグレード 

追加ポーリング エンジンのアップグレードは、主要な Orion NPM ポーリング エンジンのアップグ

レードで必要となる手順と同様になります。詳細については、30 ページの「Orion Network 

Performance Monitor」を参照してください。 

 注記： 

 最新のインストーラは、 Orion_Additional_Polling_Engine_version.zip  

アーカイブの SolarWinds カスタマー ポータルで利用可能です。 

 メインの Orion サーバーのアップグレードを、追加ポーリング エンジンのアップグレード以前

に行ったことを確認してください。 

 現在使用中の追加ポーリング エンジンをアップグレードする場合、追加ポーリング エンジン

は一時的にシャットダウンされ、いくつかのポーリング  データを失う場合があります。

SolarWinds は、オフピーク時間中に追加ポーリング エンジンのアップグレードを実行する

ことを推奨しています。 

追加ポーリング エンジンの設定 

通常、設定は最初のインストール後に行われますが、同様に標準的でない設定変更を行った

り、モジュールを追加ポーリング エンジンに追加したときに要求される場合もあります。通常、追

加ポーリング エンジンの設定を行う手順は主要な Orion NPM ポーリング エンジンの設定と同

様になります。その際に、以下の点を考慮する必要があります。 

 ネットワークを監視するためにカスタムプロパティを使用する場合は、関連するスキーマと構

成ファイルを、主要な Orion サーバーから追加ポーリング エンジンをホストしているサー 

バーへコピーする必要があります。詳細については、168 ページの「追加ポーリング エンジ

ンのカスタムプロパティ」を参照してください。 

 基本アラートを使用してネットワークを監視している場合は、Orion データベース内のすべ

ての基本アラートの定義をコピーし、それらのコピーを追加ポーリング エンジンに割り当てる

必要があります。詳細については、116 ページの「基本アラートの追加ポーリング エンジン

へのコピー」を参照してください。 

 追加ポーリング エンジンでポーリングされるデバイスの監視および管理を行う Orion モ 

ジュールを使用する場合は、追加ポーリング エンジンをホストしているサーバーで使用され

るモジュールの追加ポーリング エンジン バージョンをインストールする必要があります。 
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追加ポーリング エンジン設定の最適化の詳細については、261ページの「Orion ポーリング エ

ンジンの管理  –  コア」を参照してください。 

注記： 追加ポーリング エンジンは、設定中に一時的にシャットダウンされます。ポーリングを実

行している場合は、一部のポーリング データを失う場合があります。SolarWinds は、オフピー

ク時間中のポーリング エンジンの設定を推奨しています。 

追加ポーリング エンジンのカスタムプロパティ 

カスタムプロパティが作成または削除される場合はいつでも、Orion スキーマと設定ファイルも修

正されます。ネットワークの監視のためのカスタムプロパティを作成した場合、これらに関連する

スキームと設定ファイルを、元の Orion NPM サーバーから追加ポーリング エンジンをホストする

サーバーへ以下の手順でコピーする必要があります。 

追加ポーリング エンジンにカスタムプロパティをコピーするには： 

1. 管理者特権のあるアカウントを使用して、定義されたカスタムプロパティの Orion ポーリン

グ エンジンにログオンします。 

2. Copy the following files from the default location on your primary Orion 

polling engine C:\Program Files\SolarWinds\Orion\ : 

  CustomPropertyEditor.trace 

  EnergyWise.schema 

  EnergyWiseCurrent.schema 

  OrionReportWriter.cfg 

  OrionReportWriter.schema 

  Wireless.schema 

3.  理者特権のあるアカウントを使用して、新規の追加ポーリング エンジンにログオンします。 

4. 追加ポーリング エンジンの同じデフォルト位置 

（C:\Program Files\SolarWinds\Orion\） に、コピーしたファイルを貼り付けます。 
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第 15章 

ウェブ コンソール  –  コアの管理 

Orion ウェブ コンソールは、インターネットに完全に接続しているコンピュータから閲覧する設定

が可能な Orion 製品ファミリーの主要な一部です。また、複数のユーザー用にウェブ コンソー

ルをカスタマイズし、ユーザープロファイルとして個々にカスタマイズされたビューを保存することも

できます。すべての Orion ウェブ コンソール ビューの右上にある Settings （設定）をクリックし

て、管理機能にアクセスできます。 

管理者として最初のログイン 

Orion ウェブ コンソールを起動すると、User Name （ユーザー名）と Password （パスワー

ド）を要求するログイン ビューが表示されます。 

Orion ウェブ コンソールにログインするには： 

1. 以下の方法を用いて Orion ウェブ コンソールを起動します。 

 Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト＞すべてのプログラム＞ SolarWinds Orion > Orion ウェブ コンソール）をクリックし

ます。 

 または Orion サーバー上のブラウザを起動して、http:// ip_address または 

http:// hostname を入力します。ここで、ip_address は Orion ホスト サー 

バーの IP アドレスであり、hostname は Orion サーバーのドメイン名です。 

2. Admin を User Name （ユーザー名）に入力し、Login （ログイン）をクリックします。 

注記： パスワードを設定するまでは、Admin としてパスワードなしでログインできます。初

回のログイン以降は、Admin パスワードを変更した方がよいでしょう。詳細については、

174 ページの「アカウント パスワードの変更」を参照してください。 

アクティブ ディレクトリでの Windows 認証 

Orion コアのバージョン 2010.2 までは、 Orion ウェブ コンソールはアクティブ ディレクトリ ユー

ザーとアクティブ ディレクトリ セキュリティ グループのメンバーであるユーザーを認証できます。 

 アクティブ ディレクトリの Windows 認証をウェブ コンソールで有効化するには： 

1. ローカル ネットワークにアクティブ ディレクトリのインストールおよび設定を行います。 
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注記： 

 Windows Server 2003 へアクティブ ディレクトリをインストールする詳細については、

Microsoft サポートの記事『Windows Server 2003」でアクティブ ディレクトリ サー

バーを作成する方法」を参照してください。 

 Windows Server 2008 でのアクティブ ディレクトリの詳細については、Microsoft 

TechNet の記事『アクティブ ディレクトリ サービス 』を参照してください。 

2. Windows 認証を使用したウェブ コンソール アカウントの自動ログインを有効にする場合

は、以下の手順に従って Orion ウェブ コンソールを設定します。 

a. Start > All Programs > SolarWinds Orion > Configuration and Auto-

Discovery > Configuration Wizard （スタート  > すべてのプログラム  > 

SolarWinds Orion > 設定と自動検出 > 設定ウィザード）の順でクリックします。 

b. Website （ウェブサイト）にチェックを入れて、Next （次へ）をクリックします。 

c. 適切な IP アドレス 、ポート 、および ウェブサイト ルート ディレクトリ を入力した後に、

Yes – Enable automatic login using Windows Authentication （はい - 

Windows 認証を使用した自動ログインを有効にする）を選択します。 

d. Next （次へ）をクリックし、Configuration Wizard （設定ウィザード）を完了します。 

3. 適切なドメインおよびユーザーを使用して（Domain \ Username または 

Username@Domain をウェブ コンソールの ユーザー名 として入力して）ウェブ コンソールに

ログインします。 

通知バーの使用 

ウェブ コンソール メニュー バーの下にある Orion 通知バーから、以下のような Orion NPM の

特徴に関連するメッセージをみることができます。 

 製品アップデートを確認するために Orion ウェブ コンソールを設定した場合、Orion 

NPM に対して、またはその他で最近インストールを行った Orion モジュールに関連する

更新（すべてのアップグレードを含む）、サービス パック、ホットフィックスが利用可能になると、

通知バーにメッセージが表示されます。Orion 製品のアップデートの詳細については、177

ページの「製品のアップデート」を参照してください。 

http://support.microsoft.com/kb/324753
http://technet.microsoft.com/en-us/library/dd578336%28WS.10%29.aspx
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 Orion ウェブ コンソールを設定してブログ投稿を保存している場合、Orion 製品チーム ブ

ログへの新規または未読の投稿がある場合は、通知バーで発表されます。Orion 製品 

チーム ブログの詳細については、177ページの「製品のアップデート」を参照してください。 

 定期的なディスカバリを最近設定した場合、ディスカバリが完了した際に通知バーに結果

が表示されます。定期的なディスカバリに関する詳細については 35 ページの「ネットワーク 

デバイスのディスカバリと追加」を参照してください。 

 Orion NPM を使用して VMware ESX または ESXi サービスを監視している場合、通

知バーにディスカバリ中に確認された ESX ノードの数が表示されます。また、発見された 

ESX ノードが資格証明を要求する場合は、通知バーで通知されます。ESX サーバーの

管理の詳細については 65ページの「仮想化」を参照してください。 

通知バーに表示されたメッセージの詳細については、More Details （詳細）をクリックすると、

表示されたメッセージに関連するウェブ コンソール ビューが開きます。 

表示されたメッセージを削除するには、メッセージの横にある Dismiss Message （メッセージ

を削除する）をクリックするか、表示されてた通知で記されている問題に適切に対応してくだ 

さい。 

通知バーをウェブ コンソールから削除するには、通知バーの右端にある閉じる（X）をクリックし 

ます。 

Orion ウェブ コンソールのナビゲート 

Orion ウェブ コンソールには、ナビゲーションを行う 2 つの主要な方法（トップレベルのウェブ コン

ソール タブとビューレベルのパンくずリスト）があります。以下のセクションでは、それらのナビゲー 

ション方法の使い方を説明します。 

ウェブ コンソール タブの使用 

Orion NPM インストールを行う場合、Orion ウェブ コンソールで次のタブが表示されます。 

 ホーム 

Home （ホーム）タブでは、通常のネットワーク管理と監視をサポートするために表示され

るメニュー バーのリンクを利用できます。Home （ホーム）メニューからリンクしたビューを生

成するために使用されるイベントや上位 10 リスト等の情報、またはアラートのような技術

は、通常すべての Orion モジュールで利用可能です。デフォルトでは、ウェブ コンソールの

いずれかのビューから Home （ホーム）をクリックすると、Orion Summary Home 

（Orion サマリー ホーム）ビューが表示されます。 
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アプリケーション（Orion APM） 

Orion APM がインストールされているサーバーで Orion ウェブ コンソールを表示している

場合、Orion AMP で監視が実行できる多くの異なるタイプのアプリケーションに対するデ

フォルト ビューのメニューを、Applications （アプリケーション）タブから開きます。Orion 

NPM がインストールされている場合、デフォルトでは、ウェブ コンソール ビューから Home 

（ホーム）をクリックすると NPM Summary Home （NPM サマリー ホーム）ビューが表示

されます。 

ネットワーク（Orion APM） 

 Network （ネットワーク）タブで、EnergyWise 、ワイヤレス ネットワーク、Orion NPM 

が供給している機能に対するインターフェース モニタリングのような技術とビューにリンクする

メニュー バーを開きます。Orion NPM がインストールされている場合、デフォルトでは、ウ

ェブ コンソール ビューから Home （ホーム）をクリックすると NPM Summary Home 

（NPM サマリー ホーム）ビューが表示されます。 

 設定（Orion NPM および NCM） 

Orion NPM 用の Orion NCM Integration がインストールされている場合、Configs 

（設定）タブからデバイス設定管理ビューをデフォルト設定するためのリンクを利用できます。

Orion NPM がインストールされている場合、デフォルトでは、ウェブ コンソール ビューから 

Home （ホーム）をクリックすると NPM Summary Home （NPM サマリー ホーム）ビュー

が表示されます。 

仮想化 

Virtualization （仮想化）タブでは、仮想デバイスを監視するために作成されるビューとリ 

ソースにアクセスすることができます。Orion の仮想化モニタリングの詳細については、65

ページの「仮想化」を参照してください。 

ウェブ コンソールでは、インストールされている各 Orion モジュールの追加のモジュール指定のタ

ブを提供します。これらのタブから、追加された Orion モジュールのビューとツールへアクセスでき

ます。Orion モジュールの追加の詳細については、 www.solarwinds.com を参照してくださ

い。メニューバーのカスタマイズの詳細については、201 ページの「ウェブ コンソールのメニュー バ

ーのカスタマイズ」を参照してください。 

ウェブ コンソール ブレッドクラム（パンくずリスト）の使用と無効化 

ウェブ コンソール ビューを移動する際、ロケーション一連のリンクとして開いたビューに記録します。

各パンくずリストでは、以下のナビゲーション オプションを提供します。 

 パンくずリストをクリックして、対応するビューを直接開きます。 

http://www.solarwinds.com/
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 パンくずリストの横にある > をクリックして、ウェブ コンソールの同じナビゲーション レベルのそ

の他のすべてのビューに対するクリックできるリストを開きます。たとえば、ノードの詳細ビュー

を使用している際は、> をクリックすることで、その他の監視されたノードのリストを表示でき

ます。 

注記： IP アドレスの英数字順に一覧表示される最初の 50 個の監視されたノードのみ

が表示されます。 

ウェブ コンソール ブレッドクラム（パンくずリスト）のカスタマイズ 

ドロップダウンのパンくずリストは、以下の手順で示されているとおりにカスタマイズが可能です。 

ブレッドクラム ドロップダウン内のアイテムをカスタマイズするには： 

1. パンくずリストの適切なレベルで > クリックして、ドロップダウンを開きます。 

2. Customize this list （このリストをカスタマイズ）をクリックします。 

3. メニューから条件を選択して、Submit （送信）をクリックします。 

注記： カスタマイズされたリスト内のすべてのアイテムは、選択された条件と一致します。 

ウェブ コンソール ブレッドクラム（パンくずリスト）の無効化 

アカウント制限ユーザーに対してアクセスが適切に制限されていることを確認するには、パンくず

リストを以下の手順で無効にします。 

ウェブ コンソール ブレッドクラム（パンくずリスト）ナビゲーションを無効化するには： 

1. 管理者権限を持つアカウントで Orion サーバーにログインします。 

2. web.config を開いて（デフォルトの場所は C:\Inetpub\SolarWinds\）編集を行いす。 

3. <appsettings> セクションで、次の設定を検索します。 

<add key=”DisableBreadCrumbs” value=”false”/> 

4. 以下のように “false” を “true” に変更します。 

<add key=”DisableBreadCrumbs” value=”true”/> 

5. web.config を保存します。 

注記： この設定を編集した後に設定ウィザードを実行すると、変更が上書きされます。 
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Orion ウェブ コンソールの管理者機能 

以下のセクションでは、ウェブ コンソール管理者により実行される主要な管理者機能を説明し

ます。 

 アカウント パスワードの変更 

 Orion ウェブサイト管理 

 ウェブ上でのセキュアなデータ表示 

 カウンタ ロールオーバーの操作 

アカウント パスワードの変更 

Orion ウェブ コンソール管理者はユーザー アカウントのパスワードを以下の手順でいつでも変

更できます。 

注記： セキュリティが優先されている場合、SolarWinds は、ユーザーが自分のウェブ コンソー

ルのアカウント パスワードを変更するビューを提供しないことを推奨します。 

アカウント パスワードを変更するには： 

1. 管理者としてウェブ コンソールにログインします。 

2. ウェブ コンソールの右上にある Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの Accounts （アカウント）グ

ループ内の Manage Accounts （アカウント管理）をクリックします。 

4. パスワードを変更するユーザー アカウントを選択して、Change Password （パスワード

を変更）をクリックします。 

5. New Password （新しいパスワード）および Confirm Password （パスワードの確認） 

フィールドを入力して、Change Password （パスワードを変更）をクリックします。 

6. パスワードが適切に変更できたら、Continue （続行）をクリックします。 

Orion ウェブサイト管理 

管理者としてウェブ コンソールにログインする場合、ウェブ コンソールの上右端にある Settings 

（設定）をクリックすると Orion ウェブサイト管理ページが表示されます。このページでは、Orion 

ウェブ コンソール ユーザーに対して情報の表示方法を管理するツールが表示されます。以下

のオプションは Orion ウェブサイト管理ページから利用できます。 
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ノード＆グループの管理 

ネットワークの監視を開始する前に、Orion インストールで監視を行うためのネットワーク オブジ

ェクトを指定する必要があります。Getting Started with Orion （Orion クイックガイド）グルー

プは以下のディスカバリ関連のビューへの直接リンクを提供します。 

 Discovery Central （ディスカバリ セントラル）では、Orion インストールで監視している

ネットワーク オブジェクトのタイプと数について集約した概要を提供します。詳細については、

35 ページの「Discovery Central （ディスカバリ セントラル）」を参照してください。 

  Network Sonar Discovery をクリックして、Network Sonar Discovery ウィザードを

開きます。ネットワーク ディスカバリは、監視対象となるネットワーク全体に渡ってデバイスを

簡単に見つけることができます。詳細については、36 ページの「Network Sonar ウィザー

ドを使用したネットワーク ディスカバリ」を参照してください。 

  Add a Node （ノードを追加）をクリックして、Add Node （ノードを追加）ウィザードを直

接開きます。ノードを個々に追加する詳細については、223 ページの「ウェブ コンソール内

の監視するデバイスを追加」を参照してください。 

 ノード＆グループの管理 

Orion ウェブサイト管理ページの Node & Group Management （ノード＆グループ管理）グ

ループでは、ノードとグループを管理するために以下のウェブ コンソール ビューへのアクセスが可

能です。 

 Manage Nodes （ノード管理）をクリックすると、Node Management （ノード管理） 

ページが表示されます。このページで Orion ウェブ コンソール管理をすぐに追加することが

でき、さらに Orion インストールで管理および監視していたすべてのネットワーク オブジェク

トを管理します。詳細については、55 ページの「ウェブ コンソールでのデバイス監視」を参

照してください。 

 VMware 設定 をクリックして、VMware 設定ビューを開きます。VMware 設定ビューで

は現在監視されている VMware ESX サーバーや Orion NPM が ESX サーバーの監

視に使用する VMware 資格証明ライブラリのリストの双方を表示することができます。詳

細については、65 ページの「仮想化」を参照してください。 
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 Manage Dependencies （依存状態の管理）をクリックし、Manage Dependencies 

（依存状態の管理）ビューを開きます。依存状態により、ネットワーク トポロジまたは優先
順位に基づいて監視されたオブジェクト間の依存関係を作成し、重複したまたは冗長な
ポーリングとアラートを取り除くことができます。詳細については、243 ページの「依存状態
の管理」を参照してください。 

 Manage Groups （グループ管理）をクリックして、Manage Groups （グループ管理 

ビュー）を開きます。カスタムプロパティが以前よりも大きな数字な場合は、グループは監視
されたネットワーク オブジェクトを論理的に整理します。詳細については、237 ページの「グ
ループの管理」を参照してください。 

アカウント 

Orion ウェブサイト管理ページの Accounts （アカウント）グループは、ウェブ コンソール管理者

に次のウェブ コンソール設定ページへのアクセスを提供します。 

 Manage Accounts （アカウント管理）リンクにより、アカウントのパスワードの設定および

変更、ユーザーの権限とアクセスの設定、さらにすべてのユーザーに対するウェブ コンソー

ル エクスペリエンスの設定を行うアクセス権限をウェブ コンソール管理者に与えます。詳細

については、249 ページの「ウェブ アカウントの管理  –  コア」を参照してください。 

 Account List （アカウント リスト）をクリックして、ウェブ コンソールのユーザー アカウント設

定の概要を即時に提供する Orion ウェブサイト アカウント ビューを開きます。このビューで

はオプションをチェックしたりクリアすることで、複数のアカウントを同時かつ即時に変更する

ことができます。Account のユーザー名をクリックすると、選択したアカウントのアカウント 

マネージャが開きます。詳細については、249 ページの「ウェブ アカウントの管理  –  コア」

を参照してください。 

カスタマイズ 

Orion ウェブサイト管理ページの Customize （カスタマイズ）グループでは、以下のページの 

Orion ウェブ コンソールのナビゲーションと外見をカスタマイズするオプションが提供されます。 

 Customize Menu Bars （メニュー バーのカスタマイズ）ページで、Orion ウェブ コンソー

ル管理者は個別ユーザーに表示されるメニュー バーを設定することができます。詳細につ

いては、201 ページの「ウェブ コンソールのメニュー バーのカスタマイズ」を参照してください。 

 Color Scheme （カラー スキーム）ページで、ウェブ コンソール管理者はリソース タイトル 

バーのデフォルト カラー スキームを選択できます。カラー スキームの選択は、ウェブ コンソー

ルを通じて即座に影響します。詳細については、203 ページの「ウェブ コンソールのカラー 

スキームの変更」を参照してください。 

 External Websites （外部ウェブサイト）で、ウェブ コンソール管理者は Orion ウェブ  

コンソール ビューとしてビュー ツールバーに表示される外部ウェブサイトを指定できます。 

詳細については、200 ページの「外部ウェブサイト ビューの作成および編集」を参照してく

ださい。 
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アラート管理 

アラート管理グループは、アドバンスト アラート管理ビューへのリンクを提供します。このビューで

は、ウェブ コンソールからのアドバンスト アラートの編集、有効化、無効化、削除を直接行う

ことができます。ウェブ コンソールのアドバンスト アラート管理の詳細については、275 ページの

「Orion アドバンスト アラートの使用  –  コア」を参照してください。 

製品アップデート 

製品アップデート グループは、ウェブ コンソール ビューへのリンクを提供し、Orion NPM の使用

とアップグレードに関する最新情報を提供します。 

 利用可能な製品アップデート ビューでは、バージョン アップグレードやサービス パックを含

む Orion NPM のアップデートの定期的な確認を設定できます。 

 Orion 製品チーム ブログ では、Orion 製品チームのメンバーからの定期的な投稿を表

示し、Orion NPM やそのモジュールが提供する機能をフル活用することができます。 

ビュー 

Orion ウェブサイト管理ページの Views （ビュー）グループでは、ウェブ コンソール管理者に次

のビュー設定ページへのアクセスを提供します。 

 Manage Views （ビューの管理）ページで、ウェブ コンソール管理者は個々のウェブ コン

ソール ビューの追加、編集、コピー、削除を行うことができます。Orion ウェブ コンソール  

ビューの管理の詳細については、182ページの「ビューのカスタマイズ」を参照してください。 

 Add New View （新規ビューの追加）をクリックすると、Add New View page （新規 

ビューの追加）ページが開きます。このページで、新規のウェブ コンソール ビューを定義でき

ます。 

 Views by Device Type （デバイス タイプ別ビュー）ページで、ウェブ コンソール管理者

はネットワーク デバイスのデフォルト ビューを設定することができます。詳細については、

186ページの「デバイス タイプ別ビュー」を参照してください。 

設定 

Orion ウェブサイト管理ページの Settings （設定）グループでは、Orion ウェブ コンソール管理

者に次の設定ページへのアクセスを提供します。 

注記： Orion モジュールを最近インストールした場合、モジュール設定ページへのリンクは 

Settings （設定）グループに表示されます。Orion モジュール設定の詳細については、あなた

の Orion モジュールの『管理者ガイド 』を参照してください。 
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 Web Console Settings （ウェブ コンソール設定） では、ウェブ コンソール管理者は、
Orion ウェブ コンソールと Orion ウェブ コンソール ビューでリソースとして表示されるチャー
ト双方の機能や外見をカスタマイズできます。Orion ウェブ コンソールとチャート設定の詳
細については、205ページの「Orion ウェブ コンソールとチャート設定」を参照してください。 

 Polling Settings （ポーリング設定）では、Orion NPM ポーリング エンジンにおける 

ポーリング間隔、タイムアウト、統計、計算およびデータベース保持設定の設定を定義し
ます。Orion ポーリング設定の詳細については、262 ページの「Orion ポーリング設定」を
参照してください。 

 Orion Thresholds （Orion しきい値）ページで Orion General Thresholds （Orion 

一般しきい値）ページを開きます。このページで Orion NPM しきい値の設定を行います。
詳細については、52 ページの「Orion NPM しきい値の設定」を参照してください。 

詳細 

Orion ウェブサイト管理ページの Deatils （詳細）グループでは、Orion インストールの情報を

含む次のページのリンクを提供します。 

データベースの詳細 

これは情報提供のみを目的としたページであり、Orion インストールで使用されている 

SQL サーバー データベースについて詳細を示します。Orion サーバーとデータベース サー

バー双方の最新バージョン情報および設定に加えて、このページでは Orion データベース

の監視されたオブジェクトの全体数を表示します。 

ポーリング エンジン 

Orion は複数のポーリング エンジンの実装をサポートします。各エンジンはネットワークの

異なる部分からのデータを監視および収集することができます。このページでは、現在稼

動しているポーリング エンジンそれぞれに対するステータスと選択した設定情報を表示し 

ます。 

Orion コア詳細 

これは情報提供のみを目的としたページであり、Orion サーバー、監視されたオブジェクト

の数、およびいかなる、そしてすべてのインストール済み Orion 製品で必須の実行ファイ

ルや DLL に関する情報を含め、すべての Orion 製品で共有する共通コンポーネントやリ

ソースのインストールについて詳細を示します。 

ライセンスの詳細 

これは情報提供のみを目的としたページであり、インストールしたすべての Orion 製品に

関する、さらにお使い Orion ライセンスと監視されたネットワークの詳細を示します。この 

ページでは、実行している Orion NPM 製品のバージョンと、関連 DLL のバージョンも表

示します。ライセンス管理の詳細については、22 ページの「ライセンス マネージャによるライ

センス管理」を参照してください。 
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ウェブ上でのセキュアなデータ表示 

コミュニティ ストリングやログイン、パスワードなどの極秘のネットワーク情報は、ウェブ コンソール

では表示できません。しかし、ネットワークの安全性を確保している場合に、Orion ポーリング

設定ページの計算＆しきい値エリアから Allow Secure Data On Web （advanced ）  

（ウェブ上の安全データを有効にする（アドバンスト））にチェックを入れて、ウェブ コンソールからコ

ミュニティ ストリングのパッセージを許可します。 

注記： この設定は、ウェブにエクスポートしたカスタム レポートの表示には影響しません。詳細

については、321ページの「レポートの作成と表示  –  コア」を参照してください。 

カウンタ ロールオーバーの操作 

カウンタ ロールオーバー設定では、Orion NPM がカウンタ ロールオーバーを適切に処理するよ

う設定を行います。Orion NPM は 32 ビットまたは 64 ビット カウンタの処理が可能ですが、

デフォルトでは、Orion NPM はカウンタは 32 ビットを想定しています。32 ビット カウンタの最

大数値は 2
 32

 、または 4,294,967,296 であり、さらに 64 ビット カウンタの最大数値は（ネッ

トワーク デバイスでサポートされている場合）2
 64

 または 18,446,744,073,709,551,616 です。 

注記： 32 ビット カウンタのオプションは、Orion ポーリング設定ページの Counter Rollover 

（カウンタ ロールオーバー）フィールドで Method 1 として指定されます。 

以下の手順で、Orion NPM で使用するカウンタ処理のタイプを指定します。 

Orion NPM で使用するカウンタ処理のタイプを指定するには： 

1. 管理者としてウェブ コンソールにログインします。 

2.  ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion ウェブサイト管理ページの Settings （設定）グループ内の Polling Settings  

（ポーリング設定） をクリックします。 

4. 64 ビット カウンタを使用している場合は、計算＆しきい値エリアの Counter Rollover 

（カウンタ ロールオーバー）フィールドの Method 2 を選択します。 

注記： 

 Method 2 を選択した場合、2
 64

 までカウントする許可を与える前回ポーリングされ

た値よりも少ない場合は、Orion NPM は意図的にポーリングをスキップします。 

 Orion は 64 ビット カウンタの使用を完全にサポートしますが、64 ビット カウンタの場

合は実装時に問題のある動作が起こる可能性があります。これらのカウンタの使用

中に問題のある結果が生じた場合、問題のあるデバイスの 64 ビット カウンタの使用

を無効にして、デバイスの製造元に問い合わせます。 
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5. 32 ビット カウンタを使用している場合は、計算＆しきい値エリアの Counter Rollover 

（カウンタ ロールオーバー）フィールドの Method 1 を選択します。 

注記： Method 1 を選択した場合、ロールオーバーが検知され、ポーリングの時間が、 

（2
 32

 – 最後にポーリングされた値） + 現在ポーリングされた値として計算されます。 

Orion 一般しきい値 

Orion ウェブ コンソールの利用可能なリソースの多くは、ネットワーク上のデバイスのエラーと警

告条件を表示することができます。Orion ウェブ コンソールにエラーと警告が表示されます。

Orion NPM は、しきい値ページ上で提供された値を使用し、Orion ウェブ コンソールのエラー

と警告を表示するタイミングと方法を設定できます。 

以下のセクションでは、しきい値タイプと構成の詳細について説明します。 

 Orion 一般しきい値タイプ 

 Orion 一般しきい値の設定 

Orion 一般しきい値タイプ 

以下のデバイス条件は Origin 一般しきい値として設定されます。 

CPU Load （ CPU 負荷） 

High Level （高レベル）の数値設定よりも高い CPU 負荷を経験する監視されたネット

ワーク デバイスは、高い CPU 負荷のレポートとリソースを表示します。これらのデバイスの

ゲージも太字の赤色で表示されます。Warning Level （警告レベル）の数値設定よりも

高い CPU 負荷を経験する監視されたネットワーク デバイスは、High Level （高レベ

ル）の数値設定より低い場合は、高い CPU 負荷レポートとリソースで、赤色で表示され

ます。これらのデバイスのゲージも赤色で表示されます。 

ディスク使用 

High Level （高レベル）の数値設定よりも高いディスク使用を経験する監視されたネット

ワーク デバイスは、ディスク使用のレポートとリソースでボールドと赤色で表示します。

Warning Level （警告レベル）の数値設定よりも高いディスク使用を経験する監視され

たネットワーク デバイスは、High Level （高レベル）の数値設定より低い場合は、高いデ

ィスク使用レポートとリソースで、赤色で表示されます。 
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Percent Memory Used （使用されたメモリの割合） 

Error Level （エラー レベル）の数値設定よりも高いパーセント メモリ使用を経験する監

視されたネットワーク デバイスは、高利用率レポートとリソースで表示します。これらのデバ

イスのゲージも太字の赤色で表示されます。Warning Level （警告レベル）の数値設

定よりも高いパーセント メモリ使用を経験する監視されたネットワーク デバイスは、Error 

Level （エラーレベル）の数値設定より低い場合は、高利用率レポートとリソースで表示さ

れます。これらのデバイスのゲージも赤色で表示されます。 

パーセント パケット損失 

Error Level （エラーレベル）の数値設定よりも高いパーセント パケット損失を経験する

監視されたネットワーク デバイスは、高いパーセント損失のレポートとリソースで表示します。

これらのデバイスのゲージも太字の赤色で表示されます。Warning Level （警告レベ

ル）の数値設定よりも高いパーセント パケット損失を経験する監視されたネットワーク デ

バイスは、Error Level （エラーレベル）の数値設定より低い場合は、高いパーセント損

失のレポートとリソースで表示されます。これらのデバイスのゲージも赤色で表示されます。 

Orion NPM は、デフォルト ポーリング間隔で作成された ICMP ピング要求を使用し、 

パーセント パケット損失を計算します。Orion ピングはデバイスを監視し、最新の 10 のピ

ング要求の結果を記録します。パーセント パケット損失は、失敗したピング要求の数 X と

して表されます。これらはピング要求の数（10）で分割されます。デフォルト ポーリング間隔

の詳細については、262ページの「Orion ポーリング設定」を参照してください。 

たとえば、選択されたデバイスに対して作成された最後の 10 個のピング要求のうち、2 個

が失敗し、8 個が成功した場合は、選択されたデバイスのパーセント  パケット損失は 

2/10 または 20% としてレポートされます。 

Response Time （応答時間） 

Error Level （エラーレベル）の数値設定よりも長い応答時間を経験する監視されたデ

バイスは、高応答時間のレポートとリソースで表示されます。これらのデバイスのゲージも

太字の赤色で表示されます。Warning Level （警告レベル）の数値設定よりも長い応

答時間を経験するデバイスは、Error Level （エラーレベル）の設定値が短い場合、高

応答時間のレポートとリソースで表示されます。これらのデバイスのゲージも赤色で表示さ

れます。 

Orion NPM は、デフォルト ノード ポーリング間隔で作成された ICMP ピング要求を使用

して応答時間を計算します。Orion ピングはデバイスを監視し、最新の 10 のピング要求

の結果を記録します。平均応答時間は最近の 10 個のピング要求の平均応答時間とし

て表示されます。Orion NPM がデフォルト ポーリング間隔にピング応答を受信しない場

合、Orion NPM は警告間隔で設定された期間中に、10 秒毎に応答のないデバイスに

ピングを送信します。詳細については、262ページの「Orion ポーリング設定」を参照してく

ださい。 
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Orion 一般しきい値の設定 

次の手順で Orion 一般しきい値を設定します。 

Orion NPM しきい値を設定するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion ウェブサイト管理ページの Settings （設定）グループ内の Orion Thresholds 

（Orion しきい値）をクリックします。 

注記： Orion 一般しきい値の詳細については、180 ページの「Orion 一般しきい値タイ

プ」を参照してください。 

4. 選択したしきい値の Error Level （エラーレベル）、High Level （高レベル）、または 

Warning Level （警告レベル）に対する適切な数値を提供します。 

ビューのカスタマイズ 

Orion ウェブ コンソール ビューでは、マップ、チャート、サマリー リスト、リポート、エベント、そのほ

かのリソースへのリンクを含むネットワーク情報の表示を設定できます。カスタマイズされたビュー

はそのあと、メニュー バーに割り当てられます。 

注記： セキュリティが優先されている場合、SolarWinds は、ユーザーが自分のウェブ コンソー

ルのアカウント パスワードを変更するビューを提供しないことを推奨します。 

新規ビューの作成 

Orion ウェブ コンソールを、個々のユーザー毎にカスタマイズすることができます。カスタマイズに

は、管理者としてログインし、次の手順で示される通りに新規のビューを作成します。 

注記： セキュリティが優先されている場合、SolarWinds は、ユーザーが自分のウェブ コンソー

ルのアカウント パスワードを変更するビューを提供しないことを推奨します。 

新規ビューを作成するには： 

1. ウェブ コンソールの右上の Settings （設定）をクリックします。 

2. Views （ビュー）グループから Manage Views （ビューの管理）をクリックします。 

3. Add （追加）をクリックします。 

4. Name of New View （新規ビューの名前）を入力して、Type of View （ビューの種類

）を選択します。 
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注記： Type of View （ビューの種類）の選択は、ビューのユーザーに対するアクセスに影

響を与えます。またここでの選択が後から変更できない場合もあります。詳細については、

186 ページの「デバイス タイプ別ビュー」を参照してください。 

5. Submit （送信）をクリックします。 

 新規ビューを作成してから Customize YourView （ビューのカスタマイズ）ページを開きます。

詳細については、183ページの「ビューの編集」を参照してください。 

ビューの編集 

Orion ウェブ コンソールで管理者は個々のユーザーに対するビューの設定を行えます。次の手

順を実行して既存ビューの設定を行います。 

既存ビューを編集するには： 

1. ウェブ コンソールの右上の Settings （設定）をクリックします。 

2. Views （ビュー）グループから Manage Views （ビューの管理）をクリックします。 

3. カスタマイズするビューをリストから選択し、Edit （編集）をクリックします。 

4. ビューの列のレイアウトを変更する場合は 、以下の手順を実行してください。 

a. 列幅の右側にある Edit （編集）をクリックします。 

b. Layout （レイアウト）の下の列の数字を選択します。 

c. 適切なフィールドで各列の幅をピクセル単位で設定します。 

d. Submit （送信）をクリックします。 

5. リソースを追加する場合、各リソースで以下の手順を繰り返してください。 

注記： 

 このページではすべてのウェブ コンソール リソースを挙げているため、ご利用のビューに

既に含まれるリソースは選択されていません。このため、既に表示しているリソースを

重複して選択する可能性があります。 

 いくつかのリソースでは追加設定が必要になる場合があります。詳細については、

186ページの「リソース構成のサンプル」を参照してください。 

 リソース追加ページがページのリソース リストに追加されますが、特定のマップ、リンク、

またはコードの実際の設定はページがプレビューされるまで追加されません。 

a. 追加するリソースの列の横にある + をクリックします。 

b. Add Resources （リソース追加）ページのリソース グループの横にある + をクリックし

てリソース グループを展開し、利用可能なリソースを表示します。 
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c. 追加するすべてのリソースをチェックします。 

d.  選択したビューへのリソースの追加が完了した後に、Submit （送信）をクリックします。 

6. 列からリソースを削除する場合、リソースを選択して、リソースの列の横にある X をクリック

して、選択したリソースを削除します。 

7. 列のリソースをコピーする場合、リソースを選択して、リソースの列の横にある  をクリック

して、選択したリソースをコピーします。 

8. ご使用のビューに表示されるリソースの順番を並べ替えるには、リソースを選択した後に、
方向キーを使用してそれらのリソースを並べ替えます。 

9. ビューの設定が完了したら、Preview （プレビュー）をクリックします。 

注記： カスタム ウェブ コンソールのプレビューは新しいウィンドウに表示されます。リソースに

関する情報へのポーリングがまだ実行されていない場合、リソースのある場所でメッセージ

が表示される場合があります。詳細については、186 ページの「リソース構成のサンプル」

を参照してください。 

10. プレビュー ウィンドウを閉じます。 

11. ビューの設定が完了した場合、Done （完了）をクリックします。 

注記： カスタマイズされたビューをカスタム アイテムとしてメニュー バーに追加する詳細につ

いては、201ページの「ウェブ コンソールのメニュー バーのカスタマイズ」 を参照してください。

カスタマイズされたビューのデフォルト ビューとしての割り当ての詳細については、250ページ

の「ユーザーアカウントの編集」を参照してください。 

ビュー制限の構成 

セキュリティ機能として、管理者はウェブ コンソールでビュー制限を適用させることができます。

以下の制限はデフォルトで定義されています。 

Orion ウェブ コンソールのビュー制限 

単一のネットワーク ノード ノード グループ システムの場所のパターン 

ノード名のパターン システム名のパターン 単一のインターフェース（ Orion NPM ） 

マシン タイプのパターン マシン タイプのグループ インターフェースの状態（ Orion NPM ） 

ハードウェアの製造元 単一ハードウェアの製造元 
インターフェース エイリアスのパターン

（ Orion NPM ） 

システムの場所 システム コンタクトのパターン 
インターフェースのグループ 

（ Orion NPM ） 

System Contact  

（システムのコンタクト） 
IP Address Pattern （ IP アド

レスのパターン） 

Interface Name Pattern （ Orion 

NPM ）（インターフェース名のパターン） 

 Group of Volumes  

（ボリュームのグループ） 
 Device Status （デバイスのス

テータス） 

Interface Type （ Orion NPM ） 

（インターフェース タイプ） 
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Orion ウェブ コンソールのビュー制限 

 Single Machine Type 

 （単一のマシン タイプ） 
Single Group （単一グループ） 

Group of Groups  

（グループのグループ） 

 Group Name Pattern 

（グループ名のパターン） 
  

 

ビュー制限は、以下の手順で構成されます。 

ビュー制限を有効化するには： 

1. ウェブ コンソールの右上の Settings （設定）をクリックし、Orion ウェブサイト管理ページ

の Views （ビュー）グループの Manage Views （ビューの管理）をクリックします。 

2. 制限を追加するビューを選択し、Edit （編集）をクリックします。 

3. Customize View （ビューのカスタマイズ）ページのビュー制限で、Edit （編集）をクリックし

ます。 

4. 適用するビュー制限のタイプを選択し、Continue （続行）をクリックします。 

5. 適切なストリングまたオプションを入力またはチェックを行い、デバイス タイプを定義して選

択したビューから含めるか除外して、Submit （送信）をクリックします。 

注記： アスタリスク（ * ）は有効なワイルドカードです。フィールドに対応しているデバイスへ

のパターン制限ビューには提供されているストリングが含まれます。 

ビューのコピー 

同じデバイス タイプを基にした複数のビューを作成する場合、ビューをコピーすることで一つの 

ビューを作成し、そのビューをテンプレートとして使用しその他のビューを新規作成できます。既

存のビューは以下の手順でコピーされます。 

ビューをコピーするには： 

1. ウェブ コンソールの右上の Settings （設定）をクリックします。 

2. Views （ビュー）グループから Manage Views （ビューの管理）をクリックします。 

3. コピーするビューを選択してから、Copy （コピー）をクリックします。 

4. コピーしたビューを編集するには、183 ページの「ビューの編集」セクションの手順を実行し

ます。 
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ビューの削除 

既存のビューは以下の手順で削除されます。 

既存のビューを削除するには： 

1. ウェブ コンソールの右上の Settings （設定）をクリックします。 

2 Orion ウェブサイト管理ページの Views （ビュー）グループ内から Manage Views  

（ビューの管理）をクリックします。 

3. 削除するビューを選択してから、Delete （削除）をクリックします。 

デバイス タイプ別ビュー 

ネットワーク オブジェクト間と、レポートされる統計の間には大きな差がありますが、Orion ウェブ 

コンソールは、デバイス タイプ別のオブジェクトの詳細を表示することでネットワーク データを示し

ます。デバイス タイプ別のオブジェクトの詳細を表示することで、ネットワーク上にある（ルーター、

ファイアウォール、サーバーも含む）デバイスの一意のタイプに対して異なる表示を行えます。次

の手順で、利用可能なデバイス タイプ別ビューを割り当てます。 

デバイス タイプ別ビューを割り当てるには： 

1. ウェブ コンソールの右上の Settings （設定）をクリックし、Orion ウェブサイト管理ページ

の Views （ビュー）グループの Views by Device Type （デバイス タイプ別ビュー）をク 

リックします。 

2. Orion が現在ネットワーク上で監視または管理しているものとは異なるタイプのデバイスに

対して、利用可能なウェブ ビューを選択します。 

3. Submit （送信）をクリックします。 

リソース構成のサンプル 

リソース追加ページから選択されるリソースには、追加設定が必要です。このセクションにはこれ

らのリソースのサンプルと、適切な設定を行うための手順が含まれています。 

ネットワーク マップの選択 

Orion Network Atlas で作成されたネットワーク マップでは、お使いのネットワークの概要をメ

イン ウェブ コンソール ビューで表示します。マップ作成の詳細については、121ページの「ネット

ワーク マップの作成」を参照してください。 

注記： タイトルバー メニューのリソース タイトルをクリックすると、ブラウザ ウィンドウにリソースが

表示されます。 
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以下の手順でネットワーク マップを Orion ウェブ コンソールに追加します。 

ウェブ コンソールにネットワーク マップを追加するには： 

1. 新規ビューを作成するか、既存ビューを編集します。 

注記： 詳細については、182ページの「ビューのカスタマイズ」を参照してください。 

2. マップを追加するビューを選択し、Edit （編集）をクリックします。 

3. 新しいマップを表示するビュー列の横にある + をクリックして、新しいマップを表示します。 

4. ネットワーク マップ の横にある + をクリックした後に ネットワーク マップ をチェックして、

Submit （送信）をクリックします。 

5. Customize YourView （ビューのカスタマイズ）ページで Preview （プレビュー）をクリック

します。 

6. ネットワーク マップのリソース タイトル バーから Edit （編集）をクリックします。 

7. デフォルトのタイトルを使用しない場合は、新しい タイトル を追加されたマップのタイトル 

バーに入力します。 

8. サブタイトルが必要な場合は、新しい サブタイトル を追加したマップに入力します。 

注記： タイトルおよびサブタイトルはテキストまたは HTML として入力されます。 

9. 利用可能なマップのリストから選択します。 

10. マップを表示する Scale （スケール）を選択します。 

注記： Scale （スケール）フィールドを空白にすると、マップが表示されるカラムのサイズに

基づいて、マップは最大スケールで表示されます。 

11. Submit （送信）をクリックします。 

ネットワーク マップのオブジェクトのリストを表示 

マップ上に表示されるネットワーク オブジェクトのリストを保持しておくと、ウェブ コンソール ビュー

にネットワーク マップが含まれているときに便利です。以下の手順で、ネットワーク マップ オブ 

ジェクトを一覧表示したリソースを有効化できます。 

注記： リソース タイトルをクリックすると、新たなブラウザ ウィンドウでリソースが表示されます。 

ネットワーク マップ オブジェクトのリストを表示するには： 

1. 新規ビューを作成するか、既存ビューを編集します。 

注記： 詳細については、182ページの「ビューのカスタマイズ」を参照してください。 
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2. ビューを選択してネットワーク マップ オブジェクトのリストを表示し、Edit （編集）をクリックしま

す。 

3. ネットワーク マップ オブジェクトの新しいリストを表示したいビュー列の横にある + をクリック

します。 

4. ネットワーク マップ の横にある + をクリックした後に ネットワーク マップ上のオブジェクト リス

ト をチェックして、Submit （送信）をクリックします。 

5. Customize YourView （ビューのカスタマイズ）ページで Preview （プレビュー）をクリック

します。 

6. ネットワーク マップ リソース上のオブジェクト リストのタイトル バーで、Edit （編集）をクリック

します。 

7. デフォルトのタイトルを使用しない場合は、新しい タイトル をオブジェクト リストのヘッダーに

入力します。 

8. サブタイトルが必要な場合は、新しい サブタイトル を追加したオブジェクト リストに入力し

ます。 

注記： タイトルおよびサブタイトルはテキストまたは HTML として入力されます。 

9. リストを設定するオブジェクト用に利用可能なマップ リストから選択し、Submit （送信）を

クリックします。 

マップのカスタムリストを表示 

ウェブ コンソールでは、利用可能なネットワーク マップのリストでカスタム ビューを設定できます。

カスタムリストの各マップをクリックすると、新しいウィンドウで開きます。以下の手順でカスタム  

ネットワーク マップ リストのリソースを有効化できます。 

注記： リソース タイトルをクリックすると、ブラウザ ウィンドウにリソースが表示されます。 

マップのカスタムリストを表示するには： 

1. 新規ビューを作成するか、既存ビューを編集します。 

注記： 詳細については、182ページの「ビューのカスタマイズ」を参照してください。 

2. ネットワーク マップのカスタムリストを追加するビューを選択して、Edit （編集）をクリックします。 

3. ネットワーク マップのカスタムリストを表示するビュー列の横にある + をクリックします。 

4. ネットワーク マップ の横にある + をクリックします。 

5. Custom List of Maps （マップのカスタムリスト）をチェックして、Submit （送信）をクリッ

クします。 
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6. Customize YourView （ビューのカスタマイズ） ページの プレビュー をクリックしたあと、マッ

プ リソースのカスタムリストのタイトル バーから Edit （編集）をクリックします。 

7. デフォルトのタイトルを使用しない場合は、新しい タイトル をマップ リストのヘッダー用に入

力します。 

8.  サブタイトルを使用する場合は、新しい サブタイトル をマップのカスタムリストへ入力します。 

注記： タイトルおよびサブタイトルはテキストまたは HTML として入力されます。 

9. マップリストに含むマップをチェックします。 

10. Submit （送信）をクリックします。 

イベント サマリー - カスタム期間の時間の表示 

ウェブ コンソール ビューを使用して、特定の期間のイベント サマリーを表示します。以下で、 

ウェブ コンソールにイベント サマリーを含める方法を列挙します。 

注記： タイトルバー メニューのリソース タイトルをクリックすると、ブラウザ ウィンドウにリソースが

表示されます。 

イベント サマリーを表示するには： 

1. 新規ビューを作成するか、既存ビューを編集します。 

注記： 新規ビューの作成または既存ビューの編集の詳細については、182 ページの「ビュ

ーのカスタマイズ」を参照してください。 

2. イベント サマリーを含めるビューを選択して、Edit （編集）をクリックします。 

3. イベント サマリーを表示するビュー列の横にある + をクリックします。 

4. イベント の横にある + をクリックします。 

5. イベント サマリー  –  カスタムの期間 をチェックして、Submit （送信）をクリックします。 

6. Customize YourView （ビューのカスタマイズ）ページで Preview （プレビュー）をクリック

します。 

7. イベント サマリー リソースのタイトル バーから Edit （編集）をクリックします。 

8. デフォルトのタイトルを使用しない場合は、新しい タイトル をイベント サマリーのヘッダー用

に入力します。 

注記： タイトルはテキストまたは HTML として入力されます。 

9. Display Events for the following Time Period （次の期間でのイベントの表示）

からイベントを表示する期間を選択します。 

10. Submit （送信）をクリックします。 
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ユーザー定義リンクの指定 

ユーザー定義リンク オプションは、外部ウェブサイトまたはカスタマイズされたビューへのクイック ア

クセスを作成するためにも使用されます。カスタマイズされたビューの URL をプレビュー ページ

からコピーし、User-Defined Links （ユーザー定義リンク）フィールドに貼り付けられます。以下

の手順でウェブ コンソールからのユーザー定義リンクを有効にします。 

注記： タイトルバー メニューのリソース タイトルをクリックすると、ブラウザ ウィンドウにリソースが

表示されます。 

ユーザー定義リンクのリソースを有効化するには： 

1. 新規ビューを作成するか、既存ビューを編集します。 

注記： 詳細については、182ページの「ビューのカスタマイズ」を参照してください。 

2. ユーザー定義リンク リソースを追加するビューを選択します。 

3. Edit （編集）をクリックします。 

4. ユーザー定義リンクのリソースを表示するビュー列の横にある + をクリックします。 

5. Miscellaneous （その他）の横にある + をクリックします。 

6. User Defined Links （ユーザー定義リンク）をチェックします。 

7. Submit （送信）をクリックします。 

8. Customize YourView （ビューのカスタマイズ）ページで Preview （プレビュー）をクリック

します。 

9. ユーザー定義リンク リソースのタイトル バーから Edit （編集）をクリックします。 

10. デフォルトのタイトルを使用しない場合は、新しい タイトル をリンク リスト用に入力します。 

11. サブタイトルが必要な場合は、新しい サブタイトル をリンク リスト用に入力します。 

注記： タイトルおよびサブタイトルはテキストまたは HTML として入力されます。 

12. 定義したい各リンクに関する以下の情報を入力します。 

a. リンクの Name （名前）とリンクの URL 。 

b. リンクを新しいブラウザ ウィンドウで開く場合は、Open in New Window （新しいウ

ィンドウで開く）をチェックします。 

13. Submit （送信）をクリックします。 
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カスタム HTML またはテキストの指定 

ウェブ コンソールで提供したい統計情報がある場合は、Custom HTML or Text （カスタム 

HTML またはテキスト）オプションを使用します。Custom HTML or Text （カスタム HTML 

またはテキスト）オプションはカスタマイズされたビューへの迅速なアクセスの作成を行うためにも

使用されます。以下の手順で、テキストまたは HTML コンテンツを表示するためにウェブ コン 

ソール内に統計コンテンツを作成します。 

注記： リソース タイトルをクリックすると、新たなブラウザ ウィンドウでリソースが表示されます。 

カスタム HTML またはテキストを指定するには： 

1. 新規ビューを作成するか、既存ビューを編集します。 

 注記： 詳細については、182ページの「ビューのカスタマイズ」を参照してください。 

2. カスタム HTML またはテキストを含むビューを選択して、Edit （編集）をクリックします。 

3. 列の横にある + をクリックして、カスタム HTML またはテキストを表示します。 

4. Miscellaneous （その他）の横にある + をクリックしたあと、Custom HTML or Text 

（カスタム HTML またはテキスト）にチェックを入れます。 

5. Submit （送信）をクリックします。 

6. Customize YourView （ビューのカスタマイズ）ページで Preview （プレビュー）をクリック

します。 

7. カスタム HTML またはテキスト リソースのタイトル バーから Edit （編集）をクリックします。 

8. デフォルトのタイトルを使用しない場合は、新しい タイトル を指定のコンテンツ エリア用に

入力します。 

9. サブタイトルを使用する場合は、特定のコンテンツ エリア用に サブタイトル を入力します。 

注記： タイトルおよびサブタイトルはテキストまたは HTML として入力されます。 

10. Raw HTML （無変換の HTML ）フィールドにテキストか HTML としてコンテンツを入力

します。 

11. Submit （送信）をクリックします。 
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Orion レポートの指定 

ウェブ コンソールは Orion Report Writer で作成したレポートをどのビューにも取り込むことが

できます。次の手順で Report Writer で作成したレポートを選択し、ウェブ コンソール ビュー

内に含めます。 

注記： タイトルバー メニューのリソース タイトルをクリックすると、ブラウザ ウィンドウにリソースが

表示されます。 

Orion レポートを含めるには： 

1. 新規ビューを作成するか、既存ビューを編集します。 

注記： 詳細については、182ページの「ビューのカスタマイズ」を参照してください。 

2. レポートを追加するビューを選択します。 

3. Edit （編集）をクリックします。 

4. レポートを表示するビュー列の横にある + をクリックします。 

5. Report Writer の横にある + をクリックします。 

6. Orion Report Writer のレポートにチェックを入れます 。 

7. Submit （送信）をクリックします。 

8. Customize YourView （ビューのカスタマイズ）ページで Preview （プレビュー）をクリック

します。 

9. Orion Report Writer リソースからのレポートのタイトル バーで Edit （編集）をクリックしま

す。 

10. デフォルトのタイトルを使用しない場合は、追加するレポートの 新しい タイトル を入力し

ます。 

11. サブタイトルが必要な場合は、追加するレポートの 新しい サブタイトル を入力します。 

注記： タイトルおよびサブタイトルはテキストまたは HTML として入力されます。 

12. 追加する Report （レポート）を選択します。 

13. 追加したレポートにフィルタを追加する場合は、適切なクエリーを Filter Nodes （フィルタ 

ノード）フィールドに入力します。 

注記： フィルタ ノード は SQL クエリーの知識を必要とするオプションの、高度なウェブ コン

ソールの機能です。フィルタのサンプルを表示するには、Show Filter Examples （フィル

タのサンプルを表示）の横にある + をクリックします。 

14. Submit （送信）をクリックします。 
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レポートのカスタムリストを表示 

ウェブ コンソールでは、カスタム レポート リストを使用してカスタム ビューを作成できます。リスト

でクリックすると、各レポートが新しいウィンドウで開きます。次の手順では、ネットワーク レポート

のカスタムリストを有効にする方法を示します。 

注記： リソース タイトルをクリックすると、新たなブラウザ ウィンドウでリソースが表示されます。 

レポートのカスタムリストを表示するには： 

1. 新規ビューを作成するか、既存ビューを編集します。詳細については、182 ページの「ビュ

ーのカスタマイズ」を参照してください。 

2. レポートのカスタムリストを追加するビューを選択し、Edit （編集）をクリックします。 

3. 列の横にある + をクリックし、レポートのカスタムリストを表示します。 

4. Report Writer の横にある + をクリックします。 

5. Custom List of Reports （レポートのカスタムリスト）にチェックを入れて、Submit （送

信）をクリックします。 

6. Customize YourView （ビューのカスタマイズ）ページで Preview （プレビュー）をクリック

したあと、Orion Report Writer リソースから、レポートのタイトル バーで、Edit （編集）を

クリックします。 

7. デフォルトのタイトルを使用しない場合は、新しい Title （タイトル）をレポート リストのヘッ

ダーに入力します。 

8. サブタイトルを使用する場合は、レポートのカスタムリストの 新しい Subtitle （サブタイト

ル）を入力します。 

注記： タイトルおよびサブタイトルはテキストまたは HTML として入力されます。 

9. レポートのカスタムリストで、追加するレポートにチェックを入れます。 

注記： カスタムリストに入っているレポートをユーザーに見えようにするには、アカウント用に

レポートへのアクセスを設定する必要があります。詳細については 258 ページの「アカウン

ト レポート フォルダの設定」を参照してください。 

10. Submit （送信）をクリックします。 
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ノードのフィルタリング 

Orion ウェブ コンソールはネットワーク上のカスタマイズ可能なノードリストを保持することができ

ます。ノードリストは SQL クエリー フィルタを用いて特定のビューに対して設定することができま

す。以下の手順で、ウェブ コンソール ビューに含まれるノードリスト用にノードのフィルタリングを

設定します。 

注記： リソース タイトルをクリックすると、新たなブラウザ ウィンドウでリソースが表示されます。 

ノードリストでフィルタを有効にするには： 

1. 新規ビューを作成するか、既存ビューを編集します。 

注記： 詳細については、182ページの「ビューのカスタマイズ」」を参照してください。 

2. ノードリストを追加するビューを選択し、Edit （編集）をクリックします。 

3. ノードリストを表示するビュー列の横にある + をクリックします。 

4. ノードリスト の横の + をクリックし、All Nodes – Table （全ノード  –  テーブル）にチェック

を入れて Submit （送信）をクリックします。 

5. カスタマイズ YourView （ビュー）ページの Preview （プレビュー）をクリックしたあと、全 

ノード  –  テーブルのタイトル バーから Edit （編集）をクリックします。 

6. デフォルトのタイトルを使用しない場合は、ノードリストの新しい Title （タイトル）を入力し

ます。 

7. サブタイトルが必要な場合は、ノードリストの新しい Subtitle （サブタイトル）を入力します。 

注記： タイトルおよびサブタイトルはテキストまたは HTML として入力されます。 

8. ノードリストをテキストか IP アドレス範囲でフィルタリングする場合は、以下の例で示され
るとおりに、テキストまたは IP アドレス範囲を Filter Text （テキストのフィルタリング）フィー

ルドで入力して、ノードリストをフィルタリングします。 

 Filter Text （フィルタ テキスト）フィールドに Home と入力し、ノード名または場所に

「Home」と記されているすべてのノードを一覧表示します。 

 Filter Text （フィルタ テキスト）フィールドに 192.168.1.* と入力し、IP アドレス範

囲が 192.168.1.0 ～ 255 の全ノードを一覧表示します。 

9. 次の例に示すとおりに、上記で与えられたフィルタ テキストに適切なプロパティを選択します。 
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 Filter Text （フィルタ テキスト）エリアで Home を入力した場合、Node Name  

（ノード名）または Location （場所）を選択し、ノード名と場所に Home」という語が

使用されているノードを一覧表示します。 

 Filter Text （フィルタ テキスト）エリアに 192.168.1.* と入力し、IP Address 

（IP アドレス）を選択して、IP アドレス範囲が 192.168.1.0 ～ 255 のノードのみを

一覧表示します。 

10. SQL フィルタをノードリストに適用する場合は、Filter Nodes （SQL） （フィルタ ノード

（SQL））フィールドで適切なクエリーを入力します。 

注記： 

 フィルタ ノード（SQL） は SQL クエリーの知識を必要とする、オプションの高度なウェ

ブ  コンソールの機能です。フィルタのサンプルを表示するには、Show Filter 

Examples （フィルタのサンプルを表示）の横にある + をクリックします。 

 デフォルトでは、ノードリスト リソースはノードのキャプション別にアルファベット順でノード

が並ぶように設定されています。この設定は、SQL フィルタを用いて上書きすることは

できません。このため、SQL フィルタに含まれる order by 句が重複し、カスタム 

SQL フィルタでフォーマット エラーが起こる場合があります。 

11. Submit （送信）をクリックします。 

ノードのグループ化 

Orion ウェブ コンソールはネットワーク上のカスタマイズ可能なノードリストを保持することができ

ます。ノードリストでは、ノード グループの特定のビューを設定することができます。以下の手順

で、ウェブ コンソール ビューに含まれるノードリスト用にノード グループを設定します。 

注記： タイトルバー メニューのリソース タイトルをクリックすると、ブラウザ ウィンドウにリソースが

表示されます。 

ノードリストのグループ化を有効にするには： 

1. 新規ビューを作成するか、既存ビューを編集します。 

注記： 詳細については、182ページの「ビューのカスタマイズ」を参照してください。 

2. ノードリストを追加するビューを選択し、Edit （編集）をクリックします。 

3. ノードリストを表示するビュー列の横にある + をクリックします。 

4. ノードリスト の横の + をクリックします。 

5. 適切なノードリストにチェックを入れて Submit （送信）をクリックします。 
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6. Customize YourView （ビューのカスタマイズ）ページで Preview （プレビュー）をクリック

します。 

7. 全ノード  –  ツリー（AJAX）のタイトルバーで Edit （編集）をクリックします。 

8. デフォルトのタイトルを使用しない場合は、ノードリストの新しい Title （タイトル）を入力し

ます。 

9.  サブタイトルが必要な場合は、ノードリストの新しい Subtitle （サブタイトル）を入力します。 

注記： タイトルおよびサブタイトルはテキストまたは HTML として入力されます。 

10. ウェブ コンソール ビュー内で指定したレベルで、Grouping Nodes （グループ化される 

ノード）の条件を 3 つまで選択します。 

11. SQL フィルタをノードリストに適用する場合は、Filter Nodes （フィルタ ノード（SQL）） 

フィールドで適切なクエリーを入力します。 

注記： 

 フィルタ ノード（SQL） は SQL クエリーの知識を必要とする、オプションの高度なウェ

ブ  コンソールの機能です。フィルタのサンプルを表示するには、Show Filter 

Examples （フィルタのサンプルを表示）の横にある + をクリックします。 

 デフォルトでは、ノードリスト リソースはノードのキャプション別にアルファベット順でノード

が並ぶように設定されています。この設定は、SQL フィルタを用いて上書きすることは

できません。このため、SQL フィルタに含まれる order by 句が重複し、カスタム 

SQL フィルタでフォーマット エラーが起こる場合があります。 

12. Submit （送信）をクリックします。 

サービス レベル合意項目のチャートへの追加 （Orion NPM） 

Orion ウェブ コンソールでは、サービス レベル合意 （SLA）項目を、最低 / 最高 / 平均 bps  

チャート上で表示します。「SLA」という名前の顧客プロパティを追加して、デバイス SLA 値を用

いてフィールドを設定する際、Orion ウェブ コンソールはチャート上に適切な項目を表示します。 

注記： 

 インターフェース データは、Orion NPM でのみ利用可能です。 

 SLA 項目がすぐには表示されない場合があります。Orion ウェブ エンジンに変更が検知

されるまでに数分かかる場合があります。 



SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 ウェブ コンソール  –  コアの管理 197 

サービス レベル合意項目を最低 / 最高 / 平均 bps チャートへ追加するには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access 

Control > Custom Property Editor （スタート > すべてのプログラム > SolarWinds 

Orion > グループ化およびアクセス コントロール > カスタム プロパティ エディタ）をクリックし

ます。 

2. Add Custom Property （カスタムプロパティを追加）をクリックして、Add Predefined 

Properties （定義済みプロパティを追加）を選択します。 

3. 定義済みプロパティのリストから SLA にチェックを入れて、OK をクリックします。 

4. Properties > Edit Interfaces Properties （プロパティ  > インターフェース プロパティ

の編集）をクリックします。 

5. SLA 値でラベルを付けたい各インターフェースの SLA カラム内で、SLA 値（bps）を入力

します。たとえば、T1 インターフェース（1.544 Mbps）には 1544000 、または 225 Kbps 

で実行するシリアル接続用には 225000 と入力します。 

6. Custom Property Editor （カスタム プロパティ エディタ）を閉じます。 

7. Start > All Programs > SolarWinds Orion > Orion Web Console （スタート  > 

すべてのプログラム  > SolarWinds Orion  > Orion ウェブ コンソール）をクリックします。 

8. 編集したインターフェースのどれか 1 つの Interface Details （インターフェースの詳細）ビュー

にブラウズします。SLA 値は Min/Max/Average bps （最低 / 最高 / 平均 bps）を表示す

るすべてのチャートで表示されます。 

Orion ウェブ コンソール メッセージ センターの使用 

メッセージ センターは、単一でカスタマイズ可能なビューをウェブ コンソールで提供します。単一

のテーブルでは、ネットワーク上のすべてのイベント、アラート、トラップ、Syslog メッセージを確

認できます。 

メッセージ センターを確認、設定するには： 

1. Home > Message Center （ホーム  > メッセージ センター）をクリックします。 

2. 指定のデバイスについてのメッセージを確認する場合は、Filter Devices （フィルタ デバイ

ス）エリアで適切なデバイス プロパティを選択します。 

3. Filter Messages （フィルタ メッセージ）エリアで、確認するメッセージの Time period 

（期間）を選択し、表示するメッセージの数を入力します。 

4. すべてのメッセージを（確認済みのメッセージも含めて）表示したい場合は、Filter 

Messages （フィルタ メッセージ）エリアの Show acknowledged （確認済みメッセージ

を表示）にチェックを入れます。 
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5. 特定の種類のメッセージのみを表示する場合は、以下に示される手順でメッセージをフィ
ルタリングします。 

a. アラートを表示する場合は、Show triggered alerts （トリガーされたアラートを表

示）がチェックされていることを確認します。そのあと、表示するアラートの種類を選択

します。 

b. イベント メッセージを表示する場合は、Show event messages （イベント メッ 

セージの表示）がチェックされていることを確認してから、表示するアラートの種類を選

択します。 

c. Syslog メッセージを表示する場合は、Show syslog messages （ Syslog メッ

セージを表示）がチェックされていることを確認してから、表示する Syslog メッセージ

の Severity （重大性）と Facility （機能）を選択します。 

注記： Syslog 重大性と機能の詳細については、362ページの「Syslog メッセージ

の優先順位」を参照してください。 

d. 受信したトラップを表示する場合は、Show received traps （受信したトラップを

表示）がチェックされていることを確認してから、表示するトラップの Trap type （トラッ

プの種類）と Community String （コミュニティ ストリング）を選択します。 

6. 表示されているメッセージを更新するには、Refresh （更新）をクリックします。 

PDF へのビューのエクスポート 

Orion ウェブ コンソールのビューの多くは、PDF （.pdf ）に直接エクスポートできます。エクスポー

トできるビューでは、その右上に Export to PDF （PDF にエクスポート）が表示されます。 

注記： PDF へのエクスポート機能を使用するには、IIS の匿名アクセスが必要です。IUSR_ 

SERVERNAME ユーザーが、Orion サーバー上のローカル ユーザー グループに属しているこ

とを確認します。 

ビューを PDF へエクスポートするには： 

1. エクスポートするウェブ コンソール ビューを開いて、ビューの右上の Export to PDF 

（PDF にエクスポート）をクリックします。 

2. .pdf ファイルを保存するよう求められたら、Save （保存）をクリックします。 

3. 適切な位置に移動して、適切なファイル名を入力し、Save （保存）をクリックします。 
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カスタムサマリー画面の作成 

Orion カスタムサマリー画面で、ユーザーは、選択したリソースのみで構成した、完全にカスタマ

イズ可能なオブジェクト ベースのビューを作成することができます。次の手順により、ウェブ コン 

ソールでカスタムサマリー画面を作成します。 

ウェブ コンソールのカスタムサマリー画面を作成または編集するには： 

1. Home > Custom Summary （ホーム  > カスタム サマリー）をクリックします。 

2. カスタム オブジェクト リソースで Edit （編集）をクリックします。 

3. 選択したカスタム オブジェクト リソースの Title （タイトル）と Subtitle （サブタイトル）を入

力します。 

4. Select Orion Object （ Orion オブジェクトの選択）をクリックします。 

5. Select a network object （ネットワーク オブジェクトを選択）ウィンドウで、Show only 

（表示のみ）と Group by （グループ別）選択フィールドを必要に応じて使用し、監視され

たオブジェクトのリストをフィルタリングします。 

6. ベースにしたい選択したカスタム オブジェクト リソースの Orion オブジェクトを選択し、

Select Orion object （Orion オブジェクトの選択）をクリックします。 

7. 選択したオブジェクトについて表示するカスタム リソースの情報タイプを選択し、下記で説

明される手順のとおりにリソースをカスタマイズします。 

a. アラーム リソースを選択した場合、必要に応じて Show Acknowledged Alerts 

（確認済みアラートを表示）をクリックまたはクリアして、確認済みアラートを表示する

かどうかを指定します。 

b. SQL フィルタが適用されるリソースを選択した場合、必要に応じて利用可能な 

SQL フィルタを編集します。詳細については、208 ページの「ノード フィルタの使用」

を参照してください。 

c. AutoHide （自動的に隠す）オプションを使用してリソースを選択した場合、Yes 

（はい）または No （いいえ）を選択し、AutoHide （自動的に隠す）機能を有効また

は無効にするかを選択します。有効にした場合、関連するデータが Orion データ 

ベースに表示されないときには、リソースが自動的に非表示になります。 

d. ソート可能なリスト リソースを選択した場合、Sort By （ソート別）フィールドで、ソー

トしたいリストのプロパティを選択します。 

e. ゲージスタイルのリソースを選択した場合、ゲージの Style （スタイル）を選択し、

Gauge Size （ゲージのサイズ）を入力します。 
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f. チャート スタイルのリソースを選択した場合、適切な Time Period （期間）と 

Sample Interval （サンプル間隔）を選択して、Trend Line （トレンド ライン）を表

示するかを指定します。 

g. ユニバーサルデバイスポーラー  リソースを選択した場合、Universal Device 

Poller （ユニバーサルデバイスポーラー）と Chart Format （チャート形式）を選択し

て、同様のリソース タイプで要求されるのと同じように、その他すべてのオプションを設

定します。 

8. Submit （送信）をクリックします。 

注記： 利用可能なリソース タイプのカスタマイズの詳細については、カスタムサマリー画面

のいずれかのリソースのヘッダーで Help （ヘルプ）をクリックしてから、対応するリソース タイ

プをクリックします。 

外部ウェブサイト ビューの作成および編集 

外部ウェブサイト ビューの機能を使用し、Orion NPM 管理者は以下の手順に示すとおりに

外部ウェブサイトを選択し、Orion ウェブ コンソール ビューとして指定することができます。 

ウェブ コンソールの外部ウェブサイト ビューを作成・編集するには： 

1. ウェブ コンソールの右上の Settings （設定）をクリックします。 

2. Orion Website Administration （Orion ウェブサイト管理）ページの  Customize 

grouping （グループのカスタマイズ）で External Websites （外部ウェブサイト）をクリッ

クします。 

3. 既存の外部ウェブサイトを削除するには、削除したいウェブサイトの横にある Delete （削

除）をクリックしてから、OK をクリックします。 

4. 新規の外部ウェブサイトを追加する場合は、Add （追加）をクリックします。 

5. 既存の外部ウェブサイトを編集するには、編集したいウェブサイトの名前の横の Edit （編

集）をクリックします。 

6. ビュー ツールバーに外部ウェブサイトを表示するには、Menu Title （メニュー タイトル）を

入力します。 

7. ビューのヘッダーを追加する場合は、オプションの Page Title （ページ タイトル）を入力し

てビューで表示します。 

8. 外部ウェブサイトの URL を http:// domain_name の形式で入力します。 

9. 外部ウェブサイトのリンクを新規に追加する Menu Bar （メニュー バー）を選択します。 
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注記： メニューバーのカスタマイズの詳細については、201 ページの「ウェブ コンソールのメ

ニュー バーのカスタマイズ」を参照してください。 

10. OK をクリックします。 

11. Preview （プレビュー）をクリックすると、ウェブ コンソールでの表示どおりに外部ウェブサイト

が表示されます。 

Orion ウェブ コンソールのカスタマイズ 

次のセクションで、Orion ウェブ コンソールのカスタマイズについて詳細を説明します。 

 ウェブ コンソールのメニュー バーのカスタマイズ 

 ウェブ コンソールのカラー スキームの変更 

 ウェブ コンソールのサイト ロゴの変更 

ウェブ コンソールのメニュー バーのカスタマイズ 

各ページの上部に表示されるメニュー バーを設定し、各メニュー アイテムを表示することができ

ます。またメニュー アイテムを定義し、カスタム メニュー バーに追加できます。各アカウント用メ

ニューバーのカスタマイズの詳細については、250 ページの「ユーザーアカウントの編集」を参照

してください。 

次の手順で、ウェブ コンソールのメニュー バーをカスタマイズします。 

ウェブ コンソールのメニュー バーをカスタマイズするには： 

1. ウェブ コンソールの右上の Settings （設定）をクリックします。 

2. Orion Website Administration （Orion ウェブサイト管理）ページの  Customize 

grouping （グループのカスタマイズ）で Customize Menu Bars （メニュー バーのカスタ

マイズ）をクリックします。 

3. 既存のメニューを変更するには、変更したいメニュー バーにある Edit （編集）をクリックし

てから、左側の Available items （利用できるアイテム）リストと右側の Selected item 

（選択したアイテム）リストの間で、編集したメニューの追加したいアイテムが、選択したアイ

テム リストにすべて移動されるまでクリックとドラッグを行います。 

注記： 説明を読むには、ビュー タイトルにカーソルを合わせます。選択したアイテムは、リスト

で上から下に表示される順序で、編集したメニュー バーの左側から右側へ表示されます。 
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4. 新しいメニュー バーを追加する場合、次の手順を実行します。 

a. New Menu Bar （新しいメニュー バー）をクリックし、新しいメニュー バーの名前 を

入力します。 

b. 左側にある Available Items （利用できるアイテム）リストから、新しいメニュー バー

に追加したいボタンをクリックし、右側にある Selected items （選択したアイテム）の

対応する位置にドラッグします。 

注記： 説明を読むには、ビュー タイトルにカーソルを合わせます。選択したアイテムは、

リストで上から下に表示される順序で、新しいメニュー バーの左側から右側へ表示さ

れます。 

5. メニュー アイテムを追加する場合には 次の手順を実行します。 

a. メニュー バーで Edit （編集）をクリックし、追加する新しいアイテムを編集します。 

b. 左側にある Available Items （利用できるアイテム）リストから、新しいメニューに追

加したいアイテムをクリックし、右側にある Selected items （選択したアイテム）の対

応する位置へドラッグします。 

注記： 

 ビューの説明を読むには、ビュー タイトルにカーソルを合わせます。選択したアイ

テムは、リストで上から下に表示される順序で、新しいメニュー バーの左側から

右側へ表示されます。 

 Reports （レポート）を Select Menu Items （メニュー アイテムの選択）ペー

ジでチェックする場合、メニュー バーを使用するアカウントのレポートも有効にする

必要があります。詳細については、258 ページの「アカウント レポート フォルダの

設定」を参照してください。 

6. カスタム メニュー アイテムを追加する場合、次の手順を実行します。 

a. メニュー バーで Edit （編集）をクリックし、追加する新しいアイテムを編集します。 

b. Add （追加）をクリックし、カスタム メニュー アイテムの 名前 、URL 、説明 を入力し

ます。 

c. メニュー  オプションを新しいブラウザ  ウィンドウで開く場合は、Open in New 

Window （新しいウィンドウで開く）にチェックを入れます。 

d. OK をクリックします。 

7. メニュー アイテムを削除する場合は、右側の Selected item （選択したアイテム）リストで

削除するアイテムをクリックし、左側の Available items （利用できるアイテム）リストへド 

ラッグします。 
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警告： Admin Menu Bar （管理者メニュー バー）から Admin （管理者）オプションを削

除しないでください。 

8. メニュー内のアイテムの場所を変更する場合は、Selected items （選択したアイテム）リ

ストでアイテムをクリックし、ドラッグしてアイテムの位置を上下で移動させます。 

9. メニュー バーの編集を終了したら、Submit （送信）をクリックします。 

ウェブ コンソールのカラー スキームの変更 

Orion ウェブ コンソールのカラー スキームは、次の手順で示すとおり、すべてのユーザーに対し

て表示可能な複数のカラー スキームに変更される場合があります。 

ウェブ コンソールのカラー スキームを変更するには： 

1. ウェブ コンソールの右上の Settings （設定）をクリックします。 

2. カスタマイズ グループの Color Scheme （カラー スキーム）をクリックします。 

3. 希望のカラー スキームを選択して、Submit （送信）をクリックします。 

ウェブ コンソールのサイト ロゴの変更 

Orion ウェブ コンソールは、各ウェブ コンソール ページの上部にあるデフォルトの SolarWinds 

のバナーの代わりに、ユーザー自身のロゴを表示するために設定することができます。次の手順

でデフォルトの SolarWinds ウェブ コンソール バナーを変更します。 

ウェブ コンソールのバナーを変更するには： 

1. SolarWinds のロゴを、サイズ設定を行った画像と適切に入れ替えます。 

注記： 

 SolarWinds バナーのファイルは 200 ピクセル / インチで 271x48 ピクセルです。 

 The SolarWinds.com の End User License Agreement （エンドユーザー ラ

イセンス契約）では、SolarWinds.com のロゴおよびメニュー バーのリンク、または 

ページの下部に記されている SolarWinds の著作権表記の修正、削除、差し替え

を禁じています。 

2. ユーザーの画像を images （イメージ）ディレクトリに置きます。 

注記： デフォルトでは、同ディレクトリは C:\Inetpub\SolarWinds \NetPerfMon\ に

なります。 

3. 管理者としてウェブ コンソールにログインします。 

4. ウェブ コンソールの右上の Settings （設定）をクリックします。 
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5. Orion Website Administration page （Orion ウェブサイト管理）ページの Settings （

設定）グループで Web Console Settings （ウェブ コンソール設定）をクリックします。 

6. Site Logo URL （サイト ロゴ URL）フィールドにある SolarWinds.Logo.jpg の代わ

りとして、新しいロゴ画像の名前を入力します。 

利用可能な製品アップデート ビューの設定 

Orion ウェブ コンソールは、最近インストールした Orion 製品のアップデートを自動的にチェック

します。デフォルトでは、ウェブ コンソールは製品アップデートを定期的に自動でチェックします。

このチェックは、Last Check （前回のチェック）および Next Check （次回のチェック）でレポー

トされている日時と回数に基づいて実行されますが、Check Now （今すぐチェック）をクリック

すると、最新のアップデートをいつでも確認することができます。アップデートを利用できる場合、

ウェブ コンソールの通知バーに通知が表示され、このビューにアップデートが一覧表示されます。

必要に応じて、このビューでアップデートを選択およびダウンロードすることができます。 

注記： 一覧表示された製品アップデートのダウンロードの詳細については、205 ページの

「Orion インストールのアップグレード」を参照してください。 

 製品アップデートを設定するには： 

1. 管理者としてウェブ コンソールにログインし、ウェブ コンソールの右上にある Settings （設

定）をクリックします。 

2. Product Updates （製品アップデート）のグループで Available Product Updates 

（利用可能な製品アップデート）をクリックします。 

3. 製品アップデートの自動チェックを無効にするには、製品アップデートのチェック をクリアし、

Save Settings （設定の保存）をクリックします。 

4. Orion NPM 、Orion APM 、すべての Orion モジュールを含むインストールされた 

Orion 製品用のアップデートが一覧表示されることを確認する場合は、Show all 

updates （すべてのアップデートを表示）にチェックを入れます。 

5. Save Settings （設定を保存）をクリックします。 
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Orion インストールのアップグレード 

Product Updates （製品アップデート）ビューを設定して Orion アップデートを一覧表示する

と、Product Updates （製品アップデート）ビューからアップデートを直接ダウンロードできます。 

Orion インストールをアップグレードするには： 

1. 管理者としてウェブ コンソールにログインし、ウェブ コンソールの右上にある Settings （設

定）をクリックします。 

2. Product Updates （製品アップデート）のグループで Available Product Updates 

（利用可能な製品アップデート）をクリックします。 

3. Check Now （今すぐチェック）をクリックしてアップデート リストを更新します。 

4. 無視したいアップデートがある場合は、無視するアップデートにチェックを入れて、Ignore 

Selected （選択したアップデートを無視）をクリックします。 

5. 適用したいアップデートにチェックを入れて、Download Selected （選択したいアップ 

デートをダウンロード）をクリックします。 

6. 保存したあと、ダウンロードしたインストーラを実行します。詳細については、ダウンロードさ

れたア ッ プ デー トのパ ッ ケージに入っている  readme.txt フ ァ イ ル 、 ま たは 

www.solarwinds.com で関連する文書を確認します。 

Orion ウェブ コンソールとチャート設定 

Orion Website Settings （ Orion オリオン設定）ページで、Orion ウェブ コンソール管理者

はウェブ コンソール ユーザーの環境に適用する多数のオプションを設定できます。以下の設定

はこのページで設定されます。 

 ウェブ コンソール設定チャート設定 

 チャート設定 

 ディスカバリ設定 

次の手順でウェブ コンソール設定を設定します。 

Orion ウェブサイトとチャート設定を設定するには： 

1. ウェブ コンソールの右上の Settings （設定）をクリックし、Settings （設定）グループ内の 

Web Console Settings （ウェブ コンソール設定）をクリックします。 

2. ウェブ コンソールとチャート設定の設定が完了したら、Submit （送信）をクリックします。 

http://www.solarwinds.com/support/documentation.aspx
http://www.solarwinds.com/support/documentation.aspx
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ウェブ コンソール設定 

次のオプションは、Orion Web Console Settings （Orion ウェブ コンソール設定）ページで

設定されます。 

 Session Timeout （セッション タイムアウト）は、ユーザーが操作を行わない場合に、 

ユーザーをログアウトさせるまで Orion ウェブ コンソールが待機する時間（分）です。 

 Windows Account Login （ Windows アカウント ログイン）でユーザーは、Windows 

アクティブ ディレクトリ資格証明で自動ログインを有効にするかどうかを選択できます。この
機能を有効にしたあと、現在のユーザーは自動にログインできます。 

 Page Refresh （ページを更新）では、ウェブ コンソール ページ、またはビューが自動的に
リロードされるまで待機する時間を指定します。 

 Site Logo URL （サイト ロゴ URL）は、各ウェブ コンソール ページの上部に表示される
バナー画像へのローカル パスです。バナーを変更してユーザーのロゴを表示する詳細につ
いては、203 ページの「ウェブ コンソールのサイト ロゴの変更」を参照してください。 

 Site Login Text （サイト ログイン テキスト）は、Orion ウェブ コンソール ログイン ページ
に表示されるオプションのテキストです。ここで入力したテキストは、すべてのウェブ コンソー
ルのユーザーに対して、ログイン時に表示されます。HTML タグを使用できます。 

 Help Server （ヘルプ サーバー）は Orion 製品のオンライン ヘルプが保存されている 

サーバーの URL です。デフォルトの場所は http://www.solarwinds.com になります。イ
ンターネットを制限したネットワーク環境にいるユーザーがオンライン ヘルプへのアクセスを
必要とする場合に、オンライン ヘルプ全体をダウンロードし、ウェブ サーバーにコピーしてか
らヘルプ サーバーの URL をウェブ サーバーの URL に変更します。 

http://www.solarwinds.com/support/Orion/docs/OrionLocalHelp.zip からオンライ
ン ヘルプをダウンロードできます。 

 Status Rollup Mode （ステータス ロールアップ モード）で、ウェブ コンソールのノード ツ 

リーまたはマップ上のノードに対する利用可能ステータスの表示方法を設定します。ステー
タス アイコンを使用した通知情報のタイプの詳細については、427ページの「ステータス ア
イコンと識別子」を参照してください。詳細については、429ページの「ステータス ロールアッ
プ モード」を参照してください。 

選択したグループに異なるステータスのノードがある場合、オプションは 2 つあります。 

 Mixed Status shows Warning （混在状態の警告を表示）はデフォルトのステー
タスで、ノード グループのステータスがグループ内で最悪の警告タイプ ステートを必ず
表示します。どのグループ メンバーにも警告タイプ ステータスがないが、グループには
アップとダウンのノードが双方含まれている場合、グループ全体に Mixed Availability 

warning （混在状態の警告）ステータスが表示されます。たとえば、Critical （重
大） + Down （ダウン） = Critical （重大）、Critical （重大） + Warning （警

告） = Critical （重大） 、および Up （アップ） + Down （ダウン） = Mixed 

Availability （混在状態） となります。 

http://www.solarwinds.com/
http://www.solarwinds.com/support/Orion/docs/OrionLocalHelp.zip
http://www.solarwinds.com/support/Orion/docs/OrionLocalHelp.zip
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 Show Worst Status （最悪ステータスを表示）では、ノード グループ内でグループ

全体に対する最悪のステータスを必ず表示します。たとえば、Up （アップ） + Down 

（ダウン） = Down （ダウン） および Unreachable （到達不能） + Shutdown （シャッ

トダウン） = Shutdown （シャットダウン） となります。 

 Child Status Rollup Mode （子ステータス ロールアップ モード）では、ノード ツリーまた

はマップ上にある単一ノードのステータスの表示方法を指定します。Orion NPM がインス

トールされているか、ノード ICMP ステータスがあれば、ノードとその子のステータス、ノード 

ステータス、および識別子を表示できます。 

Show Worst Status （最悪ステータスを表示）を選択すると、最悪ステータスのノード 

グループが表示されます（ダウンしているノードは赤色で表示されます）。Show Worst 

Status (Interfaces only) （最悪ステータスの表示（インターフェースのみ））を選択すると、

選択されたノード上の最悪ステータスのインターフェースが表示されます。Show only 

ICMP Status （ICMP ステータスのみ表示）を選択すると、監視されているインターフェー

スでアップ / ダウン ステータスのみが表示されます。 

 Child Status Display Mode （子ステータス表示モード）では、ノード ツリーまたはマッ

プ上にある単一ノードのステータスの表示方法を設定します。ノードのステータスとその子

ステータスは、点滅するアイコンで表示されます。デフォルトでは、Orion は静的アイコンを

使用して子オブジェクトのステータスを表示します。 

チャート設定 

以下のチャート設定は、Web Console Settings （ウェブ コンソール設定）ページの Chart 

Settings （チャート設定）で設定します。 

 Chart Aspect Ratio （チャート アスペクト率）はウェブ コンソール チャートの高さ / 幅の

比率です。この比率は 0.25 ～ 3.0 で設定し、表示に関連する問題を防ぐ必要があ

ります。ただし、個々のシステムのパフォーマンスは異なる場合があります。 

 Thumbnail Aspect Ratio （縮小表示アスペクト比）はチャートの縮小表示の高さ / 

幅の比率です。 

 95th Percentile Calculations （95 パーセンタイルの計算）は、入力した百分位で、

チャートに注釈の線を追加するための設定を行います。この数値は通常 95 に設定され

ています。詳細については、461ページの「95 パーセンタイル計算」を参照してください。 

 Font Size （フォント サイズ）では、Oricon ウェブ コンソールのチャートで表示されるテキス

トに対するデフォルトの相対サイズとして Small （小）、Medium （中）または Large 

（大）を設定します。この設定はユーザーのブラウザ設定に依存していません。ユーザーの

ブラウザのフォント設定は、リソース ヘッダーといくつかのリソース コンテンツに影響します。 
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ディスカバリ設定 

Discovery Settings （ディスカバリ設定）セクションで、Notify about new removable 

volumes （新しいリムーバブル ボリュームを通知する）オプションを入力します。ユーザーはこの

オプションを利用し、リムーバブル ボリュームがネットワークに追加されて、ネットワーク ディスカバ

リ中に発見された時に、通知を受けるかどうかを指定します。Orion NPM のネットワーク ディ

スカバリの詳細については、35ページの「ネットワーク デバイスのディスカバリと追加」を参照して

ください。 

ノード フィルタの使用 

多数のネットワーク デバイスを管理または監視している場合、ノードリスト リソースはすぐに規

模が大きくなり、リソースのナビゲーションが困難になります。フィルタは、ノードリストの表示を制

限してリソースのナビゲーションを容易にするために使用するオプションの SQL クエリーです。

SQL クエリーは定義済みプロパティまたはカスタムプロパティで作成できます。カスタムプロパティ

の定義の詳細については、375 ページの「カスタム プロパティの作成  –  コア」を参照してくだ 

さい。 

ノード フィルタを適用するには： 

1. ノードリスト リソースで Edit （編集）をクリックします。 

2. Filter Nodes （SQL） （フィルタ ノード（SQL））フィールドで適切な SQL クエリーを入力

して、Submit （送信）をクリックします。 

以下は関連する SQL クエリーを用いたフィルタのサンプルです。 

注記： デフォルトでは、ノードリスト リソースはノードのキャプション別にアルファベット順でノードが

並ぶように設定されています。この設定は、SQL フィルタを用いて上書きすることはできません。

このため、SQL フィルタに含まれる order by 句が重複し、カスタム SQL フィルタでフォーマッ

ト エラーが起こる場合があります。 

 結果をフィルタリングして、Up （アップ）でないノードのみを表示するには： 

Status<>1 

以下は有効なステータス レベルです。 

o 0 = Unknown （不明） （ノードの現在のアップ / ダウン ステータスは不明です）  

o 1 = Up （アップ） （ノードは PING に応答しています）  

o 2 = Down （ダウン） （ノードは応答していません）  

o 3 = Warning （警告） （ノードは応答しているかもしれませんが、サーバーから 

ノードへの接続は、パケットを破棄しています）  
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 Cisco デバイスのみを表示： Vendor = 'Cisco'  

 Atlanta のデバイスのみを表示します。（City という名前のカスタムプロパティを使用し 

ます） 

City = ' Atlanta '  

 「AX3-」で始まるデバイスのみを表示： Caption Like 'AX3-*'  

 ダウンしている Nortel デバイスのみを表示： 

Vendor Like 'Nortel*' AND Status=2 

 「-TX」で終わるデバイスのみを表示： Vendor Like '*-TX'  

Orion ウェブ コンソールのカスタム チャート 

Orion ウェブ コンソールでは、ユーザーの使用を目的としてカスタマイズ可能な、監視されたす

べてのオブジェクトにチャートを示します。これについては、次のセクションで詳細に説明します。 

Orion ウェブ コンソールのチャートのカスタマイズ 

チャートをクリックすると、Custom Chart （カスタム チャート）ビューが新しいウィンドウで開き、

追加のチャート カスタマイズ オプションで選択されたチャートが表示されます。カスタム チャート 

ビューの詳細については、213ページの「カスタム チャート ビュー」を参照してください。 

リソース タイトル バーから直接 Orion ウェブ コンソールのカスタム チャート リソースを設定でき

ます。設定するには、下記のセクションで説明するように、オプションのドロップダウン メニューから

選択するか、Edit （編集）をクリックして、編集する Chart Title （チャート タイトル）ビューを

表示させます。 

カスタム チャートのリソース タイトル バー オプション 

カスタム チャート リソースのタイトル バー メニューには、チャート データを表示するために次のオ

プションを使用することができます。 

 Last 7 Days （直近 7 日）または Last 30 Days （直近 30 日）上でチャート データを

表示します。 

 Edit Chart （チャートを編集）を選択して、チャート設定を表示、修正します。 

注記： これは、タイトル バーの Edit （編集）をクリックするのと同じです。 

 View Chart Data （チャート データを表示）で HTML 形式のドキュメントとして表示し 

ます 

 View Chart Data in Excel （Excel のチャート データを表示）で Excel™ と互換性の

ある形式でチャート データを表示します 
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Chart Title （チャート タイトル）ビューを編集します 

カスタムチャート リソースのタイトル バーの Edit （編集）をクリックして、Chart Title ビューの編

集を表示します。このビューでは以下のオプションを提供し、チャート リソースを設定します。 

 Select a Chart （チャートを選択）で、ユーザーは、現在のリソースに表示されるチャート 

タイプを変更できます。チャート オプションは、現在編集しているリソースを表示するビュー

のタイプに従って設定されます。利用可能なノード チャートのカスタマイズの詳細について

は、211ページの「ノードチャートのカスタム」を参照してください。利用可能なボリューム チ

ャートのカスタマイズの詳細については、213ページの「カスタム ボリューム チャート」を参照

してください。 

 選択したチャートの Time Period （期間）は以下のいずれかになります。 

Last Hour  

（最近の 1 時間） 
Last 2 Hours  

（最近の 2 時間） 
Last 24 Hours  

（最近の 24 時間） 
Today （今日） 

Yesterday  

（昨日） 
Last 7 Days  

（直近 7 日） 
This Month （今月） Last Month （先月） 

Last 30 Days  

（直近 30 日） 
Last 3 Months  

（直近 3 ヶ月） 
This Year （今年） 

Last 12 Months  

（直近 12 ヶ月） 

 

 選択したチャートの Sample Interval （サンプル間隔）は、以下のいずれかになります。 

Every Minute  

（毎分） 
 Every 5 Minutes 

（ 5 分毎） 
 Every 10 Minutes 

（ 10 分毎） 
 Every 15 Minutes 

（ 15 分毎） 

Every 30 Minutes 

（ 30 分毎） 
 Every Hour  

（ 1 時間毎） 
 Every 2 Hours 

 （ 2 時間毎） 
 Every 6 Hours  

（ 6 時間毎） 

Every 12 Hours 

 （ 12 時間毎） 
 One a Day  

（ 1 日 1 回） 
 Every 7 Days  

（ 7 日間毎） 
 

 

注記： 

 各サンプル間隔は単一の点または棒によって、チャート上に表示されます。選択した

サンプル間隔内のデータは、自動的に要約されます。 

 メモリ割り当ての制限により、期間とサンプル間隔の組み合わせによっては、ポーリン

グされた多数のデータ ポイントを表示するために、かなりのシステム リソースが必要に

なる場合もあります。このため、期間が長すぎる、またはサンプル間隔が短すぎる場

合、チャートが表示されないこともあります。 
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 Trend Line （トレンド ライン）オプションで、ユーザーは Orion NPM チャートのトレンド ラ

イン機能を有効にすることができます。Orion NPM チャートのトレンド ラインを有効にする

ことで、収集した履歴データから推定される可能な今後の結果を見ることができます。 

注記： ネットワーク上のデバイスのパフォーマンスに影響する多数の要因から、Orion 

NPM チャートで提供されたトレンド ラインは、今後のデータのおおよその予測としてのみ

使用されます。 

ウェブ コンソール ビューのカスタマイズの詳細については、182ページの「ビューのカスタマイズ」を

参照してください。いくつかのチャートでは 95 パーセンタイルマーカーを参考用に提供します。

詳細については、461 ページの「95 パーセンタイル計算」を参照してください。 

ノードチャートのカスタム 

以下の（タイプごとにグループ化された）ノード関連のチャートは、Orion ウェブ コンソール内のリ

ソースとして利用できます。これらのチャートを、監視されたノードに対応するウェブ コンソール ビ

ューにチャートを追加するには、Custom Node Chart （カスタム ノード チャート）リソースを 

Node Details （ノードの詳細）ビューに追加します。Orion ウェブ コンソール ビューへのリソース

追加の詳細については、182 ページの「ビューのカスタマイズ」を参照してください。詳細につい

ては、205ページで「Orion ウェブ コンソールとチャート設定」を参照してください。 

Availability （可用性） 

以下のチャートは、カスタム期間中に、Orion で監視されたノードに対する可用性情報を表示

するために利用できます。 

  Availability （可用性） 

  Availability – Autoscale （可用性 - 自動サイズ設定） 

  Availability and Response Time （可用性と応答時間） 
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CPU Load （ CPU 負荷） 

以下のチャートは、Orion で監視されたノードの特定期間中の CPU 負荷に関する情報を表

示します。 

 Average CPU Load （平均 CPU 負荷） 

 Min/Max/Average CPU Load （最低 / 最高 / 平均 CPU 負荷） 

メモリ使用量 

以下のチャートは、Orion で監視されたノードのカスタム期間中のメモリ使用量に関する情報

を表示します。 

 Average Memory Usage （平均メモリ使用量） 

 Memory/Buffer Failures （メモリ / バッファのエラー） 

 Min/Max/Average Memory Usage （最低 / 最高 / 平均メモリ使用量） 

 Percent Memory Used （使用されたメモリの割合） 

パケット損失と応答時間 

以下のチャートは、Orion で監視されたノードのパケット損失および応答時間に関する統計情

報の履歴を表示します。 

 Availability and Response Time （可用性と応答時間） 

 Average Response Time （平均応答時間） 

 Average Response Time and Packet Loss （平均応答時間とパケット損失） 

 Min/Max/Average Response Time （最低 / 最高 / 平均応答時間） 

 Min/Max/Average Response Time and Packet Loss （最低 / 最高 / 平均応答時

間とパケット損失） 

 Percent Loss – Bar Chart （損失の割合 - 棒グラフ） 

 Percent Loss – Line Chart （損失の割合 - 折れ線グラフ） 
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カスタム ボリューム チャート 

以下の（タイプごとにグループ化された）ボリューム関連のチャートは、Orion ウェブ コンソール内

のリソースとして利用できます。これらのチャートを、監視された値に対応するウェブ コンソール 

ビューにチャートを追加するには、Custom Volume Chart （カスタム ボリューム チャート）を 

Volume Details （ボリュームの詳細）ビューに追加します。Orion ウェブ コンソール ビューへの

リソース追加の詳細については、182 ページの「ビューのカスタマイズ」を参照してください。以下

のチャートをカスタマイズする詳細については、205 ページで「Orion ウェブ コンソールとチャート

設定」を参照してください。 

割り当てのエラー 

選択されたボリュームで起こったディスク割り当てのエラー数を表示します。 

Min/Max/Average Disk Usage （最低 / 最高 / 平均ディスク使用量） 

選択したボリュームで利用可能なディスク スペースの合計値と、使用しているディスク ス 

ペースの平均値の双方を表示します。また、バーによってもディスク使用量の最高、最低

値が表示されます。 

ディスク使用量の割合 

選択したボリュームのディスク スペースの合計値と、使用しているディスク スペースの平均

値が、全体で利用できる割合として表示されます。 

ボリューム サイズ 

選択したボリュームで利用可能なディスク スペースの合計を表示します。 

カスタム チャート ビュー 

Orion ウェブ コンソールのチャートは簡単にカスタマイズできます。チャートをクリックすると、新し

いウィンドウでカスタム チャートが開きます。下記のセクションでは、Custom Chart （カスタム チ

ャート）ページで選択したチャートの表示方法を変更するためのオプションについて説明してい 

ます。 

注記： Refresh （更新）をクリックすると、いつでも行った変更を確認できます。 

オプションの印刷 

カスタマイズしたチャートを印刷するには、Printable Version （印刷バージョン）をクリックする

と、カスタマイズしたチャートの印刷バージョンがブラウザに表示されます。 
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チャートのタイトル 

Chart Titles （チャートのタイトル）は、生成されたチャートの中央上部に表示されます。Chart 

Titles （チャートのタイトル）エリアでは、生成したチャートの Title （タイトル）と Subtitles （サ

ブタイトル）を変更できます。 

注記： Orion は、デフォルトのチャートのタイトルとサブタイトルを提供する場合もあります。

Customize Chart （チャートのカスタマイズ）ページの Chart Titles （チャートのタイトル） 

フィールドを編集した場合、該当するフィールドをクリアして Submit （送信）をクリックすると、デ

フォルトのタイトルとサブタイトルを復元できます。 

期間 

生成されたチャートで定義済みまたはカスタムの期間を設定できます。次のいずれかの方法で、

チャートの期間を指定できます。 

 定義済みの期間を Select a Time Period: （期間を選択 : ）メニューから選択します。 

 Time Period （期間）エリアの該当するフィールドに、カスタムの 開始日 / 開始時刻 およ

び 終了日 / 終了時刻 を入力します。 

サンプル間隔 

サンプル間隔は、提供されたチャートの精度で決まります。サンプル間隔ごとに、1 つの点また

は棒が描かれます。サンプル間隔が複数のポーリングをまたがる場合、ポーリングされたデータは

自動的に集約され、チャート上に 1 つの点または棒として描かれます。 

注記： メモリ割り当ての制限により、期間とサンプル間隔の組み合わせによっては、ポーリングさ

れた多数のデータ点を表示するために、かなりのシステム リソースが必要になる場合もあります。

このため、期間が長すぎる、またはサンプル間隔が短すぎる場合、チャートが表示されないこと

もあります。 

チャート サイズ 

Chart Size （チャート サイズ）オプションでは、チャートの幅と高さをピクセル単位で設定します。

幅 / 高さの縦横比を維持するか、Width （幅）フィールドに幅を、Height （高さ）フィールドに 

0 をそれぞれ入力すると、チャートのサイズを拡大・縮小できます。 

フォント サイズ 

生成したチャートのフォント サイズは変更可能です。Font Size （フォント サイズ）オプションで

は、チャート ラベルとテキストのフォント サイズを Small （小）、Medium （中）または Large 

（大）に設定できます。 

注記： フォント サイズ の選択は、ユーザーのチャートの印刷バージョンにも反映されます。 
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データ エクスポートのオプション 

Display Data from Chart （チャートのデータを表示）エリア では、チャート データを Excel と

互換性のある Raw Data （生データ）、または HTML 形式の Chart Data （チャート デー

タ）としてチャート データをエクスポートすることができます。 

 Excel と互換性のある形式でチャート データを表示するには、Raw Data （生データ）を

クリックしてから確認を行い、それらの生データ ファイルを開くか保存します。 

 HTML 形式のチャート データを新しいブラウザで表示するには、Chart Data （チャート 

データ）をクリックします。 

Orion ウェブ コンソールのカスタム オブジェクト リソース 

Orion ウェブ コンソールは、ユーザーが幅広くリソースを設定できるカスタム オブジェクト リソース

を提供し、監視される特定のオブジェクトのパフォーマンス データを表示します。次のセクション

ではカスタム オブジェクト リソースの編集、監視されたオブジェクトの選択、カスタム オブジェクト 

リソースに表示されるデータの設定に関する詳細を説明します。 

 カスタム オブジェクト リソースの編集 

 カスタム オブジェクトとリソースの選択 

 利用可能なカスタム リソース 

カスタム オブジェクト リソースの編集 

次の手順でカスタム オブジェクト リソースを編集します。 

カスタム オブジェクト リソースを編集するには： 

1. カスタム オブジェクト リソースのヘッダーで Edit （編集）をクリックします。 

2. リソースの Title （タイトル）と Subtitle （サブタイトル）を必要に応じて編集します。 

3. Select Orion Object （Orion オブジェクトの選択）をクリックし、適切な監視されたオブ

ジェクトを選択します。詳細については、「カスタム オブジェクトとリソースの選択」を参照し

てください。 

4. 編集が完了したら、Submit （送信）をクリックします。 



 管理者ガイド  SolarWinds Orion Network Performance Monitor 

 

 

216  ウェブ コンソール  –  コアの管理 

カスタム オブジェクトとリソースの選択 

次の手順により、選択したカスタム オブジェクト リソースのネットワーク オブジェクトを選択します。 

カスタム オブジェクト リソースで監視されたカスタム オブジェクトを選択するには： 

1. カスタム オブジェクト リソースのヘッダーで Edit （編集）をクリックします。 

2. Select Orion Object （Orion オブジェクトの選択）をクリックします。 

3. Show only: （表示のみ : ）フィールドで、カスタム オブジェクト リソースで監視するオブ 

ジェクトのタイプを選択します。 

4. Group by: （グループ別 : ）フィールドで、条件をグループ化する適切なオブジェクトを選
択します。 

注記： 定義済みのカスタムプロパティは、すべてのグループ タイプに対して一覧表示されます。 

5. 左側のリストから監視するオブジェクトをクリックし、main pane. グループ条件で選択します。 

6. Select Orion Object（Orion オブジェクトの選択）をクリックします。 

7. Select object resource （オブジェクト リソースの選択）フィールドからオブジェクト リ 

ソースを選択し、必要に応じてオプションを設定します。利用可能なリソースの詳細につい
ては、「利用可能なカスタム リソース」を参照してください。 

利用可能なカスタム リソース 

カスタム オブジェクト リソースは、選択したネットワーク オブジェクトの Orion ウェブ コンソール リ
ソースの数と同じだけのデータを提供するように設定することができます。 

注記： 

 リソースの可用性は、インストールされている Orion 製品により異なります。 

 利用可能なカスタム リソースの詳細については、リソース タイトルの Help （ヘルプ）をク 

リックして、関連するヘルプ トピックを表示します。 

SolarWinds エンジニア ツールセットの統合 

SolarWinds ツールセットを既にインストール済みのコンピュータから Orion ウェブ コンソールを

ブラウズしている場合、Orion NPM により、ツールセットをウェブ ブラウザから直接起動すること

ができます。ツールセットの統合を実行している Orion ウェブ コンソールに一覧表示された、監

視されているオブジェクトをどれか右クリックすると、利用可能なツールセットとその機能がメ 

ニューに表示されます。次のセクションでは、利用可能なツールセットの統合に関する設定につ

いて詳細に説明します。 

注記： SolarWinds エンジニア ツールセットの詳細については、www.solarwinds.com を参

照してください。 
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ツールセットの統合の設定 

以下の手順により、SolarWinds ツールセットを Orion ウェブ コンソール内で統合するための

設定を実行します。 

注記： ツールセットに初回アクセスするときに、セキュリティ警告が表示される場合があります。

Yes （はい）をクリックし、ツールセットの統合を許可します。 

SolarWinds ツールセットの統合設定を設定するには： 

1. Orion ウェブ コンソール内で表示される監視されたオブジェクトをどれか右クリックします。 

2. Settings （設定）をクリックします。 

3. SNMP Community String （SNMP コミュニティ ストリング）をクリックします。 

注記： SNMP コミュニティ ストリングを要求するツールを、右クリック メニューから初めて起

動すると、SNMP コミュニティ ストリング ウィンドウが表示されます。 

4. 保存されたコミュニティ ストリングのいずれかまたはすべてを削除するには、削除するストリ
ングを選択してから、Remove （削除）または Remove All （すべて削除）をクリックし 

ます。 

5. Menu Options （メニュー オプション）をクリックし、右クリック メニューを以下のとおりに設

定します。 

a. メニュー アイテムを右クリック メニューに追加する、または右クリック メニューから削除
する場合、左側の Available Menu Options （利用できるメニュー オプション）と、

右側の Selected Menu Options （選択されたメニュー オプション）のリストの間で

メニュー アイテムを移動させます。移動させるには、列からアイテムを選択するか、左

右の矢印をクリックしてください。 

b. メニュー アイテムの順番を変更する場合は、アイテムを選択して Selected Menu 

Options （選択したメニュー オプション）リストの横にある上下の矢印をクリックします。 

c. アイテム間に区切り線を追加する場合は、 -------------- メニュー  オプションを 

Available （利用できる）リストから Selected （選択された）リストに移動して、

Selected Menu Options （選択されたメニュー オプション）内で希望する場所へ

移します。 

6. Automatic Menu Items （自動メニュー アイテム）をクリックします。 
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7. 以下のオプションのうち、どちらかあるいは双方にチェックを入れます。 

 MIB ブラウザのブックマークの「 MIB Browser （Query MIB）」（MIB ブラウザ（クエ

リー MIB ））メニュー オプションにサブメニュー アイテムを自動的に追加します。 

 Real-Time Interface Monitor （リアルタイム インターフェース モニター）の保存し

たレポート タイプから、「 Real Time Interface Monitor 」（リアルタイム インターフ

ェース モニター）メニュー オプションにサブメニュー アイテムを自動的に追加します。 

注記 ：これらのオプションは、メニュー リンクを MIB ブラウザのブックマークと、リアルタイム イ

ンターフェース モニターの保存したレポート双方に統合することで、利用可能なメニュー ア

イテムのリストを展開します。 

ツールセット統合メニューへのプログラムの追加 

次の手順により、SolarWinds ツールセット統合に外部スクリプトまたはアプリケーションを追加

します。 

SolarWinds ツールセット統合メニューへプログラムを追加するには： 

1. 外部スクリプトをツールセット統合メニューに追加する場合、Orion サーバーのインストー

ル ボリューム上の適切な場所にスクリプトを保存します。  

(例： <InstallVolume>:\\Scripts\)  

2. 外部アプリケーションをツールセット統合メニューに追加する場合、Orion サーバーのインス

トール ボリューム上の適切な場所にアプリケーションをインストールします。  

(例： <InstallVolume>:\\Application\)  

3. テキスト エディタで、ツールセット統合メニューの設定ファイル 

SWToolset.MenuOptions を開きます。 

注記：  デフォルトでは、SWToolset.MenuOptions は以下のフォルダにあります。 
<InstallVolume>:\\Program Files\SolarWinds\Common\ 

4. SWToolset.MenuOptions のコピーを SWToolset_Old.MenuOptions として保存

します。 

5. SWToolset.MenuOptions ファイルの <MenuOptions></MenuOptions> タグの間

で次のラインを追加します。 

<MenuOption Visible="TRUE" Title="ApplicationName" 

BeginGroup="FALSE" HasSubMenu="FALSE" 

ExecString="<InstallVolume>:\\Application\ExecutableFile" 

Icon="" Extra="" Parent="" Required="4"/> 
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注記： Title （タイトル）用に与えられたストリングは、メニューに表示される追加したスク

リプトまたはアプリケーションの名前になります。ExecString 用に提供されたストリングは、

スクリプトまたはアプリケーションの実行可能ファイルのパスです。 

6. ツールセット統合メニューを自動的にアップデートするために、新しい 

SWToolset.MenuOptions を保存します。 

HTTP 、SSH 、および Telnet を使用したノードのアクセス 

Orion サーバー上の PuTTy と FiSSH のような関連付けられたアプリケーションが適切に登録

されている場合、Orion ウェブ コンソールでは、リモート デバイス アクセス用の HTTP 、SSH 、

および Telnet プロトコルの使用をサポートします。詳細については、MSDN の記事『URL プ

ロトコルへのアプリケーションの登録』を参照してください。Details （詳細）ビューからリモート アク

セス アプリケーションを次のように起動します。 

  表示されたデバイスをウェブ ブラウザで直接ブラウズするには、  をクリックします。 

  セキュア シェル（ SSH ）を監視されたデバイスに開くには、  をクリックします。 

  監視されたデバイスで Telnet セッションを開くには、  を開きます。 

統合されたリモート デスクトップの使用 

場合によっては、リモート サーバーをコンソールして、問題に対してトラブルシューティングする必

要ががあります。これは、Orion ウェブ コンソール内で次のように実行されます。 

注記： Ctrl+Alt+Break を押して全画面モードを開始 / 終了します。 

統合リモート デスクトップを起動するには： 

1. リモートで表示したいサーバーの Node Details （ノードの詳細）ビューを開きます。 

注記： Node Details （ノードの詳細）ビューを簡単に開くには、All Nodes （全ノード）リ

ソースで表示するリモート サーバーをクリックします。 

2. Node Details （ノードの詳細）ビューの場所にある  をクリックします。 

注記： ブラウザのセキュリティ設定によっては、リモート デスクトップを表示するために、

ActiveX コントロールのインストールを求められる場合があります。この要求されたコント 

ロールをインストールするには、以下のすべての手順を実行してください。 

3. サーバー の IP アドレスまたはホスト名を確認し、適切な Screen Size （画面サイズ）を

選択してから Connect （接続）をクリックします。 

http://msdn.microsoft.com/en-us/library/aa767914(VS.85).aspx
http://msdn.microsoft.com/en-us/library/aa767914(VS.85).aspx
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Orion ウェブ コンソール設定の管理 

Orion ウェブ コンソール設定では、すべてのアカウント、メニュー バーを保存し、また Orion 

Web Configuration Backup/Restore （Orion ウェブ設定バックアップ / 復元）を使用するこ

とで、以下の関連するタスクを実行できます。 

 ウェブ コンソール設定のバックアップの作成 

 ウェブ コンソール設定のバックアップの復元 

 ウェブ コンソール設定のクリア 

ウェブ コンソール設定のバックアップの作成 

以下の手順で、Orion Web Configuration Backup/Restore （Orion ウェブ設定バックアッ

プ / 復元）を使用し、Orion ウェブ コンソール設定のバックアップを作成します。 

注記： Orion Web Configuration Backup/Restore （Orion ウェブ設定バックアップ / 復

元）では、Orion データベースのバックアップを作成しません。そのため、設定のバックアップでは、

ネットワーク デバイス データまたは監視されたネットワーク オブジェクトの統計情報は保持でき

ません。Orion データベースのバックアップ作成の詳細については、388 ページの「データベース 

バックアップの作成」を参照してください。 

Orion ウェブ コンソール設定バックアップを作成するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. Start > All Programs > SolarWinds Orion > Advanced Features > Web 

Configuration Backup （スタート > すべてのプログラム > SolarWinds Orion > 拡

張機能 > ウェブ設定バックアップ）の順でクリックします。 

3. Create Backup （バックアップを作成）をクリックします。 

4. Orion フ ォ ル ダ を開 く 、 ま たは フ ォ ル ダ を参照する場所が、デ フ ォ ル トでは 

<Volume:>\Program Files\Solarwinds\ であることを確認します。 

5. 適切なファイル名と場所を入力して Save （保存）をクリックします。ウェブ コンソール設定

バックアップが完了したら、OK をクリックします。 
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ウェブ コンソール設定のバックアップの復元 

以下の手順で Orion Web Configuration Backup/Restore （Orion ウェブ設定バックアッ
プ / 復元）を使用して、保存された Orion ウェブ コンソール設定のバックアップを復元します。 

警告： 現在インストールしているバージョン以前の Orion NPM のバージョンから、ウェブ コン 

ソール設定を復元しないでください。 

Orion ウェブ コンソール設定のバックアップを作成するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. Start > All Programs > SolarWinds Orion > Advanced Features > Web 

Configuration Backup （スタート > すべてのプログラム > SolarWinds Orion > 拡
張機能 > ウェブ設定バックアップ）の順でクリックします。 

3. Restore Web Site Configuration （ウェブサイト設定の復元）エリアで、復元したい設
定バックアップ ファイルを選択します。 

4. 復元したウェブ コンソール設定を現在の設定として上書きする場合は、Overwrite （上
書き）を選択して、Restore Backup （バックアップの復元）をクリックします。 

5. 復元したウェブ コンソール設定を現在の設定とマージする場合は、select Merge （マー
ジ）を選択してから、Restore Backup （バックアップの復元）をクリックします。 

6.  選択した設定バックアップの復元を確定するには、Yes （はい）をクリックします。 

ウェブ コンソール設定のクリア 

次の手順で既存の Orion ウェブ コンソール設定をクリアします。 

警告： ウェブ コンソール設定をクリアすると、既存のすべてのユーザー アカウント、アカウント、 

ビュー設定、およびメニュー バーのカスタマイズが削除されます。SolarWinds では、ウェブ コン
ソール設定をクリアして、ウェブ コンソールのカスタマイズの削除によって問題が発生しないことを
確認する前に、現在の Orion ウェブ コンソール設定のバックアップを作成しておくことを推奨し
ています。 

Orion ウェブ コンソール設定をクリアするには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. Start > All Programs > SolarWinds Orion > Advanced Features > Web 

Configuration Backup （スタート > すべてのプログラム > SolarWinds Orion > 拡
張機能 > ウェブ設定バックアップ）の順でクリックします。 

3. File > Clear Web Configuration （ファイル > ウェブ設定のクリア）をクリックします。 

4. 現在のウェブ コンソール設定の削除を確定するには、Yes （はい）をクリックします。 

5. ウェブ コンソール設定がクリアされた後に、OK をクリックします。 
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第 16章 

ウェブ コンソールのデバイスの管理  –  コア 

ネットワーク上のすべての監視されたデバイスの管理は、Orion ウェブ コンソールのノード管理

機能で簡易化できます。このツールを使用すると、デバイスを簡単に追加と削除することができ

ます。さらに、デバイス プロパティの表示と編集も容易に実行できます。ノード管理権を持つす

べてのユーザーは、All Nodes （全ノード）リソースまたは Orion Website Administration 

（Orion ウェブサイト管理）ページ経由で、ノード管理ツールに直接アクセスできます。ノート管

理権の付与の詳細については、250ページの「ユーザーアカウントの編集」を参照してください。

次のセクションでは、Orion ウェブ コンソールからすべてのネットワーク デバイスの表示と管理を

行うための各種機能について説明しています。 

注記： ノード管理機能にアクセスするには、All Nodes （全ノード）リソースのヘッダーか Orion 

Website Administration （ Orion ウ ェ ブ サ イ ト管理 ）ページの  Node & Group 

Management （ノード & グループ管理）グループから Manage Nodes （ノード管理）をクリッ

クします。デフォルトでは、All Nodes （全ノード）リソースは Orion Summary Home （ Orion 

サマリー ホーム）ビューに含まれますが、その他のウェブ コンソール ビューにも追加することが可

能です。続行する前に、All Nodes （全ノード）リソースが適切なウェブ コンソール ビューで利

用できることを確認します。Orion ウェブ コンソール ビューへのリソース追加の詳細については、

183ページの「ビューの編集」を参照してください。 

ウェブ コンソール内の監視するデバイスを追加 

次の手順により、Orion ウェブ コンソール内の監視するデバイスを追加します。 

注記： この手順では、個々の Orion 製品でのみ特別に監視されるオブジェクトの追加に対

応しません。詳細については、各 Orion 製品の 管理者ガイド を参照してください。 

Orion ウェブ コンソール内の監視するデバイスを追加するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノード＆グループ管理）のグループ化で Manage Nodes （ノードの管

理）をクリックします。 

4. ノード管理ツールバーで Add Node （ノードを追加）をクリックします。 

5. 追加するノードのホスト名または IP アドレスを Hostname or IP Address （ホスト名

または IP アドレス）フィールドに入力します。 
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6. 追加しようとしているノードの IP アドレスを動的に割り当てる場合は、Dynamic IP 

Address （動的 IP アドレス）にチェックを入れます。 

7. ICMP のみを使用して追加したノードのノード ステータス、応答時間またはパケット損失
を監視するには、ICMP (Ping only) （ICMP （Ping のみ））にチェックを入れます。 

8. ホストしているアプリケーションを Orion アプリケーション パフォーマンス モニターで監視す
るために、外部ノードを追加する場合は、External （外部）にチェックを入れます。 

注記： External （外部）ステータスは、Orion アプリケーション パフォーマンス モニターで監

視するアプリケーションをホストするノードのために予約されます。Orion NPM は、

External （外部）としてマークされている場合は、ノード自体のデータの収集または監視を

行いません。 

9. VMware デバイスを追加する場合は、Poll for VMware （VMware のポーリング）にチ

ェックを入れ、Vmware デバイスが SNMP ポーリングにリクエストを提供するデータを 

Orion NPM が取得することを確認します。そのあと、次の手順を実行し、要求された 

vCenter または ESX サーバーの資格証明を入力します。詳細については、65ページの

「仮想化」を参照してください。 

a. 適切な vCenter または ESX の資格証明 を選択します。 

注記： 

 新規資格証明を作成する場合は、<New Credential> （<新規資格証 

明 >）を選択します。 

 既存の資格証明を編集する場合には、編集する資格証明を選択します。 

 SolarWinds は、VMware 資格証明名に英数字以外の文字を使用すること

を推奨しません。 

b. 新規資格証明を作成する場合は、資格証明名を作成します。 

c. 適切な User name （ユーザー名）と Password （パスワード）を入力してから、

Confirm password （パスワードの確認）フィールドでパスワードを再入力します。 

d. Test （テスト）をクリックし、入力した VMware 資格証明を確認します。 

10. SNMP を使用して追加したノードを監視する場合は、ICMP (Ping only) (ICMP 

（Ping のみ））がクリアされていることを確認し、次の手順を実行します： 

a. 追加したノードの SNMP バージョン を選択します。 
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注記： 

 Orion ではデフォルトでは SNMPv2c が使用されます。追加するデバイスが 

SNMPv3 の強化されたセキュリティ機能をサポートするか、それを要求する場

合は、SNMPv3 を選択します。 

 Orion NPM で監視したいデバイス上で SNMPv2c が有効になっている場合、

Orion NPM はデフォルトで SNMPv2C を使用し、パフォーマンス情報のポーリ

ングを試みます。Orion NPM に SNMPv1 のみを使用してポーリングさせる場

合、ポーリングの対象となるデバイス上で SNMPv2c を無効にしなければなりま

せん。 

b. 複数のポーリング エンジンをインストール済みの場合は、追加したノードから統計情
報を収集する Polling Engine （ポーリング エンジン）を選択します。 

注記： ユーザーが 1 つのポーリング エンジンのみを使用してネットワークから情報を収

集している場合は、このオプションを利用できない場合があります。 

c. 追加したノード上の SNMP ポートが Orion のデフォルトの 161 でない場合は、実
際のポート番号を SNMP Port （SNMP ポート）フィールドに入力します。 

d. 追加されたノードが 64 ビット カウンタをサポートしており、ユーザーがそれらを使用す
る場合、Allow 64bit counters （64 ビット カウンタを許可）にチェックを入れます。 

注記： Orion では 64 ビット カウンタの使用を完全にサポートしますが、これらの大

容量カウンタは、製造元の実装によっては動作エラーを引き起こす可能性があります。

これらのカウンタを使用中に動作不良に気が付いた際は、Node Details （ノードの

詳細）ビューを使用し、デバイスへの 64 ビット カウンタの使用を無効にするか、ハード

ウェア製造元に問い合わせてください。 

11. Orion で SNMPv2c を使用して追加したノードを監視する場合は、追加したノードに
対して有効なコミュニティ ストリングを入力します。 

注記： Read/Write Community String （読み取り / 書き込み コミュニティ ストリン

グ）はオプションですが、Orion はノードを監視するために少なくとも パブリック の コミュニテ

ィ ストリング を要求します。読み取り / 書き込み用 SNMPv3 資格証明を使用する場

合、Read / Write SNMPv3 Credentials （読み取り / 書き込み用 SNMPv3 資格証

明）エリアで次の手順を実行します。 

12. SNMPv3 を使用して追加したノードを監視する場合、次の SNMP Credentials （

SNMP 資格証明）、Authentication （認証）、Privacy/Encryption （プライバ 

シー / 暗号化）設定を入力します。 
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 SNMPv3 Username （SNMPv3 ユーザー名）、Context （コンテキスト）、

Authentication Method （認証方法）、Password （パスワード）。 

注記： このパスワードがキーの場合、Password is a key （このパスワードがキーで

す）にチェックを入れます。 

 SNMPv3 Privacy/Encryption Method （SNMPv3 プライバシー / 暗号化方

式）と Password （パスワード）。 

注記： このパスワードがキーの場合、Password is a key （このパスワードがキーで

す）にチェックを入れます。 

13. 入力した資格証明を資格証明セットとして保存する場合は、名前 を入力し、Save 

（保存）を入力します。 

14. 最近保存した資格証明セットを削除するには、削除するセットを選択し、Delete （削

除）をクリックします。 

15. SNMP を使用して追加したノードを表示するには、Validate SNMP （SNMP を検証）

を、すべての資格証明を入力してからクリックし、SNMP 設定を確認します。 

16. Next （次へ）をクリックします。 

17. Orion で監視または管理する、追加したノードのオブジェクトにチェックを入れます。以下

のオプションは、選択したツールバーから利用できます。 

 All （すべて）をクリックすると、監視を行う、一覧表示されたすべてのデバイスとチャー

トが選択されます。 

 None （なし）をクリックすると、監視対象として選択されたチェック済みのインター 

フェース、ボリューム、インターフェース チャートをクリアします。 

 All Volumes （すべてのボリューム）をクリックし、一覧表示された監視対象のボ 

リュームを選択します。 

18. 監視するオブジェクトを選択したら、Next （次へ）をクリックします。 

19. 先に入力した SNMP 設定を編集するには、Change Properties （プロパティの変更）

ページにある SNMP エリアで適切な値に変更してから、Validate SNMP （SNMP を

検証）をクリックし、新しい設定を確定します。 

20. 追加したノードに対するデフォルトのポーリング設定を編集する場合は、Node Status 

Polling （ノード ステータス ポーリング）値または Collect Statistics Every （統計情

報の収集間隔）値を、Change Properties （プロパティの変更）ページの Polling （ポー

リング）エリアで必要に応じて変更します。 
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注記： Node Status Polling （ノード ステータス ポーリング）値は、追加したノードで 

Orion が実行するノード ステータス チェックの秒数を指します。Collect Statistics 

Every （統計情報の収集間隔）値は、追加されたノードについて表示される統計情報を 

Orion が更新する間隔を指します。 

21. 監視されたノードのカスタムプロパティを定義してある場合は、Change Properties （プロ

パティの変更）ページの Custom Properties （カスタムプロパティ）エリアで、追加したノー

ドへの適正な値を入力します。 

注記： 監視されたネットワーク オブジェクトのカスタムプロパティが定義されていない場合、

Custom Properties （カスタムプロパティ）エリアは空です。 

22. プロパティの設定が完了したら、OK, Add Node （はい、ノードを追加します）をクリックし

ます。 

23. ノードの追加が完了したら、ダイアログで OK をクリックします。 

監視するデバイスの削除 

以下の手順で、ウェブ コンソールで監視されているデバイスを削除します。 

警告： ウェブ コンソールで監視するノードを削除すると、削除したノード上のすべてのアプリケー

ション、インターフェース、ボリュームの監視が自動で停止されます。 

注記： 削除するデバイスを同時に複数選択できます。さらに、ノードリスト上で検索ツールを使

用すると、異なるノード上の複数のインターフェースを選択して同時に削除できます。 

Orion ウェブ コンソール内で監視するデバイスを削除するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノード＆グループ管理）のグループ化で Manage Nodes （ノードの管

理）をクリックします。 

4. 監視対象のノード、すべてのアプリケーション、ボリュームを削除する場合は、次の手順を
実行します。 

a. 次のいずれかの方法を使用し、削除するノードを見つけます。 

 ノードリスト上にある検索ツールを使用し、削除するノードを Orion データベース

内で検索します。 

 適切な Group by （グループ化基準：）を選択し、削除するノードを含む適切

なグループをクリックします。 
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b. リストから削除するノードにチェックを入れてから、ツールバーで Delete （削除）をク 

リックします。 

5. 監視されたアプリケーション、インターフェース、またはボリュームを削除するには、次の手順
を実行します。 

a. 次のいずれかの方法を使用し、削除する要素を見つけます。 

 ノードリスト上で検索ツールを使用し、削除するオブジェクトか、削除する親オブ

ジェクトを Orion データベース内で検索します。 

 適切な Group by （グループ化基準：）を選択し、削除するオブジェクトの親 

ノードを含む適切なグループをクリックします。 

b. ノード リストの結果がある場合は、+ をクリックし、削除するオブジェクトの親ノードを

展開します。 

c. 削除 するオブジェクトにチェックを入れ、ツールバーで Delete （削除）をクリックします。 

6. OK をクリックし、削除を確認します。 

ヒントでのノード データの表示 

Orion NPM のノードのヒントは、監視されたノードのステータス概要を即座に表示します。ウェ

ブ コンソールで監視されたノードのクイック概要を表示するには、デバイス名にカーソルを合わせ

ます。以下のテーブルの情報はすぐに表示されます。 

注記： Orion NPM は、インターフェースのデータもヒントで提供します。詳細については、 

57ページの「Orion NPM Tooltips （ヒント）でのインターフェース データの表示 」を参照してく

ださい。 

Node Data （ノード データ） 

Node Status  

（ノード ステータス） 
ノードの現在のステータス。(up, down, warning, unmanaged, or 

unreachable) （アップ、ダウン、警告、管理されない、到達不可） 

IP Address （ IP アドレス） 選択されたノードに現在割り当てられている IP アドレス 

Machine Type （マシン タイプ） 選択されたノードのベンダー アイコンとベンダー説明 

Average Response Time  

（平均応答時間） 
最近のノード ポーリング以後に選択されたノードにおける測定済み平

均応答時間 

Packet Loss （パケット損失） 
最近のノード ポーリング以後に選択されたノードによって損失したすべ

ての送信済みパケットにおける割合 

CPU Load （ CPU 負荷） 
最近のノード ポーリング以後の現在使用されている選択されたノード

において利用できる処理能力の割合 

Memory Used  

（使用済みメモリ） 
最近のノード ポーリング以後の現在使用されている選択されたノード

において利用できるメモリの割合 

../../06_tech/Users/andrew.pacetti/AppData/Roaming/Documents%20and%20Settings/Andrew.Pacetti/Application%20Data/Microsoft/Word/OrionNPMAdministratorGuide.doc#ViewingInterfaceDataOrionNPMTooltips
../../06_tech/Users/andrew.pacetti/AppData/Roaming/Documents%20and%20Settings/Andrew.Pacetti/Application%20Data/Microsoft/Word/OrionNPMAdministratorGuide.doc#ViewingInterfaceDataOrionNPMTooltips
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オブジェクト プロパティの編集 

次の手順で、監視されたオブジェクトのプロパティの編集を Orion ウェブ コンソールのノード管

理機能で実行する方法を説明します。 

注記： 複数のブラウザ タブで複数のオブジェクトを同じセッション内に編集すると、データの損

失やデータベースのエラーが起こる場合があります。オブジェクト管理のアクティビティを単一のブ

ラウザ タブのみに制限することで、データベースのエラーとデータ損失を防ぎます。 

Orion ウェブ コンソールのオブジェクト プロパティを編集するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ  コンソールの右上の  Settings （設定）をクリ ックし、Node & Group 

Management （ノードおよびグループ管理）グループ内で Manage Nodes （ノード管

理）をクリックします。 

3. 次のいずれかの方法で、編集するオブジェクトを見つけます： 

 ノードリストの上にある検索ツールを使用し、編集するオブジェクトまたはボリュームの

親ノードを Orion データベース内で検索します。 

 適切な Group by （グループ化基準：）を選択し、編集するノードまたはオブジェクト

の親ノードを含む適切なグループをクリックします。 

4. 監視されたノードのプロパティを編集する場合は、編集するノードにチェックを入れ、Edit 

Properties （プロパティの編集）をクリックします。 

5. 監視されたオブジェクトのプロパティを編集する場合は、編集するオブジェクトの親ノードの
横にある  + をクリックし、編集するオブジェクトにチェックを入れます。そのあと、Edit 

Properties （プロパティの編集）をクリックします。 

6. ノードの SNMP プロパティを編集する場合は、新しい設定を入力した後に Test （テス

ト）をクリックし、編集されたノードに対して有効であることを確認します。 

7. 選択されたノードが VMware ESX サーバーであり、VMware API でポーリングを行い
たい場合は、Poll for VMware （VMware のポーリング）がチェックされていることを確認

します。 

8. 既存の ESX 資格証明を使用して ESX データをポーリングする場合は、適切な資格証
明を VMware credentials （VMware 資格証明）ドロップダウン メニューから選択し 

ます。 
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9.  新しい ESX 資格証明で ESX データをポーリングする場合は、次の手順を実行します。 

a. Choose Credential （認証の選択） ドロ ッ プダウン  メニ ューで  <New 

Credential> （ < 新規資格認証 > ）を選択し、Credential Name （資格認証

名）フィールドに新規資格認証名を入力します。 

注記： SolarWinds は、VMware 資格認証名に英数字以外の文字を使用するこ

とを推奨しません。 

b. 必要に応じて、認証の User name （ユーザー名）と Password （パスワード）を追

加します。 

c. パスワードを確認して Validate VMware （VMware の検証）をクリックし、入力し

た資格証明が編集されたノードで有効であることを確認します。 

10. 必要に応じて追加のデバイス プロパティを編集し、Submit （送信）をクリックします。 

ICMP から SNMP 監視へのノードのプロモーション 

ノードを Orion データベースに ICMP のみのノードとして追加したあとに、ノードを SNMP にレ

ベルを上げてさらに統計情報収集を開始する必要がある場合があります。Orion ウェブ コン 

ソールのノード管理機能は、ノードを、履歴データの損失なく容易にレベルを上げることができ

ます。 

ICMP のみのノードを SNMP へプロモーションするには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

 Orion Website Administration （ ウ ェ ブサイト管理 ）ページの  Node & Group 

Management （ノードおよびグループ管理）グループ内で Manage Nodes （ノード管

理）をクリックします。 

3.  次のいずれかの方法でレベルを上げるデバイスを見つけます。 

 ノードリストの上にある検索ツールを使用し、プロモーションするノードを Orion データ

ベース内で検索します。 

 適切な Group by （グループ化基準：）を選択し、プロモーションするノードを含む適

切なグループをクリックします。 

4. Edit Properties （プロパティの編集）をクリックし、ICMP (Ping only) （ICMP（Ping 

のみ））をクリアします。 

5. SNMP エリアで、レベルを上げたノードに対する SNMP Version （SNMP バージョン）を

選択します。 



SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 ウェブ コンソールのデバイスの管理  –  コア 231 

注記： Orion では、デフォルトで SNMPv2c が使用されます。プロモーションしたデバイス

が SNMPv3 の強化されたセキュリティ機能をサポートする、またはそれを要求する場合は、

SNMPv3 を選択します。 

6. 複数のポーリング エンジンをインストール済みの場合は、追加したノードから統計情報を
収集する Polling Engine （ポーリング エンジン）を選択します。 

注記： ユーザーが 1 つのポーリング エンジンのみを使用してネットワークから情報を収集し

ている場合は、このオプションを利用できない場合があります。 

7. 追加したノードでの SNMP ポートが Orion のデフォルトの 161 でない場合は、実際の
ポート番号を SNMP Port （SNMP ポート）フィールドに入力します。 

8. 追加されたノードが 64 ビット カウンタをサポートしており、ユーザーがそれを使用する場合
には、Allow 64 bit counters （64 ビット カウンタを許可）にチェックを入れます。 

注記： Orion では 64 ビット カウンタの使用を完全にサポートしていますが、これらの大容

量カウンタは、使用方法によっては動作エラーを引き起こす可能性があります。これらのカ

ウンタを使用中に動作不良に気がついた場合は、Edit Properties （プロパティの編集）

ビューを使用し、問題となっているデバイスへの 64 ビット カウンタの使用を無効にするか、

ハードウェアの製造元に問い合わせてください。 

9. SNMPv2c を使用してプロモーションされたノードを監視する場合は、追加されたノードに
対して有効なコミュニティ ストリングを提供します。 

注記： Read/Write Community String （読み取り / 書き込みコミュニティ ストリング）

はオプションですが、Orion では、ノードを監視するのに少なくとも パブリック の コミュニティ 

ストリング が必要です。 

10. SNMPv3 を使用してプロモーションしたノードを監視するには、以下の SNMPv3 資格

証明の設定を入力します。 

 SNMPv3 Username （SNMPv3 ユーザー名）と Context （コンテキスト） 

 SNMPv3 Authentication Method （SNMPv3 認証方法）と Password/Key 

（認証パスワード / キー） 

 SNMPv3 Privacy/Encryption Method （SNMPv3 プライバシー / 暗号化方

式）と Password/Key （認証パスワード / キー） 

注記： Read/Write SNMPv3 Credentials （読み取り / 書き込み SNMPv3 資格

証明）はオプションですが、ノードを監視するには、少なくとも パブリック の コミュニティ ストリ

ング が必要になります。 

11. 既存の SNMPv3 資格証明リストを編集するには、Saved Credential Sets （保存さ

れた資格証明セット）リストからセット名を選択し、保存した設定を編集します。 
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12. 入力した SNMPv3 資格証明を資格証明セットとして保存する場合は、新しい資格証
明セットの 名前 を入力し、Save （保存）をクリックします。 

13. 必要な資格証明をすべて入力したあとに、Validate SNMP （SNMP を検証）をクリック

し、SNMP 設定を確認します。 

14. プロモーションしたノードでのデフォルトのポーリング設定を編集する場合は、Node 

Status Polling （ノード ステータス ポーリング）値または Collect Statistics Every 

（統計情報の収集間隔）値を、Polling （ポーリング）エリアで必要に応じて変更します。 

注記： Node Status Polling （ノード ステータス ポーリング）値は、Orion がプロモーシ

ョンされたノード上で実行するノード  ステータス  チェックの秒数を指します。Collect 

Statistics Every （統計情報の収集間隔）値は、プロモーションされたノードについて表

示される統計情報を Orion が更新する間隔を指します。 

15. 監視されたノードのカスタムプロパティを定義済みの場合には、Custom Properties （カ

スタムプロパティ）エリアで、プロモーションしたノードでの適正な値を入力します。 

16. プロモーションしたノードのプロパティ設定が完了したら、Submit （送信）をクリックします。 

17. ノードの追加が完了したら、ダイアログで OK をクリックします。 

ノードのリソースを表示 

Orion ウェブ コンソール ノード管理ユーティリティの List Resources （リソースの一覧表示）

機能で、ユーザーは、以下の手順で示すとおりに、監視されたすべてのインターフェース、ボ 

リューム、インターフェース チャートを選択したノードで即座に表示できます。 

すべてのリソースのリストをノードで表示するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノード＆グループ管理）のグループ化で Manage Nodes （ノードの管

理）をクリックします。 

4. 次のいずれかの方法で、表示するノードを見つけます。 

 ノードリストの上にある検索ツールを使用し、表示するノードを Orion データベース内

で検索します。 

 適切な Group by （グループ化基準：）を選択し、表示するノードを含む適切なグ

ループをクリックします。 

5. 表示するノードをリストからチェックし、ノード管理ツールバーで List Resources （リソー

スのリスト）をクリックします。 
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デバイス管理状態の設定 

監視されたデバイスは操作ステータスに定期的にポーリングされます。収集された統計情報は、

Orion ウェブ コンソールに表示されます。Orion ウェブ コンソールの Node Management  

（ノード管理）機能を使用することで、監視されたノードの管理ステータスを簡単に設定または

変更することができ、必要に応じてデータ収集を一時中断したり、ポーリングや統計情報の収

集を再開することができます。次の手順は、Orion ウェブ コンソールで監視されたノードの管理

状態を設定または変更します。 

注記： ノードを管理外ステータスに設定すると、選択されたノード上のすべてのインターフェース

とボリュームが自動的に停止します。 

ノードの管理状態を設定または変更するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノード＆グループ管理）のグループ化で Manage Nodes （ノードの管

理）をクリックします。 

4. 次のいずれかの方法で、管理するノードを見つけます。 

 ノードリストの上にある検索ツールを使用し、管理するデバイスを Orion データベース

内で検索します。 

 適切な Group by （グループ化基準：）を選択し、管理するノードを含むグループを

クリックします。 

5. 変更するノードにチェックを入れ、必要に応じて、選択されたノードに対して Unmanage 

（管理外）または Remanage （管理再開）をクリックします。 

6. Unmanage （管理外） を選択した場合には、管理の中断の開始および終了日時を入

力して OK をクリックします。 
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予定外のデバイス ポーリングおよび再ディスカバリ 

Orion NPM は、Orion ウェブ コンソールにある Polling Setting （ポーリング設定）ビューでの

ポーリング設定に基づいて、定期的にデバイスから統計情報とステータスをポーリングします。詳

細については、262ページの「Orion ポーリング設定 」を参照してください。しかし時には、監視

されたデバイスに対して、予定外のポーリングまたは再ディスカバリを行う必要がある場合もあり

ます。次の手順で示すように、Node Management （ノード管理）ユーティリティはこの機能を

提供します。 

予定外のポーリングまたは再ディスカバリを実行するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノード＆グループ管理）のグループ化で Manage Nodes （ノードの管

理）をクリックします。 

4. 次のいずれかの方法を使用し、ポーリングするノードまたはインターフェースを見つけ、再 

ディスカバリするノードを選択します。 

 ノード リストに上にある検索ツールを使用して、Orion データベースを検索します。 

 適切な Group by （グループ化基準）を選択し、ポーリングするノードまたはインター

フェース、または再ディスカバリするノードのいずれかを含むグループをクリックします。 

5. 選択したノードまたはインターフェースをポーリングするには、More Actions > Poll Now 

（その他のアクション  > 今すぐポーリング）の順でクリックします。 

6. 選択したノードを再ディスカバリするには、More Actions > Rediscover （その他のア

クション  > 再ディスカバリ）の順でクリックします。 

Windows サーバー メモリ監視 

Orion NPM が Windows サーバーの CPU 負荷とメモリ利用率をポーリングする場合、物理

的メモリの総量を検討して 100% レベルを定義を行い、さらに使用している物理メモリの割合

を計算し、使用メモリの総計を行います。多くのアプリケーションは、あらかじめメモリを割り当て、

実際にメモリが必要になる前にスワップするため、100% を超えるメモリ利用率の測定値になる

ことがあります。この問題に対応するために、物理メモリを、Orion 内の該当するサーバー用の

ボリュームとして追加することもできます。ボリュームとして監視すると、測定値はより予測に沿っ

たものになります。 
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ノード保守モード期間のスケジュール 

ノードまたはそのコンポーネントに対して、ファームウェアのアップグレード、新しいソフトウェアのイ

ンストール、セキュリティの更新などの保守を実施する必要がある場合は、保守でデバイスがダ

ウンしている間に、ポーリングを中断することを検討してください。ノード保守時に、ポーリングを

無効にしたり、ノード ステータスを Unmanaged （管理外）として設定することで、データの精

度を維持し、不要なアラート メッセージを防ぎます。ノード保守実行時のノード ポーリングの無

効化については、233 ページの「デバイス管理状態の設定 」を参照してください。 
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第 17章 

グループと依存状態の管理  –  コア 

依存状態とグループで、ユーザーはより有効にネットワークを管理できます。グループにより、デ

バイス タイプや場所を問わず、監視されたオブジェクトを論理的に整理することができます。ま

た依存関係は、ネットワークの本当の状態を忠実に示すことができるため、「誤検出」のアラー

ト トリガーを排除し、ネットワークのステータスについて正確な見識を得られます。 

グループの管理 

グループには、ノードやボリューム、アプリケーション、インターフェース、その他のグループなどのス

テータスをレポートする Orion オブジェクトが含まれています。ユーザーは、Manage Groups 

（グループ管理）ページでグループの作成、削除、修正を行うことができます。 

注記： グループをもう一方のグループ内でネストしても、厳密な親 / 子の関係は作成できませ

ん。いくつでも他のグループのメンバーとして、グループを追加することができます。 

Manage Groups （グループ管理）ページにアクセスするには： 

1. Orion ウェブ コンソールにログオンします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノードおよびグループ管理）のグループ化で Manage Groups （グルー

プの管理）をクリックします。 

以下のセクションでは、Orion でのグループの作成と管理について詳細に説明します。 

 グループの作成 

 既存のグループの編集 

 グループ メンバーの管理 

 グループの削除 

 Display of Group （グループの表示）ステータスの管理 
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グループの作成 

グループの作成は簡単な手順で行えます。追加するグループの Orion オブジェクトを選択する

だけです。作成時、SolarWinds Orion でグループ メンバーのステータスをロールアップする方

法も決定できます。 

また、ダイナミック クエリーを使用して追加することで、共有するプロパティ上でグループ メンバー

を指定することも可能です。ダイナミック クエリーで追加された Orion オブジェクトは、グループ

から自動で追加または削除されます。 

新規のグループを作成するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノードおよびグループ管理）のグループ化で Manage Groups （グルー

プの管理）をクリックします。 

4. Add New Group （新しいグループの追加）をクリックします。 

5. Name （名前）フィールドで名前を入力してから、Advanced （アドバンスト）を展開し 

ます。 

6. グループで、グループ メンバーの最悪ステータスをロールアップする場合は、Show Worst 

Status （最悪ステータスを表示）を選択します。 

7. グループ メンバーのベスト ステータスをグループでロールアップする場合は、Show Best 

Status （最悪ステータスを表示）を選択します。 

8. グループ メンバーに異なるステータスが混在している場合に、グループで警告ステータスを
表示するようにするには、Mixed Status shows warning （混在ステータスが警告を

表示）を選択します。 

9. Next （次へ）をクリックします。 

10. グループ メンバーを個別に選択する場合は、次の手順を実行します。 

a. Show Only （表示のみ）リストで、グループ メンバーとして追加する Orion オブジェ

クトの種類を選択します。 

b. Orion オブジェクトのチェックボックスにチェックを入れ、Add to Group （グループに追

加）をクリックします。 
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11. 共有するプロパティに基づいてグループ メンバーを動的に選択する場合、次の手順を実
行します。 

a. Add dynamic query （ダイナミック クエリーの追加）をクリックします。 

b. Dynamic query object name （ダイナミック クエリー オブジェクト名）フィールドで

クエリーの名前を入力します。 

c. Orion Object （ Orion オブジェクト）リストで Orion オブジェクトのタイプを選択し 

ます。 

d. Add Condition （条件を追加）をクリックし、さらに選択するプロパティを指定します。 

注記： クエスチョン マーク (?) は、複数の文字を表すワイルドカード文字として使用

します。アンダースコア (_) 文字は、任意の一文字を表すワイルドカードとして使用し

ます。 

e. Preview （プレビュー）をクリックし、ダイナミック クエリーがユーザーの希望したオブジェ

クトを選択していることを確認します。 

f. Save （保存）をクリックします。 

12. 個々の Orion オブジェクトまたはダイナミック クエリーを、グループの作成が終了するまで

追加し続けます。 

13. Create Group （グループを作成）をクリックします。 

既存のグループの編集 

既存のグループのプロパティの編集、またはオブジェクトの追加または削除が可能です。これら

は別々に編集するタスクです。 

既存のグループのプロパティを編集するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノードおよびグループ管理）のグループ化で Manage Groups （グルー

プの管理）をクリックします。 

4. 編集するグループにチェックを入れ、Edit Properties （プロパティの編集）をクリックします。 

5. 選択したグループの Name （名前）と Description （説明）を必要に応じて編集します。 
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6. 選択したグループのメンバーを管理するには、Add & Remove Objects （オブジェクト

の追加と削除）をクリックします。グループ メンバーの管理の詳細については、240 ページ

の「グループ メンバーの管理」を参照してください。 

注記： 選択したグループの Contains サマリーを展開し、グループ内のすべてのメンバー 

オブジェクトを表示します。 

7. 表示されたグループ ステータスまたはグループ ステータスの更新頻度の計算を設定するに
は、Advanced （アドバンスト）を展開してから Status rollup mode （ステータス ロー

ルアップ モード）を選択し、さらに Refresh frequency （更新頻度）を入力します。 

注記： グループのステータス ロールアップの詳細については、241 ページの「Display of 

Group （グループの表示）ステータスの管理」を参照してください。 

8. Submit （送信）をクリックします。 

グループ メンバーの管理 

次の手順で、定義されたグループ内のオブジェクトを管理します。 

既存のグループのオブジェクトを追加および削除するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. ウェブ  コンソールの右上の  Settings （設定）をクリ ックし、Orion Website 

Administration （ウェブ管理）ページの Node & Group Management （ノードおよびグ

ループ管理）グループ内の Manage Groups （グループ管理）をクリックします。 

3. 編集するグループにチェックを入れ、Add & Remove Objects （オブジェクトの追加と削

除）をクリックします。 

グループの削除 

既存の依存性を削除する作業は、次の手順で示すように、非常に簡単です。 

グループを削除するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 
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2. ウェブ  コンソールの右上の  Settings （設定）をクリ ックし、Orion Website 

Administration （ウェブ管理）ページの Node & Group Management （ノードおよびグ

ループ管理）グループ内の Manage Groups （グループ管理）をクリックします。 

3. 削除するグループにチェックを入れ、Delete （削除）をクリックします。 

Display of Group （グループの表示）ステータスの管理 

特定のグループのステータスは、グループのメンバー ステータスによって判断されます。監視され

たオブジェクトのグループ用に表示されたステータスを判断するには、次の  3 つの方法があり 

ます。 

注記： Orion のオブジェクトのステータスの詳細については、427 ページの「ステータス アイコン

と識別子」を参照してください。 

 Show Best Status （最良ステータスを表示）は、代理またはバックアップ デバイスのコレ

クションとして定義されているグループを表示する際に最も有用です。下表は、Show 

Best Status （最良ステータスを表示）オプションの操作方法を示しています。 

注記： Show Best Status （最良ステータスを表示）オプションのグループ ステータス結果

と、Show Worst Status （最悪ステータスを表示）オプションと同じグループのオブジェクト

の結果を比較します。 

 オブジェクト ステータス  グループ ステータス 

 （アップ、警告、ダウン）  （アップ） 

 （警告、ダウン）  （アップ） 

 （警告、ダウン、不明）  （警告） 

 

 Show Worst Status （最悪ステータスを表示）では、オブジェクト グループの最悪なス

テータスがグループ全体に表示されます。次の表で、Show Worst Status （最悪ステー

タスを表示）オプションの機能について説明します。 

 オブジェクト ステータス  グループ ステータス 

 （アップ、警告、ダウン）  （ダウン） 

 （警告、ダウン）  （警告） 

 （警告、ダウン、不明）  （ダウン） 
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 Mixed Status shows Warning （混在ステータスが警告を表示）で、グループのス 

テータスがグループ内で最悪警告タイプ ステータスを表示することを確認します。警告タイ

プ ステートがなくても、アップとダウン双方のステータスがグループに含まれている場合、

Mixed Availability warning （  ）（混在警告）ステータスがグループ全体に表示されま

す。次の表で、Mixed Status shows Warning （混在ステータスが警告を表示）オプ

ションの機能について説明します。 

 オブジェクト ステータス  グループ ステータス 

  （危機） 

  （危機） 

  （混合可用性） 

 

次の手順で、グループ ステータスの判断に使用する方法を設定します。 

選択したグループのステータスを判断する方法を設定するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. ウェブ  コンソールの右上の  Settings （設定）をクリ ックし、Orion Website 

Administration （ウェブ管理）ページの Node & Group Management （ノードおよびグ

ループ管理）グループ内の Manage Groups （グループ管理）をクリックします。 

3. 編集するグループにチェックを入れ、Edit Properties （プロパティの編集）をクリックします。 

4. Advanced （アドバンスト）を展開し、Status rollup mode （ステータスのロールアップ 

モード）を以下のように選択します。 

a. グループで、グループ メンバーの最悪ステータスをロールアップする場合は、Show 

Worst Status （最悪ステータスを表示）を選択します。 

b. グループ メンバーのベスト ステータスをグループでロールアップする場合は、Show 

Best Status （最悪ステータスを表示）を選択します。 

c. グループ メンバーに異なるステータスが混在している場合に、グループで警告ステータ
スを表示するようにするには、Mixed Status shows warning （混在ステータスが

警告を表示）を選択します。 

5. Submit （送信）をクリックします。 
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依存状態の管理 

Orion の依存状態により、ネットワーク上のトポロジ制約の理由を明らかにすることができます。

これらの制約は、特定のデバイスの設計（スイッチまたはルータのインターフェース等）またはネッ

トワーク自体の物理的構造が理由である場合があります。Orion は、Unreachable （到達

不可）ステータスを提供します。このステータスは、デバイスが、別のデバイスがダウンまたは応答

なしであるために、実際のステータスは不確定にも関わらず（デバイスが）ダウンしているように表

示される場合に相当します。 

たとえば、Orion NPM で監視されたスイッチがダウンして応答しなくなった場合、（機能は完全

に実行されますが）スイッチ上のすべてのインターフェースも応答しなくなります。デフォルトでは、

Orion NPM でこれらの 子 インターフェースは Unreachable （到達不可）と表示されます。こ

れは、こうした 親ノード がダウンとしてリポートされることが原因です。 

同様に、Orion では各デバイス間（たとえば単一の WAN リンクに依存しているネットワーク上

のデバイスのサブネット）の依存関係を定義することも可能です。この場合、ユーザーがこの依

存状態のサブネットのデバイスで構成されたグループを持っている場合は、依存しているサブ 

ネットが、ネットワークの残余に接続する WAN リンクとして機能している親ルーターに対する子

グループとしての依存関係を定義できます。グループの詳細については、237 ページの「グルー

プの管理」を参照してください。 

依存関係の機能は、アラートを検討する際により明らかになります。監視されたオブジェクトが

ダウンしているときにトリガーするようアラートが設定されている場合、監視されたオブジェクトが

実際にダウンしている時にのみ、そのアラートが必要となります。つまり、実際にはダウンしていな

いオブジェクトについてトリガーするダウン オブジェクト アラートは必要ありません。依存関係が

ない場合、ICMP クエリに対して応答しない監視されたノード上のすべての監視されたオブジェ

クトも同様に、ダウンとしてレポートされます。使用中の依存関係がある場合、これらの子オブ

ジェクトは Unreachable （到達不可）として表示され、単一のノードがステータス クエリーに即

座に反応したために起こる、大量のフォルス アラームへの面倒な対応から解消されます。 

注記： インターフェースは親オブジェクトとして定義される場合がありますが、子オブジェクトとし

ては定義できません。Orion NPM は、親ノードをポーリングすることで直接インターフェースのス

テータスを判断します。インターフェースのあるノードがダウンした場合、Orion NPM は、その 

ノード上のどれか、またはすべてのインターフェースを到達不可としてレポートします。 
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新しい依存関係の作成 

以下の手順で示すように、新しい依存関係の作成は、親 / 子オブジェクトを選択するという簡

単なプロセスです。 

新しい依存関係を作成するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. ウェブ コンソールの右上の Settings （設定）をクリックし、Orion Website Administration 

（ウェブ管理）ページの Node & Group Management （ノードおよびグループ管理）グルー

プ内の Manage Dependencies （依存状態の管理）をクリックします。 

3. Add new dependency （新しい依存関係の追加）をクリックします。 

4. Select Parent （親を選択）ページで、次の手順を実行します。 

a. Show only: （表示のみ：）と Group by: （グループ化基準：）フィールドを使用し、

表示されたオブジェクトとグループのリストをカスタマイズします。 

注記： Group by （グループ化基準：）フィールドに一覧表示されるプロパティは動的

です。 

b. メイン ペインで親オブジェクトまたはグループを選択し、Next （次へ）をクリックします。 

注記： 依存状態を定義して、レポートされた子オブジェクトのステータスを複数の親

オブジェクトのステータスに依存させる場合は、すべての親オブジェクトが含まれるグ 

ループを作成し、このビューでそのグループを選択します。詳細については、238 ペー

ジの「グループの作成」を参照してください。 

5. Choose Child （子を選択）ページで、次の手順を実行します。 

a. 必要に応じて、Dependency name （依存状態名）を編集します。 

b. Show only: （表示のみ：）と Group by: （グループ化基準：）フィールドを使用し、

表示されたオブジェクトとグループのリストをカスタマイズします。 

注記： Group by: （グループ化基準：）フィールドに表示されたプロパティは、Show 

only: （表示のみ：）フィールドに動的に依存しています。 

c. メイン ペインで子オブジェクトまたはグループを選択し、Next （次へ）をクリックします。 

注記： 依存状態を定義して、レポートされた複数の子オブジェクトのステータスを  

1 つまたはそれ以上の親オブジェクトのステータスに依存させる場合は、すべての子オ

ブジェクトが含まれるグループを作成し、このビューでそのグループを選択します。詳細

については、238ページの「グループの作成」を参照してください。 
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6. Review Dependency （依存状態の確認）ビューで、設定された依存状態の現在の設

定を確認します。 

 注記： 

 アドバンスト アラートが親または子オブジェクトで設定されている場合は、このビューで

一覧表示されます。+ をクリックし、アラートの詳細を展開します。 

 親オブジェクトがダウンしている場合、ダウンした親オブジェクト上にある依存状態の子

オブジェクトで設定されたすべてのアラートは、自動的に抑制されます。 

7. Submit （送信）をクリックし、依存状態の定義に同意します。 

既存の依存性の編集 

既存の依存性を編集する作業は、次の手順で示すように、非常に簡単です。 

既存の依存性を編集するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. ウェブ  コンソールの右上の  Settings （設定）をクリ ックし、Orion Website 

Administration （ウェブ管理）ページの Node & Group Management （ノードおよびグ

ループ管理）グループ内の Manage Dependencies （依存状態の管理）をクリックし 

ます。 

3. 編集する依存状態にチェックを入れ、Edit （編集）をクリックします。 

4. Select Parent （親を選択）ページで、次の手順を実行します。 

a. Show only: （表示のみ：）と Group by: （グループ化基準：）フィールドを使用し、

表示されたオブジェクトとグループのリストをカスタマイズします。 

注記： Group by: （グループ化基準：）フィールドに表示されたプロパティは、Show 

only: （表示のみ：）フィールドに動的に依存しています。 

b. メイン ペインで親オブジェクトまたはグループを選択し、Next （次へ）をクリックします。 

注記： 依存状態を定義して、レポートされた子オブジェクトのステータスを複数の親

オブジェクトのステータスに依存させる場合は、すべての親オブジェクトが含まれるグ 

ループを作成し、このビューでそのグループを選択します。詳細については、238 ペー

ジの「グループの作成」を参照してください。 
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5. Choose Child （子を選択）ページで、次の手順を実行します。 

a. 必要に応じて、Dependency name （依存状態名）を編集します。 

b. Show only: （表示のみ：）と Group by: （グループ化基準：）フィールドを使用し、

表示されたオブジェクトとグループのリストをカスタマイズします。 

注記： Group by: （グループ化基準：）フィールドに表示されたプロパティは、Show 

only: （表示のみ：）フィールドに動的に依存しています。 

c. メイン ペインで子オブジェクトまたはグループを選択し、Next （次へ）をクリックします。 

注記： 依存状態を定義して、レポートされた複数の子オブジェクトのステータスを 1 

つまたはそれ以上の親オブジェクトのステータスに依存させる場合は、すべての子オブ

ジェクトが含まれるグループを作成し、このビューでそのグループを選択します。詳細に

ついては、238ページの「グループの作成」を参照してください。 

6. Review Dependency （依存状態の確認）ビューで、設定された依存状態の現在の設

定を確認します。 

注記： 

 アドバンスト アラートが親または子オブジェクトで設定されている場合は、このビューで

一覧表示されます。+ をクリックし、アラートの詳細を展開します。 

 親オブジェクトがダウンしている場合、ダウンした親オブジェクト上にある依存状態の子

オブジェクトで設定されたすべてのアラートは、自動的に抑制されます。 

7. Submit （送信）をクリックし、依存状態の定義に同意します。 

既存の依存性の削除 

既存の依存性を削除する作業は、次の手順で示すように、非常に簡単です。 

既存の依存性を削除するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. ウェブ コンソールの右上の Settings （設定）をクリックし、Orion Website Administration 

（ウェブ管理）ページの Node & Group Management （ノードおよびグループ管理）グルー

プ内の Manage Dependencies （依存状態の管理）をクリックします。 

3. 削除する依存状態にチェックを入れ、Delete （削除）をクリックします。 

4. Yes （はい）をクリックし、選択した依存状態の削除を確定します。 
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子オブジェクトのアラートの表示 

親オブジェクトがダウンしている場合、ダウンした親オブジェクト上にある依存状態の子オブジェ

クトで設定されたすべてのアドバンスト アラートは、自動的に抑制されます。次の手順で、選

択された依存状態の子オブジェクト上で現在設定されている、すべてのアドバンスト アラートを

表示します。 

選択した依存状態の子オブジェクトについてアラートを表示するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノードおよびグループ管理）グループ内の Manage Dependencies （

依存状態の管理）をクリックします。 

4. 表示するアラートが設定されている子オブジェクトを依存状態が含んでいることを確認し、

Alerts on Child （子のアラート）をクリックします。 
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第 18章 

ウェブ アカウントの管理  –  コア 

Orion ウェブ コンソールのユーザー アカウント、許可およびビューは、Orion アカウント マネー 

ジャで設定・保存されます。Advanced Customization （アドバンスト カスタマイズ）が Orion 

Website Settings （ウェブサイト設定）ページで有効になっているとき、Account Manager 

（アカウント マネージャ）を使用し、異なるユーザー用にメニュー バーとビューをカスタマイズします。

Orion ウェブ設定とアドバンスト カスタマイズの詳細情報は、205 ページの「Orion ウェブ コン

ソールとチャート設定」を参照してください。 

注記： 

 このガイドでは、Advanced Customization （高度なカスタマイズ）が有効になっているこ

とが前提となっています。もしこのカスタマイズが有効でない場合は、次のセクションで言及

されているページ上のオプションで、利用できるものが非常に少なくなります。詳細について

は、174 ページの「Orion ウェブ コンソールとチャート設定」を参照してください。 

 ウェブ コンソール アカウントの問題を防ぐには、SQL サーバーを no count （カウントしな

い）接続オプションが有効の状態で設定してはいけません。no count （カウントしない）オプ

ションは、Default connection options （デフォルト接続オプション）エリアで、SQL 

Server Management Studio （SQL サーバー管理スタジオ）の Server Properties > 

Connections （サーバー プロパティ  > 接続）から設定します。 

新規アカウントの作成 

新規の Orion ウェブ コンソール ユーザー アカウントは、すべてのウェブ コンソール管理者が作

成できます。新規のウェブ コンソール ユーザー アカウントは、次の手順で作成されます。 

新規のユーザー アカウントを作成するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （Orion ウェブサイト管理）ページの Accounts （アカウ

ント）グループで Manage Account （アカウント管理）をクリックします。 

4. Add New Account （新規のアカウントを追加）をクリックします。 

5. 追加するアカウントのタイプを選択し、Next （次へ）をクリックします。 
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6. Orion の個人アカウント を選択した場合、次の手順を実行します。 

a. Orion の個人アカウントの ユーザー名 と パスワード を入力します。 

b. パスワードを確認し、Next （次へ）をクリックします。 

c. 必要に応じて、ユーザー設定と特権を定義します。詳細については、250 ページの
「ユーザーアカウントの編集 」を参照してください。 

7.  Windows の個人アカウント を選択した場合、次の手順を実行します。 

a. アクティブ ディレクトリまたはローカル ドメインへの管理者アクセスを持つユーザーの  

ユーザー名 と パスワード を入力します。 

b. Search for Account （アカウントの検索）エリアで、新しいウェブ コンソール アカウン
トを作成するアクティブ ディレクトリまたはローカル ドメインの ユーザー名 を入力し、
Search （検索）をクリックします。 

c. Add Users （ユーザーを追加）エリアで、新規のウェブ コンソール アカウントを作成す
るユーザーを選択し、Next （次へ）をクリックします。 

8. Windows のグループ アカウント を選択した場合、次の手順を実行します。 

a. アクティブ ディレクトリまたはローカル ドメインへの管理者アクセスを持つユーザーの  

ユーザー名 と パスワード を入力します。 

b. Search for Account （アカウントの検索）エリアで、新しいウェブ コンソール アカウン
トを作成するアクティブ ディレクトリまたはローカル ドメインの グループ名 を入力し、
Search （検索）をクリックします。 

c. Add Users （ユーザーを追加）エリアで、新規のウェブ コンソール アカウントを作成す
るユーザーを選択し、Next （次へ）をクリックします。 

新規アカウントが作成されたとき、Edit User Account （ユーザーアカウントの編集）ビューが表
示され、設定可能なアカウントのオプションがすべて示されます。詳細については、250 ページ
の「ユーザーアカウントの編集」を参照してください。 

注記： Orion ウェブ コンソールでの自動ログインに Windows パススルー セキュリティ、アクティ
ブ ディレクトリ、DirectLink のアカウントを使用する詳細については、421ページの「自動ログイ
ンの設定」を参照してください。 

ユーザーアカウントの編集 

Edit User Account （ユーザーアカウントの編集）ページで、ウェブ コンソール ユーザー アカウン
トの設定オプションを利用できます。Edit User Account （ユーザー アカウントの編集）ページ
で、管理者は、アカウントの無効化、アカウントの有効期間の設定、管理者へのノード管理権
の提供、ユーザー ビューの制限、デフォルト メニュー バーの定義を行い、さらにユーザー アカウ
ントの表示方法と Orion ウェブ コンソールの使用方法を定義するその他複数のデフォルトの
設定を行うことができます。 
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次のセクションと手順で、ユーザー アカウントの設定の詳細について説明します。 

注記： パスワードのリセットには、ページ下部にある Change Password （パスワードの変

更）をクリックします。 

 ユーザー アカウントのアクセス設定 

 アカウント制限の設定 

 パターン制限の定義 

 デフォルト アカウントのメニュー バーとビューの設定 

 アカウント レポート フォルダの設定 

 音によるウェブ アラートの設定 

ユーザー アカウントのアクセス設定 

次の手順で、ユーザー アカウントへのアクセス設定のガイドを行います。 

ユーザー アカウントを編集するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの Accounts （アカウント）グ

ループ内の Manage Accounts （アカウント管理）をクリックします。 

4. 編集するアカウントを選択し、Edit （編集）をクリックします。 

5. Account Enabled （アカウントは有効です）を Yes （はい）または No （いいえ）に、必

要に応じて設定します。 

注記： アカウントはデフォルトでは有効です。アカウントを無効にしても、アカウント自体の

削除は行えません。アカウントの定義と詳細は、後ほどアカウントが有効になるイベントの 

Orion データベースで保存されます。 

6. 特定の日時に有効期間を終了するアカウントがある場合は、Account Expires （アカ

ウントの有効期間）フィールドの横にある Browse （参照） (…) にアクセスし、カレン 

ダー ツールでアカウントの有効期限を選択します。 

注記： デフォルトでは、アカウントは有効期間が Never （なし）に設定されています。日

付はどの形式でも入力できますが、ユーザーがお使いのコンピュータのローカル設定に従い

ます。 

7. ユーザーの無期限のログインを許可する場合は、Disable Session Timeout （セッショ

ン タイムアウトを無効にする）オプションで Yes （はい）を選択します。 
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注記： セキュリティをより強化するために、デフォルトでは、新規のユーザーアカウントは自
動的にタイムアウトするように設定されています。 

8. 選択したアカウントに管理者権限を与える場合は、Allow Administrator Rights （
管理者権限の許可）で Yes （はい）を選択します。 

注記： 

 管理者権限を与えても、Admin （管理）メニューバーをユーザーには割り当てること
はできません。ユーザーが Admin （管理）オプションへのアクセスを必要とする場合は、
そのユーザーを Admin （管理）ビューに割り当てる必要があります。詳細については、
256 ページの「デフォルト アカウントのメニュー バーとビューの設定」を参照してください。 

 管理者権限はデフォルトでは与えられませんが、アカウントの作成、削除および編集
は要求されます。管理者権限のないユーザー アカウントでは Admin （管理）ページ
情報にはアクセスできません。 

9. ユーザーが Orion ウェブ コンソールのノードを直接管理する許可を与える場合は、
Allow Node Management Rights （ノード管理権）を Yes （はい）に設定します。 

注記： デフォルトでは、ノード管理権は与えられていません。Orion ウェブ コンソールでのノ
ード管理の詳細については、55ページの「ウェブ コンソールでのデバイス監視 」を参照して
ください。 

10. ユーザーにビューのカスタマイズを許可する場合は、Allow Account to Customize 

Views （アカウントにビューのカスタマイズを許可）で Yes （はい）と設定します。 

注記： デフォルトでは、カスタマイズされたビューの作成は許可されていません。ビューに対
する変更は、同じビューに割り当てられているすべてのユーザーが確認できます。 

11. Allow Account to Clear Events and Acknowledge Alerts （イベントと承認ア
ラートのクリアを許可する）かどうかを指定します。 

12. Allow Browser Integration （ブラウザの統合を許可）を選択します。 

注記： ブラウザの統合で、（クライアントのブラウザの容量によりますが）メニューオプションを
右クリックできる等の追加機能が使用できるようになります。 

13. クライアントのブラウザで音のあるアラートを有効にする場合は、Alert Sound （アラート
音）リストからサウンドを選択します。 

注記： デフォルトでは、サウンドは Sounds （サウンド）ディレクトリに保存されます。ディレ
クトリの場所は C:\Inetpub\SolarWinds\NetPerfMon\Sounds になります。この
ディレクトリに追加される.wav フォーマットのサウンドは、Edit User Account （ユーザー 

アカウントの編集）ページが更新されるとすぐに利用できるようになります。 

14.  パンくずリストのアイテム数 の最大数を入力します。 

注記： この値が 0 に設定されている場合、利用可能なアイテムがすべてパンくずのドロッ
プダウンリストに表示されます。 
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アカウント制限の設定 

アカウント制限は、指定されたネットワーク エリアへのユーザーのアクセスを制限するか、指定さ

れたユーザーに関する特定の種類の情報について公開を控える設定を行うために使用されま

す。次の手順でユーザーアカウント制限の設定を行います。 

ユーザーアカウント制限を設定するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上にある Settings （設定）をクリックしてから、Orion Website 

Administration （ウェブサイト管理）ページの  Accounts （アカウント）グループで 

Manage Accounts （アカウント管理）をクリックします。 

3. 個々のユーザーアカウントを制限するには、次の手順を実行します。 

a. Individual Accounts （個々のアカウント）タブで、制限するアカウントにチェックを入

れます。 

b. Edit （編集）をクリックします。 

c. Add Limitation （制限の追加）を Account Limitations （アカウント制限）セク 

ションでクリックします。 

d. 適用する制限の種類を選択し、Continue （続行）をクリックします。 

注記： 

 Orion Netflow トラフィック アナライザ（ NTA ）は最初にアカウント制限をキャッ

シュします。このため、Orion NTA に関連するアカウント制限が Orion NTA で

有効になるには 1 分程かかる場合があります。 

 アカウント制限ビルダーで定義されたアカウント制限は Select Limitation （制

限の選択）ページにオプションとして表示されます。アカウント制限は、ほぼすべて

のカスタムプロパティで定義および設定することができます。詳細については、

253 ページの「アカウント制限の設定 」を参照してください。 

e. 次の Configure Limitation （制限の設定）ページの指示に従って、制限を定義し

ます。パターン タイプの制限を定義する詳細については、255 ページの「パターン制

限の定義」を参照してください。 

4. グループ アカウントを制限するには、次の手順を実行します。 
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注記： 選択したグループ アカウントに適用する制限は、グループ アカウントのみが対象と

なり、グループのメンバーのアカウントには適用されません。 

a. Groups （グループ）タブで、制限するグループ アカウントにチェックを入れます。 

b. Edit （編集）をクリックします。 

c. Add Limitation （制限の追加）を Account Limitations （アカウント制限）セク 

ションでクリックします。 

d. 適用する制限の種類を選択し、Continue （続行）をクリックします。 

注記： 

 Orion Netflow トラフィック アナライザ（ NTA ）は最初にアカウント制限をキャッ

シュします。このため、Orion NTA に関連するアカウント制限が Orion NTA で

有効になるには 1 分程かかる場合があります。 

 アカウント制限ビルダーで定義されたアカウント制限は Select Limitation （制

限の選択）ページにオプションとして表示されます。アカウント制限は、ほぼすべて

のカスタムプロパティで定義および設定することができます。詳細については、

253 ページの「アカウント制限の設定 」を参照してください。 

e. 次の Configure Limitation （制限の設定）ページの指示に従って、制限を定義し

ます。パターン タイプの制限を定義する詳細については、255 ページの「パターン制

限の定義」を参照してください。 

5. Add Limitation （制限の追加）を Account Limitations （アカウント制限）セクションで

クリックします。 

6. 適用する制限のタイプをリストから選択し、Continue （続行）をクリックします。 

注記： 

 アカウント制限ビルダーで定義されたアカウント制限は Select Limitation （制限の

選択）ページにオプションとして表示されます。アカウント制限は、ほぼすべてのカスタ

ムプロパティで定義および設定することができます。詳細については、253 ページの

「アカウント制限の設定 」を参照してください。 

 Orion Netflow トラフィック アナライザ（ NTA ）は最初にアカウント制限をキャッシュし

ます。このため、Orion NTA に関連するアカウント制限が Orion NTA で有効にな

るには 1 分程かかる場合があります。 

7. 次の Configure Limitation （制限の設定）ページの指示に従って、制限を定義します。

パターン タイプの制限を定義する詳細については、255 ページの「パターン制限の定義」

を参照してください。 
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パターン制限の定義 

パターン制限は OR 、AND 、EXCEPT 、NOT といった演算子、さらにワールドカード文字として 

_ と * を使用して定義することができます。次のサンプルは、利用できる演算子とワイルドカー

ド文字の使い方について示します。 

注記： パターンには大文字と小文字の区別はありません。 

 foo は「foo」という名前のオブジェクトのみに一致します。 

 foo_ は「foo」という文字列で構成される名前のすべてのオブジェクトと、「foot」または

「food」といった、「foo」に 1 文字のみ追加した名前のオブジェクトに一致します。ただし

「seafood」や「football」といった文字列には一致しません。 

 foo* は「football」または「food」のような「foo」という文字列で始まる名前のあらゆる

オブジェクトに一致しますが、seafood などの名前には一致しません。 

 *foo* は、「seafood」または「Bigfoot」といった「foo」という文字列が含まれる名前の

すべてのオブジェクトに一致します。 

 *foo* OR *soc* は、「football」、「socks」、「soccer」そして「food」などの「foo」

または「 soc 」という文字列が含まれているすべてのオブジェクトに一致します。 

 *foo* AND *ball* は、「football」などのように「foo」と「ball」双方の文字列を含

むすべてのオブジェクトに一致します。しかし「 food 」などは含まれません。 

 *foo* NOT *ball* は、「food」などのように「foo」という文字列を含んでおり、かつ

「ball」という文字列が含まれていないすべてのオブジェクトに一致します。このため、

「football」には一致しません。 

 *foo* EXCEPT *ball* は、「food」などのように「foo」という文字列を含んでおり、か

つ「ball」という文字列が含まれていないすべてのオブジェクトに一致します。このため、

「football」には一致しません。 

また以下のサンプル同様に、括弧を使用して演算子をグループ化できます。 

(*foo* EXCEPT *b*) AND (*all* OR *sea*) は「seafood」と「footfall」に

一致しますが、「football」または「Bigfoot」には一致しません。 
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デフォルト アカウントのメニュー バーとビューの設定 

Default Menu Bar and Views （デフォルト メニュー バーとビュー）セクションで、ユーザー アカ

ウントのデフォルト メニュー バーとビュー設定用のオプションを提供します。次の手順で、ユー 

ザー アカウントへのアクセス設定のガイドを行います。 

デフォルト メニュー バーとビュー オプションを設定するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ  コンソールの右上の  Settings （設定）をクリ ックし、Orion Website 

Administration （ウェブ管理）ページの Accounts （アカウント）グループ内の Manage 

Accounts （アカウント管理）をクリックします。 

3. 続行するアカウントを選択し、Edit （編集）をクリックします。 

4. Default Menu Bar and Views （デフォルト メニュー バーとビュー）をスクロール ダウンし

ます。 

5. 利用可能リストから Home Tab Menu Bar （ホーム タブ メニュー バー）を選択します。 

注記： これは、Orion ウェブ コンソールの Home （ホーム）をクリックしたときに表示される

デフォルト メニュー バーです。管理者特権を持つユーザー アカウントを編集する場合、

Home Tab Menu Bar （ホーム タブ メニュー バー）を Admin に設定します。 

6. 利用可能リストから Network Tab Menu Bar （ネットワーク タブ メニュー バー）を選択

します。 

注記： これは、Orion ウェブ コンソールの Network （ネットワーク）をクリックしたときに表

示されるデフォルト メニュー バーです。管理者特権を持つユーザー アカウントを編集する

場合、Admin （管理）を選択します。 

7. 利用可能リストから Virtualization Tab Menu Bar （仮想化タブ メニュー バー）を選

択します。 

注記： これは、Orion ウェブ コンソールの Virtualization （仮想化）をクリックしたときに

表示されるデフォルト メニュー バーです。管理者特権を持つユーザー アカウントを編集す

る場合、Admin （管理）を選択します。 

8. Orion モジュールを追加インストールするには、利用可能な各リストから Orion Module 

Tab Menu Bar （ Orion モジュール タブ メニュー バー）を選択します。 

注記： この手順により、インストールしているモジュールに対応するタブを Orion ウェブ コン

ソールでクリックしたときに表示されるデフォルト メニュー バーを設定します。管理者特権を

持つユーザー アカウントを編集する場合、Admin （管理）を選択します。 

9. Home Page （ホーム ページ ビュー）を選択します。 
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注記： Home （ホーム ページ ビュー） を指定していない場合は、デフォルトは Default 

Summary View （デフォルト サマリー ビュー）フィールド内で指定されているページと同

様に設定されています。 

10. 選択した Home Page View （ホーム ページ ビュー）が特定のネットワーク デバイスを参
照する場合、Edit （編集）をクリックし、次のページの利用可能なデバイス リストから選択

し、Default Network Device （デフォルト ネットワーク デバイス）を選択します。 

注記： ユーザーが選択した Home Page View （ホーム ページ ビュー）が特定のネットワ

ーク デバイスを要求しない場合は、Orion は表示するデバイスを自動選択します。 

11. アカウント用に Default Summary View （デフォルト サマリー ビュー）を選択します。 

注記： これは通常、Home Page View （ホーム ページ ビュー）と同じになります。 

12. アカウントですべてのレポートを利用する場合は、\Reports を Default Menu Bars 

and Views （デフォルト メニュー バーとビュー）の Report （レポート）フォルダ リストから選

択します。 

注記： ユーザーを新規作成する場合、新規アカウントが Orion レポートにアクセスする際

に使用する Report Folder （レポート フォルダ）を指定します。デフォルトでは、新規ユー

ザーにはレポート フォルダは設定されません。Reports （レポート）ディレクトリは、下記の

Orion NPM インストール ディレクトリにあります： C:\Program Files\SolarWinds 

\Orion\ 。 

13. このアカウント用のデフォルトの  Node （ノード）、Volume （ボリューム）、Group 

Details （グループの詳細）ビューを指定する場合、Orion General Settings （Orion 

一般設定）を展開し、適切な Node Detail （ノードの詳細）、Volume Detail （ボ 

リュームの詳細）、Group Detail Views （ノードの詳細）ビューを選択します。 

14. このアカウントでデフォルトの Virtualization Summary Manager （仮想化サマリー マ
ネージャ）、Cluster Details （クラスタの詳細）、Datacenter Details （データセンター
の詳細）ビューを指定する場合は、Integrated Virtual Infrastructure Monitor 

Settings （統合仮想インフラストラクチャ モニターの設定）を展開し、適切なデフォルト  

ビューを選択します。 

15. Submit （送信）をクリックします。 
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アカウント レポート フォルダの設定 

レポートは、Reports ディレクトリ内でサブディレクトリを作成することで、アカウントに割り当てら

れます。希望するレポートはサブディレクトリ内に追加され、サブディレクトリをアカウントで利用

できるようになります。これにより、レポートがビューに含まれるかカスタム メニュー アイテムとして

追加されるときに、安全性のレベルが提供されます。詳細については、200 ページの「外部ウェ

ブサイト ビューの作成および編集」を参照してください。 

アカウント レポート フォルダを設定するには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上にある Settings （設定）をクリックしてから、Orion Website 

Administration （ウェブサイト管理）ページの  Accounts （アカウント）グループで 

Manage Accounts （アカウント管理）をクリックします。 

3. 続行するアカウントを選択し、Edit （編集）をクリックします。 

4. アカウントですべてのレポートを利用する場合は、\Reports を Default Menu Bars 

and Views （デフォルト メニュー バーとビュー）の Report （レポート）フォルダ リストから選

択します。 

注記： ユーザーを新規作成する場合、新規アカウントが Orion レポートにアクセスする際

に使用する Report Folder （レポート フォルダ）を指定します。デフォルトでは、新規ユー

ザーにはレポート フォルダは設定されません。Reports （レポート）ディレクトリは、下記の

Orion NPM インストール ディレクトリにあります： C:\Program Files\SolarWinds 

\Orion\ 。 

5. Submit （送信）をクリックします。 

音によるウェブ アラートの設定 

Orion ウェブ コンソールを開いているときに、アラートは、アラートが新しく生成されるたびに音が

鳴ります。このアラートが有効になっている場合、ログインしてから最初にページ上にアラートが

表示されるとアラート音が鳴ります。このアラートはアラート リソースまたはアラート ビューから生

成されます。表示しているアラート ビューかアラート リソースが空の場合は、アラート音は聞こえ

ません。 
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最初のアラート音のあと、すでに表示済みの現在のアラートよりもあとにトリガーされたアラート

が発生するたびに、アラート音が鳴ります。 

たとえば、ユーザーがログインし、午前 9 時 1 分から午前 9 時 25 分の範囲でアラート トリ 

ガー グループを確認すると、アラート音が聞こえます。ユーザーが新規ページを開いて現在のペ

ージを自動更新にした場合、午前 9 時 25 分以降にアラート トリガーが表示されると、新し

いアラート音が鳴ります。 

音のあるウェブ アラートを有効にするには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上の Settings （設定）をクリックします。 

3. Orion Website Administration （ウェブサイト管理）ページの Accounts （アカウント）グ

ループ内の Manage Accounts （アカウント管理）をクリックします。 

4. 設定するアカウントを選択します。 

5. Edit （編集）をクリックします。 

6. 新しいアラートが発生したときに再生する音声ファイルを、Alert Sound （アラート音）リス

トから選択します。 

注記： デフォルトでは、サウンドは Sounds （サウンド）ディレクトリに保存されます。ディレ

クトリの場所は C:\Inetpub\SolarWinds \NetPerfMon\Sounds になります。この

ディレクトリに追加される.wav フォーマットのサウンドは、Edit User Account （ユーザー 

アカウントの編集）ページが更新されるとすぐに利用できるようになります。 

7. Submit （送信）をクリックします。 
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第 19章 

Orion ポーリング エンジンの管理  –  コア 

ポーリング エンジンがパフォーマンスを最大限発揮できるよう最適化するために、時々調整を

行う必要があります。1 つ以上のポーリング エンジンを使用する場合、各エンジンが最適に機

能するように負荷を分散する必要があります。 

ウェブ コンソールのポーリング エンジン ステータスの表示 

Orion ウェブ コンソールは Polling Engines （ポーリング エンジン）ビューを表示し、Orion イン

ストレーション内のすべてのポーリング エンジンのパフォーマンスについて即座に洞察を得ることが

できます。 

ポーリング エンジン ビューを表示するには： 

1.  管理者として Orion ウェブ コンソールにログインします。 

2.  ウェブ コンソールの右上の Settings （設定）をクリックします。 

3.  Details （詳細）グループの Polling Engines （ポーリング エンジン）をクリックします。 

このビューでの設定の構成方法と、その他すべての利用可能なポーリング エンジン変数の設

定の詳細については、261 ページの「ポーリング エンジン設定の実行」を参照してください。 

ポーリング エンジン設定の実行 

Orion NPM ポーリング  エンジンの設定は、Orion ウェブ  コンソールの  Orion Polling 

Settings （Orion ポーリング設定）ビューで構成されます。 

Orion Polling Settings （Orion ポーリング設定）ビューを開く方法 : 

1.  管理者として Orion ウェブ コンソールにログインします。 

2.  ウェブ コンソールの右上の Settings （設定）をクリックします。 

3.  Settings （設定）グループの Polling Settings （ポーリング設定）をクリックします。 

次のセクションでは、Orion Polling Settings （Orion ポーリング設定）ビューで構成できる設

定の説明を行います。 
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Orion ポーリング設定 

次のポーラー設定は、Orion Polling Settings （ポーリング設定）ビューで設定できます。 

注記： ユーザーがインストールした Orion 製品とモジュールによっては、別のポーリング設定も

利用できる場合があります。その他のポーリング設定の詳細については、Orion 製品の「管理
者ガイド 」を参照してください。 

Polling intervals （ポーリング間隔） 

次の手順で、デフォルトのポーリング間隔を設定します。ポーラー設定を適用するには、

ReApply Polling Intervals （ポーリング間隔の再適用）をクリックします。 

 デフォルトのノード ポーリング間隔 

デバイスは、ここで設定される間隔で定期的にポーリングされ、ステータスと応答時間が判

断されます。デフォルトでは、この間隔は 120 秒です。 

 デフォルトのボリューム ポーリング間隔 

ボリュームは、ここで設定される間隔で定期的にポーリングされ、ステータスと応答時間が

判断されます。デフォルトでは、この間隔は 120 秒です。 

 デフォルトの再ディスカバリ間隔 

ユーザーのネットワーク全体がこの間隔でポーリングされ、再度インデックス付けされたインター

フェースを検知します。監視されたネットワーク デバイスも、EnergyWise のサポートが可能

な IOS アップグレードについてチェックされます。デフォルトでは、この間隔は 30 分です。 

注記： Orion NPM バージョン 10.1 以前にリリースされた Orion 製品では、最短の間

隔は 1 分になります。Orion NPM バージョン 10.1 以降では、最短の再ディスカバリ間

隔は 5 分です。デフォルトの再ディスカバリ間隔が最短でも 5 分間に設定されていないと、

ポーリング間隔設定は送信されない場合があります。 

 カスタム値をロック 

このオプションはデフォルトで有効です。このオプションを有効にすると、Orion Polling 

Settings （ポーリング設定）ビューで設定したポーリングのカスタマイズを自動的に保存します。 
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ポーリング統計の間隔 

次の手順で、デバイス統計用のデフォルトのポーリング間隔を設定します。ポーラー設定を適

用するには、ReApply Polling Statistic Intervals （ポーリング統計の間隔の再適用）を

クリックします。 

 デフォルトのノード統計のポーリング間隔 

デバイスのパフォーマンスの統計は、この間隔で定期的にポーリングされます。デフォルトで

は、この間隔は 10 分です。 

 デフォルトのボリューム統計のポーリング間隔 

ボリュームのパフォーマンスの統計は、この間隔で定期的にポーリングされます。デフォルト

では、この間隔は 15 分です。 

データベース設定 

次のオプションで Orion データベース保守と保持設定を設定します。 

注記：  データベース保守と保持設定の変更は、SolarWinds Network Performance 

Monitor サービスが再起動されるまでは有効になりません。 

 アーカイブ時間 

The Archive Time （アーカイブ時間）は、Orion データベース保守が実行される際の 1 

日当たりの時間を指します。詳細については、399 ページの「データベース保守」を参照し

てください。 

 詳細な統計情報の保持 

1 時間以内の時間で収集されたすべての統計情報は、Detailed Statistics Retention 

（詳細統計情報の保持）期間として設定された時間が経過した後に、毎時間単位の統

計情報に要約されます。デフォルトでは、この期間は 7 日間になります。 

 毎時間の統計情報の保持 

1 日以内および  1 時間以上の時間で収集されたすべての統計情報は、Hourly 

Statistics Retention （毎時間の統計情報の保持）期間として設定された時間が経過

した後に、日単位の統計情報に要約されます。デフォルトでは、この期間は 30 日間にな

ります。 

 毎日の統計情報の保持 

Orion データベースで毎日収集されたすべての統計情報は、設定された期間中は保持

されます。デフォルトでは、この期間は 365 日間になります。 
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 イベントの保持 

すべてのネットワーク イベント データは、イベント終了後に Events Retention （イベント

の保持）で設定された期間が経過すると、Orion データベースから削除されます。デフォル

トでは、この期間は 30 日間になります。 

 Syslog メッセージの保持 

受信したすべての Syslog メッセージは、設定された期間中は保持されます。デフォルトで

は、この期間は 7 日間になります。 

 トラップ メッセージの保持 

受信したすべてのトラップ メッセージは、設定された期間中は保持されます。デフォルトで

は、この期間は 30 日間になります。 

 アラートの最大実行時間 

ここで指定した数値よりもアラート実行に時間がかかる場合、Orion はアラートを無効にしま

す。アラートの実行時間には、アラート アクションの設定をトリガーする時間も含まれます。 

 ディスカバリの保持 

設定されたすべてのディスカバリ プロファイルは、設定された期間中は保持されます。デ 

フォルトでは、この期間は 60 日間になります。ディスカバリ プロファイルの詳細については、

35 ページの「ネットワーク デバイスのディスカバリと追加」を参照してください。 

 ネットワーク 

 次の設定で、ICMP と SNMP 要求を構成します。 

 ICMP タイムアウト 

Orion ポーラーで作成されたすべての ICMP (ping) 要求は、設定された期間内に応答

がない場合はタイムアウトになります。デフォルトでは、この期間は 2500ms になります。 

 ICMP データ 

 このストリングは、Orion から送信されたすべての ICMP パケットに含まれます。 

 SNMP タイムアウト 

Orion ポーラーで作成されたすべての SNMP 要求は、設定された期間内に応答を受け取

らなかった場合はタイムアウトになります。デフォルトでは、この期間は 2500ms になります。 
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 SNMP リトライ 

Orion ポーラーで作成された SNMP ポーリング要求への応答が、設定された SNMP タ

イムアウト以内に受け取られなかった場合、Orion ポーラーは、この数値で設定された回

数だけ再試行を行います。デフォルトでは、この数値は 2 となっています。 

 ESX API タイムアウト 

 Orion ポーラーで作成されたすべての VMware ESX API 要求は、設定された期間内

に応答がない場合はタイムアウトになります。デフォルトでは、この期間は 30000ms にな

ります。VMware ESX ポーリングの詳細については、65 ページの「仮想化」を参照してく

ださい。 

 UCS API タイムアウト 

Orion ポーラーで作成されたすべての UCS API 要求は、設定された期間内に応答が

ない場合はタイムアウトになります。デフォルトでは、この期間は 240 秒になります。 

 DNS 逆引き参照の実行 

Orion NPM を使用して、監視される DHCP で DNS 逆引き参照を実行する場合は、

このオプションがチェックされていることを確認してください。デフォルトでは DHCP ノード用

の DNS 逆引き参照は有効になっています。 

計算 & しきい値 

次の設定でベースラインの可用性と送信速度を計算する方法を指定します。Orion NPM  

ノード警告レベルとカウンタ タイプを選択し、ウェブ コンソールでコミュニティ ストリングとそのほか

の機密情報に対するセキュリティ設定を指定します。 

計算の可用性（高度） 

この設定で Orion NPM がデバイスの可用性を判断するために実行する計算のタイプを

指定します。詳細については、266 ページの「ノード可用性の計算」を参照してください。 

 ベースライン計算（高度） 

スタートアップ時に、Orion はネットワークのさまざまな要素の伝送速度のベースラインを計

算できます。このベースラインはすべての比較統計の開始点として利用されます。詳細に

ついては、267 ページの「ベースラインの計算 」を参照してください。 
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 ウェブでセキュリティ保護されたデータを有効にする（高度） 

セキュリティ保護のため、ネットワークの機密情報は Orion ウェブ コンソールでは表示されま
せん。しかしネットワークが確実に安全である場合は、このオプションにチェックを入れて、ウェ
ブ コンソール内のコミュニティ ストリングとその他の機密情報を表示させることも可能です。 

注記： この設定は、ウェブにエクスポートしたカスタム レポートの表示には影響しません。
詳細については、123 ページの「定義済み Orion NPM レポート」を参照してください。 

 ノード警告レベル 

 設定された期間内にポーリングに応答しないデバイスは、ウェブ コンソールで Down （ダウ
ン）と表示されます。デフォルトでは、この数値は 120 秒です。 

 カウンタ ロールオーバー 

 このオプションは、Orion NPM が使用するカウンタのタイプを設定します。詳細について
は、179 ページの「カウンタ ロールオーバーの操作」を参照してください。 

ノード可用性の計算 

Orion Polling Settings （オプション ポーリング設定）ビューの可用性の計算設定では、デバ

イスの可用性を判断する次の 2 つの方法から選択できます。 

Node Status （ノード ステータス）： 

デフォルトの方法は、選択したノードのアップまたはダウンのステータスの履歴に基づいています。
選択されたノードは、Orion Polling Settings （オプション ポーリング設定）ビューで定義された
デフォルト ノード ポーリング間隔でポーリングされます。詳細については、262 ページの「Orion 

ポーリング設定」を参照してください。 

選択されたノードがデフォルトの間隔内に ping へ応答した場合、ノードはアップとみなされ、
Orion データベースの Response Time （応答時間）テーブルに 100 の数値が記録されま
す。選択されたノードがデフォルトの間隔内に ping へ応答しない場合、ノードはダウンとみなさ
れ、Orion データベースの Response Time （応答時間）テーブルに 0 の数値が記録されま
す。選択した期間のノード可用性を計算するために、選択した期間に選択したノードに対する
すべての Response Time （応答時間）テーブルの記録の合計数が、選択された期間で除
算されます。これにより選択した期間での平均可用性が提供されます。 

Percent Packet Loss （パケット損失率）： 

2 つ目の方法は、より複雑な計算になります。この計算は、パケット損失率に関する選択され

たノードの可用性をベースにします。ノード ステータス方法と同様に、選択されたノードはステー

タス用にポーリングされます。Orion Polling Settings （オプション ポーリング設定）ビューで定

義されたデフォルト ノード ポーリング間隔内に応答がない場合、100 の数値が前の 10 件の

記録と共に平均化されます。詳細については、262 ページの「Orion ポーリング設定」を参照

してください。 
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パケット損失率の計算結果は、スライディング ウィンドウの平均です。選択した期間のノード可

用性を計算するために、選択した期間に選択されたノードに対する Response Time （応答

時間）テーブルのすべての結果の合計数が、選択した期間で除算されます。これにより期間中

の平均可用性を求めます。 

注記： パケット損失率メソッドで、依存性の履歴を利用可能な各ノードのレコードに導入しま

す。通常、パケット損失に基づいたノード可用性を特に必要としない限りは、ノード ステータス

に基づいた計算がベストです。 

ベースラインの計算 

Orion NPM が、監視されたネットワーク オブジェクトからポーリングした生データの大部分は、

最初にバリュー カウンターとして提供されます。たとえば、Orion NPM がインターフェースから 

ポーリングする値の 1 つは ifInOctets で、ポーリングされたインターフェースが（デバイスが最

後に起動してから）受信したバイト数を返します。通常、ネットワーク パフォーマンスの監視の

観点からみて、この値がそれ自体で役立つ情報となりますが、インターフェースが受信したバイ

トの 割合 を把握すると、さらに役立ちます。 

割合を判断するには、2 つの値が必要になります。 新しくインストールしたときかシャットダウン後

に、SolarWinds Network Performance Monitor サービスが開始した際に、Orion データ 

ベースには現在のネットワーク データがありません。この場合、デフォルトでは、Orion はネット 

ワークのさまざまな要素の伝送速度のベースラインを計算します。このベースラインを計算するに

は、すべてのネットワーク リソースがスタートアップ時に即座にポーリングされ、そのあと最初のポー

リングをできるだけ早く完了し、さらにネットワークを再度ポーリングします。結果データの 2 つの 

セットは、ネットワーク パフォーマンスのベースライン ビューを即座に計算するのに使われます。 

この統計情報がすぐには必要ない場合、または Orion NPM でスタートアップ時にベースライン

を計算したくない場合は、Orion Polling Settings （ポーリング設定）ビューの Baseline 

Calculation （ベースライン計算）オプションを False に設定して、ベースライン計算を無効に

します。詳細については、261 ページの「Orion ポーリング エンジンの管理  –  コア」を参照して

ください。 

注記： ベースライン計算では、大量のデータを収集および処理する必要があります。ベースライ

ン計算が完了するまでは、Orion NPM サーバーのパフォーマンスと、一部のネットワーク ルータ

の CPU パフォーマンスに影響が出る場合があります。 
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ポーリング エンジン負荷バランサーの使用 

ポーリング エンジン負荷バランサーも、ノードを新しいポーリング エンジンへ再割り当てするため

に有効なツールです。この装置では不要のポーリング エンジンを削除し、複数のポーリング エン

ジン間で負荷分散を行います。このツールは、Monitor Polling Engines （ポーリング エンジン

を監視）アプリケーションで利用できる Orion NPM の拡張機能です。 ノードを新しいポーリン

グ エンジンに再割り当てするには、以下の点が要求される場合があります。 

 Orion NPM サーバーの移動または名前の変更 

  2 つ以上の Orion サーバーの統合 

再割当てのために必要なこれらの条件、またはそれ以外の条件が要求された場合、次の手

順を実行してノードを新しいポーリング エンジンに再割当てします。 

ノードを異なるポーリング エンジンに再割り当てするには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > Orion 

Service Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 

> Orion サービス マネージャ）の順でクリックします。 

2. Shutdown Everything （すべてシャットダウン）をクリックします。 

注記： すべてのポーリング エンジンで SolarWinds Network Performance Monitor サ

ービスを停止することを確認します。 

3. Start > All Programs > SolarWinds Orion > Advanced Features > 

Monitor Polling Engines （スタート > すべてのプログラム > SolarWinds Orion > 

拡張機能 > ポーリング エンジンの監視）の順でクリックします。 

4. Servers > Poller Load Balancing （サーバー > ポーラー負荷バランシング） 

5. 再割当てするノードを選択します。 

注記： 複数の連続する列をハイライトする場合は Shift + クリック を、複数の非連続

な列をハイライトする場合は Ctrl + クリック を使用します。 

6. Polling Engines > Move Selected Nodes to * （ポーリング エンジン > 選択したノ

ードを * へ移動）をクリックして、* にターゲットのポーリング エンジンを置換します。ノードが

再割当てされると、ポーリング エンジン コラムのポーリング エンジン名に反映されます。 

7. Start > All Programs > SolarWinds Orion > Advanced Features > Orion 

Service Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 

> Orion サービス マネージャ）の順でクリックします。 
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ノード警告レベルの設定 

デバイスはさまざまな理由から、パケットを破棄するか、ポーリングへの応答に失敗する場合が

あります。デバイスが応答に失敗した場合は、デバイスのステータスは  UP （アップ）から 

Warning （警告）に変更されます。Orion Polling Settings （ポーリング設定）ビューで Node 

Warning Level （ノード警告レベル）を指定できます。ここで、デバイスのステータスが Down 

（ダウン）としてマークされる前に Warning （警告）のままの状態でいる時間の長さを指定でき

ます。指定された間隔の間、このサービスは「迅速なポーリング」（ICMP）を実行してノード ス 

テータスを継続的にチェックします。 

注記： 実際にはダウンしていないのに、ダウンと表示されているノードのイベントを確認したり、

アラートを受け取る場合があります。これはネットワーク上の断続的なパケット損失が原因であ

る可能性があります。Node Warning Interval （ノード警告間隔）を高い値で設定し、これら

の誤った通知を避けます。パケット損失のレポートの詳細については、269 ページで「パケット

損失レポートの管理」を参照してください。 

ノード警告レベルを設定するには： 

1. 管理者権限を持つアカウントで Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上隅の Settings をクリックし、Orion Website Administration 

（ウェブサイト管理）ビューの Settings （設定）グループ内の Polling Settings （ポーリン

グ設定）をクリックします。 

3. Calculations and Thresholds （計算としきい値）グループで、Node Warning Level 

（ノード警告レベル）を適切な間隔（秒）に設定します。 

注記： デフォルトのノード警告レベル間隔は 120 秒です。 

4. Submit （送信）をクリックします。 

パケット損失レポートの管理 

Orion でレポートされるネットワークのパケット損失を管理するには、ポーリング エンジンの応答

時間再試行カウントを設定します。この設定では、Orion が（パケット損失がレポートされる前

に）監視されたデバイスで ICMP ping に再試行する回数を指定します。 

注記：この設定の変更では、Orion データベースへの挿入を要求します。ユーザー環境で可

能であれば、SolarWinds は、SQL Server Management Studio をインストールおよび使

用してこの挿入を実行することを推奨します。 
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ポーリング エンジンの応答時間再試行カウントを設定するには： 

1. Orion データベースの完全バックアップを作成します。詳細については、SolarWinds テク

ニカル リファレンスの「 Orion NPM データベースの移動 」を参照してください。 

2. Orion サーバーで  Start > All Programs > SolarWinds Orion > Advanced 

Features > Orion Service Manager （スタート > すべてのプログラム > SolarWinds 

Orion > 拡張機能 > Orion サービス マネージャ）の順でクリックします。 

3. Shutdown Everything （すべてシャットダウン）をクリックします。 

4. Orion デバイス サーバーで、Start > All Programs > Microsoft SQL Server > 

SQL Server Management Studio （スタート > すべてのプログラム > Microsoft 

SQL Server > SQL Server Management Studio ）の順でクリックします。 

5. Orion データベースの サーバー名 を選択します。 

6. 適切な Authentication type （認証タイプ）を選択し、要求された資格証明を入力し

ます。そのあと、Connect （接続）をクリックします。 

7. Databases > OrionDatabaseName  > Tables （データベース > 

OrionDatabaseName > テーブル）を展開します。 

8. New Query （新規クエリー）をクリックします。 

9. 次のクエリーを空の SQL query （ SQL クエリー）フィールドに入力します。 

注記： ユーザーのカスタム値の Maximum （最大）、CurrentValue （現在の値）、

DefaultValue （デフォルト値）を指定します。 

INSERT INTO [OrionDatabaseName].[dbo].[Settings] (SettingID, 

Name, Description, Units, Minimum, Maximum, CurrentValue, 

DefaultValue) VALUES (‘SWNetPerfMon-Settings-Response Time 

Retry Count’ , ‘Response Time Retry Count’, ‘Number of times 

Orion retries ICMP pings on a monitored device before reporting 

packet loss’, ‘’, 1, Maximum, CurrentValue, DefaultValue ) 

10. Execute （実行）をクリックします。 

11. SQL Server Management Studio を閉じます。 

12. Orion サーバーで Start > Run （スタート > 実行）をクリックして regedit を入力し、

OK をクリックします。 

13. HKEY_LOCAL_MACHINE > SOFTWARE （ソフトウェア）  > SolarWinds.Net > 

SWNetPerfMon を展開します。 

14. Settings （設定）を右クリックして、New > String Value （新規  > ストリング値）をク 

リックします。 

http://www.solarwinds.com/support/Orion/docs/OrionServerMigration.pdf
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15. Response Time Retry Count （応答時間再試行カウント）を New Value （新しい

値）として入力します。 

16.  Response Time Retry Count （応答時間再試行カウント）を右クリックし、Modify 

（修正）をクリックします。 

17. Value data （値データ）フィールドで、上記のクエリーで入力された CurrentValue 

（現在の値）を入力し、OK をクリックします。 

18. Registry Editor （レジストリ エディタ）を閉じます。 

19. Start > All Programs > SolarWinds Orion > Advanced Features > Orion 

Service Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > 

Orion サービス マネージャ）の順でクリックします。 

20. Start Everything （すべて開始）をクリックします。 
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第 20章 

ネットワーク イベントの監視  –  コア 

Orion NPM は、ネットワークで監視されたデバイスで発生するイベントをすべて自動的にログ

に記録します。そのあと、これらのイベントは Orion ウェブ コンソールで表示され、ユーザーは 

ネットワーク管理ポリシーが要求するとおりにイベントを表示および承認できます。 

ウェブ コンソールの Event Details （イベントの詳細）を表示 

Orion はネットワーク イベントをログに記録し、ウェブ コンソールで簡単にカスタマイズできる

Events（イベント）ビューで、それらのイベントを一覧表示します。イベントは発生順に表示されま

す。またデバイス、日付、時間、そして イベントまたはデバイスの タイプごとにも表示が可能です。 

注記: ネットワークのイベント ログは、Orionウェブ コンソールの Orion Polling Setting（ポーリ

ング設定）にある Database Settings（データベース設定）エリア内で定義する、夜間データ 

ベース保守計画の一環として保存されます。Events Retention（イベント保持）フィールドで

指定された日数の間、レコードは保存されます（デフォルトは 30 日間）。詳細については、  

262 ページの「Orion ポーリング設定」を参照してください。 

ウェブ コンソールの Event Details（イベントの詳細）を表示するには: 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スタート > す

べてのプログラム > Solar Winds Orion > Orionウェブ コンソール）の順でクリックします。 

2. Orionウェブ コンソールにログインし、Views（ビュー）ツールバーで Events （イベント）をク

リックします。 

3. イベント ビューを オブジェクト 別にフィルタリングする場合は、Network Object （ネットワ

ーク オブジェクト）または Type of Device （デバイスのタイプ）を Filter Devices （フィル

タ デバイス）エリアで選択します。 

4. イベント ビュー を 制限 して 特定のタイプのイベントのみを表示する場合は 、適切な 

Event Type （イベント タイプ）を Filter Events（フィルタ イベント）エリアで選択します。 

5. 定期間のイベントのみを 確認 する 場合 は 、次のいずれかのオプションを実行します。 

 定義済みの期間を Time Period （期間）メニューから選択します。 

 Custom （カスタム）を Time Period （期間）メニューから選択し、適切なフィールド

をクリックしてから B egin （開始）と E nd （終了）日時と回数 を入力します 。 

6. Show X Events （X イベントを表示）フィールドで、表示するイベントの 最大 数 を入力

します。 
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7. 既にクリアされているイベントを含む  すべてのイベントを表示する場合は  、Show 

Cleared Events （クリアしたイベントを表示）にチェックを入れます。 

8. Refresh （更新）をクリックして、イベント ビュー設定を完了させます。 

ウェブ コンソールのイベントの確認 

次の手順で示すように、ウェブ コンソールではネットワーク イベントを簡単に承認できます。 

ウェブ コンソールのイベントを承認するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スタート  > す

べてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリックします。 

2. Orion ウェブ コンソールにログインし、Views （ビュー）ツールバーで Events （イベント）を

クリックします。 

3. 表示されたイベントの適切なフィルタリング基準を入力します。詳細については、273 ペー

ジの「ウェブ コンソールの Event Details （イベントの詳細）を表示 」を参照してください。 

4. Refresh （更新）をクリックし、選択された表示基準がすべて有効になっていることを確認

します。 

5. 各イベントをチェックして承認するか、Select All （すべてを選択）をクリックします。 

6. Clear Selected Events （選択されたイベントのクリア）をクリックします。 
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第 21章 

Orion アドバンスト アラートの使用  –  コア 

アラートは、ネットワーク イベントに対して生成され、突発事象が発生した場合、または監視さ

れるインターフェース、ボリューム、ノードのしきい値を超えた場合にトリガーされます。アラートは、

曜日別、時間別、イベント別に異なる担当者に通知したり、時間、イベント、担当者の任意

の組み合わせで通知するように設定できます。次に示す複数の媒体を通じて、担当者に緊急

イベントを知らせるようにアラートを設定できます。 

  電子メールまたは呼び出しの送信 

  Orion Network Performance Monitor サーバーでのサウンド再生 

  アラートの詳細をファイルにログ記録 

  アラートの詳細を Windows イベント ログにログ記録 

  アラートの詳細の NetPerfMon イベント ログへの記録 

  Syslog メッセージの送信 

  外部プログラムの実行 

  Visual Basic スクリプトの実行 

  ウェブ ページのメール送信 

  テキスト音声変換出力の再生 

  Windows Net メッセージの送信 

  呼び出しまたは SMS サービスのダイヤル 

  SNMP トラップの送信 

  ウェブ サーバーへの URL の取得および投稿 

アドバンスト アラートの作成と設定 

Orion NPM でユーザーは、アドバンスト アラートの次の機能を設定できます。 

  持続したステータスのトリガーとリセット条件 

  複数の条件の一致 

  自動アラート エスカレーション 

  トリガーとリセットの別々のアクション 
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アドバンスト アラートは、次のセクションで説明されるように、アドバンスト アラート マネージャで

設定されます。 

注記： 指定時間が設定されるアラートのチェック、遅延アラート トリガー、またはアラート抑制と

いったアドバンスト アラート機能を設定するには、Advanced Alert （アドバンスト アラート）ウィ

ンドウの左下で Show Advanced Features （拡張機能を表示）にチェックを入れます。こ

の文書では、Show Advanced Features （拡張機能を表示）が常に有効となります。 

新しいアドバンスト アラートの作成 

次の手順で新しいアドバンスト アラートを作成します。 

新しいアドバンスト アラートを作成するには： 

1. Start > SolarWinds Orion > Alerting, Reporting, and Mapping > Advanced 

Alert Manager （スタート > SolarWinds Orion > アラート、レポートおよびマッピング > 

アドバンスト アラート マネージャ）の順にクリックします。 

2. View > Configure Alerts （ビュー > アラートの設定）をクリックします。 

 

 

3. New （新規）をクリックします。 
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Edit Alert （アラートの編集）ウィンドウが表示され、編集可能な多数のアラート オプションが

提供されます。オプションには、トリガーとリセット条件、抑制、そして日付と時間の制限が含ま

れます。次のセクションでは、アラートの設定オプションの詳細について説明します。 

アドバンスト アラートの名前付け、説明、有効化 

アドバンスト アラートに名前を付け、説明を行うには、Manage Alerts （アラート管理）ウィンド

ウから New （新規）をクリックし、さらに Copy （コピー）または Edit （編集）をクリックしてから、

次の手順を実行します。 

アドバンスト アラートに名前を付けて説明するには： 

1. Start > SolarWinds Orion > Alerting, Reporting, and Mapping > 

Advanced Alert Manager （スタート > SolarWinds Orion > アラート、レポートおよ

びマッピング > アドバンスト アラート マネージャ）の順にクリックします。 

2. View > Configure Alerts （ビュー > アラートの設定）をクリックします。 

3. 新しいアラートを作成する場合は、New （新規）をクリックします。 

4. 既存のアラートをコピーまたは編集する場合は、リストからアラートを選択し、必要に応じ
て Copy （コピー）または Edit （編集）をクリックします。 

 

 

5. General （一般）をクリックし、Name of Alert （アラート名）フィールドでアラートの名前

を入力します。また説明フィールドでアラートの説明を入力します。 
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6.  Enable this Alert （このアラートを有効にする）にチェックを選択します。 

 

 

7.  Alert Evaluation Frequency （アラートの評価頻度）を入力し、リストから Seconds 

（秒）、Minutes （分）、Hours （時間）を選択してアラートのチェック間隔を設定します。 
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8. Trigger Condition （トリガー条件）をクリックし、アラートのトリガー条件を設定します。

詳細については、279 ページの「アドバンスト アラートのトリガー条件の設定」を参照してく

ださい。 

 

アドバンスト アラートのトリガー条件の設定 

次の方法で、アドバンスト アラートをトリガーする条件を指定できます。 

注記： 選択されたネットワーク オブジェクトでネットワーク条件の指定を行うためにアラート トリ

ガー条件を適切に定義すると、アラート抑制条件の設定が不要になります。SolarWinds は、

ユーザーが可能な場合、抑制条件ではなく特定のトリガー条件を適正に使用してアラートを

定義することを推奨します。条件定義の詳細については、288 ページの「条件グループの理

解」を参照してください。 

アドバンスト アラートのトリガー条件を設定には： 

1. Start > SolarWinds Orion > Alerting, Reporting, and Mapping > Advanced 

Alert Manager （スタート > SolarWinds Orion > アラート、レポートおよびマッピング > 

アドバンスト アラート マネージャ）をクリックします。 

2. View > Configure Alerts （ビュー > アラートの設定）をクリックします。 

3. 新しいアラートを作成する場合は、New （新規）をクリックします。 

4. 既存のアラートをコピーまたは編集する場合は、リストからアラートを選択し、必要に応じ
て Copy （コピー）または Edit （編集）をクリックします。 

5. Trigger Condition （トリガー条件）をクリックします。 
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6. リストで Type of Property to Monitor （監視するプロパティ タイプ）を選択します。 

注記： 次の画像は、Orion Network Performance Monitor インストレーションのスク 

リーン キャプチャです。その他のモジュールも同様の見た目ですが、異なるオブジェクトが表

示される場合があります。 

 

 

7. Custom SQL Alert （カスタム SQL アラート）を選択する場合、次の手順を実行し 

ます。 

a. Set up your Trigger Query （トリガー クエリーの設定）フィールドでアラートするオ

ブジェクトを選択します。 

b. カスタム SQL を、フィールド内の選択したオブジェクトの下に入力します。 

c. このアラートのトリガーを遅らせる場合は、希望するアラート トリガーの遅延の値と単

位を入力します。 

d. 入力した SQL を確認する場合は、Validate SQL （SQL を検証）をクリックします。 

8. 監視されたオブジェクトのタイプを選択する場合は、次の手順を実行します。 

a. テキスト フィールドでトリガー条件を生成するには、リンクされたコンテキスト メニューで

適切な説明を選択し、テキストフィールドの左側の Browse （参照） ( … ) をクリッ

クします。 

b. リンクされたテキストをクリックして適用する条件の数を選択します（all （すべて） any 

（一部）、none（なし）、not all（一部なし））。リンクテキスト条件の詳細については、

288ページの「条件グループの理解」を参照してください。 
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c. Browse （参照） (…) をクリックして、次の条件オプションを表示します。 

注記： has changed （変更済み）条件は Last Boot （最終ブート）、IOS 

Version （IOS バージョン）、IOS Image Family （IOS イメージ ファミリー）デバイ

スの特性にのみ有効です。 

 

 

 デバイス ステータスの比較に基づいた条件を生成するには、Add a Simple 

Condition （シンプル条件を追加）をクリックします。 

 

 

 デバイス フィールドの比較に基づいた条件を生成するには、Add a Complex 

Condition （複雑な条件を追加）をクリックします。 

 より多くの条件を定義するには、Add a Condition Group （条件グループを

追加）をクリックします。 

 選択された条件を削除するには、Delete Current Condition （現在の条件

を削除）をクリックします。 

 条件の順序を変更するには、必要に応じて Move Down （下に移動）か 

Move Up （上に移動）をクリックします。 

d. さらに条件が必要な場合は、Browse （参照） (…) をクリックしてから、必要に応じ

て、追加する条件に対して Add ConditionType （条件のタイプを追加）をクリックし

ます。 

e. 条件を削除するには、削除する条件の横の Browse （参照） (…) をクリックして、

Delete Current Condition （現在の条件を削除）をクリックします。 
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注記： 

 条件を他のアラートで使用するためにエクスポートするには、Export 

Conditions （条件のエクスポート）をクリックして、必要に応じて保存します。 

 他のアラートから既存の条件をインポートするには、Import Conditions （条

件をインポート）をクリックします。インポートされたトリガー条件は、既存のトリ 

ガー条件を自動で上書きします。 

f. 有効にさせる条件の期間を指定するには、間隔を入力してから、Seconds （秒）、

Minutes （分）、Hours （時間）をリストから入力します。 

注記： アラート トリガー アクションを、条件が一定期間抑制されるまで遅延させる必

要がある場合があります。たとえば、CPU 負荷に基づいたアラートは、ノードの CPU 

負荷が 10 分間以上のあいだ 80% 以上になるまではトリガーされません。抑制ス 

テータスのトリガー条件を設定するには、Trigger Condition （トリガー条件）タブの

下の部分で、アラート エンジンが、アクションが実行される前に待機する時間を入力

します。デフォルトでは、（トリガー条件が存在する場合）アラートはすぐにトリガーされ

ます。アラート アクション最大遅延はトリガー条件が満たされてから 8 時間です。 

g. アドバンスト アラートの設定を終了したら、OK をクリックします。 

アドバンスト アラートのリセット条件の設定 

次の手順でアドバンスト アラートのリセットの指定条件を設定します。 

アドバンスト アラートをリセットする条件を設定するには： 

1. Start > SolarWinds Orion > Alerting, Reporting, and Mapping > Advanced 

Alert Manager （スタート > SolarWinds Orion > アラート、レポートおよびマッピング > ア

ドバンスト アラート マネージャ）をクリックします。 

2. View > Configure Alerts （ビュー > アラートの設定）をクリックして、New （新規）をク

リックするか、リストからアラートを選択します。そのあと Copy （コピー）または Edit （編

集）をクリックします。 

3. Reset Condition （条件のリセット）をクリックします。 

4. トリガー条件が存在しない時にシンプルなアラート リセットを行う場合、Reset when 

trigger conditions are no longer true （トリガー条件が true でない時にリセット）

を選択します。 

5.  条件アラートのリセットを行う場合、select Reset this alert when the following 

conditions are met （次の条件を満たしたときにこのアラートをリセット）を選択します。 

注記： テキスト フィールドでリセット条件を生成するには、リンクされたコンテキスト メニューで

適切な説明を選択し、Browse （参照） (…) をクリックします。 
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6. Trigger Condition （トリガー条件）タブで用いた条件をコピーするには、Copy From 

Trigger （トリガーからコピー）をクリックします。 

7. 適用する条件の数を選択するには、リンクされたテキストをクリックします。詳細については、

288ページの「条件グループの理解」を参照してください。 

8. Browse （参照） (…) をクリックして、次の条件オプションを表示します。 

 デバイス  ステータスの比較に基づいた条件を生成するには、Add a Simple 

Condition （シンプル条件を追加）をクリックします。 

 デバイス フィールドの比較に基づいた条件を生成するには、Add a Complex 

Condition （複雑な条件を追加）をクリックします。 

 アプリケーションの条件を定義するには、Add a Condition Group （条件グループ

を追加）をクリックします。 

 選択された条件を削除するには、Delete Current Condition （現在の条件を削

除）をクリックします。 

 条件の順序を変更するには、Move Down （下に移動）か Move Up （上に移

動）をクリックします。 

9. 追加の条件が必要な場合は、Add （追加）をクリックし、追加する条件のタイプを選択し

ます。 

10. 条件を削除する必要がある場合は、条件リストから条件を選択して Delete （削除）をク

リックします。 

注記： 

 条件を他のアラートで使用するためにエクスポートするには、Export Conditions 

（条件のエクスポート）をクリックして、必要に応じて保存します。 

 条件を他のアラートから現在のアラートにインポートするには、Import Conditions 

（条件のインポート）をクリックします。 

警告： インポートされたトリガー条件は、既存のトリガー条件を自動で上書きします。 

 リセット条件がトリガー条件と逆、または非常に似ている状況が多くあるため、

SolarWinds はトリガー条件をリセット条件にコピーする機能を提供しています。

Copy From Trigger （トリガーからコピー）をクリックし、トリガー条件を追加します。 

11. 条件の有効期間を指定するには、間隔を入力してから、Seconds （秒）、Minutes 

（分）、Hours （時間）をリストから入力します。 
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注記： 条件が一定期間抑制されるまで、アラート リセット アクションを遅延させる必要が

ある場合があります。たとえば、ノード ステータスに基づいたアラートは、ノードが 5 分以上

アップされるまでリセットしません。抑制ステータスのリセット条件を設定するために、Reset 

Condition （リセット条件）タブの下の部分で、アラート エンジンが、いずれかのアクションが

実行される前に待機する時間の適切な間隔を入力します。デフォルトの設定では、（リ 

セット条件がある場合は）アラートをすぐにリセットします。トリガー条件が最初に作成され

た時と、アラート アクションへの一致が実行される時の間の最大間隔は 8 時間になります。 

12. アドバンスト アラートの設定を終了したら、OK をクリックします。 

アドバンスト アラートの抑制の設定 

次の手順で、アドバンスト アラートを抑制するための条件を指定できます。 

注記： 

 Alert Suppression （アラート抑制）は、Edit Advanced Alert （アドバンスト アラートの

編集）ウィンドウの左端にある Show Advanced Features （拡張機能の表示）が 

チェックされている場合にのみ利用できます。 

 多くの場合、抑制条件がネットワーク上のすべての監視されたオブジェクトに対してチェック

されていることから、アラート トリガー条件を適性に定義すると、アラート抑制の必要がなく

なる場合があります。アラート トリガー条件の定義の詳細については、286 ページの「アド

バンスト アラートのトリガー アクションを設定」、および 288 ページの「条件グループの理

解」を参照してください。 

アドバンスト アラート抑制の条件を設定するには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Advanced Alert Manager （スタート > すべてのプログラム > SolarWinds 

Orion > アラート、レポートおよびマッピング > アドバンスト アラート マネージャ）をクリックし 

ます。 

2. View > Configure Alerts （ビュー > アラートの設定）をクリックします。 

3. New （新規）をクリックするか、リストからアラートを選択します。 

4. 必要に応じて Copy （コピー）または Edit （編集）をクリックします。 

5. Alert Suppression （アラート抑制）をクリックします。 

注記： テキスト フィールドで抑制条件を生成するには、リンクされたコンテキスト メニューで適

切な説明を選択し、テキストフィールドの左側の Browse （参照） ( … ) をクリックします。 

6. Trigger Condition （トリガー条件）タブで用いた条件をコピーするには、Copy From 

Trigger （トリガーからコピー）をクリックします。 
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7. リンクされたテキストをクリックして適用する条件の数を選択します（all （すべて） any （一

部）、none （なし）、not all （一部なし））。リンクテキスト条件の詳細については、288

ページの「条件グループの理解」を参照してください。 

8. Browse （参照） (…) をクリックして、次の条件オプションを表示します。 

 デバイス  ステータスの比較に基づいた条件を生成するには、Add a Simple 

Condition （シンプル条件を追加）をクリックします。 

 デバイス フィールドの比較に基づいた条件を生成するには、Add a Complex 

Condition （複雑な条件を追加）をクリックします。 

 アプリケーションの条件を定義するには、条件グループを追加 をクリックします。 

 選択された条件を削除するには、Delete Current Condition （現在の条件を削

除）をクリックします。 

 条件の順序を変更するには、Move Down （下に移動）か Move Up （上に移

動）をクリックします。 

9. 追加の条件が必要な場合は、Add （追加）をクリックし、追加する条件のタイプを選択し

ます。 

10. 条件を削除する必要がある場合は、条件リストから条件を選択して Delete （削除）をク

リックします。 

注記：  条件を他のアラートで使用するためにエクスポートするには、Export 

Conditions （条件のエクスポート）をクリックして、必要に応じて保存します。条件を他の

アラートから現在のアラートにインポートするには、Import Conditions （条件のインポー

ト）をクリックします。 

警告： インポートされたトリガー条件は、既存の条件を自動で上書きします。 

11. アドバンスト アラートの設定を終了したら、OK をクリックします。 

アドバンスト アラートの監視期間の設定 

ユーザーは次の手順で、アドバンスト アラートがネットワーク オブジェクトを監視する特定の期

間と日数を選択できます。 

アドバンスト アラートを監視する期間と日数を設定するには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Advanced Alert Manager （スタート > すべてのプログラム > SolarWinds 

Orion > アラート、レポートおよびマッピング > アドバンスト アラート マネージャ）をクリックし 

ます。 

2. View > Configure Alerts （ビュー > アラートの設定）をクリックします。 
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3. New （新規）をクリックするか、リストからアラートを選択します。 

4. Copy （コピー）または Edit （編集）をクリックします。 

5. Time of Day （時間帯）をクリックします。 

6. ネットワークを監視する期間を入力します。 

注記： アラートは、この期間内にトリガー条件が満たされた場合のみ、トリガーされます。 

7. ネットワークを監視する日数を選択します。 

注記： アラートは、選択された日数内にトリガー条件が満たされた場合のみ、トリガーされ

ます。 

8. アドバンスト アラートの設定を終了したら、OK をクリックします。 

アドバンスト アラートのトリガー アクションを設定 

アドバンスト アラートがトリガーされるときに発生するアクションを、次のように選択します。 

アドバンスト アラートのトリガー アクションを設定するには： 

1. Start > SolarWinds Orion > Alerting, Reporting, and Mapping > Advanced 

Alert Manager （スタート > SolarWinds Orion > アラート、レポートおよびマッピング > ア

ドバンスト アラート マネージャ）をクリックします。 

2. View > Configure Alerts （ビュー > アラートの設定）をクリックします。 

3. New （新規）をクリックするか、リストからアラートを選択します。そのあと、必要に応じて 

Copy （コピー）または Edit （編集）をクリックします。 

4. Trigger Actions （トリガー アクション）をクリックします。 

5. 新規のアドバンスト アラート アクションを追加する場合は、Add New Action （新しいア

クションを追加）をクリックし、アラートがトリガーするときに発生させたいアクションを選択し 

ます。 

6. 既存のアドバンスト アラート アクションを編集する場合は、既存のアラート アクションを選

択し、さらに Edit Selected Action （選択されたアクションを編集）をクリックします。 

7. 次の手順に従い、各アクションを設定します。 

注記： 選択されたアクションのタイプによっては、アラート アクションを設定するための異な

るオプションが表示されます。各アラート アクションの詳細については、294 ページの「利用

できるアドバンスト アラート アクション」を参照してください。 

8. アクションを削除する必要がある場合は、アクションを選択して  Delete Selected 

Action （選択したアクションの削除）をクリックします。 
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9. アドバンスト アラートの設定を終了したら、OK をクリックします。 

アドバンスト アラートのリセット アクションを設定 

アドバンスト アラートがリセットされるときに発生するアクションを、次の手順で選択します。 

アドバンスト アラートのリセット アクションを設定するには： 

1. Start > SolarWinds Orion > Alerting, Reporting, and Mapping > Advanced 

Alert Manager （スタート > SolarWinds Orion > アラート、レポートおよびマッピング > ア

ドバンスト アラート マネージャ）をクリックします。 

2. View > Configure Alerts （ビュー > アラートの設定）をクリックします。 

3. 必要に応じて、New Alert （新しいアラート）、Copy Alert （アラートのコピー）、または 

Edit Alert （アラートを編集）をクリックします。 

4. Reset Actions （アクションのリセット）をクリックします。 

5. 新規のアドバンスト アラート アクションを追加する場合は、Add New Action （新しいア

クションを追加）をクリックし、アラートがトリガーするときに発生させたいアクションを選択し 

ます。 

6. 既存のアドバンスト アラート アクションを編集する場合は、既存のアラート アクションを選

択し、さらに Edit Selected Action （選択されたアクションを編集）をクリックします。 

7. 次の手順に従い、各アクションを設定します。 

注記： 選択されたアクションのタイプによっては、アラート アクションを設定するための異な

るオプションが表示されます。各アラート アクションの詳細については、294 ページの「利用

できるアドバンスト アラート アクション」を参照してください。 

8. 選択したアクションを削除する必要がある場合は、Delete Selected Action （選択し

たアクションを削除）をクリックします。 

9. アドバンスト アラートの設定を終了したら、OK をクリックします。 
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アラート エスカレーション 

トリガーまたはリセットのアクションを編集するときは、可能な場合は、Alert Escalation （アラー

ト エスカレーション）タブを使用して追加のアラート アクションのオプションを定義します。設定さ

れたアラート アクションによっては、次のいずれかまたはすべてのオプションは Alert Escalation 

（アラート エスカレーション）タブで利用できます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているときにこ

のアクションを実行しない）にチェックを入れます。 

 トリガー条件があるときにアクションを繰り返し実行するには、Execute this Action 

repeatedly while the Alert is Triggered （アラートがトリガーされているときにこのア

クションを繰り返し実行する）にチェックを入れ、適切なアクション実行間隔を入力します。 

 アラート アクションの実行を遅らせるには、Delay the execution of this Action （こ

のアクションの実行を遅延させる）にチェックを入れ、アラート アクションを実行する前に、ア

ラート条件を満たした後にアラート エンジンが待機する適切の間隔を入力します。 

詳細については、314 ページの「エスカレーションしたアドバンスト アラート 」を参照してください。 

条件グループの理解 

条件グループは、ユーザーが定義するアラート トリガーとリセットを制御するルールのセットです。

デフォルトでは、条件グループ  Trigger Alert when all of the following 

apply （次のすべてが適用されたときにアラートをトリガーする）が、新しいアラート トリガーかリ

セット条件が作成された時に追加されます。以下の 4 つの異なる論理記述子を使用して条

件を作成します。all （すべて）、any （一部） none （なし）、not all （一部なし）。all を

クリックして、異なる値を選択できるようにします。次のセクションでは、これらの論理記述子を

説明します。 

すべての条件グループ 

Trigger Alert when all of the following apply （次のすべてが適用されるとき

にアラートをトリガーする）は、アラートがトリガーされる前にグループ内のすべての条件は True 

（真）である必要があります。 

次の例では、条件グループで 3 つの条件があります。 

  ノード ステータスが Up （アップ）と同じ 

  パケット損失率が 75% と同等またはそれ以上 

  CPU 負荷が 85% と同等またはそれ以上 
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このアラートは、ノードが Up （アップ）で、パケット損失が 75% と同等またはそれ以上、そして 

CPU 負荷が 85% と同等またはそれ以上でないとトリガーされません。 

条件グループを all に設定するとき、記述 and で分けられているようにすべての条件を入力

します。つまり、この例では、アラート トリガーは以下を読み取ります。 

Alert when: (Node Status = Up) and (Percent Loss >= 75) and (CPU 

Load >= 85) 

すべての条件グループ 

条件グループを Trigger Alert when any of the following apply （次のいずれ

かが適用された時にアラートがトリガーされる）に変更して、論理を記述 or に変更します。こ

の例では、条件グループを any に変更すると、アラート トリガーが以下に変更します 

Alert when: (Node Status = Up) or (Percent Loss >= 75) or (CPU 

Load >= 85) 

この状況では、3 つの条件の いずれか が True （真）になった場合、アラートはトリガーされます。 

None （なし）の条件グループ 

条件グループを Trigger Alert when none of the following apply （次のいず

れも適用しないときにアラートをトリガーする）に変更する場合は、アラートがトリガーされる前に

グループ内のすべての条件が False （偽）である必要があります。 

この例では、アラート トリガーは以下を読み取ります。 

Alert when: (Node Status = Down) and (Percent Loss <= 75) and 
(CPU Load <= 85) 

各条件は記述 and で分けられています。これは all 条件グループと同様です。しかし、これ

らの条件は反転されています（Node Status = Up の代わりに Node Status = Down）。 

Not All （一部なし）の条件グループ 

条件グループを Trigger Alert when not all of the following apply （次の

一部のみが適用するときにアラートをトリガーする）に変更する場合は、アラートがトリガーされ

る前にグループ内の一部の条件が False （偽）になります。つまり、この例では、アラート トリガ

ーは以下を読み取ります。 

Alert when: (Node Status = Down) or (Percent Loss <= 75) or (CPU 

Load <= 85) 

各条件は記述 or で分けられています。これは any 条件グループと同様です。しかし、これら

の条件は反転されています（Node Status = Up の代わりに Node Status = Down）。 
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アドバンスト アラート マネージャの使用 

アドバンスト アラート マネージャはネットワーク イベントとアラートを表示するために使用されるイ

ンターフェースです。アドバンスト アラート マネージャを使用して、アドバンスト アラートを作成、

管理することもできます。以下の手順では、アドバンスト アラート マネージャの主要な機能であ

るアドバンスト アラートの設定と表示について説明します。 

現在のイベント ウィンドウ 

Advanced Alert Manager （アドバンスト アラート マネージャ）の Current Events （現在の

イベント）ウィンドウは、イベント ログからの説明とその他の情報と一緒に、最新のネットワーク イ

ベントを表示します。 

Current Events （現在のイベント）ウィンドウを使用してネットワーク イベントを表示するには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Advanced Alert Manager （スタート > すべてのプログラム > SolarWinds 

Orion > アラート、レポートおよびマッピング > アドバンスト アラート マネージャ）をクリックし 

ます。 

2. View > Current Events （ビュー > 現在のイベント）をクリックします。 

3. 次のいずれかの Group By （グループ別）基準から 1 つを選択し、イベントをグループ化

します。Event Type （イベント タイプ）、Object Type （オブジェクト タイプ）、Network 

Node （ネットワーク ノード）、Acknowledged （承認済み）、No Grouping （グルー

プなし）。 

4. Current Events （現在のイベント）ウィンドウで表示できるカテゴリー コラムを変更する
場合は、Include （追加する）をクリックして、次の手順を実行します。 

a. Event View Columns （イベント ビュー コラム）タブをクリックして、列 ID を All 

Columns （すべてのコラム）フィールドから選択します。 

b. 右矢印をクリックしてコラム ID を Selected Columns （選択されたコラム）フィール

ドに移動します。 

c. Selected Columns （選択されたコラム）フィールドに表示したくないコラム ID があ
る場合は、それらの ID を選択してから左矢印を選択し、All Columns （すべての

コラム）フィールドに移動させます。 

d. 上下の矢印をクリックし、選択されたコラムの順番を変更します。 

e. スライダーの位置を調整して、Event View （イベント ビュー）の更新レートを設定し

ます。 
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f. Event View （イベント ビュー）の XXXX イベントの最大数を表示フィールドで確認

するイベント数を入力します。 

g. Current Events View （現在のイベント ビュー）の設定が終了している場合は、
OK をクリックします。 

5. Current Events （現在のイベント）ウィンドウの最新イベントとコラム ID をアップデートす

る場合は、Refresh （更新）をクリックします。 

6. ネットワーク イベントを承認する場合は、イベントの横の X をクリックします。 

アクティブ アラート ウィンドウ 

Advanced Alert Manager （アドバンスト アラート マネージャ）の Active Alerts （アクティブ 

アラート）ウィンドウでは、ネットワーク アラートがアラート ログからの説明とその他の情報と一緒

に表示されます。 

アクティブ アラート ウィンドウでアクティブ ネットワーク アラートを使用するには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Advanced Alert Manager （スタート > すべてのプログラム > SolarWinds 

Orion > アラート、レポートおよびマッピング > アドバンスト アラート マネージャ）をクリックし 

ます。 

2. View > Active Alerts （ビュー > アクティブ アラート）をクリックします。 

3. 次のいずれかの Group By （グループ別）基準から 1 つを選択し、アラートをグループ化

します。Alert Name （アラート名）、Object Type （オブジェクト タイプ）、Object 

Name （オブジェクト名）、Alert State （アラート ステータス）、Acknowledged （承認

済み）、Acknowledged By （確認者）または No Grouping （グループなし）。 

4. Include （追加する）をクリックして、表示するアラートのタイプにチェックを入れます。

Acknowledged （承認済み）、Trigger Pending （トリガー保留）、Triggered （トリ

ガー済み）または Reset Pending （保留のリセット）。 

5. Current Events （現在のイベント）ウィンドウで表示できるカテゴリー コラム」を変更する
場合は、Include > Select Alert Columns （追加 > アラート コラムの選択）をクリッ

クして、次の手順を実行します。 

a. All Columns （すべてのコラム）フィールドからコラム ID を選択します。 

b. 右矢印をクリックしてコラム ID を Selected Columns （選択されたコラム）フィール

ドに移動します。 

c. Selected Columns （選択されたコラム）フィールドに表示したくないコラム ID があ
る場合は、それらの ID を選択してから左矢印を選択し、All Columns （すべての

コラム）フィールドに移動させます。 
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d. 上下の矢印をクリックし、選択されたコラムの順番を変更します。 

e. スライダーの位置を調整して、Alert View （アラート ビュー）の更新レートを設定し 

ます。 

f. Active Alerts View （アクティブ アラート ビュー）の設定を終了したら、OK をクリッ

クします。 

6. Active Alerts （アクティブ アラート）ウィンドウの最新アラートとコラム ID をアップデートする

には、Refresh （更新）をクリックします。 

7. 個々のアラートの設定を変更するには、Configure Alerts （アラートの設定）をクリックし

ます。詳細については、273 ページの「ネットワーク イベントの監視  –  コア 」を参照してく

ださい。 

8. アクティブ アラートを承認するには、Acknowledged （承認済み）コラムでアラートに 

チェックを入れます。 

注記： アラートが承認されるとすぐに、ユーザー情報と日時 / 回数がデータベースに記録

されます。 

アラート ビューの設定 

Orion Advanced Alert Manager （アドバンスト アラート マネージャ）のアラート ビューは、以

下の手順で示される通りに、Alert Viewer Settings （アラート ビューア設定）で設定されます。 

アドバンスト アラート マネージャでアラート ビューを設定するには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Advanced Alert Manager （スタート > すべてのプログラム > SolarWinds 

Orion > アラート、レポートおよびマッピング > アドバンスト アラート マネージャ）をクリックし 

ます。 

2. File > Settings （ファイル＞設定）をクリックします。 

注記： Alert Viewer Settings （アラート ビューア設定）ウィンドウの Configure Alerts 

（アラートの設定）タブは、利用可能なすべてのネットワーク アラートを表示し、さらにこのウ

ィンドウからアラートの作成、コピー、編集、削除が可能です。詳細については、275 ペー

ジの「アドバンスト アラートの作成と設定」を参照してください。 

3. Alert View Columns （アラート ビュー コラム）をクリックします。 

4. All Columns （すべてのコラム）リストのアラートについて表示する情報のタイトルを選択

します。 

5. 右矢印をクリックし、Selected Columns （選択したコラム）リストへ転送します。 

注記： Selected Columns （選択したコラム）リストでは、Alert Viewer （アラート ビュー

ア）が各アクティブ アラートについて表示するすべての情報のリストを提供します。 
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6. Selected Columns （選択したコラム）リストからタイトルを削除する場合は、
Selected Columns （選択したコラム）リストのアクティブ ビューから削除するタイトルを

選択して、左矢印をクリックします。 

7. 異なるアラート情報を Alert Viewer （アラート ビューア）で表示させる順番を並べ替え
るには、Selected Columns （選択したコラム）リストからタイトルを選択し、上下矢印を

使用してタイトルの配置を変更します。 

8. タブの一番下でスライダーの位置を調整し、Alert View （アラート ビュー）の更新レートを

設定します。 

9. Event View Columns （イベント ビュー コラム）をクリックします。 

10. All Columns （すべてのコラム）リストのイベントについて表示する情報のタイトルを選択

します。 

11. 右矢印をクリックし、Selected Columns （選択したコラム）リストへ転送します。 

注記： Selected Columns （選択したコラム）リストでは、Alert Viewer （アラート ビュー

ア）が記録された各イベントについて表示するすべての情報のリストを提供します。 

12. Selected Columns （選択したコラム）リストからタイトルを削除する場合は、
Selected Columns （選択したコラム）リストのアクティブ ビューから削除するタイトルを

選択して、左矢印をクリックします。 

13. 異なるイベント情報を Alert Viewer （アラート ビューア）で表示させる順番を並べ替え
るには、Selected Columns （選択したコラム）リストからタイトルを選択し、上下矢印を

使用してタイトルの配置を変更します。 

14. タブの一番下でスライダーの位置を調整して、Event View （イベント ビュー）の更新レー

トを設定します。 

15. Event View （イベント ビュー）で、確認するイベントの数を入力します。 

アラート アクションの追加 

Orion Network Performance Monitor は、ネットワークでアラート条件を発するさまざまなア

クションを提供します。これらのアラート アクションは基本およびアドバンスト アラートの双方で

利用可能です。また、次の手順でネットワーク用に定義したアラート条件へのアクションを割り

当てます。 

アラート アクションを追加するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance 

Monitor > System Manager （スタート  > すべてのプログラム   > SolarWinds 

Orion > Network Performance Monitor > システム マネージャ）の順でクリックします。 
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2. Alerts> Active Alerts （アラート ?> アクティブ アラート）の順でクリックし、Configure 

Basic Alerts （基本アラートの設定）または Configure Advanced Alerts （アドバ

ンスト アラートの設定）のいずれかをクリックします。 

3. アクションをトリガーするにはアラートに選択して、Edit Alert （アラートの編集）をクリックし

ます。 

4. Actions （アクション）をクリックして、編集するアクションを選択します。 

5. Add Alert Action （アラート アクションの追加）をクリックして、選択したアラートに追加

するアクションをクリックします。 

各アラート アクションの詳細については、294ページの「利用できるアドバンスト アラート アクシ

ョン」を参照してください。 

利用できるアドバンスト アラート アクション 

次のセクションでは、利用可能なアラート アクションの設定を説明します。 

 電子メールまたは呼び出しの送信 

 サウンドの再生 

 アドバンスト アラートのファイルへのログ 

 アドバンスト アラートの Windows イベント ログへのログ 

 アドバンスト アラートの NetPerfMon イベント ログへのログ 

 Syslog メッセージの送信 

 外部プログラムの実行 

 Visual Basic スクリプトの実行 

 ウェブ ページの電子メール送信 

 テキスト音声変換出力の使用 

 Windows Net メッセージの送信 

 SNMP トラップの送信 

 GET または POST URL 機能の使用 

 ページングへのダイヤルまたは SMS サービス  
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電子メールまたは呼び出しの送信 

次の手順で、電子メールまたは呼び出しのアクションのアドバンスト アラートを設定します。 

注記： 

 アラートをトリガーするために設定したポーリング エンジンが SMTP サーバーにアクセスでき

ることを確認します。 

 電子メールと呼び出しはテキスト形式で送信されます。 

電子メール / 呼び出しのアクション用のアドバンスト アラートを設定するには： 

1. E-mail/Pager Addresses （電子メール / ポケットベルのアドレス）をクリックしてから、

To （宛先）、CC 、BCC 、Name （名前）、Reply Address （返信先アドレス）フィー

ルドを入力します。 

注記： To （宛先）フィールドで少なくとも 1 つの電子メールアドレスを入力する必要があり

ます。また複数のアドレスは、コンマで区切って入力します。一部のページ システムでは、

ページを完了させるために、返信可能なメールアドレスを要求します。 

2. Message （メッセージ）をクリックしてから、メールの形式を選択します ( Plain text （テキ

スト）または HTML ) 。 

3. アラート トリガーの電子メール / 呼び出しの Subject （件名）と Message （メッセージ）

を入力します。 

注記： Subject （件名）と Message （メッセージ）フィールドが空の場合、メッセージの

送信はできません。 

4. 変数を Subject または Message フィールドに挿入する場合は、新しい変数の場所を
クリックして次の手順を実行します。 

a. Insert Variable （変数を挿入）をクリックします。 

b. Variable Category （変数カテゴリ）を選択してから、追加する変数を選択します。 

c. パーサーを変更する場合は、Change Parser （パーサーの変更）にチェックを入れ

て使用するパーサーを選択します。 

d. SQL 変数を定義してクリップボードにコピーする場合は、Define SQL Variable 

（SQL 変数の定義）にチェックを入れ、Insert Variable From Above List （上

記リストから変数を挿入）をクリックします。 

e. Build Selected Variable （選択した変数をビルド）をクリックします。 

注記： 変数の使用の詳細については、431ページの「Orion NPM 変数と例」を参

照してください。変数を使用するメッセージの詳細については、440 ページの「変数を

使用するメッセージの例」を参照してください。 
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5. SMTP Server （ SMTP サーバー）をクリックします。 

6. SMTP サーバーのホスト名または IP アドレス 、および指定した SMTP ポート番号 を入

力します。 

注記： SMTP サーバーのホスト名と IP アドレスのフィールドを入力する必要があります。

SMTP サーバーを同定せずに電子メール / 呼び出しを送信することはできません。 

7. アラート メールに SSL/TLS 暗号を使用する場合は、Enable SSL （SSL を有効化）

にチェックを入れます。 

8. ご利用の SMTP サーバーが認証を必要とする場合、This SMTP Server requires 

Authentication （この SMTP サーバーは認証を必要とする）にチェックを入れます。 

9. Time of Day （時間帯）をクリックします。 

10.  アラート アクションをアーカイブする期間を入力してから、アラート アクションをアーカイブし

たい日数を選択します。 

11. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーション）

タブをクリックし、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件があるときにアクションを繰り返し実行するには、Execute this Action 

repeatedly while the Alert is Triggered （アラートがトリガーされているときに

このアクションを繰り返し実行する）にチェックを入れ、適切なアクション実行間隔を入

力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れ、アラート アクションが

実行される前にアラート条件が満たされた場合にアラート エンジンが待機する必要

のある適切な間隔を入力します。 

12.  電子メール / 呼び出しアラート アクションの設定を完了したら、OK をクリックします。 
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サウンドの再生 

アラート トリガーまたはリセット時のサウンドを再生するために Orion を設定できます。次の手

順で、アドバンスト アラートのサウンド再生を設定します。 

注記： Windows サービスのアプリケーションへの制限により、Play a Sound action （サウンド 

アクションの再生）は Windows 7 または Windows Server 2008 以降での Orion インス 

トールではご利用になれません。 

アドバンスト アラートのサウンド再生アクションを設定するには： 

1. Play Sound （サウンドを再生）をクリックします。 

2. 以下のどちらかを Sound file to play （再生するサウンド ファイル）フィールドで実行し、

アラート トリガーのサウンド ファイルを指定します。 

 完全なディレクトリ パスとファイル名を入力します。 

 Browse (…) （参照）をクリックし、ファイル システムを移動させてから、ターゲット ファ

イルを選択します。 

3. テキスト フィールドの右側の音符ボタンをクリックし、指定したサウンド ファイルをテストし 

ます。 

4. Time of Day （時間帯）をクリックします。 

5. アラート アクションをアーカイブする期間を入力してから、アラート アクションをアーカイブした

い日数を選択します。 

6. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーショ

ン）をクリックし、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件があるときにアクションを繰り返し実行するには、Execute this Action 

repeatedly while the Alert is Triggered （アラートがトリガーされているときに

このアクションを繰り返し実行する）にチェックを入れ、適切なアクション実行間隔を入

力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れ、アラート アクションが

実行される前にアラート条件が満たされた場合にアラート エンジンが待機する必要

のある適切な間隔を入力します。 

7. アラート アクション用サウンドの再生の設定を終了した場合、OK をクリックします。 
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アドバンスト アラートのファイルへのログ 

アラートを希望するファイルへログするように Orion を設定できます。次の手順でアドバンスト ア

ラートを希望するファイルへログします。 

アドバンスト アラートのアラート ログファイルを設定するには： 

1. Event Log （イベント ログ）をクリックしてから、Alert Log Filename （アラート ログ ファ

イル名）フィールドで次のいずれかを行ってアラート ログ ファイルを指定します。 

注記： 指定したファイルが存在しない場合は、ファイルは作成され、最初のアラートが実

行されます。 

 完全なパスとターゲット ファイルの名前を入力します。 

 Browse (…) （参照）をクリックし、ファイル システムを移動させてから、ターゲット ファ

イルを選択します。 

2. アラート ログファイルにログしたいメッセージを Message （メッセージ）フィールドで入力し 

ます。 

3. 変数を Message （メッセージ）フィールドに挿入する場合は、次の手順を実行します。 

a. Insert Variable （変数を挿入）をクリックして、Variable Category （変数カテゴ

リ）を選択します。 

b. 追加する変数を選択します。 

c. パーサーを変更する場合は、Change Parser （パーサーの変更）にチェックを入れ

て使用するパーサーを選択します。 

d. SQL 変数を定義してクリップボードにコピーする場合は、Define SQL Variable 

（SQL 変数の定義）にチェックを入れ、Insert Variable From Above List （上

記リストから変数を挿入）をクリックします。 

e. Build Selected Variable （選択した変数をビルド）をクリックします。 

注記： 変数を使用する詳細については、431 ページの「Orion NPM 変数と例」を

参照してください。 

4. Time of Day （時間帯）をクリックします。 

5. アラート アクションを有効化する期間を入力します。 

6. アラート アクションを有効化する日数を選択します。 
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7. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーション）

タブをクリックし、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件があるときにアクションを繰り返し実行するには、Execute this Action 

repeatedly while the Alert is Triggered （アラートがトリガーされているときに

このアクションを繰り返し実行する）にチェックを入れ、適切なアクション実行間隔を入

力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れ、アラート アクションが

実行される前にアラート条件が満たされた場合にアラート エンジンが待機する必要

のある適切な間隔を入力します。 

8. アドバンスト アラートの設定を終了したら、OK をクリックします。 

アドバンスト アラートの Windows イベント ログへのログ 

Orion サーバーか、リモート サーバー上で Windows イベントログに記録されるアラートを指定

する必要があります。次の手順で、指定サーバー上の Windows イベントログにアドバンスト 

アラートを記録します。 

アドバンスト アラートを設定して Windows イベント ログに記録するには： 

1. Windows Event Log （Windows イベント ログ）をクリックします。 

2. Orion サーバー上の Windows イベントログにアラートを書き込む場合、Use Event 

Log Message on Network Performance Monitor Server （ Network 

Performance Monitor サーバーでイベントログ メッセージを使用する）を選択します。 

3. リモート サーバー上の Windows イベントログにアラートを書き込む場合、Use Event 

Log Message on a Remote Server （リモート サーバーで Windows イベントログ  

メッセージを使用する）を選択し、リモートサーバー名か IP アドレス を入力します。 

4. Windows イベント ログにログするメッセージを  Message に入力して、Windows 

Event Log （ Windows イベントログ）フィールドに送信します。 

5. 変数を Message （メッセージ）フィールドに挿入する場合は、次の手順を実行します。 

a. Insert Variable （変数を挿入）をクリックします。 

b. Variable Category （変数カテゴリ）を選択します。 

c. 追加する変数を選択します。 
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d. パーサーを変更する場合は、Change Parser （パーサーの変更）にチェックを入れ

て使用するパーサーを選択します。 

e. SQL 変数を定義してクリップボードにコピーする場合は、Define SQL Variable 

（SQL 変数の定義）にチェックを入れ、Insert Variable From Above List （上

記リストから変数を挿入）をクリックします。 

f. Build Selected Variable （選択した変数をビルド）をクリックします。 

注記： 変数を使用する詳細については、431 ページの「Orion NPM 変数と例」を

参照してください。 

6. Time of Day （時間帯）をクリックします。 

7. 期間を入力し、アラート アクションを有効化する日数を選択します。 

8. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーショ

ン）をクリックし、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件があるときにアクションを繰り返し実行するには、Execute this Action 

repeatedly while the Alert is Triggered （アラートがトリガーされているときに

このアクションを繰り返し実行する）にチェックを入れ、適切なアクション実行間隔を入

力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れ、アラート アクションが

実行される前にアラート条件が満たされた場合にアラート エンジンが待機する必要

のある適切な間隔を入力します。 

9. アドバンスト アラートの設定を終了したら、OK をクリックします。 

アドバンスト アラートの NetPerfMon イベント ログへのログ 

Orion サーバーか、リモート サーバー上で NetPerfMon イベントログへログされるアラートを指

定する必要があります。次の手順で、指定サーバー上の NetPerfMon イベントログへアドバン

スト アラートをログします。 

NetPerfMon イベント ログへログするアドバンスト アラートの設定方法： 

1. NPM Event Log （ NPM イベントログ）をクリックします。 

2. NetPerfMon イベント ログにログするメッセージを Message で入力して、Network 

Performance Monitor イベント ログ フィールドに送信します。 
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3. 変数を Message （メッセージ）フィールドに挿入する場合は、次の手順を実行します。 

a. Insert Variable （変数を挿入）をクリックします。 

b. Variable Category （変数カテゴリ）を選択します。 

c. 追加する変数を選択します。 

d. パーサーを変更する場合は、Change Parser （パーサーの変更）にチェックを入れ

て使用するパーサーを選択します。 

e. SQL 変数を定義してクリップボードにコピーする場合は、Define SQL Variable 

（SQL 変数の定義）にチェックを入れ、Insert Variable From Above List （上

記リストから変数を挿入）をクリックします。 

f. Build Selected Variable （選択した変数をビルド）をクリックします。 

注記： 変数を使用する詳細については、431 ページの「Orion NPM 変数と例」を

参照してください。 

4. Time of Day （時間帯）をクリックします。 

5. 期間を入力し、アラート アクションを有効化する日数を選択します。 

6. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーショ

ン）をクリックし、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件があるときにアクションを繰り返し実行するには、Execute this Action 

repeatedly while the Alert is Triggered （アラートがトリガーされているときに

このアクションを繰り返し実行する）にチェックを入れ、適切なアクション実行間隔を入

力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れ、アラート アクションが

実行される前にアラート条件が満たされた場合にアラート エンジンが待機する必要

のある適切な間隔を入力します。 

7. アドバンスト アラートの設定を終了したら、OK をクリックします。 
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Syslog メッセージの送信 

Orion では、受け取ったアラートを指定したマシンの Syslog にログできます。次の方法でアド

バンスト アラートを設定すると、指定した Syslog サーバーにメッセージを送信できます。 

アドバンスト アラートを設定して Syslog メッセージを送信するには： 

1. Syslog メッセージ をクリックします。 

2. Syslog メッセージを送信する Syslog サーバーのホスト名または IP アドレス を入力し 

ます。 

3. アラート Syslog メッセージの Severity （重要度）を選択します。 

注記： 詳細については、363 ページの「Syslog 重大度」を参照してください。 

4. アラート Syslog メッセージの Facility （機能）を選択します。 

 注記： 詳細については、362 ページの「Syslog 機能」を参照してください。 

5.  送信する Syslog メッセージ を入力します。 

6.  変数を Message （メッセージ）フィールドに挿入する場合は、次の手順を実行します。 

a. Insert Variable （変数を挿入）をクリックします。 

b. Variable Category （変数カテゴリ）を選択します。 

c. 追加する変数を選択します。 

d. パーサーを変更する場合は、Change Parser （パーサーの変更）にチェックを入れ

て使用するパーサーを選択します。 

e. SQL 変数を定義してクリップボードにコピーする場合は、Define SQL Variable 

（SQL 変数の定義）にチェックを入れ、Insert Variable From Above List （上

記リストから変数を挿入）をクリックします。 

f. Build Selected Variable （選択した変数をビルド）をクリックします。 

注記： 変数を使用する詳細については、431 ページの「Orion NPM 変数と例」を

参照してください。 

7.  Time of Day （時間帯）をクリックします。 

8.  アラート アクションを有効化する期間を入力します。 

9.  アラート アクションを有効化する日数を選択します。 
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10. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーショ

ン）をクリックし、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件があるときにアクションを繰り返し実行するには、Execute this Action 

repeatedly while the Alert is Triggered （アラートがトリガーされているときに

このアクションを繰り返し実行する）にチェックを入れ、適切なアクション実行間隔を入

力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れ、アラート アクションが

実行される前にアラート条件が満たされた場合にアラート エンジンが待機する必要

のある適切な間隔を入力します。 

11. Syslog メッセージ送信アクションの設定が終了したら、OK をクリックします。 

外部プログラムの実行 

指定のネットワーク イベントが発生した時にプログラムを実行する状況があります。次の手順で

示すように、Edit Execute Program Action （プログラム アクションの実行を編集）ウィンドウ

を使用して、指定したアラートがトリガーまたはリセットされたときに開始する実行可能ファイルを

指定します。 

注記： このアクション用に選択された外部プログラムは、コマンド ラインからのバッチ ファイルを使

用する実行可能ファイルである必要があります。 

アドバンスト アラートを設定して外部プログラムを実行するには： 

1. Execute Program （実行プログラム）をクリックします。 

2. 完全なパスとターゲット ファイル名を Program to execute （実行するプログラム）フィー

ルドに入力するか、Browse (…) （参照）をクリックしてフォルダ構造を参照し、対象の実

行可能ファイルを選択して、バッチファイルを指定します。 

3. Time of Day （期間）をクリックし、外部プログラムを実行する期間を入力します。 

4. 外部プログラムを実行する日数を選択します。 

5. Alert Escalation （アラート エスカレーション）をクリックし、アラートの必要に応じて、次の

オプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 
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 トリガー条件が満たされたときにアクションを繰り返し実行するには、Execute this 

Action repeatedly while the Alert is Triggered （アラートがトリガーされてい

るときにこのアクションを繰り返し実行する）にチェックを入れ、適切なアクション実行間

隔を入力します。 

 アラート アクションの実行を遅らせるには、Delay the execution of this Action 

（このアクションの実行を遅延させる）にチェックを入れてから、アラート エンジンが待機

する必要のある適切な間隔を入力します。 

6. 外部プログラム実行のアクションの設定を終了したら、OK をクリックします。 

Visual Basic スクリプトの実行 

状況に応じて、ユーザーは、ネットワーク イベント発生時に Visual Basic (VB) スクリプトを実

行する場合があります。Edit Execute VB Script Action （ VB スクリプト アクション実行の

編集）ウィンドウで、指定されたアラートがトリガーまたはリセットされた時に実行されるファイルの

名前と完全なパスを指定します。 

アラートを設定して Visual Basic (VB) スクリプトを実行するための方法： 

1. VB Script （VB スクリプト）をクリックします。 

2. 利用可能な VB Script Interpreter （VB スクリプト インタープリタ）を選択します。 

3. 完全なパスと VB スクリプト名を VB Script to execute （VB スクリプトの実行）フィー

ルドに入力するか、Browse (…) （参照）をクリックしてフォルダ構造を参照しスクリプトを

選択して、実行する VB スクリプトを指定します。 

4. Time of Day （期間）をクリックしてから、期間を入力し、選択した VB スクリプトを実行

する日数を選択します。 

5. Alert Escalation （アラート エスカレーション）をクリックし、アラートの必要に応じて、次の

オプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件が満たされたときにスクリプトを繰り返し実行するには、Execute this 

Action repeatedly while the Alert is Triggered （アラートがトリガーされてい

るときにこのアクションを繰り返し実行する）にチェックを入れて、適切なアクション実行

間隔を入力します。 
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 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）をクリックしてから、スクリプトが実行され

る前にアラート条件が満たされた場合にアラート エンジンが待機する適切な間隔を

入力します。 

6. VB スクリプト実行のアクションの設定を終了したら、OK をクリックします。 

ウェブ ページの電子メール送信 

Edit E-mail Web Page Action （電子メールをウェブ ページへの送信アクションの編集）ウィ

ンドウには、設定を行う複数のタブが含まれます。次の手順で、アドバンスト アラートの電子 

メール URL アクションを設定します。 

注記： 電子メールはテキスト形式で送られます。 

アドバンスト アラートの電子メール ウェブ ページ アクションを設定するには： 

1. E-mail a Web Page （電子メールのウェブ ページへの送信）をクリックし、OK をクリック

します。 

2. To （宛先）、CC 、BCC 、Name （名前）、および Reply Address （返信アドレス）フ

ィールドを入力します。 

注記： 少なくとも To フィールドに 1 つのアドレスを入力する必要があります。複数のアド

レスを入力する際は、コンマでアドレスを分けて入力する必要があります。一部のページ 

システムでは、ページを完了させるために、返信可能なメールアドレスを要求します。 

3. SMTP Server （SMTP サーバー）をクリックします。 

4. SMTP サーバーのホスト名または IP アドレス 、および指定した SMTP ポート番号 を入

力します。 

注記： SMTP サーバーのホスト名と IP アドレスのフィールドを入力する必要があります。

SMTP サーバーを指定せずに、ウェブ ページに電子メールを送信することはできません。 

5. URL をクリックし、アラート電子メールの Subject （件名）を入力します。 

注記： Subject （件名）と URL フィールドが空の場合、メッセージは無効になります。 

6. 変数を Subject または Message フィールドに挿入する場合は、新しい変数の場所を
クリックして次の手順を実行します。 

a. Insert Variable （変数を挿入）をクリックしてから、Variable Category （変数カ

テゴリ）を選択し、追加する変数を選択します。 

b. パーサーを変更する場合は、Change Parser （パーサーの変更）にチェックを入れ

て使用するパーサーを選択します。 
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c. SQL 変数を定義してクリップボードにコピーする場合は、Define SQL Variable 

（SQL 変数の定義）にチェックを入れ、Insert Variable From Above List （上

記リストから変数を挿入）をクリックします。 

d. Build Selected Variable （選択した変数をビルド）をクリックします。 

注記： 変数の使用の詳細については、431 ページの「Orion NPM 変数と例」を参

照してください。変数を使用するメッセージの詳細については、440 ページの「変数を

使用するメッセージの例」を参照してください。 

7. アラート電子メールの URL を入力します。 

注記： Subject （件名）と URL フィールドが空の場合、メッセージは無効になります。 

8. 電子メールを送信する URL のウェブ サーバーがユーザーにアクセス認証を要求する場
合、ウェブ サーバーのユーザー ID と ウェブ サーバーのパスワード を Optional Web 

Server Authentication （オプション ウェブ サーバー認証）エリアで入力します。 

9. Time of Day （期間）をクリックして、その後期間を入力し、アラート アクションを有効化

する日数を選択します。 

10. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーショ

ン）をクリックし、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件が満たされたときにアクションを繰り返し実行するには、Execute this 

Action repeatedly while the Alert is Triggered （アラートがトリガーされてい

るときにこのアクションを繰り返し実行する）にチェックを入れて、適切なアクション実行

間隔を入力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れてから、アラート アクショ

ンが実行される前にアラート条件が満たされた場合に、アラート エンジンが待機する

適切な間隔を入力します。 

11. URL 電子メール アラート アクションの設定を終了した場合、OK をクリックします。 

テキスト音声変換出力の使用 

アラートがトリガーされる時に読み上げられる語句を指定することができます。Orion では 

Microsoft Speech Synthesis Engine バージョン 5.0 （ Windows 2003 および XP 

Professional に含まれる）を使用します。Orion 保守を実行する場合、その他のテキスト音

声変換エンジンも SolarWinds ウェブサイトからインストールおよび使用することができます。次

の手順で、アドバンスト アラート トリガーやリセットのテキスト音声変換出力を設定します。 
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注記： Windows サービスのアプリケーションへの制限により、Text to Speech （テキスト音声

変換）は Windows 7 または Windows Server 2008 以降での Orion インストールではご

利用になれません。 

アドバンスト アラートのテキスト音声変換アクションを設定するには： 

1. Text to Speech output （テキスト音声変換出力）をクリックし、さらに OK をクリックし

ます。 

2. General （一般）タブで Speech Engine （スピーチエンジン）を選択します。 

3. スライダーを使用して必要な Speed （速度）、Pitch （ピッチ）そして Volume （ボリュー

ム）を設定します。 

4. Phrase （語句）タブで、スピーチとして出力するテキストを Phrase to speak （読み上

げる語句）フィールドで入力します。 

注記： General （一般）タブで設定したオプションで、Speak （読み上げる）をクリックして

テキストを聴きます。 

5. Time of Day （期間）タブで期間を入力してから、アラート アクションを有効化する日数

を選択します。 

6. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーション）

タブを開き、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件が満たされたときにアクションを繰り返し実行するには、Execute this 

Action repeatedly while the Alert is Triggered （アラートがトリガーされてい

るときにこのアクションを繰り返し実行する）にチェックを入れて、適切なアクション実行

間隔を入力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れてから、アラート アクショ

ンが実行される前にアラート条件が満たされた場合に、アラート エンジンが待機する

適切な間隔を入力します。 

7. テキスト音声変換アクションの設定を終了した場合、OK をクリックします。 
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Windows Net メッセージの送信 

アラートを設定して、指定したコンピュータか、選択したドメインまたはワークグループ内のすべて
のコンピュータで、Windows Net メッセージをポップアップ表示できます。次の手順では、トリ 

ガーまたはリセットしたアラートの Windows Net メッセージを設定します。 

注記： SolarWinds が Orion のインストールをサポートしている WindowsNet Messaging に
対応している唯一のオペレーティング システムは、Windows Server 2003 および Windows 

XP です。SolarWinds は、Windows XP で Orion の評価版のみをサポートします。 

Orion を設定してアラート時に Windows Net メッセージを送信するには： 

1. Send a Windows Net Message （Windows Net メッセージを送信する）をクリックし
て、その後 OK をクリックします。 

2. Net Message （Net メッセージ）タブで、Windows Net メッセージを送信するマシンの コ
ンピュータ名か IP アドレス を入力します。 

3. ドメインまたは対象となるコンピュータのワークグループのすべてのコンピュータにメッセージを
送信する場合は、Send to all Computers in the Domain or Workgroup （ドメ
インまたはワークグループのすべてのコンピュータに送信する）にチェックを入れます。 

4. 送信する Windows Net メッセージを Message to send （送信するメッセージ）フィー
ルドに入力します。 

注記： このメッセージで変数を使用することもできます。変数を使用する詳細については、
431ページの「Orion NPM 変数と例」を参照してください。 

5. Time of Day （期間）タブで期間を入力してから、アラート アクションを有効化する日数
を選択します。 

6. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーション）
タブを開き、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき
にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件が満たされたときにアクションを繰り返し実行するには、Execute this 

Action repeatedly while the Alert is Triggered （アラートがトリガーされてい
るときにこのアクションを繰り返し実行する）にチェックを入れて、適切なアクション実行
間隔を入力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れてから、アラート アクショ
ンが実行される前にアラート条件が満たされた場合に、アラート エンジンが待機する
適切な間隔を入力します。 

7. テキスト音声変換アクションの設定を終了した場合、OK をクリックします。 
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SNMP トラップの送信 

次の手順を実行することで、アラートを設定し、トリガーまたはリセットに関する SNMP トラップ

を送信します。 

Orion を設定してアラート時の SNMP トラップを送信するには： 

1. Send an SNMP Trap （SNMP トラップの送信）を選択し、OK をクリックします。 

2. SNMP Trap （SNMP トラップ）タブの SNMP Trap Destinations （SNMP トラップ

先）フィールドで、生成したトラップを送信するサーバーの IP アドレスを入力します。 

注記： 複数の宛先 IP アドレスを区切るにはコンマを使用します。 

3. Trap Template （トラップ テンプレート）リストからアラート トリガーを送信するためのトラッ

プのタイプを選択します。 

注記： 一部のトラップ テンプレートはアラート メッセージを使用できます。ユーザーが望む

場合は、入力したテキストの変更を行えますが、変数の使い方を前もって理解している必

要があります。変数を使用する詳細については、431 ページの「Orion NPM 変数と例」

を参照してください。 

4. ネットワークの SNMP Community String （ SNMP コミュニティ ストリング）を指定さ

れたフィールドで入力します。 

5. Time of Day （期間）タブで期間を入力してから、アラート アクションを有効化する日数

を選択します。 

6. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーション）

タブを開き、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件が満たされたときにアクションを繰り返し実行するには、Execute this 

Action repeatedly while the Alert is Triggered （アラートがトリガーされてい

るときにこのアクションを繰り返し実行する）にチェックを入れて、適切なアクション実行

間隔を入力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れてから、アラート アクショ

ンが実行される前にアラート条件が満たされた場合に、アラート エンジンが待機する

適切な間隔を入力します。 

7. SNMP トラップ アラート アクションの設定を終了したら、OK をクリックします。 
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GET または POST URL 機能の使用 

HTTP GET または POST 機能を使用して Orion を設定し、アラートを通信することができ

ます。サンプルとして、URL はトラブル チケット システムへのインターフェースとして使用され、さ

らに GET 機能を正しくフォーマットすることで新しいトラブル チケットが自動作成されます。次

の手順で Orion を設定し、GET または POST HTTP 機能を利用し、アラート情報を通信

します。 

Orion を使用して GET または POST URL 機能をアラートに使用するには： 

1. Get or Post a URL to a Web Server （URL のウェブ サーバーへの Get または 

Post）をクリックし、OK をクリックします。 

2. Use HTTP GET （HTTP GET を使用）か Use HTTP POST （ HTTP POST を使

用）のどちらかを選択し、アラート情報と通信するのに使用する機能を設定します。 

3. Use HTTP GET を選択した場合、GET する URL を入力します。 

4. Use HTTP POST を選択した場合、POST する URL を入力してから、Body to 

POST （POST する本文）を入力します。 

5. Time of Day （期間）タブで期間を入力してから、アラート アクションを有効化する日数

を選択します。 

6. アラート エスカレーションを有効にするには、Alert Escalation （アラート エスカレーション）

タブを開き、アラートの必要に応じて、次のオプションのいずれかにチェックを入れます。 

 アラートが承認されているときにアクションを無効にするには、Do not execute this 

Action if the Alert has been Acknowledged （アラートが承認されているとき

にこのアクションを実行しない）にチェックを入れます。 

 トリガー条件が満たされたときにアクションを繰り返し実行するには、Execute this 

Action repeatedly while the Alert is Triggered （アラートがトリガーされてい

るときにこのアクションを繰り返し実行する）にチェックを入れて、適切なアクション実行

間隔を入力します。 

 アラート アクションの実行を遅らせるためには、Delay the execution of this 

Action （このアクションの実行を遅延させる）にチェックを入れてから、アラート アクショ

ンが実行される前にアラート条件が満たされた場合に、アラート エンジンが待機する

適切な間隔を入力します。 

7. HTTP GET または POST URL 機能を使用する Orion の設定を終了したら、OK を

クリックします。 
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ページングへのダイヤルまたは SMS サービス 

NotePager Pro がインストールされている場合、ページングまたは SMS サービスを使用して

アラートと通信するように Orion を設定できます。インストールと設定の詳細については、

「SolarWinds Orion Network Performance Monitor の統合」を www.notepage.net で

参照してください。 

アラート アクションのテスト 

アドバンスト アラート マネージャでは、アラート アクション テスト機能を提供します。これによりユ

ーザーは、Orion がネットワーク上でアラート条件を検知した時に実行されるよう設定したアク

ションの機能を確認できます。以下の手順を完了して、アラート アクションをテストします。 

アラート アクションをテストするには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Advanced Alert Manager （スタート > すべてのプログラム > SolarWinds 

Orion > アラート、レポートおよびマッピング > アドバンスト アラート マネージャ）をクリックし 

ます。 

2. Configure Alerts （アラートの設定）をクリックして、テストするアクションが設定されてい

るアラートをクリックします。 

3. Test （テスト）をクリックします。 

4. ノード条件で実行するようアラートが設定されている場合、Alert on Network Node 

（ネットワーク ノードのアラート）を選択し、アクションをテストする対象のノードを選択します。 

5. インターフェース条件で実行するようアラートが設定されている場合、次の手順を実行し 

ます。 

a. Alert on Network Node （ネットワーク ノードのアラート）を選択してから、アクショ

ンをテストするインターフェースの親ノードを選択します。 

b. Select Interface on ParentNode （親ノード上でインターフェースを選択）を選択

してから、アクションをテストするインターフェースを選択します。 

6. ボリューム条件で実行するようアラートが設定されている場合、次の手順を実行します。 

a. Alert on Network Node （ネットワーク ノードのアラート）を選択してから、アクショ

ンをテストするボリュームの親ノードを選択します。 

b. Select Volume on ParentNode （親ノード上でボリュームを選択）を選択してか

ら、アクションをテストするボリュームを選択します。 

7. アラート トリガーのアクションをテストする場合は、Test Alert Trigger （アラート トリガー

のテスト）をクリックします。 

../../06_tech/2011-07-11_prep/01_save_as_XML/www.notepage.net
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8. アラートリセット アクションをテストする場合は、Test Alert Reset （アラート リセットのテ

スト）をクリックします。 

9. テストを終了したら、テスト ログで示されるように、Done （完了）をクリックします。 

予想していたアクションが、選択したアラート トリガーまたはリセットの結果として起こったことを確

認します。 

Orion ウェブ コンソールのアラートの表示 

All Network Devices （すべてのネットワーク デバイス）ページでは、アラート ログの表ビューを

提供します。次の手順で望ましいアラートのグループ化基準を選択すると、リスト ビューをカスタ

マイズできます。 

Orion ウェブ コンソールのアラートの表示方法： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. Views （ビュー）ツールバーで Alerts （アラート）をクリックします。 

3. デバイス別にアラートの表ビューをフィルタリングする場合は、Network Object （ネット 

ワーク オブジェクト）フィールドでアラート ビューを制限するデバイスを選択します。 

4. デバイスのタイプ別にアラート テーブルをフィルタリングする場合は、アラート ビューを制限

するデバイス タイプを Type of Device （デバイスのタイプ）フィールドで選択します。 

5. アラート表を制限してアラートの特定のタイプを表示するには、Alert Name （アラート

名）フィールドでアラートのタイプを選択します。 

6. Show Alerts （アラートの表示）フィールドで、表示するアラートの数を入力します。 

7. すべてのアラートを表示する場合、（すでにそれらのアラートがクリアまたは承認されている
場合でも） Show Acknowledged Alerts （承認アラートの表示）にチェックを入れ 

ます。 

8. Refresh （更新）をクリックし、Alerts （アラート）ビュー設定を完了させます。 
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ウェブ コンソールでアドバンスト アラートの承認 

Orion NPM でユーザーは Orion ウェブ コンソールのアドバンスト アラートを承認できます。こ

れによりユーザーは、複数のユーザーが同じ問題を解決しようとする場合、あるいはユーザーが

すでに解決済みの問題に対処しようとして無駄になる時間のロスを省くことができます。 

Orion ウェブ コンソールでアドバンスト アラートを承認するには： 

1. アラート承認特権が与えられたアカウントを使用して Orion ウェブ コンソールにログインし

ます。 

注記： Orion ウェブ コンソール ユーザーのアクセス特権の詳細については、251 ページの

「ユーザー アカウントのアクセス設定」を参照してください。 

2.  Views （ビュー）ツールバーで Alerts （アラート）をクリックします。 

3. 単一のデバイスのみに対応するためにアラートのリストを制限するには、Network 

Object （ネットワーク オブジェクト）リストから指定デバイスを選択します。 

注記： このオプションはアラートが複数のネットワーク デバイスで機能する場合にのみ利用

できます。 

4. 単一のデバイス タイプのみに対応するためにアラートのリストを制限するには、Type of 

Device （デバイスのタイプ）リストからデバイス タイプを選択します。 

注記： このオプションは、Orion が複数のタイプのネットワーク デバイスを監視する場合に

のみ利用できます。 

5. 単一のタイプのみに対応するためにアラートのリストを制限するには、指定するアラート タ

イプを Alert Name （アラート名）リストから選択します。 

注記： このオプションは、複数のタイプの Orion NPM アラートがトリガーされた時にのみ

利用できます。 

6. Show Alerts （アラートを表示）フィールドに表示されるアラートの数を確認します。 

7. 承認アラートを（承認後でも） Alerts （アラート）ビューに残しておきたい場合は、Show 

Acknowledged Alerts （承認アラートを表示）にチェックを入れます。 

8. Refresh （更新）をクリックし、新しい設定でアラート リストを更新します。 

9. 承認するアラートの横の Acknowledged （承認済み）にチェックを入れます。 

10. Acknowledge Alerts （承認アラート）をクリックします。 
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エスカレーションしたアドバンスト アラート 

Orion NPM で、ユーザーはエスカレーションした複数のアラートを作成し、アラートをカスタマイ

ズし連続的なアクションをトリガーすることを可能にします。次のセクションでは、エスカレーション

したアラートが有効であるシナリオと、Orion アドバンスト アラート マネージャのアラートを作成

するのに必要な手順を説明します。 

エスカレーションしたアラートの例 

WidgetCo は、2 人の技術者と IT マネージャという少数のスタッフで構成されている会社です。

問題に適切に対応するために、IT マネージャは複数のエスカレーションしたアラートを、広範囲

のネットワーク イベント用に作成しました。イベントにはデバイスの不良、ディスク スペースの占

有、帯域幅の使用率が含まれます。通常、WidgetCo の IT マネージャが設定するエスカレー

ションしたアラートは、以下のように続行されます。 

1. Orion NPM がアラート条件を認識すると、Orion NPM は、ただちに 2 人の技術者のう

ち 1 人に送信される電子メールとページを生成します。エントリは Orion イベント ログに

記録されます。 

2. アラートが Orion ウェブ コンソールに 20 分以内に承認されない場合、2 番目のアラート

が実行され、2 人の技術者に送信される別の電子メールと呼び出しを生成します。エント

リは Orion イベント ログに記録されます。 

3. アラートが Orion ウェブ コンソールに 20 分以内に承認されない場合、Orion NPM は 3 

番目のアラートを実行し、電子メールと呼び出し双方を技術者たちと IT マネージャに送

信します。エントリは Orion イベント ログに記録されます。 

エスカレーションしたアラートにより、WidgetCo の IT スタッフ全員が、いかなるネットワーク ア 

ラートの条件に関しても 45 分以内に通知を受け、さらに過度なアラート通知による IT マネー

ジャへの負担を避けることができます。次のセクションでは、この例と同様の、エスカレーションし

たアラートのスキームを作成する方法を提供します。 
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複数のエスカレーションしたアラートの作成 

次の手順で、先述したスキームに類似した複数のエスカレーションしたアラートを作成します。 

注記： これらの手順を繰り返して、各通知レベルのアラートを作成します。前のセクションで紹

介された例では、3 つのレベルのエスカレーションしたアラートが使用されました。次の手順は各

アラートにつき一度ずつ、合計 3 度実行して、前のセクションのエスカレーションしたアラートを

複製する必要があります。 

エスカレーションしたアラートを作成するには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Advanced Alert Manager （スタート > すべてのプログラム > SolarWinds 

Orion > アラート、レポートおよびマッピング > アドバンスト アラート マネージャ）をクリックし 

ます。 

2. Configure Alerts （アラートの設定）をクリックします。 

3. New （新規）をクリックしてから、General （一般）をクリックします。 

4. レベル X を、X が現在設定されているアラートに対応しているレベルの場所で、Name of 

Alert （アラート名）フィールド内のエスカレーションしたアラートの名前に合わせて入力し 

ます。 

注記： 前のセクションで紹介された例では、3 つのレベルのエスカレーションしたアラートを

使用しています。 

5. 最初のレベルのエスカレーションしたアラートの説明を、説明フィールドに入力して、その後 

Enable this Alert （このアラートを有効化）にチェックを入れます。 

6. Alert Evaluation Frequency （アラートの評価頻度）を入力し、リストから Seconds 

（秒）、Minutes （分）、Hours （時間）を選択してアラートのチェック間隔を設定します。 

7. Trigger Condition （トリガー条件）をクリックします。 

注記： トリガー条件の設定の詳細については、279 ページの「アドバンスト アラートのトリ

ガー条件の設定」を参照してください。 

8. Node （ノード）を Type of Property to Monitor （監視するプロパティ タイプ）として選

択します。 

9. アラート定義フィールドのリンクされたテキストが all （すべて）を表示していることを確認し 

ます。 

注記： リンクされたテキストをクリックして適用する条件の数を選択します（ all （すべて） 

any （一部）、none （なし）、not all （一部なし））。リンクテキスト条件の詳細について

は、288 ページの「条件グループの理解」を参照してください。 
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10. Browse (…) （参照）をクリックしてから、Add a Simple Condition （シンプル条件を

追加）をクリックします。 

11. 最初のアスタリスク（*）をクリックし、Network Nodes > Node Details > Node 

Name （ネットワーク ノード  > ノードの詳細  > ノード名）を選択します。 

12. is equal to （以下と同等）がトリガー定義のリンクされた条件テキストであることを確認し

ます。 

注記： リンクされたテキストをクリックして、適用する条件を選択します（equal （同等） 

greater （以上）、less （以下）、…）。リンクテキスト条件の詳細については、288 ペー

ジの「条件グループの理解」を参照してください。 

13. 2 番目のアスタリスク (*) を選択して、監視されたノードのリストから運用ウェブ サーバーを

選択します。 

14. Add （追加）をクリックして、Simple Condition （シンプル条件）をクリックします。 

15. 最初のアスタリスク (*) を 2 番目の条件でクリックし、Network Nodes > Node 

Status > Node Status （ネットワーク ノード  > ノード ステータス  > ノード ステータス）

を選択します。 

16. is equal to （以下と同等）が、2 番目のトリガー定義のリンクされた条件テキストである

ことを確認します。 

注記： リンクされたテキスト条件をクリックして、適用する条件を選択します（equal （同

等） greater （以上）、less （以下）、…）。リンクテキスト条件の詳細については、288 

ページの「条件グループの理解」を参照してください。 

17. 2 番目のアスタリスク (*) を 2 番目の条件でクリックし、Down （ダウン）を選択します。 

18. リセット条件をエスカレーションしたアラートに適用する場合は、Reset Condition （リセ

ット条件）をクリックし、適切な条件を入力します。詳細については、282 ページの「アドバ

ンスト アラートのリセット条件の設定」を参照してください。 

19. エスカレーションしたアラートに対してアラート抑制を適用する場合は、Alert 

Suppression （アラート抑制）をクリックし、適切な抑制条件を入力します。詳細につい

ては、284 ページの「アドバンスト アラートの抑制の設定」を参照してください。 

20. エスカレーションしたアラート有効時の制限を実行する場合は、Time of Day （期間）を

クリックし、エスカレーションしたアラートの Valid Time of Day （有効期間）を指定します。

その後、エスカレーションしたアラートが有効な Days of the Week （曜日）を選択します。

詳細については、285 ページの「アドバンスト アラートの監視期間の設定」を参照してくだ

さい。 

注記： デフォルトでは、エスカレーションしたアラートは常に有効です。 
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21. Trigger Actions （トリガー アクション）タブをクリックしてから、Add New Action （新

規アクションの追加）をクリックします。 

22. Send an E-mail / Page （電子メール / 呼び出しの送信）を選択して OK をクリックし

ます。 

23.E-mail/Pager Addresses （電子メール / ポケベル アドレス）をクリックし、To （宛先）、

CC 、BCC 、Name （名前）および Reply Address （返信用アドレス）フィールドをレ

ベル 1 の連絡先用に入力します。 

注記： To （送信先）フィールドに電子メールのアドレスを少なくとも 1 つ入力する必要が

あります。複数のアドレスをフィールドに入力する際は、コンマでアドレスを分けて入力する

必要があります。 

24. Message （メッセージ）をクリックし、エスカレーションしたアラートの電子メールの Subject 

（件名）と Message （メッセージ）を入力します。 

注記： 

 Subject （件名）と Message （メッセージ）フィールドが空の場合、メッセージの送

信はできません。 

 電子メールの件名およびメッセージでの変数の詳細については、295 ページの「電子

メールまたは呼び出しの送信」を参照してください。 

25. SMTP Server （ SMTP サーバー）をクリックし、SMTP サーバーのホスト名または IP ア

ドレス 、および指定する SMTP ポート番号 を入力します。 

注記： SMTP サーバーのホスト名と IP アドレスのフィールドを入力する必要があります。

SMTP サーバーを同定せずに電子メール / 呼び出しを送信することはできません。 

26. ご利用の SMTP サーバーが認証を必要とする場合、This SMTP Server requires 

Authentication （この SMTP サーバーは認証を必要とする）にチェックを入れます。 

27. エスカレーションしたアラートが有効な時に制限を実行するには、Execute this Action 

only between specific hours （指定した時間の間だけ、このアクションを実行する）

にチェックを入れて、適切な設定を行います。 

注記： デフォルトでは、エスカレーションしたアラートは常に有効です。詳細については、

285 ページの「アドバンスト アラートの監視期間の設定」を参照してください。 

28. Alert Escalation （アラート エスカレーション）をクリックします。 

29. Do not execute this Action if the Alert has been Acknowledged （アラート

が承認されているときにこのアクションを実行しない）にチェックを入れます。 
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30. トリガー条件が満たされたときにアクションを繰り返し実行するには、Execute this 

Action repeatedly while the Alert is Triggered （アラートがトリガーされていると

きにこのアクションを繰り返し実行する）にチェックを入れて、適切なアクション実行間隔を

入力します。 

31. アラート アクションの実行を遅らせるためには、Delay the execution of this Action 

（このアクションの実行を遅延させる）にチェックを入れてから、アラート アクションが実行され

る前にアラート条件が満たされた場合に、アラート エンジンが待機する適切な間隔を入

力します。 

注記： 通常、最初のレベルのアラートを設定する場合、このオプションにはチェックを入れ

ないでください。2 番目のレベルのアラートを設定する場合、このオプションにチェックを入れ

て、最初と 2 回目の通知の間で希望する遅延を入力します。3 番目のレベルのアラート

を設定する場合、このオプションにチェックを入れて、最初と 3 回目の通知の間で希望す

る遅延を入力します。 

32. OK をクリックします。 

33. エスカレーションしたアラートをリセット時にアクションを実行するには、Reset Action （アク

ションをリセット）タブをクリックし、適切なアクションを設定します。詳細については、282 ペ

ージの「アドバンスト アラートのリセット条件の設定」を参照してください。 

34. エスカレーションしたアラートの設定を終了したら、OK をクリックします。 

モバイル デバイスのアラートを表示 

Orion NPM では、モバイル デバイスで Orion ウェブ コンソールにアクセスする時に、検知を実

行できます。このモバイル アラート ビューにより、ユーザーは既存のアクティブ アラートの表示と

承認を行えます。 

モバイル デバイスで承認アラートを表示するには： 

1. モバイル デバイスでブラウザを使用して、Orion ウェブ コンソールにアラート管理権を持つ

ユーザーとしてログインします。 

2. Views （ビュー）ツールバーで Alerts （アラート）をクリックします。 

注記： モバイル アラート ビューをデスクトップまたはサーバー  ブラウザで表示するに

は、?IsMobileView=true を Orion ウェブ コンソールの Alerts （アラート）ビューの 

URL に追加します。 

3. 承認するアラートにチェックを入れて、Acknowledge （承認）をクリックします。 

 アラート メッセージ内のクリック可能なリンクから、トリガーされたアラートの詳細情報が提供さ

れます。 
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第 22章 

レポートの作成と表示  –  コア 

時間が経過する毎に Orion NPM データベースは大量の情報を累計します。SolarWinds 

では、Report Writer を用いて、データをデータベースから抽出し、便利な形式で表示するす

ばやく簡単な方法を提供します。修正可能な複数の標準的レポートが Report Writer に含

まれており、必要に応じて新しいレポートも作成できます。Report Writer は強力なツールを

備えており、ユーザーが情報をフォーマット化し、表示する前にレポートを簡単にプレビューする

のをサポートします。レポートの編集が終了したあと、デフォルトでは、ボタンをクリックしてレポー

トを印刷することができます。さらに、多くのレポートで Orion Network Performance 

Monitor ウェブ コンソールを通じて表示を有効にできます。Orion ウェブ コンソール ビューへの

レポート追加の詳細については、182ページの「ビューのカスタマイズ 」を参照してください。 

注記： Report Writer の機能は、Custom Property Editor （カスタムプロパティ エディタ）と

併用することで、より強化されます。プロパティを追加すると、レポートの分類やフィルタリングに

使用できるようになります。詳細については、375ページの「カスタム プロパティの作成  –  コア」

を参照してください。 

定義済みの Orion レポート 

次のセクションでは、Orion インストールですぐに利用可能なレポートを説明します。これらのレ

ポートは、必要に応じて、ネットワーク パフォーマンスのレポート要件に合わせて変更できます。 

注記： ユーザーが要求するレポートが以下のどのセクションにも表示されない場合、Orion 

Report Writer で自身のカスタムレポートを作成できます。カスタムレポート作成の詳細につい

ては、328 ページの「Report Writer を使用 」を参照してください。 

Availability （可用性） 

次のネットワーク可用性レポートは、Orion によってデフォルトで提供されます。 

可用性 – 先月 

 先月監視されたすべてのノードの平均可用性と IP アドレスを表示します。 

可用性 – 今年 

 昨年監視されたすべてのノードの平均可用性と IP アドレスを表示します。 

可用性 – 昨日 

 前日監視されたすべてのノードの平均可用性と IP アドレスを表示します。 
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ネットワーク全体の可用性 – 先月 

 先月ネットワーク全体で監視されたすべてのノードの可用性を表示します。 

ダウン比率のトップ 25 – 先月 

 ノードに関して、先月ダウンタイムの長かったトップ 25 を表示します。 

現在のノード ステータス 

次のノード ステータス レポートは、Orion によってデフォルトで提供されます。 

平均応答時間 

監視されたすべてのノードの平均および最大応答時間の双方を表示します。 

現在の CPU 負荷 

監視されたすべてのノードの現在の CPU 負荷率を表示します。 

現在の応答時間 

監視されたすべてのノードの現在の応答時間、平均応答時間、および最大応答時間と 

IP アドレスを表示します。 

各ノードの現在のステータス 

監視された全ノードの現在の操作ステータスの説明と IP アドレスを表示します。 

ダウンしているノード 

現在ダウンしている監視されているすべてのノードを表示します。 

各ノードを前回起動した時間 

全ノードを前回起動した日付と時間、およびマシン タイプを表示します。 

現在のボリューム ステータス 

Orion はデフォルトで Available Space on each Volume （各ボリュームの利用可能な

領域）レポートを提供します。このレポートでは、ボリューム サイズ、ボリュームの利用可能な領

域、監視されたすべてのボリュームの利用可能な領域の割合を表示します。ボリュームは、そ

れぞれの親ノードに一覧表示されます。 
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日間ノード可用性 

次のノード可用性レポートは、Orion によってデフォルトで提供されます。 

可用性 – 先月 

 今月監視されたすべてのノードの日間可用性と IP アドレスを表示します。 

可用性 – 今月 

 今月監視されたすべてのノードの日間可用性と IP アドレスを表示します。 

可用性 – 今年 

 過去 12 ヶ月に監視されたすべてのノードの日間可用性と IP アドレスを表示します。 

イベント 

次のネットワーク イベント レポートは、Orion によってデフォルトで提供されます。 

すべてのダウンイベント 

過去 12 ヶ月でポーリングへの応答が停止したノードに関連する、データベース内のすべて

のイベントのリストを表示します。各ダウンイベントに関して、このレポートはダウンイベントの

日付と時間、ノード名、IP アドレス、そしてダウンイベントの説明を表示します。 

ダウンイベント - Windows デバイス 

先月ポーリングへの応答が停止した Windows デバイスに関連する、データベース内のす

べてのイベントのリストを表示します。各ダウンイベントに関して、このレポートはダウンイベン

トの日付と時間、ノード名、さらにダウンイベントの説明を表示します。 

過去 250 件のイベント 

監視されたデバイスに関連する過去 250 件のイベントを表示します。このレポートでは、

各イベントのイベント日付、時間、関連するノード、イベントを説明するメッセージを表示し

ます。 

ダウンしたノード - 過去 24 時間 

過去 24 時間で応答が停止したすべてのノードのリストを表示します。ダウンするノードの

全てのイベントに関して、このレポートはイベントの日付と時間、現在のノード ステータスを

示すアイコン、ノード名、そしてダウンイベントの説明を表示します。 
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トリガーされたアラート - 過去 30 日間 

過去 30 日間にトリガーされたすべてのアラートのリストを表示します。このレポートでは、

トリガーされた各アラート イベントに関するアラート トリガーの日付と時間、アラートをトリ 

ガーしたノード、トリガーされたアラート イベントを説明するメッセージが表示されます。 

トリガーおよびリセットされたアラート - 過去 30 日間 

過去 30 日間にトリガーおよびリセットされたすべてのアラートのリストを表示します。このレ

ポートでは、トリガーまたはリセットされた各アラート イベントに関するアラート イベントの日

付と時間、アラートをトリガーまたはリセットしたノード、アラート イベントを説明するメッセー

ジが表示されます。 

CPU およびメモリの履歴レポート 

Orion はデフォルトで CPU Load - Last Month （CPU 負荷 - 先月）レポートを提供しま

す。このレポートでは、前回の暦月に CPU で監視された、すべてのノードの CPU 平均負荷

率および最大負荷率、ベンダー アイコンを表示します。 

応答時間の履歴レポート 

次の応答時間レポートは、Orion によってデフォルトで提供されます。 

応答時間 - 先月 

前回の暦月に監視されたすべてのノードの平均および最大応答時間を表示します。 

応答時間 - 先月のトップ 10 

前回の暦月に監視されたノードのトップ 10 の平均および最大応答時間を表示します。 

VMware ESX サーバーの履歴レポート 

Orion NPM では、Orion のデフォルトで、次の VMware ESX サーバー パフォーマンス レ 

ポートを提供します。 

過去 7 日間の VM のネットワーク トラフィック 

監視された各 VMware ESX サーバーに関して、このレポートは、過去 7 日間にホストさ

れた VM 別の ESX サーバー上のネットワーク トラフィックの日間平均率を表示します。 

先月 の VM のネットワーク トラフィック 

監視された各 VMware ESX サーバーに関して、このレポートは、先月ホストされた VM 

別の ESX サーバー上のネットワーク トラフィックの日間平均率を表示します。 
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過去 7 日間の VM の CPU 割合 

監視された各 VMware ESX サーバーに関して、このレポートは、過去 7 日間にホストさ

れた各 VM 別の ESX サーバー上の CPU の日間平均負荷率を表示します。 

先月 の VM の CPU 割合 

監視された各 VMware ESX サーバーに関して、このレポートは、先月にホストされた各 

VM 別の ESX サーバー上の CPU の日間平均負荷率を表示します。 

過去 7 日間の VM のメモリ割合 

監視された各 VMware ESX サーバーに関して、このレポートは、過去 7 日間にホストさ

れた各 VM 別の ESX サーバー上のメモリの日間平均負荷率を表示します。 

先月 の VM のメモリ割合 

監視された各 VMware ESX サーバーに関して、このレポートは、先月にホストされた各 

VM 別の ESX サーバー上のメモリの日間平均負荷率を表示します。 

実行時間と停止中の割合 

監視された各 VMware ESX サーバーに関して、このレポートは、ホストされた VM の実

行されていた時間と、ホストされた VM が停止していた時間の割合を表示します。 

グループ：現在のグループとグループ メンバーのステータス 

次のグループとグループ メンバー ステータスは、Orion によってデフォルトで提供されます。 

各グループの現在のステータス 

各グループの現在のステータス 

各グループ メンバーの現在のステータス 

各グループ メンバーの現在のステータス 

グループとグループ メンバー 

グループとグループ メンバー 

グループ：日間グループの可用性： 

次のグループ可用性レポートは、Orion によってデフォルトで提供されます。 

グループ可用性 – 先月 

グループ可用性 – 先月 
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グループ可用性 – 今月 

グループ可用性 – 今月 

グループ可用性 – 今年 

グループ可用性 – 今年 

グループ：グループ可用性（メンバー含む） 

次のグループ可用性レポート（メンバー可用性を含む）は、Orion によってデフォルトで提供さ

れます。 

グループ可用性（メンバー含む） – 先月 

グループ可用性（メンバー含む） – 先月 

グループ可用性（メンバー含む） – 今月 

グループ可用性（メンバー含む） – 今月 

グループ可用性（メンバー含む） – 今年 

グループ可用性（メンバー含む） – 今年 

グループ：グループ ステータスの履歴 

次のグループ ステータスの履歴レポートは、Orion によってデフォルトで提供されます。 

各グループのステータスの履歴 – 過去 7 日間 

各グループのステータスの履歴 – 過去 7 日間 

各グループのステータスの履歴 – 先月 

各グループのステータスの履歴 – 先月 

各グループのステータスの履歴 – 今月 

各グループのステータスの履歴 – 今月 

ボリューム使用量レポートの履歴 

Orion は、Average Disk Space Used - Last 12 Months （使用されるディスク容量の

平均値 - 過去 12 ヶ月）レポートをデフォルトで提供します。監視されるすべてのボリュームに

関して、このレポートはボリュームのタイプとサイズ、現在利用可能なボリューム容量の比率、

現在使用されている利用可能な容量、現在利用可能なボリューム領域を表示します。ボ 

リュームは、それぞれの親ノードに一覧表示されます。 
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インベントリ 

次のインベントリ レポートは、Orion によってデフォルトで提供されます。 

すべてのディスク ボリューム 

監視されるすべてのボリュームに関して、このレポートは、過去 12 ヶ月のボリュームのタイ

プとサイズ、利用可能なボリューム容量、現在使用されている利用可能な容量、最も使

用された月のボリューム上で利用されていた領域の最大容量を表示します。ボリュームは、

それぞれの親ノードに一覧表示されます。 

デバイス タイプ 

監視される Machine Types （マシン タイプ）と現在監視されている各タイプの数を表示

します。 

Cisco デバイスの IOS バージョン 

このレポートは、監視されたすべての Cisco デバイスのデバイス名、マシン タイプ、および 

Cisco ISO バージョンとイメージを表示します。 

レポートの表示 

次の手順で示される通り、カスタムまたは定義済みのすべてのレポートは、Orion ウェブ コン 

ソールと Report Writer の双方で表示できます。 

 Orion ウェブ コンソールのレポートの表示 

 Orion NPM Report Writer のレポートの表示 

注記： デフォルトでは、新しく作成されたユーザー用のレポート フォルダーは設定されていませ

ん。新規のユーザーがレポートを確認できない場合、新規ユーザー用の Report Folder （レ

ポート フォルダ）を選択する必要があります。詳細については、258 ページの「アカウント レポー

ト フォルダの設定」を参照してください。 

Orion ウェブ コンソールのレポートの表示 

次の手順で、Orion ウェブ コンソールで表示するためにレポートを開きます。 

Orion ウェブ コンソールのレポートの表示方法： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 



 管理者ガイド  SolarWinds Orion Network Performance Monitor 

 

 

328 レポートの作成と表示  –  コア 

2. Orion ウェブ コンソールにログインして、Home > Reports （ホーム  > レポート）をクリック

します。 

3. レポート グループ名を選択し、レポート グループを展開します。 

4. 表示するレポートのタイトルをクリックし、ウェブ コンソール ブラウザで直接表示させます。 

またレポートを、ウェブ コンソール ビュー内に Orion Report Writer リソースのレポートとして含

めることもできます。Orion Report Writer リソースのレポート追加の詳細については、183ペ

ージの「ビューの編集」を参照してください。 

Orion NPM Report Writer のレポートの表示 

次の手順で、Orion NPM Report Writer で表示するレポートを開きます。 

Orion NPM Report Writer でレポートを表示するには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Report Writer （スタート > すべてのプログラム > SolarWinds Orion > 

アラート、レポートおよびマッピング > Report Writer ）をクリックします。 

2. レポート グループが左ペインにまだ展開されていない場合は、レポート グループ名の横の 

+ をクリックしてグループを展開します。その後、表示するレポートのタイトルをクリックします。 

3. Preview （プレビュー）をクリックします。 

Report Writer を使用 

Report Writer が使用する前に、監視するデバイスにおける少なくとも数分間のデータをデー

タベースに収集しておく必要があります。Report Writer にはさまざまなレポートや、利用可能

なレポート タイプを区別するレポート名の前に付くアイコンが含まれています。次の手順で 

Report Writer を起動できます。 

Report Writer を起動するには： 

1. Start > All Programs >SolarWinds Orion > Alerting, Reporting, and 

Mapping > Report Writer （スタート > すべてのプログラム  >SolarWinds Orion > 

アラート、レポートおよびマッピング  > Report Writer ）をクリックします。 

2. File > Settings （ファイル＞設定）をクリックします。 
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3. Report Writer 設定ウィンドウの General （一般）タブで、次のいずれかをデフォルトの表

示モードとして選択します。 

 Preview （プレビュー）では、印刷形式で表示されるようにレポートを表示します。詳

細については、329ページの「プレビュー モード」を参照してください。 

  Report Designer （レポート デザイナー）はレポートの作成および編集のインターフ

ェースです。詳細については、329 ページの「デザイン モード 」を参照してください。 

注記： Preview （プレビュー）と Report Designer （レポート デザイナー）モードは、ツー

ルバーで Preview （プレビュー）または Design （デザイン）をそれぞれクリックすることでい

つでも切り替えることができます。 

4. 横線で個別のネットワーク オブジェクトのデータを区切りたい場合は、Report Style （レ

ポート スタイル）をクリックして、Display horizontal lines between each row （各

行の間に横線を表示する）にチェックを入れます。 

5. OK をクリックして Report Writer 設定を閉じます。 

プレビュー モード 

Preview （プレビュー）モードでは、プリントされる状態と同じ形でレポートが表示されます。

Preview （プレビュー）モードでレポートを開くとき、または Preview （プレビュー）モードを 

Design （デザイン）モードから切り替えると、Orion はクエリーを実行してレポートを生成し、

Report Writer は結果を表示します。 

Preview （プレビュー）ウィンドウ ツールバーでは、次のアクションと情報を提供します。 

 レポートの現在のページ番号と全体のページ数。 

 ページ移動ボタン：最初のページ、前ページ、次ページ、最後のページ 

 ビューのズーム 

注記： プレビューをダブルクリックするとズームイン、右ダブルクリックするとズームアウトできます。 

 レポートの印刷 

デザイン モード 

デザイン モードを使用すると、新しいレポートの作成や既存レポートの修正または名前の変更

を実行できます。レポートの作成と修正の双方で同じオプションを利用できます。デザイン モー

ドのオプションもダイナミックで、レポートのタイプ、レポートに含まれているデータ、レポートの表

示方法に基づいています。利用可能なオプションは、デザインしているレポートのタイプによって

異なりますが、すべてのレポートで含むべきデータを選択し、データの並べ替え、順序決定、フィ

ルタ、表示方法を決める必要があります。 
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レポートの作成と修正 

Report Writer でレポートを修正または作成する際は、次の手順を実行してください。 

Report Writer でレポートを開くには： 

1. 既存のレポートを修正する場合は、Report Writer のメイン ウィンドウの左側のペインに

あるインベントリで既存のレポートをクリックします。 

2. 新しいレポートを作成する場合は、File > New Report （ファイル > 新規レポート）をク

リックし、作成したいレポートのタイプを選択してから OK をクリックします。 

各レポートには異なる設定オプションが含まれているため、一部のレポートでは以下のセクショ

ンで説明されている書式設定タブを利用できないこともあります。 

注記： 

 レポートの生成に使用される SQL クエリーは追加タブで表示できます。Report > 

Show SQL （レポート > SQL を表示）をクリックし、デザイン ウィンドウに読み取り専用 

SQL タブを追加します。 

 レポートのプレビューはいつでも表示できます。Preview （プレビュー）をクリックするとプレ 

ビュー モードに入り、Design （デザイン）をクリックするとデザイン モードに戻ります。 

General （一般）オプション タブ 

General （一般）タブはデフォルトで開き、タイトルとオプションが表示されます。 

General （一般）オプションを設定するには： 

1. Report Group （レポート グループ）、Report Title （レポート タイトル）、Subtitle （サ

ブタイトル）、Description （説明）を指定します。 

注記： 既存のレポート グループ名を使用する場合は、メイン ウィンドウの左側のペインで

新規レポートがこの既存グループに追加されます。 

2. レポートを表示する Orientation （方向）を選択します。 

3. 履歴レポートの作成中にデータを日付でグループ化したくない場合は、Group 

historical data by days （履歴データを日付でグループ化する）チェックボックスをクリア

します。 

注記： デフォルトで、一部の可用性および履歴レポートのデータは、Orion ウェブ コンソー

ルに表示される際、日付によってグループ化されます。日付によるデータのグループ化は、

レポート ビューアでは表示できません。 
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4. Orion ウェブ コンソールでこのレポートを利用できるようにしたい場合は、Make this 

Report available from the Orion website （このレポートを Orion ウェブサイトで利

用できるようにする）をクリアします。 

注記： デフォルトで、ほとんどのレポートは Orion ウェブ コンソールで表示できるようになっ

ています。詳細については、182ページの「ビューのカスタマイズ 」を参照してください。 

Select Fields （フィールドの選択）オプション タブ 

Select Fields （フィールドの選択）タブでは、レポートのデータ フィールドを選択できます。 

フィールドを選択・設定するには： 

1. Select Fields （フィールドの選択）をクリックします。 

2. 新規レポートを作成するか、既存のレポートにフィールドを追加する場合は、省略記号を
クリックして Add a new field （新規フィールドの追加）を選択し、以下のように新規レ 

ポートをそれぞれダイナミックに定義します。 

a. Field: （フィールド：）の後ろにあるアスタリスクをクリックし、現在のレポート フィールド

に含める情報のタイプを選択します。 

b. 現在のフィールドでデータを並べ替える場合は、sort （並べ替え）のアスタリスクをク 

リックして並べ替えの順序を選択します。 

c. 現在のフィールドのデータで操作を行いたい場合は、function （機能）のアスタリス

クをクリックして操作を選択します。 

3. 既存のレポートを修正する場合は、変更したい Field （フィールド）、sort （並べ替え）、

function （機能）をクリックし、以下のように新しい値を選択します。 

a. Field: （フィールド：）の後ろにあるアスタリスクをクリックします。 

b. 現在のレポート フィールドに含める情報のタイプを選択します。 

c. 現在のフィールドでデータを並べ替える場合は、sort （並べ替え）のアスタリスクをクリ

ックして並べ替えの順序を選択します。 

d. 現在のフィールドのデータで操作を行いたい場合は、function （機能）のアスタリス

クをクリックして操作を選択します。 

4. レポートの作成時に選択内容をテストしたい場合は、Execute SQL Query （SQL ク

エリーの実行）をクリックして現在のクエリー結果を表示します。 
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5. フィールドを削除するか、レポートに列記されているフィールドの順序を変更したい場合は、
フィールドを選択し、Browse （参照）（…）をクリックしてから適切なアクションを選択し 

ます。 

注記： チェックが外されているフィールドはレポートに表示されませんが、並べ替え順序お

よび機能の設定は保持されます。 

6. レポートのプレビューを見たい場合は、Preview （プレビュー）をクリックします。 

Filter Results （結果のフィルタ）オプション タブ 

Filter Results （結果のフィルタ）タブでは、リンクされたコンテキスト メニューで適切な記述子を

選択することにより、フィールド データのフィルタ条件を生成できます。結果フィルタは以下のよう

に設定します。 

結果フィルタを設定するには： 

1. Browse （参照）（…）をクリックし、次のオプションから選択します。 

 Add a new elementary condition （新しい基本的な条件を追加する）を選択

すると、ネットワーク オブジェクト データのフィールドの直接的な比較に基づいた条件

を生成できます。 

 Add a new advanced elementary condition （新しい詳細な基本的条件を

追加する）を選択すると、デバイス データ フィールドと値の比較に基づいた条件を生

成できます。 

 Add a new complex condition （新しい複雑な条件を追加する）を選択すると、

定義済みの他の条件をフィルタリングする条件を定義できます。 

 Delete current condition （現在の条件を削除する）を選択すると、選択された

条件を削除できます。 

 Move current condition forward （現在の条件を前方に移動する）または 

Move current condition backward （現在の条件を後方に移動する）を選択

すると、選択に応じて条件の順序を変更できます。 

注記： 同じ条件のあらゆる他の変数を考慮し、リンクされた利用可能な説明のリストがダ

イナミックに生成されます。条件グループとその適用の詳細については、288 ページの「条

件グループの理解 」を参照してください。 

2. 各フィルタ条件にチェックを入れるかクリアして、レポートへの適用を有効または無効にし 

ます。 

javascript:fD(58);
javascript:fD(58);
javascript:fD(58);
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Top XX Records （トップ ＸＸ 記録）オプション タブ 

Top XX （トップＸＸ）タブでは、レポートに表示される記録件数をあらゆる結果の上位の 件数 

または上位の パーセンテージ に限定することができます。トップＸＸオプションは以下の手順のよ

うに設定します。 

トップＸＸ記録を設定するには： 

1. レポートですべての記録を表示したい場合は、Show All Records （すべての記録を表

示）を選択します。 

2. レポートで利用できる項目の省略リストを指定するには、次の手順を実行します。 

a. Show only the Top number Records （トップＸＸ記録のみを表示）または 

Show the Top percentage % of Records （トップＸＸ % の記録を表示）のい

ずれかを選択します。 

b. 適切な 数字 または パーセント の値を入力してください。 

Time Frame （時間枠）オプション タブ 

Time Frame （時間枠）オプション タブでは、レポートの範囲を特定期間に限定することがで

きます。時間枠オプションを設定するには、Named （名前付き）、Relative （相対的）、また

は Specific Time Frame （特定の時間枠）のいずれかを選択し、必要な値を選択または

入力します。 

注記： 

 SQL タイムアウト エラー メッセージが表示された場合には、SWNetPerfMon.db ファイル

でタイムアウトの設定を編集します。このファイルはデフォルトで、

C:\Program Files\SolarWinds\Orion directory ディレクトリにあります。 

 Relative Time Frame （相対的時間枠）は継続的に変動するため、これを使用してレ

ポートを実行した場合、時間的に近い間隔で実行しても異なる結果が表示されることが

あります。 

Summarization （要約）オプション タブ 

Summarization （要約）タブでは、特定期間にわたる結果の要約を生成できます。要約オプ

ションは次のように設定します。 

結果要約を設定するには： 

1. 結果を要約したくない場合は、Do not Summarize the Results （結果を要約しな

い）が選択されていることを確認します。 
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2. 結果を要約したい場合は、次の手順を実行します。 

a. Summarize the Results by Hour, Date, Month, etc （時間、日付、月など

で結果を要約する）を選択してから、要約期間を選択します。 

b. レポートの要約フィールドの場所を指定します。 

c. Summary Date/Time （要約の日時）フィールドの場所を選択します。 

Report Grouping （レポートのグループ化）オプション タブ 

Report Grouping （レポートのグループ化）タブでは、レポート内でフィールド記述子別に結果

をグループ化できます。レポートのグループを追加、編集、削除すると、レポートのデータを整理

できます。レポート グループは次のように作成、編集します。 

レポート グループを追加・編集するには： 

1. 新しいレポート グループを追加する場合は、リストからフィールドを選択してグループを定
義します。そのあと Add Report Group （レポート グループの追加）をクリックし、選択さ

れたフィールドを Report Groups （レポート グループ）リストに追加します。 

注記： グループ化の順序を変更するには、上向きまたは下向き矢印を使います。 

2. 既存のレポート グループを編集したい場合は、Report Groups （レポート グループ）リス

トからフィールドを選択し、Edit Report Group （レポート グループの編集）をクリックし 

ます。 

3. 必要に応じて次のオプションを変更できます。 

 Group Header （グループ ヘッダー）は、レポート上でグループを指定するテキストで

す。 

 Web URL （ウェブ URL）は、Orion ウェブ コンソールに関する発行済みのレポート

がダイナミックに保存されている場所です。 

 フォント のサイズ、字体、色、バックグラウンドはすべて、該当する記号をクリックすると

変更できます。 

 位置合わせ は左、中央、右のいずれかになります。 

 レポートをウェブで発行する際には、見やすくなるよう Transparent Background 

（透明なバックグラウンド）にチェックを入れます。 

 グループ化の順序を変更したい場合は、上向きまたは下向き矢印を使用してグルー

プ化の順序を変更します。 
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Field Formatting （フィールドの書式設定）オプション タブ 

Field Formatting （フィールドの書式設定）タブでは、レポートのさまざまな結果フィールドの 

フォーマットをカスタマイズできます。結果フィールドのフォーマットを設定するには、設定したい 

フィールドを選択してからラベルを編集し、適切なオプションを選択します。 

注記： 

 各フィールドで利用できる書式オプションは、当該フィールドに含まれているデータの性質に

応じて異なります。 

 Hidden Field （非表示フィールド）にチェックを入れると、レポートのどのフィールドでも非

表示にできます。 

 Preview （プレビュー）をクリックすると、いつでも変更を表示できます。 

レポート ヘッダーとフッターの画像のカスタマイズ 

各レポートの最上部と最下部に表示されている画像は変更できます。レポートのヘッダーおよ

びフッターとして会社のロゴを追加するには、SolarWinds\Common\WebResources フォル

ダ（通常は C:\Program Files\ にある）でロゴを Header.jpg として保存し、Refresh 

（更新）をクリックします。 

 注記： 画像は JPEG 形式で、高さは 150 ピクセル以下でなければなりません。 

レポートのエクスポート 

Orion Report Writer では、作成したレポートを次のような業界基準の形式で表示できます。 

  コンマ区切り（*.csv 、*.cdf） 

  テキスト（*.txt） 

  HTML （*.htm, *.html） 

  MIME HTML 、埋め込み画像付き（*.mhtml） 

  Excel® スプレッドシート（*.xls） 

  Adobe® PDF （*.pdf） 

  画像（*.gif） 
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次の手順は、Orion Report Writer から前述の形式のいずれかにオープン レポートをエクス 

ポートするために必要なステップです。 

Report Writer からレポートをエクスポートするには： 

1. 次のいずれかをクリックし、エクスポートするレポートを選択します。 

 左側のペインでファイル ツリーからレポートを選択します 

 File > Open （ファイル > オープン）を選択して既存のレポートを開きます 

 File > New Report （ファイル > 新規レポート）を選択して新規レポートを作成しま

す。レポート作成の詳細については、123 ページの「定義済み Orion NPM レポー

ト」を参照してください。 

2. File > Export （ファイル > エクスポート）を選択してから、レポートをエクスポートしたい形

式でクリックします。 

3. 選択した形式でエクスポートしたい、開いているレポートのフィールドにチェックを入れ、OK 

をクリックします。 

4. ファイルを保存する場所を選択します。 

5. ファイル名 を入力してから Save （保存）をクリックします。 

デバイス可用性レポートの例 

次の手順では、前の週のネットワーク デバイス可用性情報のレポート例を作成できます。最

終レポートは、最大のエラーが最初に表示されるように並べ替えられます。まだダウンしたままの

ダウン ノードは、可用性が高い順に一覧表示されているすべてのデバイスと一緒に最上部に

表示されます。 

注記： レポート作成時はいかなるときでも File > Save （ファイル＞保存）で作業内容を保

存することができます。最初に保存する際は、レポートにファイル名をつけるか、デフォルトを受

諾する必要があります。デフォルトは次の手順で割り当てるレポート タイトルになります。 

ネットワーク デバイスの可用性情報レポートの例を生成するには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Report Writer （スタート > すべてのプログラム > SolarWinds Orion > 

アラート、レポートおよびマッピング > Report Writer ）をクリックします。 

2. File > New Report （ファイル＞新規レポート）とクリックします。 

3. このレポートでは前週の可用性に関するレポートが必要なので、Historical 

Availability Details （履歴可用性の詳細）を選択してから OK をクリックします。 
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4.  Report Group （レポート グループ）フィールドに My Reports （マイ レポート）と入力

し、Report Title （レポート タイトル）として Last Week’s Availability （前週の

可用性）と入力します。 

 

5. Portrait （縦）の用紙方向を選択し、Make this Report availablefrom the 

Orion website （このレポートを Orion ウェブサイトから利用できるようにする）にチェック

を入れます。 

  

 



 管理者ガイド  SolarWinds Orion Network Performance Monitor 

 

 

338 レポートの作成と表示  –  コア 

6. Select Fields （フィールドの選択）をクリックします。 

 

 

7. Browse （参照）（…）をクリックし、Add a new field （新規フィールドの追加）を選択し

ます。 

 

 

8. Field （フィールド）のアスタリスクをクリックし、Network Nodes > Node Details > 

Node Name （ネットワーク ノード > ノードの詳細 > ノード名）を選択します。 

 

9. Browse （参照）（…）をクリックし、Add a new field （新規フィールドの追加）を選択し

ます。 

 

 



SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 レポートの作成と表示  –  コア 339 

10. Field （フィールド）のアスタリスクをクリックし、Network Nodes > Node Status > 

Status Icon （ネットワーク ノード > ノード ステータス > ステータス アイコン）を選択します。 

注記： このフィールドは、カラー表示されるレポートを視覚的に際立たせますが、モノクロで

印刷された場合にはほとんど、あるいはまったく差はありません。 

 

 

11. Browse （参照）（…）をクリックし、Add a new field （新規フィールドの追加）を選択し

ます。 

12. Field （フィールド）のアスタリスクをクリックし、Network Nodes > Node Status > 

Status （ネットワーク ノード > ノード ステータス > ステータス）を選択します。 

 

 

13. Execute SQL Query （SQL クエリーの実行）をクリックすると、プレビュー ウィンドウにレ

ポートのデータが表示されます。 
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注記： レポートのプレビューには、現在のステータスと履歴ステータスの双方に関する情報

が表示されます。現在のステータスへのエントリは、紛らわしさを避けるためラベルを書き換

える必要があります。 

 

 

14. Field Formatting （フィールドの書式設定）をクリックします。 

 

 

15. Select a Field （フィールドの選択）リストで Status （ステータス）をクリックし、Column 

Header （列ヘッダー）のエントリを Current Status （現在のステータス）に変更します。 

 

 

16. Select a Field （フィールドの選択）リストで  Status_Icon をクリックし、Column 

Header （列ヘッダー）のエントリを Current Status （現在のステータス）に変更します。 
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17. Execute SQL Query （SQL クエリーの実行）をクリックします。 

注記： カラム幅は調節できます。カラム幅を変更するには、カーソルをカラム ディバイダに

おき、別の位置にドラッグさせます。 

18. Select Fields （フィールドの選択）をクリックします。 

19. Status （ステータス）フィールドの行で  sort （並べ替え）のアスタリスクをクリックし、

descending （降順）を選択します。 

 

 

20. Execute SQL Query （SQL クエリーの実行）をクリックし、選択内容を確定します。 

21. Browse （参照）（…）をクリックし、Add a new field （新規フィールドの追加）を選択し

ます。 

22. Field （フィールド）のアスタリスクをクリックし、Historical Response Time and 

Availability > Availability （履歴応答時間と可用性 > 可用性）を選択します。 

 

 

23. 新しい行で sort （並べ替え）のアスタリスクをクリックし、ascending （昇順）を選択し 

ます。 

24. Execute SQL Query （SQL クエリーの実行）をクリックし、レポートを表示します。 

25. Time Frame （時間枠）をクリックします。 



 管理者ガイド  SolarWinds Orion Network Performance Monitor 

 

 

342 レポートの作成と表示  –  コア 

 

26. Relative Time Frame （関連タイム フレーム）を選択して、テキスト フィールドに 7 と

入力し、リストから Days （日）を選択します。 

 

 

27. レポートを 1 日ごとに分析したい場合は、Summarization （要約）をクリックして選択内

容を指定します。 

 

 

 

 

28. レポートのフィルタリングを行う場合は、Filter Results （結果のフィルタ）をクリックし、

Select Fields （フィールドの選択）タブと同様にフィルタリング規則を指定します。 
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29. File > Save （ファイル＞保存）とクリックして作業内容を保存します。 

Orion Report Scheduler の使用 

Orion では、レポートの自動生成・配布を設定可能な Orion Report Scheduler を提供し

ています。 

スケジュール済みレポート ジョブの作成 

次の手順では、定期的に印刷またはメール送信される Orion レポート用にスケジュールを設

定したレポート ジョブを作成します。 

レポートのスケジュールを設定するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. Reports （レポート）をクリックします。 

3. 必要に応じて + をクリックし、スケジュールしたいレポートを見つけます。 

4. スケジュールしたいレポートの名前をクリックします。 

5. スケジュールしたいレポートの URL をコピーします。 

6. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Orion Report Scheduler （スタート  > すべてのプログラム  > 

SolarWinds Orion > アラート、レポート、およびマッピング > Orion Report Scheduler 

）をクリックします。 

7. Edit > Add New Job （編集 > 新規ジョブの追加）をクリックします。 

8. このスケジュール済みレポートのジョブ名を入力し、Continue （続行）をクリックします。 

9. スケジュールしたいレポートの URL をリンク フィールドに貼り付けます。 

10. スケジュールを設定しているレポートを表示するために Windows ログイン資格証明を入
力する必要がある場合は、NT Account （NT アカウント）のログイン タブをクリックし、ログ

インに必要なユーザー アカウントの詳細を入力します。  
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11. Orion ウェブ コンソールのバナーやメニュー バーを除いた印刷可能なレポートを作成する
には、Orion Web Login （ Orion ウェブ ログイン）タブで Retrieve a Printable 

Version of this Page （このページの印刷可能なバージョンを取得する）にチェックを入

れます。 

12. スケジュールを設定しているレポートで Orion ユーザー アカウントが必要な場合は、
Orion Web Login （Orion ウェブ  ログイン）タブで  Send Orion Username / 

Password in URL （URL で Orion ユーザー名 / パスワードを送信する）にチェックを入

れ、Orion レポートを表示するために必要なユーザー資格証明を入力します。 

13. Continue （続行）をクリックします。 

14. レポート ジョブ向けのスケジュールを設定し、Continue （続行）をクリックします。 

15. レポートを電子メールで送信する場合は、次の手順を実行します。 

a. Email the Web Page (as HTML) （HTML としてウェブ ページをメールする）また

は Email the Web Page (as PDF) （PDF としてウェブ ページをメールする）のい

ずれかが選択されていることを確認してから、Continue （続行）をクリックします。 

b. Email To （メール送信先）タブの適切なフィールドに必要なメール アドレスと件名を

入力します。 

c. Email From （メール送信元）タブに氏名と返信先アドレスを入力します。 

d. SMTP Server （ SMTP サーバー）タブでホスト名または IP アドレスを入力し、

Orion サーバーからのメール送信に使用されるサーバーのポート番号を確認します。 

e. Continue （続行）をクリックします。 

16. レポートを印刷したい場合は、次の手順を実行します。 

a. Print the Web Page （ウェブ ページの印刷）を選択し、Continue （続行）をク 

リックします。 

b. プリンタ、方向、印刷したい部数を選択します。 

c. Continue （続行）をクリックします。 

17. レポートをメールする Windows アカウントのユーザー名とパスワードを入力します。 

18. Continue （続行）をクリックします。 

19. このジョブに関するさらなるコメントや注記を追加し、Finish （完了）をクリックします。 



SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 レポートの作成と表示  –  コア 345 

HTTPS による Orion Report Scheduler の使用 

HTTPS を使用して Orion ウェブ コンソールでレポートを表示する場合、要求されたレポート

を印刷または送信する前に信頼できる認証を提供するよう  HTTPS サーバーが Orion 

Report Scheduler に要求することがあります。HTTPS で Orion Report Scheduler を使

用するには、Orion Report Scheduler を使い、HTTPS サーバーからレポートを要求してい

るあらゆるユーザー アカウントに有効な認証を提供するか、Orion Report Scheduler ユー 

ザーの使用する各ブラウザをチェックする認証を無効にします。これについては、次の手順を参

照してください。 

認証チェックを無効化するには： 

1. Internet Explorer を設定する場合は、次の手順を実行します。 

a. ユーザーのコンピュータで Internet Explorer を開きます。 

b. Tools > Internet Options （ツール > インターネット オプション）をクリックし、

Advanced （詳細）タブをクリックします。 

c. Security （セキュリティ）セクションで、以下のオプションがクリアになっていることを確認

します。 

  発行者の認証取り消しをチェックします 

  サーバーの承認取り消しをチェックします（再起動が必要） 

  無効なサイト認証について警告します 

d. OK をクリックします。 

2. Mozilla Firefox を設定する際は、次の手順を実行します。 

a. ユーザーのコンピュータで Mozilla Firefox を開きます。 

b. Tools > Options （ツール > オプション）をクリックします。 

c. Advanced （詳細）をクリックしてから、Encryption （暗号化）タブをクリックします。 

d. Protocols （プロトコル）領域で、Use SSL 3.0 （SSL 3.0 を使用する）と Use 

TLS 1.0 （TLS 1.0 を使用する）の双方をクリアにします。 

e. Certificates （認証）領域で、Select one automatically （自動的に 1 つを選

択する）を選択し、Validation （検証）をクリックします。 

f. Use the Online Certificate Status Protocol (OCSP) （オンライン認証ス 

テータス プロトコル（OCSP ）を使用する）オプションをクリアし、認証の現在の検証

状況を確認してから OK をクリックします。 
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Orion Report Scheduler のトラブルシューティング 

Orion Report Scheduler の使用に際しては、次のような既知の問題が発生しています。 

 Report Scheduler でのウェブ ページの印刷 

 Orion Report Scheduler および Internet Explorer Enhanced Security 

Report Scheduler でのウェブ ページの印刷 

Report Scheduler でウェブ ページの印刷をスケジュールしているときに Orion で警告ダイアロ

グが開くと、印刷ジョブを完了できない場合があります。Report Scheduler で設定された印

刷ジョブを確実に完了するには、次の点を確認してください。 

 Print the Web Page （ウェブ ページを印刷）を、Report Scheduler でスケジュール設

定済みタスクが設定するときに選択します。 

 SWToolset.exe や javascript 警告など、開いているダイアログはすべて閉じます。 

 スケジュール設定している印刷タスクはすべて、現在のユーザーがログインしていなくても実

行するように設定します。 

Orion Report Scheduler および Internet Explorer Enhanced Security 

Internet Explorer (IE) Enhanced Security Configuration をインストールすると、スケ 

ジュール設定済みのレポート印刷ジョブを実行しようとしている Orion Report Scheduler が

断続的にフリーズする場合があります。この問題に対処するには、次の手順のいずれかを実行

してください。 

 （推奨） 信用できるサイトとして Orion ウェブ コンソールをブラウザで追加します。Internet 

Explorer Enhanced Security Configuration および信用できるサイトのリストへの追

加の詳細については、Microsoft の文書「拡張セキュリティ設定ゾーンへのサイトの追

加 」を参照してください。 

 IE Enhanced Security Configuration をアンインストールします。 

http://msdn.microsoft.com/en-us/library/ms537181(v=VS.85).aspx
http://msdn.microsoft.com/en-us/library/ms537181(v=VS.85).aspx
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レポートおよびアカウントの制限 

Orion Report Writer で作成したレポートは、Orion ウェブ コンソールのアカウント制限に従い

ます。セキュリティのため、デフォルトでは、Orion 管理者がアクセス権を特に認めない限り、アカ

ウントが制限されているユーザーはレポートを使用できません。次の手順では、アカウント制限

ユーザーのためにレポート フォルダを作成し、アカウント制限ユーザーが Orion レポートにアクセ

スできるよう設定します。 

注記： ユーザー アカウントの作成の詳細については、249 ページの「新規アカウントの作成」を

参照してください。ユーザー アカウントへのアカウント制限の適用の詳細については、253 ペー

ジの「アカウント制限の設定 253 」を参照してください。 

アカウント制限ユーザーにレポートへのアクセスを許可するには： 

1. Orion レポート フォルダを開きます。 

注記： Orion Report Writer で作成または事前定義したレポートはすべて、デフォルトで 

C:\Program Files\Solarwinds\Orion\Reports に保存されています。 

2. アカウント制限ユーザーの名前を使って新しいフォルダを作成します。 

3. アカウント制限ユーザーに見てほしいレポートを Orion レポート フォルダからアカウント制限

ユーザーの新規フォルダにコピーします。 

4. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

5. 管理者として Orion ウェブ コンソールにログインします。 

6. ウェブ コンソールの右上の Settings （設定）をクリックします。 

7. Orion Website Administration （ウェブサイト管理）ページの Accounts （アカウント）グ

ループ内の Manage Accounts （アカウント管理）をクリックします。 

8. アカウント制限ユーザーを選択し、Edit （編集）をクリックします。 

9. Default Menu Bar and Views （デフォルトのメニュー バーとビュー）セクションで、アカウン

ト制限ユーザーのために Orion レポート フォルダで作成した Report Folder （レポート 

フォルダ）を選択します。 

10. Submit （送信）をクリックします。 
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第 23章 

Syslog 監視メッセージ  –  コア 

Syslog メッセージは、指定されたイベントに応答する際にネットワーク デバイスが送信できる

一種のリアルタイム通知です。Orion では、監視されているネットワーク デバイスから UDP  

ポート 514 で Syslog メッセージを受信する SolarWinds Syslog サービスを提供しています。

SolarWinds Syslog サービスでは、SQL サーバーへの複数の接続も開くことができるため、あ

らゆる監視デバイスからの多数の受信 Syslog メッセージを同時に処理することができます。

受信したメッセージはデコードされ、Orion データベースで保存されます。メッセージは、承認さ

れるまでウェブ コンソールの Syslog ビューまたは Syslog ビューアで表示できます。ウェブ コン

ソールの Syslog ビューでは、次の基準のどれか、またはすべてによってフィルタリングされている

現在のメッセージにすばやくアクセスできます。 

  メッセージを送信しているネットワーク オブジェクトの名前またはタイプ。 

  メッセージの重大度、機能、タイプ、またはパターン 

  メッセージが送信される期間。 

Syslog ビューアでは、カスタム規則を使用して Syslog メッセージのビューを調節できます。さ

らに、Orion データベースの検索と、受信 Syslog メッセージ向けの Syslog 固有アラートの設

定も実行できます。 

注記： Syslog メッセージを送信するようにネットワーク デバイスを設定するときは、Orion 

NPM サーバーに割り当てられている IP アドレスにメッセージが送信されていることを確認してく

ださい。Syslog メッセージ用にネットワーク デバイスを適切に設定するには、デバイス ベンダー

の提供する文書を参照してください。  

Orion Syslog ポートの設定 

Orion は、ポート 514 （UDP）で Syslog メッセージをリスンします。このポートは次の手順で

示しているように、SyslogService.exe.config ファイルで設定できます。 

注記： Configuration Wizard （設定ウィザード）を実行すると、SyslogService.exe.config  

ファイルで実行された変更がすべて元に戻ります。Configuration Wizard （設定ウィザード）を実行

した場合、この手順を繰り返して必要なポートの設定を復元する必要があります。 

Syslog ポートを設定するには： 

1. 管理者権限を持つアカウントを使用し、Orion サーバーにログオンします。 
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2. テキスト エディタで SyslogService.exe.config を開きます。 

注記： デフォルトで、SyslogService.exe.config は C:\Program 

Files\SolarWinds\Orion\Orion\SyslogService\ にあります。 

3. 次の行を見つけます。 

<add key="UDPListenPort" value="514"> 

4. 必要に応じて value="514" を編集し、監視デバイスが Orion サーバーに Syslog メッ

セージを送信するように設定しているポートを示します。 

5. SyslogService.exe.config を保存します。 

ウェブ コンソールの Syslog メッセージ 

Orion ウェブ コンソールでは、Syslog 固有のリソースと Syslog ビュー（Orion サーバーが受信

した Syslog メッセージの表を示す）の双方が表示されます。次のセクションでは、利用可能な 

Syslog リソースと、Orion ウェブ コンソール内で Syslog メッセージを表示および承認する手

順の概要を説明します。 

Syslog リソース 

Orion NPM では、ウェブ コンソール ビューに含める次の Syslog 関連リソースを提供します。 

詳細な Syslog カウント 

各 Syslog メッセージでは、重大度が指定されています。Syslog 重大度の詳細について

は、363  ページの「Syslog 重大度」を参照してください。アドバンスト Syslog カウント リ

ソースは、現在表示されているノードで受信したすべての Syslog メッセージを重大度レ

ベルに基づいて分類します。このリソースは、受信した Syslog メッセージ件数を重大度

別に示します。 

アドバンスト Syslog パーサー 

アドバンスト Syslog パーサー リソースでは、表示しているノードで最も直近に受信した 

Syslog メッセージの包括的なビューを示します。重大度レベルの最も直近のメッセージが

それぞれ一覧表示されます。Syslog 重大度の詳細については、363  ページの「Syslog 

重大度」を参照してください。 

アドバンスト Syslog サマリー 

アドバンスト Syslog サマリー リソースは、現在表示しているノードで受信された Syslog 

メッセージすべてをメッセージのタイプ別に分類します。メッセージのタイプは、Syslog メッ 

セージ パケットでコード化されます。このリソースでは、メッセージ タイプごとに重大度、メッ

セージ送信元のホスト名または IP アドレス、受信した Syslog メッセージの総数を示し 

ます。 



SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 Syslog 監視メッセージ  –  コア 351 

直近の Syslog メッセージ 25 件 

Last 25 Syslog Messages （直近の Syslog メッセージ 25 件）リソースには、監視ネッ

トワークから表示ノードに送信された直近の Syslog メッセージ 25 件のリストが表示され

ます。メッセージごとに、このリソースはメッセージの送信日時、メッセージを送信したデバイ

スのホスト名と IP アドレス、メッセージのテキストを示します。 

ホスト名、IP アドレス、またはメッセージのテキストをクリックすると、これに対応する Object 

Details （オブジェクトの詳細）ページが開き、メッセージを送信している監視されたネット 

ワーク オブジェクトについて包括的な診断情報が表示されます。 

Edit （編集）をクリックすると、Edit Last 25 Syslog Messages （直近の Syslog メッ 

セージ 25 件を編集）ページが開き、表示されるメッセージの最高件数を設定できます。

メッセージを表示する期間を選択し、このリソースが表示するメッセージを限定するフィルタ

を設定します。詳細については、208  ページの「ノード フィルタの使用」を参照してください。 

Syslog サマリー 

Syslog Summary （ Syslog サマリー）リソースでは、特定期間にわたって監視ネットワー

ク デバイスから表示ノードが受信する Syslog メッセージの件数が一覧表示されます。 

ウェブ コンソールでの Syslog メッセージの表示 

次の手順で望ましいメッセージのグループ化基準を選択すると、リスト ビューをカスタマイズでき

ます。 

ウェブ コンソールで Syslog メッセージを表示するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. Orion ウェブ コンソールにログインし、Views （ビュー）ツールバーで Syslog をクリックし 

ます。 

3. 特定の Syslogenabled ネットワーク オブジェクトの Syslog メッセージを表示したい場
合は、Network Object （ネットワーク オブジェクト）フィールドで選択したオブジェクトを指

定します。 

注記： Syslog メッセージを Orion サーバーに送信したオブジェクトのみが、このフィールド

に表示されます。 

4. デバイスのタイプ別に Syslog メッセージ表のフィルタリングを行う場合は、Type of 

Device （デバイスのタイプ）フィールドで表示を制限したいタイプを選択します。 
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5. 重大度別に Syslog メッセージ表のフィルタリングを行いたい場合は、Select Severity 

（重大度を選択）フィールドで、表示を制限する重大度レベルを選択します。 

注記： 詳細については、363  ページの「Syslog 重大度」を参照してください。 

6. 機能別に Syslog メッセージ表のフィルタリングを行いたい場合は、Select Facility 

（機能を選択）フィールドで表示を制限したい機能を選択します。 

注記： 詳細については、363  ページの「Syslog 重大度」を参照してください。 

7. 指定されたタイプのメッセージのみを表示するよう Syslog メッセージ表を制限したい場
合は、Message Type （メッセージのタイプ）フィールドに適切なストリングを入力します。 

8. 指定されたパターンを含むメッセージのみを表示するよう Syslog メッセージ表を制限す
る場合は、Message Pattern （メッセージのパターン）フィールドに適切なストリングを入

力します。 

注記： 提供されているパターンが次のいずれかでない限り、パターン ストリングの前後でア

スタリスク（ * ）がワイルドカード文字として必要となります。 

  メッセージの最初 

  メッセージの最後 

  完全なメッセージ 

9. 特定期間の Syslog メッセージのみを表示したい場合は、Time Period （期間）メ 

ニューで期間を選択します。 

10. Show Messages （メッセージを表示）フィールドで表示するメッセージの件数を確認し

ます。 

11. クリアまたは承認されたメッセージを  Syslog ビューに残す場合は、Show Cleared 

Messages （クリアされたメッセージを表示する）にチェックを入れます。 

12. Refresh （更新）をクリックし、新しい設定で Syslog メッセージ リストを更新します。 

ウェブ コンソールの Syslog メッセージの承認 

次の手順に示すように、Orion ウェブ コンソールでは Syslog メッセージを簡単に承認できます。 

Orion ウェブ コンソールで Syslog メッセージを承認するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

2. Orion ウェブ コンソールにログインします。 
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3. Views （ビュー）ツールバーで Syslog をクリックします。 

4. Syslog メッセージ表のフィルタリング基準を入力します。詳細については、350 ページの

「ウェブ コンソールの Syslog メッセージ」を参照してください。 

5. Refresh （更新）をクリックし、選択された表示基準がすべて有効になっていることを確認

します。 

6. 承認したいメッセージにチェックを入れ、Clear Selected Messages （選択したメッセー

ジをクリア）をクリックします。 

Syslog ビューアの使用 

Orion では、ネットワークで Syslog メッセージを表示し、承認できるスタンドアロンの Syslog 

ビューア アプリケーションも提供しています。Syslog ビューアはネットワークから Syslog メッセー

ジを収集し、すぐにレビュー・検索できるリストで表示するため、ネットワークを簡単に監視できま

す。次のセクションでは、Syslog ビューア アプリケーションを使用し、ネットワーク上で Syslog 

メッセージに応答してアラートを表示、承認、トリガーする手順を説明します。 

Syslog ビューアを開くには、Start > All Programs > SolarWinds Orion > Syslog 

and SNMP Traps > Syslog Viewer （スタート > すべてのプログラム > SolarWinds 

Orion > Syslog および SNMP トラップ > Syslog ビューア）をクリックします。   

最新メッセージの表示と承認 

Syslog ビューアでは、簡単にメッセージを表示、承認できます。次の手順では、最新の 

Syslog メッセージを表示して承認します。 

最新の Syslog メッセージを表示・承認するには： 

1.  View > Current Messages （表示 > 最新メッセージ）をクリックします。 

2.  次のいずれかの方法を使用して最新メッセージを承認します。 

 任意のメッセージを右クリックして、Acknowledge Selected （選択項目を承認）

を選択します。 

 Syslog ビューアに Acknowledged （承認済み）列を追加し、承認するメッセージ

にチェックを入れます。詳細については、354 ページの「Syslog サーバーの設定」を

参照してください。 
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Syslog メッセージの検索 

収集された Syslog メッセージは、Syslog ビューア内で検索できます。次の手順では、

Syslog メッセージを検索し、さらに検索結果の書式設定を行います。  

Syslog メッセージ リストを検索するには： 

1. View > Search Messages （表示 > メッセージの検索）をクリックします。 

2. 適切な検索基準を入力し、Search Database （データベースの検索）をクリックします。 

3. ナビゲーションを容易にするためにメッセージをグループ化する場合は、Grouping （グ 

ループ化）リストでグループ化のタイプを選択します。 

注記： メッセージは、Current Messages （最新メッセージ）ビューでの承認と同じように、

検索結果でも承認できます。詳細については、354 ページの「Syslog サーバーの設定」

を参照してください。 

4. 表示されるメッセージの件数を制限したい場合は、Maximum number of 

messages to display （表示するメッセージの最大件数）フィールドで数字を入力する

か選択します。 

5. 検索基準を満たすメッセージをすばやく表示するには、Auto Refresh every number 

seconds （Ｘ秒ごとに自動更新）フィールドで数字を選択します。 

注記：  自動更新は、現在のメッセージを表示している場合にのみ利用できます。

Date/Time Range （日時範囲）は、Today （今日）、Last 24 Hours （過去 24 時

間）、Last 2 Hours （過去 2 時間）、Last Hour （過去 1 時間）のいずれかに設定す

る必要があります。 

Syslog サーバーの設定 

次の手順に従い、Syslog ビューアを起動、設定してください。 

Syslog ビューアを起動・設定するには： 

1. Start > All Programs > SolarWinds Orion > Syslog and SNMP Traps > 

Syslog Viewer （スタート > すべてのプログラム > SolarWinds Orion > Syslog およ

び SNMP トラップ > Syslog ビューア）をクリックします。 

2. File > Settings （ファイル＞設定）をクリックします。 

3. Syslog Server Settings （ Syslog サーバー設定）ウィンドウで General （一般）タブを

クリックします。 
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4. Maximum number of messages to display in Current Messages view （現

在のメッセージ ビューで表示するメッセージの最大件数）スライダを調節し、表示するメッ

セージの件数を設定します。 

5. Automatically Refresh the Current Messages View （現在のメッセージのビュー
を自動的に更新）したい場合は、このオプションにチェックを入れ、中央のスライダで更新 

レートを設定します。 

6. Retain Syslog messages for how many days? （Syslog メッセージは何日間

保持しますか? ）を調整し、Syslog メッセージをデータベースに残す期間を設定します。 

7. Displayed Columns （表示列）タブをクリックします。 

8. 矢印キーを使用し、Current Messages （現在のメッセージ）ビューで、表示する情報 

フィールドを選択して順序を決めます。 

注記： Acknowledged （承認済み）列を選択して使用中のビューに追加すると、

Syslog メッセージを容易に承認できます。 

9. Current Messages （現在のメッセージ）ビューで Syslog メッセージのテキストを折り
返し表示したい場合は、Word wrap long messages （長いメッセージは折り返し表

示する）にチェックを入れます。 

10. Syslog サーバーを Syslog メッセージの主要なビューアとして使用しない場合は、
Message Parsing （メッセージのパース）タブを選択して次の手順を実行します。 

注記： Orion データベースの Syslog 表の中で次のデータ ポイントを保存します。追加

済みのデータを各記録から削除すると、データベースのサイズを事前に縮小できます。 

11. Remove embedded Date/Time from Syslog Messages （埋め込まれた日時を 

Syslog メッセージから削除する）、Remove Message Type from Syslog 

Messages （メッセージのタイプを  Syslog メッセージから削除する）、Remove 

Domain Name from DNS Lookups （ドメイン名を DNS ルックアップから削除する）

にチェックを入れます。 
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Syslog ビューアのフィルタとアラートの設定 

Syslog ビューアは、ネットワーク デバイスから受信した Syslog メッセージが定義済みの規則

に一致する場合、Orion アラート アクションのシグナルを送信するよう設定することができます。

次の手順では、Syslog メッセージをフィルタリングし、判断に従ってアラート アクションを開始す

る規則を確立します。 

注記： Syslog 規則は、非管理状態のノードには適用できません。非管理状態としてのノー

ド指定の詳細については、55 ページの「ウェブ コンソールでのデバイス監視」を参照してください。 

Syslog ビューアのフィルタとアラートを設定するには： 

1. Start > All Programs > SolarWinds Orion > Syslog and SNMP Traps > 

Syslog Viewer （スタート > すべてのプログラム > SolarWinds Orion > Syslog およ

び SNMP トラップ > Syslog ビューア）をクリックします。 

2. File > Settings （ファイル＞設定）をクリックします。 

3. Alerts/Filter Rules （アラート / フィルタ規則）をクリックします。 

4. 新しい規則を作成している場合は、Add New Rule （新規規則の追加）をクリックします。 

5. 既存の規則を編集している場合は、規則を選択してから Edit Selected Rule （選択

した規則を編集）をクリックします。 

6. General （一般）タブで次の手順を実行します。 

a. Rule Name （規則名）を入力または編集し、Enabled （有効）にチェックを入れます。 

b.  Apply this Rule to （この規則の適用対象）リストから適切なサーバーを選択します

。 

c. Source IP Addresses （ソース IP アドレス）エリアで、この規則を適用する IP アド

レスまたはサブネットを入力します。 

注記： このタブの例を使用し、ソース IP アドレスのリストが適切に書式設定されてい

ることを確認します。 

7. 特定のホスト、ドメイン、またはホスト名パターンのメッセージのみに規則を限定したい場
合は、DNS Hostname （DNS ホスト名）タブに DNS ホスト名パターンを入力します。 

 注記： 

 DNS ホスト名パターン規則では、大文字と小文字を区別します。 

 Use Regular Expressions in this Rule （この規則では正規表現を使用す

る）にチェックを入れている場合は、「like」ステートメントの代わりに正規表現を使用

できます。Orion NPM での正規表現の使用に関する詳細については、463 ページ

の「正規表現パターン マッチング」を参照してください。 
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8. Syslog メッセージ内の特定のメッセージ タイプまたはテキストにのみ規則を制限したい
場合は、必要に応じて Message （メッセージ）タブで Message Type Pattern （メッ 

セージ タイプのパターン）および Syslog Message Pattern （ Syslog メッセージのパ 

ターン）の規則を入力します。 

注記： 

 このタブに記載されている例を使い、リストを適切に書式設定してください。 

 Use Regular Expressions in this Rule （この規則では正規表現を使用す

る）にチェックを入れている場合は、「 like 」ステートメントの代わりに正規表現を使用

できます。Orion NPM での正規表現の使用の詳細については、463 ページの「正

規表現パターン マッチング」を参照してください。 

9. 特定の重大度または機能タイプを適用したい場合は、Severity / Facility （重大度 / 

機能）タブで適用したい重大度と機能タイプにチェックを入れます。 

注記： デフォルトで、すべてのメッセージの重大度と機能は選択されています。Syslog 重

大性と機能の詳細については、362 ページの「Syslog メッセージの優先順位」を参照し

てください。 

10. 規則の適用を特定期間に限定したい場合は、Time of Day （時間帯）タブを選択し、

Enable Time of Day checking （時間帯を有効にする）にチェックを入れます。時間

帯を入力したら、規則を適用する曜日にチェックを入れます。 

注記： 

 時間帯を有効にすると、CPU のオーバーヘッドが増加します。 

 指定された時間枠外にメッセージを受信しても、アラートはトリガーされません。 

11. 規則を満たすメッセージが指定した件数届くまでアラート アクションを抑制したい場合は、
次の手順を実行してください。 

a. Trigger Threshold （トリガーしきい値）タブを選択します。 

b. Define a Trigger Threshold for this Rule （この規則のトリガーしきい値を定

義する）にチェックを入れます。 

c. 必要に応じてオプションの値を入力します。 

注記： Suspend further Alert Actions for （以下についてさらなるアラート アクショ

ンを一時停止：）にチェックが入っている場合は、指定期間が過ぎるまでアラート アクション

は送信されません。当該期間が経過すると、新しいアラートのみが送信されます。その期

間中に抑制されたアラートはすべて、廃棄されます。 
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12. 次の手順で示しているように、Alert Actions （アラート アクション）タブで Syslog アラート 

アクションを設定します。 

a.  新しいアクションを規則に関連付けている場合は、Add New Action （新規アクシ

ョンを追加）をクリックします。利用可能なアクションの詳細については、358 ページの

「利用可能な Syslog アラート アクション」を参照してください。 

b. 当該規則について既存のアクションを編集したい場合は、リストからアクションを選択
して、Edit Selected Action （選択したアクションの編集）をクリックします。 

c. 必要に応じてアクションを設定します。利用可能なアクションの詳細については、358

ページの「利用可能な Syslog アラート アクション」を参照してください。 

注記： Syslog アラートでは独自の変数のセットを使用します。利用可能な Syslog 

変数の詳細については、361 ページの「Syslog アラート変数」を参照してください。 

d. アクションを削除する必要がある場合は、アクションを選択して Delete Action （ア

クションの削除）をクリックします。 

e. 矢印ボタンを使用し、アクションを実行する順序を設定します。 

注記： アクションは一覧表示されている順序で上から下に処理されます。 

f. OK をクリックして変更内容をすべて保存し、Syslog Viewer Settings （Syslog  

ビューアの設定）に戻ります。 

13. 矢印ボタンを使用して、規則を適用する順序を決めます。 

注記： 規則は表示されている順序で上から下に処理されます。 

利用可能な Syslog アラート アクション 

次のリストでは、各 Syslog アラート タイプで利用可能なアクションの定義を示します。アラート 

アクションを割り当てる方法の詳細については、356 ページの「Syslog ビューアのフィルタとアラ

ートの設定」を参照してください。 

Syslog メッセージの廃棄 

Syslog サーバーに送信された望ましくない Syslog メッセージを削除できます。 

Syslog メッセージへのタグ付け 

受信した Syslog メッセージにカスタム タグを追加できます。タグを割り当てる際は必ず 

ビューアに Tag （タグ）列を含めてください。 

Syslog メッセージの変更 

Syslog メッセージの重大度、機能、タイプ、または内容を変更できます。 
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 ファイルへのメッセージのログ 

ファイルと、ファイルに送信された Syslog メッセージにタグを付ける一連の変数を指定でき
ます。使用したいログ ファイルがすでに作成されていることを確認してください。アラートでは
ファイルを作成できません。 

 Windows イベント ログ 

ローカルまたはリモート Windows イベント ログにメッセージを書き込みます。 

 Syslog メッセージの転送 

IP アドレス、またはホスト名、および Syslog イベントを転送するポートを指定します。 

 新しい Syslog メッセージの送信 

特定のポートで特定の IP アドレスまたはホスト名に送信された新しい Syslog メッセージ
をトリガーします。カスタマイズ可能な重大度、機能、メッセージを使用できます。 

 SNMP トラップの送信 

特定のトラップ テンプレートに従い、特定の SNMP コミュニティ ストリングを使用して IP 

アドレスにトラップを送信できます。 

 サウンドの再生 

一致する Syslog メッセージを受信した際にサウンドを再生できます。 

 テキスト音声変換出力 

音声エンジン、音声、ピッチ、音量、読み上げるメッセージを定義します。 

 外部プログラムの実行 

バッチ ファイルを使用して起動する外部プログラムを指定できます。このアクションは、
Orion NPM でリアルタイム変更通知を作成する際に使用します。 

 外部 VB スクリプトの実行 

選択されたスクリプト インタープリタ エンジンと保存済みのスクリプト ファイルを使用し、VB 

スクリプトを起動することができます。 

 Windows ネット メッセージの送信 

特定のコンピュータ、またはドメインあるいはワークグループ全体のいずれかにネット メッセー

ジを送信できます。 

注記：  SolarWinds が  Orion のインストールをサポートしている  WindowsNet 

Messaging に対応している唯一のオペレーティング システムは、Windows Server 2003 

および Windows XP です。SolarWinds は、Windows XP で Orion の評価版のみをサ

ポートします。 
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電子メール / 呼び出しの送信 

特定の SMTP を使用し、カスタマイズ可能な件名をメッセージを含むメールを、指定され

たアカウントから指定されたアドレスに送信します。 

Syslog 規則の処理を停止 

一致する Syslog メッセージの Syslog 規則の処理を停止します。 

Syslog メッセージの転送 

Syslog メッセージの転送アクションでは、受信した Syslog メッセージを転送できます。さらに、

WinPCap バージョン 3.0 以降を Orion NPM サーバーにインストールしている場合は、ス 

プーフィングしたネットワーク パケットとして Syslog メッセージを転送できます。次の手順では、

転送した Syslog メッセージで利用できるオプションを設定します。 

注記： 次の手順では、Forward the Syslog Message （ Syslog メッセージの転送）アラー

ト アクションを編集しているものと想定しています。Syslog アラート アクションの詳細について

は、356ページの「Syslog ビューアのフィルタとアラートの設定」を参照してください。 

Syslog メッセージの送信アクションを設定するには： 

1. 受信した Syslog メッセージの転送先のホスト名または IP アドレスを入力します。 

2. Syslog メッセージで使用している UDP Port （ UDP ポート）を入力します。 

注記： デフォルトは、UDP ポート 514 です。 

3. ソース デバイスの IP アドレスを保持したい場合は、次の手順を実行します。 

a. Retain the original source address of the message （メッセージのオリジナ

ル ソース アドレスを保持する）にチェックを入れます。 

b. 特定の IP アドレスまたはホスト名を Syslog ソースとして指定したい場合は、Use 

a fixed source IP address (or hostname) （固定ソース IP アドレス（またはホ

スト名）を使用する）にチェックを入れて、ソース IP アドレスまたはホスト名を入力し 

ます。 

c. ネットワーク パケットをスプーフィングする場合は、Spoof Network Packet （ネット

ワーク  パケットにスプーフィングする）にチェックを入れてから適切な  Network 

Adapter （ネットワーク アダプタ）を選択します。 

4. OK をクリックし、Syslog 転送アクションの設定を完了します。 
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Syslog アラート変数 

Syslog アラート メッセージでは次の変数を使用できます。各変数はドル記号で始め、中カッ

コで囲む必要があります（例： ${ VariableName } ）。Syslog アラートは、ノード アラート

変数の使用もサポートしています。詳細については、431 ページの「Orion NPM 変数と例」を

参照してください。 

 Syslog 日時変数 

 Syslog 日時変数  説明 

 ${AbbreviatedDOW}  1 週間のうちの現在の曜日。3 文字の省略表示。 

 ${AMPM}  現在の時刻に対応する AM または PM （午前または午後） 

 ${D}  1 ヶ月のうちの現在の日付 

 ${DD}  １ヶ月のうちの現在の日付（ 2 桁の数字、ゼロ詰め） 

 ${Date}  現在の日付。（短い日付形式） 

 ${DateTime} 
 現在の日付と時刻。（ Windows のコントロール パネルが定義した「日付

（短い形式）」と「時刻（短い形式）」） 

 ${DayOfWeek}  1 週間のうちの現在の曜日。 

 ${DayOfYear}  1 年のうちの数値日 

 ${H}  現在の時間 

 ${HH}  現在の時間。2 桁の形式、ゼロ詰め。 

 ${Hour}  現在の時間。24 時間形式 

 ${LocalDOW}  1 週間のうちの現在の曜日。ローカライズされた言語形式。 

 ${LongDate}  現在の日付。（長い日付形式） 

 ${LocalMonthName}  地域の言語での現在の月名。 

 ${LongTime}  現在の時刻。（長い時間形式） 

 ${M}  数字で示した現在の月 

 ${MM}  現在の月。2 桁の数値、ゼロ詰め。 

 ${MMM}  現在の月。3 文字の省略表示。 

 ${MediumDate}  現在の日付。（中間の長さの日付形式） 

 ${Minute}  現在の分。2 桁の形式、ゼロ詰め。 

 ${Month}  現在の月のフルネーム 

 ${N}  現在の月と日 

 ${S}  現在の秒。 

 ${Second}  現在の秒。2 桁の形式、ゼロ詰め。 

 ${Time}  現在の時刻。（短い時刻形式） 

 ${Year2}  2 桁で示す年度 

 ${Year}  4 桁で示す年度 
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 その他の Syslog 変数 

 Syslog 変数  説明 

 ${Application} SolarWinds アプリケーション情報 

 ${Copyright}  著作権情報 

 ${DNS}  完全に適格なノード名 

 ${Hostname}  アラートをトリガーするデバイスのホスト名 

 ${IP_Address}  アラートをトリガーするデバイスの IP アドレス 

 ${Message}  アラートをトリガーするデバイスのステータス 

 ${MessageType}  トリガーされたアラートの名前 

 ${Severity} 
 指定されたメッセージの重大度に対応する数字（ 0 ～ 7 ）。詳細については、

363 ページの「Syslog 重大度」を参照してください。 

 ${Version} SolarWinds ソフトウェア パッケージのバージョン 

Syslog メッセージの優先順位 

優先順位は、各 Syslog メッセージの最初に記載されています。優先順位の範囲は 0 ～ 

191 で、山括弧（< および >）と区切り文字に囲まれています。優先順位は、次の式を使用

して計算されます。 

優先順位＝機能 ｘ 8 ＋ 重大度 

Syslog 機能 

機能の値は、どのプロセスによってメッセージが作成されたかを示します。Syslog プロトコルは

元々 BSD Unix で書き込まれているため、機能は UNIX プロセスとデーモンの名前を反映し

ています（下表を参照）。 

注記： UNIX システムからメッセージを受信している場合は、最初に User （ユーザー）機能

を使用してみてください。Local0 ～ Local7 は UNIX では使用されず、通常はネットワーキン

グ機器で使用されます。たとえば、Cisco ルーターでは Local6 または Local7 を使用します。 

 番号  ソース  番号  ソース 

 0  カーネル メッセージ  12  NTP サブシステム 

 1  ユーザー レベルのメッセージ  13  ログ監査 

 2  メール システム  14  ログ アラート 

 3  システム デーモン  15  クロック デーモン 

 4  セキュリティ / 許可メッセージ  16  ローカル使用 0 （ local0 ） 

 5  Syslog により内部で生成されたメッセージ  17  ローカル使用 1 （ local1 ） 



SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 Syslog 監視メッセージ  –  コア 363 

 番号  ソース  番号  ソース 

 6  ライン プリンタ サブシステム  18  ローカル使用 2 （ local2 ） 

 7  ネットワーク ニュース サブシステム  19  ローカル使用 2 （ local3 ） 

 8  UUCP サブシステム  20  ローカル使用 2 （ local4 ） 

 9  クロック デーモン  21  ローカル使用 2 （ local5 ） 

 10  セキュリティ / 許可メッセージ  22  ローカル使用 2 （ local6 ） 

 11  FTP デーモン  23  ローカル使用 2 （ local7 ） 

 

Syslog 重大度 

下表は、Syslog 重大度のレベルを、各レベルの説明と提案されるアクションと一緒に示したリ

ストです。 

 番号  重大度 提案されるアクション 

 0  緊急事態 

複数のアプリケーションやサーバー、サイトに影響を与える「パニック」状

態。システムは使用できません。待機中の技術スタッフ全員に通知し

てください。 

 1  アラート 
すみやかに是正する必要がある状態（バックアップ ISP 接続の喪失な

ど）。問題を解決できるスタッフに通知してください。 

 2  危機 

すみやかに是正する必要がある状態、または主要システムの障害を

示唆する状態（主要 ISP 接続の喪失など）。危機的な問題はアラー

ト レベルの問題よりも先に解決してください。 

 3  エラー 
急を要さない障害。エラーを特定の時間内に解決する必要があるた

め、開発者または管理者に通知してください。 

 4  警告 

警告メッセージはエラーではありませんが、必要なアクションが実行され

なければエラーが発生することを示唆します。たとえば、ファイル システ

ムが 85% 使用済みになっている場合などです。各項目は特定の時

間内に解決する必要があります。 

 5  通知 

正常ではありませんが、エラー状態でもないイベントを指します。このよ

うな項目は、潜在的な問題を特定するために開発者や管理者への 

メールでサマリーを示す場合があります。すみやかなアクションは必要で

はありません。 

 6  情報 

通常の操作に関するメッセージ レポートやスループット測定などのネッ

トワーク保守機能向けに使われることもあります。アクションは必要あり

ません。 

 7  デバッグ 
アプリケーションのデバッグを行う際、開発者の役に立つ情報。操作中

は役に立たない情報です。 
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第 24章 

SNMP トラップの監視  –  コア 

SNMP トラップは、要求されていない SNMP メッセージを監視デバイスに送ることにより、有

意なイベントの発生を伝えます。SolarWinds トラップ サーバーは UDP ポート 162 で受信ト

ラップ メッセージをリッスンし、Orion NPM データベースでメッセージを復号化、表示、保管しま

す。SolarWinds トラップ サービスを利用すると、Orion NPM はあらゆるタイプの監視ネットワ

ーク デバイスから SNMP トラップを受信して処理します。SolarWinds トラップ サービスはマル

チスレッドであるため、多くの受信トラップを同時に処理できます。 

SNMP トラップは、Trap Viewer アプリケーションで表示できます。Trap Viewer アプリケー 

ションでは、トラップ固有のアラートの設定、トラップの表示と検索、強力なトラップ フィルタリング

の適用を行うことができます。 

注記： SNMP トラップを送信するようにデバイスを設定する際は、Orion NPM サーバーに割

り当てられている IP アドレスにトラップが送信されていることを確認してください。適切な設定を

行うためには、デバイスのベンダーが提供した文書を参照してください。 

SNMP トラップ プロトコル 

SNMPv1 （簡易ネットワーク管理プロトコル）、SNMPv2c 、および関連のあるマネジメント情

報ベース（MIB）では、トラップに対する通知を利用できます。多数のデバイスを監視するときに、

各デバイスに独自のオブジェクトが数多く接続されている場合、あらゆるデバイスのあらゆるオブ

ジェクトから情報を要求することは難しくなります。このような場合、要求がなくてもあらゆる問

題点を Orion NPM SNMP トラップ サーバーに通知するように各管理デバイスを設定するこ

とを検討してください。この設定では、問題のあるデバイスはメッセージを送信してサーバーに通

知を行います。このメッセージはイベントのトラップと呼ばれます。イベントを受信すると、Trap 

Viewer がこれを表示するため、イベントの性質に応じて対策を講じるか、自動的にアクション

をトリガーするかを選択できます。 

ウェブ コンソールでの SNMP トラップの表示 

次の手順に示されているように Traps （トラップ）ビューをカスタマイズします。 

ウェブ コンソールで SNMP トラップを表示するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 
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2. Views （ビュー）ツールバーで Traps （トラップ）をクリックします。 

3. デバイス別にトラップ表ビューをフィルタリングする場合は、Network Object （ネットワーク 

オブジェクト）フィールドでビューを制限するデバイスを選択します。 

4. デバイスのタイプ別にトラップ表をフィルタリングする場合は、Type of Device （デバイス

のタイプ）フィールドで、表示するデバイスのタイプを選択します。 

5. 指定されたタイプのトラップのみを表示するようトラップ表を制限する場合は、Trap Type 

（トラップのタイプ）フィールドで、適切なタイプを選択します。 

6. 特定の IP アドレスに由来するトラップのみを表示するようトラップ表を制限する場合は、
Source IP Address （ソース IP アドレス）フィールドに IP アドレスを入力します。 

7. 指定したコミュニティ ストリングのあるトラップのみを表示するようトラップ表を制限する場合
は、Commnity String （コミュニティ ストリング）フィールドで適切なコミュニティ ストリング

を選択します。 

8. 特定期間のトラップのみを表示する場合は、Time Period （期間）メニューで期間を選

択します。 

9. Show Traps （トラップの表示）フィールドで、表示されるトラップの数を確認します。 

10. Refresh （更新）をクリックして、Traps （トラップ）ビューを新しい設定に更新します。 

Trap Viewer の使用 

Orion NPM サーバーにトラップを送信するようネットワーク上の監視デバイスを設定したあと、

受信したトラップ情報を表示するように Orion Trap Viewer を設定します（次のセクションを

参照）。 

注記： 

 ネットワーク デバイスを適切に設定するには、当該デバイスのベンダーが提供した文書を

参照してください。 

 Orion Trap Viewer は、UDP ポート 162 でトラップを受信します。 

現在のトラップの表示 

Trap Viewer では、次の手順に示されているように、トラップ メッセージを簡単に表示できます。 

現在のトラップ メッセージを表示するには： 

1. Start > All Programs > SolarWinds Orion > Syslog and SNMP Traps > 

Trap Viewer （スタート  > すべてのプログラム  > SolarWinds Orion > Syslog および 

SNMP トラップ  > Trap Viewer ）をクリックします。 
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2. View > Current Traps （ビュー  > 現在のトラップ）をクリックします。 

3. 列ヘッダーをクリックし、選択したトラップの特徴別に一覧表示されるトラップの順序を決め

ます。 

4. Trap Viewer を設定してトラップの特徴が表示される順序を決めるには、列をクリックして

ドラッグします。 

トラップの検索 

収集されたトラップ メッセージは、Trap Viewer 内で検索できます。次の手順では、トラップ メ

ッセージを検索するとともに検索結果リストの書式設定を行います。  

トラップ メッセージ リストを検索するには： 

1. Start > All Programs > SolarWinds Orion > Syslog and SNMP Traps > 

Trap Viewer （スタート> すべてのプログラム > SolarWinds Orion > Syslog および 

SNMP トラップ  > Trap Viewer ）をクリックします。 

2. View > Search Traps （ビュー  > トラップの検索）をクリックします。 

3. 適切な検索基準を入力し、Search Database （データベースの検索）をクリックします。 

4. ナビゲーションを容易にするためにメッセージをグループ化する場合は、Grouping （グ 

ループ化）リストでグループ化のタイプを選択します。 

5. 表示されるメッセージの件数を制限したい場合は、Maximum number of 

messages to display （表示するメッセージの最大件数）フィールドで数字を入力する

か選択します。 

6. 検索基準を満たすメッセージをすばやく表示するには、Auto Refresh every number 

seconds （Ｘ秒ごとに自動更新）フィールドで数字を選択します。 

注記：  自動更新は、現在のメッセージを表示している場合にのみ利用できます。

Date/Time Range （日時範囲）は、Today （今日）、Last 24 Hours （過去 24 時

間）、Last 2 Hours （過去 2 時間）、Last Hour （過去 1 時間）のいずれかに設定す

る必要があります。 

7. 検索基準ペインを非表示にする場合は、ページ右上の二重上向き矢印をクリックすると
ペインを開いたり閉じたりできます。 
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Trap Viewer の設定 

次の手順に従い、Trap Viewer を起動、設定してください。 

Trap Viewer を起動・設定するには： 

1. Start > All Programs > SolarWinds Orion > Syslog and SNMP Traps > 

Trap Viewer （スタート > すべてのプログラム > SolarWinds Orion > Syslog および 

SNMP トラップ  > Trap Viewer ）をクリックします。 

2. File > Settings （ファイル＞設定）をクリックします。 

3. General （一般）タブで、次のトラップ サーバー設定を構成します。 

a. 最上部のスライダーを動かし、Current Traps （現在のトラップ）ビューで表示するト

ラップの最大数 を設定します。 

b. Orion NPM で Automatically Refresh the Current Traps View （現在の
トラップ ビューを自動的に更新） する場合は、このオプションにチェックを入れ、中央の
スライダーを動かして更新レートを設定します。 

c. Retain Trap messages for how many days? （トラップ メッセージの保持日

数）スライダーを動かして、トラップをデータベースに保持する期間を設定します。 

4. Displayed Columns （表示列）タブで矢印キーを使用し、Current Traps （現在のト 

ラップ）ビューで表示する情報フィールドを選択して順序を決めます。 

5. トラップ メッセージでドメイン名が必要ない場合は、Message Parsing （メッセージの 

パース）タブで Remove Domain Name from DNS Lookups （ DNS ルックアップか

らドメイン名を削除する）にチェックを入れます。 

注記： このオプションにチェックを入れると、トラップ メッセージからドメイン名が削除されるた

め、データベースのサイズを縮小できます。 
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Trap Viewer のフィルタとアラートの設定 

Trap Viewer は、受信したトラップ メッセージが定義済みの規則に一致した場合に Orion 

NPM アラート アクションをトリガーするように設定できます。次の手順では、トラップ メッセージ

のフィルタリングを行い、アラート アクションを随意に開始するための規則を設定します。 

注記： 

 SolarWinds では、フィルタ定義で英数字以外の文字を使用しないよう推奨しています

（アスタリスク（*）ワイルドカードは例外）。 

 トラップ規則は、管理されていないノードには適用されません。詳細については、55 ページ

の「ウェブ コンソールでのデバイス監視」を参照してください。 

Trap Viewer のフィルタとアラートを設定するには： 

1. Start > All Programs > SolarWinds Orion > Syslog and SNMP Traps > 

Trap Viewer （スタート > すべてのプログラム > SolarWinds Orion > Syslog および 

SNMP トラップ > Trap Viewer ）をクリックします。 

2. File > Settings （ファイル  > 設定）をクリックしてから、Alerts / Filter Rules （アラート / 

フィルタ規則）タブをクリックします。 

3. 新しい規則を作成する場合は、Add Rule （規則の追加）をクリックします。 

4. 既存の規則を編集する場合は、Edit Rule （規則の編集）をクリックします。 

5. General （一般）タブをクリックします。  

6. Rule Name （規則名） を入力し、Enabled （有効）にチェックを入れて規則を有効にし

ます。 

7. Apply this Rule to （この規則の適用対象）リストから適切なサーバーを選択します。 

8. この規則を適用する IP アドレスまたはサブネットを入力します。 

注記： このタブに記載されている例を使い、リストの適切な書式設定を行ってください。 

9. 特定のホスト、ドメイン、またはホスト名パターンのメッセージのみに規則を制限する場合
は、DNS Hostname （DNS ホスト名）をクリックしてから、DNS ホスト名パターンを入力

します。 

注記： 

 DNS ホスト名パターン規則では、大文字と小文字を区別します。 
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 Use Regular Expressions in this Rule （この規則では正規表現を使用す

る）にチェックを入れている場合は、「 like 」ステートメントの代わりに正規表現を使用

できます。Orion NPM での正規表現の使用に関する詳細については、463 ページ

の「正規表現パターン マッチング」を参照してください。 

10. Trap Details （トラップの詳細）フィールドの内容に基づいて規則を制限する場合は、
Trap Details （トラップの詳細）をクリックしてトラップ詳細パターンを入力します。 

注記： Use Regular Expressions in this Rule （この規則では正規表現を使用す

る）にチェックが入っている場合は、「like」ステートメントの代わりに正規表現を使用できま

す。Orion NPM での正規表現の使用に関する詳細については、463 ページの「正規表

現パターン マッチング」を参照してください。 

11. 特定のコミュニティ ストリングに規則を制限する場合は、Community String （コミュニティ 

ストリング）をクリックし、Community String Pattern （コミュニティ ストリング パターン） 

フィールドに適切なパターンを入力します。 

注記： Use Regular Expressions in this Rule （この規則では正規表現を使用す

る）にチェックが入っている場合は、「 like 」ステートメントの代わりに正規表現を使用でき

ます。Orion NPM での正規表現の使用に関する詳細については、463 ページの「正規

表現パターン マッチング」を参照してください。 

12. Conditions （条件）をクリックし、テキスト フィールドで次のように規則適用のトリガー条件

を作成します。 

 リンクされたコンテキスト メニューから適切なオブジェクト識別子と比較関数を選択し

ます。 

  Browse （参照） （…）をクリックし、必要に応じて Insert an “OR” condition 

（「OR 」条件の挿入）、Insert an “AND” condition （「AND」条件の挿入）、ま

たは Delete a condition （条件の削除）を実行します。 

注記： 条件と条件グループの詳細については、288 ページの「条件グループの理解」を参

照してください。 

13. 規則の適用を特定期間に制限する場合は、Time of Day （時間帯）をクリックし、

Enable Time of Day （時間帯を有効にする）にチェックを入れます。時間帯を入力し

たら、規則を適用する曜日を選択します。 

注記： 

  時間帯を有効にすると、CPU のオーバーヘッドが増加します。 

  指定された時間枠外にメッセージを受信しても、アラートはトリガーされません。 
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14. 規則に一致する特定数のトラップを受信するまでアラート アクションを抑制する場合は、
Trigger Threshold （トリガーしきい値）をクリックし、Define a Trigger Threshold 

for this Rule （この規則のトリガーしきい値を定義する）にチェックを入れて、必要に応じ

てオプション値を入力します。 

注記： Suspend further Alert Actions for （以下についてさらなるアラート アクショ

ンを一時停止：）にチェックが入っている場合は、指定期間が過ぎるまでアラート アクション

は送信されません。当該期間が経過すると、新しいアラートのみが送信されます。当該期

間中に抑制されているアラートは一切、送信されません。 

15. Alert Actions （アラート アクション）をクリックします。 

16. 新しいアクションを規則に関連付ける場合は、Add New Action （新規アクションの追

加）をクリックし、構成するアクションをリストから選択します。アラート アクションの追加の詳

細については、103 ページの「アラート アクションの追加」を参照してください。 

17. 規則について既存のアクションを編集する場合は、リストからアクションを選択し、Edit 

Action （アクションの編集）をクリックします。アラート アクションの追加の詳細については、

103 ページの「アラート アクションの追加」を参照してください。 

18. 矢印ボタンを使用し、アクションを実行する順序を設定します。 

注記： アクションは表示されている順序で上から下に処理されます。 

19. アクションを削除する必要がある場合は、アクションを選択して Delete Action （アクショ

ンの削除）をクリックします。 

20. OK をクリックして変更内容をすべて保存し、Trap Viewer Settings （Trap Viewer の

設定）に戻ります。 

21. 矢印ボタンを使用して、規則を適用する順序を決めます。 

注記： 規則は表示されている順序で上から下に処理されます。 

利用可能なトラップ アラート アクション 

トラップ アラートでは、次のアクションを利用することができます。アラート アクションの割り当てと

設定の詳細については、103 ページの「アラート アクションの追加」を参照してください。 

トラップを廃棄する 

SNMP トラップ サーバーに送信された不要なトラップを削除することができます。 

トラップにタグを付ける 

受信したトラップにカスタム タグを追加できます。タグを割り当てる際は必ずビューアに Tag 

（タグ）列を含めてください。 
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 特定の色でトラップにフラグを付ける 

Orion ウェブ コンソールおよび Trap Viewer での表示に特別な色を割り当て、規則に一

致するトラップにフラグを付けることができます。 

 ファイルにトラップをログする 

ファイルと、ファイルに送信されたトラップにタグを付ける一連の変数を指定できます。使用

したいログ ファイルがすでに作成されていることを確認してください。アラートではファイルを

作成できません。 

 Windows イベント ログ 

ローカル Windows イベント ログ、またはリモート Windows イベント ログにメッセージを書

き込むことができます。 

 トラップを転送する 

トラップを転送する IP アドレスまたはホスト名およびポートを指定できます。トラップの宛先

となる IP アドレスまたはホスト名、およびトラップを送信するポートを指定します。トラップ 

ソースの IP アドレスを含めるには、Include Source Address （ソース アドレスを含む）

にチェックを入れます。 

 サウンドの再生 

一致する SNMP トラップを受信した際にサウンドを鳴らすよう設定できます。 

 テキスト音声変換出力 

特定の音声エンジン、音声、ピッチ、音量、読み上げるメッセージを定義できます。 

 外部プログラムの実行 

バッチ ファイルを使用して起動する外部プログラムを指定できます。このアクションは、

Orion NPM でリアルタイム変更通知を作成する際に使用します。 

 外部 VB スクリプトの実行 

選択されたスクリプト インタープリタ エンジンと保存済みのスクリプト ファイルを使用し、VB 

スクリプトを起動することができます。 

 Windows ネット メッセージの送信 

特定のコンピュータ、またはドメインあるいはワークグループ全体のいずれかに Windows  

ネット メッセージを送信できます。 
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注記：  SolarWinds が  Orion のインストールをサポートしている  WindowsNet 

Messaging に対応している唯一のオペレーティング  システムは、Windows Server 

2003 および Windows XP です。SolarWinds は、Windows XP で Orion の評価の

みをサポートしています。 

 電子メール / 呼び出しの送信 

特定の SMTP サーバーを使用し、カスタマイズ可能な件名とメッセージを含むメールを、

指定されたアカウントからアドレスに送信できます。 

 トラップ規則の処理を停止する 

一致するトラップの SNMP トラップ規則の処理を停止します。 

 インターフェースのステータスを変更する 

Orion NPM はトラップを受信するインターフェースのステータスを変更できます。インターフ

ェースを変更するステータスを指定します。 

トラップ アラートの変数 

Orion NPM トラップ サーバーでは、以下の変数をトラップ アラート メッセージで使用できます。

各変数はドル記号で始め、変数識別子をそれぞれ波括弧で囲む必要があります（例：

${VariableName}）。 

注記： トラップ アラートでは、有効なノード変数も使用できます。ノード アラート変数の詳細に

ついては、431ページの「Orion NPM 変数と例」を参照してください。 

 トラップ日時変数とらっぷ（ひづけ/じこく）" 

 トラップ日時変数  説明 

 ${AbbreviatedDOW}  1 週間のうちの現在の曜日。3 文字の省略表示。 

 ${AbbreviatedMonth}  現在の月。3 文字の省略表示。 

 ${AMPM}  現在の時刻に対応する AM または PM （午前または午後） 

 ${D}  現在の日付。（ MM/DD/YYYY 形式） 

 ${DD}  １ヶ月のうちの現在の日付（ 2 桁の数字、ゼロ詰め） 

 ${Date}  現在の日付。（ MM/DD/YYYY 形式） 

 ${DateTime}  現在の曜日、日付、時刻。（曜日名 月 DD, YYYY HH:MM AM/PM ） 

 ${Day}  現在の日付。（ MM/DD/YYYY 形式） 

 ${DayOfWeek}  1 週間のうちの現在の曜日。 

 ${DayOfYear}  1 年のうちの数値日 

 ${H}, ${Hour}   現在の時間。24 時間形式 
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 トラップ日時変数  説明 

 ${HH}  現在の時間。2 桁の形式、ゼロ詰め。 

 ${LocalDOW}  1 週間のうちの現在の曜日。ローカライズされた言語形式。 

 ${LongDate}  現在の日付。（曜日名、月、日、年） 

 ${LongTime}  現在の時刻。（ HH:MM:SS AM/PM ） 

 ${M}  数字で示した現在の月  

 ${MM}  現在の月。2 桁の数値、ゼロ詰め。 

 ${MMM}  現在の月。3 文字の省略表示。 

 ${MMMM}  現在の月のフルネーム 

 ${MediumDate}  現在の日付。（曜日名、月、日、年） 

 ${MediumTime}  現在の時刻。（ HH:MM:SS AM/PM ） 

 ${Minute}  現在の分。2 桁の形式、ゼロ詰め。 

 ${MonthName}  現在の月のフルネーム 

 ${S}  現在の秒を含む日時（ YYYY-MM-DDTHH:MM:SS ） 

 ${Second}  現在の秒。2 桁の形式、ゼロ詰め。 

 ${Time}  現在の時刻。（ HH:MM AM/PM ） 

 ${Year}  4 桁で示す年度 

 ${Year2}  2 桁で示す年度 

 その他のトラップ変数 

 トラップ変数  説明 

 ${Application} SolarWinds アプリケーション情報 

 ${Community}  ノード コミュニティ ストリング 

 ${Copyright}  著作権情報 

 ${DNS}  完全に適格なノード名 

 ${Hostname}  トラップをトリガーするデバイスのホスト名 

 ${IP}  アラートをトリガーするデバイスの IP アドレス 

 ${IP_Address}  アラートをトリガーするデバイスの IP アドレス 

 ${Message} 
 トリガーされたトラップとともに送信され、Trap Viewer の Trap Details （ト

ラップの詳細）フィールドに表示されるメッセージ 

 ${MessageType}  トリガーされたトラップの名前またはタイプ 

 ${Raw}  対応する受信トラップで送信されたプロパティの生の数値。 

 ${RawValue}  対応する受信トラップで送信されたプロパティの生の数値。${Raw} と同じ 

 ${ vbData1 }  トラップ変数を拘束する値 

 ${ vbName1 }  トラップ変数を拘束する名前 
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第 25章 

カスタム プロパティの作成  –  コア 

すべての Orion 製品で、 カスタム プロパティ エディタにアクセスし、あらゆる監視デバイスにカス

タム プロパティを追加することができます。カスタム プロパティは、country （国）、building （ビ

ル）、asset tag （資産タグ）、serial number{ （シリアル番号）などの追加フィールドで、

Orion データベースで定義、保存できます。プロパティを追加すると、Orion ウェブ コンソールと 

Report Writer アプリケーションの双方でプロパティを表示、フィルタリングできます。カスタム プ

ロパティは次のように使用することもできます。 

  ノードへの情報追加（連絡先や所有者、サポート連絡先など）。 

  ノード上でアカウント制限として使用されるカスタム プロパティの追加。 

  ウェブまたはレポートでグループ化するためのノードへのカスタム プロパティの追加。 

  カスタム プロパティを追加して、チャートの注釈として表示。 

カスタム プロパティ エディタでは、最も一般的に使用されるプロパティの中から選択できます。ま

た、独自のカスタム プロパティを容易に効率よく構築することも可能です。詳細については、

375 ページの「カスタム プロパティの作成  –  コア」を参照してください。 

カスタム プロパティを定義すると、インポート ウィザードで、テキスト ファイルまたはコンマ区切りフ

ァイルから新しいプロパティを自動入力することができます。詳細については、377 ページの「カ

スタム プロパティ データのインポート」を参照してください。 

 変更または追加の数が少ない場合は、Edit （編集）ビューで変更を行うこともできます。詳細

については、379 ページの「カスタム プロパティの編集」を参照してください。 

カスタム プロパティの作成 

次の手順は、カスタム プロパティ エディタを使用してカスタム プロパティを作成する際に必要です。 

カスタム プロパティ エディタでプロパティを作成するには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access 

Control > Custom Property Editor （スタート > すべてのプログラム > SolarWinds 

Orion > グループ化およびアクセス コントロール > カスタム プロパティ エディタ）をクリックし

ます。 

2. Add Custom Property （カスタム プロパティの追加）をクリックします。 
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3. あらかじめ定義されたプロパティを追加する場合は、次の手順を実行します。 

a. Add Predefined Properties （定義済みプロパティの追加）を選択します。 

b. Show Advanced Properties （詳細なプロパティを表示する）にチェックを入れる

と、その他の定義済みプロパティを表示できます。 

c. 追加するプロパティにチェックを入れて、OK をクリックします。 

4. 完全に新しいカスタム プロパティを生成する場合は、次の手順を実行します。 

a. Build a Custom Property from scratch （カスタム プロパティを最初から構築

する）を選択します。 

b. 新しいカスタム プロパティを追加する Orion データベース テーブルを選択します。 

c. 新しい Property Name （プロパティ名）を入力します。 

注記： 

 カスタム プロパティのあらゆる機能を使用できるようにするには、Property 

Name （プロパティ名）フィールドに必ず入力してください。 

 カスタム プロパティ名で使用される英数字以外のほとんどの文字は、名前が 

Orion データベースで保存される際、下線（_）に置き換えられますが、

SolarWinds ではカスタム プロパティ名に英数字以外の文字を使用しないよう

お勧めしています。どのプロパティ名でも、ハッシュ文字（#）の使用は許可されて

いません。 

d. Property Type （プロパティ タイプ）を選択します。 

e. Max. Text length （テキスト最大文字数）を入力します。 

注記： このフィールドに入力した値に関わりなく、Orion NPM では、4,000 字を超え

るテキストで定義されたカスタム プロパティに対応していません。 

f. OK をクリックします。 

カスタム プロパティの削除 

カスタム プロパティは、カスタム プロパティ エディタを使用すると容易に削除できます（次の手順

を参照）。 

カスタム プロパティを削除するには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access Control > 

Custom Property Editor （スタート > すべてのプログラム > SolarWinds Orion > グルー

プ化およびアクセス コントロール > カスタム プロパティ エディタ）をクリックします。 
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2. Properties > Remove Custom Properties （プロパティ > カスタム プロパティの削

除）をクリックします。 

3. 削除するプロパティにチェックを入れます。 

4. 選択が終了したら OK をクリックします。 

カスタム プロパティ データのインポート 

カスタム プロパティを定義したら、カスタム プロパティ エディタのインポート ツールでカスタム プロ

パティ データを自動入力できます。たとえば、すべてのネットワーク ノードの資産タグを一覧表

示したスプレッドシートがすでにあり、ウェブ コンソールでこの情報をレポートや発行に利用でき

るようにする場合に便利です。この場合には、カスタム プロパティとして Asset Tag （資産タグ）

が追加され、インポート ウィザードを使って資産タグの値がスプレッドシートから自動入力されま

す。次の手順では、カスタム プロパティ データの入力プロセスについて概要を示します。 

カスタム プロパティ データをインポートするには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access Control > 

Custom Property Editor （スタート > すべてのプログラム > SolarWinds Orion > グルー

プ化およびアクセス コントロール > カスタム プロパティ エディタ）をクリックします。 

2. File > Import （ファイル  > インポート）をクリックし、適宜、Import from Comma 

Delimited File （コンマ区切りファイルからインポート）、または Import from Text File 

（テキスト ファイルからインポート）を選択します。 

3. カスタム プロパティ データが含まれているファイルまでナビゲートします。 

4. カスタム プロパティ データが含まれているファイルを選択し、Open （開く）をクリックします。 

5. ファイル内でデータを分離している区切り文字を選択します。 

6. データ ファイルにヘッダー行が含まれている場合は、First row contains field names 

（最初の行にフィールド名が含まれている）にチェックを入れます。 

7. ファイル内でテキスト フィールドを取り囲む文字を指定し、Next （次へ）をクリックします。 

8. データをインポートするカスタム プロパティが記載されているデータ表を選択し、Next （次

へ）をクリックします。 

9. ドロップダウン メニューを使用し、左側でファイルの主要なフィールドを選択して、これに対

応する表のフィールドを右側で選択します。 

注記： ファイル データによっては、複数の主要なフィールドを指定する必要がある場合が

あり、インポート ウィザードでは表のフィールドに適切にデータを一致させます。 

10. Next （次へ）をクリックします。 
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11. 左側のファイルからインポートするフィールドを指定するには、右側の対応する空白のセル

をクリックしてから、自動入力するデータ フィールドのあるターゲット フィールドを選択します。 

注記： セルをクリックしてメニューを有効にします。メニュー項目を使用し、データを自動入

力するターゲット フィールドを選択します。 

12. データと Orion データベースで一致するセルをすべて指定したら、Import （インポート）を

クリックします。 

13. インポートの完了後、インポートされた行の数を確認して OK をクリックします。 

カスタム プロパティ エディタの設定 

Custom Property Editor Settings （カスタム プロパティ エディタの設定）ウィンドウでは、ノー

ドとボリュームの表示をカスタマイズできます。 

注記： Orion Network Performance Monitor のユーザーは、インターフェースの表示をカス

タマイズすることもできます。 

カスタム プロパティ エディタを設定するには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access Control > 

Custom Property Editor （スタート > すべてのプログラム > SolarWinds Orion > グルー

プ化およびアクセス コントロール > カスタム プロパティ エディタ）をクリックします。 

2. File > Settings （ファイル＞設定）をクリックします。 

3. Node Editing （ノードの編集）をクリックして、Edit Node Properties （ノード プロパティ

の編集）ウィンドウで表示するシステム プロパティにチェックを入れます。Volume Editing 

（ボリュームの編集）でも同じ手順を繰り返します。 

4. 自動検索を有効にする場合は、Auto-Search （自動検索）をクリックし、Enable 

Auto-Search （自動検索を有効にする）にチェックを入れます。 

注記： 自動検索を有効にすると、入力と同時に現在の列が検索されます。セルを選択

し、Enter を押してセルの内容を編集します。自動検索を無効にすると、入力と同時に

セルの編集が始まります。 



SolarWinds Orion Network Performance Monitor  管理者ガイド 

 

 

 カスタム プロパティの作成  –  コア 379 

カスタム プロパティの編集 

カスタム プロパティ エディタでは、カスタム プロパティを簡単に変更できます。 

注記： Orion Network Performance Monitor のユーザーは、インターフェースのカスタム プ

ロパティを編集することもできます。 

カスタム プロパティを編集するには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access Control > 

Custom Property Editor （スタート > すべてのプログラム > SolarWinds Orion > グルー

プ化およびアクセス コントロール > カスタム プロパティ エディタ）をクリックします。 

2. Properties > Edit Object Properties （プロパティ  > オブジェクト プロパティの編集）をク

リックします。Object （オブジェクト）は適宜、Node （ノード）または Volume （ボリューム）に

なります。 

3. 編集する表のセルをクリックし、必要に応じてセルに入力するか、セルの内容を変更します。 

4. カスタム プロパティのフィルタを作成または編集する場合は、No Active Filter （アクティ

ブなフィルタなし） または Filter Active （アクティブなフィルタ）のいずれかをクリックし、適

用するフィルタを定義します。詳細については、379 ページの「編集ビューでのフィルタの使

用」を参照してください。 

5. 編集が終了したら OK をクリックします。 

編集ビューでのフィルタの使用 

Edit Custom Properties （カスタム プロパティの編集）ウィンドウでは、あらゆるデバイスでフィ

ルタリングを利用できます。フィルタを適用すると、利用可能なデータ ビューを操作できます。カ

スタム プロパティ エディタでは、フィルタを適用するカスタム プロパティ フィールド内のテキストを

編集できます。次の手順は、カスタム プロパティ エディタ内でフィルタを使用する方法を示して

います。 

カスタム プロパティ フィルタの作成 

次の手順で、カスタム プロパティ フィルタを作成します。 

注記： Orion Network Performance Monitor のユーザーは、インターフェースのカスタム プ

ロパティ用のフィルタを作成することもできます。 
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フィルタを作成するには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access Control > 

Custom Property Editor （スタート > すべてのプログラム > SolarWinds Orion > グルー

プ化およびアクセス コントロール > カスタム プロパティ エディタ）をクリックします。 

2. Properties > Edit Object Properties （プロパティ  > オブジェクト プロパティの編集）をク

リックします。Object （オブジェクト）は適宜、Node （ノード）または Volume （ボリューム）に

なります。 

3. Filter Active （アクティブなフィルタ） または No Active Filter （アクティブなフィルタな

し）をクリックしてから、Apply Filter （フィルタの適用）をクリックします。 

注記： Filter Active / No Active Filter （アクティブなフィルタ / アクティブなフィルタな

し）ボタンのテキストはダイナミックに変化し、現在表示されているデータのフィルタのステータ

スを示します。 

4. ハイパーリンクされたテキストをクリックして、適切な基準を選択します。 

5. 記号をクリックして、次のオプションから選択します。 

注記： 同じ条件のあらゆる他の変数を考慮し、リンクされた利用可能な説明のリストがダ

イナミックに生成されます。詳細については、288 ページの「条件グループの理解」を参照

してください。Browse （参照）（…）をクリックして、条件のタイプを選択します。 

 Add a new elementary condition （新しい基本的な条件を追加する）を選択

すると、ネットワーク オブジェクト データのフィールドの直接的な比較に基づいた条件

を生成できます。 

 Add a new advanced elementary condition （新しい詳細な基本的条件を

追加する）を選択すると、デバイス データ フィールドと値の比較に基づいた条件を生

成できます。 

 Add a new complex condition （新しい複雑な条件を追加する）を選択すると、

定義済みの他の条件をフィルタリングする条件を定義できます。 

 Delete current condition （現在の条件を削除する）を選択すると、選択された

条件を削除できます。 

 Move current condition forward （現在の条件を前方に移動する）または 

Move current condition backward （現在の条件を後方に移動する）を選択

すると、選択に応じて条件の順序を変更できます。 

6. 引き続きハイパーリンクされたテキストをクリックし、カスケード メニューを使用してフィルタリン

グ基準を選択します。 
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7. フィルタの設定を終了したら、OK をクリックします。 

注記： Edit Object Properties （オブジェクト プロパティの編集）ビューは、選択したフィル

タに応じて変化し、Filter Active / No Active Filter （アクティブなフィルタ / アクティブ

なフィルタなし）のテキストには「アクティブなフィルタ」と表示され、現在表示されているプロ

パティにフィルタが適用されていることを示します。 

カスタム プロパティ フィルタの削除 

次の手順では、カスタム プロパティ フィルタを削除します。 

注記： Orion Network Performance Monitor のユーザーは、インターフェースのカスタム プ

ロパティ用のフィルタを削除することもできます。 

フィルタを削除するには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access Control > 

Custom Property Editor （スタート > すべてのプログラム > SolarWinds Orion > グルー

プ化およびアクセス コントロール > カスタム プロパティ エディタ）をクリックします。 

2. Properties > Edit Object Properties （プロパティ  > オブジェクト プロパティの編集）をク

リックします。Object （オブジェクト）は適宜、Node （ノード）または Volume （ボリューム）に

なります。 

3. Filter Active （アクティブなフィルタ）をクリックしてから、Remove Filter （フィルタの削

除）をクリックします。 

 注記： Edit Object Properties （オブジェクト プロパティの編集）ビューに、カスタム プロ

パティがすべて表示されます。 
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第 26章 

アカウント制限の作成  –  コア 

アカウント制限ビルダーでは、Orion ウェブ コンソールのアカウント制限を作成およびカスタマイ

ズできます。制限を利用すると、ウェブ コンソールのユーザーが自らの職務に関連のあるネット 

ワーク オブジェクトのみを表示できるように設定できます。Orion ウェブ コンソールでのアカウント

制限の使用例の一部を次に挙げます。 

  カスタマー ビューを特定のネットワーク ノードに制限する 

  部署または職能分野別にビューを制限する 

  デバイスのタイプまたはデバイスの役割別にビューを制限する 

  デバイスの地理的な所在場所に基づいてビューを制限する 

Orion NPM には定義済みのアカウント制限が含まれており、内蔵 Orion NPM プロパティを

使用してユーザー アクセスを制限します。ただし、柔軟性を高めるため、定義済みプロパティま

たはカスタム プロパティに基づいてアカウント制限ビルダーで独自のアカウント制限を作成するこ

とができます。Orion ウェブ コンソールでのアカウント制限の有効化の詳細については、 

253 ページの「アカウント制限の設定」を参照してください。カスタム プロパティの詳細について

は、375ページの「カスタム プロパティの作成  –  コア 」を参照してください。 

アカウント制限ビルダーの使用 

アカウント制限ビルダーを使用する前に、まず、Orion Network Performance Monitor の 

ウェブ コンソール ビューの制限に使用するカスタム プロパティを作成しておく必要があります。カ

スタム プロパティの詳細については、375ページの「カスタム プロパティの作成  –  コア 」を参照

してください。カスタム プロパティを定義してデータを自動入力したあと、次の手順に従ってアカ

ウント制限ビルダーを使用することができます。 
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アカウント制限の作成 

次の手順でアカウント制限を作成します。 

アカウント制限を作成するには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access 

Control > Account Limitation Builder （スタート   > すべてのプログラム   > 

SolarWinds Orion > グループ化およびアクセス コントロール  > アカウント制限ビルダー）

をクリックします。 

2. スプラッシュ画面で Start （スタート）をクリックします。 

3. Edit > Add Limitation （編集  > 制限の追加）をクリックします。 

4. Custom Property （カスタム プロパティ）を選択します。 

注記： 

 Custom Property （カスタム プロパティ）が空の場合は、カスタム プロパティを定義

する必要があります。カスタム プロパティの詳細については、375ページの「カスタム プ

ロパティの作成  –  コア 」を参照してください。 

 残りのボックスは、選択内容に基づいて自動的に入力されます。 

5. Selection Method （選択方法）を選びます。 

注記： これは、ウェブ アカウント マネージャを介してアカウント制限の値を選ぶ際に表示さ

れる選択形式です。詳細については、253 ページの「アカウント制限の設定」を参照してく

ださい。 

6. アカウント制限に関する独自の説明を含めたい場合は、Description （説明）フィールド

に記載されているデフォルトのテキストに説明を上書きします。 

7. OK をクリックします。 

新しく定義したアカウント制限が、表ビューの最上部に追加されます。これで、Orion ウェブ コ

ンソールのアカウント マネージャで新しい制限を使用できるようになります。詳細については、

253 ページの「アカウント制限の設定」を参照してください。 
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アカウント制限の削除 

次の手順で、アカウント制限ビルダー ユーティリティを使用してアカウント制限を削除します。 

アカウント制限を削除するには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access Control > 

Account Limitation Builder （スタート > すべてのプログラム > SolarWinds Orion > グ

ループ化およびアクセス コントロール  > アカウント制限ビルダー）をクリックします。 

2. スプラッシュ画面で Start （スタート）をクリックします。 

3. 削除する制限の行をクリックします。 

注記： 複数の連続した行を選択するには Shift ＋クリック 、連続していない複数の行

を選択するには Ctrl ＋クリック を使用します。 

4. Edit > Delete Selected Limitations （編集 > 選択した制限の削除）をクリックします。 

注記： Orion は選択された制限を表から削除し、ウェブ アカウント マネージャではこのような制

限を利用できなくなりますが、アカウント制限ビルダーを使用して制限を削除すると、該当する

制限を割り当てられていたアカウントはすべて制限されたままになります。制限を削除しても、

Orion ウェブ コンソールで使用できなくなるだけです。 
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第 27章 

Orion データベースの管理  –  コア 

すべての Orion ネットワーク監視・管理製品では、Microsoft SQL サーバー データベースを

使用し、ウェブ コンソールの設定と収集されたネットワーク パフォーマンスおよび設定データを保

存します。次のデータベース ユーティリティには、Orion データベースの管理を容易にする

Orion NPM 製品が付属しています。 

データベース マネージャ  

クエリーの実施、データベース値の編集、データのエクスポート、データベースの修理、

Orion データベースの圧縮を実行できます。詳細については、387 ページの「データベース 

マネージャの使用」を参照してください。 

データベース保守 

Orion データベースを要約、クリーン、圧縮できます。詳細については、399ページの「デー

タベース保守」を参照してください。 

Orion が使用するデータベースは、Microsoft SQL サーバー上でホストされています。SQL 

サーバーをインストールする際、SQL Server Management Studio をインストールするオプ 

ションを選択できます。Orion データベースをホストしている SQL サーバーのデータベース管理

者に対して、SolarWinds では通常、このユーティリティをインストールすることを推奨していま

す。これは、Orion データベース マネージャでは現時点で利用できない数多くの機能が含まれ

ているためです。詳細については、396 ページの「SQL Server Management Studio の使

用」を参照してください。 

注記： Orion Network Configuration Manager では、デバイス設定とユーザー アクティビ 

ティのログ用に独自の追加データベースを維持しています。 

データベース マネージャの使用 

データベース マネージャを使用すると、クエリーの実施、データベースと表の詳細の表示、データ

のエクスポート、データベース値の編集を実行できます。また、データベース マネージャからは 

データベースの修理、圧縮、復元、バックアップも可能です。次の手順は、データベース マネー

ジャで利用できる基本的なデータベース管理操作の一部を示しています。 
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サーバーの追加 

バックアップまたは補足として Orion で使用するデータベースをまだ指定していない場合は、次

の手順でデータベース マネージャに SQL サーバーを追加することができます。追加したあと、 

データベース マネージャの左側のペインにあるツリー構造に、選択したサーバーおよび関連のあ

るデータベースが表示されます。 

データベース マネージャに SQL を追加するには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > 

Database Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機

能 > データベース マネージャ）の順でクリックします。 

2. File > Add Server （ファイル  > サーバーの追加）をクリックします。 

3. SQL Server （SQL サーバー） リストから選択するか、SQL サーバーの IP アドレスを入

力します。 

4. ログイン スタイルを選択します。 

注記：  Log in using Windows NT Integrated Security （Windows NT 

Integrated Security を使用してログイン）を選択して自動的に  SQL サーバーへ 

Windows ユーザー ID およびパスワードをパスするか、Log in using an SQL Server 

userid and password （SQL サーバーのユーザー ID とパスワードを使用してログイ

ン）を選択して別個のログインを利用することができます。後者を選択するとウィンドウが変

わり、使用する別の SQL サーバーの User Name（ユーザー名）と Password （パス 

ワード）を入力するフィールドが表示されます。 

5. Connect to Database Server （データベース サーバーに接続）をクリックします。 

データベース バックアップの作成 

Orion Network Performance Monitor のデータベースは定期的にバックアップする必要があ

ります。定期的なデータベース バックアップのスケジュール設定の詳細については、395 ページ

の「データベース保守計画の作成」を参照してください。次の手順を使用すると、データベース 

マネージャでデータベースをバックアップできます。 

データベース マネージャでデータベースをバックアップするには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データベー

ス マネージャ）の順でクリックします。 
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2. Orion データベースをホストしている SQL サーバーが左側のペインのリストに表示されて
いない場合は、Orion データベースをホストしている SQL サーバーを追加する必要があり

ます。詳細については、388ページの「サーバーの追加」を参照してください。 

3. + をクリックすると、Orion データベースをホストしている SQL サーバーを展開して表示で

きます。 

4. バックアップするデータベースの名前を右クリックしてから、Backup Database （データ 

ベースのバックアップ）をクリックします。 

5. データベース バックアップの Description （説明）を入力します。 

6. Browse （参照）（…）をクリックしてバックアップ ファイルの場所までナビゲートするか、パス

を直接入力して、Backup Filename （バックアップ ファイル名）へのパスを指定します。 

注記：通常、Orion データベースのデフォルトのバックアップ場所は、

C:\Program Files\SolarWinds\ に指定されています。データベース バックアップの

ターゲットとなっている場所に十分な空きボリュームがあることを確認してください。 

7. 必要に応じて、Append to the end of the Backup File （バックアップ ファイルの最

後に添付する）、または Overwrite Backup File （バックアップ ファイルを上書きする）を

選択して、OK をクリックします。 

データベースの復元 

次の手順で、バックアップしたデータベースを復元します。 

バックアップからデータベースを復元するには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データベー

ス マネージャ）の順でクリックします。 

2. Orion データベースをホストしている SQL サーバーが左側のペインのリストに表示されて
いない場合は、Orion データベースをホストしている SQL サーバーを追加する必要があり

ます。詳細については、388ページの「サーバーの追加」を参照してください。 

3. 左側のペインにある + をクリックし、Orion データベースをホストしている SQL サーバーを

展開してから、Orion データベースをクリックします。 

4. Database > Restore Database （データベース  > データベースの復元）をクリックします。 

5. Browse （参照）（…）をクリックして、復元するデータベースまでナビゲートするか、有効な 

SQL バックアップ データベースの名前とパスを入力します。 

注記： 通常、Orion データベース バックアップのデフォルトの場所は、

C:\Program Files\SolarWinds\ です。 
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6. Verify （確認）をクリックし、有効な SQL データベースを選択していることを確認します。 

注記： 

 データベースを選択すると、残りのフィールドは自動的に入力されます。Database 

Name （データベース名）フィールドには、指定されたデータベースを参照する際に 

SQL サーバーが使用する名前が入力されます。残りの 2 つのフィールドには、データ

（.mdf）とデータベースのトランザクション ログ（.ldf）ファイルが表示されます。入力さ

れている値は変更できます。 

 データベース マネージャではディレクトリを作成できません。すでに存在しているパスを

指定できるだけです。 

 また、現在使用中のデータベースは復元できません。 

7. 選択したデータベースを復元するには、OK をクリックします。 

データベースの圧縮 

データベースは圧縮すると小さくなり、インデックスが再作成されて余白が削除されます。データ

ベースは、次の手順を実行すると圧縮できます。 

データベース マネージャでデータベースを圧縮するには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データベー

ス マネージャ）の順でクリックします。 

2. Orion データベースをホストしている SQL サーバーが左側のペインのリストに表示されて
いない場合は、Orion データベースをホストしている SQL サーバーを追加する必要があり

ます。詳細については、388ページの「サーバーの追加」を参照してください。 

3. 左側のペインにある + をクリックし、Orion データベースをホストしている SQL サーバーを

展開してから、Orion データベースをクリックします。 

4. Database > Compact Database （データベース  > データベースの圧縮）をクリックし

ます。 

注記： 圧縮の終了後、データベース マネージャには、圧縮前と圧縮後のデータベースの

大きさを比較したウィンドウが表示されます。サイズが同じであれば、データの再配置に必

要な空きボリュームがデータベースにない可能性があります。データベースを圧縮するため

に空きボリュームを増やす必要がある場合は、391 ページの「個々の表の圧縮」を参照し

てください。 
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個々の表の圧縮 

サーバーの空きボリュームが限られているため、完全なデータベースの圧縮を実行できない場

合は、次の手順で示すように データベース マネージャを使用してデータベースの表を個別に圧

縮することができます。 

個々の表を圧縮するには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データベー

ス マネージャ）の順でクリックします。 

2. Orion データベースをホストしている SQL サーバーが左側のペインのリストに表示されて
いない場合は、Orion データベースをホストしている SQL サーバーを追加する必要があり

ます。詳細については、388ページの「サーバーの追加」」を参照してください。 

3. 左側のペインにある + をクリックし、Orion データベースをホストしている SQL サーバーを

展開してから、Orion データベースをクリックします。 

注記： SolarWinds Orion は、Orion データベースのデフォルト名です。 

4. 表をクリックし、拡張したデータベースの圧縮を行います。そのあと、Table > 

Compact/Rebuild Indexes （表  > インデックスの圧縮 / 再作成）をクリックします。 

データベース詳細の表示 

データベース マネージャの Database Details （データベースの詳細）ウィンドウには、選択した

データベースのプロパティおよび表情報を示す  2 つのタブが表示されます。次の手順は、

Database Details （データベースの詳細）ウィンドウで利用できる情報についてのガイドです。 

データベース詳細を表示するには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データベー

ス マネージャ）の順でクリックします。 

2. Orion データベースをホストしている SQL サーバーが左側のペインのリストに表示されて
いない場合は、Orion データベースをホストしている SQL サーバーを追加する必要があり

ます。詳細については、388ページの「サーバーの追加」を参照してください。 

3. 左側のペインにある + をクリックし、Orion データベースをホストしている SQL サーバーを

展開してから、Orion データベースをクリックします。 

注記： SolarWinds Orion は、Orion データベースのデフォルト名です。 
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4.  Database > Database Details （データベース  > データベースの詳細）をクリックします。 

 注記： 

 Properties （プロパティ）タブには、一般的な統計情報と、選択したデータベースの

説明が表示されます。 

 Tables （表）タブには、選択したデータベースとそれぞれのサイズを示す表のリストが

表示されます。 

5. Properties （プロパティ）タブの Last Backup （前回のバックアップ）フィールドが空白の
場合は、選択したデータベースのバックアップが生成されていません。推奨されている定期
的なデータベース バックアップのスケジュール設定の詳細については、395ページの「データ

ベース保守計画の作成」を参照してください。 

表の詳細の表示 

データベース マネージャの Table Details （表の詳細）ウィンドウには、選択した表のプロパティ、

列、インデックス情報が表示されます。また、Table Details （表の詳細）ウィンドウでは、次の

手順に示すように、選択した表のクエリーを直接行うことができます。 

表を詳細に表示するには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > 

Database Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機

能 > データベース マネージャ）の順でクリックします。 

2. Orion データベースをホストしている SQL サーバーが左側のペインのリストに表示されて
いない場合は、Orion データベースをホストしている SQL サーバーを追加する必要があり

ます。詳細については、388ページの「サーバーの追加」を参照してください。 

3. 左側のペインにある + をクリックし、Orion データベースをホストしている SQL サーバーを

拡張表示します。そのあと、+ をクリックして Orion データベースを拡張表示します。 

注記： SolarWinds Orion は、Orion データベースのデフォルト名です。 

4. 表をクリックし、拡張表示されたデータベースで表示します。 

5. Table > Table Details （表 > 表の詳細）をクリックします。 

注記： Properties （プロパティ）タブには、表のサイズと作成日に関する一般的な情報が

含まれています。Columns （列）タブでは、表の列、表のキー、およびフィールドのタイプに

ついて説明します。Indexes （インデックス）タブには、表で使用されるインデックスが一覧

表示されます。 

6. 開いている表のクエリーを行いたい場合は、ツールバーで Query （クエリー）をクリックします。 
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警告： データベースの値を編集する際は特に注意してください。データベースの完全性が

容易に損なわれる可能性があります。詳細については、393ページの「データベース フィー

ルドの編集」を参照してください。 

注記： デフォルトの SQL ステートメントの他にも、読み取りまたは読み取り / 書込み 

ビューでデータを表示するためのラジオボタンが用意されています。 

データベース フィールドの編集 

データベースのフィールドは、データベース マネージャ内のクエリー ビューで編集できます。次の

手順は、Orion データベース マネージャでデータベースのフィールドを編集する方法を示してい

ます。 

警告： データベースの値を編集する際はよく気をつけてください。データベースの完全性が危険

にさらされる可能性があります。 

データベース マネージャでデータベース フィールドを編集するには： 

1. SolarWinds Network Performance Monitor のサービスを次の手順で停止します。 

a. Start > All Programs > SolarWinds Orion > Advanced Features > Orion 

Service Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機 

能 > Orion サービス マネージャ）をクリックします。 

b. Services （サービス）セクションで  SolarWinds Network Performance 

Monitor をクリックしてから、Stop （停止）をクリックします。 

2. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データベー

ス マネージャ）の順でクリックします。 

3. Orion データベースをホストしている SQL サーバーが左側のペインのリストに表示されて
いない場合は、Orion データベースをホストしている SQL サーバーを追加する必要があり

ます。詳細については、388ページの「サーバーの追加」を参照してください。 

4. 左側のペインにある + をクリックし、Orion データベースをホストしている SQL サーバーを

拡張表示します。そのあと、+ をクリックして Orion データベースを拡張表示します。 

注記： SolarWinds Orion は、Orion データベースのデフォルト名です。 

5. 表をクリックし、拡張表示されたデータベースで表示します。 

6. Table > Query Table （表 > クエリー表）をクリックします。 

7. クエリー フィールドで提供されている SQL ステートメントを使用するか、独自のクエリーを

入力します。 

8. 表ビューでクエリー結果を表示したい場合は、Refresh （更新）をクリックします。 
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9. 表のフィールドを編集したい場合は、ウィンドウの最上部で Read/Write （読み取り / 書

き込み）を選択し、必要に応じてフィールドを編集します。 

10. 同じ SQL クエリーを頻繁に使用する場合は、次の手順でクエリーにお気に入りの印を付

けると時間を節約することができます。 

a. クエリー フィールドにクエリーを入力します。 

b. Add to Favorites （お気に入りに追加）をクリックします。 

c. コマンドの名前を入力し、OK をクリックします。 

注記： データベース マネージャは、入力された名前を使用してコマンドを保存します。

これにより、Paste from Favorites （お気に入りから貼り付け）をクリックすると、コ

マンドを直接使用できるようになります。 

データベースの分離 

データベースを分離すると、その参照が SQL サーバーから削除されるため、ファイルを異なる場

所に安全に移動できます。データベース マネージャでは、次の手順で示すようにデータベースを

分離し、データベースのデータ ファイルを完全な状態にしておくことができます。 

注記： SolarWinds では、SQL サーバーから別の SQL サーバーへデータベースを移すために 

Detach Database （データベースの分離）オプションを使用することを推奨していません。詳

細については、400ページの「データベースの移動 」を参照してください。 

データベースを分離するには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データベー

ス マネージャ）の順でクリックします。 

2. Orion データベースをホストしている SQL サーバーが左側のペインのリストに表示されて
いない場合は、Orion データベースをホストしている SQL サーバーを追加する必要があり

ます。詳細については、388ページの「サーバーの追加」を参照してください。 

3. 左側のペインにある + をクリックし、Orion データベースをホストしている SQL サーバーを

展開してから、Orion データベースをクリックします。 

注記： SolarWinds Orion は、Orion データベースのデフォルト名です。 

4. メニューで Database > Detach Database （データベース > データベースの分離）をク

リックします。 
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データベース保守計画の作成 

データベース マネージャを使用すると、データベース保守計画を作成し、設定されたスケジュー

ルに基づいてデータベースを自動的に圧縮およびバックアップできるようになります。セキュリティ

および情報の完全性を保つには、データベースを定期的にバックアップしておくことが重要です。

データベース マネージャでは、次の手順で簡単にバックアップを実行できます。 

注記： データベースの保守を実行するには、SQL サーバー エージェントを実行する必要があり

ます。 

Orion Network Performance Monitor データベースのデータベース保守計画を作成す

るには： 

1. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データベー

ス マネージャ）の順でクリックします。 

2. Orion データベースをホストしている SQL サーバーが左側のペインのリストに表示されて
いない場合は、Orion データベースをホストしている SQL サーバーを追加する必要があり

ます。詳細については、388ページの「サーバーの追加」を参照してください。 

3. 左側のペインにある + をクリックし、Orion データベースをホストしている SQL サーバーを

展開してから、Orion データベースをクリックします。 

注記： SolarWinds Orion は、Orion データベースのデフォルト名です。 

4. Database > Database Backup Schedule （データベース > データベースのバック 

アップ スケジュール）をクリックします。 

5. 毎 日 1 回、または 週 1 回のいずれかにバックアップを実行するよう選択します。 

6. 週 1 回バックアップを実行したい場合は、Backup Day （バックアップ日）を選択してくだ

さい。 

7. Backup Time （バックアップ時間）を設定します。 

8. Next （次へ）をクリックします。 

9. バックアップ前にデータベースを圧縮して縮小する場合は、Compact and Shrink 

Database before Backup （バックアップ前にデータベースを圧縮して縮小する）に 

チェックを入れます。 

注記： SolarWinds では、データベースの圧縮を毎週行い、バックアップ前にデータベース

を圧縮して縮小するよう推奨しています。 

10. バックアップ ファイルを保存したいディレクトリへのパスを入力するか、Browse (…) （参

照）をクリックして適切なディレクトリまでナビゲートします。 
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11. バックアップ レポートを維持したい場合は、Generate a backup report each time 

the backup Job runs （バックアップ ジョブを実行するたびにバックアップ レポートを生

成する）にチェックを入れてから、バックアップ レポートを保存するディレクトリへのパスを入力

するか、Browse (…) （参照）をクリックして適切なディレクトリまでナビゲートします。 

12. Finish （完了）をクリックします。 

SQL Server Management Studio の使用 

SQL Server Management Studio がインストールされている SQL Server 2005 または 

2008 の標準版もしくはエンタープライズ版のライセンスがある場合は、これを使用して Orion 

NPM データベースを維持できます。次の手順は、SQL Server Management Studio で日

常的な Orion データベース保守計画を設定する基本的な方法です。 

注記： 

 特定の環境によっては、さらに設定が必要となる場合もあります。 

 Orion データベース向けに SQL Server Management Studio へのアクセスを得るには

データベース管理者に問い合わせる必要があるかもしれません。 

 次の手順で履歴保守記録をクリアにし、Orion データベースのバックアップを作成します。

ただし、SolarWinds では通常、Orion データベースを管理するために SQL Server 

Management Studio を使用する方法については、データベース管理者に連絡し、SQL 

サーバーに付属の Microsoft ドキュメンテーションを参照するようにお勧めしています。 

SQL Server Management Studio を使用して Orion データベースを管理するには： 

1. Start > Microsoft SQL Server > SQL Server Management Studio （スタート > 

Microsoft SQL サーバー > SQL Server Management Studio ）をクリックします。 

2. View > Object Explorer （ビュー > Object Explorer ）をクリックします。 

3. 左側の Object Explorer ペインで Orion データベースを含む SQL サーバーのインスタン

スを拡張します。 

注記： 任意のインスタンスのデータベース フォルダを拡張し、含まれているデータベースを

確認してください。デフォルトで、Orion データベースには SolarWinds Orion という名

前が付いています。 

4. 管理フォルダを拡張して保守計画フォルダを右クリックし、Maintenance Plan Wizard 

（保守計画ウィザード）をクリックします。 

5. Next （次へ）をクリックし、SQL Server Maintenance Plan Wizard （SQL サーバー保

守計画ウィザード）をスタートします。 

6. 保守計画の適切な Name （名前）と Description （説明）を入力します。 
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7. Server （サーバー）フィールドの横にある Browse (…) （参照）をクリックします。 

8. SQL Server \ Instance にチェックを入れ、OK をクリックします。 

注記： SQL Server\Instance がリストに含まれていない場合は、手動で入力してください。 

9. SQL サーバーへの接続に使用される認証タイプを選択し、必要に応じて適切な User 

name （ユーザー名）と Password （パスワード）の資格証明を入力します。 

注記： Orion データベースにアクセスするには、Orion Configuration Wizard （ Orion 

設定ウィザード）に入力した認証タイプおよび資格証明と同じものを使用してください。 

10. Clean Up History （履歴のクリーンアップ）および Back Up Database (Full) （デー

タベースのバックアップ（完全））にチェックを入れます。 

注記： タスクをクリックすると、Maintenance Plan Wizard （保守計画ウィザード）にタス

クの簡単な説明が表示されます。 

11. Next （次へ）をクリックします。 

12. タスクの実行順序を上から下に設定します。必要に応じて Move Up （上に移動）または 

Move Down （下に移動）を選択してください。 

注記： 次の手順では、Clean Up History （履歴のクリーンアップ）タスクを Back Up 

Database (Full) （データベースのバックアップ（完全））タスクよりも前に行うものと想定し

ています。 

13. タスクの実行順序を設定したら、Next （次へ）をクリックします。 

14. Define Cleanup History Task （履歴クリーンアップ タスクの定義）ビューで、削除する履

歴データのタイプにチェックを入れ、履歴データの削除のしきい値となる期間を設定します。 

15. Next （次へ）をクリックします。 

16. Database Back Up (Full) （データベースのバックアップ（完全）ビューで、次の手順を実

行します。 

a.  Databases （データベース）ィールドをクリックします。 

b.  These databases （これらのデータベース）を選択します。 

c.  使用している Orion データベースにチェックを入れます。 

17. OK をクリックします。 

18. Backup component （バックアップ コンポーネント）エリアで Database （データベース）を

選択します。 
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19. Destination （保存先）エリアで次の手順を実行します。 

a. Disk （ディスク）を選択します。 

b. Create a backup file for every database （あらゆるデータベースのバックアップ 

ファイルを作成する）を選択します。 

c. Browse (…) （参照）をクリックし、十分な空き容量のある適切なデータベース バッ

クアップ ファイルの保存先を選択します。 

20. Next （次へ）をクリックします。 

21. Select Plan Properties （計画プロパティの選択）ビューで、Change （変更）をクリック

します。 

22. 次のようにデータベース保守ジョブのスケジュールを設定します。 

a. 新しいジョブ スケジュールの適切な Name （名前）を入力します。 

b. Schedule type （スケジュール タイプ） として Recurring （反復）を選択します。 

c. Enabled （有効）にチェックを入れたあと、Occurs （発生）フィールドで Daily （毎

日）を選択します。 

d. Occurs once at （発生頻度）フィールドにオフピーク ネットワーク使用時間を入力

します。 

e.  Start date （開始日）を選択してから、No end date （終了日なし）を選択します

。 

23. OK をクリックします。 

24. Next （次へ）をクリックし、Write a report to a text file （テキスト ファイルにレポートを

書き込む）にチェックを入れます。 

25. Browse (…) （参照）をクリックし、適切な保守レポート ファイルの書き込み先を選択し

ます。 

26. ウィザードの結果をレビューして Finish （完了）をクリックし、ウィザードが終了したら 

Close （閉じる）をクリックします。 

SQL server Management Studio の使用に関する詳細なヘルプについては、Microsoft サ

ポート ウェブサイト（ http://support.microsoft.com ）をご覧ください。 

http://support.microsoft.com/
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データベース保守 

SQL データベースの保守に利用できる主なタスクは、データの要約とデータベースの圧縮です。

データの要約は、夜間保守プログラムの一環として自動的に行われます。また、Windows の

スタート メニューからオン デマンドでデータベースの保守を実行することもできます。 

データベース保守の実行 

 データベースの保守では、一連のデータ要約を実行して Orion データベースのサイズの最適化

を支援します。データの要約では、一定期間に収集されたネットワークデータをすべて収集し、

データから統計情報を計算し、統計情報を保持する一方でデータ自体を廃棄します。定期的

にデータベースの保守を行うと、容量が大幅に節約されるとともにパフォーマンスも改善します。 

データベースの保守は、スタート メニューから直接実行するか、特定のアーカイブ時間にスケ 

ジュールを設定して Orion ウェブ コンソールの Orion Polling Settings （Orion ポーリング設

定）ビューで開始することができます。どちらの場合でも、データの保守は通常、一度開始する

と注意を払わなくても進行します。Orion Polling Settings （Orion ポーリング設定）ビューで

データベース保守のアーカイブ時間を設定する方法の詳細については、262 ページの「Orion 

ポーリング設定」を参照してください。次の手順は、データベースの保守を実行する方法を示し

ています。 

注記： データベースの保守を実行するには、管理権限が必要です。 

データベース保守ユーティリティを実行するには： 

1. Orion ウェブ コンソールからデータベースの保守を実行する場合は、次の手順に従ってく
ださい。 

a. ウェブ コンソールの右上で Settings （設定）をクリックし、設定グループで Poller 

Settings （ポーラーの設定）をクリックします。 

b. Database Settings （データベースの設定）エリアで Perform Maintenance 

Now （今すぐ保守を実行）をクリックします。 

2. スタート メニューからデータベース保守を実行する場合は、Start > All Programs > 

SolarWinds Orion > Advanced Features > Database Maintenance （スター

ト > すべてのプログラム > SolarWinds Orion > 拡張機能 > データベース保守）をクリッ

クしてから、Start （開始） をクリックします。 
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データベースの移動 

Orion NPM インプリメンテーションを変更して異なるデータベース サーバーを使用する場合は、

Orion データベースから別の Orion データベースにデータを移動することができます。データのエ

クスポート元であるデータベースと、データのインポート先であるデータベースは双方とも、Orion 

のバージョンが同じである必要があります。 

警告： ウェブサイトを上書きしてもウェブ  コンソールのカスタマイゼーションは失われません

が、.asp ページ内で手作業で HTML を上書きまたは変更した場合は例外です。 

注記： タブをスキップしたり、タブの順序を変えたりしないでください。Start （開始）をクリックして

から Continue （続行）をクリックし、ウィザードを順番どおりに実行します。タブの順序を変更

して実行すると、インストール手順に悪影響が出る場合があります。詳細については、9 ページ

の 「 SolarWinds Orion Network Performance Monitor 」 を 参 照 し て く だ 

さい。 

Orion データベースからデータをエクスポートして別の Orion データベースにインポートするには： 

1. データベース マネージャを使用し、データベース サーバーに接続します。詳細については、

388ページの「サーバーの追加」を参照してください。 

2. データベースを選択し、Database > Backup Database （データベース > データベース

のバックアップ）をクリックします。 

3. データベース バックアップの Description （説明）を入力します。 

4. パスを入力するか、Browse (…) （参照）をクリックして Backup Filename （バックアッ

プ ファイル名）までナビゲートします。 

5. OK をクリックします。 

6. 新規作成したバックアップ ファイルを新しいサーバーのフォルダにコピーします。 

注記： バックアップ ファイルは、使用している Orion データベースと特定の.bak 拡張子に

基づいて名前が付けられます。たとえば、Orion データベース名として OrionDB を指定

した場合、バックアップ名は OrionDB.bak となります。 

7. Start > All Programs > SolarWinds Orion > Advanced Features > Database 

Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > データベー

ス マネージャ）の順でクリックします。 

8. Add Server （サーバーの追加）をクリックします。 

9. SQL Server （SQL サーバー）リストから SQL インスタンスの名前を選択します。使用し

ているサーバーがリストに含まれていない場合は、388 ページの「サーバーの追加」手順を

実行します。 
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10. 適切な認証タイプを選択し、Connect to Database Server （データベース サーバー

に接続）をクリックします。 

11. リストで新しいサーバーを選択し、Server > Connect to Server （サーバー > サーバ

ーに接続）をクリックします。 

12. Server > Restore Database （サーバー > データベースの復元）をクリックします。 

13. サーバー上のデータベース バックアップ ファイルへのパスを入力するか、Browse (…)  

（参照）をクリックしてデータベース バックアップ ファイルの場所までナビゲートします。 

14. OK をクリックします。 

15. データベース マネージャを閉じます。 

16. Start > All Programs > SolarWinds Orion > Configuration and Auto-

Discovery > Configuration Wizard （スタート > すべてのプログラム > SolarWinds 

Orion > コンフィギュレーションおよび自動ディスカバリ > コンフィギュレーション ウィザード）をク

リックします。 

17. ウィザードの Database Setup （データベース設定）セクションで、新しく復元したデータ 

ベースを指定します。 

18. プロンプトが表示されたら Yes （はい）をクリックし、既存のデータベースを使用します。 
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第 28章 

一般的な Orion NPM タスク 

以下の章では、Orion NPM がソリューションを提供する数多くの一般的なネットワーク パ 

フォーマンス監視シナリオについて説明します。 

ネットワーク デバイス障害を見つけるためのアラートの作成 

アドバンスト アラート機能を備えた Orion NPM では、ネットワーク上のデバイスで問題が発生

すると、すみやかにこれを見つけることができます。次の手順では、カスタム ロケーション プロパ 

ティを使用して監視中のネットワーク上のノード障害を知らせる、アドバンスト アラートを作成し

ます。 

カスタム プロパティの作成 

Orion NPM はカスタム プロパティ エディタを備えており、最もよく使用される数多くのプロパティ

の中から選択したり、独自のカスタム プロパティを簡単に効率よく構築することができます。カス

タム プロパティを定義すると、インポート ウィザードで、テキスト ファイルまたはコンマ区切りファイ

ルから新しいプロパティを自動入力することができます。詳細については、377 ページの「カスタ

ム プロパティ データのインポート」を参照してください。 

変更または追加の数が少ない場合は、Edit （編集）ビューで変更を行うこともできます。詳細

については、379ページの「カスタム プロパティの編集 」を参照してください。 

次の手順では、カスタム プロパティ エディタを使用し、監視中のノードに適用するカスタム ロ 

ケーション プロパティを作成します。 

カスタム ロケーション プロパティを作成・適用するには： 

1. Start > All Programs > SolarWinds Orion > Grouping and Access Control > 

Custom Property Editor （スタート > すべてのプログラム > SolarWinds Orion > グルー

プ化およびアクセス コントロール > カスタム プロパティ エディタ）をクリックします。 
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2. Add Custom Property （カスタム プロパティの追加）をクリックします。 

 

3. Add Predefined Properties （定義済みのプロパティを追加）を選択し、State （状

態）にチェックを入れて OK をクリックします。 

 

 

4. Start > All Programs > SolarWinds Orion > Orion Web Console （スタート  > す

べてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリックします。 

5. 管理者として Orion ウェブ コンソールにログインします。 

6. ウェブ コンソールの右上にある Settings （設定）をクリックします。 

7. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノード＆グループ管理）のグループ化で Manage Nodes （ノードの管

理）をクリックします。 

8. 次の方法のいずれかを使用し、状態プロパティに適用するノードのタイプを選択します。 

 ノード リストに上にある検索ツールを使用して、Orion データベースを検索します。 

 適切な Group by （グループ化基準）で基準を選択し、ノードを含む適切なグルー

プをクリックします。 
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9. 状態プロパティを適用するノードすべてにチェックを入れ、Node Management （ノード管

理）ツールバーで Edit Properties （プロパティの編集）をクリックします。 

 

10. State （状態）にチェックを入れ、選択したノードまたはノード グループの適切な状態名を

入力して Submit （送信）をクリックします。 

 

 

カスタム プロパティを使用したアラートの作成 

次の例では、上記で定義された状態カスタム プロパティを使用して複数のアラートを作成しま

す。各アラートは、ノードが低下するとトリガーされます。トリガーのあと、アラートをトリガーする 

ノードの状態カスタム プロパティの値に応じて、各アラートは特定のアクションを実行します。 

新しいアドバンスト アラートを作成するには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and Mapping > 

Advanced Alert Manager （スタート > すべてのプログラム > SolarWinds Orion > アラート

、レポートおよびマッピング > アドバンスト アラート マネージャ）をクリックします。 

2.  Configure Alerts （アラートの設定）をクリックします。 
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3. Alert me when a node goes down （ノードが低下したら通知する）にチェックを入れ

て、Edit （編集）をクリックします。 

 

 

4. Trigger Actions （トリガー アクション）タブをクリックしてから、Add New Action （新規

アクションの追加）をクリックします。 
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次のセクションでは、選択したアラートに多数のアラート アクションを追加する方法を説明します。 

アラート アクションの設定 

次のセクションでは、同じアラートに対する 3 つの異なるアクションを作成します。 

 ローカル アラート ログの作成 

 Syslog メッセージ 

 SMTP トラップの送信 

次のセクションでは、状態カスタム プロパティがすでに作成されており、既存のアラートにアクショ

ンを追加しているものと想定しています。カスタム プロパティの詳細については、375 ページの

「カスタム プロパティの作成  –  コア」を参照してください。アラート作成の詳細については、 

275 ページの「アドバンスト アラートの作成と設定」を参照してください。 

ローカル アラート ログの作成 

次の手順では、Orion NPM 評価をホストしているコンピュータでローカル アラート ログを設定

します。 

ローカル アラート ログを作成するには： 

1. 編集用にネットワーク上で有効にするアラートを開きます。 

注記： 編集用にアラートを開く方法の詳細については、275ページの「アドバンスト アラー

トの作成と設定」」を参照してください。 

2. Trigger Actions （トリガー アクション）タブをクリックしてから、Add New Action （新規

アクションの追加）をクリックします。 

 

3. Log the Alert to a file （アラートをファイルにログする）を選択し、OK をクリックします。 
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4. Browse (…) （参照）をクリックしてデフォルトの Orion ディレクトリを開きます。 

 

 

5. 適切なフォルダを参照し、アラート ログ ファイル名として ExampleAlertLog と入力します。 

 

 

6. Save （保存）をクリックします。 

7. Message （メッセージ）テキスト  ボックスで、Node ${NodeName} in ${State} 
network is currently down （${State}ネットワークのノード ${NodeName} は現

在ダウン）と入力します。 
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8. OK をクリックします。 

 

 

次のセクションでは、このアラートがトリガーされた場合に、指定したサーバーに Syslog メッセー

ジを送信する追加のアクションを設定します。 

Syslog メッセージの送信 

次の手順で、アラート Syslog メッセージを設定します。 

アラート Syslog メッセージ アクションを設定するには： 

1. 編集するアラートを開き、Add New Action （新規アクションの追加）をクリックします。 

 

 

2. Send a Syslog Message （ Syslog メッセージの送信）を選択してから、OK をクリッ

クします。 

3. Syslog Message （ Syslog メッセージ）タブをクリックします。 
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4. Hostname or IP Address of the Syslog Server （ Syslog サーバーのホスト名ま

たは IP アドレス）として 127.0.0.1 と入力します。次に、Syslog Message （Syslog 

メ ッ セ ー ジ ） フ ィ ー ル ド に Node ${NodeName} in ${State} network is 

currently down （${State} ネットワークのノード ${NodeName} は現在ダウン） と入

力します。 

注記： Orion NPM 変数では、${ variable } 構文が必要です。詳細については、

431ページの「Orion NPM 変数と例」を参照してください。 

 

 

5. OK をクリックします。 

SNMP トラップの送信  

次の手順で、SNMP トラップ アラート アクションを設定します。 

SNMP トラップ アクションを設定するには： 

1. 編集するアラートを開き、Add New Action （新規アクションの追加）をクリックします。 

2. Send an SNMP Trap （SNMP トラップの送信）を選択し、OK をクリックします。 
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3. SNMP Trap （SNMP トラップ）タブをクリックします。 

4. SNMP Trap Destination （SNMP トラップ送信先）として 127.0.0.1 と入力し、

…Alert Message （… アラート メッセージ）フィールドに Node ${NodeName} in 
${State} network is currently down （${State} ネットワークのノード 

${NodeName} は現在ダウン） と入力します。 

注記： Orion NPM 変数では、${ variable } 構文が必要です。利用可能な変数

の詳細については、431ページの「Orion NPM 変数と例」を参照してください。 

 

 

5. OK をクリックします。 

6. アラート アクションの設定を終了したら、OK をクリックします。 

アラートのテスト 

アラートの機能チェックをするために、実際にデバイスで障害を生じさせる必要はありません。

Orion NPM はアラートのテスト機能が備えられているため、次の手順に示されているように、

アラートが適切に設定されていることを確認できます。 

設定済みアラートをテストするには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and Mapping > 

Advanced Alert Manager （スタート > すべてのプログラム > SolarWinds Orion > アラート

、レポートおよびマッピング > アドバンスト アラート マネージャ）をクリックします。 

2. Configure Alerts （アラートの設定）をクリックします。 
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3. テストするアラートにチェックを入れて、Test （テスト）をクリックします。 

注記： この例では、Alert me when a node goes down （ノードが低下したら通知

する）にチェックを入れます。これは、上記で設定されたアラートと同じものです。 

 

 

4. Alert on Network Node （ネットワーク ノード上でアラート）を選択し、Orion サーバー

を選びます。 
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5. Test Alert Definition （テスト アラートの定義）エリアで、Test Alert Trigger （テスト 

アラート トリガー）をクリックします。 

 

6. テスト中は、アラート テスト ログをレビューします。 

アラートのテストが終了したあと、次のように各アラート アクションの結果を表示できます。 

 メール アラート アクションの結果を表示するには、Orion フォルダで 

EvaluationAlertLog を開きます（通常は、<Volume: >\Program 

Files\Solarwinds\Orion ）。 

 Syslog メッセージ  アクションの結果を表示するには、Start > All Programs > 

SolarWinds Orion > Syslog and SNMP Traps > Syslog Viewer （スタート > 

すべてのプログラム > SolarWinds Orion > Sylog および SNMP トラップ > Syslog 

Viewer ）をクリックします。 

 Syslog メッセージ  アクションの結果を表示するには、Start > All Programs > 

SolarWinds Orion > Syslog and SNMP Traps > Trap Viewer （スタート > す

べてのプログラム > SolarWinds Orion > Sylog および  SNMP トラップ > Trap 

Viewer ）をクリックします。 
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営業時間レポートのスケジュール設定とメール送信 

Orion Report Writer は、あらゆる Orion 製品で利用できるコンポーネントです。Orion 

Report Scheduler とともに Orion Report Writer を使用すると、レポートを作成し、定期的

なスケジュールを設定したメールでこれを配信することができます。次のセクションでは、ピーク営

業時間中のインターフェース トラフィックのレポート例のメール配信を作成し、スケジュールを設

定します。 

営業時間レポートの作成 

次の手順で、ピーク営業時間（午前 7 時～午後 7 時として定義）のインターフェース トラ 

フィック月次レポートを作成します。 

営業時間インターフェース トラフィック レポートを作成するには： 

1. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and 

Mapping > Report Writer （スタート > すべてのプログラム > SolarWinds Orion > 

アラート、レポートおよびマッピング > Report Writer ）をクリックします。 

2. 左側のペインで、Historical Traffic Reports > Average and Peak Traffic 

Rates – Last Month （履歴トラフィック レポート > 平均およびピーク トラフィック レート

：前月）をクリックします。 

3. General （一般）タブで適宜、Report Group （レポート グループ）と Report Title （レ

ポート タイトル）、Description （説明）を編集します。 

4. Filter Results （フィルタ結果）タブで Browse (...) （参照）をクリックし、Add a new 

elementary condition （新しい基本的条件を追加する）を選択します。 

5. 新しいフィールドで最初のアスタリスク（*）をクリックし、Date/Time (Traffic Filtering 

Only) > Time of Day (24 hour format) （日時（トラフィックのフィルタリングのみ） > 

時刻（24 時間形式））を選択します。 

6. is equal to （以下と同等：）をクリックし、greater or equal （以上）を選択します。 

7. 2 番目のアスタリスク（*）をクリックし、ピーク営業時間の開始時刻を 24 時間 hh:mm 

形式で入力します（例：07:00）。 

8. Browse (...) （参照）をクリックし、Add a new elementary condition （新しい基本

的条件を追加する）を選択します。 

9. 最初のアスタリスク（*）をクリックし、Date/Time (Response Time Filtering Only) > 

Time of Day (24 hour format) （日時（応答時間のフィルタリングのみ） > 時刻（ 24 

時間形式））を選択します。 

10. is equal to （等しい）をクリックし、less （未満）を選択します。 
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11. 2 番目のアスタリスク（*）をクリックし、ピーク営業時間の終了時刻を 24 時間 hh:mm 

形式で入力します（例： 19:00 ）。 

12. Browse (...)（参照）をクリックし、Add a new elementary condition （新しい基本

的条件を追加する）を選択します。 

13. 最初のアスタリスク（*）をクリックし、Date/Time (Traffic Filtering Only) > Day of 

Week （日時（トラフィックのフィルタリングのみ） > 曜日）を選択します。 

14. is equal to （等しい）をクリックし、not equal （等しくない）を選択します。 

15. 2 番目のアスタリスク（*）をクリックし、Saturday （土曜日）を選択します。 

16. Browse (...)（参照）をクリックし、Add a new elementary condition （新しい基本

的条件を追加する）を選択します。 

17. 最初のアスタリスク（*）をクリックし、Date/Time (Response Time Filtering Only) > 

Day of Week （日時（応答時間のフィルタリングのみ） > 曜日）を選択します。 

18. is equal to （等しい）をクリックし、not equal （等しくない）を選択します。 

19. 2 番目のアスタリスク（*）をクリックし、Sunday （日曜日）を選択します。 

20. Report Designer （レポート デザイナー）ペインの右側で Preview （プレビュー）をクリック

します。 

21. File > Save （ファイル > 保存）をクリックします。 

これでレポートは、Orion サーバーの Reports （レポート）フォルダに保存されます。レポート デ

ザイナーの General （一般）タブのレポート グループの一部としてリストされます。 

レポートのスケジュール設定とメール送信 

次の手順で、選択したレポートのスケジュールを設定し、メールで配信できるようにします。 

メール レポートのスケジュールを設定するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スタート  > す

べてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリックします。 

2. Reports （レポート）をクリックします。 

3. 必要に応じて + をクリックし、メール送信のスケジュールを設定するレポートを見つけます。 

4. メール送信用にスケジュールを設定するレポートの名前をクリックします。 

5. メール送信のスケジュールを設定するレポートの URL をコピーします。 
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6. Start > All Programs > SolarWinds Orion > Alerting, Reporting, and Mapping > 

Orion Report Scheduler （スタート > すべてのプログラム > SolarWinds Orion > アラート

、レポートおよびマッピング > Orion Report Scheduler ）をクリックします。 

7. Edit > Add New Job （編集 > 新規ジョブの追加）をクリックします。 

8. このスケジュール済みレポート メールの適切なジョブ名を入力し、Continue （続行）をク

リックします。 

9. メール送信をスケジュールするレポートの URL をリンク フィールドに貼り付けます。 

10. スケジュールを設定しているレポートを表示するために Windows ログイン資格証明を入
力する必要がある場合は、NT Account （NT アカウント）のログイン タブをクリックし、ログ

インに必要なユーザー アカウントの詳細を入力します。  

11. Orion ウェブ コンソールのバナーやメニュー バーを除いた印刷可能なレポートを作成する
には、Orion Web Login （Orion ウェブ  ログイン）タブで  Retrieve a Printable 

Version of this Page （このページの印刷可能なバージョンを取得する）にチェックを入

れます。 

12. スケジュールを設定しているレポートで Orion ユーザー アカウントが必要な場合は、
Orion Web Login （Orion ウェブ  ログイン）タブで  Send Orion Username / 

Password in URL （URL で Orion ユーザー名 / パスワードを送信する）にチェックを入

れ、Orion レポートを表示するために必要なユーザー資格証明を入力します。 

13. Continue （続行）をクリックします。 

14. レポート ジョブ向けのスケジュールを設定し、Continue （続行）をクリックします。 

15. Email the Web Page (as HTML) （HTML としてウェブ ページをメールする）または 

Email the Web Page (as PDF) （PDF としてウェブ ページをメールする）のいずれかが

選択されていることを確認してから、Continue （続行）をクリックします。 

16. Email To （メール送信先）タブの適切なフィールドに必要なメール アドレスと件名を入力

します。 

17. Email From （メール送信元）タブに氏名と返信先アドレスを入力します。 

18. SMTP Server （SMTP サーバー）タブでホスト名または IP アドレスを入力し、Orion  

サーバーからのメール送信に使用されるサーバーのポート番号を確認します。 

19. Continue （続行）をクリックします。 

20. レポートをメール送信するローカル Windows アカウントのユーザー名とパスワードを入力

し、Continue （続行）をクリックします。 

21. このジョブに関するさらなるコメントや注記を追加し、Finish （完了）をクリックします。 
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地理ビューまたは部門ビューの作成 

グループを利用すると、カスタム ウェブ コンソール ビューを簡単に作成して、地理または部門の

場所別に監視されたオブジェクトの情報を表示できます。次の手順で、カスタム ビューを作成

し、適切なグループ ベースのリソースを使って自動入力します。 

カスタム グループの作成 

次の手順で、定義済みの地理的な場所における監視されたオブジェクトのカスタム グループを

作成します。 

カスタム グループを作成するには： 

1. Start > All Programs > SolarWinds Orion > Orion Web Console （スタート  > す

べてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリックします。 

2. 管理者としてウェブ コンソールにログインします。 

3. ウェブ コンソールの右上にある Settings （設定）をクリックします。 

4. Orion Website Administration （ウェブサイト管理）ページの  Node & Group 

Management （ノードおよびグループ管理）のグループ化で Manage Groups （グルー

プの管理）をクリックします。 

5. Add New Group （新しいグループの追加）をクリックします。 

6. カスタム グループの適切な名前と説明を入力します。たとえば、オースティン という名前のグ

ループは、オースティン オフィスにあるすべての監視されたネットワーク オブジェクト として説明で

きます。 

7. Next （次へ）をクリックします。 

8. Available Objects （利用可能なオブジェクト）ペインで、グループの定義に一致するすべ

ての監視されたオブジェクトにチェックを入れます。たとえば、上記の例では、オースティン オ

フィスにあるすべてのオブジェクトを選択します。 

9. Add to Group （グループに追加）をクリックします。 

10. 右側の新しいグループ ペインで監視されたオブジェクトをすべて選択し、Create Group 

（グループの作成）をクリックします。 

同じ地理的な場所にある監視されたオブジェクトの新しいグループが、Manage Groups （グ

ループの管理）ビューにリストされます。 
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付録 A 

ソフトウェアのライセンス キー 

インストール中に Install Software License Key （ソフトウェアのライセンス キーのインストー

ル）ウィンドウが開き、名前とメール アドレス、電話番号、カスタマー ID 、パスワードを入力する

よう求められることがあります。この場合は次の手順に従い、ソフトウェアのライセンス キーを有

効にしてください。 

ソフトウェアのライセンス キーを有効にするには： 

1. Orion Network Performance Monitor をインストールしているコンピュータがインター
ネットに接続されている場合は、要求された情報を Install Software License Key （ソ

フトウェア ライセンス キーのインストール）ウィンドウに入力して Continue （続行）をクリッ

クします。 

注記： SolarWinds ライセンス登録サーバーはライセンス キーを迅速に発行し、Orion 

Network Performance Monitor を操作できるようになります。 

2. Orion Network Performance Monitor をインストールしているコンピュータがインター
ネットに接続していない場合、ご使用中のサーバーは SolarWinds ライセンス登録サー

バーで認証されないため、次の手順を実行する必要があります。 

a. Install Software License Key （ソフトウェア ライセンス キーのインストール）ウィンド

ウで Skip This and Enter Software License Key Now （これをスキップして

今すぐソフトウェア ライセンス キーを入力する）をクリックします。 

b. インターネットに接続されている別のコンピュータを使い、SolarWinds ウェブサイトの

カスタマーエリア（ www.solarwinds.com/keys ）にログインします。 

c. Customer Area （カスタマーエリア）メニューで Software Keys （ソフトウェア キー）

をクリックします。 

d. キーが必要な製品をクリックします。 

e. 要求された情報を入力します（コンピュータ名、プログラムのシリアル番号など）。 

f. Generate Key （キーの生成）をクリックします。 

g. 生成されたキーをコピーします。 

h. Enter Software License Key （ソフトウェア ライセンス キーの入力）テキスト ボッ

クスにキーを入力します。 

3. Continue （続行）をクリックして、ソフトウェア ライセンス キーのインストールを完了します。 
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付録 B 

自動ログインの設定 

Orion NPM ウェブ コンソールでは、次の方法のいずれでもログインすることができます。 

 Windows Active Directory Authentication 。Orion NPM バージョン 10.1 以降にリ

リースされたあらゆる Orion 製品で利用できます。 

 Windows Pass-through Security 。Windows Pass-through Security を使用する

場合、Orion NPM ユーザーは Windows Security を介して認証されるため、別個の

Orion NPM アカウントまたはユーザー名とパスワードを使用してログインする必要はありま

せん。詳細については、422ページの「Windows Passthrough Security の使用 」を参

照してください。 

  DirectLink 。DirectLink アカウントが有効な場合、Orion ウェブ コンソール ページを直

接参照する URL はすべて、Orion ウェブ コンソールのログインページをバイパスし、ユーザ

ーを DirectLink アカウントでログインします。詳細については、425 ページの「DirectLink 

アカウントの使用」を参照してください。 

  URL パススルー。詳細については、424 ページの「URL パラメータを使用したログイン情

報のパス」を参照してください。 

Orion NPM では、次の方法でユーザーのログインに優先順位を付けます。 

1. Windows Active Directory Authentication を有効にします。Windows Active 

Directory Authentication を有効にするには、コンフィギュレーション ウィザードで Orion 

ウェブ コンソールの設定を行う際、Windows Authentication （Windows 認証）オプショ

ンにチェックを入れます。 

2. URL でパスされたアカウントまたはユーザー ID とパスワード。 

3. login.aspx ページで入力されたアカウントまたはユーザー ID とパスワード。 

4. NT Security を使用してユーザーをログインする Windows ユーザー（ IIS NT Security 

が有効な場合）。 

5. ユーザーの所属する Windows ドメイン（例： Development\Everyone ）。 

6. DirectLink アカウントの存在。 
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Windows Passthrough Security の使用 

Orion NPM バージョン 10.1 よりも前にリリースされた Orion の全製品では、  IIS NT 

Security が有効になっている場合に Windows Passthrough Security 機能を利用するこ

とができます。Orion NPM ユーザーは Windows Security を介して認証されるため、別個の

Orion NPM アカウントまたはユーザー ID とパスワードを使用してログインする必要はありませ

ん。Passthrough Security は、ドメインまたはローカル コンピュータ セキュリティのいずれかを

使用するよう設定できます。双方を同時に使用することも可能です。Orion Network 

Performance Monitor のアカウントあるいはユーザー ID およびパスワードを設定し、ドメイン

および / またはローカル コンピュータ セキュリティで使用されたアカウントあるいはユーザー ID お

よびパスワードに一致させる必要があります。次の手順で IIS NT Security を有効にし、

Windows Passthrough Security を使用して Orion ウェブ コンソールにログインできるように

します。注記： 

 Orion NPM 10.1 のリリースに伴い、アクティブ ディレクトリを使って Orion ウェブ コンソー

ルのユーザーを認証できるようになりました。 

 Windows Security でユーザーを認証する際は、Orion サーバーが完全に適格なドメイ

ン名ではなく、NetBIOS ドメイン名を使用していることを確認してください。 

Windows Passthrough Security 向け IIS NT セキュリティを有効にするには： 

1. パススルー アカウントで NT ドメイン認証形式を使用する場合は、次のようにユーザー名

として Domain\UserID を使用し、Orion Web Console Account Manager でパスス

ルー アカウントを作成します。 

  Washington\Edward 

  StLouis\Bill 

注記： Orion Web Console Account Manager を使用したアカウント作成の詳細に

ついては、249ページの「新規アカウントの作成」を参照してください。 

2. パススルー アカウントでローカル コンピュータ認証形式を使用する場合は、次のように 

User Name （ユーザー名）として Computer \ UserID を使用して Orion Web 

Console Account Manager でアカウントを作成します。 

 SolarWinds S2\Edward 

  Server3\JonesR 
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注記： Orion Web Console Account Manager を使用したアカウント作成の詳細に

ついては、249ページの「新規アカウントの作成」を参照してください。 

3. Start > Control Panel > Administrative Tools > Internet Information Services 

(IIS) Manager （スタート > コントロール パネル > 管理ツール > インターネット インフォメーショ

ン サービス（ ISS ）マネージャ）をクリックします。 

4. Windows Server 2003 を使用している場合は、次の手順を実行してください。 

a. 左側のペインで、Internet Information Services > Local Computer > Web 

Sites （インターネット インフォメーション サービス > ローカル コンピュータ > ウェブサイ

ト）の順に拡張表示します。 

b. SolarWinds NetPerfMon を選択します。 

c. Action > Properties （アクション > プロパティ）をクリックします。 

d. Directory Security （ディレクトリ セキュリティ）タブをクリックします。 

e. Authentication and access control （認証およびアクセス コントロール）エリア

内で Edit （編集）をクリックします。 

f. Enable anonymous access （匿名のアクセスを有効にする）をクリアします。 

g. 認証済みアクセス グループで Integrated Windows authentication （統合 

Windows 認証）にチェックを入れます。 

h. OK をクリックして、Authentication Methods （認証方法）ウィンドウを閉じます。 

i. 利用できる場合には  Apply （適用）をクリックしてから  OK をクリックし、

SolarWinds NetPerfMon Properties （ SolarWinds NetPerfMon プロパティ）

ウィンドウを閉じます。 

j. Internet Information Services > Local Computer > Web Sites （インター

ネット インフォメーション サービス > ローカル コンピュータ > ウェブサイト）の順に折りた

たみます。 

k. 左側のペインで、Internet Information Services > Local Computer （インター

ネット インフォメーション サービス > ローカル コンピュータ）の順に折りたたみます。 

l. Action > All Tasks > Restart IIS （アクション > すべてのタスク > IIS の再起

動）をクリックします。 

m. Restart Internet Services on Local Computer （ローカル コンピュータでインタ
ーネット サービスを再起動する が選択されていることを確認し、OK をクリックします。 

n. IIS マネージャを閉じます。 
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5. Windows Server 2008 を使用している場合は、次の手順を実行してください。 

a. Start > Administrative Tools > Server Manager （スタート > 管理ツール > 

サーバー マネージャ）をクリックします。 

b. Roles （役割）を拡張します。 

c. Web Server (IIS) （Web サーバー（IIS）） をクリックします。 

d. Role Services （役割サービス）エリアで、Web Server > Security > Windows 

Authentication （ウェブ サーバー > セキュリティ > Windows 認証）がインストールさ

れていることを確認します。 

e. Windows 認証がインストールされていない場合は、Add Role Services （役割

サービスを追加） を ク リ ッ ク し 、Web Server > Security > Windows 

Authentication （ウェブ サーバー > セキュリティ > Windows 認証）にチェックを入

れます。Next （次へ）をクリックして、サービスのインストールを完了します。 

f. Start > Administrative Tools > Internet Information Services (IIS) 

Manager （スタート > 管理ツール > インターネット インフォメーション サービス（IIS ）

マネージャ）をクリックします。 

g. 左側のペインで独自の Orion サーバーを選択します。 

h. メイン ペインの IIS グループで Authentication （認証）をクリックします。 

i. Anonymous Authentication （匿名の認証）を右クリックし、Disable （無効）

をクリックします。 

j. Windows Authentication （Windows 認証）を右クリックし、Enable （有効）を

クリックします。 

k. Orion サーバーをクリックしてから Actions （アクション）ペインで Restart （再起動）

をクリックします。 

6. IIS マネージャを閉じます。 

7. すでに確立している Windows アカウント資格証明を使用して Orion ウェブ コンソールに

ログインします。 

URL パラメータを使用したログイン情報のパス 

ユーザー ID とパスワードは、URL 内のパラメータとしてパスできます。これにより、ブラウザ内、

またはデスクトップ上でお気に入りやブックマークを作成できます。ログイン情報をパスするため、

次の形式でリンクのあるお気に入りを作成します。 

http://DOMAIN/Orion/Login.aspx?AccountID=USER&Password=PASSWORD 
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使用している Orion サーバーのホスト名または IP アドレスを DOMAIN として入力します。

Orion ユーザー ID を USER 、Orion ユーザー アカウントのパスワードを PASSWORD として入

力します。 

警告： HTTP 要求は暗号化されていないため、HTTP 要求で送信されたユーザー ID とパス

ワードは安全ではありません。Orion サーバー上での HTTP 有効化の詳細については、

www.microsoft.com を参照してください。 

DirectLink アカウントの使用 

DirectLink アカウントを有効にすると、まだ Orion ウェブ コンソールのユーザー アカウントを持っ

ていない個人が利用できる特定のウェブ コンソールへの直接的なハイパーリンクを作成できま

す。Orion NPM ウェブ ページを直接参照する URL はすべて、ログイン画面をバイパスし、 

ユーザーを DirectLink アカウントにログインします。DirectLink アカウントは他のアカウントのよ

うに作成でき、カスタム ビューとアカウント制限を含めることができます。ウェブ コンソール アカウ

ントの詳細については、249ページの「新規アカウントの作成」を参照してください。 

Orion ウェブ コンソールの DirectLink アカウントを有効にするには： 

1. 管理者として Orion ウェブ コンソールにログインします。 

2. ウェブ コンソールの右上で Settings （設定）をクリックし、アカウント グループで Manage 

Accounts （アカウントの管理）をクリックします。 

3. Add （追加）をクリックします。 

4. 新しい User Name （ユーザー名）として DirectLink と入力します。 

5. パスワード を入力および再入力し、Submit （送信）をクリックします。 

6. 必要に応じて、使用している Orion Network Performance Monitor 用に DirectLink 

アカウント オプションを編集します。アカウント オプション編集の詳細については、250 ペー

ジの「ユーザーアカウントの編集」を参照してください。 

7. DirectLink アカウントのホーム ページとして使用するカスタム ビューを作成します。詳細に

ついては、182ページの「新規ビューの作成」を参照してください。 

8.  アカウント マネージャでデフォルトのビューとして新しい DirectLink ビューを指定します。詳

細については、250ページの「ユーザーアカウントの編集」を参照してください。 

9.  DirectLink アカウントを特定のデバイスやデバイス タイプに制限する場合は、253ペー

ジの「アカウント制限の設定」を参照してください。 
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付録 C 

ステータス アイコンと識別子 

Orion NPM および Orion モジュールでは、システム マネージャおよびウェブ コンソールのリソー

スでステータス インジケータとして数多くの異なるアイコンを使用しています。アラートとイベントに

ついては、リソース内でさらに詳細な情報をアイコンと一緒に示します。 

ステータス インジケータ 

下表は、Orion NPM アイコンを関連のあるステータス表示、ステータスのタイプ、ステータス識

別子（数値）、最悪なステータスからの手順とともにリストしたものです。 

 注記： 「無視」タイプのステータス レベルは、ステータス ロールアップ モードでは表示されません。 

 アイコン ステータス表示  タイプ  ID 

 ノードまたはインターフェースが低下（ポーリング要求タイムアウト）  エラー  2 

 シャットダウン  エラー  4 

 下層ダウン  エラー  8 

 到達不可  エラー  12 

 

 
ノードは警告状態（パケットがドロップまたはインターフェースが低下）  警告  3 

 危機  警告  14 

 混合可用性  警告  15 

 誤設定  警告  16 

 ポーリング不可  警告  17 

 未確認  警告  19 

 
ポーリング エンジンのシャットダウン、監視停止、システム エラー、フェ

イルオーバー 
 警告  -- 

 
システム警告：ノード、インターフェース、またはボリュームの変更：イン

ターフェース再表示：ネットワーク ベースライン開始 / 終了 
 警告  -- 

 ノードまたはインターフェースが上昇  OK  1 

 休止  OK  6 

 有効  OK  22 

 無効  OK  24 
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 アイコン ステータス表示  タイプ  ID 

 期限切れ  OK  25 

 不明  無視  0 

 ノードまたはインターフェースが未管理  無視  9 

 インターフェースはアンプラグ状態だが低下していない  無視  10 

 

ノードは「外部」として定義 

（ノードは Orion NPM によって監視されていないが、ノード上のアプ

リケーションが APM によって監視されている可能性あり） 

 無視  11 

 監視無効  無視  26 

 無効  無視  27 

 ライセンスなし  無視  28 

 情報提供、ボリューム再表示  該当なし  -- 

 監視開始、NPM サービス開始、またはフェイルバック  該当なし  -- 

 
 ノード、インターフェース、またはボリュームの削除 

 インターフェースのシャットダウン 
 該当なし  -- 

 
 ノードの追加 

 インターフェースまたはボリュームの追加（システム マネージャ） 
 該当なし  -- 

  インターフェースまたはボリュームの追加（ウェブ コンソール）  該当なし  -- 

  ノードの再起動  該当なし  -- 

  インターフェースが有効  該当なし  -- 

  インターフェースの再マッピング  該当なし  -- 

  ボリュームの再マッピング  該当なし  -- 

  インターフェースまたはボリュームの消失  該当なし  -- 
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ステータス ロールアップ モード 

Orion ウェブ コンソールでは、ステータス ロールアップ モードで、ノード グループの可用性ステー

タスの表示方法を指定します。選択したグループ内の異なるステータス レベルにオブジェクトが

ある場合は、3 つのオプションを利用できます。 

 Show Best Status （最良ステータスを表示）は、代理またはバックアップ デバイスのコレ

クションとして定義されているグループを表示する際に最も有用です。下表は、Show 

Best Status （最良ステータスを表示）オプションの操作方法を示しています。 

注記： Show Best Status （最良ステータスを表示）オプションのグループ ステータス結果

と、Show Worst Status （最悪ステータスを表示）オプションと同じグループのオブジェクト

の結果を比較します。 

 オブジェクト ステータス  グループ ステータス 

 （アップ、警告、ダウン）  （アップ） 

 （警告、ダウン）  （アップ） 

 （警告、ダウン、不明）  （警告） 

 Show Worst Status （最悪ステータスを表示）では、オブジェクト グループの最悪なス

テータスがグループ全体に表示されます。次の表で、Show Worst Status （最悪ステー

タスを表示）オプションの機能について説明します。 

 オブジェクト ステータス  グループ ステータス 

 （アップ、警告、ダウン）  （ダウン） 

 （警告、ダウン）  （警告） 

 （警告、ダウン、不明）  （ダウン） 

 

 Mixed Status shows Warning （混在ステータスが警告を表示）で、グループのス 

テータスがグループ内で最悪警告タイプ ステータスを表示することを確認します。警告タイ

プ ステートがなくても、アップとダウン双方のステータスがグループに含まれている場合、

Mixed Availability warning （  ）（混在警告）ステータスがグループ全体に表示されま

す。次の表で、Mixed Status shows Warning （混在ステータスが警告を表示）オプ

ションの機能について説明します。 

 オブジェクト ステータス  グループ ステータス 

  （危機） 

  （危機） 

  （混合可用性） 
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付録 D 

Orion NPM 変数と例 

Orion NPM は、他の Orion 製品と同様に、アドバンスト アラート マネージャ（Trap Viewer と 

Syslog Viewer の両方）、および Network Atlas など、Orion の構成部品を採用しており、

それらすべてが Orion 変数を使用できます。これらの変数はダイナミックで、アラート発生時に、

アラートがトリガーまたはリセットされると解析を行います。たとえば、変数 ${ResponseTime} 

は、アラートをトリガーしているノードの現在の応答時間で解析を行います。 

注記： 一部のケースでは、${Nodes.CPULoad} のように、アラート変数にデータベース テーブ

ル名が必要です。変数が意図した通りに応答しない場合、希望する変数のテーブル名を含め

てください。 

変数修正子 

次のセクションの変数は次の表の変数修正子のいずれかを追加することで修正することができ

ます。 

 変数修正子 説明 

 -Raw 
統計の未加工値を表示します。たとえば、送信帯域幅が 10 Mbps に設定され

ている場合、未加工値は「 10000000 」です。加工値は「 10 Mbps 」です。 

 -Previous アラートがトリガーされる前の統計の以前の値を表示します。 

 -Cooked 

統計の加工値を表示します。たとえば、Transmit Bandwidth が 10 Mbps に

設定されている場合、未加工値は「 10000000 」で、加工値は「 10 Mbps 」で

す。 

 -PreviousCooked アラートがトリガーされる前の統計の以前の加工値を表示します。 

アドバンスト アラート エンジン変数 

次の変数は Orion NPM および Orion モジュール内のアラートメッセージで使用できます。各

変数はドル記号で開始し、変数識別子を中括弧で囲みます（たとえば、${ObjectName} ）。 

一般 

以下は有効で一般的なアドバンスト アラート変数です。 

 一般的な変数 説明 

 ${Acknowledged} 承認済みステータス 

 ${AcknowledgedBy} アラートを承認した人 
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 一般的な変数 説明 

 ${AcknowledgedTime} アラートが承認された時間 

 ${AlertTriggerCount} トリガー回数 

 ${AlertTriggerTime} 
このアラートの最後のイベントの日時。（ Windows のコントロール パネルが

定義した「日付（短い形式）」と「時刻（短い形式）」） 

 ${Application} SolarWinds アプリケーション情報 

 ${CR} 改行 - キャリッジ リターン 

 ${Copyright} 著作権情報 

 ${ObjectName} アラート内のオブジェクトの説明 / 名前 

 ${Release} リリース情報 

 ${Version} SolarWinds ソフトウェア パッケージのバージョン 

日付／時刻 

以下は有効な日付変数と時間変数です。 

 日付／時間変数  説明 

 ${AMPM}  AM/PM 識別子 

 ${AbreviatedDOW}  1 週間のうちの現在の曜日。3 文字の省略表示。 

 ${D}  1 ヶ月のうちの現在の日付 

 ${DD}  １ヶ月のうちの現在の日付（ 2 桁の数字、ゼロ詰め） 

 ${Date}  現在の日付。（短い日付形式） 

 ${DateTime} 
 現在の日付と時刻。（ Windows のコントロール パネルが定義した「日付

（長い形式）」と「時刻（長い形式）」） 

 ${DayOfWeek}  1 週間のうちの現在の曜日。 

 ${DayOfYear}  1 年のうちの数値日 

 ${H}  現在の時間 

 ${HH}  現在の時間。2 桁の形式、ゼロ詰め。 

 ${Last2Hours}  最近の 2 時間 

 ${Last24Hours}  最近の 24 時間 

 ${Last7Days}  最近の 7 日間（短い日付形式） 

 ${LastHour}  最近の 1 時間 

 ${LocalDOW}  1 週間のうちの現在の曜日。ローカライズされた言語形式。 

 ${LocalMonthName}  地域の言語での現在の月名。 

 ${LongDate}  現在の日付。（長い日付形式） 

 ${M}  数字で示した現在の月 

 ${MM}  現在の月。2 桁の数値、ゼロ詰め。 

 ${MMM}  現在の月。3 文字の省略表示。 
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 日付／時間変数  説明 

 ${MMMM}  現在の月のフルネーム 

 ${MediumDate}  現在の日付。（中間の長さの日付形式） 

 ${Minute}  現在の分。2 桁の形式、ゼロ詰め。 

 ${S}  現在の秒。 

 ${Second}  現在の秒。2 桁の形式、ゼロ詰め。 

 ${Time}  現在の時刻。（短い時刻形式） 

 ${Today}  今日（短い日付形式） 

 ${Year}  4 桁で示す年度 

 ${Year2}  2 桁で示す年度 

 ${Yesterday}  昨日（短い日付形式） 

 グループ変数 

 以下は有効なグループ変数です。 

 グループ変数 説明 

 ${GroupDetailsURL} 選択したグループのグループ詳細ビューの URL 

 ${GroupFrequency} 
グループ メンバーシップが評価され、グループ スナップショット

が取得される間隔。 

 ${GroupID} 定義したグループの指定識別子 

 ${GroupMemberDisplayName} 
グループ メンバー タイプの表示名：ノード、ボリューム、コン 

ポーネント、アプリケーションなど。 

 ${GroupMemberDisplayNamePlural} 
あるタイプの複数のグループ メンバーの表示名：ノード、コン

ポーネント、アプリケーションなど。 

 ${GroupMemberFullName} グループ メンバーのフルネーム（場所を含む）。 

 ${GroupMemberName} グループ メンバーの名前 

 ${GroupMemberPercentAvailability} 

グループ メンバー ステータスがアップ、警告、または臨界のと

きのグループ メンバーの可用性率、ステータスがそれ以外の

場合は 0%。 

 ${GroupMemberSnapshotID} グループ メンバー スナップショットの固有識別子。 

 ${GroupMemberStatusID} 

そのステータスを示すグループ メンバーに割り当てられた識別

子。詳細については、434ページの「ステータス変数」をご覧

ください。 

 ${GroupMemberStatusName} 
グループ メンバー スタータスの名前。詳細については、 

434ページの「ステータス変数」をご覧ください。 

 ${GroupMemberUri} 

SolarWinds Information Service (SWIS) が Web コン

ソール内で選択したグループ メンバーを参照するのに使用し

た URI。 

 ${GroupName} グループの名前。 
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 グループ変数 説明 

 ${GroupOwner} グループ タイプに適した Orion 製品 

 ${GroupPercentAvailability} 
グループ ステータスがアップ、警告、臨界のときは 100% 、そ

れ以外のときは 0%。 

 ${GroupStatusCalculatorID} 

メンバーのステータスに基づいてグループのステータスを評価

するロールアップ論理計算器の名前。 

（0 = 混合、1 = 最低、2 = 最高） 

 ${GroupStatusCalculatorName} 

メンバーのステータスに基づいてグループのステータスを評価

するロールアップ論理計算器の名前。 

（混合 、最低 、最高 ） 

 ${GroupStatusID} 

そのステータスを示すグループに割り当てられた識別子。 

詳細については、434ページの「ステータス変数」をご覧くだ 

さい。 

 ${GroupStatusName} 
グループ ステータスの名前。詳細については、434ページの

「ステータス変数」をご覧ください。 

 ${GroupStatusRootCause} アップではないすべてのグループ メンバーのリスト 

 ${NodeID} 常に NULL - レガシー製品のサポートのためのみ。 

SQL クエリー 

データベースから収集できる値は SQL クエリーを使って変数として生成、フォーマット化、また

は計算することができます。Orion NPM で SQL クエリーを変数として使用するには、SQL ク

エリー Select Count(*) From Nodes : の結果を返す次の例のように、

${SQL:{query}} を使用します。 

${SQL:Select Count(*) From Nodes} 

ステータス変数 

${Status} 変数を監視されたオブジェクトで使用するとき、ステータス値は必要に応じて返さ

れます。次の表は各ステータス値について説明しています。 

 ステータス値  説明 

 0  不明 

 1  アップ 

 2  ダウン 

 3  警告 

 4  シャットダウン 

 5  試験中 

 6  休止 

 7  不在 
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 ステータス値  説明 

 8  下層ダウン 

 9  非管理 

 10  非接続 

 11  外部 

 12  到達不可 

 14  危機 

 15  混合可用性 

 16  誤設定 

 17  ポーリング不可 

 19  未確認 

 22  有効 

 24  無効 

 25  期限切れ 

 26  監視無効 

 27  無効 

 28  ライセンスなし 

 ノード変数 

以下は有効なノード変数です。 

 ノード変数 説明 

 ${AgentPort} ノード SNMP ポート番号 

 ${Allow64BitCounters} 
ノードは 64 ビット カウンターを使用可能（ 1 ）、または

不可能（ 0 ） 

 ${AvgResponseTime} ICMP の要求に対する平均ノード応答時間（ミリ秒） 

 ${BlockUntil} 
ノード ポーリングがブロックされるまでの曜日、日付およ

び時刻 

 ${BufferBgMissThisHour} 

現在の時間におけるノードでのバッファーの重大なミス

のデバイス依存数、MIB 1.3.6.1.4.9.2.1.30 でク 

エリー 

 ${BufferBgMissToday} 

現在の曜日におけるノードでのバッファーの重大なミス

のデバイス依存数、MIB 1.3.6.1.4.9.2.1.30 でク 

エリー 

 ${BufferHgMissThisHour} 

現在の時間におけるノードでのバッファーの特に重大な

ミスのデバイス依存数、MIB 1.3.6.1.4.9.2.1.62 でク

エリー 
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 ノード変数 説明 

 ${BufferHgMissToday} 

現在の曜日におけるノードでのバッファーの特に重大な

ミスのデバイス依存数、MIB 1.3.6.1.4.9.2.1.62 でク

エリー 

 ${BufferLgMissThisHour} 

現在の時間におけるノードでのバッファーの重大なミス

のデバイス依存数、MIB 1.3.6.1.4.9.2.1.38 でクエ 

リー 

 ${BufferLgMissToday} 

現在の曜日におけるノードでのバッファーの重大なミス

のデバイス依存数、MIB 1.3.6.1.4.9.2.1.38 でクエ 

リー 

 ${BufferMdMissThisHour} 

現在の時間におけるノードでのバッファーの中程度のミ

スのデバイス依存数、MIB 1.3.6.1.4.9.2.1.22 でク 

エリー 

 ${BufferMdMissToday} 

現在の曜日におけるノードでのバッファーの中程度のミ

スのデバイス依存数、MIB 1.3.6.1.4.9.2.1.22 でク 

エリー 

 ${BufferNoMemThisHour} 
現在の時間におけるノードでのメモリ不足によるバッファ

エラー数 

 ${BufferNoMemToday} 
現在の曜日におけるノードでのメモリ不足によるバッファ

エラー数 

 ${BufferSmMissThisHour} 
現在の時間におけるノードでのバッファーの小さなミスの

デバイス依存数、MIB 1.3.6.1.4.9.2.1.14 でクエリー 

 ${BufferSmMissToday} 
現在の曜日におけるノードでのバッファーの小さなミスの

デバイス依存数、MIB 1.3.6.1.4.9.2.1.14 でクエリー 

 ${Caption} ユーザー フレンドリーなノード名 

 ${Community} ノード コミュニティ ストリング 

 ${Contact} ノードを担当する人またはグループの連絡先情報 

 ${CPULoad} 最後のポーリング時のノード CPU 使用率 

 ${CustomPollerLastStatisticsPoll} 
ノードで最後のポーリングを試みた曜日、日付および

時刻 

 ${CustomPollerLastStatisticsPollSuccess} 
ノードで最後のポーリングが成功した曜日、日付および

時刻 

 ${Description} ノードのハードウェアおよびソフトウェア 

 ${DNS} 完全に適格なノード名 

 ${DynamicIP} 

ノードが BOOTP または DHCP を使ったダイナミック 

IP アドレスの割り当てに対応している場合は（1）を、ス

タティック IP アドレスの場合は（0）を返す 

 ${EngineID} 
ノードが割り当てられたポーリング エンジンの内部固有

識別子 

 ${GroupStatus} 
ノードのステータス アイコンのファイル名、Orion NPM 

の場合はそのインターフェース 

 ${IOSImage} ノードの Cisco IOS のファミリー名  
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 ノード変数 説明 

 ${IOSVersion} ノードの Cisco IOS バージョン 

 ${IP_Address} ノードの IP アドレス 

 ${LastBoot} 最後にノードを起動した曜日、日付および時刻 

 ${LastSync} 
ノードのデータベースとメモリを最後に同期させた時刻と

日付 

 ${Location} ノードの物理的な場所 

 ${MachineType} 
ノードの製造業者または販売代理店およびファミリーま

たはバージョン情報 

 ${MaxResponseTime} ICMP の要求に対する最大ノード応答時間（ミリ秒） 

 ${MemoryUsed} ポーリング間隔で使用されたノード メモリ合計 

 ${MinResponseTime} ICMP の要求に対する最小ノード応答時間（ミリ秒） 

 ${NextPoll} 
次にスケジュールされているノード ポーリングの曜日、

日付および時刻 

 ${NextRediscovery} 次のノードの再ディスカバリの時刻 

 ${NodeID } ノードの内部固有識別子 

 ${ObjectSubType} 
ノードが SNMP またはその ICMP のみをサポートする

かどうかを示します 

 ${PercentLoss} 
ノードが最後にポーリングされたときの ICMP パケット 

ロス割合 

 ${PercentMemoryUsed} ポーリング間隔で使用されたノード メモリ合計 % 

 ${PollInterval} ノードのポーリング間隔（秒） 

 ${RediscoveryInterval} ノードの再ディスカバリ間隔（分） 

 ${ResponseTime} 
最後の ICMP 要求に対するノードの応答時間 

（ミリ秒） 

 ${RWCommunity} 

ノードの読み取り / 書き込みコミュニティ文字列、読み

取り / 書き込み SNMP アクセスのセキュリティ コードと

して機能 

 ${RWSNMPV3AuthKey} SNMPv3 読み取り / 書き込み資格証明認証キー 

 ${RWSNMPV3AuthKeyIsPwd} 
SNMPv3 読み取り / 書き込み資格証明認証キーが

パスワードかどうかを示す 

 ${RWSNMPV3AuthMethod} SNMPv3 読み取り / 書き込み資格証明認証方法 

 ${RWSNMPV3Context} 
SNMPv3 読み取り / 書き込みセキュリティー コンテキ

スト情報 

 ${RWSNMPV3PrivKey} SNMPv3 読み取り / 書き込み資格証明キー 

 ${RWSNMPV3PrivKeyIsPwd} 
SNMPv3 読み取り / 書き込み資格証明プライバシー 

キーがパスワードかどうかを示す 

 ${RWSNMPV3PrivMethod} 
SNMPv3 読み取り / 書き込み資格証明プライバシー

暗号方法 
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 ノード変数 説明 

 ${RWSNMPV3Username} 
SNMPv3 読み取り / 書き込み資格証明のユーザー 

フレンドリーな名前 

 ${Severity} 

監視するオブジェクトのステータスにスコアを付けること

によって付加的に決定したネットワーク健全性スコア。

たとえば、Orion NPM では、警告状態のインター 

フェースには 1 ポイント、ダウン状態のインターフェースに

は 1,000 ポイント、ダウン状態のノードには 100 万ポ

イントが付与されます。 

 ${SNMPV2Only} 
ノードが SNMPv1 または SNMPv2 のみをサポートし

ているかどうかを示します 

 ${SNMPV3AuthKey} SNMPv3 認証キー 

 ${SNMPV3AuthKeyIsPwd} 
ノードの SNMPv3 認証キーがパスワードかどうかを示

します 

 ${SNMPV3AuthMethod} SNMPv3 認証タイプ 

 ${SNMPV3Context} 
ノードへの SNMPv3 アクセスのあるユーザーのグルー

プまたはドメイン 

 ${SNMPV3PrivKey} SNMPv3 資格証明キー 

 ${SNMPV3PrivKeyIsPwd} 
ノード SNMPv3 資格証明キーがパスワードかどうかを

示します 

 ${SNMPV3PrivMethod} SNMPv3 資格証明キー タイプ 

 ${SNMPV3Username} SNMPv3 資格証明のユーザー フレンドリーな名前 

 ${SNMPVersion} ノードが使用する SNMP のバージョンを示します 

 ${StatCollection} 統計の収集頻度（分） 

 ${Status} 
ノードの数値ステータス。詳細については、435ページ

の「ノード変数」をご覧ください。 

 ${StatusDescription} ユーザー フレンドリなノード ステータス 

 ${StatusLED} ノード ステータス アイコンのファイル名 

 ${SysName} 
SNMP SYS_NAME OID 要求に対する文字列の

応答 

 ${SysObjectID} 
OID 形式のネットワーク管理サブシステムのベンダー 

ID 。ノードのタイプを明確に決定します。 

 ${SystemUpTime} ネットワークの監視を開始してからの時間（1/100 秒） 

 ${TotalMemory} 利用可能な合計ノード メモリ 

 ${UnManaged} ノードが現在管理されていないかどうかを示します。 

 ${UnManageFrom} 
ノードが「非管理」に設定された曜日、日付、および 

時刻 

 ${UnManageUntil} 
ノードが管理されるようにスケジュールされた曜日、日

付、および時刻 

 ${Vendor} ノードの製造業者または販売代理店 

 ${VendorIcon} ノードのベンダー ロゴのファイル名 
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ボリューム変数 

以下は、有効なボリューム変数です。 

 ボリューム変数 説明 

 ${Caption} ユーザー フレンドリなボリューム名 

 ${FullName} 
親ノードのキャプションを含むユーザー フレンドリなボリューム名

で、Orion NPM の場合、インターフェース  

 ${LastSync} 
データベースとメモリ モデルで最後にボリュームを同期した時

刻と日付 

 ${NextPoll} 
次にスケジュールされているボリューム ポーリングの曜日、 

日付および時刻 

 ${NextRediscovery}  次のボリュームの再ディスカバリのスケジュール時刻 

 ${NodeID} 親ノードの内部固有識別子 

 ${PollInterval} ボリュームステータスのポーリング間隔（秒） 

 ${RediscoveryInterval} ボリュームの再ディスカバリ間隔（分） 

 ${StatCollection} 統計の収集頻度（分） 

 ${Status} 
ボリュームの数値ステータス：（ 0= 「不明」、1= 「アップ」、 

2= 「シャットダウン」、3= 「試験中」） 

 ${StatusLED} ボリューム ステータス アイコンのファイル名 

 ${VolumeAllocationFailuresThisHour} 
最後の 1 時間にこのボリュームに対して発生したボリューム割

り当てエラー数 

 ${VolumeAllocationFailuresToday} 
現在の曜日にこのボリュームに対して発生したボリューム割り

当てエラー数 

 ${VolumeDescription} ユーザー フレンドリなボリュームの説明 

 ${VolumeID} ボリュームの内部固有識別子 

 ${VolumeIndex} 親ノード内のこのボリュームの固有指数 

 ${VolumePercentUsed} 現在使用中のボリュームの % 

 ${VolumeResponding} (Y) = ボリュームは現在 SNMP クエリーに応答中 

 ${VolumeSize} ボリュームのサイズ（バイト） 

 ${VolumeSpaceAvailable} ボリュームで利用可能な合計空き容量（バイト） 

 ${VolumeSpaceUsed} ボリュームで使用されている合計容量（バイト） 

 ${VolumeType} 

hrStorageType OID （リムーバブル ディスク / 固定ディスク / 

コンパクト ディスク / 仮想メモリ /RAM/ 等）で報告された、ボ

リューム タイプ 

 ${VolumeTypeIcon} ボリューム タイプに対するアイコンのファイル名 
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変数を使用するメッセージの例 

次の例は、変数の使用の一部を示しています。 

 前回の再起動は ${LastBoot-Previous} で実行されました。 

 アラート： ${NodeName} は非常に高応答時間となっています。平均応答時間は 

${AvgResponseTime} でその範囲は ${MinResponseTime} ～ 

${MaxResponseTime} です。 

 ${NodeName} の現在のパケット損失は ${%Loss} です。平均応答時間は 

${AvgResponseTime} でその範囲は ${MinResponseTime} ～ 

${MaxResponseTime} です。 

 アラート： ${NodeName} をクエリーするために使用する SNMP コミュニティ ストリングは 

${Community-Previous} から ${Community} に変更されています。 

 Orion NPM は新しいコミュニティ ストリングを使用して ${NodeName} をクエリーします。 

基本的なアラート エンジンの変数 

次の変数は Orion NPM 内の基本アラートメッセージで使用できます。各変数は 

${NodeID} のように、中括弧で囲み、ドル記号で開始する必要があります。 

アラート固有 

以下は有効な一般的なアラート固有変数です。 

 アラート固有変数 説明 

 ${AlertName} アラートの名前 

 ${Property} このアラートが監視しているプロパティ 

 ${TriggerTime} 
このアラートの最後のイベントの日時。（ Windows のコントロール パネルが

定義した「日付（短い形式）」と「時刻（短い形式）」） 

 ${LastResetTime} 
このアラートの最後のイベントの日時。（ Windows のコントロール パネルが

定義した「日付（短い形式）」と「時刻（短い形式）」） 

 ${LongTriggerTime} 
このアラートの最後のイベントの日時。（ Windows のコントロール パネルが

定義した「日付（中間の形式）」と「時刻（中間の形式）」） 

 ${LongLastResetTime} 
このアラートの最後のイベントの日時。（ Windows のコントロール パネルが

定義した「日付（中間の形式）」と「時刻（中間の形式）」） 

 ${TriggeredValue} アラートをトリガーした値 

 ${AlertStartTime} アラートがアクティブでトリガー / リセットが可能な 1 日のうちの時刻 

 ${AlertEndTime} アラートがアクティブでトリガー / リセットが可能な 1 日のうちの時刻 
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 バッファ エラー 

 以下は有効なバッファ関連変数です。 

 バッファ エラー変数  説明 

 
${BufferNoMemThisHour} 

 現在の時間中にメモリ不足により生じたバッファ エラー 

 ${BufferNoMemToday}  現在の日付中にメモリ不足により生じたバッファ エラー 

 
${BufferSmMissThisHour} 

 この時間中の小さなバッファ ミス 

 ${BufferSmMissToday}  この日中の小さなバッファ ミス 

 
${BufferMdMissThisHour} 

 この時間中の中規模のバッファ ミス 

 ${BufferMdMissToday}  この日中の中規模のバッファ ミス 

 ${BufferBgMissThisHour}  この時間中の重大なバッファ ミス 

 ${BufferBgMissToday}  この日中の重大なバッファ ミス 

 ${BufferLgMissThisHour}  この時間中の重大なバッファ ミス 

 ${BufferLgMissToday}  この日中の重大なバッファ ミス 

 ${BufferHgMissThisHour}  この時間中の特に重大なバッファ ミス 

 ${BufferHgMissToday}  この日中の特に重大なバッファ ミス 

日付／時刻 

以下は有効な日付と時刻の変数です。 

 日付／時間変数  説明 

 ${DateTime} 
 現在の日付と時刻。（ Windows のコントロール パネルが定義した「日付

（短い形式）」と「時刻（短い形式）」） 

 ${Date}  現在の日付。（短い日付形式） 

 ${LongDate}  現在の日付。（長い日付形式） 

 ${MediumDate}  現在の日付。（中間の長さの日付形式） 

 ${Time}  現在の時刻。（短い時刻形式） 

 ${DayOfWeek}  1 週間のうちの現在の曜日。 

 ${D}  1 ヶ月のうちの現在の日付 

 ${DD}  １ヶ月のうちの現在の日付（ 2 桁の数字、ゼロ詰め） 

 ${AbreviatedDOW}  1 週間のうちの現在の曜日。3 文字の省略表示。 

 ${LocalDOW}  1 週間のうちの現在の曜日。ローカライズされた言語形式。 

 ${M}  数字で示した現在の月 

 ${MM}  現在の月。2 桁の数値、ゼロ詰め。 

 ${MMM}  現在の月。3 文字の省略表示。 
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 日付／時間変数  説明 

 ${MMMM}  現在の月のフルネーム 

 ${LocalMonthName}  地域の言語での現在の月名。 

 ${DayOfYear}  1 年のうちの数値日 

 ${Year2}  2 桁で示す年度 

 ${Year}  4 桁で示す年度 

 ${H}  現在の時間 

 ${HH}  現在の時間。2 桁の形式、ゼロ詰め。 

 ${Minute}  現在の分。2 桁の形式、ゼロ詰め。 

 ${S}  現在の秒。 

 ${Second}  現在の秒。2 桁の形式、ゼロ詰め。 

 ${AMPM}  AM/PM 識別子 

グループ変数 

以下は有効なグループ変数です。 

 グループ変数 説明 

 ${GroupDetailsURL} 選択したグループのグループ詳細ビューの URL 

 ${GroupFrequency} 
グループ メンバーシップが評価され、グループ スナップショット

が取得される間隔。 

 ${GroupID} 定義したグループの指定識別子 

 ${GroupMemberDisplayName} 
グループ メンバー タイプの表示名：ノード、ボリューム、コンポ

ーネント、アプリケーションなど。 

 ${GroupMemberDisplayNamePlural} 
あるタイプの複数のグループ メンバーの表示名：ノード、 

コンポーネント、アプリケーションなど。 

 ${GroupMemberFullName} グループ メンバーのフルネーム（場所を含む）。 

 ${GroupMemberName} グループ メンバーの名前 

 ${GroupMemberPercentAvailability} 

グループ メンバー ステータスがアップ、警告、または臨界のと

きのグループ メンバーの可用性率、ステータスがそれ以外の

場合は 0%。 

 ${GroupMemberSnapshotID} グループ メンバー スナップショットの固有識別子。 

 ${GroupMemberStatusID} 

そのステータスを示すグループ メンバーに割り当てられた識別

子。詳細については、237ページの「グループの管理 」を参

照してください。 

 ${GroupMemberStatusName} 
グループ メンバー スタータスの名前。詳細については、237

ページの「グループの管理 」を参照してください。 

 ${GroupMemberUri} 

SolarWinds Information Service (SWIS) が Web コン

ソール内で選択したグループ メンバーを参照するのに使用し

た URI。 
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 グループ変数 説明 

 ${GroupName} グループの名前。 

 ${GroupOwner} グループ タイプに適した Orion 製品 

 ${GroupPercentAvailability} 
グループ ステータスがアップ、警告、臨界のときは 100% 、 

\それ以外のときは 0% 。 

 ${GroupStatusCalculatorID} 

メンバーのステータスに基づいてグループのステータスを評価

するロールアップ論理計算器の名前。 

（0 = 混合、1 = 最低、2 = 最高） 

 ${GroupStatusCalculatorName} 

メンバーのステータスに基づいてグループのステータスを評価

するロールアップ論理計算器の名前。 

（ 混合 、最低 、最高 ） 

 ${GroupStatusID} 

そのステータスを示すグループに割り当てられた識別子。詳

細については、237ページの「グループの管理 」を参照してく

ださい。 

 ${GroupStatusName} 
グループ ステータスの名前。詳細については、237ページの

「グループの管理 」を参照してください。 

 ${GroupStatusRootCause} アップではないすべてのグループ メンバーのリスト 

 ${NodeID} 常に NULL - レガシー製品のサポートのためのみ。 

 インターフェース 

 以下は有効なインターフェース関連の変数です。 

 インターフェース変数 説明 

 ${Caption} インターフェースの説明 

 ${InterfaceID} 
インターフェースの固有 ID 。Network Performance Monitor はすべての

ネットワーク オブジェクトに固有 ID を割り当てます。 

 ${InterfaceCaption} このインターフェースに対してユーザーが割り当てた名前 

 ${Index} ネットワーク ノード内のインターフェースのインデックス 

 ${InterfaceType} 
インターフェースの数値タイプ。この情報は、ネットワーク ノードのディスカバリ

時に Orion NPM によって収集されます。 

 ${MAC} インターフェースの物理アドレス（ MAC アドレス） 

 ${MTU} 最大送信単位 

 ${InterfaceSpeed} 
ネットワーク ノードのスキャン時に Network Performance Monitor がディ

スカバリしたインターフェースの速度 

 ${InterfaceName} ノードから見つかったインターフェースの名前 

 ${InterfaceIcon} 
インターフェースのタイプ（Ethernet 、Frame-Relay 、ATM 、Token 

Ring 、無線等）を示すアイコン。 

 ${NodeID} 
このインターフェースが属するノードの ID。Orion NPM はすべてのネット 

ワーク オブジェクトに固有 ID を割り当てます。 

 ${InterfaceTypeName} インターフェースのタイプ。ifType からディスカバリ。 
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 インターフェース変数 説明 

 ${FullName} 
インターフェースが属するネットワーク ノードの名前を含むインターフェースの

フルネーム 

 ${Counter64} インターフェースは IF-MIB 高容量カウンターに対応 

 インターフェース エラー 

 以下は有効なインターフェース エラー関連の変数です。 

 インターフェース エラー変数 説明 

 ${InDiscardsToday} 今日のこのインターフェースに対する受信廃棄の累積数 

 ${InErrorsToday} 今日のこのインターフェースに対する受信エラーの累積数 

 ${OutErrorsToday} 今日のこのインターフェースに対する送信エラーの累積数 

 ${OutDiscardsToday} 今日のこのインターフェースに対する送信廃棄の累積数 

 ${InDiscardsThisHour} この時間での、このインターフェースに対する受信廃棄の累積数 

 ${InErrorsThisHour} 
この時間での、このインターフェースに対する受信エラーの累積数（このカ

ウンターは 00 時にリセットされます） 

 ${OutErrorsThisHour} 
この時間での、このインターフェースに対する送信エラーの累積数（このカ

ウンターは 00 時にリセットされます） 

 ${OutDiscardsThisHour} 
この時間での、このインターフェースに対する送信廃棄の累積数（このカ

ウンターは 00 時にリセットされます） 

 インターフェース ポーリング 

 以下は有効なインターフェース ポーリング関連の変数です。 

 インターフェース ポーリング

変数 
 説明 

 ${PollInterval}  インターフェースをポーリングする頻度（秒） 

 ${RediscoveryInterval}  ノード / インターフェースが再ディスカバリされる頻度（分） 

 ${NextRediscovery}  このインターフェースの次の完全なディスカバリの予定時刻 

 ${NextPoll}  このインターフェースの次のポーリングの予定時刻 

 ${StatCollection}  統計収集頻度 

 インターフェース ステータス 

 以下は有効なインターフェース ステータス関連の変数です。 

インターフェース ステータス変数 説明 

 ${AdminStatus} インターフェースの管理者ステータス（有効または無効） 

 ${AdminStatusLED} インターフェースの現在の管理者ステータス（有効または無効）を示す LED 
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インターフェース ステータス変数 説明 

 
${InterfaceLastChange} 

インターフェースが操作ステータスを最後に変更した日時 

 ${OperStatus} インターフェースの操作ステータス 

 ${OperStatusLED} インターフェースの現在の操作ステータスを示す LED 

 ${Status} インターフェースの現在のステータス（アップ、ダウン、シャットダウン等） 

 ${StatusLED} インターフェースの現在のステータス（アップ、ダウン、シャットダウン等） 

 インターフェース トラフィック 

 以下は、有効なインターフェース トラフィック関連の変数です。 

インターフェース トラフィック

変数 
説明 

 ${OutBandwidth} 
インターフェースのユーザー定義送信帯域幅。送信および受信帯域幅は、非

対称回線を正確に監視するために、それぞれ独立して設定できます。 

 ${OutBps} インターフェースが送信している現在のトラフィック量 

 ${InBps} インターフェースが受信している現在のトラフィック量 

 ${OutPps} インターフェースが送信した現在のパケット レート（秒） 

 ${InPps} インターフェースが受信した現在のパケット レート（秒） 

 ${InPktSize} インターフェースが現在受信中のパレットの平均パケット サイズ 

 ${OutUcastPps} 送信したユニキャスト パケットの現在のレート（秒） 

 ${OutMCastPps} 送信したマルチキャスト パケットの現在のレート（秒） 

 ${InUcastPps} 受信したユニキャスト パケットの現在のレート（秒） 

 ${InMcastPps} 受信したマルチキャスト パケットの現在のレート（秒） 

 ${OutPktSize} インターフェースが現在送信中のパレットの平均パケット サイズ 

 ${InPercentUtil} インターフェースの受信側での現在の使用率 

 ${OutPercentUtil} インターフェースの送信側での現在の使用率 

 ${MaxInBpsToday} インターフェースの今日のピーク受信 bps 

 ${MaxOutBpsToday} インターフェースの今日のピーク送信 bps 

 ${MaxInBpsTime} ピーク bps を受信した時刻（今日） 

 ${MaxOutBpsTime} ピーク bps を送信した時刻（今日） 

 ${InBandwidth} 
インターフェースのユーザー定義受信帯域幅。送信および受信帯域幅は、非

対称回線を正確に監視するために、それぞれ独立して設定できます。 
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ノード 

以下は有効なノード変数です。 

 ノード変数 説明 

 ${NodeID} 各ノードに自動的に割り当てられる固有 ID 

 ${IP_Address} ノードの IP アドレス。これはすべての管理機能に使用される IP アドレスです。 

 ${NodeName} このノードにユーザーが割り当てた名前 

 ${SysName} ノードのシステム名 

 ${DNS} 
リバース DNS ルックアップを使って決定した DNS 名。DNS エントリーはネッ

トワーク ノードの再ディスカバリ中に確認されます。 

 ${SysObjectID} 製造業者によってこのノードに割り当てられた固有識別子 

 ${Vendor} ネットワーク ノードの製造業者 

 ${Location} システム MIB から取得した場所 

 ${Contact} 
システムの連絡先。この情報は、ネットワークのディスカバリ時に  Network 

Performance Monitor によって収集されます。 

 ${Description} 
ノードのシステムの説明。この情報は、ネットワークのディスカバリ時に 

Network Performance Monitor によって収集されます。 

 ${LastBoot} 前回マシンを起動した日時 

 ${Community} このノードとの通信に使用した SNMP コミュニティ ストリング 

 ${VendorIcon} マシンのタイプを示すアイコン 

 ${IOSImage} Cisco IOS イメージ ファミリー タイプ 

 ${IOSVersion} Cisco IOS バージョン 

 ${MachineType} ネットワーク ノードのマシン タイプまたは製造業者 

ノード ポーリング 

以下は、有効なノード ポーリング関連の変数です。 

 ノード ポーリング変数  説明 

 ${RediscoveryInterval}  ノードが再ディスカバリされる頻度（分） 

 ${NextRediscovery}  次の再ディスカバリの日時 

 ${PollInterval}  ノード / インターフェースがポーリングされる頻度。（秒） 

 ${NextPoll}  ノード / インターフェースの次のポーリングの予定時刻 

 ${StatCollection}  統計収集頻度 
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ノードの統計 

以下は、有効なノード統計関連の変数です。 

 ノード統計変数 説明 

 ${ResponseTime} ノードの現在の応答時刻（ミリ秒） 

 ${PercentLoss} 
最後の数分間のパケット損失率。パケット損失はノードのポーリング時

にドロップした ICMP パケットの数から計算します。 

 ${AvgResponseTime} 最後の数分間のノードの平均応答時間 

 ${MinResponseTime} 最後の 2 、3 分間の最短応答時間 

 ${MaxResponseTime} 最後の 2 、3 分間の最長応答時間 

 ${CPULoad} CPU 使用率 

 ${TotalMemory} ノードに報告された合計 RAM 

 ${MemoryUsed} ノードに割り当てられた合計 RAM 

 ${PercentMemoryUsed} 合計 RAM に対する使用 RAM の割合 

ノード ステータス 

以下は、有効なノード ステータス関連の変数です。 

 ノード ステータス変数  説明 

 ${Status}  ノードの現在のステータス。（アップ、ダウン、警告等） 

 ${StatusLED}  ノードの現在のステータス アイコン。 

 ${GroupStatus} 
 ノードおよびそのすべてのインターフェースの現在のステータス アイコン

（アップ、ダウン、警告等） 

 ${StatusDescription}  ノードおよびそのインターフェースの現在のステータス。 

 ${Severity}  ノードおよびそのインターフェースの現在の重大度ステータス。 

オブジェクト タイプ 

以下は、有効なオブジェクト タイプ変数です。 

 オブジェクト タイプ変数  説明 

 ${ObjectType}  ネットワーク オブジェクトのタイプ 

 ${ObjectSubtype}  ネットワーク オブジェクトのサブタイプ 
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ボリューム 

以下は、有効なボリューム変数です。 

 ボリューム変数 説明 

 ${NodeID} 
このボリュームが属するネットワーク ノードの ID Network Performance 

Monitor はすべてのネットワーク オブジェクトに固有 ID を割り当てます。 

 ${VolumeID} 
ボリュームの固有 ID 。Network Performance Monitor はすべてのネット

ワーク オブジェクトに固有 ID を割り当てます。 

 ${Caption} このボリュームにユーザーが割り当てた名前 

 ${VolumeIndex} ネットワーク ノード内のボリュームのインデックス 

 ${VolumeType} ボリュームのタイプ。hrStorageType から検出 

 ${VolumeDescription} ボリュームの説明 

 ${FullName} 属しているネットワーク ノードの名前を含めた、ボリュームのフルネーム 

ボリューム ポーリング 

以下は、有効なボリューム ポーリング関連の変数です。 

 ボリューム ポーリング変数  説明 

 ${PollInterval}  ボリュームをポーリングする頻度 

 ${StatCollection}  統計収集頻度 

 ${NextPoll}  このボリュームの次のポーリングの予定時刻 

 ${RediscoveryInterval}  このボリュームの再ディスカバリ間隔 

 ${NextRediscovery}  このボリュームの次の完全なディスカバリの予定時刻 

ボリュームの統計 

 以下は有効なボリュームの統計関連の変数です。 

 ボリューム統計変数  説明 

 ${VolumeSize}  ボリュームのサイズ（バイト） 

 ${VolumeSpaceUsed}  ボリュームで使用されている合計バイト数 

 ${VolumePercentUsed}  SNMP によってディスカバリされたボリューム使用率 

 ${VolumeAllocationFailuresThisHour}  この時間のボリューム割り当てエラー数 

 ${VolumeAllocationFailuresToday}  今日のボリューム割り当てエラー数 
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ボリューム ステータス 

以下は、有効なボリューム ステータ関連の変数です。 

 ボリューム ステータス変数  説明 

 ${Status}  ボリュームの現在のステータス（アップ、ダウン、シャットダウン等） 

 ${StatusLED}  ボリュームの現在のステータス（アップ、ダウン、シャットダウン等） 

 ${VolumeResponding}  ボリュームが現在 SNMP クエリーに応答しているかどうかを示します。 

変数を使用するメッセージの例 

次の例は、変数の使用の一部を示しています。 

 インターフェース ${FullName} は、${Status-Previous} から、${LastBoot} で再

起動された ${Status} ${FullName} に変わりました。 

 前回の再起動は ${LastBoot-Previous} で実行されました。 

 ${NodeName} のインターフェース ${Caption} は ${Status} です。これは、このネット

ワーク セグメントに問題があり、調査が必要であることを示しています。この問題は 

${DateTime} に識別されました。 

 アラート： ${NodeName} は非常に高応答時間となっています。平均応答時間は 

${AvgResponseTime} でその範囲は ${MinResponseTime} ～ 

${MaxResponseTime} です。 

 アラート： ${Fu1lName} の使用率は ${OutPercentUtil} を上回っています。このイン

ターフェースでの現在のトラフィック ロードは ${InBps} 受信および ${OutBps} 送信です。 

 ${NodeName} の現在のパケット損失は ${%Loss} です。平均応答時間は 

${AvgResponseTime} でその範囲は ${MinResponseTime} ～ 

${MaxResponseTime} です。 

 アラート： ${NodeName} をクエリーするために使用する SNMP コミュニティ ストリングは 

${Community-Previous} から ${Community} に変更されています。 

 Orion NPM は新しいコミュニティ ストリングを使用して ${NodeName} をクエリーします。 
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基本アラート エンジンの抑制例 

ネットワークで発生し、単一のイベントから複数のアラートをトリガーするような数多くのエラー条

件があります。また、それ自体ではアラートをトリガーする必要はないとしても、別の条件と一緒

に発生した場合に、アラートをトリガーするという条件もあります。アラート抑制により、アラート

状態を解析し、問題の根本原因の特定に必要な情報を示す条件を設定することができます。 

デフォルトでは、アラート抑制は Orion NPM アラートに対して無効になっています。基本アラー

ト エンジンを使用するとき、1 つ以上のいずれかの条件が存在するとき、または 2 つ以上のす

べての条件が存在する場合、アラート抑制を指定できます。 

注記： アラート抑制の取り扱いには注意が必要です。ご利用のネットワークに関する重要な

情報を含むアラートを抑制してしまう可能性があります。SolarWinds は、ネットワーク図を使

い、アラート抑制を適用する予定のあらゆるシナリオを広範にテストすることで、アラート抑制ス

キームを念入りに検討することをお勧めします。 

以下の図では、アラート抑制状況の数例を示しています。 

 

注記： Orion NPM サーバーは上部右のスイッチ 2 にあります。 

冗長サーバーの障害 

この図では、双方の WServer が、フェイルオーバー、冗長性およびロード バランシングを

同じように提供しています。WServer4 に障害が発生しながらも、WServer5 は機能し

ている場合、営業時間中に障害が発生した場合にはすぐにアラートを受信したいと思う

一方で、真夜中にポケットベルのアラートを受信するのは控えたいと思うでしょう。この場合、

WServer の 1 つの障害に対するアラートを、もう 1 つの Wserver にも障害が発生する

まで、抑制するように設定します。 

故障したルーターの依存ノード ダウンストリームの明白なエラー 

この図では、デバイス間で依存関係があります。たとえば、ルーター C が故障した場合、

Orion NPM サーバーはスイッチ 3 、または 4 つのワークステーションのどれにもアクセスで

きません。ルーター C とスイッチ 3 に障害が発生していない場合のみ、ワークステーション

が故障したかどうか、またその時間を知りたいとします。ワークステーションの障害アラートが

動作中のルーター C およびスイッチ 3 に依存するように、アラートを設定します。 
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冗長リンクがまだ機能しているときのネットワーク リンクの障害 

場合によっては、ルーター A による代替リンクもダウンした場合に、ルーター B とルーター C 

間のリンクの障害のみを知りたい、ということがあるかもしれません。 

デバイス間のロード バランシングの障害 

ネットワークが Web サーバーでトラフィックを分散するように設定したとします。この場合、

サーバーのいずれかに高い CPU 負荷があり、かつ残りの使用率が非常に低い場合にの

み通知するように、アラートを設定できます。 

注記： アラート抑制は、危機的なイベントに関する情報は除外しません。アラート抑制が有効

な場合も無効な場合も、ネットワーク イベントはデータベースに記録されます。 

依存ノードのアラート抑制の例 

この例は、サブネットのノードがダウンしたことを通知するアラートを示しています。このケースでは、

ノードは特定のルーターのもう一方のネットワークのセグメント上にあり、そのルーターがまだ動作

している場合にのみアラートを受信することを希望しています。 

注記： このアラートが監視するオブジェクト グループにルーターを含めないでください。これは、こ

の障害によってアラート抑制がトリガーされるからです。ルーター障害を通知するには、別のア 

ラートを設定する必要があります。 

 

以下は、この例のアラート抑制の設定手順です。 

 依存ノードのアラート抑制を設定するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート  > すべてのプログラム  > SolarWinds Orion > Network 

Performance Monitor > System Manager ）をクリックします。 

2. Alerts > Configure Basic Alerts （アラート  > 基本アラートの設定）の順でクリックし

ます。 

3. New Alert （新規アラート）をクリックします。 
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4. General （一般）をクリックし、アラート名を入力して、Enable this Alert （このアラート

を有効化）にチェックを入れます。 

5. Property to Monitor （監視するプロパティ）をクリックします。 

6.  Check Node Status > Status （ノードのステータス  > ステータス）にチェックを入れます。 

注記： プロパティは利用可能なものを 1 つのみ選択してください。 

7. Monitored Network Objects （監視されるネットワーク オブジェクト）をクリックし、ルー 

ターのもう一方のネットワークのセグメント上にあるワークステーションを選択します。 

8. Alert Trigger （アラート トリガー）をクリックします。 

9. Trigger Alert when Status is > Unknown , Down 、and Warning （次のステータ

ス時にアラートをトリガー  > 不明、ダウンおよび警告）にチェックを入れます。 

10. Reset Alert when Status is > Up （次のステータス時にリセット  > アップ）にチェックを

入れます。 

11. Alert Suppression （アラート抑制）をクリックし、Suppress this alert if ANY of the 

selected suppressions are active （選択した抑制のいずれかがアクティブのときにこ

のアラートを抑制）を選択します。 

注記： 現在の抑制のリスト（存在する場合）と、条件の追加、編集、および削除に使用

できるボタンを含むウィンドウが表示されます。 

12. Add （追加）をクリックします。 

13. Property to Monitor （モニターするプロパティ）をクリックし、Node Status > Status （ノー

ド ステータス  > ステータス）を選択します。 

注記： プロパティは利用可能なものを 1 つのみ選択してください。 

14. Network Object （ネットワーク オブジェクト）をクリックします。 

15. Orion NPM とノード ダウン アラートを設定したサブネット間に存在するルーターを選択し

ます。 

注記： 監視できるオブジェクトのタイプは、Properties to Monitor （監視するプロパティ）

タブの選択によって異なります。インターフェース関連のプロパティの監視を選択した場合は、

利用可能なインターフェースのリストが表示されます。ここではノード関連のプロパティを選

択したため、ノードのリストが表示されます。 

16.  Suppression Trigger （抑制トリガー）をクリックします。 

17.  このタブで Down （ダウン）、Warning （警告）、および Unknown （不明）にチェックを

入れて OK をクリックします。 

 注記： ステータス条件については、条件を 1 つ以上指定することができます。 
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18. これらを有効にするために、適用する抑制にチェックを入れます。 

注記： デフォルト設定では、抑制はオフになっています。 

19. さらに条件を追加する場合は、Add （追加）をクリックして再び開始し、この操作を繰り

返します。 

ロード バランシング障害アラート 

Web サイトで負荷を共有するように設定された複数のサーバーが存在する場合には、そのう

ちの 1 つが予定通りに機能していない場合に通知を受け取ることを望むでしょう。この例を示

すため、2 台のサーバー上の CPU 負荷が 80 パーセントを超えた場合、ただし 1 台が CPU 

負荷 40 パーセント以下を示した場合に通知を受けることを想定します。言い換えると、図示

のとおりに、2 台目のサーバーが 40 パーセントを超える使用率を報告する場合、アラートは抑

制されます。 

 

各サーバーに 1 つずつ、2 つのアラートを設定する必要があります。この 2 つは同一のアラート

ですが、各アラートが監視するサーバーのみが異なります。以下のステップに従ってこれらのア 

ラートを設定します。詳細については、89 ページの「アラートの作成と管理」を参照してください。 

ロード バランシング障害アラートを設定するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート  > すべてのプログラム  > SolarWinds Orion > Network 

Performance Monitor > System Manager ）をクリックします。 

2. Alerts > Configure Basic Alerts （アラート  > 基本アラートの設定）の順でクリックし

ます。 

3. New Alert （新規アラート）をクリックします。 

4. General （一般）をクリックします。 

5. アラート名を入力して、Enable this Alert （このアラートを有効化）にチェックを入れます。 

6. Property to Monitor （監視するプロパティ）をクリックします。 

7. Node Statistics > % CPU Utilization （ノード統計  > % CPU 使用率）にチェック

を入れます。 
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8. Monitored Network Objects （監視されるネットワーク オブジェクト）をクリックし、監視

するサーバーにチェックを入れます。 

9. Alert Trigger （アラート トリガー）をクリックします。 

10. Trigger Alert when % CPU Utilization （% CPU 使用率の時にアラートをトリガー

する）の条件を選択し、トリガー値を入力します。この例では、トリガー値は 80 % です。 

11. Reset Alert when % CPU Utilization （% CPU 使用率の時にアラートをリセットす

る）の条件を選択し、リセット値を入力します。この例では、リセット値 80 % です。 

12. タイムフレーム パラメーターを設定するには、Time of Day （1 日のうちの時刻）タブを使

います。 

13. Alert Suppression （アラート抑制）をクリックします。 

14. Suppress this alert if ANY of the selected suppressions are active （選択

した抑制のいずれかがアクティブのときこのアラートを抑制）を選択します。 

注記： 以前に設定したアラートすべてがチェックされていない状態で一覧表示されます。 

15. Add （追加）をクリックします。 

16. Property to Monitor （監視するプロパティ）をクリックします。 

17. Node Statistics > % CPU Utilization （ノード統計  > % CPU 使用率）にチェック

を入れます。 

18. Network Object （ネットワーク オブジェクト）をクリックします。 

19. 負荷分散する必要があるペアの 2 番目のサーバーにチェックを入れます。 

20. Suppression Trigger （抑制トリガー）をクリックします。 

21. Greater Than （次の値以上）を選択します。 

22. 文字入力フィールドに 40 と入力し、OK をクリックします。 

23. アクティブ化するように定義した抑制にチェックを入れます。 

24.  アラート通知と抑制のサーバーの選択を逆にして、この手順を繰り返します。 
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アドバンスト アラート エンジン変数 

すべての Orion 製品で使用可能なアドバンスト アラートおよびアラート変数に加えて Orion 

NPM 単体で提供する監視機能もまた、次の Orion NPM 固有のアラート変数を使用する

ことができます。 

 インターフェース ポーラー変数 

 インターフェース変数 

 ユニバーサル デバイス ポーラー 

 ワイヤレス ノード変数 

インターフェース ポーラー変数 

以下は、有効なインターフェース ポーラー変数です。 

注記： 以下の表の少なくとも 1 つの CustomPollerStatus 変数をすべてのインターフェー

ス ポーラー アラートのトリガー条件に含める必要があります。 

インターフェース ポーラー割り当て

変数 
説明 

 ${AssignmentName} 

以下の形式の、特定の割り当てのユーザーフレンドリ名  : 

<PollerName> - <NodeName> - <InterfaceName> 。インター

フェース名は、これがノード ポーラーの場合に「 0 」です。 

 
${CustomPollerAssignmentID} 

ノードまたはインターフェースへのポーラーの特定の割り当ての内部固

有 ID （グローバル固有 ID ）。 

 ${InterfaceID} 
この割り当てでのインターフェースの内部固有 ID （整数）。これがノー

ド ポーラーの場合は「0」。 

 ${NodeID} この割り当てにおけるノードの内部固有 ID （整数）。 

 ${PollerID} この割り当てでの内部固有ポーラー ID （グローバル固有 ID）。 

 

インターフェース ポーラー ステータス

変数 
説明 

 
${CustomPollerAssignmentID} 

ノードまたはインターフェースに対するポーラーの特定の割り当ての内部

固有 ID （グローバル固有 ID ）。 

 ${DateTime} ポーラー統計が最後に収集された日時。 

 ${DateTimeUTC} この割り当てで、統計が最後に収集された UTC 日付 / 時刻 

 ${Rate} 

MIB 値タイプ 'Rate' のポーラーの場合、このフィールドには OID から収

集した数値データが含まれます。MIB 値タイプ 'Counter' のポーラーの

場合、このフィールドにはポーリング間隔に対して正規化された以前の

値の変更が含まれます。'Raw Value' ポーラーの場合、このフィールド

は空になります。 



 管理者ガイド  SolarWinds Orion Network Performance Monitor 

 

 

456  Orion NPM 変数と例 

インターフェース ポーラー ステータス

変数 
説明 

 ${RawStatus} 

MIB 値タイプが 'Rate' または 'Counter' のポーラーの場合、このフィー

ルドは空になります。MIB 値タイプが 'Raw Value' で、OID 応答値が

数値の場合、このフィールドには数値が含まれます。MIB 値タイプが 

'Raw Value' で、OID 応答値が数値ではない場合、このフィールドは

空になります。列挙値の場合、このフィールドには、ユーザーフレンドリー

なテキストではなく、OID から返された実際の数値が含まれます。数値

（以上よび未満）がこのフィールドを使用する必要があるステータス比

較。テキストの説明が 'Status' フィールドを使用する必要があるステー

タス値。 

 ${Status} 

MIB 値タイプが 'Rate' または 'Counter' のポーラーの場合、このフィー

ルドは空になります。MIB 値が 'Raw Value' のポーラーの場合、この

値には、そのサブタイプに応じて OID からの値が含まれます。列挙値に

はこのフィールドには、OID から返された実際の数値ではなく、ユーザー

フレンドリーなテキストが含まれます。 

 ${Total} 

MIB 値タイプが 'Rate' のポーラーの場合、このフィールドは空になりま

す。MIB 値タイプ 'Counter' のポーラーの場合、このフィールドには以

前収集された値の変更が含まれます。MIB 値が 'Raw Value' のポー

ラーの場合、このフィールドは空になります。 

レート ポーラーは 'Rate' フィールドにのみ、カウンター ポーラーは 'Total' および 'Rate' フィール

ドにのみ、またステータス ポーラーは 'Status' フィールドにのみ書き込みます。ただし、それらが

正しく数値に変換された場合に限ります。この場合、数値もまた 'RawStatus' フィールドに書

き込まれます。 

 インターフェース ポーラー変数 説明 

 ${DefaultDisplayTimeUnitID} UI が示す時間単位の内部固有 ID 

 ${Description} ポーラーの説明 

 ${Enabled} 
(1) はポーラーが現在起動し、収集中であることを示し、それ以外の

場合は (0) です。 

 ${Format} 現在未使用 

 ${GroupName} このポーラーが属するグループのユーザー フレンドリ名 

 ${IncludeHistoricStatistics} 

(1) はすべての統計収集が新しいレコードとして挿入されることを示し

ます。(0) はこの統計が 1 つの統計レコードのみを保持するように  

 更新されたことを示します。 

 ${LastChange} ポーラー レコードが最後に変更された日時 

 ${LastChangeUTC} ポーラー レコードが最後に変更された日時（ユニバーサル時間） 

 ${MIB} 一般に認識された OID 名 

 ${NetObjectPrefix} 
これがノード ポーラーの場合は (N)。これがインターフェース ポーラー

の場合は (I) 

 ${OID} 情報の収集に使用された OID 

 ${ParserID} 
このポーラーのパーサー（サブタイプ）の内部固有 ID、ここで 1=None

、2=text、3=enum、4=macAddress、5=counter、6=gauge、
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 インターフェース ポーラー変数 説明 

10=TrueFals 、11=FalseTrue、12=CleanMa 、14=TimeTicks

、15=HighBandwidth、16=AdminStatus、

17=OperationalStatus とする 

 ${PollerID}  ポーラー固有 ID （グローバル固有 ID ） 

 ${PollerType} 
(R) はレート ポーラー、(C) はカウンター ポーラー、(S) はステータス 

ポーラー 

 ${SNMPGetType} SNMP 要求タイプ（ Get または GetNext ） 

 ${TimeUnitID} 
ポーラーがノーマライズしている時間単位（ミリ秒 / 秒 / 分 / 時 / 日）

の内部固有 ID 

 ${TimeUnitQuantity} ポーラーがノーマライズしている時間単位の数 

 ${UniqueName} ポーラーのユーザー フレンドリ名 

 ${Unit} 収集した単位についてユーザーが入力した説明（バイト / 度 /dbs ） 

インターフェース変数 

以下は有効なインターフェース変数です。 

 インターフェース変数 説明 

 ${AdminStatus} 
インターフェースの数値管理者ステータス。詳細については、 

427ページの「ステータス アイコンと識別子」を参照してください。 

 ${AdminStatusLED} 現在のインターフェースの管理者ステータス アイコンのファイル名 

 ${Caption} 
他の ID 情報と名前を組み合わせたインターフェースのユーザー 

フレンドリ名 

 ${Counter64} 
インターフェースが IF-MIB 高容量カウンターに対応しているかを

示します 

 ${CustomBandwidth} 
送信および受信帯域幅フィールドがユーザー制御（1）または 

ifSpeed MIB を使った自動検出による制御（0）かを示します。 

 ${CustomPollerLastStatisticsPoll} 
このインターフェースが現在のポーラーによって最後にポーリングさ

れた曜日、日付および時刻 

 ${FullName} 
親ノードとインターフェースのキャプションを組み合わせたユーザー 

フレンドリ名 

 ${IfName} このインターフェースについて見つかった内部名と ifName OID 

 ${InterfaceID} 選択したインターフェースの内部固有識別子 

 ${InBandwidth} インターフェースの受信帯域幅 

 ${Inbps} インターフェースに対する現在の受信トラフィック（ bps ） 

 ${InDiscardsThisHour} 過去 1 時間にインターフェースによって廃棄された受信パケット数 

 ${InDiscardsToday} この 1 日にインターフェースによって廃棄された受信パケット数 

 ${InErrorsThisHour} 過去 1 時間のインターフェースの受信エラー数 

 ${InErrorsToday} この 1 日のインターフェースの受信エラー数 
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 インターフェース変数 説明 

 ${InMcastPps} 
インターフェースに対する現在の受信マルチキャスト トラフィック 

（パケット / 秒） 

 ${InPercentUtil} インターフェースの受信側の現在の使用率 

 ${InPktSize}  インターフェースに対する受信パケットの平均サイズ 

 ${InPps} インターフェースに対する現在の受信トラフィック（パケット / 秒） 

 ${InterfaceAlias} 親ノードから発見されたインターフェースのエイリアスまたは説明 

 ${InterfaceIcon} インターフェース タイプを示すのに使用されたアイコンのファイル名 

 ${InterfaceIndex} 親ノードで選択したインターフェースのインデックス 

 ${InterfaceLastChange} 
インターフェースが現在の動作状態を入力したときの 

sysUpTime 値 

 ${InterfaceMTU} 
インターフェース最大転送単位 : インターフェースが処理できる最

大パケット 

 ${InterfaceName} ユーザー フレンドリ名 

 ${InterfaceSpeed} インターフェース帯域幅 

 ${InterfaceType} 選択したインターフェースの IANA タイプ 

 ${InterfaceTypeDescription} インターフェース タイプのユーザー フレンドリーな説明 

 ${InterfaceTypeName} インターフェース IANA タイプのユーザー フレンドリ名 

 ${InUcastPps} 
現在のインターフェースに対する受信ユニキャスト トラフィック（パケ

ット / 秒） 

 ${LastSync} 
インターフェースのデータベースとメモリを最後に同期させた時刻と

日付 

 ${NextPoll} 
次にスケジュールされているインターフェース ポーリングの曜日、日

付および時刻 

 ${NextRediscovery} 次のインターフェース再ディスカバリ時刻 

 ${NodeID} 
選択したインターフェースに対して親であるノードの内部固有識

別子 

 ${ObjectSubType} 
ノードが SNMP またはその ICMP のみをサポートするかどうかを

指定 

 ${OperStatusLED} 現在のインターフェースの動作ステータス アイコンのファイル名 

 ${OutBandwidth} インターフェースの送信帯域幅 

 ${Outbps} インターフェースからの現在の送信トラフィック（ bps ） 

 ${OutDiscardsThisHour} 過去 1 時間にインターフェースによって廃棄された送信パケット数 

 ${OutDiscardsToday} 
この 1 日の過去 1 時間でインターフェース送信エラーの 

inteNumber によって廃棄された送信パケット数 

 ${OutErrorsThisHour} 過去 1 時間のインターフェースの送信エラー数 

 ${OutErrorsToday} この 1 日のインターフェースの送信エラー数 

 ${OutMcastPps} 
インターフェースからの現在の送信マルチキャスト トラフィック 

（パケット / 秒） 
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 インターフェース変数 説明 

 ${OutPercentUtil} インターフェースの送信側の現在の使用率 

 ${OutPktSize} インターフェースからの送信パケットの平均サイズ 

 ${OutPps} インターフェースからの現在の送信トラフィック（ pps ） 

 ${OutUcastPps} 
インターフェースからの現在の送信ユニチキャスト トラフィック 

（パケット / 秒） 

 ${PhysicalAddress} インターフェースの物理アドレス 

 ${PollInterval} インターフェースに対するポーリング試行間の間隔（秒） 

 ${RediscoveryInterval} インターフェースに対する再ディスカバリ試行間の間隔（分） 

 ${Severity} 

ネットワーク健全性スコアは、警告状態のインターフェースには  

1 ポイント、ダウン状態のインターフェースには 1000 ポイント、ダウ

ン状態のノードには 100 万ポイントを付与します 

 ${StatCollection} インターフェース統計収集頻度（分） 

 ${Status} 
数値でのインターフェース ステータス 詳細については、427ページ

の「ステータス アイコンと識別子」を参照してください。 

 ${StatusLED} 現在のインターフェースのステータス アイコンのファイル名 

ユニバーサル デバイス ポーラー 

以下は有効なユニバーサル デバイス ポーラー変数です。 

 ユニバーサル デバイス ポーラー変数  説明 

 ${DateTime}  日付／時刻 

 ${Description}  ユニバーサル デバイス ポーラーの説明 

 ${Enabled}  ユニバーサル デバイス ポーラーの組み込みステータス 

 ${MIB}  MIB 

 ${OID}  OID 

 ${Rate}  レート 

 ${Status}  ステータス 

 ${Total}  Total （合計） 

 ${UniqueName}  ユニバーサル デバイス ポーラーの名前 

ワイヤレス ノード変数 

以下は有効なワイヤレス ノード変数です。 

 ワイヤレス ノード変数 説明 

 ${WirelessAP} 
ノードがワイヤレス ポーラーポーリングされているか（ 1 ）、いないか（ 0 ）を指

定 

 ${WirelessLastStatPoll} ワイヤレス ポーラーによって最後にポーリングされた日時 
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 ワイヤレス ノード変数 説明 

 ${WirelessPollInterval} ノードに対するワイヤレス ポーリング試行間の間隔（分） 

${WirelessStatBlockUntil} ワイヤレス ポーラーによって再びポーリングされる可能性がある日時 
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付録 E 

95 パーセンタイル計算 

95 パーセンタイル計算は、最大スパイクを廃棄するのに使用される有名な統計標準で、5 分

データ サンプルに基づいています。この計算では、どれだけ長い時間を選択しても 5 分毎にこ

れらの値を収集し、上位 5% を廃棄して、リストの始めに 95 パーセンタイル値を算出します。 

以下の例を使って、95 パーセンタイルが午前 8 時から午後 6 時の間での 10 営業時間

（ 600 分）に対してどのように計算されるかを検討してみましょう。 

1. 10 時間にわたって、次の 120 の値が受信トラフィックについて収集されます (Mb/s) 。 

0.149 0.623 0.281 0.136 0.024 0.042 0.097 0.185 0.198 0.243 0.274 0.390 
0.971 0.633 0.238 0.142 0.119 0.176 0.131 0.127 0.169 0.223 0.291 0.236 
0.124 0.072 0.197 0.105 0.138 0.233 0.374 0.290 0.871 0.433 0.248 0.242 
0.169 0.116 0.121 0.427 0.249 0.223 0.231 0.336 0.014 0.442 0.197 0.125 
0.108 0.244 0.264 0.190 0.471 0.033 0.228 0.942 0.219 0.076 0.331 0.227 
0.849 0.323 0.221 0.196 0.223 0.642 0.197 0.385 0.098 0.263 0.174 0.690 
0.571 0.233 0.208 0.242 0.139 0.186 0.331 0.124 0.249 0.643 0.481 0.936 
0.124 0.742 0.497 0.085 0.398 0.643 0.074 0.590 0.771 0.833 0.438 0.242 
0.092 0.376 0.231 0.627 0.249 0.663 0.181 0.636 0.224 0.342 0.697 0.285 
0.108 0.211 0.074 0.490 0.271 0.133 0.338 0.242 0.519 0.376 0.331 0.227  

2. 高から低へと並べ替えると以下のようになります。 

0.971 0.942 0.936 0.871 0.849 0.833 0.771 0.742 0.697 0.690 0.663 0.643 
0.643 0.642 0.636 0.633 0.627 0.623 0.590 0.571 0.519 0.497 0.490 0.481 
0.471 0.442 0.438 0.433 0.427 0.398 0.390 0.385 0.376 0.376 0.374 0.342 
0.338 0.336 0.331 0.331 0.331 0.323 0.291 0.290 0.285 0.281 0.274 0.271 
0.264 0.263 0.249 0.249 0.249 0.248 0.244 0.243 0.242 0.242 0.242 0.242 
0.238 0.236 0.233 0.233 0.231 0.231 0.228 0.227 0.227 0.224 0.223 0.223 
0.223 0.221 0.219 0.211 0.208 0.198 0.197 0.197 0.197 0.196 0.190 0.186 
0.185 0.181 0.176 0.174 0.169 0.169 0.149 0.142 0.139 0.138 0.136 0.133 
0.131 0.127 0.125 0.124 0.124 0.124 0.121 0.119 0.116 0.108 0.108 0.105 
0.098 0.097 0.092 0.085 0.076 0.074 0.074 0.072 0.042 0.033 0.024 0.014  

3. 最初の 6 つが値の上位 5% に匹敵するため、これらをドロップします。 

0.771 0.742 0.697 0.690 0.663 0.643 0.643 0.642 0.636 0.633 0.627 0.623 
0.590 0.571 0.519 0.497 0.490 0.481 0.471 0.442 0.438 0.433 0.427 0.398 
0.390 0.385 0.376 0.376 0.374 0.342 0.338 0.336 0.331 0.331 0.331 0.323 
0.291 0.290 0.285 0.281 0.274 0.271 0.264 0.263 0.249 0.249 0.249 0.248 
0.244 0.243 0.242 0.242 0.242 0.242 0.238 0.236 0.233 0.233 0.231 0.231 
0.228 0.227 0.227 0.224 0.223 0.223 0.223 0.221 0.219 0.211 0.208 0.198 
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0.197 0.197 0.197 0.196 0.190 0.186 0.185 0.181 0.176 0.174 0.169 0.169 
0.149 0.142 0.139 0.138 0.136 0.133 0.131 0.127 0.125 0.124 0.124 0.124 
0.121 0.119 0.116 0.108 0.108 0.105 0.098 0.097 0.092 0.085 0.076 0.074 
0.074 0.072 0.042 0.033 0.024 0.014  

4. 95 パーセンタイルは 0.771 です。 
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付録 F 

正規表現パターン マッチング 

比較基準を編集するとき、次の正規表現をパターン マッチングに使用することができます。この

セクションの終わりに例が示されています。 

文字 

文字 説明 例 

[、\、^、$、.、|、?、*、

+、(、) 、以外のすべ

ての文字 

特殊以外の文字はすべてそれらのシングル インスタ

ンスに相当します。 
a は a に相当 

[、\、^、$、.、|、?、*、

+、(、) のいずれかに

続く \ （バックスラッ 

シュ） 

バックスラッシュは特殊文字をエスケープしてそれら

の特別な意味を抑制します。 
\+ は + に相当 

\xFF （FF が 2 桁の 

16 進数字の場合）  

文字と指定した ASCII/ANSI 値（使用するコード 

ページによる）をマッチングします。文字クラスで使用

できます。 

\xA9 は © に相当

（ Latin-1 コード ペー

ジ使用時）。 

\n、\r、および \t 
LF 文字、CR 文字およびタブ文字をそれぞれマッ

チングします。文字クラスで使用できます。 

\r\n は 

DOS/Windows 

CRLF の改行に 

相当。 

 

文字クラスまたは文字セット [abc] 

 文字クラスまたはセット 説明  例 

 [ （左角括弧） 

文字クラスを開始します。文字クラスは

文字クラスが提供するあらゆる可能性

から 1 つの文字をマッチングします。文

字クラス内では、様々なルールが適用さ

れます。このセクションのルールは文字ク

ラス内でのみ有効です。このセクション以

外のルールは文字クラスでは無効です。

ただし \n、\r、\t、および \xFF を除き 

ます。 

  

以外のすべての文字 ^、-、]、

\ はその文字をその文字クラスの

可能性のあるマッチに追加し 

ます。 

特殊文字を除くすべての文字。 
[abc] は a、b、または 

c に相当 

^、-、]、\ のいずれかに続く  

\ （バックスラッシュ） 

バックスラッシュは特殊文字をエスケープ

してそれらの特別な意味を抑制します。 

[\^\]] は ^ または ] に

相当 
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 文字クラスまたはセット 説明  例 

- （ハイフン）、ただし [ の直後の

ものを除く 

文字の範囲を指定します。（ [ の直後

に置かれた場合は、ハイフンを指します） 

[a-zA-Z0-9] はあら

ゆる文字または数字

です 

[ の直後に続く ^ （キャレット） 

文字クラスを無効にし、文字クラスにな

い単一文字にマッチさせます。（ [ の後

以外の場所にある場合はキャレットを指

します ) 

[^a-d] は x に相当

（a、b、c、または d 

以外の文字） 

\d、\w、および \s 

それぞれ 0 ～ 9 の数字、言葉（文字と

数字）および空白の省略文字クラス。

文字クラスの内側および外側で使用で

きます 

[\d\s] は数値または

空白の文字に相当。 

 

 アンカー 

 アンカー 説明 例 

 ^ （キャレット） 

正規表現パターンが適用された文字列の開始

点。文字というよりは位置です。最も一般的な表

現方法には、キャレットを改行の後（つまりファイルの

行の開始時点）にするオプションがあります。 

^. は abc\ndef の a 

に相当。また「マルチ

ライン」モードの場合

は d に相当。 

 $ （ドル記号） 

正規表現パターンが適用された文字列の終了

点。文字というよりは位置です。最も一般的な表

現方法には、ドル記号を改行の前（つまりファイルの

行の終了時点）にするオプションがあります。また、

文字列が改行で終了する場合は、最も最後の行

の前です。 

.$ は abc\ndef の f 

に相当。また「マルチ

ライン」モードの場合

は c に相当。 

 \A 

正規表現パターンが適用された文字列の開始

点。文字というよりは位置です。改行の後に来るこ

とはありません。 

\A. は abc の a に 

相当 

 \Z 

正規表現パターンが適用された文字列の終了

点。文字というよりは位置です。文字列が改行で

終了する場合の最後の改行を除き、改行前に来

ることはありません。 

.\Z は abc\ndef の f 

に相当 

 \z 

正規表現パターンが適用された文字列の終了

点。文字というよりは位置です。改行の前に来るこ

とはありません。 

.\z は abc\ndef の f 

に相当 
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数量詞 

 数量詞 説明 例 

 ? （疑問符） 
前のアイテムをオプションに相当。オプションのアイテ

ムは、可能な場合、照合に含まれます。 

abc? は ab または 

abc に相当 

 ?? 

前のアイテムをオプションに相当。オプションのアイテ

ムは、可能な場合、照合で除外されます。この構

成概念は使用が限定的なため、多くのマニュアル

からは除外されています。 

abc?? は ab または 

abc に相当 

 * （スター） 

前のアイテムを 0 回またはそれ以上の回数繰り返

します。前のアイテムのより少ない照合との並べ替

えを試みる前に、以前のアイテムが全く照合されな

い点まで、できるだけ多くのアイテムを照合します。 

.* は "def" "ghi" jkl 

の "def" "ghi" に相当 

 *? （レージー スター） 

前のアイテムを 0 回またはそれ以上の回数繰り返

します。エンジンはまず、前のアイテムの増加し続け

る照合との並べ替えを試みる前に、前のアイテムを

スキップしようとします。 

.*? は abc "def" 

"ghi" jkl の "def" に

相当 

 #NAME?  

前のアイテムを 1 回以上繰り返します。前のアイテ

ムのより少ない照合との並べ替えを試みる前に、

以前のアイテムが 1 回のみ照合される点まで、で

きるだけ多くのアイテムを照合します。 

.+ は abc "def" "ghi" 

jkl の "def" "ghi" で

す 

 +? （レージープラス） 

前のアイテムを 1 回以上繰り返します。エンジンは

まず、前のアイテムの増加し続ける照合との並べ 

替えを試みる前に、前のアイテムを１回だけ照合し

ます。 

.+? は abc "def" 

"ghi" jkl の "def" に

相当 

 {n} （ n が整数 >= 

1 の場合） 
前のアイテムをちょうど n 回繰り返します。 a{3} は aaa に相当 

 {n, m} （ n >= 1  

および m >= n の 

場合） 

前のアイテムを n ～ m 回繰り返します。繰り返し

を n 回に減らす前に m 回繰り返そうとします。 

a{2,4} は aa 、aaa 

または aaaa に相当。 

 { n , m }? where n 
>= 1 and m >= n 

前のアイテムを n ～ m 回繰り返します。繰り返し

を m 回に増加する前に n 回繰り返そうとします。 

a{2,4}? は aaaa 、

aaa または aa に相

当。 

 { n ,} （ n >= 1 の 

場合） 

前のアイテムを少なくとも n 回繰り返します。前の

アイテムのより少ない照合との並べ替えを試みる前

に、前のアイテムが m のみ照合される点まで、でき

るだけ多くのアイテムを照合します。 

a{2,} は aaaaa の 

aaaaa に相当 

 { n ,}? （ n >= 1 の

場合） 

前のアイテムを n ～ m 回繰り返します。エンジン

はまず、前のアイテムの増加し続ける照合との並べ

替えを試みる前に、前のアイテムを n 回だけ照合

します。 

a{2,}? は aaaaa の 

aa に相当 
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ドット 

 ドット文字  説明  例 

. （ドット） 
 改行文字 \r および \n を除くすべての単一文字

に相当。 

. は x またはその他ほと

んどの文字 

 

単語の境界 

 単語の境界  説明  例 

 \b 

 単語文字（ \w で照合された文字）と非単語文字

（ [^\w] または \W で照合された文字）間の位置、お

よび文字列の最初および / または最後の文字が単

語文字の場合は開始および / または終了点に相

当。 

.\b は abc の c に

相当 

 \B 

 2 つの単語文字間の位置（つまり \w\w 間の位置）

および、2 つの非単語文字間の位置（つまり 

\W\W ）。 

 \B.\B は abc の b 

に相当 

 

変換 

 変換文字 説明 例 

 |  

 （縦棒または「パイプ」） 

正規表現エンジンに左側の部分または右側の部

分を照合させます。合わせて一連のオプションにな

る場合があります。 

abc|def|xyz は 

abc 、def または 

xyz に相当 

 |  

 （縦棒または「パイプ」） 

縦棒はすべての演算子で最も優先性が低くなりま

す。グルーピングを使って正規表現の一部のみを変

更します。 

abc （ def|xyz ）は 

abcdef または 

abcxyz に相当 

 

正規表現パターン照合例 

以下は、正規表現パターン照合の使用例です。 

snmp-server community public 

テキスト snmp-server community public を含むあらゆる行を検索します。同じ行

の文字列の前 / または後のテキストが存在する場合があります。 

service tcp-keepalives-in.*\n(.*\n)*.*service tcp-keepalives-out 

最初の行  service tcp-keepalives-in を検索し、その後のあらゆる行の 

service tcp-keepalives-out を検索します。正規表現文字列.*\n(.*\n)*.* 

は文字列間の任意の行数を検索するのに使用されます。 
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access-list 105 deny.*tcp any any eq 139 log 

access-list 105 deny の行とそれに続く任意のタイプの任意の文字数、そして同じ

行の tcp any any eq 139 log を検索します。正規表現文字列.* は、同じ行の

任意の文字および任意の文字数を検索します。この表現はスペース、タブ、数字、文字

または特殊文字の検索にも使用できます。 

ntp clock-period \d* 

ntp clock-period を含む任意の行とそれに続く数値を検索します。正規表現文字

列 \d* は 3 、48 、または 2394887 など、任意の長さの任意の数字を検索します。 

user \x2a 

user * を含む任意の行を検索します。正規表現文字列 \x 、それに続く 16 進数値

は個々の文字を指定します。この例では、\x2a は、16 進数値 2a を含むアスタリスク

文字を表しています。 
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付録 G 

トラブルシューティング 

Orion NPM で問題が発生したら、通常は誤った設定かファイルの破損が原因です。以下の

提案を参照することにより、多くの場合これらの問題を解決できます。 

データのバックアップ 

トラブルシューティング手順の最初のステップとして、ご利用の Orion Network Performance 

Monitor データベースをバックアップする必要があります。詳細については、388 ページの「デー

タベース バックアップの作成 」を参照してください。 

プログラム動作の確認 

Orion NPM は情報を提供する上で、同時に複数のコンポーネントを実行する必要がありま

す。以下のコンポーネントが実行されていることを確認します。 

  サービス： 

o メッセージ キューイング 

o Net.Tcp ポート共有サービス 

o SNMP トラップ サービス 

o SolarWinds Alerting Engine 

o SolarWinds Collector Data Processor 、Management Agent 、および 

Polling Controller サービス 

o SolarWinds Information Service 

o SolarWinds Job Engine および Job Engine v2 

o SolarWinds Job Scheduler 

o SolarWinds Network Performance Monitor サービス 

o SolarWinds Orion Information Service 

o SolarWinds Orion Module Engine 

o SolarWinds Syslog および Trap Service 

  SQL Server 

  Internet Information Service （ IIS ） 
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停止と再起動 

多くの問題はプログラムを再起動すると解決します。Internet Information Service （IIS）を

停止し、再起動すると Web ページの問題が解決する場合があります。ポーリングまたはデータ

収集の問題は、利用可能なシャットダウン  ツールを使って SolarWinds Network 

Performance Monitor Service を停止し、再起動することで解決する場合があります。この

ツールは以下から検索できます。 

Start > All Programs > SolarWinds Orion > Advanced Features > Orion 

Service Manager （スタート > すべてのプログラム > SolarWinds Orion > 拡張機能 > 

Orion サービス マネージャ）の順でクリックします。 

システムを完全にリフレッシュするには、コンピュータを再起動します。 

Configuration Wizard （設定ウィザード）を実行します。 

設定ウィザードを実行すると、Web サーバー上のファイルが更新され、データベース構造の 

チェックが行われるため、多くの問題が解決する場合があります。 

注記： 設定ウィザードを実行する前に、開いているすべてのアプリケーションを閉じ、Windows 

のサービス コントロール パネルで SolarWinds Network Performance Monitor Service を

終了する必要があります。プロセスの終了時にウィザードにより再起動されます。 

インターフェース転送レートの調整 

Orion NPM は、レポートまたはユーザー インターフェースでの要求に応じて、インターフェース

上の実際の転送レートを監視し、使用率をリアルタイムで計算します。通常、インターフェース

使用率が 100% を超えると、これは Orion NPM のこのインターフェースに対する 送信 および 

受信 帯域幅値が正しくないためです。 

インターフェースの転送レートを更新するには： 

1. Start > All Programs > SolarWinds Orion > Network Performance Monitor > 

System Manager （スタート  > すべてのプログラム  > SolarWinds Orion > Network 

Performance Monitor > System Manager ）をクリックします。 

2. アップデートしたいインターフェースを含むノードを開き、Interfaces > Interface Details 

（インターフェース  > インターフェース詳細）をクリックします。 

3. Transmit Bandwidth （送信帯域幅）および Receive Bandwidth （受信帯域幅）

フィールドの値を編集し、Apply Changes （変更を適用）をクリックします。 
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完全な変数名の使用 

${VariableName} フォーマットを使って、選択した変数から予期した値を取得するのが困難

な場合、${Nodes.IP_Address} のように、データベース テーブル名を変数名に含めると便

利です。 

一時ディレクトリでの作業 

次のセクションでは、Windows および SQL Server の一時ディレクトリを移動して、Orion  

サーバーのパフォーマンスとリソースを最適化する手順について説明します。 

SQL Server の一時ディレクトリの移動 

SQL Server の一時ディレクトリ tempdb は、テーブルの作成および保存中に生成された一

時データベース オブジェクトが保存されている場所で、通常 Orion データベース サーバーと同

じ場所に、master 、model 、および msdb データベースとして作成されます。tempdb データ

ベースを Orion NPM データベースとは異なる物理ドライブに移動すると、全体的なシステム 

パフォーマンスが大幅に向上する場合があります。 

SQL Server 2005 一時ディレクトリ tempdb の移動に関する詳細は、「システム データベー

スの移動 – 例 A: tempdb データベースの移動」を参照してください。 

SQL Server 2008 一時ディレクトリ tempdb の移動に関する詳細は、「システム データベー

スの移動 – 例 A: tempdb データベースの移動」を参照してください。 

Windows システム一時ディレクトリの再定義 

既存の Windows の標準に従って、Orion NPM インストーラーは Windows User と 

System TEMP および TMP 変数ディレクトリを一時スクラッチ領域として使用し、ファイルを

展開および実行することができます。デフォルトの User または System TEMP および TMP 

ディレクトリに必要なスクラッチ領域がない場合は、次の手順に従ってデフォルトの位置を再定

義してください。 

注記： Orion NPM を実際にインストールする場所にかかわらず、一部の共通ファイルは、使

用している Orion サーバーのオペレーティング システムが存在する場所にインストールされる場

合があります。 

デフォルトのシステム一時ディレクトリを再定義するには： 

1. 管理者権限を持つユーザーとして Orion サーバーにログインします。 

2. マイ コンピュータ を右クリックし、Properties （プロパティ）をクリックします。 

http://msdn.microsoft.com/en-us/library/ms345408(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms345408(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms345408.aspx
http://msdn.microsoft.com/en-us/library/ms345408.aspx
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3. Advanced （アドバンスト）をクリックし、Environment Variables （環境変数）を選択

します。 

4. 再定義したいディレクトリを示す変数名を選択し、Edit （編集）をクリックして、選択した

一時ディレクトリ変数に対する Variable value （変数値）として新しいパスを入力します。 

Windows Server 2008 でのパフォーマンスが低い 

Orion が Windows Server 2008 または Windows Vista にインストールされ、Orion サー

バーとデータベース間でネットワーク上に RFC 1323 をサポートしていない何らかのデバイスが

存在する場合、Windows Server 2008 および Windows Vista の TCP ウィンドウ サイズ

自動調整機能である 「TCP Extensions for High Performance （高パフォーマンス用 

TCP 拡張機能）」により、Orion サーバーが Orion データベースに正しく接続できない場合が

あります。この TCP 自動調整機能は、ご利用の Orion サーバーが受信を許容されている、

または受信可能なデータ量をネットワーク別に制限するため、受信者側が適用します。Orion 

サーバーと Orion データベース間のネットワーク パスにあるデバイスが、RFC 1323 で詳述され

ている TCP ウィンドウ サイズ調整機能をサポートしていない場合、Orion サーバーに送信さ

れる CP ウィンドウの許容サイズ（パケット）は、Orion サーバーが送信したパケットで報告され

る TCP ウィンドウ サイズと一致しない場合があります。この不一致により、Orion サーバーと 

Orion データベース間の接続が正しく確立しない場合があります。以下に示すのは、この 

TCP 自動調整機能を無効にし、TCP 受信ウィンドウを 64kB にリセットする手順です。 

TCP 自動調整機能を無効にするには： 

1. Start > All Programs > Accessories （スタート > すべてのプログラム > アクセサリ）

の順にクリックします。 

2. Command Prompt （コマンド プロンプト）を右クリックし、Run as administrator 

（管理者として実行）をクリックします。 

3. User Account Control （ユーザー アカウント制御）によりプロンプト表示された場合は、
Continue （続行）をクリックして次のコマンド プロンプトを開きます。 

注記： 一部のケースでは、Windows Server 2008 および Windows Vista （評価の

み）でユーザー アカウント制御（UAC）が有効になっていると、インストール エラーが発生す

る場合があります。UAC の無効化の詳細については、SolarWinds ナレッジ ベースの記

事、「ユーザー アカウント制御（UAC ）の無効化」をご覧ください。 

4.  プロンプトが表示されたら、以下を入力します。 

 netsh interface tcp set global autotuninglevel=disabled 

5.  コマンド プロンプト ウィンドウを閉じ、Orion サーバーを再起動します。 

 

 

http://www.ietf.org/rfc/rfc1323.txt
http://www.ietf.org/rfc/rfc1323.txt
http://knowledgebase.solarwinds.com/kb/questions/2287/
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付録 H 

その他の Orion 製品 

SolarWinds Orion NPM ファミリー製品は、ネットワークやシステム、ストレージの監視および

管理要件を満たす、使いやすくてスケーラブルなソリューションを提供します。以下のセクション

では、Orion ファミリーの個々の製品に関する詳細な情報を提供します。 

 ネットワーク アプリケーション データの監視（ Orion APM ） 

 IP アドレスの管理（ Orion IPAM ） 

 IP SLA の管理（Orion IP SLA Manager） 

 NetFlow トラフィック解析データ（Orion NTA）の監視 

 Orion スケーラビリティ エンジン 

 Orion Additional Website サーバーの使用 

 Orion フェイルオーバーおよび障害復旧 

ネットワーク アプリケーション データの監視（ Orion APM ） 

Orion アプリケーション パフォーマンス モニター（Orion APM ）は、ネットワーク エンジニア向け

に集中したアプリケーション監視を提供しますが、単なるアップ / ダウン ステータス チェックやプロ

セス管理よりも、遥かに優れています。監視されたコンポーネントのカスタム コレクションを作成、

監視できるため、Orion APM は、ネットワーク エンジニアに幅広い機会を提供します。Orion 

APM を使用することで、中核的なサービスの監視に集中しながら、アプリケーションの機能停

止がネットワーク内で発生しないようにします。Orion APM は以下のような役立つ機能を提

供します。 

  ネットワークとアプリケーション サービスの監視 

  一般 TCP ポートの監視 

  WMI および SNMP プロセスの監視 

  HTTP または HTTPS コンテンツ確認を利用したユーザー エクスペリエンスの監視 

Orion NPM の実証済みの機能と堅牢なアーキテクチャに基づいて構築されているため、現在

の要件を確実に満たし、また将来的にニーズが増加しても、Orion プラットフォームと Orion 

APM モジュールの両方を拡張できます。 
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SolarWinds Orion アプリケーション パフォーマンス モニターでのネットワーク アプリケーション管

理の詳細については www.solarwinds.com にア クセスし 、 『 SolarWinds Orion 

Application Monitor 管理者ガイド 』を参照してください。 

IP アドレスの管理（ Orion IPAM ） 

Orion IP Address Manager （Orion IPAM ）は、Orion ウェブ コンソールの直感的なポイン

ト & クリック型インターフェースを利用し、IP アドレス空間の問題を簡単に調査できる Orion 

NPM モジュールです。Orion IPAM は、IP アドレスの変更について、ネットワークを定期的に

スキャンして IP アドレスの動的なリストを維持するため、エンジニアはネットワークの増大に対

応した計画を立てることができます。これにより、IP 空間使用率で企業標準を満たし、IP の

衝突を低減させることができます。Orion IPAM を使うと、ネットワーク エンジニアは非応答 IP 

アドレスの検出、チームの IP 空間へのアクセスの調整、およびネットワーク変更の追跡が可能

になります。 

Orion IPAM はエンタープライズ Orion コアを搭載しており、ネットワーク エンジニアは単一の

レポート機能エンジンから、IP 空間レポートを作成、スケジュール設定および共有することがで

きます。最後に、ネットワーク エンジニアは障害、パフォーマンス、設定、および現在の IP アドレ

スの健全性インジケータについて、ネットワーク デバイスを監視できます。 

 直感的なウェブ コンソールから IP インフラストラクチャ全体を管理 

 IP アドレスを単一のレポジトリに統合 

 IP アドレス変更についてネットワークを定期的にスキャンして記録をアップデート 

 IP アドレス空間使用率に関するレポートの作成、スケジュール設定および共有 

 IP アドレスの衝突を特定し、削除することで、ネットワーク デバイスを最新の状態に維持 

 役割ベースのアクセス制御と変更追跡により、アドレス空間に対するチームのアクセスを調整 

 非応答 IP アドレスを特定し、IP 空間を最適化  

Orion IP Address Manager の詳細については、 www.solarwinds.com にアクセスし、

『SolarWinds Orion IP Address Manager 管理者ガイド 』を参照してください。 

IP SLA の管理（Orion IP SLA Manager） 

SolarWinds Orion IP Service Level Agreement （IP SLA） Manager は、Orion Web 

Console にシームレスに統合された、使いやすくスケーラブルな IP SLA ネットワーク監視ソ 

リューションを提供する Orion NPM モジュールです。 

http://www.solarwinds.com/
http://www.solarwinds.com/support/apm/docs/APMAdministratorGuide.pdf
http://www.solarwinds.com/support/apm/docs/APMAdministratorGuide.pdf
http://www.solarwinds.com/
http://www.solarwinds.com/support/IPAM/docs/OrionIPAMAdministratorGuide.pdf
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Orion IP SLA Manager をインストールする理由 

Internet Protocol Service Level Agreement （ IP SLA ）テクノロジーは、あらゆる規模の

企業のニーズに対して、コスト効果および効率の高いソリューションを提供します。ネットワーク 

マネージャーが直面する問題は、ネットワークがアップしているか、ダウンしているかと言った単純

なものではありません。ネットワークに関するサービス対策特有の品質、またそれらの過去の経

過とリアルタイムの状態の双方を知る必要があります。Orion IP SLA Manager は、現在の

ネットワークの適合性を即座に試験し、ネットワークのサービス品質を経時的に判断および追

跡できるツールを備えています。 

Orion IP SLA Manager は Orion NPM の実証済みの機能を活用し、IP SLA 固有の 

データ コレクション IP SLA ネットワーク監視およびリアルタイム ステータス レポート機能を有効

にするプレゼンテーションも搭載しています。これは Orion NPM のモジュールのため、Orion IP 

SLA Manager は Orion NPM の機能を維持しつつ、ネットワークの管理と監視を広範な 

ネットワークから IP SLA 対応デバイスに絞ることができます。 

Orion IP SLA Manager の特徴 

Orion IP SLA Manager は、IP SLA 対応ネットワークに対するリアルタイムおよび経時的な

パフォーマンス統計を監視およびレポートする総合的なソリューションを提供します。Orion IP 

SLA Manager はネットワーク全体の管理に役立つ以下の機能を提供します。 

  Quality of Service （QoS）監視、Cisco IP SLA オペレーションの使用 

  カスタム チャートとゲージ 

  カスタム アラートとアクション 

  カスタム レポート機能 

  コール マネージャー監視 

Orion IP SLA Manager の詳細については、  www.solarwinds.com にアクセスし、

『SolarWinds Orion IP SLA Manager 管理者ガイド 』を参照してください。 

NetFlow トラフィック解析データ（Orion NTA）の監視 

Orion NetFlow トラフィック アナライザ（Orion NTA）は、あらゆるサイズの Cisco NetFlow 

対応ネットワークを扱う IT プロフェッショナル向けに、使いやすくスケーラブルなネットワーク監視

ソリューションを提供する Orion NPM モジュールです。NetFlow 対応 Cisco ルーターとスイッ

チは、充実した IP 関連のトラフィック情報を提供します。Orion NTA はこの NetFlow データ

を収集し、それを使用可能なフォーマットに関連付けたあと、Orion NPM が収集した詳細な

ネットワーク パフォーマンス データと共に、使用中のネットワークおよびそれに対する帯域使用に

ついて分かりやすいグラフとレポートとして提供します。これらのレポートは、帯域幅の監視、内

http://www.solarwinds.com/
http://www.solarwinds.com/support/IPSLA/docs/IPSLAManagerAdministratorGuide.pdf
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外のエンドポイント間における会話の追跡、トラフィックの解析、および必要な帯域幅容量の

計画に役立ちます。Orion NTA はまた、sFlow および Jflow パケットを使って、デバイスに同

じフロー データ分析機能を提供することもできます、 

Orion NetFlow トラフィック アナライザの詳細については、 www.solarwinds.com にアクセス

し、『SolarWinds Orion NetFlow トラフィック アナライザ 管理者ガイド 』を参照してください。 

Orion スケーラビリティ エンジン 

Orion Scalability Engine を使うと、企業ネットワークの拡張およびネットワーク管理ニーズの

変化に伴って、プライマリの Orion インストールの監視および管理機能を拡張することができま

す。SolarWinds は、以下のスケーラビリティ エンジン オプションを提供します。 

 追加ポーリング エンジンでポーリングを複数のサーバーに分散します。詳細については、

165ページの「追加ポーリング エンジンの使用」を参照してください。 

 Orion Additional Web Server を使用すると、より多くのユーザーが Orion ウェブ コンソ

ールにアクセスできるようになります。詳細については、476 ページの「Orion Additional 

Website サーバーの使用」を参照してください。 

 Orion Failover Engine と Hot Standby Server で監視機能の停止から保護します。

詳細については、481 ページの「Orion フェイルオーバーおよび障害復旧」を参照してくだ

さい。 

Orion Additional Website サーバーの使用 

Orion Additional Website を使用すると、プライマリ Orion サーバー以外の場所からの 

Orion ウェブ コンソールにリモート アクセスできるようになります。Additional Website をインス

トールした場合、リモート ユーザーは、Orion インストールすべてを配備したり、あるいはメイン

Orion NPM サーバーのリソースを過度に浪費することなく、プライマリ Orion ウェブ コンソール

を表示できます。以下の手順により、Orion Additional Website をインストールします。 

Orion 追加 Web サーバーをインストールするには： 

1. Orion Additional Website 実行可能ファイルを SolarWinds のウェブサイトからダウ
ンロードした場合、ダウンロード先に移動し、実行ファイルを起動します。 

2. 物理メディアに Orion Additional Website を受信した場合は、実行ファイルを参照
して起動します。 

注記： 実行可能ファイルは Additional Web Server に対応しているすべての Orion 製

品向けの HTML readme 、Installer Guide 、および Additional Web Server インス

トーラを含むフォルダに解凍されます。 

http://www.solarwinds.com/
http://www.solarwinds.com/support/NetFlow/docs/NetFlowAdministratorGuide.pdf
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3. プライマリー サーバーにインストールされた Orion 製品に対応するインストーラーを起動し

ます。 

注記： メインの Orion サーバーに複数の Orion 製品がインストールされている場合は、

それぞれに Additional Web Server をインストールし、確実に機能するようにします。 

4. Compatibility Check （互換性チェック）のウェルカム ウィンドウでは、次の情報を示します。 

 メインの Orion サーバーの Hostname or IP Address （ホスト名または IP 

アドレス）。 

 メイン Orion サーバーの Orion ウェブ コンソールに対して管理者権限を有する

ユーザーの User name （ユーザー名）および Password （パスワード）。 

5. Next （次へ）をクリックします。 

6. 要件をインストールするように求められたら、Install （インストール）をクリックして、インス 

トールを完了させ、必要に応じて再起動を行います。 

注記： 

 既存のシステム構成によっては、Microsoft.NET Framework 3.5 SP1 のダウン 

ロードとインストールに、20 分以上かかる場合もあります。 

 再起動が必要な場合は、インストーラーをもう一度起動する必要があります。インス

トーラーが自動的に起動したら、Install （インストール）をクリックしてインストールを再

開し、Welcome （ようこそ）ウィンドウで Next （次へ）をクリックします。 

7. Welcome （ウェルカム）テキストを確認し、Next （次へ）をクリックします。 

8. ライセンス契約の条件に同意し、Next （次へ）をクリックします。 

9. Orion Additional Web Server をデフォルト以外のフォルダにインストールしたい場合
は、Browse （参照）をクリックし、Choose Destination Location （インストール先の選

択）ウィンドウで別のインストール先フォルダを指定します。 

10. Choose Destination Location （インストール先の選択）ウィンドウで Next （次へ）をク

リックします。 

11. Start Copying Files （ファイル コピーの開始）ウィンドウで設定を確認し、Next （次へ）

をクリックします。 

12. Orion Network Performance Monitor Setup Wizard （セットアップウィザード）が終

了したら、Finish （完了）をクリックします。 

13. Orion NPM を評価する場合は、Continue Evaluation （評価を続ける）をクリックし

ます。 
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14. Orion NPM Additional Web Server の本番用バージョンをインストールする場合、
Enter Licensing Information （ライセンス情報の入力）をクリックし、次の手順に従っ

て Orion NPM インストレーションをライセンスします。 

a. アクティベーション キーをお持ちでインターネットへのアクセスがある場合は、最初のオ
プションの I have internet access and an activation key… （インターネット 

アクセスとアクティベーション キーがあります）を選択し、Activation Key （アクティ 

ベーション キー）を入力して、Next （次へ）をクリックします。 

注記： プロキシ サーバー経由でインターネットにアクセスしている場合、I access 

the internet through a proxy server （プロキシ サーバー経由でインターネット

にアクセスする）を選択し、Proxy address （プロキシ アドレス）と Port （ポート）を

入力します。 

b. Orion NPM サーバーからインターネットへのアクセスがない場合は、This server 

does not have internet access… （このサーバーはインターネット アクセスがな

い）を選択し、Next （次へ）をクリックして指示される手順に従います。 

15. Configuration Wizard （設定ウィザード）が自動的に開始されない場合は、Start > 

All Programs > SolarWinds Orion > Configuration and Auto-Discovery > 

Configuration Wizard （スタート  > すべてのプログラム  > SolarWinds Orion > 設

定と自動ディスカバリ  > 設定ウィザード）の順でクリックします。 

16. Configuration Wizard （設定ウィザード）の Welcome （ウェルカム）タブで、Next （次

へ）をクリックします。 

17. プライマリ Orion サーバーが使用する SQL Server （ SQL サーバー）を選択するか、入

力します。 

18. Windows NT Integrated Security を使用している場合は、Use Windows 

Authentication （ Windows 認証の使用）を選択し、Next （次へ）をクリックします。 

19. SQL Server のログインとパスワード を使用している場合は、次のステップを実行します。 

a.  Use SQL Server Authentication （ SQL Server 認証の使用）を選択します

。 

b. Login （ログイン）と Password （パスワード）を入力します。 

c. Next （次へ）をクリックします。 

20. Orion サーバーに接続している Database Name （データベース名）を選択するか、入

力し、Next （次へ）をクリックします。 

21. 複数のポーリング エンジンが検出されたというダイアログが表示されたら、OK をクリックして

データベースのアップグレード / 検証を続行します。 

22. データベース構造の検証が完了したら、Next （次へ）をクリックします。 
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23. ポーリング エンジンと Web サイトがデータベースへのアクセスに使用する SQL アカウント

の User Name （ユーザー名）と Password （パスワード）を指定し、Continue （続

行）をクリックします。 

注記： すでに SQL アカウントを保有している場合、そのアカウントの資格証明を指定で

きます。 

24. ウェブ コンソールを設定するには、Create Website （Web サイトの作成）タブで Next 

（次へ）をクリックし、以下の手順を実行します。 

a. 新しい  Web 専用インターフェースをインストールするローカル  サーバーの  IP 

Address （IP アドレス）を指定します。 

b. ウェブ コンソールへのアクセスに使用する TCP Port （TCP ポート）を指定します。 

注記： 80 以外のポートを指定する場合、ウェブ コンソールにアクセスするときに使用

する URL にそのポートを指定しなければいけません。たとえば、192.168.0.3 の 

IP アドレスと 8080 のポートを指定する場合、URL は 

http://192.168.0.3:8080 になります。 

c. ウェブ コンソール ファイルをインストールするボリュームとフォルダを指定し、Continue 

（続行）をクリックします。 

25. 既存の Web サイトを上書きするように求められたら、Yes （はい）をクリックします。 

26. 新しいウェブ コンソールが作成されたら、Continue （続行）をクリックします。 

27. Start > All Programs > SolarWinds Orion > Orion Web Console （スター

ト  > すべてのプログラム  > SolarWinds Orion > Orion ウェブ コンソール）の順でクリック

します。 

28. アドレス バーに IP アドレスを入力します。  

29. すでに Admin アカウントとパスワードを保有している場合は、それぞれのフィールドにそれ
らを入力し、Login （ログイン）をクリックします。 

注記： Admin を Account ID として使用する場合は、パスワードなしでもログインできます。 

30.新しい追加 Web サーバーが、ローカルおよびプライマリ Orion サーバーで使用されるとき、

同じアカウントに対して同じビューを表示することを確認します。 
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31. Orion NetFlow トラフィック アナライザまたは Orion アプリケーション パフォーマンス モニ
ターを Orion の追加 Web サーバーのいずれかにインストールする場合は、以下の手順
に従って必要な追加ウェブ コンソール コンポーネントをインストールしてください。 

a. SolarWinds の カスタマー ID および パスワード を使用し、 

http://www.solarwinds.com/customerportal/ にアクセスしてカスタマー 

ポートにログインします。 

b. 左側の  Customer Portal （カスタマー  ポータル）メニューで、Additional 

Components （追加コンポーネント）をクリックします、 

c. Download Orion NPM Components （Orion NPM コンポーネント）をダウン 

ロードします。 

32. この Orion 追加 Web サーバーで Orion アプリケーション パフォーマンス モニターを使用
する場合は、次の手順を実行します。 

a. Additional Components – Orion v8 and v9 （追加コンポーネント –Orion v8 お

よび v9）セクションで Application Performance Monitor Additional Web 

Console—v2 （アプリケーション パフォーマンス モニター 追加ウェブ コンソール —

v2 ）をクリックしてから、Save （保存）をクリックします。 

b. 適切な場所を参照し、Save （保存）をクリックします。 

c. ダウンロードが完了したら、Open （開く）をクリックします。 

d. 実行可能ファイルを起動し、設定ウィザードを完了します。 

33. この Orion 追加 Web サーバーで Orion アプリケーション パフォーマンス モニターを使用
する場合は、次の手順を実行します。 

a. Additional Components – Orion v8 and v9 （追加コンポーネント –Orion v8 お

よび v9）セクションで Application NetFlow Traffic Analyzer Additional 

Web Console—v3 （Application NetFlow トラフィック アナライザ追加ウェブ コン

ソール —v3 ）をクリックしてから、Save （保存）をクリックします。 

b. 適切な場所を参照し、Save （保存）をクリックします。 

c. ダウンロードが完了したら、Open （開く）をクリックします。 

d. 実行可能ファイルを起動し、設定ウィザードを完了します。 

http://www.solarwinds.com/customerportal/
http://www.solarwinds.com/customerportal/
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Orion フェイルオーバーおよび障害復旧 

インストールしている Orion NPM のバージョンによって、SolarWinds はフェイルオーバーまた

は障害復旧ソリューションのいずれかを提供します。Hot Standby Server と Orion Failover 

Engine Hot Standby Server は、バージョン 10.0 以前の Orion NPM インストールに対し

て提供されるフェイルオーバー保護は限定的です。Orion NPM バージョン 10.0 以降の製品

については、SolarWinds は、プライマリの Orion NPM インストールおよびその他のインストー

ル済みモジュールを保護する Orion Failover Engine を提供しています。 

Orion Failover Engine の詳細については、『SolarWinds Orion Failover Engine 管理
者ガイド 』と 

http://www.solarwinds.com/support/failoverengine/FailoverEngineDoc.aspx に記

載されている関連文書を参照してください。 

Hot Standby Engine の使用 

Orion NPM 10.0 より前のバージョンでは、Orion ポーリング エンジンに対してシームレスな 

バックアップ サービスを提供する Orion Hot Standby Engine を追加製品として利用できます。 

注記： Orion NPM バージョン 10.0 のインストールには、Orion Failover Engine をお勧め

します。Orion NPM バージョン 10.0 以降の製品にフェイルオーバーと災害復旧保護を提供

するには、Orion Failover Engine が必要です。Orion Failover Engine の詳細については、
『SolarWinds Orion Failover Engine 管理者ガイド』と 

http://www.solarwinds.com/support/failoverengine/FailoverEngineDoc.aspx に記

載されている関連文書を参照してください。 

Orion サーバーに障害が発生すると、指定されたホット スタンバイ システムが当該サーバーに

ついて即座に監視、データ収集、および基本的なアラート通知を実行します。Orion サーバー

の動作が復旧すると、Hot Standby Engine は Orion サーバーへの監視制御へと戻ります。 

警告： Orion Hot Standby Engines は現在のところ、障害の発生した Orion サーバーから

以前に収集された同じすべてのデータをカスタム ポーラーおよびユニバーサル デバイス ポーラー

に提供することはできません。同様に、Orion Hot Standby Engine は現時点では 

EnergyWise 、VMw are ESX 、または無線デバイスについてデータの収集およびネットワー

ク パフォーマンス統計の計算を行うことはできません。 

以下のグラフィックは、Orion Hot St andby Engine が、障害の発生した Orion NPM サー

バーのポーリング作業をどのように実行するかを示しています。 

http://www.solarwinds.com/support/failoverengine/FailoverEngineDoc.aspx
http://www.solarwinds.com/support/failoverengine/FailoverEngineDoc.aspx
http://www.solarwinds.com/support/failoverengine/FailoverEngineDoc.aspx
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注記： 1 つの Hot Standby Engine で、複数の Orion サーバーとポーリングエンジンのフェイ

ルオーバー保護として同時に機能することができます。ただし、1 つの Hot Standby Engine 

は、障害が発生した Orion NPM サーバーを所定の時間につき 1 つのみ監視することができ

ます。 

Hot Standby Engine のインストール 

Orion Hot Standby Engine のインストールは、標準の Orion サーバーのインストールとほと

んど同じで、次の通りです。 

注記： 

 最適なパフォーマンスを実現するには、ご利用の Orion Hot Standby Engine のバー 

ジョンは、それがサポートしている Orion NPM サーバーの最新バージョン以降である必要

があります。 

 同じバージョンの場合、Orion サーバーおよび Orion Hot Standby サーバーのハードウェ

アおよびソフトウェア要件は同等です。詳細については、10ページの「Orion の要件」を参

照してください。 

Hot Standby Engine をインストールするには、以下の手順を実行します。 

1. ネットワークに Orion サーバーをインストールして設定します。Orion NPM のインストールと

設定の詳細については、9 ページの「SolarWinds Orion Network Performance 

Monitor」を参照してください。 
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2. Hot Standby サーバーとして使用するサーバーにログオンします。 

注記： Hot Standby Engine は、プライマリ Orion NPM サーバー以外のサーバーにイン

ストールする必要があります。 

3. Hot Standby Engine インストーラーを Hot Standby Server を使用したいサーバーの

適切な場所にダウンロードまたはコピーします。 

4. Hot Standby Engine を SolarWinds のウェブ サイトからダウンロードした場合は、ダ
ウンロード実行ファイルに移動して、それを起動します。 

5. 物理メディアに Hot Standby Engine を受信した場合は、実行可能なファイルを参照
し、それを起動します。 

6. Microsoft.NET Framework 3.5 など、必要なコンポーネントをインストールするように
求められた場合は、Install （インストール）をクリックし、必要な追加コンポーネントのイン

ストールを行います。 

7. Welcome （ウェルカム）テキストを確認し、Next （次へ）をクリックします。 

8. ライセンス同意書に同意し、Next （次へ）をクリックします。 

9. Choose Destination Location （インストール先の選択）ウィンドウにインストール先フォ

ルダを指定し、Next （次へ）をクリックします。 

10. Start Copying Files （ファイルのコピー開始）ウィンドウで Next （次へ）をクリックします。 

11. Enter Licensing Information （ライセンス情報の入力）をクリックします。 

注記： キーを正常にインストールするには、カスタマー ID とパスワードが必要になります。

詳細については、419ページの「ソフトウェアのライセンス キー」を参照してください。 

12. ライセンスが正しくインストールされたら、Continue （続行）をクリックし、その後 

Installation Complete （インストール完了）ウィンドウで Finish （完了））をクリックします。 

13. Configuration Wizard （設定ウィザード）の Welcome （ウェルカム）ウィンドウで、Next 

（次へ）をクリックします。 

14. SQL Server のアドレスを選択するか、入力します。 

15. Windows NT Integrated Security を使用している場合は、利用可能なオプションを

選択し、Continue （続行）をクリックします。 

16. SQL Server UserID およびパスワードを使用している場合は、利用可能なオプションを
選択し、Continue （続行）をクリックします 

17. Use an existing database （既存のデータベースを使用）を選択します。 

18. プライマリ Orion NPM サーバーが使用している Existing Database （既存のデータ 

ベース）名を入力し、Next （次へ）をクリックします。 
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注記： Hot Standby Engine は、障害の発生したサーバーの代替になるよう設計されて

いるため、Orion NPM ポーリング エンジンとスタンバイ ポーリング エンジンの双方が、ネッ

トワークの監視を維持するために、同じデータベースを指定する必要があります。 

19. Use an existing account （既存のアカウントを使用）を選択します。 

20. ポーリング エンジンと ウェブ サイトがデータベースへのアクセスに使用する Existing 

Account （既存のアカウント）と Password （パスワード）を入力し、Next （次へ）をク 

リックします。 

21. Orion NPM インストールの特定の IP アドレスを指定する必要がある場合は、ウェブ コ

ンソールに使用したいウェブ サーバーの IP アドレスを入力します。 

注記： SolarWinds は、ご利用の環境で Orion ウェブ コンソールの特定の IP アドレス

の宛先が求められる場合を除き、All Unassigned （すべて未割り当て）のデフォルトの 

IP アドレス設定を維持することを推奨します。 

22. ウェブ コンソールのアクセスに使用するポートとウェブ コンソール ファイルのインストール先と

なるボリュームとフォルダを指定します。 

注記： 80 以外のポートを指定する場合、ウェブ コンソールにアクセスするときに使用する 

URL にそのポートを含めなければなりません。たとえば、192.168.0.3 の IP アドレスと 

8080 のポートを指定する場合、ウェブ  コンソールにアクセスするための  URL は 

http://192.168.0.3:8080 になります。 

23. Next （次へ）をクリックします。 

24. 新しいディレクトリを作成するように求められたら、Yes （はい）をクリックします。 

25.Hot Standby サーバーをインストールするサービスをチェックし、Next （次へ）をクリックします。 

注記： 利用可能なすべてのサービスを選択すると、サーバーの障害発生時にすべての 

ネットワーク監視機能を確実に維持することができます。 

26. Next （次へ）をクリックして設定を開始します。 

27.SolarWinds サービスがインストールされている場合は、Finish （完了））をクリックします。 

28. Hot Standby ポーリング サービスの開始リクエストを送信するように指示された場合は、
Yes （はい）をクリックします。 

注記： 設定ウィザードは、Hot Standby サーバーを設定する際に、すべてのポーリング エ

ンジンを停止します。 
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29. Start > All Programs > SolarWinds Orion > Advanced Features > 

Monitor Polling Engines （スタート  > すべてのプログラム  > SolarWinds Orion > 

拡張機能  > ポーリング エンジンの監視）の順でクリックします。 

30. プライマリー Orion サーバーと Hot Standby サーバーの双方が、Monitor Polling 

Engines （ポーリング エンジンの監視）ウィンドウで Responding （応答中）の表示に 

なっていることを確認します。 

注記： Orion NPM サーバーをクリックすると、Monitor Polling Engines （ポーリング エ

ンジンの監視）ウィンドウの下半分にサーバー情報が表示されます。 

Hot Standby Engine の設定 

インストールおよび割り当て済みの Hot Standby サーバーは、Orion サーバーの役割を実行

しているときにアラートを通知し、さらに元のサーバーが停止している限り、継続してアラートを

通知する機能を備えています。しかし、停止した Orion サーバーから Hot Standby Engine 

への移行は必ずしも迅速に行う必要はありません。これは、一次障害から Hot Standby の

実行までの遅延は一定ではないためです。 

以下は、Hot Standby Engine のアラートおよび遅延を設定するステップです。 

Hot Standby Engine を設定するには、以下の手順を実行します。 

1. Start > All Programs > SolarWinds Orion > Advanced Features > Monitor 

Polling Engines （スタート  > すべてのプログラム  > SolarWinds Orion > 拡張機能  > 

ポーリング エンジンの監視）の順でクリックします。 

2. Monitor Polling Engines （ポーリング エンジンの監視）ウィンドウの上部ペインのリストで 

Hot-Standby サーバーをクリックします。 

注記： 下部ペインには、選択したサーバーの現在の情報が示されています。 

3. Configure Hot-Standby （ Hot-Standby の設定）をクリックします。 

注記： Configure Hot-Standby Server （ Hot-Standby の設定）ウィンドウの Hot-

Standby タブのデフォルト ビューには、現在選択されているサーバーがホット スタンバイで

あるサーバーの一覧が表示されています。 

4. Hot Standby Engine をインストールする Orion サーバーをチェックします。 

5. ホット スタンバイ サーバーを採用したときにアラート アクションを有効にするには、Fail-

Over Notifications （フェイルオーバー通知）をクリックし、次に Add New Action （新

規アクションの追加）をクリックします。 



 管理者ガイド  SolarWinds Orion Network Performance Monitor 

 

 

486  その他の Orion 製品 

注記： 詳細については、103 ページの「アラート アクションの追加」を参照してください。 

6. Fail-Over Timing （フェイルオーバーのタイミング）をクリックし、上部スライダーを動かして 

Orion サーバーの停止から Hot-Standby サーバーの開始までの遅延を設定します。 

7. アラートを継続的に行うようにアラートアクションを設定する場合、Hot-Standby サー 

バーが有効な限り、Continuously send Fail-Over notifications… （フェイルオー

バー通知を継続してそ）をチェックし、下部スライダーを動かして Orion サーバーの停止か

ら Hot-Standby サーバーの開始までの遅延を設定します。 

8. Hot Standby Engine の設定が完了したら、OK をクリックします。 

Hot Standby Engine のテスト 

Hot Standby Engine のインストール、割り当て、および設定が完了したら、次のステップで機

能テストを行います。 

警告： Hot Standby Engine をテストするには、ネットワークで Orion サーバーをオフにする必

要があります。SolarWinds は、アップタイム中断の可能性を最小限に抑えるため、オフピーク

使用時間にテストを実施することをお勧めします。 

Hot Standby Engine をテストするには、以下の手順を実行します。 

1. Orion で使用している SQL データベースがプライマリ Orion サーバーと同じ物理サーバー

上にないことを確認します。 

2. Hot Standby Server で、Start > All Programs > SolarWinds Orion > Advanced 

Features > Monitor Polling Engines （スタート > すべてのプログラム > SolarWinds 

Orion > 高度な機能  > ポーリング エンジンの監視）をクリックします。 

3. Hot Standby Server で、Start > All Programs > SolarWinds Orion > Orion Web 

Console （スタート > すべてのプログラム > SolarWinds Orion > Orion ウェブ コンソール）

の順でクリックします。 

4. プライマリ Orion サーバーの電源をオフにします。 

5. Monitor Polling Engines （ポーリング エンジンの監視）ウィンドウおよび Orion ウェブ コ

ンソールが示す結果から、Hot Standby サーバーが Orion サーバーの役割を果たしてい

ることを確認します。Monitor Polling Engines （ポーリング エンジンの監視）ウィンドウの

下部ペインには、エンジンの状態を判断するために役立つエントリが多数あります。たとえ

ば、Server Type （サーバー タイプ）、Hot-Standby For… （Hot-Standby の対

象... ）、および Last Fail-Over （最後のフェイルオーバー）などです。 
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